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Preface iii 

Preface 
Within these pages are thirty projects to guide your introduction to the Apple Macintosh. 
We developed these projects after several years of teaching a broad range of stude nts, from 
novices to computer p rogrammers. W hile ma ny of t hese projects h elp you create useful 
ite ms, all will provide you with a fresh look a t o rganizing your world, allowing you to be 
creative and to en joy your journey as you master ind ividual software packages. A Macintosh 
foumey with Guided Projects provides step-by-step instructions to individuals interested in 
learning to use an Apple Macintosh at sch oo l, in the office, or at h ome. It is an in troduction 
to using many popular softwa re packages available for the Macintosh-Microsoft Word, 
Microsoft Excel, MacPaint, MacDraw II , Fi leMake r II, a nd HyperCard. 

Each of the five parts of our book begins wi th a brief ch apter on the basic concepts o f 
computing, graphics, word processing, spreadsheets and information management softwa re. 
The applica tio n chapter(s) that fo llow are a series of pro jects that reinforce learni ng by 
building upon the successful completio n of the previous pro ject. Howeve r, each application 
chapter is independent of the others. You may choose to skip an entire appl ication 
package, o r learn the packages in any o rder you require. 

The Applicatio n chapters are structu red on this model: 

• Objectives 
• Two-to-Four h a nds-on Projects with each completed Project provided 
• Visual integration of Icons, Command Key Eq ui valents, Menus, 
• Dialog boxes and Screen s 
• Enhanced selected screens as checkpoin ts for your work 
• Suggested points to quit and instruc ti ons for starting up aga in 
• Cautions and Warnings for beginning computer users 
• Suggested points to Save Your Work 
• Summary with Key Terms 
• Command Key Equivalents and Sho rtcuts Summa ry Table 
• Additional Project(s) for independen t study 

Conventions Used in This Book 

You will see li nes in the applications chapters that are formatted as follows. 

3€ -S • C hoose Save from the File m enu. 

The a rrow indicates that this is an act io n step that the reader should perform. Comm and 
key eq uivalents and keyboard sho rtcuts for these actions, when available, a re listed in th e 
left column. 

Ancillaries 

• Reference Guide to Your Macinlosll by j ohn Dil beck and Nicki Fink. A brief guide in 
two pa rts: 
1. A Mini Manual (essentia l in fo rmation a nd practical tips for beginn ing computer 

users); and 
2. How to Buy Your Own Macintosh (a concise overview of Macintosh hardware) with 

Buyer's C hecklist. 
• lnstmctor's Manual to Acco111pany A Macinto.sh joume by Ann Quade with Lecture Outlines, 

Project Summaries, Teaching Hints and Test Questio ns. 
• Macintosh j ourney Projects d isk. An opti o nal d isk with data files and project graph ics. 
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Part 1: Introduction to 
Using the Macintosh 

P art I teaches you the basics of using the Macintosh and introduces 
you to some of the concepts, terminology, and procedures that 
are standard on this c01;nputer. 

The concepts include the Macintosh user interface and its components: 
the desktop, windows, buttons, menus, and icons. You will learn to use 
the Finder, format a disk, create and move fo lders, use menus, open a 
program and quit from it, and be able to identify the parts of the desktop 
and windows. 

You will learn the background information necessa ry to interact with 
the Mac and to use programs that implement the standard Macintosh 
interface. 
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Chapter 1: Getting Started 

What You Will Learn in This Chapter 

After reading this chapter and completing the projects in it, you 
should be able to: 

• Identify the parts of the Macintosh desktop and windows 

• Maneuver around the desktop 

• Use the keyboard and mouse 

• Issue commands from menus 

• Open and close windows 

• Open a program and quit from it 

• Format a data disk 

• Create and move folders 

• Duplicate documents, folders, and disks 

• Organize documents, folders, and disks 

• Erase documents and folders 

T he Macintosh is one of the easiest of all computers to use. You 
can learn the basic operations of the system in less than an hour. 
The programs you will be using-graphics, word processing, 

spreadsheets, information managers, and others-all share a common 
method of operation. Once you learn the standard methods of interacting 
with the Mac, you will be on your way to knowing how to use these other 
programs as well. 

The Macintosh introduced a graphical user interface. Instead of typing 
commands to the Macintosh, you interact with it using icons, windows, 
menus, buttons, and a mouse. 

When you first start a Macintosh, it runs a program named Finder, which 
allows you to run programs, copy and erase documents, format disks, 
find files, tell the computer when you are ready to quit, and many other 
tasks. 
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THE DESKTOP 

LJ 
Applications 

I 
Tr-ash 

3 

The Finder presents a view of the system known as the desktop (see 
Figure 1-1). 

Figure 1-1 The desktop 

In most offices you can usually find items that you already know how 
to use. These items cou ld include such things as clocks, calculators, note 
pads, file folders, and trash cans. By building on your real-world skills 
and knowledge, the Macintosh lets you interact easily with the computer 
as you perform tasks that are simi lar to equivalent tasks in an office. 

The desktop metaphor is one of the reasons the Macintosh is easy to 
learn to use. If you want to file a document, you already know how to 
put it into a file folder and then put the file folder into a filing cabinet. 
On the Macintosh you also put a document into a folder, and the folder 
is contained in a disk. 

You already know how to drop something into a folder, open a folder, 
take someth ing out of a folder, close a folder, and store a folder or throw 
it away. The Macintosh lets you build on your real-world experience as 
you work in the Mac's desktop. You can prepare a document, store it o n 
a disk, place it into a folder with similar documents, move it into a 
different folder, place it on the ~esktop, and throw it away. 

O n the Macintosh, there are no cane commands tha t you have to lea rn 
to do these things wi th documents. If you want to throw something 
away, you already have practice putting it into a trash can. On the 
Macintosh, you can discard a document by selecting its icon and 
dragging the icon into the Trash. 
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The desktop allows you to contro l the Macin tosh and tell it what to do. 
At the same time, the computer will be communicati ng with you, so you 
can see the results of your actions. For example, when you place a 
document in the Trash, the Trash icon changes to a bulging trash can 
to show that something is in it. 

There are two icuns (pictures representi ng objects) showing on the 
screen (see Figure 1-1). One icon is named My Ha rd Disk and the o ther 
is named Trash. 

My Hard Disk contains the programs and documents currently avai lable 
fo r use. The Trash al lows you to discard (erase) a ny documents you no 
longer need. (Since the Trash has straight- as opposed to bulging
sides, you know it is empty.) 

In addition to allowing you to organ ize your disks and dispose of 
unwanted documents, the desktop enables you to start application 
programs. Many popular programs are available for usc o n the Macintosh. 
One of the first programs written for the Macintosh is named MacPaint. 
This program a llows you to create and modify graph ics on your 
computer. 

for the next several pages you will be led through the process of fi nding, 
starti ng, and qu itting MacPaint. Read along, a nd fo llow the process 
with ou t trying the steps yourself. Your disk will proba bly be organ ized 
differently from what is demonstrated he re, and it could get confusing 
if you we re to try to fo llow along at th is point. In Pro ject 1, however, you 
will work through a brie f tutorial to learn how to work with the d esktop. 
(Lnte1~ in Cl!npter 4, )'Oil will lenni how to use MncPaint.) 

USING THE MOUSE 

Most of the actions o n the desktop are initiated using the 111ouse. The 
pointer on the screen is controlled by moving the mouse o n a d esk o r 
table. Pull the mouse toward you and it moves the pointer down on the 
screen. Push the mouse away from you and the pointer moves up. 
Moving the mouse left o r right causes t he pointe r to move in a 
correspond ing direction o n the scree n. 

The mouse has a single button on its top. There are four main ways to 
use the mouse and its button. 

Click Press down on the mouse button, and then release it. 

Double-click Click the mouse button twice in rapid succession without 
moving the mouse. 

Drag Press the mouse button and keep holding it down whi le 
you move the mouse to a new location. Then release the 
button. 
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Shift-click Wh ile you are pressing the Shift key on th e keyboard, click 
the mouse button. 

The poin ter changes shape depending upon what you are do ing at any 
particula r mo ment. When you a re working on the desktop, you will be 
using the arrow pointer most of the time. This is the shape it wi ll be when 
you are working with the icons and controls on the desktop. If you select 
an icon and then move the pointer over the icon's name, the pointer wil l 
change to th e !-beam pointer, which indicates that you can now change 
the name o f the icon if you wish. When you tell the Macintosh to 
perform some operation that may take more than a second or two, the 
pointer will usuall y change to a wristwatch pointer, which essen t ia lly 
means, "Wait a minute, I'm busy." 

Figu re 1-2 shows the pointers that you will see most freque ntly 
when working on the desktop. 

111ro.. Arrow pointer, used to imerac~ with windows, 
~ controls, the menu bar, and icqns on the desktop. 

I !-beam pointer, used in editing text. Clicking moves 
the insertion point, and dragging selects text. 

~ Wristwatch po inter, shows that the current 
~ operation will take some time 'to complete. 

Figure 1-2 Pointe rs used when working o n the deskto p 

ISSUING A COMMAND 
Issuing a command is a two-step process. First you select an object, and 
then you tell th e computer what to do to it. You can also issue a 
command when mo re than one ob ject is selected. 

In the top right corner of Figure 1-1 is the icon of a disk named My Hard 
Disk (yours will probably say something e lse) . You want to open this 
disk to see what is in it. The easiest way to do this is to move the mo use 
po inter so that the tip of the arrow is touching the disk icon. Then, 
without moving th e mouse, double-click on the icon. 

As soon as you double-click on it, the disk icon opens a wi ndow, as 
shown in Figure 1-3. Thi s window shows six icons representing fo lders. 
The System Folder icon has a p icture of a Maci n tosh on it, which means 
that it is the folder containing all the necessary fil es for the Macintosh 
to operate . All the o ther folders look alike, but each has a differen t name. 
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., 

LJ LJ 
System Folder Applications Utilities 

LJ LJ LJ 
Correspondence Clip Ar t Homework 

Figure 1-3 The window fo r My Hard Disk 

Every ha rd disk is probably organized differently. Some have more o r 
fewer folders than this one. 

TWO TYPES OF PROGRAMS 

There a re two ma in ty pes of computer program s. System progrnms are used 
to control the syste m, and they are stored in the System Folde r on a 
Macintosh. The desktop on a Macintosh computer is provided by a 
system program known as the Finder. 

Applicntion progmms are used by a person to perform a task. MacPaint is 
used to draw images, so it is an application program. On this hard d isk, 
MacPaint is located in the Applications fo lder. 

Your next step is to open the Applications folder by double-clicking on 
its icon. 

When you do uble-click o n the Applications folder, the Finde r opens 
the fo lder and sh ows its directaty window (see Figu re 1-4), wh ich contains 
six mo re folde rs. Th is directory window shows all the documen ts 
and folders conta ined in the Applications folder just opened. 
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,. -' File Edi t Uiew Speci al 
., 

System Folder 

LJ 
Graphics Word Processing Excel 

LJ LJ LJ 
FileMak•r II PageHak•r HyJl"rCard 

Figure 1-4 Directo ry window fo r the Applicatio n s fo lder 

FOLDERS WITHIN FOLDERS 

The p rocess o f sto ring fo lde rs within folders is known as nesti11g. Nesting 
a ll ows you to sto re large quantities of inform ation o n a disk an d stil l be 
able to find it qu ickly. 

MacPaint is a grap hics program, so you will find it inside the G rap hi cs 
fo lde r. Ope ning the Graphics fo (der reveals other folde rs a nd docume nts 
(see Figure 1-5). 

r 5 File Edit Uiew Special 
., 

MacPainl 2.0 lrlacDr a\i II 

Figure 1-5 The G raphics s contents 
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The Gra phics fo lde r contains two items, including one with an icon 
representing a h and painting on a sheet o f paper. This is the icon for 
MacPaint. It is named MacPaint 2.0. 

RUNNING A PROGRAM 

MacP aint 2 .0 

Let's te ll th e Finder to run MacPaint. You have a lread y seen that you can 
open a disk by double-clicking o n its icon, and you can open a fo lder by 
double-cli cking o n its icon. Th is would lead you to guess that you can 
open MacPaint by double-clicking on its ico n, and you would be correct. 

Pointing to a n icon and dou ble-clicking is actually a shortcut method 
pre ferred by many Macintosh users. The standard method for opening 
a documen t o r fo lder, or for running a program, is to select the icon, and 
th en choose the Open command from the File menu. Many people who 
are new to the Macintosh prefer this method, at least until th ey become 
comfortable using th e mouse and double-clicking. 

Ano th er shortcu t method for opening a document o r folder, o r for 
running a program, in volves using a Command-key equivalent. 

As you ca n see in the top po rtion of the File menu (at left), the Open 
command has somethi ng to its right in the menu. There is a cloverleaf 
symbol and the letter "0". The cloverlea f symbol represents the Command 
key on th e keyboard . In the Fi nder, the process of pressing the "0" key 
wh ile the Command key is held down is equivalent to ch oosing the 
Open command fro m the File me nu. 

In th e remainder of this book, Command-key equiva lents are shown as 
Command-O (with the "0" replaced by the appropriate key). You also 
ca n see from the menu that Command-N is equivalent to choosing New 
Folder from the Fi le me nu. The Print command does n ot have a 
Command-key eq uivalent in Finder, but it may in o ther program s. 

When you open MacPaint, it runs the applicatio n, creates a blank 
docu men t, and presents you with the view shown in Figure 1-6. As you 
ca n see, the pointer has changed to the shape of a penc il , but if you move 
the pointer up to th e menu ba r, it w ill cha nge back to the arrow pointer, 
which is used to se lect commands from a m enu . 
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' j File Edit Goodies Font Style Po t erns Tools 

"Unlil lcd- 1" ot ' t00'7. 

(l 

Figure 1-6 The opening screen of MacPain t 

You will learn how to use MacPai nt in Chapter 4. Now that you o pened 
MacPaint, h ow do you te ll the Macin tosh that you don 't want to use it 
a nymore? 

When you are fi rst learning to use the mo use, you may feel uncomfortable 
with it and have tro uble pointing to the icon you wan t. If you 
accidentally open an applicatio n that you don't want to use, you shou ld 
h ave no problem q uitting the program, eve n if you don' t know how to 
use that program yet. 

QUITTING A PROGRAM 

The main thing that makes the Macintosh easy to use is the consistency 
of commands given to all programs. You wi ll tell MacPaint to quit the 
same way you tell almost all Macintosh programs to q uit. 

To do th is, you will use one of the commands in a menu. On the top o f 
the screen is a menu bnrthat lists eight menu names. The first is the Apple 
( ) menu, and the next two are the File menu and the Edit menu. These 
three menus are sta ndard on a ll Maci n tosh programs (except games and 
special-purpose progra ms). 

A fi le is computer terminology for a collectio n of info rmation. In 
Macintosh termino logy a fil e is a lso ca lled a dowment. The Fi le m en u 
allows you to con tro l ope rations concern ing a document, including the 
ability to tell th e program to qu it. 

Let's te ll MacPa int to q uit a nd l·eturn to the desktop. To do this, m ove 
the mouse poin ter so that it toLrhes the ri le menu. Pressi ng the mouse 
button pulls the menu down onto the screen. Wh ile you are stil l 
pressing the button, drag the m use towa rd you unti l it selects the menu 
item you wa nt. 
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When a menu item is selected, it is highlighted. This mea ns that the white 
parts in the item turn black, and vice versa. Continue dragging the 
pointer down until it highlights the word Quit at the bottom of the 
menu (see figure 1-7). Stop dragging the mouse, and release the button 
whi le Quit is still selected. The command will blink several times, and 
MacPaint will return you to the desktop. 

Goodies Font Style Patterns Tools 

XN nlllled- 1" at l 00% 

Soue 
SoueRs ... 
Reut.>r I ro S<n•ed 

XO 
xw 

xs 

Toke Snapshot X Y 
Throw Awoy Snapshot 

Poge Setup ... 
Print ... 
Pr ln I Sel e< Uon ... 

Quit ~Q 

Figure 1-7 Selecting the Quit command from the File menu 

(Most programs a llow you to quit by typing Command-Q.) 

That's al l there is to issuin g a command using the Macintosh's pull-down 
111enus. 

CLOSING OPEN FOLDERS 

The finder now returns you to the same place you were before you 
launched MacPaint. Now you want to close all the folders and return to 
an uncluttered desktop. There are several ways to do this. 

The easiest way is to click in the window's close box (see Figure 1-8). Notice 
that the pointer in the figure is in a small square box to the left of the 
Graphics folder title. 
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r • File Edit Uiew Special 
., 

MacPaint 2 .0 MacDraw II 

Figure 1-8 Closing a window with the close box 

Each window has a title bnr at its top. Most also have a close box on the 
left and a zoorn box o n the right side of the title bar. 

As its name i m pi ies, the close box causes the window to close. The screen 
should re turn to the same appearance it had before you opened the 
fo lder that is represented by t he window. 

The zoom box, if it is present, ca uses the window to zoom to a larger size. 
Some application programs caus~ the window to fil l the screen when the 
zoom box is cl icked. Others ca use the window to get larger, but not to 
fill the en ti re screen. If you click in the zoom box a second t ime, most 
applications wi ll return the window to the size it was before you first 
clicked in the zoom box. 

You ca n also see in Figure 1-8 th at the Graphics folder window has 
several ho rizontal lines in its ti tle bar, but the wi ndow named My Hard 
Disk does not. The p rese nce of the ho rizontal lines tells you that a 
window is the active window. 

A standard feature of the Macintosh user interface is that actions occur 
in the active window. There is another way to close a window that will 
ill ustrate this. Instead of clicking in the close box of a window, you can 
go to the Fi le menu and choose Close. Th is will cause only the act ive 
window to close and wil l have no effect on any others that may be 
presen t. 

There is ano ther way to close wihdows that is even easier and faster if 
you want to close a ll open windqws on the desktop. First, position the 
pointe r so that it is in the close pox of the active window. Then hold 
down the Option key and click in \ the close box. This tells the Finder to 
close the active window, make the next one active, close it, and con tin ue 
thi s process until a ll the window are closed and the desktop o nce agai n 
looks like figure 1-1. 
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Project 1: Preparing a Data Disk 

Now it 's time fo r you to g ive it a try. Since you will pro bably be working 
through several of the projects presented Ia ter in th e book, it is a good 
idea for you to (on nat a disk o n whi ch to store your work. 

You may be working on a computer that has a lwrd disk, or you m ay have 
only floppy disks o n wh ich to work. Either way, you will need to know 
how to fo rmat a d isk, to keep a spa re copy, o r backup, of you r important 
work. 

Formatting a disk is the process of letting the computer magneti cally 
o rga ni ze the disk, so that the di sk ca n sto re your info rmation and 
retrieve it. You ca n think of fo rm atting as setting up a fil e cabi n et a nd 
hanging folders, in wh ic h you ca n sto re real information at a later time. 
Many different computers use 3.5-inch di sks, and each type of computer 
h as a d ifferent routine that it uses to format the disk for its pattern of 
sto rage. 

You will need a blank disk, or o ne you can erase, to proceed with this 
project. 

A pamgmpl1 siiOwll indented with a rig!It-poiutiug arrow (such as tile uextoue) 
is the indicntion tlint you are to do wliat is stated in that paragraph. 
Paragraphs that are italicized (such as this oue) are COIIIIIIents to the reade1~ 

!Iinls, or 1/lild warnings. 

• The first thing you need to do is have your computer turned on. If 
you are working on a Mac that has an ex tern al hard di sk, turn o n the 
power to the di sk drive a nd then to the computer. If you are working 
with a fl oppy-based syste m, turn o n the computer and insert a 
syste m disk. 

Since //lOSt readers will probably be usiug a Maciutosl1 with a liard disk, that 
is the basic coufigumtiou assumed for the projects. We will also assume that 
you will be storiug these projects on a floppy disk rather than the hard disk. 
If you are usiug n syste/11 that does uot have a hard disk, you will ueed to 
remember to insert a startup disk into your computer tlwt co uta ins the system 
and applicatious you will need to complete tile particular project. For the 
projects i 11 this clwpte1~ you wi llueed a startup disk containing a System Folder 
and a blouk disk. 

};ou should also hove a copy, or access to a copy, o(t/1e Macintosh jo urney 
Pro jects disk. !(you are i11 a class tlwt lias adopted this book, your teacher 
should hove oue or more copies available for you to use. !(you purchased this 
book to learn 011 your owu, you will find a cord with instructious fur obtaining 
this disk attocl1ed ius ide the rear cover. You dou 't absolutely need tile Projects 
disk to col/lplete tile projects ill A Macintosh jo urney, but in a few projects, 
suc/1 as this oue, the disk will make it easier. 
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When your computer is started, you will see a desktop similar to the o ne 
in r:igure 1-9. Your desktop may look different, de pending on the 
nu mber and type of disk d rives you have attached to your system. 

• Fil e Edit Uiew Special 

Figure 1-9 The desktop 

• Your system wil l have o ne or more 3.5-inch floppy disk drives. 
When you and your Macintosh are ready, insert a blank disk in to 
any available d rive. 

If the di sk you inserted is blank or has been formatted on a differen t type 
of computer, you wi ll see a dinlos box like the one in Figure 1-10. 

1· - t l This dislc is unreadable: 

Do you want to initi~ li ze it? 

f Eject ) (One- Sided) (Two-Sided) 

Figure 1-10 Unreadable disk noti ce 

This d ia log box allows you to respond in one of three ways. If you insert 
a disk that h as valid data on it and receive this notice, immediate ly cl ick 
the Eject butto n . Th is means that something is wrong with the disk o r 
the way the data is stored on it. If you do not know how to correct the 
situation, take the d isk to someone who may be able to recover your 
data. 

The other two buttons, One-Sided and Two-Sided, a re there so you can 
te ll the Mac how you wan t the d isk to be formatted. Many single-sided 
disk drives a re still in use, and these drives can read disks that are 
formatted fo r 400K storage on ly. If you wa n t to use the disk you are 
formatting in a dr ive that reads 400K disks, you must click One-Sided. 
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If your disk d ri ve sto res and reads 800K disks, you sho uld click Two-Sided. 

(If you nre using n Macintosh witll n "SuperDrive" you will see one of two 
din/us boxes, depending upon wllet/1er you i11.serted n DSDD (double-sided, 
double density) or high-de nsity disk into the dri ve. If you put n DSDD disk 
(tl1e most common one) into the drive, you will see tile din log shown in Figure 
1-10. if you inserted n high-density disk into tile dri ve, the computer cnn 
recognize this nnd will show the same din log box with only two choices: Eject 
or initialize. JV!ncintoshes without n SuperDrive nre not nble to rend high
density disks.) 

• You probably wi ll wa nt to format (initialize) the d isk fo r use in an 
800K disk drive, so click Two-Sided. 

If you are using System 6.0 or later, the Maci ntosh will then respond 
with an other di alog box (see Figure 1-11 ). 

This process will erase all 
information on this disk. 

Cancel n EraSP~ 

Figure 1-11 Warning aga inst erasing contents of disk 

• This shou ld be a blank disk; you do n ' t have to be con cern ed with 
losing any info rmation , so c li ck Erase. 

Before formatt ing your d isk, th e computer asks for a name to assign to 
the d isk (see Figure 1-12). If you are using this textbook in a classroom 
setting, you probably sho uld have you r n ame as pa rt of the disk's n am e 
so th at even if the label were to come o ff, someone could recognize the 
disk as yours by insert ing it into th e com puter and read ing the d isk's 
name. 

Please name this disk: 

I Alan White Data 

n OK;) 
Figure 1-12 Na ming your d isk 

• Enter your nam e, fo llowed by the word Data fo r the disk's name. 
Click OK. 
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For the n ex t few seconds, the Macintosh will forma t the d isk and the n 
veri fy that the formatting process worked correctly. If the initializa tion 
was successfu l, the icon of your d isk will show on the desktop (see 
Figure 1-13). 

Figure 1-13 Formatted disk's icon on the desktop 

Do n' t worry if part of th e name goes o ff the side of the screen. The full 
name is st ill there. However, if thi s appearance bothers you, you can 
either drag the icon a I i ttle to the left o r use shorter names o r abbreviations. 
If you wa n t to move the disk icon, you move the mouse pointer to the 
icon, press the button, a nd th en drag the disk to the left w h ile the butto n 
is held down. Whe n you release the mouse button, th e icon will move 
to its new locat ion and stay there. 

If the initia liza ti on was not successful , you wi ll receive a notice that the 
ini tialization fa il ed. At that point, you have the option of t rying it again 
or using a different di sk. Sometimes a disk w ill fo rmat correctly the 
second t ime . If the initialization stil l fai ls, you shou ld use an other disk. 

If the initia lization fails, you may want to d isca rd the d isk now, before 
you save important info rmation on to it. All d isks eventually fa il, so 
d isca rding one tha t d oes not fo rm at correctl y may save you fro m losing 
va luable time and inform ation later. 

".. Ope n your d isk's directo ry wlindow by double-clicking o n its icon. 

Anoth er way to open a disk's d i r~ctory w indow is to click once on the 
disk's icon to select it. Then type o m mand-0 to open the d isk. It is your 
ch oice whether to issue a comm, nd with the mouse and me nu o r with 
a Command-key eq ui va lent. 
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As you can see in Figure 1-1 4, no documents are currently located on this 
newly forma tted d isk. The status line just below the wi ndow's n am e 
shows th at there a re 0 items on the disk. Seven kilo bytes of storage a re 
already used by the system, w hich h as rese rved a portio n o f the d isk fo r 
directory information and a place to store how the di rectory window 
will appear o n the desktop. 

' a File Edit Uiew Sp ecial 

} Alan While 011111 
0 tttms 7K tn disk 

Figure J-14 Di rectory window of newly initialized d isk 

~ - W • Close the window by clicking in the close box, th e small white 
rectang le a t th e left end of the title bar just above "0 items." 

Tl1e symbol to the le{to{tl1e instmction above represents Conmwnd- W, which 
is the Conn nand-key equivalent for closing the active window. Throughout the 
book we will usually indicate a Command-key equivalent (a lso known as a 
keyboard equivalent) when one exists. It will be your option to select frorn the 
111enu or issue the cormnand from the keyboard. 

DUPLICATING A DISK 

Th e nex t part of this proj ect involves copying the documents in the 
Macintosh foumey Projects d isk onto your newly formatted data d isk. If 
you do not have that d isk, you ca n read a lon g and complete only th e 
pa rts that do n ot depen d o n h aving the Projects d isk. 

All Macintosh computers have at least o n e flo ppy disk drive, and some 
have two o r more. For thi s pro ject, we w ill assume that your Macintosh 
has a hard d isk and one floppy drive . 

Pat yourself o n the back if you noticed the re is a problem arising. You 
h ave two disks and o nly o n e fl o ppy d isk drive. How can you copy one 
d isk o nto the o th er with only one d ri ve? 

Duplicating one di sk onto another is a fa irl y easy process, even if you 
on ly h ave one drive. (If you have two fl oppy d ri ves, o f course, it is fast 
and easy.) 
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Ejecting a Disk and Still Showing Its Icon 

The first ste p is to eject your data d isk from th e drive in such a way that 
th e Macintosh will sti ll reme mber it. Th en you can insert the Projects 
disk and d rag its icon onto your data disk's icon , even tho ugh the data 
disk is not currently in the drive. 

As was stated before whe n you were lea rning how to sta rt MacPaint, 
doing something on a Macintos h usually involves two steps: se lecting 
an object and then issuing the command that w ill affect that object. 

First, select the o bject. .. 

• Select your data disk by m oving the pointer so that the tip touches 
your data disk's icon , and th en click the mouse button once. 

And th en issue the command ... 

3€ -E • Eject your data disk by ch oosing Eject fro m the file menu, and then 
remove the disk from the drive. 

This will e ject the disk and leave its icon showing o n the desktop. Notice 
that there is now a gray pattern in your data disk's icon (see figure 1-15). 
An icon that looks like th is is known as a dimmed icon. Th is indicates 
that the Mac remembers the disk but that it is not currently in a disk 
drive . 

~e 1-15 Disks not presently in a drive have dimmed icons. 
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Copying the Projects Disk onto the Data Disk 
You have to insert the document d isk, so you ca n copy the informatio n 
stored on it. 

• Insert the Macintosh Journey Projects disk into the drive. 

Another icon, representing the Projects disk, wi ll appear o n the desktop 
below the icon of your data disk. Now that both icons are visible o n the 
screen , you have largely overcome the problem of two d isks and only 
one drive. 

Since both disks are formatted the same (double-sided or SOOK), you can 
copy the Projects disk onto your data disk by dragging the icon representing 
the Projects disk onto the icon of the data disk and then releasing the 
mouse button. 

• Move the mouse poi n ter so the tip is on the Macintosh joumey Projects 
icon . 

• Press the mouse butto n and, while keeping the button pressed, 
move the mouse forward sotheoutlineoftheProjectsdisk icon moves 
up o n the screen. When the pointer is on your data disk icon, the 
data disk icon wi ll change appearance, indicating that you have 
chosen it as the disk onto which the documen ts will be copied. 
Release the mouse button to start the copying process . 

When copying fro m one disk to another, the disks are usually referred 
to as the source and destination disks. Since you are copyingfi·om the Projects 
d isk, it is the source disk. The d ata disk is the destination disk, beca use 
it is th e destination of th e fil es being copied. 

If you have correctly told the Macintosh to copy the fi les on the Projects 
disk on to your d ata disk, a dialog box (see Figure 1-16) will appear aski ng 
if you want to completely replace the contents of you r data disk with th e 
contents of the Projects disk. 

15 File Edi I Uiew 

Are you sure you w ant to complet ely 
replace contents or 

" Rian Whi t e Data" (not in any driue) 

with contents or 
" Macintosh Journey Projects" (Internal 
driue)? 

F~""''\ [ Cancel ) 

Figure 1-16 Dialog box to confirm disk duplication 
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Enter or Return • This is what you want to d , so click OK. 

The dark oval around the OK button shows that it is the default button. 
Pressing the Enter or Return key is interpreted the same as clicking the 
default button. 

Once you give the Mac your permission to replace the contents of the 
data disk with the contents o f the Projecl.s d isk, a new dialog box wi ll 
appea r showing the progress of copying the disk. This process begins 
with reading the information on the Projects disk. 

When the computer has read all the information on the disk, or al l that 
it can conta in in memory, it will eject the Projects disk and ask you to 
insert your data disk. It will then continue the copying process by 
writing information to your data disk. 

Depending on how much in formation is o n the source disk and the 
amount o f main memory in the Macintosh you are using, you may be 
asked to swap disks one or more times. When the computer is fini shed 
copying the information from the Projects d isk, the operation wil l end 
with your data disk in the computer's disk drive. 

(If you have two or more floppy disk drives, you ca n insert both disks 
in to the computer at the same time and then drag the Projects disk's icon 
onto the data disk. The copying operatio n will proceed without requiring 
any d isk swapping.) 

Warn ing: You can use this process ofdragginga disk's icon onto another 
disk whenever you want to duplicate all of the information on one disk 
onto another. This process will erase the information on the destination 
disk, so be sure this is what you really want to do before you tell the Mac 
it is okay to completely replace the destination disk's contents. 

Th is process will only work if both disks a re formatted the same. This 
restriction is there to insure the safety of you r info rmation. You would 
never want to completely replace the contents of a hard disk with the 
contents of a floppy disk. 

COPYING A DOCUMENT 
There is another waytocopyoneor more documen ts from onediskonlo 
another one without replacing the entire contents of the destination 
disk. 

just as you ca n drag a disk o nto! another d isk to make a complete d isk 
du plicate, you ca n drag one o r ore selected documents from one d isk 
o nto another disk. 
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Let's d rag o ne file from the Projects disk onto your data di sk. You will 
drag the Myste ry Document onto your d isk. The process of dupl ica ting 
the di sk that you just com p leted has al ready p laced th is fi le o n your d isk. 
The Macin tosh wi ll recognize this a nd ask if you want to replace a file 
with th e sa me n a me as th e selected fi le. 

O n ly one fil e with a particular name may exist on a disk or in a folde r. 
If you copy ano ther file wi th the same name, the Mac would have to 
erase th e one already on the disk. There is potentia l that th is situatio n 
could be accidentally en countered and would result in the loss o f the 
o rigi nat fi I e. Therefo re, the Mac asks your permission before it con tinues. 
If you have any doubt about the conten ts of the fi les in questi on, tell the 
Mac to cancel the copy operati on and determ ine if this is what you real ly 
want to do by looking at the contents of both documents. 

In this case, you already know that it is okay to replace the document, 
so you will tell the Mac to go a head with the o peration. 

Notice that the icons of both di sks a re sti ll on th e desktop. You ca n look 
at the conte nts of th e Projects disk by double-clicking o n its icon . The n 
you wi ll copy the Mystery Document o nto your data disk aga in. 

• Double-cl ick on the Macintosh joumey Projects disk icon. You may be 
prompted to swap disks one or more times. If the icons are d immed, 
eject your data d isk and insert the Projects disk. 

The d irectory window o pe ns, and you will see the Mystery Document 
in the fourth row of icons. 

• C lick on the Mystery Document a nd then drag it on to the icon o f 
you r data di sk (see fi gure 1-17). 

~ I . ~ y 

. 
Tr~v.ling TWMS l.'flform.ttttd Tr~nhng Tirl'les Logo 

~ 
Clus Notu Buttons 

II wmtmu:. ;: , J.il 

[Q ~ 
9& KP-1W1hng B & K DnWW>j 

Figure 1-17 Copying one fi le to a nother disk 
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The process of copying th e file wi ll involve at least o ne d isk swap (if you 
are using o nl y one flo ppy d rive) . As soon as the computer determines 
that a docu ment with the same name already exists on your d ata disk, 
it will ask if you want to continue (see Figure 1-18). 

~ 
lnvtntorv 

Vnu1l Effeots 

~ 
l2J 

B & K0r•w"'9 

11 
lilJfibiJiij.rglf .. iJ.Q 

Figure 1-18 Dialog box for pennission to replace a documen t on data 
disk 

Enter or Return •• Sin ce you are sure you wan t to replace the Mystery Document, cl ic k 
OK. 

You wi ll see a dia log box showing the progress of the copy operatio n and 
may be asked to swap d isks o ne o r more times. 

If a document named Mystery Document h ad not al ready been stored 
on your data disk, the Macintosh would not have encountered a 
situatio n with the pote ntial fo r los ing data. In that case, it would no t 
have asked permission befo recopyingthe file. lt will only ask permission 
before engaging in a copy o peration that m ay erase information. 

Of course, o nce you tell it to proceed, the Macintosh will replace the 
original document, so be sure you know what you are doing before you 
tell the computer to continue. 

Ejecting a Disk and Removing Its Icon 
Now that you have copied the fi les from the Macintosh joumey Projects 
d isk, you are fin ished with it and ca n eject it (if it is in the computer) and 
remove its icon from the desktop. 

When ever you a re finished us i~g a disk, you shou ld tell t he compute r 
to eject the d isk and re move the~ i s k's icon from the deskto p. It doesn't 
matte r if the disk is in the comr uter or not. 

- Drag the Projects di sk icon nto the Trash and release the mo use 
button. 
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Thi s will no t erase t he disk; it just te lls the computer that you are 
fin ished usi ng th e d isk fo r now and to fo rget wh at it knows about that 
disk. Not on ly does this remove the icon fro m the desktop, it also frees 
some of the com puter's me mo ry fo r o ther uses. 

.. Double-cl ick on your data disk icon to open its directo ry window. 

You ca n now see, as shown in Figure 1-19, that the Mystery Docum ent 
icon is out of place. It may no t be in the positio n sh ow n, but it should 
be located in the firs t available pos itio n in the top row. 

,. -' File Edit Uiew Special 
, 

Geno ·s Menu Unformatted 

Tr aveling Times Unformatted Traveling Times Logo 

Glossary Visua 1 Effects Class Notes Buttons 

Inventory 

. 
~~ 

B & K Dr a~1ing 

Figure 1-1 9 Mystery Document's icon is out o f place. 

W he n you duplicated the entire Projects disk o nto your data disk, the 
icons were placed in this window the same as they were on the o riginal 
d isk. However, when you copied the Mystery Docum ent o nto th e d isk 
ind ividually, its icon was placed in th e first available positio n . 

Since this is not where we wa nt the icon, you can move it to its o riginal 
positio n . (Note: lt is n ot impo rtan t to try to place the icon precisely, just 
get it in its approx imate positio n. ) 

Moving a Document's Icon 
You have alread y seen th at you can copy a docum en t fro m o ne disk o nto 
anoth er o ne by d ragging the docum ent's icon onto the destin atio n d isk. 
This does not e rase the fil e fro m the source disk. 

If you d rag a docume nt icon around inside the sa me window, it does not 
copy th e file; it just changes the locatio n wh ere the ico n will be 
di splayed. If you d rag the ico n onto a fo lder on the sa me disk, it does not 
copy th e fi le and place a copy in to the fo lder; it moves the documen t 
in to the folder a nd removes it from its previo us locatio n. 
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In a few minutes, you will mo e a file into a fo lder, but for now just 
move the Mystery Document's icon to the fourth row of icons (see 
Figure 1-20). 
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Figure 1-20 Moving a fil e's icon to a different location 

.. Drag the Mystery Document icon to its new position and release it. 
Be sure to keep the mouse po inter inside the directory window of 
your data disk. 

Notice, when you drag the icon, that a gray outline of the icon moves 
wi th the pointer. This is to show th e position the icon wi ll assume if you 
release the mouse button. It enables you to move and place icons 
accurately in the window. 

If you release the mouse button before you have the icon where you 
want it, just drag it again until you get it to its proper new location. 

TAKING DIFFERENT VIEWS OF A DIRECTORY 
WINDOW 

Up until now you have been viewing the directory window using icons. 
This is only one way you can view the contents of a disk or folder. 

Every application uses a particular icon to represent its documents. Each 
of these icons is diffe rent from the others. When you become familiar 
with the different icons, this is a convenient way to find and access the 
document in which you are interested. 

There a re times, however, wher it is more conven ient to view the 
directory in o ther ways. Two of t:h e other most useful views are by date 
and by name. 
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By Date 

By Name 

Part I: Introduction to Using the Macintosh 

Viewing a di sk or folder window by date shows all the documents sorted 
by reverse chronologica l o rder based on the last time each document 
was modified (see figure 1-21). If you wan t to quickly find a document 
you worked on recently, it is conven ient to view by date so that the most 
recently modifi ed fi les are shown first. 

• Choose by Date from the View menu. 
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Figure 1-21 Viewing your data disk by date 

Another convenient way to view the window's contents is by name. 

., 

Viewing a disk o r folder window by name shows all the documents 
sorted alphabetically by name (see Figure 1-22). If you want to quickly 
find a document and you know its name, the view by name option may 
be helpful. 

• Choose by Name from the View menu. 
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Figure 1-22 Viewing your data disk by name 
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You will find all of these methods of viewing the directory window 
useful. 

• Choose by Icon from the View menu to change back to the original 
view of the disk's directory. 

This is the Macintosh's default view. When you format a new disk, it will 
automatica lly be viewed by icon. Next time you insert the disk, the v iew 
will be the same as it was the last time you used it. 

DUPLICATING A DOCUMENT 
Now you will learn how to create an exact duplicate of a document. This 
is useful if you want to make a backup copy of a document on the same 
disk befo re you try an operation that might result in damage to the 
current state of the document. For example, you mightwanttoduplicate 
a spreadsheet before sorting it, backup a complex drawing before 
modi fying it, or backup a long word processing document befo re 
starting an involved formatting process. 

Copying a document and duplicating a document are similar, but use 
different mechanisms. Copying a document involves making a new 
copy of the document on a different disk. To copy a document, click on 
its icon and drag it to a different disk. The Finder will then create a copy 
of the file, with the same name, on the other disk. 
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Duplicating a document in volves making a new copy of the document 
o n the same disk and in the same folde r as the original document. To 
duplica te a document, click o n its icon, and then choose Duplicate 
fro m th e File menu (or use Command-D). The Finder will then create a 
copy o f the fil e, with the wo rds "Copy o f " added to the beginning ofthe 
file's name. Since the original fil e, and the new copy of it, are located at 
the same level o n the disk, they must have diffe rent names. 

In this case, you will go through the steps involved in duplicating a 
document. 

• Select Myste ry Document by clicking on its icon . 

~ - D • Choose Duplicate fro m the File menu. 

In a couple of seconds, you will see a new document named Copy o f 
Mystery Document appear in your disk's directory window just below 
and to the right of the selected document (see Figure 1-23). The new 
document is selected so you can change its name if you want. 
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Figure 1-23 The new copy of the Mystery Document 

That's a ll you will be do ing with this new document for a few minutes. 

,,. Deselect the Copy of Mystery Document icon by clicking in the 
white area o f th e window. 
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CREATING A NEW FOLDER 

Now you will create and place a folder on your disk. This will allow you 
to organize the storage of the projects you will later create. You may 
decide that you would like to organize your disk differently later. Feel 
free to customize it so that it works best for you, but for now, try it like 
this. 

:3€- N • Create a new folder by choosing New Folder from the File menu 
(see Figure 1-24). 
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Figure 1-24 Creating a new folder on your disk 

This will create a new folder on your disk labeled Empty Folder. 

,. Do not click anywhere yet. 

When the Empty Folder is created, it is automatically selected so you can 
easily change its name. 

• Rename the folder Final Projects by typing this name on the 
keyboard . As you type, you will see the name change. 

If you make any typing mistakes, use the Backspace key (Delete key on 
some keyboards) to erase the mistake and retype the name. 

• Move the Final Projects folder to the last row just below and to the 
right of the two Mystery Documents. 

• Deselect the fo lder by clicking in the white area of the window. 

You may have to resize the window so the folder will fit and be visible. 
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When you finish, the new folder will be named Final Projects and will 
be in the lower right side of the window (see Figure 1-25). 
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Figure 1-25 New Final Projects folder 
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DRAGGING A DOCUMENT INTO A FOLDER 

The main use for folders is to he lp you organize many files o n a disk by 
placing them into folders where you will be able to loca te them as you 
need to access the informatio n they contain. 

Putting a document into a folder is a matter of dragging its icon onto the 
icon of the folder and releasing the mouse button. 

• Using what you have learned, drag the icon representing Copy of 
Mystery Document into the Final Projects folder. 

The Final Projects folder wi ll be highlighted when the cursor gets on top 
of it. When you release the mouse button the Copy of Mystery Document 
ico n will disappear. 

How can you tell if the document was really moved into the folder? 
Open the folder and take a look. 

• Double-click o n th e Final Projects fo lder to open its directory 
window. 

When the window opens, part of the documen t's name may be missing 
on the left. If it is, you can click in the left scroll arrow so that the entire 
name becomes visible. 
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Your screen should now look l"ke the one shown in Figure 1-26. 
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Figure 1-26 Th e document after dragging it into the folder 

Now that you have verified that the document is really inside the 
folder, you can close the folder. 
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00 -W ,,. Close the window by choosing Close from the File menu or by 
clicking in the window's close box. 

DUPLICATING A FOLDER 

You have seen how easy it is to duplicate a disk and a document. Now 
let's duplicate a folder. Duplicating a folder is very similar to duplicating 
a document. 

• Select the Final Projects folder. 

8€ -D • Choose Duplicate from the File menu. 

In a couple of seconds you will see another folder appear on your 
desktop. (see Figure 1-27). 
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Figure 1-27 The duplica ted folder 

Duplicating a folder is similar to duplica ting a document, but not 
exactly. W hen you duplicate a folder, its entire contents are duplicated 
as well. This includes all documents in th e folder and even other folders 
and their contents that are located within the selected fo lder. 

Th is means that you now have two documents named Copy of Mystery 
Document. One is contai ned in the Final Projects folder, and the other 
is in Copy o f Final Projects. 

If the fo lder you select for duplica tion has a lot of information in it, the 
duplication process may result in more information than the disk has 
room to store. In this case, your Macintosh will info rm you and will 
terminate the duplicatio n process. 

ERASING A FOLDER AND ITS CONTENTS 

This is all you will be doing with the Copy of Final Projects folder and 
its contents, so you can now erase it from your disk. 

• Drag the icon of the Copy of Final Projects fo lder into the Trash 
and release it there. 

Be sure that the Trash is highlighted (turns black) before you release the 
mo use button; othe rwise, the folder will be placed close to the Trash but 
will not go into it. You ca n tell if you were successful in putting the folder 
into the Trash in a couple of ways. 

If the fo lder icon di sappears and the sides of the Trash bulge, the folder 
was placed inside the Trash (see figure 1-28). lfyou can still see the folder 
icon next to the Trash, the folder is just on top of th e Trash and not 
inside it. 
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Figure 1-28 The Trash bulges when there is something inside it. 

Warning: Dragging a folder into the trash will erase not only the folder, 
but also all of its contents. This includes any folders it contains and all 
of their contents. Before dragging a folder into the Trash, be sure that it 
does not contain other folders whose information you want to keep. 
You can accidentall y erase a lot of information from your disk by not 
being aware of what is inside a folder before putting it in the Trash. 

As long as the Trash's sides still bulge, you can open the Trash and 
remove any of its contents by dragging the icon(s) back where you want 
it. When the Trash is emptied, the files that were in the Trash are erased 
from the disk and cannot be retrieved. 

There are several ways to empty the Trash . You can choose Empty Trash 
from the Special menu, start any application, or choose Shut Down 
from the Special menu. All of these methods empty the Trash and erase 
whatever was inside it 

In this case, you know what is in the Trash, and you are sure you want 
to delete it. 

• Select Empty Trash from the Special menu. 

• Click the up scrol l arrow to make the top row of icons visible again. 

ERASING A DOCUMENT 
You have learned how to duplicate documents, disks, and folders. You 
have learned to move an icon around inside a window. You can move 
a document into a fo lder, an~ you know how to erase unwanted 
information. I 
• Using what you have learned, open the Final Projects folder and 

drag Copy of Mystery Doc ment into the Trash. Empty the Trash 
and close the Final Project folder. 



32 Part I: Introduction to Using the Macintosh 

This will leave your data disk set up for completing the rest of the 
projects in A Macintosh Journey. 

You still have the Final Projects folder on your data disk. You do not have 
to make use of this folder unless you want to, but you might find it 
convenient for storing your completed projects from the following 
chapters. When you complete a project, you can drag it into this folder 
where it will be out of your way. 

All that remains in this project is to eject your data disk and turn off the 
computer. 

• Choose Shut Down from the Special menu. 

This ejects any floppies that are in any of the Mac's disk drives and 
positions the hard disks for shutting down. A Mac Plus, SE, Classic, or 
SE/30 shows a dialog box telling you that you can now turn off the 
power. Any model in the Mac II series automatically shuts the power off 
to the computer. 

Congratulations! You have completed this project. 

This completes your quick tour of using the Macintosh and setting up 
a data disk. Although the Finder and other programs on the Mac do 
much more than you have seen so far, you have touched on many of the 
basics you need to know to get started. 

For more detailed information on using the Macintosh, see Reference Guide 
to Your Macintosh, a reference that covers Macin tosh subjects in 
alphabetical order by topic. It also includes an overview of Macintosh 
systems. Refer to the glossary in this book for defnitions of key terms 
used in this book. 

If you want more background about computers in general, continue 
with Chapter 2. 

If you are anxious to start working, turn to Part II and continue there. 

SUMMARY 

• The Macintosh employs a graphical user interface consisting of windows, menus, icons, 
d ialog boxes, buttons, and the use of a mouse for a person to interact with the computer. 

• Windows have title bars, close boxes, and zoom boxes . A window contains information that 
varies depending on the application that created the window. 

• Only the topmost window is active, and all action takes place in the active window. Active 
windows are indicated by title bars and other visible controls, such as scroll bars, that are not 
present in inactive windows. 

• Disks are used to store information in a fo rm that is readable by computers. Disks must be 
formatted, or initia lized, before they can be used to store this information. 
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• Disks are organized by the use of folders on the Macintosh. Folders may be placed inside other 
folders, a process that is known as nesting. 

• Moving the mouse moves a po inter on the screen and allows the user to interact with the 
computer by pointing at icons that represent objects and by clicking, dragging, or double
clicking the button on the mo use. The pointer changes shape depending upon the task being 
performed. In some applications, the pointer can take many shapes. 

• To issue a command to the Macintosh, point at a menu name, pull down the menu, and select 
a menu item from the list. Command-key equivalents are combinations of key presses that 
substitute for using the menus to issue commands with the mouse. 

• The Finder is an application that allows the user to organize and rearrange the storage of 
information on d isks, to copy and move files and folders, and to open applications. The 
Finder is the program that provides the desktop when you first start your Mac. 

KEY TERMS 
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application program 
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COMMAND KEYS AND SHORTCUTS 
File Menu Edit Menu 
New Folder 00-N Undo 00 -Z 
Open ~-0 Cut ~-X 

Close ~ -W Copy ~ -C 
Duplicate ~-D Paste 00 -V 

Select All ~-A 



Chapter 2 : Computer Concepts 35 

Chapter 2: Computer Cone pts 
I 

What You Will Learn in This Chapter 

After reading this chapter, you should be able to: 

• Understand some o f the concept s and termino logy appl icable to 
persona l computing 

• Name the two ma in ca tegories of software 

• Name the standard parts o f a compute r system 

• Name the most commo n peripherals attached to a computer 

I f you are new to computers, this section should help you understand 
some of the concepts and te rminology used in data processing. If you 
al ready have experience with com puters and are an xious to start 

working, you migh t wan t to skip the general discussion and go straight 
to Part II. 

A BRIEF OVERVIEW OF TERMS 

In persona l computing, as in all other technical areas, a standard 
term ino logy is used by the people working in that field. Sometimes the 
terms are used on ly in a pa rticular area. Other times, words take on a 
different meaning when they a re used as technical jargon from when 
they are used in ordinary con versa tion. The computer fie ld is filled with 
examples of these words and phrases. 

Some exa mples o f terms that have a d iffere nt mean ing when refe rring 
to computers and the use of computers are: bug (error), debug (find and 
correct erro rs), and bo mb o r crash (the program encounters a problem 
and stops working properly). This is only a small sample of a large group 
of such words. 

In addition to red efining some words, th e computer industry cons tan tl y 
uses acro nyms, such as ROM (read-on ly memory), RAM (random access 
memo ry), SCSI (small compute r system interface), GUI (graphical user 
interface), and WYSIWYG (what you see is what you get). 

Believe it o r not, a lmost all of the computer-related acronyms you will 
encounter are pronounceable, and in ordi nary speech those of us who 
use th is terminology pro nounce them; we do n't spell th em as you might 
expect. For example, RAM and Rb M are obviously pronounceable, SCSI 
is pronounced "scuzzy," GU I is "gooey," and WYSIWYG is spoken as 
"wissy-wig" o r "wizzy-wig." 
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You will encounter a number of these terms in any book that discusses 
computers. Many are defined and explained in the following sections of 
this chapter. 

PARTS OF A COMPUTER SYSTEM 

Software 

There a re three main components of a computer system: hardware, 
software, and people. 

You may be so new to using computers that you don ' t know how to turn 
one on, or you may have many years of experience with o ther computers. 
Either way, you are about to set out on a journey that will increase your 
knowledge of computers and enhance your skills in using them. 

Hardware and software are the te rms used for equipment and programs, 
respectively. Many people have a difficult time at first understanding 
what these terms mean. The hardware part is easy. If you can touch it, 
it's hardware. The equipment that makes up the system is the hardware. 

Softl.vare is a little more difficult to grasp because it is an abstraction. 
Information and methods for solving problems are known as software. 
When using a computer, you process data (or facts) to produce 
information. The methods for solving problems o r performing tasks are 
called algorithms. When you combine data and proper algorithms you 
produce a program. All o f these-data, informatio n, a lgorithms, and 
programs- are known as software. This is one of the reasons it can be a 
confusing term. However, most of the time software means a computer 
program. 

A computer program is a set of steps for the computer to follow to arrive 
at a particular goal. Part of these instructio ns allow the computer to 
interact with you- the user. Other instructio ns tell the computer to 
accept data, modify it, output it, and store it for further use. 

Usually, when someone refers to software, they mean a program, such 
as Microsoft Word or MacPaint. Since "software" and "program" are 
synonymous, it is redundant to call something a software program. 

Software is d ivided into two categories: systern so{tl.vare and application 
softl.vare. 
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Hardware 

System Software 

System software is a program that controls the interaction among 
different parts of the computer system or between the user and the 
system. It allows you to find information on the disk, make copies of it, 
and send it to the printer as well as many other tasks. The Finder is the 
system software on the Macintosh that allows you to control the system 
and the information it contain s. 

Application Software 

Application software is design ed to allow you to complete a task. If you 
want to write a letter or a book, you use a word processor, such as 
Microsoft Word. To produce a budget o r cash flow analysis, you use a 
spreadsheet, such as Excel. If you have a list of customer information, 
you store it using a database or file management program, such as 
FileMaker o r HyperCard. 

All of these are examples of applications. They are not designed to 
facilitate your interaction with the computer system; they are design ed 
to allow you to complete a task. 

Application software on the Macintosh is available fo r purchase from 
many third-party companies. This means that neither you nor Apple 
Computer produced this prograr;n. Tf you want to do the tasks a program 
allows, you can purchase the p~ogram from whomever produced it
Microsoft, Claris, Apple, and so on-and use it on your computer. 

The software tells the hardware how to do tasks. The hardware performs 
the operations and handles the flow of information. The hardware 
comprises a central processing unit, memory, storage, and input/output 
peripherals. 

Central Processing Unit 

The central processing unit, or CPU, is the part of the computer that 
processes information. This is the part of the computer that controls 
data flow and the interaction amon g other hardware compon ents. It 
performs arithmetic calculations and logical operations. 

The CPU accesses and controls the computer's memory and directs the 
fl ow of information into the system and out of it. The CPU performs the 
tasks that convert data into the information you need from the system. 

In a microcomputer, tjlis CPU is on a single microprocessor. You may have 
heard of a microprocessor being referred to as a "computer chip. " The 
MC68000 is the microprocessor, or brain, used in the first generation of 
Macintosh computers (128K, 512K, 512Ke, Plus, SE, and Classic) and the 
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Macintosh Portable. The "sixty-eight thousand" is produced by Motorola, 
and it and its descendants provide the computing power for the 
Macintosh line o f computers. 

The second generation of Macintosh computers (Mac II, Mac LC) uses 
a newer and more powerful processor-the MC68020. The "sixty-eight
oh-twenty" runs at a faster speed and processes information more 
quickly than the 68000. This in turn was followed by the MC68030, 
which is even more powerful and faster and is found in the Macintosh 
SE/30, llx, llcx, Ilci, Ilsi, and llfx computers. 

Newer and more powerful microprocessors are in the works (such as the 
MC68040), and Apple will undoubtedly introduce computers that use 
them as they become available. Change is inevitable in the world of 
computers. 

Memory 

Memory in a computer is a group of integrated circuits where information 
can be stored and from which the CPU can access and read this 
information. 

Thereareessentially twotypesofcomputermemory:ROMandRAM.ROM 
mean s read-only mem01y. This is a type of permanent storage. ROM retains 
its contents even when the power is removed from the system. However, 
it cannot be modified by a user. Once the info rmatio n is stored in ROM 
it stays there for the life of the chip. On the Macintosh, th e instructions 
that produce windows, pull-down menus, and other parts of the 
Macintosh user interface are stored mostly in ROM. 

The second type of memory is RAM, or random access memory. It is not 
truly random access; it is really direct access, but probably nobody 
wanted to call it DAM memory. (If computers really had random access 
memory, it would be quite a trick to get any work done.) 

Whatever the name, RAM is the changeable memory used to store the 
information the system is currently processing. This memory is temporary 
(or volatile) storage only. If the power to the computer goes out for a 
fraction of a second, this memory is erased. When you see the lights 
blink in a room where people are using computers, it is not uncommon 
to hear vario us socially unacceptable phrases uttered by users who have 
not recently saved their work onto disks. Any work done since the last 
time it was saved is usua lly lost. 
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(There is n simple way to protect yo Irs elf from losing your work whenlhe power 
goes out. A II you have to rio is save your work every ten or fifteen minutes. Get 
into the habit of doing this. fn fact, since many applications supp01t 
Comma nrl-5 as the equi vn lent of chaos i ng Save, many Mac users have len mer/ 
to type this command routinely as they work. You hardly ever hear this group 
groaning and moaning about losing n day's work when the power goes out!) 

Several arca ne-sounding term s are used to describe various amounts of 
memory. These terms apply to both ROM and RAM. 

You have probably hea rd of bits and bytes. Bit is the contraction for 
Binary digiT. Computers don't process English, or words or numbers as 
you are familiar with them. Everything the compute r does is in the form 
of a code. Many ingenious people have devised codes for all types of data 
sto rage and representatio n. 

All the computer knows is high voltage or low voltage, on or off, positive 
or negative. Each of these groups is composed of exactly two conditions. 
The computer works using binary numbers, which allow only the digits 
0 and 1. (This is also known as the base two number system.) For most 
purposes, one bit is not very useful, so eigh t bits are combined into a 
byte. 

A byte is the smallest unit of storage for most uses. For example, each of 
the le tters that compose thi s sentence is stored in the computer as one 
byte. Even th e blank spaces are stored as a single character in one byte 
of th e computer's memo ry. 

Often, you need to store more than a few bytes of information, so bytes 
are grouped into larger units. The next unit of storage commonly used 
is the kilobyte. This is not 1,000 bytes as you might expect; it is 1,024 
bytes. (1,024 is a round number in the base two number system: 
10000000000

2
, which is the binary representation for 2 raised to the 

lOth power.) You shou ld remember that kilo- (as in kilobyte) mea ns 
1,024, not 1,000, when referring to computer storage, even though you 
wi ll probably tend to think of it as roughly 1,000. 

The nex t unit ofstorage is the megabyte. This is approximately one million 
bytes (1,024 x 1,024 = 1,048,576) . Since humans can't easily remember 
these kinds of numbers, we don't like to be concerned with the extra 
48,000 bytes or so. Megabyte is easier to pronounce and remember, 
anyway. 

Input and Output 

If a computer is going to process information, there has to be some 
means for entering info rmatio n ,into the computer and getting it back. 

In formation is input into the computer (reading data) and is output from 
the compute r (writing data). 
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Many forms o f in put and output are available to computers, depend ing 
on wh ich periphera ls are attached to the computer. A peripheral is a device 
that is external to the CPU and that allows the computer to interact with 
the outside world or to store information for later retrieval. Peripherals 
may be mounted externa lly to the computer by mean s of cables or may 
be internally mounted inside the computer's case, where they are 
connected by cables o r by being plugged into expansion ports or expansion 
slots. 

Expansion slots are places where peripherals may be attached to the 
computer by plugging in additio nal electronic circuit boards, and these 
slots are located inside the computer's case. Expansion ports allow 
periphera ls to be attached by means of a cable and may be located 
internally or externall y. 

All microcompute rs have at least one main electronic circuit board. This 
board holds the microprocessor and other electronic components that 
make up the computer. TheSE and Mac II series of computers all have 
at least one expansion slot that allows the addition of other circuit 
boards designed for special purposes. For example, many Macintosh 
computers are now equipped with large monitors that are capable of 
displaying o ne, or even two, letter-size pages at actual size. These 
monito rs require a video carq that plugs into an expansio n slo t o n the 
com puter's main circuit board. 

The most common peripherals attached to a Macintosh computer are a 
mouse, keyboard, mo nitor, printer, modem, disk drive, and tape drive. 

Mouse 

A mouse is a hand-held device that slides on a desktop and allows you 
to control the position of a pointer o n the computer screen. The pointer 
ind icates where the next action wi ll take place if you click the mouse 
button. 

A mouse used with the Macintosh has only one button. When you press 
and release the button, it te lls the Macintosh that you want to do 
something at the position where the pointer is located on the screen. 

Most computer systems other than the Macintosh make the user 
inte ract mostly through the keyboard, and that can be very frustrating 
if you are not a touch typist. On the Macintosh, most of your interactio ns 
wi ll involve pointing at something and clicking the mouse button. 

Although the mouse is the most commo n poin ting device for the 
Macintosh, many people use alternate devices, such as trackballs, which 
consist of ba lls mounted in a stationary housing. Moving your hand 
over the ball causes the pointer to move in the same directio n. The 
Macintosh Portable has a trackball, and they are available for attachment 
to other Macs as well. 
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Keyboard 

The keyboard is used for entering text. Unless you are actually entering 
text, you don't need to use the keyboard at all. Some people prefer to 
keep their hands on the keyboard, so most Macintosh programs prov ide 
keyboard equivalents to using the mo use and pulling down menus. 
These keyboard equivalents are also known as Command-keyequivalellt5. 
They allow you to issue commands using the Command key. For 
example, Command-S o ften means Save. When a Command-key 
equivalent is available for a particular command, it is listed nex t to the 
command o n the right side of the menu. Other keyboard sho rtcuts and 
Command-key equivalents are listed in the manual fo r each program. 

Monitors 

A monitor is the TV screen used with a compute r. You also will hear this 
referred to as a CRT (cathode ray tube) or sometimes as a VDT (video 
display terminal). 

The monitor is the output device you will use the most when wo rking 
on a Macintosh. As you type, draw, paint, calculate, or compose pages, 
you will see the results of your actions on the mo nitor. 

This almost instantaneous feedback is what allows you to interact so 
intuitively with the Mac. As you do something with the mo use o r 
keyboard, it is shown o n the screen. As the computer perfo rms an 
operation, you can quickly see the results. 

Some models of the Macintosh o nly suppo rt black-and-white mo nito rs. 
All Macs in the o riginal-shaped case (128K, 512K, 512Ke, Plus, SE, SE/30, 
Mac Classic) and the Mac Portable come equipped with a built-in black
and-white monitor. TheSE, SE/30, and Portable also have slots o r po rts 
that make it easy to add other monitors that support color, or that can 
display a full letter-size page of text or mo re. 

The mod ula r Macintosh computers (II, llx, llcx, Ilci, ll fx, LC, Ilsi) do no t 
come bundled with a monito r. You can choose to add a black-and-white 
or a color monitor. In fact, if you can affo rd it, you can add both, o r even 
severa l of them in any combinatio n to all of these models but th e LC and 
llsi. Drawbacks to adding extra monitors, ho wever, include the amount 
o f extra RAM required to use them and the delay caused by updating 
more than o ne screen . 

The standard Macintosh screen has a resolutio n of 72 dots per inch. Dots 
per inch (dpi) refers to the numb~of dots that are displayed horizontally 
and vertically by the screen in o e inch . As this number (5,184 dots per 
square inch) increases, so does t e resolut ion o f the device. Resolution is 
a measure of how well a device cbn produce an image. Higher resolution 
produces clearer images. (The Mac screen , at 72 dpi, has a resolution o f 
5,184 do ts per square inch; a LaserWriter, at 300 dpi, has a resolution o f 
90,000 dots per square inch. The number o f ho rizontal and vertical dots 
per inch is a little over 4 times greater, and the resolutio n improves by 
a facto r of a little more than 16.) 
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Each dot on the screen is known as a pixel (picture element) and is used 
to represent the info rmation you see. The Macintosh screen uses square 
pixels so that when a circle or square is d rawn on the screen, that is what 
you see. Ma ny o ther computers use rectangular pixels that are taller 
than they are wide, because they were designed for use with text rather 
than graphics. 

Printers 

When you have in formation that you want to preserve or send to 
someone, you can print it on paper. This is known as hard copy. Soft copy 
is what you see on the screen. It is called soft because it is changeable and 
transitory. 

There are many types of printers. On the Macintosh, you are mostly 
concerned with two types of printers: ImageWriters and LaserWriters. 

The ImageWriteris a dot-matrix printercapable of printing text and graphics 
at a resolution of 72 or 144 dpi, depending upon whether you choose 
faster or betterqualitywhen you print. Faster printing uses lower resolution. 
Better uses high er resolution but prints much slower. 

The LaserWriter was a dramatic development in printer technology 
when it was introduced. It offered, and continues to offer, much higher 
resolution than any dot-matrix printer and its output is often referred 
to as near-typeset quality. The Laser Writer prints 300 dots per inch and 
supports the PostScript page description language, which is a programming 
language designed to facilitate graph ics printing and provide sm ooth 
outline fonts. (This includes text, since the characters printed by 
PostScript are mathematical descriptions of the shapes used to represent 
those characters.) 

LaserWriters come equipped with a set of built-in, high-quality fonts. 
The Laser Writer Plus, liNT, Personal liNT, IINTX, and Personal IINTX all 
come with 11 fonts in 35 typefaces. If the font you want to use is not 
included in this selection, you can download others from your computer. 
The Laser Writer liNT and IINTX can use more additional, downloadable 
fonts due to their increased RAM. The Laser Writer IINTX also offers the 
option of attaching a hard disk to the printer so that additional fonts will 
be readily accessible to the printer. 

Modems 

Modems are devices that allow computers to commun icate with each 
other over the phone lines . The speed of this communication is 
increasing. The standard communication speed was 300 baud (about 30 
characters per second) just a few years ago. Then it wen t to 1200 baud, 
and now many people are using 2400, 4800, and 9600 baud over no rmal 
phone lines. 
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If you have a computer, a mode , and communica tion software, you 
ca n access othe r computers arour d the world.ln computer-to-compute r 
communication , both users have to have a modem and communication 
software, but you d on 't have to have the same type of computer. In fact, 
dissimilar computers, such as IBM PCs and Macs, can communicate 
using mod ems. Man y people a re usi ng their computers and modems to 
transmit a nd receive electronic mail. 

Storage 

Because RAM is temporary memo ry, you must have some other way to 
retain info rmatio n after you turn off the computer. For this p urpose you 
generally use some type of magnetic mass storage such as disks or tapes. 

On the Macintosh, hard disk drives are the primary form of data storage 
because o f th eir ability to hold large amounts of information. You 
should keep a copy of what is o n you r hard disk, and backing up the 
info rm ation to floppy di sks is very popular because every Macintosh has 
at least one floppy disk drive. Tape drives, however, are becomin g mo re 
widely available and are increasingly popular because they ho ld so 
much mo re information than floppy disks, and backing up using a tape 
drive is much faster and easier. 

Most info rmation is distributed on 3.5-inch floppy disks in the Macin tosh 
world . These disks are not really floppy, because they are enclosed in a 
ha rd p las ti c case. Most people just refer to them as disks. 

Disks are called permanent, o r nonvolatile, sto rage. However, do not 
make the mistake o f thinking that once you have stored your data on a 
d isk th at it will be available forever. Although the in formation on a disk 
is no nvo latile, the disk itself has an unpredictable lifetime. Disk 
techno logy, in its simplest terms, is a meth od of storing information 
magnetically on to very small metallic particles glued to plastic (disks) or 
a luminum (hard disks). An yth ing that damages the surface of the disk 
wi ll ca use you to lose any informatio n that might be sto red there, and 
it can even cause you to lose all of the informatio n on that disk. 

Fo r th is reason, it is standard p ractice to m akebackupsofyour information. 
You ca n copy a document on to two or more disks. If one of them goes 
bad, you can use the other backup copy. If you do not have a backup 
copy, you will probably lose wha tever information was stored o n that 
disk. 

The n u mber of backups you make, and the frequency with which you 
make them, depe nds on how valuable the in format ion is and how 
d ifficult it would be to recover o r reproduce. Accounting info rmation o r 
important strategic plann ing documents for a who le company should 
be backed up frequen tly. 
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SUMMARY 

• A computer system is composed of memory (ROM and RAM), a central processing unit (CPU), 
input and output devices, storage devices, and other attached peripherals. 

• Computer systems can be divided into two major categories: software and hardware. 

• There are two types of software: system software and application software. System software 
allows various parts of the computer system to interact . Application software is used to solve 
a problem or perform a task, such as writing a letter or planning a budget. 

• Common peripherals attached to a Macintosh computer include a mouse, keyboard, 
monitor, printer, modem, and storage devices such as disk and tape drives. 

• Two main types of printers are most commonly used on microcomputer systems: dot-matrix 
and laser. Dot-matrix printers have the advantages of being able to produce multiple copies 
on multipart forms, many can print in color, and they can print on continuous fo rms such 
as computer paper, mailing labels, 3x5 ca rds, and pre-printed checks. Laser printers have the 
advantages of being faster, q uieter, and producing better quality output, but they accept only 
cut-sheet paper and cannot print on multipart forms. 

• Most computer information is stored on hard disks. Since the life of a disk is indeterminate, 
data is backed up on floppy disks and/or tape cartridges. Floppy disks have the adva ntage of 
being available on all computer systems, but backing up large quantities of data is a slow, 
boring process wh en using th em. Tape drives are optional and cost more, but they have the 
advantage of being faster and easier to use, and a cartridge stores much more information 
than a floppy disk. 

KEY TERMS 

algorithms 
application software 

backup 
baud 
bit 
byte 

cable 
Command-key equivalent 
CPU (central processing unit) 
CRT (cathode ray tube) 

dot-matrix printer 
dpi (dots per inch) 

electronic circuit board 
expansion port 
expansion slot 

Finder 
floppy disk 
hard copy 
hard d isk drive 
hardware 

input 
Image Writer 

keyboard 
kilobyte 

Laser Writer 

megabyte 
memory 
microprocessor 
modem 
monitor (also called CRT or VDT) 
mouse 
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output 

pe ripheral 
pixel 
pointer 
PostScript 
printer 
program 

RAM (rando m access memory) 
resolution 
ROM (read-o nl y memory) 

soft copy 
software 
system software 

tape drive 
trackball 

VDT (video display terminal) 
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Part II: Graphics 

P art II introduces Macintosh graphics. 

Chapter 3 presents the basic concepts of graphics applications. 

Chapter 4 introduces you to usmg MacPaint. MacPaint was the first 
graphics application created for the Macintosh, and it is both fun and 
easy to use. You will create some drawings of your own in this chapter 
and copy some existing MacPaint artwork into your drawing. 

Chapter 5 teaches you how to use MacDraw II. MacDraw II's ease of use 
and high quality output make it one of the most popular drawing 
programs for the Macintosh. You will create drawings using some of 
MacDraw II's text and layout CaJ?abilities. 
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Chapter 3: Graphics Concepts 

What You Will Learn in This Chapter 

After readi ng th is chapter, you shou ld be able to: 

• See that there is a familiar drawing environ ment used in a 
graphics applicatio n 

• List some uses fo r computer graphics 

• Understa nd the differences be tween bitmapped and ob ject
oriented graphics 

M 
ost people don 't associate fun with a computer, but d rawing 
with a graphics application is just that-fun. The combination 
of using the mouse, the Macintosh 's screen resolutio n, its 

graphical user interface, and the Laser Writer creates an environment of 
easy-to-use, h igh-quali ty gra ph ics. 

just how do you go about drawin g with a computer? Graphics 
applications make it easy by providing a familiar en viro nment-your 
screen acts as the paper, and you have available the various tools you 
would need for any drawing, such as pencils and paint brushes. You can 
draw lines and shapes, even perfectly straight lines and perfect circles 
and squares, without having any specia l skills. You can paint lines and 
fill shapes using an array of pat terns. Not o nly can you d raw ob jects in 
varying shapes and sizes, but yo u can erase, move, duplicate, flip, invert, 
rotate, sh rink, and stretch your creatio ns. Once you have created your 
masterpieces, you can save them and copy them into other drawings 
and other types of documents. 

There are endless usesforcomputer graphics. You can create noteworthy 
greeting cards, an nouncements, inv itations, signs, posters, and 
letterheads. You can illustrate term papers and reports, create logos, and 
design floor plans. You can create decorative mailing labels and 
illustrated newsletters. Graphics can also make a business presentation 
impressive. Your imagination is all that limits your uses of a graphics 
application . 

If you don' t have the inte rest or the talent to crea te freeh and drawings, 
you can use some of th e th ousands o f drawings ava ilable fro m firm 
whose artists produce some useful libraries of clip art. There are a lso 
public domain drawings available from users groups and public domain 
libraries. Creativity and drawing ability are not prerequ isites for using 
and en joying a graphics application. 
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BITMAPPED GRAPHICS 

There are basically two types of graphics applications: paint (bitmapped) 
programs and draw (object-oriented) programs. · 

Painted, o r bitmapped, shapes are a collection of dots. Drawing with a 
painting program consists of turning on or off a series of dots on the 
screen . If the dot is on, it is black; if the dot is off, it is white. 

To modify a shape created in a paint program, you must turn off, or 
"erase," the dots from the part oft he shape that you wantto modify. The 
concepts of painting with a program such as this are relatively easy to 
understand, and even beginners can quickly master bitmapped drawing 
techniques. 

A dot is also called a pixel, for "picture element." A pixel is stored 
internally as a bit, and a map of these bits and their on or off status is 
stored for each drawing, hence the term "bitmapped." 

The Macintosh screen displays 72 dots per inch, measured both 
horizon tally and vertically, giving each square inch 5,184 dots that can 
each be either on or off. Paint programs such as MacPaint use each of 
these pixels to compose the drawing page. 

The main drawback of paint programs is the resulting jagged lines and 
edges of some of the objects when they are printed. This is often referred 
to as the jaggies. Figure 3-1 illustrates the difference between the output 
of a bitmapped drawing and that of an object-oriented drawing. Notice 
the jagged curves of the bitmapped drawing on the left. 

bilmapped drawing object-oriented drawing 

Figure 3-1 Comparison of bitmapped and ob ject-oriented output 
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There are many excellent paint programs on the market, some of which 
arc more sop hi sti cated that others. MacPaint, Ful!Paint, DeskPaint, 
Stud io/1, Studio/8, Pi xel Paint, and SuperPaint are all paint programs of 
varying degrees of sophistication and difficulty. Studio/8, DeskPaint, 
Pixel Paint, and Supe rPai nt support color. SuperPain t uses two layers to 
allow you to paint bitmapped objects on one layer and object-oriented 
objects on the other. 

The bitmapped paint program you' ll be using in Chapter 4 is MacPaint. 

OBJECT-ORIENTED GRAPHICS 

In an object-oriented drawing program, each object in the drawing is 
stored as mathematical information in the computer rather than as a 
collection of dots. 

In an ob ject-ori en ted drawing you can move one item on top of the 
other and the "foreground" item does not "erase" the item it obscures, 
li ke it would in a bitmapped program. You also use a different technique 
to edit object-oriented images. Objects cannot be edited dot-by-dot as 
bitmapped images can. Modifying an object-oriented item is easier, 
since you can resize an item and change its fill pattern, line pattern, and 
thickness without red rawing it. 

Using an object-o riented program is different from using a bitmapped 
program, and object-oriented programs are generally more soph isticated. 
Also, the output of object-oriented graphics programs is gene rally 
superior to that of bi tmapped programs. This is because object-oriented 
drawing programs use the att ributes of each ob ject to create an image 
that contains as many dots per inch as the printer can produce. 
Therefore, images to be printed on the LaserWriter will be converted to 
300 dots per inch before they are printed. 

MacOraw II, SuperPaint, and OeskDraw are examples of object-oriented 
drawing programs. There are also some soph isticated 3D drawing 
programs available, such as Pro 30. Two professional level drawing 
programs for technical illustrators and artists are Aldus Freehand and 
Adobe Illustrator. While technically object-oriented, these programs 
create graphics using the PostScript printer description language and 
work o nly with PostScript printers, such as the Apple LaserWriter. In 
PostScript graph ics, the description of each drawing element is stored in 
PostScript, which is the same language that a PostScript printer uses. 

You'll be exploring some of the many object-oriented features of 
MacDraw II in Chapter 5 . 



Chapter 3: Graphics Concepts 51 

SUMMARY 
• The mouse, the Macintosh's screen resolution and its graphical user interface, and the 

LaserWriter have created an environment of easy-to-use and high-quality graphics. 

• Graphics applications provide a familiar drawing environment. Your screen acts as the paper 
or canvas and you have available the various tools you would need for any drawing, such as 
pencils and paint brushes. 

• Drawings created in a graphics application can be saved and copied into other drawings and 
into other types of documents. 

• There are many uses for computer graphics . You can create greeting cards, announcements, 
invitations, signs, posters, logos, and letterheads. You can illustrate term papers and reports, 
design floor plans, and incorporate graphics into business presentations. Your imagination 
is all that limits your uses of a graphics application. 

• There are basically two types of graphics applications: paint (bitmapped) programs and draw 
(object-oriented) programs. 

• Bitmapped shapes are drawn by turning on or off a series of dots on the screen. If the dot is 
on, it is black; if the dot is off, it is white. To modify a shape created in a bitmapped graphics 
program, you must turn off, or "erase," the dots from the part of the shape that you want to 
modify. 

• In an object-oriented drawing program each object in the drawing is stored as mathematical 
information in the computer rather than as a collection of dots. It is easier to modify an 
object-oriented item, since you can resize an item and change its fill pattern without 
redrawing it. 

• The output of an object-oriented graphics application is usually superior to that of a 
bitmapped application. 

KEY TERMS 
bitmapped 

jaggies 

object-oriented 

pixel 
PostScript 
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Chapter 4: MacPaint 2.0 

What You Will Learn in This Chapter 

After reading this chapter and completing the projects in it, you should 
be able to: 

• Position tear-off menus on the drawing window 

• Select, move, and duplicate objects 

• Use the Shift key for horizontal and vertical constraints 

• Change line weights with the border palette 

• Draw objects filled with a selected pattern 

• Draw lines and unfilled ovals, circles, and rectangles 

• Use Zoom In and Zoom Out for detailed drawing 

• Position the drawing using the grabber tool and the scroll bars 

• Use different brush shapes and patterns 

• Copy drawings to the Clipboard 

• Paste drawings into a document from the Clipboard 

• Use the Flip Horizontal and Rotate commands 

• Fill objects using the paint bucket tool 

• Add text to a drawing using the text tool 

• Save and print documents 

M acPaint was one of the first two application s available on the 
Macintosh, and it set the standard for bitmapped graphics on 
this computer. These standards are still in effect today, which 

means users can transfer graphic images fo r most applications to almost 
every other application. 

Imagine drawing a picture using only the keys on a typewriter and no 
other tools. Producing gra phics on a computer prio r to the introduction 
of the microcomputer just ten years ago was essentia lly like producing 
pictures on a typewriter. Using this method of character-based graphics, 
your picture was formed with whatever characters were available. 
MacPaint is a good example of just how fa r we've progressed in the field 
of computer graphics in the last decade or so. 

Instead of trying to paint a picture with a typewriter, wouldn ' t it be 
easier to use tools you' re already familiar with? Most people started their 
a rtistic endeavors using crayons, and when they learned to stay inside 
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the lines they progressed to colo ed pencil s, watercolor sets, charcoal, or 
pen and in k. With each new tool that was adopted, they were able to 
overlay new ski lls on top of the skills that were developed using crayons. 

MacPa in t allows you to take skills you've al ready developed and apply 
them to computer graphics. MacPaint provides tools that you are 
familiar with , such as pencils, brushes, erasers, and spray cans, and 
introduces new tools such as those for producing geometric shapes and 
stra ight lines. 

Remember as a child when you watched your favorite cartoon character 
on TV and you were amazed and entertained when he or she threw a 
bucket of plaid paint on a wall? You knew, even as a chi ld, that this 
cou ld n't be done in the real world. However, using a Macintosh and 
Mac Paint, if you want to throw a bucket of pla id painton a wall, you can. 

MacPaint 2.0 is the second generation of this program and has all the 
original featu res as well as some very inte resting new abilities. This 
chapter will start you on your journey to discovering the fascinating 
capabili ties of MacPaint. 

STARTING MACPAINT 

MacPaint 2 .0 

GETTING HELP 

• Double-click on the MacPaint 2.0 icon to open a new, unti tled 
drawing window. 

Every new document has the title "'Untitled-1' at lOOo/o" until you save 
it for the first time and give it a name. 

The drawing window shows only a part of the 8- by 10-inch a rea 
available for drawing. 

A menu bar runs across t he top of the screen: 

,.. • File Edit Goodies Font Style Pa ttern s Tools 

You' ll learn about each menu as you get to it. 

Many applications provide online help for quick refe rence when you are 
using different tools and com mhnds. Unfortuna tely, MacPaint is not 
one of these programs. The rkference manual you get when you 
purchase MacPaint is very conprehensive, however, and includes a 
tutoria l as well as detailed descriptions of the features of each tool and 
command. 
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SAVING YOUR WORK 
The first time you save your document, MacPaint asks you, by way of the 
dialog box shown in Figure 4-1, where you wa nt your document saved 
and what you wa nt it to be named. After you have saved it the first time, 
the next time you choose Save, MacPaint assumes you want the 
document to be saved in the same place and under the same name. Be 
ca refu l about saving your document in the correct place the first time 
you save it so you can find it later. The save process is much quicker the 
second and subsequent times, because you are not prompted fo r any 
additional information. 

Unfortunately, sometimes people are not careful, and they occasionally 
lose their work because they save it but do not think about where they 
are saving it and then can't find it aga in. Clicking the Drive button (see 
Figure 4-1) toggles between one or more flo ppy drives and hard drives, 
depending on the hardwa re you are using. The Save dialog box shows 
the name of the floppy disk or hard drive as that drive is selected. You 
are saving your document o n the selected disk or hard drive with the 
name showing in the Save dialog box. In the dialog box shown in Figure 
4-1, the name ofthedisk, Connie Barlow, is shown in two places. Always 
be aware of where you are saving your work. 

The Save As command is similar to the Save command, except that it 
enables you to give your document a d ifferent name and save it in a 
different location. Every time you choose Save As from the Fi le menu, 
you a re prompted with the dialog box shown in Figure 4-1. This is the 
same dialog box you see the first time you save your document. 

When you use the Save As command and you attempt to save the 
document with the same name and in the sa me location as before, you 
will be asked if you want to replace the old document. Th is is because 
no two files in a particular location can have the same name. If you want 
to save different versions of the same document, use the Save As 
command and give the document a different name and/or location. 

Save your work often-at least every ten minutes, so you never lose more 
than ten minutes of work. The Command-key equivalent of the Save 
command, Command-S, is a helpful shortcut. Always save your work 
before printing. 

I jg) Connie Borlow I 

Saue Point document as: 

@ MocPoint 

Document format: 

0 Stationery 0 Startup screen 

Figure 4-1 The Save dialog box 
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Be aware that you can save a document before you actually type 
anyth ing into it, and that many people do it this way. However, you will 
be given explicit instructions for saving your work at appropriate times 
throughout the projects in this chapter. 

USING MACPAINT'S TOOLS 

II II 

"• Click Tools in the menu bar. 

This shows you the toolbox. The toolbox is what is referred to as a tear
off menu. It can be placed and moved to wherever it is most accessible 
on the screen. Placing the toolbox on the screen gives you faster access 
to the different tools and allows you to see at a glance which tool is 
selected. You can move the toolbox to a different place on your screen 
if it gets in your way. 

To tear off the toolbox, click and drag downward until the cursor goes 
past its bottom edge. When you do this, the outline of the toolbox 
follows the cursor around on the screen, as shown in Figure 4-2. 
Wherever you stop and release the mouse button, the toolbox will 
remain. The patterns palette is also a tear-off menu. 

,.. Tear the toolbox off the menu bar and position it in the bottom right 
portion of the screen, as shown in Figu re 4-2. 
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Figure 4-2 The Tools menu is a tear-off menu. 

Now that you've got the Tools menu positioned, you'll learn how each 
tool works, and you'll get practice working with each one before you 
start the actual project. 
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Drawing Lines 

Using the Eraser 

CAUTION 

Drawing Shapes 

Part II: Graphics 

The pencil is the tool that is automatically selected when you open a new, 
untitled drawing window. It is used to draw a one-pixel-wide li ne. You 
can tell it is selected because it is highlighted. When the pencil is selected, 
the pointer becomes a pencil when positioned over the drawing area. 

• Hold down the mouse button while you drag the pencil across the 
drawing window in the direction you wa nt to d raw. Release the 
mouse button when the line is the length you want it to be. 

The pencil tool draws a freehand line. The line you d raw will be crooked, 
but you get the idea of how the pencil works. Draw a few li nes with the 
pencil to get the feel of it. 

The line tool is used to draw straight lines. When the line tool is selected , 
the pointer becomes a cross-beam(+) . As you draw a li ne you can control 
the length of the line and its posi tion on the screen. When the line is 
positioned and sized like you want then you release the mouse button. 

• Select the line tool by clicking on it in the toolbox. 

• Hold the mouse button down while you drag the pointer across the 
drawing window, and release the mouse button when the line is the 
desired length and angle. 

Practice drawing a few more lines with th is tool. 

Now is a good time to learn how the eraser tool works, because you can 
use it to clear the screen of the lines you just drew. When you select the 
eraser by clicking on it, the pointer becomes a small square. To erase, 
hold down the mouse button while dragging across the object you want 
to erase. 

Caution: double-clicking on the eraser in the toolbox erases the entire 
screen. This is a great shortcut if you want to clear your screen. Be sure 
to click only on ce on the eraser to select it when you don't want to erase 
the whole screen. 

• To get rid of the lines you practiced drawing, double-cli ck on the 
eraser tool to clear the whole screen, or drag the eraser across the 
lines to erase them. 

MacPaint provides several tools for easi ly d rawi ng a variety of shapes. 
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Rectangles and Squares 

Unfilled and filled rectangles and unfilled and filled rounded rectangles 
allow you to draw rectangles and squares. The unfilled rectangle draws 
hollow rectangles and squares, and the filled rectangle draws rectangles 
and squares that are filled with the currently selected pattern in the 
Patterns menu. The rounded rectangles work the same way, except that 
they have rounded corners. The pointer becomes a cross-beam when 
you select any of these shapes. 

• Click on the unfilled rectangle tool in the toolbox to select it, and 
then place the cursor in the upper left corner of the screen. 

.. Hold down the mouse button and drag diagonally to the bottom 
center of the screen, and then release the mouse button. 

You use the filled rectangle tools in the same manner. 

• To change the currently selected pattern, choose Patterns from the 
menu bar, and drag down to the pattern on the palette that you want 
to use. Release the mouse button while the pointer is on the desired 
pattern. 

If you choose Patterns again from the menu bar, you'll see that the 
wider box on the left side of the first row reflects the currently selected 
pattern, as shown in Figure 4-3. 

Figure 4-3 The currently selected pattern in the Patterns menu 

• Click on the filled rounded rectangle, and draw a rectangle in the 
same manner as you did the hollow rectangle. It is filled with the 
pattern that you select or with the default pattern. 

To draw a perfect square, hold down the Shift key while using the 
rectangle tools. 

• Draw a few filled and unfilled squares, rectangles, rounded squares, 
and rounded rectangles for practice, and then clear the screen with 
the eraser tool when you're leady to go on. 
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Ovals and Circles 

The unfilled and fill ed ovals are used to draw ovals and circles. The 
unfilled oval draws hollow ova ls and circles, and the filled oval draws 
ovals and circles that a re fill ed with the selected pattern. The pointer 
becomes a cross-beam when you select either of these shapes. 

• Click on the filled oval tool in the toolbox to select it, select a pattern 
from the Patterns menu, and then place the pointer in the center o f 
the screen. 

• Hold down the mouse button and drag diagonally to create an oval. 
Release the mouse button when the oval is the shape and size you 
want. 

To draw a perfect circle, ho ld down the Shift key when using either of 
the oval tools. 

• Draw severa l circles and ova ls using both o f these tools, and then use 
the e raser to clear the screen when you are ready to go on. 

Freehand Shapes 

The unfilled and fill ed {reella11d tools allow you to draw curved irregular 
freehand shapes, e ither filled with the currently selected pattern or 
hollow. The pointer becomes a cross-beam when you select e ither of 
these tools. 

- Click on the fill ed freehand tool in the toolbox to select it, and then 
hold down the mo use button while you drag the pointer to create 
the shape of a banana o n the screen. Release the mouse button 
when the lines are connected to close the shape. 

Polygons 

The unfilled and fi lled polygon tools allow you to create angular shapes 
consisting of different angles and short connected lines, such as L-shapes 
and stars, either filled with the currently selected pattern or hollow. 
When you select either of these too ls the poin ter becomes a cross-beam. 

• Select the unfilled polygon tool from the toolbox, and click once on 
the screen to create a starting point for your polygo n. 

• Move the pointer about o ne inch to the right, and th en cl ick again 
to a11chor that line. 

.. Move the pointe r in a different directio n this time, and click again 
to anchor th e new line, as shown in Figure 4-4. 
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Figure 4-4 Shapes drawn with the freehand and polygon tools 
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• When you've drawn all the angles and lines that you'd like in this 
polygon, double-click on the screen where the last line should end 
to finish the polygon and release the polygon tool. 

When you've finished practicing with these tools, use the eraser to clear 
the screen. 

The spray can tool is used to spray a "mist" of the currently selected 
pattern onto the drawing area. You can make the mist more dense by 
moving the pointer repeatedly over the same area. The pointer changes 
to a series of small dots when this tool is selected. 

• Click on the spray can in the toolbox to select it, and then move the 
pointer into the drawing window. 

.. Hold down the mouse button and drag the pointer across the screen, 
moving the mouse in a side-to-side motion. Release the mouse 
button when you've painted the desired area. 

When you've finished experimenting with this tool, double-click on t he 
eraser tool to clear the screen. 

The paint brush too/lets you paint brush-st rokes of the selected pattern. 
There are many brush shapes available. You access them by double
clicking on the paint brush tool. The pointer changes to the currently 
selected brush shape when this tool is selected. 

,,. Double-click on the paint rush tool in the toolbox to display the 
selection of brush shapes a ailable. 

.. Click once on any of the brush shapes to select it, and then position 
the pointer in the drawing window. 
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• Try writing your first name by holding down the mouse button and 
dragging the pointer around in the drawing window. 

• Practice with the paint brush using different patterns and brush 
shapes. When you are finished, clear the screen by double-clicking 
on the eraser. 

Using Different Line Weights 

Entering Text 

The border palette is used to change the weight of a line. It affects the 
thickness of the lines that you draw with the line tool and the borders 
of any of the shapes. When you click on one of the line weights in the 
border palette, the cross-beam indicator on the left of the border palette 
reflects the currently selected horizontal and vertical weights of the line. 
The position of the small triangle above the line controls the vertical line 
weight, and the position of the triangle below the line controls the 
horizontal line weight, as shown in Figure 4-S. 

Figure 4-5 Different horizontal and vertical line weights 

The text tool allows you to add text to a drawing. The text characters are 
created in the type style, or font, that is selected from the Font menu. 
The options in the Style menu also apply to the text you type. When you 
select the text tool, the pointer changes to an !-beam. 

,,. Click on the text tool to select it, and then move the pointer into the 
drawing window. 

,,. Click in the center of the drawing window to set the insertion point. 

The insertion point is where the text will begin on the screen, and it is 
represented by a small, blinking vertical line. 

• Choose a fo nt of your choice from the Font menu by dragging to a 
font name and releasing the mouse button. 

• Choose one of the larger font sizes from the Style menu by dragging 
to a size and releasing the mouse button . 

Font sizes are shown in points. Since there are 72 points, or dots, per inch 
on the Macintosh screen, a 72-point character is 1 inch high, and 36-
point type is 1/z inch high. 

• Type your name. If you make an error, press the Backspace key 
(Delete key on some keyboards) to delete the incorrect characters 
and then retype . To go to another line, press the Return key. 
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MacPaint's text capabilities are ~ery limited. As long as you do not click 
the mouse button to reset the msertion point, you can backspace to 
delete and correct mistakes. Once you have moved on to another tool 
or have clicked elsewhere on the screen, you can no longer use the 
Backspace key to delete characters-at that point you must retype. 

In MacPaint, as in most Macintosh applications, you have to point out 
an object that you want to do something with, and then you either issue 
a command or take some action with the mouse. You select something 
as a means of pointing it out. For example, to copy an object you select 
it first, and then you choose Copy from the Edit menu. If you didn't 
select the object first, MacPaint would not know what you wanted to 
copy. 

Two tools are used to select objects in MacPaint: the selection rectangle 
and the lasso. 

Selection Rectangle 

To use the selection rectangle, also called the selection marquee, you click 
and drag through an object in a diagonal manner to encompass the 
selection with a dotted rectangle. The border of the rectangle surrounding 
the object will look animated-the effect has been described as looking 
like marching ants. The pointer changes to a dotted cross-beam when 
this tool is selected (see Figure 4-6). 

,,. Click on the selection rectangle in the toolbox to select it. 

• Beginning slightly above and to the left of the name you just typed, 
click and drag diagonally to slightly below and to the right of your 
name, and then release the mouse button. See Figure 4-6. 
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Figure 4-6 Selecting with the selection rectangle 
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Your name and the white space around it within the dotted rectangle are 
now selected. 

• Now that the object is selected you can click within the border of the 
dotted rectangle and drag to reposition your name on the screen. 

To deselect a selected ob ject, click somewhere on the screen (outside the 
selected area) or click on a tool in the toolbox. 

• Click somewhere outside the selected area to deselect your name. 

You can also select the entire contents of your window by double
clicking the selection rectangle in the toolbox. 

Lasso 

The other tool used for selecting objects is the lasso. The poin ter changes 
to a lasso when this tool is selected (see Figure 4-7). 

The difference between the selection rectangle and the lasso is that the 
selection rectangle also selects all the area inside the rectangle, including 
the white space surrounding an ob ject, whereas the lasso shrinks to the 
exact size of the ob ject and selects only the object. 

• Click on the lasso in the toolbox to select it. 

• While holding down the mouse button, move the lasso around your 
name on the screen. The line it creates must completely encircle the 
object you are selecting and must not cut into the object. 

When you release the mouse button, the name you selected looks 
animated, as shown in Figure 4-7. 
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Figure 4-7 Selecting with the lasso 
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Clicking elsewhere on the screen or in the toolbox will deselect anything 
that you select with the lasso. 

• Without pressing the mouse button, position the pointer on the 
selected name until the pointer changes from a lasso to an arrow. 

If you click wh ile the pointer is not an arrow, it will deselect the 
selected object. You will need to encircle the object with the lasso again 
to select it. 

,,. Once the pointer changes to an arrow, click and drag to reposition 
your name on the screen, and then click somewhere else on the 
screen to deselect your name. 

Whether you use the selection rectangle or the lasso to select ob jects 
depends on whether you want the area surrounding the object selected 
also. The selection rectangle is easier to use, but sometimes you will 
need the precision afforded by the lasso. 

The Grabber 

The grabber tool is not rea lly used for selecting, but it is used to drag a 
portion of the window into view. The pointer changes to a hand when 
this tool is selected. 

• Click on the grabber in the toolbox to select it. 

• Position the hand on the screen, and then click and drag to shift the 
position of the page on the screen. 

Filling an ob ject with a pattern involves using the Patterns menu and 
the paint bucket. The Patterns menu is used to select the pattern that 
you want to fill the object with. 

Patterns Menu 

The Patterns menu is a tear-off menu like the toolbox. You can position 
it anywhere on your screen so you can easily access any of the patterns 
it contains. The currently selected pattern is shown in the wide box in 
the upper left portion of the Patterns menu. You click on a pattern to 
make it the currently selected pattern. 

.. Choose Patterns from the menu bar and select a pattern of your 
choice by dragging to a pattern and releasing the mouse button 
when the pointer is on the pattern you want. 
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Paint Bucket 

The paint bucket is used to fill a hollow shape with a pattern. You select 
the paint bucket and move it so that the drip of the paint bucket is inside 
the shape to be filled with the selected pattern; then you click once 
to fill the shape. Be sure there are no leaks, or gaps in the border of 
the shape you are filling, or the paint will "spill out" and fill the 
background area. 

• Click on the unfilled rectangle tool to select that tool, and then draw 
a hollow rectangle about the size of a matchbox somewhere on the 
screen. 

• Click on the paint bucket in the toolbox, and, without holding 
down the mouse button, position the drip of the paint bucket inside 
the rectangle. Click the mouse button once. 

This fills your shape with the selected pattern. Use the eraser to clear the 
screen when you've finished experimenting with this tool. 

Project 1: Creating a Flyer 

This project teaches you how to use MacPaint to create a flyer advertising 
a yard sale. You'll use most of the tools in MacPaint's toolbox to 
create the different shapes and pictures, and you'll use the text tool 
to create the body of the yard sale flyer. The completed project is shown 
in Figure 4-8. 



Chapter 4: MacPaint 2.0 

r-, 

I 
-

I 

Trash and Treasure 
Yard Sale 

4712 Blount Ave . N.W. 
(5th house on right) 

Friday - Saturday - Sunday 
Apri 1 7 } 8 } 9 from 9:00- 5 :00 

Rain or Shine!!! 

db~ 
'tW ~ 

Figure 4-8 fi nal output of Project 1 
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You' ll begin the project by drawing the garbage can in the upper left 
corner of the flyer. 

• Select the line tool by clicking on it. 

To draw the sides oft he garbage can, you'll draw one line and then you'll 
select it, duplicate it, and fli p it horizontally. 

• Beginning in the upper left corner of the screen, click and drag 
the pointer down, angling slightly to the right, to create a line about 
2 1/z inches long, as shown in Figure 4-9. 
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Figure 4-9 Drawing the first line 

• Next, select the selection rectangle by clicking on it. 

• Place the pointer just above and to the left of the line you just drew 
and, while holding down the mouse button, drag to the bottom 
right of the line so that a dotted rectangle completely encompasses 
the line. See Figure 4-10. 
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Figure 4-10 Using the selection rectangle 

Now the line you drew is selected. 



Chapter 4: MacPaint 2.0 67 

If you press the Backspace key 1 choose Clear or Cut from the Edit 
menu) while an object is selected, you erase that object from the 
drawing. 

DUPLICATING OBJECTS 

Now you'll duplicate the line you just selected. 

There are a couple of ways to duplicate objects .in MacPaint. In each case, 
the object you want to duplicate must be selected first. 

3€: -C One way to duplicate an object is to choose Copy from the Edit menu. 
This copies it to the Clipboard, which is an area in memory that contains 
the most recently copied or cut item. After copying an object to the 
Clipboard, you click in your drawing wi ndow where you want the 

3€: -V duplicate to be placed, and then you choose Paste from the Edit menu. 

Using the Option Key 

Using the Shift Key 

The duplicate object is then pasted into your drawing. 

Another way to duplicate an object in MacPai nt is to hold down the 
Option key while dragging the selected ob ject to a diffe rent position on 
the screen. This leaves the original object in place and the object you 
drag becomes the duplicate. 

The Shift key is used with the Option key when the duplicate object is 
to be a ligned vertically or horizontally to the o riginal-for example, to 
align objects along their bottom edge, as you want to do in this case. 

The Shift key has many other uses. It is used toconstmin a motion vertically 
or horizonta lly. To draw a straight line, you hold down the Shift key 
while using the line tool. To draw a circle, you hold down the Shift key 
while using the ova l tool. To draw a square, you ho ld down the Shift key 
while using the rectangle tool. To erase in a straight line, you hold down 
the Shift key while using the e raser. 

You want the duplicate line you' re about to make to a lign with the 
o riginal line alo ng the bottom. You'lluse the Sh ift-Optio n combination 
to accomplish this. 

• Press and ho ld down the Shift and Option keys. 

• Move the pointer into the selection rectangle that surrounds the 
line on the screen. While holding down the Option and Shift keys, 
hold down the mouse button. Now drag the mouse to the right. 
W hen the duplicated object is where you want it, release the mouse 
button. See Figure 4-11. 
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Figure 4-11 Duplicating an ob ject 
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•• While the duplicated line is still selected, choose Flip Horizontal 
from the Edit menu. 

If you deselected the duplicate line by clicking somewhere else on the 
screen, you must select it again so you can flip it. 

Flipping this line horizontally makes the duplicate line have an angle 
that is the mirror image of the first one. Now you have drawn both sides 
of the garbage can. 

• Click on the line tool to select that tool. 

• To connect the two lines to form the bottom of the garbage can, 
move the pointer to one end, hold down the Shift key, and draw a 
horizontal line connecting the bottom ends of the lines, as shown 
in Figure 4-12. 
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Figure 4-12 Using the Shift key with the line tool 
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SAVING THE DOCUMENT 
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• Choose Save from the File menu. 

You'll be presented with a dialog box similar to the o ne shown in 
Figure 4-13. 
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Figure 4-13 The Save dialog box 

When saving a MacPaint document, you can choose o ne of three 
document formats, as shown at the bottom of t he d ialog box in Figure 
4-13. MacPaint format is the preset option, and it causes the document 
to be saved as a MacPaint p icture. The Stationery option lets you save 
the document as a template that records the page setup, menu positions, 
and other preferences. The Startup screen option lets you save the 
MacPaint drawing as a sta rtup screen that is displayed when you turn on 
your Macintosh. You will use the defau lt MacPaint format for the 
projects in this book. 

It is important that you save your work in a place where you know it will 
be when you go back to modify or print that document later. If you are 
usi ng a data disk, be sure you save your work on it. Since you probably 
named your data disk when you initial ized it, you will want that name 
to be at the top of the dialog box when it is presented to you, where 
"Connie Barlow" is showing in Figure 4-13. 

• If necessary, cl ick the Drive button to switch drives until the name 
of your disk is showing at the top of the window, as shown in Figure 
4-13. 

·• In the box marked Save Paint document as:, type the name that you 
want this document to have when it is saved: Yard Sale Flyer. Then 
click the Save button. 

Your document will no lo nger be named Untitled , as it has been up to 
this point- it will come back on the screen with the name Yard Sale 
Flyer. 

After you've named and saved the document once, when you next 
choose Save, it wi ll automatically be saved with the same name, and in 
the same locatio n, as when you originally saved it. 
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CORRECTING MISTAKES 

As you are working through this assignment, it is likely that you may 
accidenta lly do something in the drawing window that you would like 
to undo. MacPaint gives you a couple of options to use to fix your 
drawing. 

There are several ways to erase in MacPaint. You can erase all or part of 
an unwanted drawing with the eraser tool. You drag the eraser across 
an object to e rase it, o r you can double-click on the eraser tool in the 
toolbox to erase the entire screen. 

Another way to get rid of an unwanted part of your drawing is to select 
it with the selection rectangle or the lasso and then press the Backspace 
key (Delete on some keyboards). You can also use the Cut or Clear 
command from the Edit menu to remove the selected object from the 
drawing. 

When typing with the text tool, you can press the Backspace key 
to delete the characters you just typed, as long as you haven't clicked 
elsewhere on the screen or selected another tool. If you have done 
either of these things, you have to erase the text in some other way and 
retype it. 

Using the Undo Command 

One way to undo your last action is with the Undo Command from the 
Edit menu. This command allows you to undo the effects created on the 
drawing window with the last action of the mouse. Immediately after you 
realize you did som ething in the drawing window that you didn't want 
to do, and before clicking anywhere else with the mouse, choose Undo 
from the Edit menu. The key words here are "before clicking anywhere else 
in the drawing window," because MacPaint will consider the last clicking 
action the one to be undone. 

Using the Revert To Saved Command 

Another way to correct a mistake takes a certain amount of fo rethought. 
If you always remember to save your document whenever you create anything 
in it that you definitely do not want to lose, you' ll have no problem using 
the Revert To Saved command in the File menu. This command brings 
back to the drawing window the last version you saved on disk. Use this 
command especia lly when you are trying something that you are not 
sure will work. Save your work first, experiment, and then you can 
always use Revert To Saved if your experiment didn't work. No matter 
how badly you mess up, if you save your work whenever you make a 
significant change to your drawing window, you can always go back to 
that last saved version using the Revert To Saved comman d. 
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When you choose RevertToSav d from the File menu, you are presented 
with the dialog box shown in Fi ure 4-14. Clicking OK will restore the 
last saved version from your disk; clicking Cancel will cancel the 
command. 

Reuert to the last uerslon 
SIIUed 1 

( Cancel ) LJLJ 
Figure 4-14 Revert To Saved dialog box 

Now you're ready to draw thicker vertical lines on the garbage can. 

CHANGING THE LINE WEIGHT 
You change the line weight by clicking on one of the other weights in 
the border palette at the top of the toolbox. 

,. Click on the fourth line weight from the left. 

- While holding down the Shift key so that the line will be straight, 
draw a thick, straight line down the center of the garbage can, 
stopping before you touch the bottom line, as shown in Figure 4-15. 
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Figure 4-15 Drawing a vertical line with the Shift key 

"• Without using the Shift key,i draw some lines on either side of this 
straight line, spaced about t e same distance apart. 

Next you'll draw the lid to the garbage can. 

• Change the line weight back to the second one in the border palette, 
where the pointer is in Figu1e 4-16. 
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Figure 4-16 Changing the line weight 

• Select the unfilled oval tool from the toolbox. 
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• Place the pointer above the garbage can on the upper left , and click 
and drag to the right to make an oval about the same size as the 
opening of the garbage can. Do this a pout 1/2 inch above the can, 
so you can place the oval on top of the can after it is done, as shown 
in Figure 4-17. 
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Figure 4-17 Using the unfilled oval tool 
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SELECTING OBJECTS IN YOUR DRAWING 
If you experimented with the lasso and the selection rectangle in the 
first part of this chapter, you' ll recall the difference between t hem-the 
selection rectangle a lso selects all the area inside the rectangle, including 
the white space surrounding an object, whereas the lasso shrinks to the 
exact size of the object and selects only the o bject. You want to use the 
lasso in this case because you want to select only the oval, not any space 
around it. 

• Click on the lasso. 
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• While holding down them , use button, move the lasso around the 
oval. This line must comple ely encircle the object you are selecting 
and must not cut into the object. See Figure 4-18. 
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Figure 4-18 Using the Jasso tool 
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When selecting with the Jasso, you create a line around the object you 
are selecting. If you release the mouse button without moving the lasso 
back to the starting point of that line, MacPaint will close the gap and 
finish the line between the point where you pressed the mouse button 
and the point where you released it. This line will be a straight line. 

.. Without pressing the mouse button, position the pointer on the 
object until the pointer changes to an arrow. 

If you click while the pointer is not an arrow, you will deselect the 
selected object. You will need to encircle the object with the lasso again 
to select it. 

• Click and drag the oval down to form the lid of the garbage can, as 
shown in Figure 4-19. Don't worry about the lines showing through 
the lid-you'll clean them up in a minute. 
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Figure 4-19 Placing the lid on the garbage can 
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Now is a good time to save your work. 

3€ -S • Choose Save from the File menu. 

Part II: Graphics 

Now you need to clean up any overlapping lines on your garbage can lid. 

TOUCHING UP YOUR DRAWING IN A 
MAGNIFIED VIEW 

Zooming in on your drawing allows you to work in detail on any part 
of your drawing. The first time you use the Zoom In command you magnify 
your drawing to 200%. In the title bar of the window the percent 
magnification that you are viewing is displayed next to the name of the 
document. 

The next time you choose Zoom In takes you to a 400% magnification, 
and the next time to 800%, or what was originally called FatBits. (FatBits 
is the term used throughout this chapter when referring to the 800% 
magnification view.) Each level of the Zoom In magnification can be 
useful for different purposes. FatBits gives you the ability to work in the 
greatest detail. 

• Click on the pencil tool to select it, and then click once on the lid 
of the garbage can. 

MacPaint zooms in to the most recent point clicked on the screen. 
Clicking on the lid of the garbage can will enable you to zoom in to 
precisely that spot. 

3€ -M ,,. Choose Zoom In from the Goodies menu. 

3€ -M ,. Choose Zoom In twice more in succession. 

You should now be viewing your document in FatBits, as shown in 
Figure 4-20. 

A shortcut for getting directly to FatBits is double-clicking on the pencil 
tool. 

Figure 4-20 Working in FatBits 
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Notice the small actual size win[ow. This reflects your drawing as it 
appears in the actual (100%) sizk. You can reposition this actual size 
window by dragging it around b~ its title bar, or you can get rid of it by 
clicking in its close box. If you want to see the actual size window again 
after closing it, choose Show Actual Size from the Goodies Menu. 

• Select the eraser tool. 

While you are pressing the mouse button, the eraser is active. When you 
release the mouse button, the eraser does not erase. 

Caution: Double-clicking 011 the eraser will erase the entire screen. If you 
accidentally double-click on the eraser, you can always choose Undo 
from the Edit menu. 

• Erase the dot created when you clicked on the lid with the pencil, 
and then the parts of the thick lines that are on the lid, as shown in 
Figure 4-21. 
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Figure 4-21 Erasing in FatBits 

• To move to a different portion of the drawing, select the grabber 
tool. 

If you click and drag with this tool selected, it moves the portion of the 
drawing that you want to work with into view. Imagine it shifting the 
page across the screen. 

• Continue touching up your drawing in th is manner until all the 
parts of the lines that overlapped onto the oval lid have been 
eliminated. 

This is a good time to clean up any overlapping li nes that you may have 
drawn when you drew the base of the garbage can. 

You can erase one dot (or pixel) at a time with the penci l tool. If you click 
in a white area with the pencil it yvill leave a black dot, and if you click 
on a black dot that dot will change to white (erasing the dot). All the 
tools work in the FatBits window nd in all the magnification views, but 
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the pencil is probably the most useful in FatBits since you can work at 
the level of the individual pixel. 

• When you are finished cleaning up the garbage can in FatBits, 
double-click on the pencil tool to take you back to the normall 00% 
size drawing. You can also use the Zoom Out command from the 
Goodies menu, but that takes you back to 100% size in stages, and 
it requires choosing Zoom Out three times. 

Since you've made changes to your drawing that you don't want to lose, 
now is a good time to save your work. 

~ -S • Choose Save from the File menu. 

SHORTCUTS 
Double-clicking on the pencil tool is a shortcut when using FatBits. If 
you would like to learn more MacPaint shortcuts, you can always access 
a help screen called Shortcuts. 

~ -H • Choose Shortcuts from the Goodies menu. The screen shown in 
Figure 4-22 will appear. 

I:!C -' I [~J Shrink marquee to fit ; stretch selection 
lsc -' I[) or [3] Change font size 
l:!C -' II shift I[) or [3] Change font 
ioptionll:!C -' I[) or [3] Change 1i ne spacing 

loptionllsc -'I Multiple copies; optional paint mode 
!shift lloptionllsc -' I Multi pie, pattern-aligned copies 

l:!C -'I tJ Zoom in 
l:!C -' II shift I tJ Zoom out 
rT.hl Use special patter.n effects while 
L:.:::....1 dragg1 ng a selechon 

Double 
Click 

~000000000000~ 
00000000000000 
c::JOOOOOOOOOOOCJ 
lconstrainl0000000[]~0~ 

~~~----------~ 
Multiple Copies 

Figure 4-22 The Shortcuts screen 

I option I Scroll document, except in [AI 
l:!C -' I Patterned 1i nes and borders 

Select window 

Select contents of window 

Choose brush shape 

Toggle 1 00% and 800% zoom 

Erase window or document 

Toggle "Draw From Center" 

re.::ul [~J Select document 
~ p Select contents of document 

lsc -' I [~J Select contents of wi ndow 

!shift l l:!C -' I [~J Select contents of doc 

• To return to your drawing window, click anywhere in the Shortcuts 
screen. 

Try out some of these shortcuts. Whenever you need to refresh your 
memory while working in MacPaint, you can access this option. 

ADDING ELEMENTS TO YOUR DRAWING 

The last thing you need to do to your garbage can is to put handles on 
both sides and on the lid. 
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Drawing Filled Rectangles 

u I .J 

You'll use the filled rectangle tool to draw the handles. 

• Click on the filled rectangle tool in the toolbox. 

Since fi lled rectangle means the object will be fi lled with a pattern, you' ll 
need to select a pattern with which to fill it. 

• Choose Patterns from the menu bar, and d rag the pointer to the first 
dotted pattern on the second row in the pattern palette to select that 
pattern for your filled rectangle (see Figure 4-23). 

Figure 4-23 Selecting a pattern 

• Using the fi lled rectangle tool, draw a small rectangle near the center 
of the screen, about the size of the one shown in Figure 4-24. 

If the toolbox gets in your way, you can move it to a new location by 
dragging its title bar. 

• After drawing the rectangle, choose the selection rectangle and 
select the rectangle you just drew, as in Figure 4-24 . 

You will duplicate this rectangle so you have a total of three, and then 
you' ll use them as handles for the garbage can sides and lid. 
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Figure 4-24 Selecting a rectangle 
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Rotating an Object 

Part II: Graphics 

• To duplicate this rectangle, hold down the Option key and press the 
mo use button and drag the selected rectangle. Wherever you release 
your mouse button, it will leave a duplicate behind. Make three 
duplicate rectangles, as shown in Figure 4-25. 
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Figure 4-25 Duplicating rectangles 

.. While the last of the three rectangles is still selected, choose Rotate 
from the Ed it menu. 

This will cause th e selected object to rotate 90° counterclockwise, as 
shown in Figure 4-26. You'll use this rotated rectangle for th e handle 
on the lid . 
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Figure 4-26 Rotating a rectangle 

[£] • Select the lasso, and encircle the first of the three small rectangles. 
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•• Move that rectangle to the l ft side of the garbage can and position 
it against the can as a handle, as shown in Figure 4-27. 
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Figure 4-27 Placing the left garbage can handle 

.. Place the other handle on the right side of the garbage can and the 
horizontal handle on the lid, as shown in Figure 4-28. 

10 "Yard Sole Flyer" at I 00'1, 

Figure 4-28 Finished garbage can 

Your garbage can is complete. 
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• Save your document now b~ choosing Save from the File menu. 

Drawing Unfilled Rectangles 
The next ob ject to draw is t he box of toys. 
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• Move the toolbox to the left side of the screen by dragging in its 
title bar, so you can draw in the right side of the screen. In the scroll 
bar at the bottom of the screen, drag the scroll box to the far right so 
you' ll be working in the right side of the window, as shown in 
Figure 4-29. 
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Figure 4-29 Move the toolbox and drag the scroll box 

.. Select the unfilled rectangle tool. 

• Draw a rectangle about 3 inches long and 1 inch high. 

• Use the line tool to draw the box flaps on either side of the box, so 
your box looks similar to the one shown in Figure 4-30. 

•o "Yord Sole Flyer" at 100% 1:!1~ 

!;! 

~----.) ~ .- - . 

~ ··~ / ~ 
+ l l llll ' 

r~J p o 2!:1 

0 1\10 Q 

~ ~~ 0 0 
I:J ~<::? ~ 

A ,q a a. 
0 

~I . '·' "' :• I· Jyi2J 

Figure 4-30 Drawing the box and flaps 

• To d raw the teddy bear's head, select the unfilled oval tool. While 
holding down the Shift key to get a circle, draw a circle about 1 inch 
in diameter, as shown in Figure 4-31. 



Chapter 4: MacPaint 2.0 81 

; " Ynrd Snle Fl!ler" nt 100'7. 0! 

·---. ,,_ 

...- - a I 
I 

+ I I II II 1 I ·-· p D • 1,, 

I~ ......_ 0 • 1 1i~1 
~ ·~ • • ::)!: 

~ (I <:? " :A u a .: 
:n: 

CIT 

Figure 4-31 Drawing a teddy bear head 

Painting with Different Brush Shapes 
To draw the ears, nose and eyes on the teddy bear, you'll use some of the 
paint brush shapes. 

• Double-click on the paint brush tool. 

This b ri ngs up a box showing the available brush shapes (see 
Figure 4-32). 
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Figure 4-32 Paint brush shapes 

.. Select the largest round brush shape, second from the left on the top 
row (where the poin ter is in Figure 4-32), by clicking on that shape. 

Since the current pattern is the one you used to draw the handles on the 
garbage can, you need to change the pattern back to black. 

• Click to select solid black on he patterns palette, which is next to 
the currently selected patter on the top row. 
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• Draw two ears and two eyes on the teddy bear by clicking this brush 
shape where you want the black circles. See Figure 4-33. 

10 "Yord Sale Flyer" ot 100% ell 
p:! 

t=;> 
6 - • 

+ 1 I 1111 1 I ·-· p D • 
I~ ........ 0 • I& ~() 0 • 

IM ~ <::? • A U a • In 
Ql ''I 

Figure 4-33 Drawing the teddy bear's ears and eyes 

• Double-cl ick on the paint brush tool again, and this time select the 
circle that is second from left in the th ird row down, as shown by the 
pointer in Figure 4-34. 

·~ / '\.. 

• • / '\. 

• \ / ' 
.. ·. · 
.. 

• • 

Figure 4-34 Selecting a d ifferent brush shape 

• Draw the nose with this brush shape. 

• Select the white pattern from the patterns palette. 

This is the pattern you' ll be using with the paint brush to create the 
white in the eyes. 

• Using the white brush shape, cl ick inside each eye of the teddy bear 
to produce an "eyeball" effect, as shown in Figure 4-35. 
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Figure 4-35 Adding the teddy bear's eyes 

.. To draw the ball, select the unfilled oval tool. Hold down the Shift 
key and draw a circle about 2 inches in diameter, like the one shown 
in Figure 4-36. 
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Figure 4-36 Drawing the ball 

Filling an Object with a Pattern 
Next you'll use the paint bucket tool to fill the ball with a pattern . 

• Select the paint bucket tool. 

• Select a pattern of your choice from the Patterns menu. 

It's always a good idea to save your work prior to painting with the paint 
bucket, since you can accidentally click in the wrong portion of your 
drawing and fill your whole screen with the selected pattern. For 
instance, if you used the paint bucket tool inside the garbage can lid, it 
would paint the whole screen because the oval tool often leaves gaps 
that the paint can "leak" through. You can use Undo from the Edit 
menu if you don't click somewhere else first. 

3€ -S .. Choose Save from the File 1enu. 

.. Position the drip portion of the paint bucket within the boundaries 
of the circle you just drew, ahd then click. 

The ci rcle fi lls with the selected pattern, as shown in Figure 4-37. 
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Moving Objects 
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Figure 4-37 Filling the ball 

Remember that where the drip of the bucket is positioned determines 
where the fill pattern wi ll be painted. Each tool has a hot spot, and the 
end of the drip is the hot spot for the paint bucket tool. You need to be 
very careful where you click when the paint bucket tool is selected. 

As soon as you have fin ished filling the desired object, always select a 
tool that is less likely to mess you up, such as the pencil or one of the 
selection tools. That way, if you accidentally click on the screen, you 
won't do as much damage. The same holds true with the eraser tool
select a different, less destructive tool when you're fi nished using it. 

Once you've completed the teddy bear's head and the ball, the box 
needs to be positioned so it looks as though those objects are in the box. 

• Using the lasso tool, encircle the entire box to select it, as shown in 
Figure 4-38. 

Figure 4-38 Selecting the box with the lasso 
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Drawing Text 
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• Drag the selected box up so that it partial ly covers the teddy bear's 
nose. 

Now the teddy bear and ba ll appear to be in the box, as shown in 
Figure 4-39. 

Figure 4-39 The toys appear to be in the box 

The last step to finish this box o f toys is to add text to it. 

There a re two ways to add text to a MacPaint drawing-by drawing it or 
by typing it. You ' ll draw the text o n the toy box using the pa int brush 
tool, and in a few minutes you' ll type the text in the middle of the fl yer 
using the text tool. 

• Select the pain t brush tool, bu t double-cl ick o n it so the selection of 
pa int brush shapes is also displayed. Select the brush pattern that 
is fourth from the left in the bo ttom row, as shown in Figure 4-40 . 
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Figure 4-40 Selecting a diffe rent paint brush shape 
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• Change the currently selected pattern to any shade of gray from the 
patterns palette. 

• Position the paint brush inside the box, on the left side, and write 
Toys across the front of the box. See Figure 4-41. 

Figure 4-41 Box of toys completed 

S€ -S • Choose Save from the File menu. 

Drawing and Filling Additional Objects 
That completes the box of toys. Next you' ll draw the gaudy roll of 
carpeting such as you'd find only at a yard sale. 

S€ _ L • Choose Zoom Out from the Goodies menu. 

This will show you the drawing at SO% of its actual size and a gray area 
that represents the area outside the drawing. 

• Drag the toolbox over to the gray area so it doesn' t obscure the 
drawing area. 

Zooming out to SO% view allows you to see three-fourths of the picture 
at one time so that you can get an idea of the overall effect. All the tools 
work in SO% view. Use the vertical scroll bar to move a different portion 
of the picture into view. 

• Using the vertical scroll bar on the right, drag the scroll box all the 
way to the bottom of the scroll bar so the bottom edge of the 
drawing is visible, as shown in Figure 4-42. 
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Fig11re 4-42 Moving to the bottom of the drawing 

• Select the unfilled oval tool, and draw an oval in the bottom right 
portion of the page, about 1 inch from the bottom. 

• Select the ova l using the selection rectangle or the lasso, and 
dupl icate it by holding down Option-Shift while dragging. Place the 
duplicate 3 or 4 inches to the left of the origina l oval, as shown in 
figure 4-43. 

Figure 4-43 Drawing and copying ovals 

• Using the li ne tool, with the Shift key held down, connect both 
ova ls on the top and bottom, as shown in Figure 4-44. 
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Figure 4-44 Crea ting the cyli nder 

• Use the eraser to e rase the inside po rtio n of the left oval. You shou ld 
now h ave a cylinder lying on its side. 

Now is a good t ime to save your work. 

• Choose Save from the File menu. 

• Choose Zoom In from the Goodies menu so you ca n d raw the 
details mo re easily. 

• Position the toolbox so it is no t in the way, and then select the 
unfil led oval tool. 

You may have to drag the scroll box to the botto m of the vertical scroll 
bar to view the cylinder and the space beneath it. 

• Draw two mo re ovals above the cyli nder, one sligh t ly smaller than 
the other and both smaller than the o riginal oval, as shown in 
Figure 4-45. 
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Figure 4-45 Drawing add itio nal ovals 
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• Select the smallest oval with the lasso, and drag it so that it is inside 
the next largest oval, as shown in Figure 4-46. 
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Figure 4-46 Positioning the smaller oval 
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·• Select both of those two ovals and place them inside the oval at the 
end of the cylinder, as shown in Figure 4-47. 
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Figure 4-47 Placing ovals to simulate a rolled rug 

• Using the line tool, draw a diagonal line underneath the three ovals, 
as shown in Figure 4-48. 

• Duplicate that line by selecting it with the lasso and then dragging 
it while holding down the Option-Shift keys. Place the duplicate 
line on the other end of th cylinder, as shown in Figure 4-48. 
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Figure 4-48 Drawing and duplicating lines 
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• Hold ing down the Sh ift key, draw a horizontal li ne to connect the 
ends of the two diagonal lines, as shown in Figure 4-49. 

~0 " Yord Sole Flyer" 111 I 00% E!ll 

Figure 4-49 Connecting the lines 

• Select that group of three lines with the lasso and drag the lines up 
to the cylinder to form the unrolled piece of carpet, as shown in 
Figure 4-50. 
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Figure 4-50 Creating the flap of the rug 
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Typing Text 

~ -S • Save your work now before you add the pattern to the carpet. 

• To create a pattern on the carpet, use any combination of fil led or 
unfi lled ovals, circles, rectangles, squares, and rounded rectangles. 
If you use unfilled shapes, select the paint bucket and choose 
different patterns with which to fill the shapes. 

Take a good look at your roll of carpeting. If you have any lines that 
don't connect, use FatBits (double-cl ick on the pencil tool) and clean up 
any lines that need it. 

The last thing needed to complete your yard sale flyer is the text. 

~ -L • Zoom out to SO% size aga in , and position the toolbox in the gray 
a rea. 

,,.. Select the text tool, which is indi cated by the" A" in the bottom left 
corn er of the toolbox. 

When you move the pointer into the drawing window, notice that it is 
now an !-beam. 

• Center the !-beam pointe r in the area below the top two drawings 
and click to set the inse rtion point, as shown in Figure 4-51. 

Figure 4-51 Setting the insertion poin t for text entry 

• Choose 36 point from the Style menu. Go back to the Style menu 
and choose Bold, and go ba k again and choose Align Middle. (See 
Figure 4-52.) 

If you do not have 36 point available, choose another large size. 
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Figure 4-52 The selected options on the Style menu 

• Type Trash and Treasure, press the Return key, and then type Yard 
Sale. (See figure 4-53.) 

If you make an y errors while typing, press the Backspace key to delete 
the character and then retype it. 

Trash and Treasure 
Yard Sale 

Figure 4-53 Adding text 

• Click in the line beneath Yard Sale, under t he "d", and then choose 
24 point from the Style menu. 

If you do no t have 24 point available, select the next smaller size from 
the first size you used. You will sti ll be typing in bold text. 

• Type the street address, 4712 Blount Ave. N.W. Press Return, and 
on the next line type (5th house on right) . See Figure 4-54. 
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4712 Blount Ave. N.W 
(5th house on right) 

Figure 4-54 Adding the address and location 
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• Finish up by typing Friday- Saturday -Sunday on one line and 
April 7, 8, 9 from 9:00-5:00 on the next line. Press Return again to 
make a blank line, and then type Rain or Shine!! ! on the next line. 
Your screen should look like the one shown in figure 4-SS. 

Trash and Treasure 
Yard Sale 

4712 Blount Ave. N.W 
(5th house on right) 

Friday - Saturday - sunday 
Apri l 7, 8, 9 from 9:00- 5 :00 

Rain or Shtne!ll 

Figure 4-55 Completion of text entry 

PRINTING YOUR DOCUMENT 

Now you're done wi th the yard sale fl yer-i t's ready to print. There is 
no need to zoom in again to take your drawing back to its 100% size, 
because MacPaint will open ydur document at 100% each time, no 
matter what view it was in when you last worked with it. 
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It's a good h abit to save your work before printing it. 

W -S ,. Save your work by choosi ng Save from the File menu. 

• Choose Print from the Fi le menu. 

Your dialog box for the Print command may not look exactly like the 
one shown in Figure 4-56, since this box is for a Laser Writer. The dialog 
box for an Image Writer is similar, and clicking OK and accepting all the 
default settings will print your document as well. 

LaserUJriter "l aserUJrller" vS.I t::liL:J 
Copies:l•l Pages:@ All 0 From:C]To: CJ ~ 

~ 
Couer Page: ® No 0 First Page 0 Last Page ~ 

Po per Source:® Po per Cassette 0 Manual Feed 

Figure 4-56 LaserWriter Print dialog box 

The Copies box in the Print dialog box specifies the number of copies 
to print. The Pages options specify whether to print all pages of a 
multipage document or just certain pages in a multipage document. 
The Cover Page option, which is only available fo r the LaserWriter and 
is for use when more than one Macintosh prints to a single shared 
printer, lets you print a page identifying your document. The Paper 
Source option, also only available to the LaserWri ter, lets you specify 
whether to print from the paper cassette or from the manual feed slot. 

The Cancel button is used to cancel the Print command. Clicking the 
Help button will present you with information about printing your 
document. The OK button accepts the settings in the dialog box and 
executes the Print command. 

Return • Click OK in the dialog box to print one copy. 

W -Q •• To exit MacPaint, choose Quit from the File menu. If you want to 
continue working with the next project, just close the document to 
remain in MacPaint. 

Project 2: Creating a Greeting Card 

In this project you' ll create a greeting card that combines what you 
learned in the first project with MacPaint's copy and paste features. 

Let your creativity be your guide. The Macintosh Journey Projects disk that 
accompanies this book includes the artwork for this project. If you 
desire, however, you can let these instructions be a guide line for creating 
your own, individually designed greeting card. 

The finished greeting card from this project is shown in Figure 4-57. 
When it is folded, it wi ll open as a greetin g card does. 
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Cheapo Caxds Company 
$17.50 

i illHJ l~Ql U! 
AJJ!S OS ~OOJ Ol 3U!03 

aJ,no.A am~qs "E s .ll 

J'ou 've achieved your goal 
and deserve to be 

recognized for your 
accon1plishment. 

We'll be proud Ft'llen 
you get your diploma ... 

Figure 4-57 Final output of P o ject 2 

95 
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• Double-click on the MacPaint 2.0 icon to open a new, untitled 
drawing window. If you did not qu it MacPaint after finishing the 
first project, choose New from the f ile menu to open a new, untitled 
document. 

Since you' re going to be working on an 8- by 10-inch a rea, you will be 
folding the finished prin ted sheet to open and close as a greeting card 
does-showing a message (and drawing) on the fro n t, other m essages 
and drawings on the inside, and even a price and "created by" message 
o n the back. You'll start by drawing some lines on the page that will act 
as boundaries for each of the four sections of the card: the front, inside 
left, inside right, and back. 

It's easier to get a proportional view of your entire drawing page by 
viewing it at 50% size . 

00 - L ,.,. Choose Zoom Out fro m the Goodies menu. 

DRAWING GUIDE LINES 

• Tear off the toolbox and p lace it in the gray area of the screen. See 
Figure 4-58. 

Figure 4-58 Placement of t he toolbox at 50°AJ size 

• Select the line tool. 

• Holding down the Shi ft key to constrain the line vertical ly, posit ion 
the pointer at the cente r of the top of the page (approximately) 
and d raw a line to divide the page in half vertically, as shown in 
figure 4-59. 
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T 

Figure 4-59 Dividing the page vertically 

Notice the vertical scroll bar at the right of your screen. The scro ll box 
moves down as your line is drawn, indicating your position relative to 
the entire page. When the scroll box is a ll the way at the bottom of the 
scro ll bar, your vertical line is complete. 

When you have finished drawing the line, be su re to release the mouse 
button before you release the Shift key. Otherwise, if you move your 
pointer to the left or to the right as you are drawing, the line will snnp 
to the pointer when you release the Shift key. 

You'll notice that you don't have a ho rizontal scroll bar when you' re 
viewing at SO% size. This is because the width of the page is en tire ly 
visible in this view. 

,. Drag the vertical scroll box to the center of the scroll bar, as shown 
in rigure 4-60. 

Figure 4-60 Moving the scroll box in the scroll bar 

This positions the page so that you are looking at the middle portion of 
it. The very top and very bottom are not visible on the screen. 



98 Part II: Graphics 

• Holding down the Shift key, place the cross-beam pointer of the line 
tool in the center of the left edge of the page, and drag to the right 
to create a horizontal line that in tersects the vertical line you just 
drew (see Figure 4-61). Be sure to release the mouse button before you 
release the Shift key when you are fin ished drawi ng the line. 

Figure 4-61 Dividing the page into quarters 

As exp lained earlier, the greeting card contains four sectio ns tha t you'll 
be worki ng with. Now that you have ma rked these boundaries on your 
page with guide lines, it's easier to understand how you r card will be 
created using the guide lines as fold li nes, as shown in Figure 4-62. 

Inside Inside 
Right Left 

Back Front 

Figure 4-62 Greeting card layout-unfolded 
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Whatever you place on the lower right corner of the drawing, in the 
rectangle that is labeled "Front" in Figure 4-63, will be displayed on the 
frontof yourcard once it is folded. Anything that you place on the lower 
left side of the page will be displayed on the back of the fo lded card. Take 
a piece of paper and try folding it. 

Figure 4-63 Folded greeting card 

The two sections that will be in the center of the greeting card, those 
marked "Inside Right" and "Inside Left" in Figure 4-62, will need to have 
any drawing or text turned upside down so that when the page is folded 
to form the ca rd, the images are positioned correctly. You'll learn how 
to do this in the instructions for this project. 

SAVING THE DOCUMENT 

Now is a good time to save what you have done so far and to name your 
document. 

00 -S • Choose Save from the File m enu. 

• If necessary, click the Drive button until your name, or whatever 
name you gave your data disk, is showing at the top of the screen, 
where "Connie Barlow" is showing in Figure 4-64. 

.. Type Greeting Card in the box marked Save Paint document as:, 
and then click Save. 



100 

I (g) Connie Oerlow I 
D Gre<!Hng C<trd fh1 
D Y<Jnl ~~~h~ l' l!J<!r 

S11ue P11lnt document 11s: 

@MIICPIIInt 

Document forme!: 

0 Stationery 

!=! (g) Connie 011 .•. 

Eject 

Drlue 

Seue 

[ Cencel 

0 Startup screen 

Figure 4-64 Saving the document Greeting Card 
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COPYING AND PASTING AN EXISTING GRAPHIC 
Now that you have created the layout of the card, you'll place a graphic 
on the front of the card. On the Macintosh Joumey Projects disk is a MacPaint 
document entitled Greeting Card Art. 

(If you are using this book in a classroom environment, check with the 
instructor to ensure that this document has been made available to you.) 

Opening the Document 
First you'll open the document that contains the artwork. 

3€ -0 • To open an existing piece of artwork, choose Open from the File 
menu. 

Your screen shows a dialog box that lists the MacPaint documents 
available to be opened, as shown in Figure 4-65. 

I (g) Connie Oerlow I 
I D Greeting Cerd 

I I 

D Y11rd Sele Flyer 

Q 

(g) Connie 011 ••• 

[ Eject 1 
[ Drlue 1 

[ Open 

[ C11ncel 

Figure 4-65 The Open dialog box 

• Click the Drive button, if necessary, to view the contents of the disk 
that contains Greeting Card Art. 

• Select Greeting Card Art from the list by clicking on it, and then 
click the Open button. A faster way to open a document is to 
double-click on its name in the list. 
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Your screen should now sho~ the Greeting Card Art document, 
and your greeting card should peek out from beneath it, as shown in 
Figure 4-66. 

• File Edit Goodies Font St yle Patterns Tools 

" Greeting Card" a t 50% 

~ "Gree ting Card Rrj" a t I 00% 

Figure 4-66 Greeting Card Art 

,,. Drag the toolbox by its title bar to reposition it on the left side ofthe 
screen, and use the bo ttom scroll bar to scroll so that the entire 
Congratulations Grad box is showing, as in Figure 4-67. 

• File Edit Goodies Font Style Patterns Tools 

"Gr ee tin Card" at 50% 

"Greetln Cord Rrt" ot I OO% EJI 

Fgu re 4-67 Positioning the toolbox and the scroll bar 

Selecting the Artwork You Want to Copy 

Congratu lations Grad will go or the front of the ca rd. To use it in your 
greeting card, you' ll select it and then copy it to the Cli pboard. 

• Click on the selection rectanple, and then select the Congratulations 
Grad rectangle, as shown in Figure 4-68. 
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• File Edit Goodies Font Style Patterns Tools 

" Greetln Card" at 50% 

¥4 "Gr eeting Card Art" at I 00% 

Figure 4-68 Selecting the drawing 

38 -C • With the desi red drawing selected, choose Copy from the Edit m enu. 

Activating Your Document 

Turn Grid On SE:G 
Draw From Center 
Show Mouse Position il8K 

Zoom I n 
Zoom Out 
Show fl< tuol Si7e 

Shortcuts... X H 
Preferences ... 
Edit Pattern .•. 
Brush Shape .. . 
Brush Mirrors .. . 
S< lllf' Sele< tlon .•• 

- ---------·-----
I i I 

Greeting Card Art :!82 

• To make your greeting card the active d rawing (or active window), 
ch oose Greeting Card from the Goodies menu, or click o n an y part 
of its window. 

The Greeting Card window moves to the topmost position. 

Whenever you h ave more than one wi ndow open in MacPaint, you can 
switch between th em by ch oosing the name of the document you want 
from the Goodies menu. You can also just click anywhere in the 
window of the documen t you wa n t active, and th at docume n t will 
move to t he topmost position and become active. 

Your o riginal Greeting Ca rd should now be showing on the screen. 

• Use the vert ical scro ll bar to scroll down so the entire front section 
of the ca rd is showing, as in Figure 4-69. 

Figure 4-69 Scrolling to view the front section of the card 
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Pasting the Artwork into Your Document 
Now you' ll paste th e draw ing that was co pied to the C lipboa rd in to your 
MacPaint docum ent. 

3€:- V .. Choose Paste fro m the Edit menu. 

Your screen shou ld look like the one shown in Figure 4-70. 

Figure 4-70 Pasting the drawing into the docum ent 

The drawing will appear in the center of the ca rd, and it will be 
selected- notice the ~' marching a nts~' aro und the border of the d rawi ng. 

Positioning the Artwork 
Now that you have copied and pasted the Congratu lations Grad 
artwork, you can put it where you want it. 

• Position th e pointer on top of the drawing a nd cl ick and drag, 
placing the drawing in the to p portion of the area reserved for the 
front of the card (see figure 4-71). 

re, ow.,. ! 
$J ! :~i 

!~! 
t--------- - ---~·-------J 

Figure 4-71 Posit ioning th e 
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00 -S "• Now is a good time to save your greeting card. Choose Save from 
the File menu. 

ADDING TEXT 

Now that the drawing is positioned on the front of the card, you can 
finish the front by typing your message on it. 

00 -M • Since it is easier to see your typed message at 100% size, choose 
Zoom In from the Goodies menu. 

• Position the toolbox in the lower left corner of the screen by clicking 
on the title bar of the toolbox and dragging it. 

,.,.. Drag the scroll box in the horizontal scroll bar all the way to the 
right, and drag the scroll box in the vertical scroll bar all the way to 
the bottom. 

This will ensure that you are working in the lower right corner of the 
page. 

[A] .... .. Select the text tool. 

Position the insertion point in the center of the front section of the 
card, just beneath the drawing, and click to set the insertion point, 
as shown in Figure 4-72. 

Figure 4-72 Centering the insertion point under the drawing 

,.. Choose New York from the Font menu. 

,.. Choose the following options from the Style menu: 
14 point 
Bold 
Italic 
Align Middle 
(Th is will take four trips to the Style menu.) 

You can be sure that you have the right selections, because they will 
have checkmarks next to them. See Figure 4-73. If you accidentally 
select the wrong item, you can choose it again to deselect it. 
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Figure 4-73 The settings in the Style menu 

lOS 

• Now type the following lines on the card (press Return where 
indicated): 
You've achieved your goal (press Return) 
and deserve to be (press Return) 
recognized for your (press Return) 
accomplishment. (press Return twice) 
We'll be proud when (press Return) 
you get your diploma ... (press Return) 

Your screen should look similar to the one shown in Figure 4-74. 

iO "Greet in 

You 've ~chieved your /l(J81 
anq deserve to be 

recognized for your 
acljomplfshment. 

We 'JJ. be proud when 
you J!8 your diploma ... 

Figure 4-74 Text on the front of the card 

3€ -S • Save your work by choosing Save from the File menu. 
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ADDING MORE ARTWORK TO YOUR DOCUMENT 

Now you have completed the front of the card. Next you'll copy and 
paste the graduation cap art from Greeting Card Art into the "inside 
right" section of the document. 

,. Choose Greeting Card Art from the Goodies menu. 

,.. When you're viewing the Greeting Card Art document, move the 
toolbox to the right part of the screen, and drag the bottom scroll 
box to the left. You should be viewing the entire cap, as shown in 
Figure 4-75. 

* File Edit Goodies Font Style Patte rns Tools 

"Greeting Card" at I 00% 

I "Gree ting Card Rrt" a t I 00% 

Figure 4-75 Positioning the art in the window 

• Click on the selection rectangle, and then select the entire cap, as 
shown in Figure 4-76. 

* File Edit Goodies Font Style Potte rns Tools 

10 
"Greeting Cord" ot 100% 

"Gree tin Cnrd Rrt" ot 1 00'7. 

r------ ----- - ------ -----------~ 

I 

Figure 4-76 Selecting the cap 

~ -C • Choose Copy from the Edit menu to copy the selection to the 
Cli pboard. 
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Now that you 've copied the sec0nd drawing to the Clipboard, you no 
longer need to have the Greetink Card Art document open. 

:3€: -W • Close Greeting Card Art by clicking in its close box or by choosing 
Close from the File menu. 

• Click No in the dialog box that asks if you want to save changes to 
the document before closing. 

WORKING IN ANOTHER PORTION OF THE 
DOCUMENT 

Now you' ll position your greeting card so you can work in another 
portion of it. 

:3€: -L • Choose Zoom Out from the Goodies menu toviewyour cardatSO% 
size. Drag the toolbox into the gray area at the right side of the 
screen. 

:3€: -V .. Ch oose Paste from the Edit menu. 

This will cause the drawing of the cap to be placed in the cente r of the 
document. The drawing will automatically be selected. 

• Position the drawing in the center o f the upper left section, and 
then click elsewhere on the screen to deselect the drawing. See 
Figure 4-77. 

Figure 4-77 Positioning the second piece of artwork on the card 

ROTATING THE ARTWORK I 
Since everything in the top section o f the page must be upside down so 
that it will be positioned prope ly when the paper is folded as a card, 
you' ll rotate the graduation cap artwork. 

• Select the graduation cap ar work with the selection rectangle. 
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Any item you choose to rotate or flip horizontally or vertically must first 
be selected with the selection rectangle, not with the lasso. 

3€ -T • Choose Rotate from the Edit menu. 

This causes the selected drawing to be rotated 90°. Since you want the 
cap rotated 180°, you will rotate it again. 

3€ -T • Choose Rotate from the Edit menu. 

Now that the drawing has been turned upside down, your drawings 
should have the same placement as those shown in Figure 4-78. 

I • _:c_- --

~~r-·····-·-··- -~ 

i i 
I ! 

I 
! l L __________________ J 

Figure 4-78 The rotated cap 

3€ -S • Save your work now by choosing Save from the File menu. 

ROTATING TEXT 

3€ -M 

Now you'll type the text in the "inside left" sectio n of the ca rd. 

• Choose Zoom In from the Goodies menu to go to 100% size. 

• Position the horizontal scroll box to the fa r right in the scro ll bar, 
and position the vertical scroll box at the top of the scroll bar, as they 
are positioned in Figure 4-79. 

This will ensure that you are working in the upper right portion of 
the page. 

• Move the toolbox to the left side of the screen so it's out of the way, 
and then select the text too l. 

• Position the pointer in the center of the ri gh t side of the sc reen, as 
shown in Figure 4-79, and click to set the insertion point. 
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"Greeting cord" at 1100% 
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Figure 4-79 Setting the insertion point 
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• Select 18 point from the Style menu. Then go back and select Italic 
to remove the checkmark beside it, which deselects it. 

• Type the following, pressing Return where indicated: 
It's a shame you're (press Return) 
going to look so silly (press Return) 
in that hat!! (press Return) 

,,,. Save your work. 

Now you need to select the text so that you can rotate it, as you did the 
drawing of the cap. 

,,. Select the text with the selection rectangle, and then choose Rotate 
twice in succession from the Edit menu. 

Your screen should now look like the one shown in Figure 4-80. 

=0-- "Greetin Cord" at I 00% 

·------- -- ---------------- ----· l jj1l!q ll!ql U! i 
i AJl!S OS :lfOOJ 01 3U!03 i 
i- -•-~,~-~~ !'_Ill_~'!~-• - _s , ~!- _: 

Figure 4-80 Rotating the text 

• Once the text is rotated 180° click somewhere e lse on the screen to 
deselect the text. 
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ADDING A PERSONALIZED MESSAGE 

Now that you've placed all th e artwork and have typed a ll the text in the 
card, you may want to put a "created by" message on the back of the card 
to personalize it. 

• Drag the scro ll box to the far left in the horizontal scroll bar, and to 
the bottom in the vertical scroll bar, as shown in Figure 4-81. Drag 
the toolbox out of your way to the right side of the screen. 

• Select the tex t tool, and then position the pointer in the lower 
portion of the left side of the screen, as shown in Figure 4-81. 

10 

rec01fn1zed fa 

+ I I II II 
~ ·-· ·-· '? D llil• 
tiO ......... 0 ., 

l I~ ·~ 0 • h ~ C:? • m 0 a « 

Figure 4-81 Positioning the pointer on the back of the card 

• Choose 9 point from the Style menu. 

• Type Ch eapo Cards Company and press Return. 

• Type $17.50, or wha teveryou feel is a good price for your masterpiece 
(see Figure 4-82). 

"Gree tln 

Cbeapo Ca.r-4• Com.paay 
$1 ? . 50 

You've ochfeved your ~\ 
and deserve to 

r ecOIJnfzed fa 

+ I I I I II 
J ·-· ·-· '? D Bl 

yo '£ 0 ......... 0 Ill 

~ '7! 0 • 
h ~ C:? " ~ 0 a ll 

Figure 4-82 Finishing the back of the ca rd 
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ERASING THE GUIDE LINES 
All that remains to be done now is to erase the gui de lines that you d rew 
to partition the four sections of the card for folding. 

• Save your work. 

,,. Choose Zoom Out from the Goodies menu so you'll be v iewing the 
card at SO% size. 

• Select the eraser tool. Whi le ho lding down the Shift key, use the 
eraser to erase the lines. 

Using the Shift key with the eraser will constrain the eraser's movement 
horizontally or vertically, depending on which way you move first, thus 
reducing the risk of erasing other parts of the card. 

If your lines are close to images or text, you may need to zoom in to 
FatBits to delete the lines with more precision. Refer to the first project 
in this chapter, if necessary, to refresh your memory about using FatBits. 

• After you've erased the lines, be sure to save you r work. 

Now you're ready to print your card. 

PRINTING THE DOCUMENT 
• Choose Print from the File menu. 

The Print dialog box will look similar to the one shown in Figure 4-83. 

LoserWriter "LoserWrlter" 5.2 (;EJ 
Coples:lllll Pages: ® Rll 0 From: CJ To: CJ r.:=::::;-"1 

~ 
Couer Page: ® No 0 First PBge 0 Los t Page ~ 

Paper Source:® Poper Cossette 0 Monuol Feed 

Figure 4-83 The Print dialog box 

• Click OK to accept the default settings. 

·• Using the fold Jines shown in Figure 4-62 as a guide, fold the page 
to form a greeting card. 

• If any of the drawings or text are not placed the way you'd like them 
to be, select the item and reposition it to your satisfaction. Then 
reprint the page. 

• Choose Quit from the File 1enu to exit MacPaint. If you want to 
stay in MacPaint and continue with the additional projects, close 
the Greeting Card document 
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SUMMARY 
• MacPain t provides fami liar tools for creating d rawing effects. The tools are found in the 

toolbox, wh ich is a tear-off menu that can be positioned wherever you like in the drawi ng 
window. You select a tool by clicking on it in the toolbox. A selected tool is high ligh ted . 

• Lines are drawn using the line tool and the pencil tool. The pencil too l draws a freehand o ne
pixel-wide line, and the line tool d raws a straight line. 

• Shapes are drawn using the oval tool, the rectangle tool, the rounded recta ngle tool, the 
freehand tool, and the polygon tool. Shapes can be drawn either unfilled or fi lled wi th the 
currently selected pattern. 

• The Shift key constrains the movement of many of the tools. It is used to draw perfect sq uares, 
perfect circles, and straight lines. It also constrains the movement of the eraser to horizontal 
or vertical movements. 

• The eraser is used to erase all or part of an ob ject from the drawing window. Double-clicking 
the eraser tool erases the entire contents of th e drawing window. 

• You select a pattern by clicking on a pattern in the Patterns menu, which is a lso a tear-off 
menu that ca n be positioned anywhere on the screen. 

• Painting is do ne with the spray can tool and the paint brush tool. The spray ca n too l paints 
a "mist", and the paint brush tool pa ints in th e shape of any of the many available brush 
shapes. Both of t hese tool s paint in the currently selected pat tern . 

• The border palette is used to change the vertical and horizontal weights of lines draw n with 
the line too l or in the border of a shape. 

• Text ca n be drawn e ith er with the pencil tool or with the pain t brush tool o r typed using the 
text tool. The options in the Style menu and Font menu apply to the te.xt typed with the text 
tool. 

• Objects are selected using the selection rectangle or the lasso. The difference between the 
selection rectangle and the lasso is tha t the selection rectangle a lso selects the area inside the 
rectangle, including th e white space surrounding an object, whereas the lasso sh rin ks to t he 
exact size of the ob ject and selects on ly the object. An item must be selected before you can 
issue a command that will affect it-to copy or move it, fo r exam ple . 

• The pa int bucket tool is used to fill an object with the curren tly selected pattern fro m the 
Patte rns menu. 

• O nce an ob ject is drawn, you can modify it in several ways. For example, you ca n fl ip an object 
vertically o r horizontally, ro tate it, duplicate it, or delete it. 

• The Zoom In command a llows you to work in a magni fied v iew of your drawing, wh ich takes 
you in 200% incremen ts u p to 800% view. The details of the drawing can be modi fied with 
more precision in soo<J-·6 view, because you can erase o r add one pixe l at a time. 
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KEY TERMS 
active window 
actual size window 
align 
anchor 

border palette 
brush shapes 

Clipboard 
constrain 
copy 
cross-beam pointer 
currently selected pattern 

deselect 
duplicate 

eraser tool 

Fat Bits 
filled 
flip 
font 
freehand tools 

grabber tool 
guide lines 

highlighted 
hot spot 

I-beam pointer 
insertion point 

lasso selection tool 
leaks 
line tool 
line weight 

magnify 
marching ants 
menu bar 

paint bucket tool 
paint brush tool 
paste 
Patterns menu 
pencil tool 
pixel 
points, point size 
polygon tools 

Revert To Saved command 
rotate 
rounded rectangles 

scroll bar 
scroll box 
select 
selection marquee 
selection rectangle 
snap 
spray can tool 

tear-off menu 
text tool 
title bar 
toolbox 

Undo command 
unfilled 

Zoom In command 
Zoom Out command 
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MACPAINT COMMAND KEYS AND SHORTCUTS 
File Menu 
New 3€-N 
Open 3€-0 
Close 3€ -W 
Save 3€ -S 
Quit 3€-Q 

Edit Menu 
Undo 3€-Z 
Cut 3€ - X 
Copy 3€ -C 
Paste 3€ -V 
Ro tate 3€ -T 

Shortcuts Window 

13€ a I [~J Shrin k marquee to fit; stretch selection 

13€ a I [lor ~ Change font size 
13€ a llshift I [l or ~ Change font 
loption ll3€ a I[] or ~ Change line spacing 

loption l l3€ a I Multiple copies; optional paint mode 

I shift l loptionll3€ a I Multiple, pattern-aligned copies 

13€ a I tJ Zoom in 

13€ a l lshift I tJ Zoom out 
l"i':'h'' Use special pattern effects while 
L.:.:::......J dragging a selection 

Double 
Cl ick 

~OOODDDDDDDOO~ 
IT!DDDDDDDDDDDDDD 
CJDDDDDDDDDDDCJ 
lconatrainiOOOOOOO~~Oc:J 

~~~------------~ 
Multiple Copies 

Additional Projects 

Goodies Menu 
Zoom In 3€-M 
Zoom Out 3€ -L 
Shortcuts 3€-H 

Style Menu 
Bold 3€ -B 
Italics 3€ -I 
Underline 3€-U 

loption l Scroll document, except in IAI 
13€ a I Patterned lines and borders 

Se 1 ect wi ndow 

Se 1 ect contents of wi ndow 

Choose brush shape 

Toggl e 1 00% and 800% zoom 

Erase window or document 

Toggle " Draw from Center" 

:---; Select document rc.:iU'l•--' 
~ p Select contents of document 

13€ a I [~J Select co ntents of window 

I shift 113€ a I [~J Select contents of doc 

The followi ng projects are accompanied by briefer instructions than 
those you have previously completed in this chapter. They require that 
you apply what you learned in the first two projects. If necessary, refe r 
to "Using MacPaint's Tools" at the beginning of this chapter for 
information and instructions about using any tools that you aren' t 
familiar with. Experi ment with the shortcuts available from the 
Goodies menu. 

You will not be reminded to save your work-you should be developing 
good saving habits of your own by now. 
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Project 3: Drawing Perspective 

u I _, 

Everybody dreams of having a lot of money, and this project gives you 
that chance. You'll use the polygon tool to draw the bills and the oval 
tool to draw the coins to achieve a look of perspective in the drawing. 
The finished project is shown in Figure 4-84. 

Figure 4-84 Final output for Project 3 

• Use the polygon tool to draw the shape of the bill in the lower left 
part of the screen, as shown in Figure 4-85. 

I "Project 3" ot 1 00% 

+ i lllll 
r:J Po • 
~-..... o • 
~rn_ o • ·:1 

iJ~ C?W 
A u [lll[l• IR 

Figure 4-85 The bill drawn wir the polygon tool 

• Select the polygon with the lselection rectangle, and then choose 
Trace Edges from the Edit menu. 
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The Trace Edges command traces the edges of the selected object, as 
shown in Figure 4-86. When you use this command, the object must be 
selected with the selection rectangle, not the lasso. 

"Pro eel 3" at I OO't 

+ I I II II 
·-· ~ D • 
~ ........ 0 • 
~ I'll 0 • 

~\:::) • It olll• 
··' ' 

Figure 4-86 The bill with the edges traced 

• Erase the top and right outline of the bill, so the bill looks "thick." 

Zoom in to clean up the corners of the bill using the following shortcut 
to zero in on a particular area. 

[fJ • Select the pencil tool, and then hold down the Command key. 

The pointer turns into a small magnifying glass when you move it into 
the drawing area. 

• Click on the area you want to edit in a magnified view. 

The view is magnified in 200% incremen ts each time you click the 
screen with the magnifying glass. See Figure 4-87. 

10 "Pro e el 3" at 200~ 

Figure 4-87 Zooming in to the selected area 
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• To crea te the border on the face of t he bill, select a heavier line 
weight from the border pale te, and select a gray pattern. 

• Select the polygon tool. 

• Ho ld dow n the Command key while drawing the border on the top 
of the bill to get a patterned line. 

Holding down the Command key while drawi ng a line o r shape draws 
the border in the currentl y selected pattern. 

• Use the oval tool to draw the ovals and any other design you want 
on the top of the bi ll. 

Next you' ll c reate the "stack" of bills. 

• Select the bill with the lasso. 

• Ho ld down the Option and Command keys, and drag the bil l toward 
the menu bar at the top of the screen. See Figure 4-88. 

The Option-Command keys allow you to make multip le copies of the 
selected object. If you don ' t li ke the effect you get with your first try, use 
the Undo command and try agai n until the stack is to your liking. 

"Pro ee l ~" ot 100% 

Figure 4-88 The stack of bills 

• To draw the coins, d raw an oval with the oval tool and then 
duplicate it. 

• Zoom in to work in grea ter detail on the rest of the coin. 

• Place one oval on top of the other. Erase where they overlap, as 
shown in Figure 4-89. 
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Figure 4-89 Erasing the overlapping ovals 

• Connect the two ova ls with a vertical line on each side to form a 
coin . 

• Close up a ll the gaps in the borde rs of the ova ls. 

• Fill the edge of the coin (the space between the two ovals) with the 
paint bucket using the vertical line patte rn in the Patterns menu, as 
shown in f-i gure 4-90. 

iD "Project 3" a t 200% i 

~ 
+ I I II II 1-

·-- p D GJ 

~ '- 0 Q 

~ ~ 0 0 
J!J ~ <::? ~ ~ A 0 a a 
~ 

' 15 
0 1 >: : i·.,: ' ··· '"l' .,;}': ,;;:-:- ' 11. T~IQ: 

Figure 4-90 Filling the edge of the coin with the paint bucket 

• Choose Draw from Center from the Goodies menu. 

You' ll use this option to draw the ova l o n the face of the coin . The Draw 
Fro m Cen ter command allows you to d raw shapes from the center 
instead of from the edge. This usually makes drawing shapes in a 
pa rticu lar loca tion easier. When Draw From Center is in effect, you'll 
see smal l crosses in the center of some of the tools in the toolbox. To 
turn off Draw From Cen ter, choose Draw From Edge from the Goodies 
menu. 

• Select the ova l tool, and then posit io n the cross-beam pointer in 
the center of the face of th e coin . 



Chapter 4: MacPaint 2.0 119 

• Drag to create an oval slighJly smaller than the face of the coin. 

• Use the penci l tool in FatBits to draw a face or other design o n the 
coin. 

• Select the coin with the lasso and, using the Option key, duplicate 
the coin to form several stacks of coins. 

·• Position the coin stacks around the stack of bills. 

Project 4: Creating a Logo 

In thi s project you' ll put together a few simple shapes-a polygon, two 
circles, and some li nes- to create a logo. You'll a lso create some special 
effects with the eraser tool and with the In vert command. The finished 
project is shown in Figure 4-91. 

Figure 4-91 Final output for Pro ject 4 

• Select the li ne tool, and th en select th e third line weight on the 
border palette . 

• Ho ld down the Shift key to constrain the line to a 45° angle and draw 
six lines each about 2 inches long. 

If you rest the bottom of the cross-beam pointer on one line as you draw 
the next one it helps you keep 1n equal distance between each line. 

,,. Select the group of lines with the selectio n rectangle, and use the 
Option key to duplicate the1

11 , as shown in Figure 4-92. 
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i!J----- "Pro ·eel 4" at I 00% 

Figure 4-92 Duplicating the group of li nes 

.. Whi le the duplicate lines are stil l selected, choose Flip Horizontal 
from the Edit menu. 

Now you'll duplicate these flipped lines to fo rm the background of the 
arrow. 

• Select the top part of the duplicated li nes with the lasso. Using the 
Option key, place a duplicate of tha t portion on either side o f the 
group of lines, as shown in Figure 4-93. 

mJ "Pro eel 4" at 100% 

Figure 4-93 Duplicating the lines for th e arrow background 

.. Zoom in to 200% size, and then use the polygon tool to draw the 
a rrow, as shown in Figure 4-94. 
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Figure 4-94 Creating the arrow with the polygon tool 

• Zoom in to 400% or larger, and use the eraser and the pencil to erase 
all the lines that extend beyond the outline of the arrow. 

• Zoom out to 100% size and select the eraser tool. Hold down the 
Shift key to constrain the eraser's movement, and erase the top of 
the left group of lines, as shown in Figure 4-95. 

' 
Figure 4-95 Erasing the lines horizontally 

• Hold down the Shift key to erase first vertically and then horizontally 
so the bottom of the left group of lines forms a point, as shown in 
Figure 4-96. 
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Figure 4-96 Erasing to form a point 
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• Select on e group of lines and move them away from the other so 
you'll have room to work. Scroll the screen so you're not working 
on top of the lines. 

• Use the oval tool with the Shift key to create a circle about 1 3/4 

inches wide. 

• Select that circle with the lasso and place it on top of the group of 
lines that forms the arrow, as shown in Figure 4-97. 

~0 "Pro eel 4" 81 1 DO% 

Figure 4-97 Positioning the circle on the arrow 

... Select Draw From Center from the Goodies menu, and then draw 
another slightly smaller circle inside the first one. 

.. Select the left group of lines with the lasso, and place them on the 
circles, as shown in Figure 4-98. 
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i!D "Project 4" ot I O% 

Figure 4-98 Positioning the lines on the circles 

,,. Zoom in to FatBits and use the pencil tool to erase the parts of the 
circles that show through the lines. 

.. Zoom out to 100% size. 

Now you' ll type the text for the logo. 

• Select the text tool and set the inserti on point away from the rest of 
the drawing. 

• Type Stanford Recycling Center in a bold, 18 point font of your 
choice (the example uses Helvetica) . 

• Select the text with the selection rectangle. Select only a small 
amount of the background with the text, as shown in Figure 4-99 . 

r----------------- ~-------- - ---

: Stanford Recycling Center: 
L-----------------------------~ 

Figure 4-99 Selecting the background with the text 

,,. Choose Invert from the Edit menu. 

The Invert command changes black dots to white and white dots to 
black in a selected area. 

• Position the text on the logo. Refer to the finished logo shown in 
Figure 4-91 at the beginnin& of thi s pro ject. 
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Chapter 5: MacDraw II 

What You Will Learn in This Chapter 

After reading this chapter, you should be able to: 

• Draw lines and rectangles 

• Resize rectangles, lines, and tex t 

• Use the Sh ift key to constrain lines horizontally and vertically 

• Draw objects fill ed with a selected pattern 

• Change line weights from the Pen menu 

• Add text to a drawing using the text tool 

• Change the style and font of text 

• Reposition objects and text 

• Group objects to form a composite object 

• Save and print documents 

• Select and move multiple objects at o ne t ime 

• Change th e fi ll pattern of selected ob jects 

• Change the line pattern of selected lines 

• Fill the text background with a pattern 

• Move ob jects in their stacking o rder 

• Use Autogrid for precise alignment of objects 

• Align objects to one another 

• Use the zoom controls to v iew a larger portion of the drawing 

M acPaint works like using a pen, pencil, or brush on paper to 
create your drawin g. If you wan t to modify an object in 
MacPaint, you "erase" by changing a black dot to white. If you 

move o r draw a shape on top of anothe r in a bitmapped drawing 
program such as MacPaint, the shape beneath is removed beca use the 
dots are changed to represent the one that was d rawn or moved o n top. 
No record of the o ne beneath remains, just as if you had e rased it fro m 
the paper. 

MacDraw II works more like cutting ob jects o ut of constructio n paper 
and then arranging th em to form a pictu re. If you draw or place an 
ob ject on top o f ano ther in an ob ject-oriented drawing program such as 
Mac Draw II , the item beneath sti ll remains. You ca n move aside the o ne 
on top and the shape undern eath is un changed, just as it would be with 
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shapes cut ou t of construction paper, because object-oriented drawing 
programs store a definition of each object's location, shape, size, and 
depth level. 

MacDraw II's drawing surface can be 69 square feet, compared with 
MacPaint's 80 square inches. MacDraw II 's grid and ruler allow you to 
precisely place objects o n the drawing page. A less soph isti ca ted grid is 
avail able in MacPaint, but a ruler is not. In MacDraw Il you can edit text 
in more o f a word p rocessing fashion, where you can select tex t and then 
type over it to mod ify it, and you can control the placement o f the 
insertion point. MacPaint's text editing is very limited-you can either 
correct errors by backspacing while typing or erase the text and retype. 

Since the printed output of MacDraw II and most object-orien ted 
programs is superior to that of paint programs, MacDraw II is popular 
among draftspersons as well as artists. Although MacDraw II is a 
powerful drawing program with many features that exceed the scope of 
this book, you' ll use many of the tools of this object-oriented d rawing 
program to create some introductory and intermediate level drawings. 

MacDraw II is best for jobs that involve a lot of text and text editing, o r 
ones that require precise placement and alignment of o bjects, o r ones 
that require smooth, high-quality output. Freehand drawing and quick 
illustrations are easier in MacPaint. In working through these projects, 
you' ll see some of the d ifferences, advan tages, and d isadvantages of 
working with a bitmapped graphics program vs. an object-oriented 
graphics program. 

STARTING MACDRAW II 

• Double-click o n the MacDraw II icon to open a new, untitled 
d rawing window. 

Every new documen t has the title "Untitled-Layer#l" until you save it 
for the first time and give it a name. 

The drawing window shows o n ly a part of the available drawing a rea, 
which is preset to a single page for a new document. The drawings you'll 
be creating in the projects in this chapter will fit on one page, al tho ugh 
a MacDraw II drawing can be as large as 69 square feet. 

A menu bnr runs across the top of the screen: 

' li File Edit Layout Arrange Pen Font Size Style 

You' ll learn about many of the options on the menus as you work 
through the projects. 



126 

GETTING HELP 
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Many applications provide o nline help fo r q uick re ference when you are 
using different tools and commands. Unfortunately, MacDraw II is not 
one of these programs. The reference manua l that you get when you 
purchase MacDraw II is very comprehensive, however, and includes a 
tutorial as well as detailed descriptions of the features of each tool and 
command. 

SAVING YOUR WORK 

The first time you save your document, Mac Draw ll asks you, by way of 
the dialog box shown in Figure S-1 , where you want your document 
saved and what you want it to be named. After you have saved a 
document the first time, the next time you choose Save, MacDraw II 
assumes that you want the document to be saved in the same place and 
under the same name. Be carefu l about saving your document in the 
correct place the first time you save it so you can find it later. The save 
process is much quicker the second and subsequent times, because you 
a re not prompted for any additional informa tion. 

Unfortunately, sometimes people are not ca reful, and they occasionally 
lose their work because they save it but do not think about where they 
a re saving it and then can't find it again. Clicking the Drive button (see 
Figure 5-1 ) toggles between one or m ore floppy d rives and hard drives, 
depending on the hardware you are using. The Save dialog box shows 
the name of the floppy disk or hard drive as that drive is selected. You 
are saving you r document on the selected disk o r hard drive with the 
name showing in the Save dialog box. In the dialog box shown in Figure 
5-l , the name of the disk, Pamela Gurnari, is shown in two places. 
Always be aware of where you are saving your work. 

The Save As command is similar to the Save command, except that it 
enables you to give your document a diffe rent name and save it in a 
different loca tion. Every time you choose Save As from the File menu, 
you are prompted with the dialog box shown in Figure 5-1. This is the 
same dialog box you see the first time you save your documen t. 

When you use th e Save As command and you attempt to save the 
document with the same name and in the same location as before, you 
will be asked if you want to replace the o ld documen t. This is because 
no two files in a particular locatio n can have the same name. If you wa nt 
to save different versions of the same document, use the Save As 
command and give the document a differen t name and/or location. 

Saveyour workoften-at least every ten mi nutes, so you never lose more 
than ten minutes of work. The Command-key eq uivalent of the Save 
command, Command-S, is a helpful shortcut. Practice it often, and it 
will become auto matic. Always save your work before printing. 
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Figure 5-1 The Save dialog box 
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Be aware that you can save a document before you actua lly type 
anything into it, and that many people do it this way. However, you will 
be given instructio ns fo r saving your work at appropria te times 
througho ut the projects in this chapter. 

USING MACDRAW'S TOOLS 

Text Tool 

The tools palette shows the drawing tools that you can use to create 
graphics. The nine icons in the tools palette represent the types of 
objects that the tools create. 

The po inter changes to a cross-beam when it moves into the drawing 
window, which is the grid yo u see on the screen. The cross-beam and the 
gridlines make it easier to positio n objects. 

To draw an object, yo u first sele~t a tool by clicking on it. After you've 
drawn an object, black squares called handles appear around the object. 
The selection arrow (at the top o f the tools palette) becomes automatically 
active, and the tool you d rew with is no longer active. You can 
manipulate th e object with the selection arrow. 

A tool becomes highlighted in gray when you select it by clicking once 
on it. It becomes highlighted in black when you click twice o n it. When 
it is highlighted in black, it remains the selected tool after you complete 
an action with it, rath er th an auto mati cally defaulting to the selectio n 
arrow. 

Now you' ll get some practice with each of these tools before beginning 
Project 1. 

The text too/ is used for typing te it. Not only does text typed in Mac Draw 
11 print in a very high qua lity, it is also easy to change parts of words o r 
sentences. 

• Select the text tool by double-clicking on it. 

Double-clicking on the text tool will keep it active until you select 
another tool. 
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Click in the center of the screen to set the insertion point for where 
the text will begin, and then type Using the text tool. 

- Clickanddragthrough the word the in the line you just typed. (You 
can also double-click on a word to select it.) 

The selected word becomes highlighted, as shown in figu re S-2. 

: : 

. ;--·····-···--·--···-'··--·····--······-···-··-, . 
: ! Using Ill text tool !: . .. ......................... -.. -···········-···-·············:. 

Figure 5-2 Selecting a word with the text tool 

• Type MacDraw II 's to replace the word "the" that you highlighted. 

Your sentence now reads "Using MacDraw Il's text tool". 

You can reposition text on the screen without having to retype it. You 
use the selection arrow for this. 

• Click on the selection arrow to select it, and then click anywhere on 
the text you just typed. 

Notice that small black squares, called handles, appea r around the block 
of text. The presence of these handles indicates that the object is 
selected. 

• Click on the text with the selectio n arrow, but don't cli ck on one of 
the handles. 

• Drag the text to another part of the screen, and then release the 
mouse button. 

Your text should be positioned in another part of the screen. 

To delete an object, you select it by clicking on it, and then you press the 
Backspace key (Delete key o n some keyboards). 

• Select the text (if it is not already selected), and then press the 
Backspace key. 
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Line Tool 
The line tool is used to draw straight lines. The width of the line is 

I 
controlled by the Pen menu. Yjo u' ll learn more about the Pen menu 
later, in Project 1. 

.,.. Select the line toot and then draw a line about 2 inches long. 

When you release the mouse button, the line is selected, as shown by the 
handles on either end. 

Now you'll lengthen the line ydu just drew . 

. ,. Click on the line's right handle with the selection arrow and drag 
about '/z inch to the right, and then release the mouse button, as 
shown in Figure S-3. 

Figure 5-3 Resizing the line 

Your line should now be length~ened by ' f, inch. 

You can shorten a line in the same manner. 

,,.. Practice drawing and resizing some lines now, and when you are 
ready to go on to the next tobl, select the lines and then delete them 
using the Backspace key. 

Rectangle and Rounded Rectangle Tools j 

rr==il 1 0 1 The rectangle and rounded rectangle tools allow you to draw rectangles 
~ and squa res, filled with a patternlthat you select. Any Mac Draw II object 

that you create can have its size changed, its border changed, and its fill 
pattern changed. You'll experi~ent with the rectangle border later in 
this chapter. To resize an object) you drag the handles on its boundary. 
When the mouse button is rele~sed, the ob ject takes on its new size. 

,.. Select one of the patterns i the pattern palette at the to p of the 
drawing window, and then elect the rectangle tool. 
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It doesn ' t matter whether you se lect the pa ttern o r the tool first. To 
select a pa ttern from the pattern palette, just cl ick on the pattern. You'll 
learn more abou t the pattern pa lette in a few minutes. 

• Click and drag in a di agonal manner from upper left to bottom right, 
and re lease the mouse butto n when you have a recta ngle. 

When you release the mouse button, the recta ngle is selected. Your 
screen shows the rectangle filled with the pattern you chose before you 
drew th e rectangle. You can also change the pattern o f an ob ject after 
you d raw it. 

• Whi le the rectangle you just drew is sti ll selected, click on the white 
pattern in the pattern pa lette. 

Th is causes the pattern in the rectangle to change to wh ite. 

To change the size of an object, click on one of the ha ndles. Drag towa rd 
the object to make it smaller, and drag away from it to make it la rger. 

• Click o n one of the handles of the selected rectangle, and drag 
toward the rectangle to make it sma ller, as shown in figure S-4. 

.. : .. . •llH 
: I 

, · · i I t:_:··-·-: ----\ I 

Figure 5-4 Resizing the rectangle 

If you want to move an object to reposition it, don't place the pointer 
on one o f th e han dles-place it on anothe r pa rt of the object and drag 
to the new posit io n . 

• Drag to reposition the rectangle on another part of the screen (do 
not d rag by one of the ha nd les). 

• De lete the rectangle by pressing the Backspace key when the 
recta ngle is selected. 

To draw a perfect square, hold down the Shift key when d rawing with 
either the rectangle or rou nded rectangle. 
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Corner/Center Control I 
~ In many cases, you will need to control t he placement of the center 
~ po int o f the o bject you are drawing. MacDraw lets you control it using 

the comer/center control, which appears below the tool palette. The 
rectangles and lines you just d rew were drawn from the corner. 

Oval Tool 

~ 
L:iJ 

~ 
L:iJ 

• Click once on the corner/center control. 

The control changes to represent an object drawn from the center. 

• Select the rounded rectangle tool. 

• Positio n the pointer in the center of the screen. Ho ld down the Shift 
key while dragging to create a rounded square that is drawn from the 
center. 

If you click once on the corner/center control, it becomes center/corner; 
if you click it again, it goes back to corner/center. 

Practice drawing some other rectangles and squares, from the center and 
from the corner. Practice resizing the rectangles you draw by dragging 
one o f the handles. Delete the ob jects when you are ready to go on to 
the next tool. 

The ova l tool is used to draw ovals and circles filled with a pattern of your 
choice. Like the rectangles, you can change the border thickness and 
patte rn of the oval either befo re you draw it or after, and you can resize 
the oval or circle by d ragging one if its handles. The corner/center 
control is also usefu l with the oval tool. 

To crea te a perfect circle, hold down the Shift key when you draw with 
the ova l tool. 

• Check to see that the corner/center control is set to draw from the 
center. 

• Double-click o n the oval too l to select it if you want to d raw more 
than one object. 

The ova l tool is high lighted in black to show that it will be selected unti l 
you choose another tool. 

• Position the pointer in the center of the screen, ho ld down the Shift 
key, and click and d rag to draw a circle about 2 inches across. 

• Position the pointer at the same center point that you just used to 
c rea te the fi rst circle, and use the Shift key again to draw a circle 
about 1 inch across. 
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Arc Tool 
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You should have one circle centered inside of the other circle, as shown 
in Figure 5-S. 

Figure S-5 One circle centered inside of the other 

Practice drawing additional circles and ovals using the corner/center 
contro l and different patterns. Delete the ob jects from your screen 
before going on to the next tool. 

• Set the corner/center control back to "draw fro m corner" before 
going on . 

The arc tool is used to draw part of a circle or part of an ellipse. When it 
is used in con junction with the Shift key, the result is a quarter of a circle. 
You can change the thickness of the border of the arc before you draw 
it, but you fill it with a pattern after it is drawn. When an arc is filled 
with a pattern, it takes on a pie-shaped appearance. 

• Click on the arc tool to select it. 

• Click and drag to create an arc. 

The d irection in which you move the mouse while drawing the arc 
determin es the shape of the arc. Figure 5-6 shows several arcs and the 
direction the mouse was moved when they were drawn. 
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Figw·e S-6 Arc shapes created by different mouse directions 
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• Click on a pattern in the pattern palette to fill th e arc with that 
pattern. 

Practice drawing some arcs by dragging in di ffe rent d irections to see 
how the directio n affects the shape of the arc. Use the Sh ift key to create 
quarter-circles. Clear the screen before going on to the next tool. 

Freehand Drawing Tool 
The freehand tool allows you to draw an irregular o r curved freehand 
shape similar to that created with a penci l. Freehand sha pes do not fill 
with a pattern as you draw them, but you ca n select a freehand shape 
and fill it with a pattern after it is drawn. You can also change the border 
thickness and border pattern. As with the other shapes you've learned 
about, you can resize an object drawn with the freehand tool by 
dragging one of its handles. 

After you draw a freehand ob ject, MacDraw II a utomati cally srnooths the 
shape to get rid of any jagged lines. 

•• Click on the freehand tool to select it, and then position the pointer 
in the drawing window. 

• W ith the mouse button h'td down, cl ick and drag to create the 
shape of a fish or your favorite ani ma l. Do not release the mouse 
button until the shape is com pleted. 

When you release the mouse butto n, the shape is smoothed, and 
handles appear that enclose the shape in a rectangular border. 
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• Wh ile the shape is sti ll selected, cl ick to select a pattern from the 
pattern pal let. 

The shape you drew shou ld be selected and filled with a pattern , as 
shown in Figu re S-7. 

·· ··········-. ···:········· . 
. 

. .. ... ~ . 

Figure S-7 The freeha nd shape selected and filled with a pattern 

Smoothing and Unsmoothing 

If you do n' t want th e ob ject you drew with the freeh and tool to be 
smoo th ed, you ca n use the Unsmootll command from the Edit m enu to 
te ll MacDraw to leave the object in angular form. 

3C -S hi ft -E • Select the a n imal you drew if it is not still selected, and choose 
Unsmoo th from the Edit m enu. 

ow the shape appears as it would if it had not been smoothed after you 
d rew it. To smooth the drawing again, ch oose Smooth from the Edi t 
me nu. 

Reshaping 

You ca n also use the Reshape command to change the shape of a n object 
d rawn with the freehand tool. When you choose this command from 
the Ed it menu, h and les are placed along the length o f the border of the 
ob ject, and you can drag those handles to change the object's sh ape. 
When a freehand object has been unsmoothed, you ca n also add extra 
h andles by clic king o n th e outline of the shape. 

3C-R • Select the shape you drew if it is no t a lready selected, a nd choose 
Reshape fro m the Edit menu. 
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• Cli ck and drag one of the handles on the border of the shape, and 
then release the mouse button. 

Figure 5-8 shows the fish with its head reshaped. 

Untltled-Layer/1 1 

Figure S-8 Reshaping the fish's head 

,,. Continue to reshape your drawing, and then click on another part 
of the screen to stop reshaping. If your drawing is still unsmoothed, 
choose Smooth from the Ed it menu. 

When you are finished perfecting your drawing, clear your screen before 
going on to the next tool. 

The polygon tool is used to d raw shapes that are composed of straight 
lines and angles. After the polygon is drawn, you can fill it with 
a pattern. You can also modify a polygon 's border thickness and border 
pattern. 

This tool is si milar to the freeha nd tool, since you can use the Smooth, 
Unsmooth, and Reshape commands with polygons as well. When 
you draw a polygon, it is not automatically smoothed as a freehand 
shape is. 

• Select the polygon tool, and then click once in the center of the 
screen to set the starting point of the polygon. 
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You do not drag while using the polygon tool; you just click to direct the 
line between the two points it is connecting. 

• Now click an inch o r so to the right of the starting point. A line will 
fo llow th e poin ter o n th e screen. 

• Click to create several mo re points and lines, and then double-cli ck 
to finish drawing the sha pe. 

Figure S-9 shows a shape drawn wit h the polygon tool. 

Figure S-9 A shape drawn with the polygon tool 

3€ - E • Choose Smooth from the Edit menu. 

Figure 5-10 shows the same shape after it has been smoothed. 

'1([' : : . . . 
. . . . . . . . . . . . . . ................. . . . . . . . . . . . 
. . . . . . . . 
. . . . . . . . 

Figure 5-10 A smoothed shape draw n with the polygon tool 
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Practice using the polygon tool.! Use the Reshape command from the 
Edit menu to modify the shape. 

• Do not clear the screen, because you'll use the shapes to practice 
with the selection arrow. 

The selection arrow is automatically active when you open a new 
untitled drawing window. You've already used it for selecting and 
resizing objects and text. 

There are several ways to select an object (any shape you create in 
MacDraw is considered an object, including text). One way that you've 
already used is to click on the object with the selection arrow. 

Another way to select with the selection arrow is to click and drag the 
selection arrow around an object, which draws a dotted rectangle 
around the object. The object must be completely enclosed by the 
rectangle for it to be selected. This method is especially helpful when 
you select multiple objects. You click and drag around a group of 
objects, and all that are completely enclosed by the dotted rectangle 
become selected and can be manipulated together. You can tell that the 
objects are selected because their handles will show. 

"• If you do not have more than one object on your screen, draw a few 
now. 

",.. Click at the top left of the group of drawings and drag diagonally to 
the bottom right, so that all the drawings are enclosed by a dotted 
rectangle. See Figure 5-11. 

. . . . 
·-- - - -. - - ------~- -- ------.-- - -- - - -~--------~----, 
' ' . "!. " 0: " ~ " " " -: . " ' . : . ~--2; . '!" . ~ " 
' . . I . J ' . 
I , . , , I , 

I , , , . . I • 

. .. : .... : ... .. :~ .. . .. · .. . . ! .: .... . . . . . . . . : ... : . . . 
I ' • ' ' ' I ' 

I • • ' ' ' I . 

I • • • ' ' I ' 

'· ... ·:· .. . . . .. ·:·· --.... · :· .. . ... --:--- -- ----:----~ 

Figure 5-11 Dragging multiple objects 
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When you release the mouse button all objects that were completely 
enclosed by the dotted rectangle are selected, as shown in Figure 5-12. 

. . . 

···· ···a• . ;~··· · ·· · ······ ·· ·· ·;,7 · · ······ 
. . . . . ~] . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
. . . . . . . . . . . . . . 

Figure 5-12 All objects selected 

• Click somewhere on the screen to deselect the objects, but don't 
delete them yet. You' ll use them in a minute. 

The layer controls appear at the bottom of the tools palette, and they 
enable you to move between the layers in a Mac Draw document. Working 
with layers in MacDraw II is similar to working with transparent film. 
You can create many layers in a document and work with each as a 
separate drawing or view them all at once in a specific stacking order. 
Due to the introductory nature of this book, we have not included any 
projects that use MacDraw's layers. All MacDraw documents consist of 
one layer-Layer #1-unless you specify otherwise. The layer controls 
are not functional unless there is more than on e layer in a document. 

...... 

1 00 The zoom controls in the lower left corner of the screen allow you to 
enlarge a drawing to see details or reduce it so you can see more of it on 
the screen. The zoom controls look like mountains. 

To enlarge your view, click the right zoom control. You can keep 
clicking on the right zoom control to magnify up to 3200% in 
predetermined increments. The zoom percentage box just above the zoom 
controls shows at what percent you are currently viewing the document. 
The right zoom con trol dims when the drawing has reached its maximum 
viewing size . The left zoom control works the same way for reducing the 
viewing size, enabling you to reduce the drawing to 3.12% in 
predetermined increments. To bring the drawing back to its original 
size, click the zoom percentage box. You can edit your drawing at any 
zoom level. 
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• Click the right zoom control to enlarge the view of your document 
to 200(Yo. 

Notice that the zoom percentage box now reads "200". 

• Use the zoom controls to experiment with reducing and magnifying 
the view of your document. When you are finished, click on the 
zoom percentage box to return the view to 100%. 

The pattem palette, at the top of the screen, allows you to fill an existing 
object with a pattern and to fi ll an object as you draw it. 

To fill an existing object, click on the object to select it. Handles appear 
to show that the object is selected. Select the desired pattern from the 
palette. You can change the pattern whenever the object is selected. 

To create a new filled object, select a drawing tool, select a pattern from 
the palette, and then d raw t he object. 

The fill pattern box, at the far left of the palette and to the left of the arrow, 
reflects the currently selected fill pattern. MacDraw's preset fill pattern 
is white. An ob ject filled with white blocks the view of ob jects behind 
it. You can use the left and right scroll arrows on the pattern palette to 
view other patterns. 

The line pattern box is at the far right of the pat tern palette and to the 
right of the arrow, and it reflects the currently selected line pattern. To 
draw a patterned line, you click the line pattern box and choose a 
pattern before you draw. MacDraw's default line pattern is black. To 
change the li ne pattern of an existing line, the line must be selected fi rst. 
Then you click the line pattern box and select the pattern you want 
to use. 

,. Select o ne of the ob jects in your drawing, and then select a pattern 
in the pattern palette to change the fill pattern. 

,,. With that same ob ject still sJlected, click on the line pattern box at 
the far right of the pattern palette, and then select the same pattern 
that you used as a fill pattern. 

The ob ject should now have the same line and fill patterns. 

Experiment with different line and fill patterns, and then delete all the 
objects on the screen. 

• Before continuing with the rest of the project, change the line 
pattern to black and the fill pattern to wh ite. 
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AUTOGRID ON/OFF 
The Autogrid feature of MacDraw II controls where you draw objects in 
a document and what size the ob jects can be. 

When you first o pen an untitled MacDraw II drawing window, Autogrid 
is automatically turned o n. This means that when you draw an object, 
it will snap to the grid increments on the screen. 

Using Autogrid ensures tha t your objects are placed on the drawing's 
grid and makes it easier to align objects. When you move objects, they 
will always align to the divisions of the grid. You cannot place or draw 
objects between these grid divisions as long as Autogrid is on. 

To have MacDraw II ignore the grid, choose Turn Autogrid Off from the 
Layout menu. This allows you to place and draw objects anywhere on 
the screen. Placement o f objects can be more precise when you work 
with Autogrid off. 

There will be times when it will be easier to draw and place objects with 
Autogrid on and times when you 'll want to turn off the Autogrid feature. 

The screen looks the same whether Autogrid is on or off. The presence 
of the gridlines in an untitled drawing window is controlled by a 
different command. 

HIDE/SHOW GRIDLINES 
When you first open an untitled drawing window, the gridlines 
automatically show. The grid lines are composed of dots that represent 
where Autogrid will constrain your objects, and they can be used as 
guides to help you place objects accurately. Gridlines do not appear 
when the document is printed . 

To hide the gridlines, choose Hide Gridlines from the Layout men u. 
Hide Gridlines is not available on the menu unless gridlines are showing 
on the screen . 

HIDE/SHOW RULERS 
When you first open an untitled document, the rulers are not turn ed on. 
If you want to use them, you have to turn them on. 

• Choose Show Rulers from the Layout menu. 
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A ruler now runs along the top a , d left sides of the drawing window, as 
shown in Figure 5-13. 

Figure 5-13 The MacDraw window with rulers showing 

The current ruler settings control the spacing of the grid that is in effect 
when you begin to draw. The default ruler settings set the grid to 
1/s-inch increments, and you can see the incremental markers on 
the ruler. 

Project 1: Creating a Form 

This assignment shows you how to create a telephone message form 
using Mac Draw II. You'lluse the rectangle tool to create the background 
border and message option box and the line tool to create the lines in 
the form. The text tool will be used to create text that will be 
repositioned in the body of the form. Once you've completed the form, 
you'll duplicate the entire message slip so that four will print on a page. 

The finished project is shown il Figure 5-14. 
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To To --------------------------------

Dale Time Da l e ------- Time -------------

WHILE vou WERE OUT WHILE VOU WERE OUT 
11 

M ______________________________ __ 

of 
of ______________________________ __ 

Phone No. Phone No. 

TELEPHONED PLEASE CALL TELEPHONED PLEASE CALL 

WAS IN TO SEE YOU WILL CALL BACK WAS IN TO SEE VOU WILL CALL BACK 

WANTS TO SEE YOU URGENT 
WANT S TO SEE VOU URGENT 

RETURNED YOUR CALL RETURNED YOUR CALL 

Message Message ---------------------------

By By ------------------

To -------------------------------- To 

Date ------- Time ------------- Date Time 

WHILE VOU WERE OUT WHILE VOU WERE OUT 
M ______________________________ __ 

M 

of ______________________________ __ of 

Phone No. Phone No. 

TELEPHONED PLEASE CALL TELEPHONED PLEASE CALL 

WAS IN TO SEE YOU WILL CALL BACK WAS IN TO SEE YOU WILL CALL BACK 

WANTS TO SEE YOU 
URGENT 

WANTS TO SEE YOU 
URGENT 

RETURNED YOUR CALL RETURNED YOUR CA LL 

Message -------------------------- Message 

By ------------------
By 

Figure 5-14 Final output of Pro ject 1 



Chapter 5: MacDraw II 143 

• Before you begin the projec , your screen should be showing the 
rulers at the top and left of he drawing window. If they are not 
showing, choose Show Rul rs from the Layout menu. 

• The corner/center control should be set to drawing from the corner. 
If it is not, click once on the control to change it. 

• The line pattern should be black, and the fill patte rn should be 
white. If they are not, refer to the information about the pattern 
palette earlier in this chapter for instructions about changing the fill 
and line patterns. 

• If necessary, clear the screen of your practice drawings. 

DRAWING AND FILLING A RECTANGLE 
The first part of the form that you' ll draw is the rectangle that is the 
border. 

,.. Select the rectangle tool. 

,,,. Using the top and side rulers as gu ides, place the pointer at 1/4 inch 
on the top (horizontal) ruler and 1/4 inch on the left (vertical) rule r. 

,.. Click and drag to form a rectangle that ends at 4 inches on the 
horizontal ruler and 4 1/ 4 inches on the vertical ruler. 

Theviewofthe rectangle you are creating will automatically scroll when 
you drag the cursor past the bottom edge of the window to reach the 4 
1/4-inch mark. Figure 5-15 shows the drawing window after it has 
scrolled, with the vertical scroll box in about the middle of the screen. 

Figure 5-15 Scrolling to view the bottom of the rectangle 

If you make an error and want to dele te the whole rectangle, press 
Backspace (or Delete on some keyboards) while the object is selected. 
This works for any object that you create in Mac Draw. You cannot erase 
part of an object in MacDraw. 
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Next you'll change the fill pattern of the rectangle you just drew. 

The empty fill pattern creates transparent objects, which lets objects 
underneath show through. 

When you select an object that is filled with a transparent pattern, you 
must click on its border to select it. If an object is filled with any other 
pattern, including white, you can click anywhere on the object to select 
it. White is the default fill pa ttern (except with polygons and freehand 
shapes, which are filled with the transparent pattern). 

• If the rectangle you created is no t alread y selected, select it by 
clicking anywhere on it. Since you want the rectangle to be 
transparent, select the empty fill pattern from the pattern palette, as 
shown in Figure 5-16. 

L 
.. 
. . 
. . . . . . . . . . . . . . . . . . . . . . . 

I 

I 
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I .. .. ... .. ... .. .. ..... 'I' ..... 

I ............................ , 
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Figure 5-16 Changing fill pattern to empty 

Now is a good time to save what you have do ne so far. 

SAVING THE DOCUMENT 

Yo u save a document the same way in all standard Macintosh 
applications, by choosing Save from the file menu. 

~ -S • Choose Save from the File menu. 

• In the resulting dialog box, click the Drive but to n, if necessary, to 
be sure that your name is showing where "Pamela Gurnari " is 
showing in Figure 5-1 7 o r that you are saving to th e correct drive and 
folder. 
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I (g) Pamela Gurnari I I 
g (g) Pemela Gu .• 

1
• 

Eject 

Oriue 

Saue drawing as: Saue 

[ Cancel 

®Drawing 0 Stationery 0 PICT 

Figure 5-17 The Save dialog box 

When saving a MacDraw II document, you can choose one of three 
document formats. They are sho'wn in the bottom of the dialog box in 
Figure S-17. Drawing format is the preset option, and it causes the 
document to be saved as a MacDraw picture. The Stationery option lets 
you save the document as a te¢ plate that records settings, drawing 
elements, and other preferences. I The PICT option saves the drawing in 
a special format so you can transfer the drawing to another application 
that uses the PICT file format. You will use the default Drawing format 
for the projects in this book. 

• Type the name of this document as Telephone Message Slip, and 
then click the Save button. 

The name at the top of your document is now "Telephone Message 
Slip-Layer#l". 

SELECTING OBJECTS 
Earlier in this chapter you learned two ways to select objects: by clicking 
on an object with the selection arrow and by dragging completely 
around one or more objects with the selection arrow. The second 
method is useful for selecting multiple objects at one time. 

You can also select multiple objects by using the Shift-click method. 
Hold down the Shift key and click on each successive object that you 
want to select. If you do not hold down the Shift key, each object will 
be deselected when you select the next one. 

8€ -A To select all the objects in the drawing window, choose Select All from 
the Edit menu. 

MOVING OBJECTS 
To move an object, you select it and then drag the object to its new 
location. (Do not click on one of the handles to drag it, because that will 
resize it.) An outline of the object follows the pointer. When you release 
the mouse button, the object will be in its new location. 



146 Part II: Graphics 

To move multiple objects at one time, you first select the o bjects using 
one of the methods described above. Then, dragging any one o f the 
group o f objects will move all the selected objects at one time. Be sure 
to click o n one of the selected objects or you will deselect all you have 
chosen. 

DELETING OBJECTS 

The most straightforward way to delete an object from the drawing is to 
select it and then press the Backspace key. Another way to delete an 
object after selecting it is to choose Cut or Clear from the Edit menu. To 
delete the entire drawing, choose Select AH from the Edit menu and 
then press the Backspace key. 

3€ -Z To undo a change made to your screen , whether you mistakenly delete 
an ob ject o r you don ' t like the results of a change to an object, 
immediately choose Undo from the Edit menu. Undo will undo the last 
command o r the las t action of the mouse. 

CREATING LINES OF VARYING WEIGHTS 

Yo u can use a variety of line weights in MacDraw. The weights of lines 
are measured in points-the higher the point size, the heavier the line 
weight (the thicker the line). To create a new line of a certain size, or to 
create a shape that has a certain size border, select the appropriat e tool, 
and then select the po int size from the Pen menu. This line width will 
be used for all lines and shapes you draw until you select a different point 
size. The preset line weight in MacDraw is 1 point. 

To change the line weight of an existing line or shape, you first select the 
o bject. The object will have h andles around it to show it is selected. 
Once it is selected, you can choose a different point size from the Pen 
menu. The line weight then changes to the point size you selected. 

Yo u' ll change the line weight of the rectangle you just drew. 

• Select the rectan gle if it is not already selected, and then choose 2 
point from the Pen m enu. Notice that the border of the rectangle 
becomes thicker. 

Next you' ll draw the lines in the message form. 

1 ·--~-~ I • To draw the lines for the message form, double-click on the line tool. 

This will enable you to draw mo re than one line without having to 
reselect the line tool each time. 

• Choose 1 point from the Pen menu. 

• At 1/4 inch from the top of the rectangle (I /z inch on the vertical ruler) 
draw a horizontal line inside the rectangle beginning at 3/s inch 
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from the rectangle (5/s inch on the horizontal ruler), and end it at 
1/4 inch before the end of the rectangle, which will be at the 33/4-inch 
mark on the horizontal ruler. See Figure 5-18. 

------- :-+ 

...... .. .. ... .... ..... .... l .. 

Figure 5-18 Drawing a horizontal line 

• 1/ 4 inch beneath that line, draw two more shorter lines. Begin the 
first at 7/s inches on the horizontal ruler and end it at the 2 inch 
mark. Start the one next to it at 21/2 inches on the horizontal ruler 
and end it at the 33/4-inch mark. 

You should now have two more lines in your rectangle, like those shown 
in Figure 5-19. 

Figure 5-19 The second set of lines 

Since you want two more lines the same length as the first line you drew, 
you'll make two copies of that li 1 e and position them in the rectangle. 

• Click on the selection arrow. 

• Click anywhere on the firs~ line to select it, 
Duplicate from the Edit menu. 

and then choose 
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The duplicate line will be placed slightly below and to the right of the 
original line, and it will automatically be selected. 

The Duplicate command places a copy of the selected object in the 
d rawing. The Copy command places a copy of the selected object in the 
Clipboard, and you use the Paste command to paste the ob ject in the 
d rawing. Duplicate works like a combination Copy/Paste command. 

• Drag that new line down to the 11/4-inch mark on the vertical ruler, 
so that it is placed 1/z inch below the short lines above it, as shown 
in Figure 5-20. 

Figure 5-20 Positioning the duplicate line 

• Click somewhere else on the screen to deselect the new line. 

• Select the bottom line again and duplicate it in the same manner. 

• Place the duplicate line 1/4 inch beneath the last line. 

• Duplicate the line one more time and place it 1/4 inch beneath the 
one above it, so your drawing has three duplicate lines 1/ 4 inch apart, 
as shown in Figure S-21. 

------,~ 

. . . . . . . . . 

Figure 5-21 Duplicating lines 
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Now you' ll resize the last line to make it sligh t ly shorter than the one 
above it. 

• If it's not already selected, select the last line and t hen click on its 
left handle. Drag to the right so it is 5/s inch sho rter th an the one 
above it, as shown in figure 5-22. 

_ _ :~· 

~-------~ 
.. . . . . . . . . " f .. . . ..... . 

. J ..... .. 
Figure 5-22 Resizing a line 

The next step is to draw another rectangle for the message options. 

• Select the rectangle tool. 

• Beginning at the 2-inch mark on the vertical ruler and 3 /s inches on 
the horizontal ruler, click and drag to form a rectangle that is 1 inch 
deep and that extends to Y /s inches o n the horizontal ruler. See 
Figure 5-23. 

--.-. . -! . . 

Figure 5-23 Drawing the second rectangle 

• Double-click on the line tool and draw three horizontal lines within 
that rectangle, 1 /~ inch apant and the entire length of the inner 
rectangle, as shown in Figur 5-24. 
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Telephone Message Slip- l ayer# 1 0: 
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Figure 5-24 The lines in the smaller rectangle 

,. Draw fou r more lines beneath the rectangle, beginning at 1/4 inch 
below the inner rectangle. There should be 1/4 inch between each 
line. Start the first at 1 inch on the horizontal ruler and end it at the 
33/4 -inch mark. See figure 5-25. 

,,. The next two lines should begin at 1/z inch o n the horizontal ruler 
and also end at 31/.t inches . 

• The las t line should start at 2 inches on the horizonta l ruler and end 
at 3:1/ 4 inches. 

Your lines should look like those shown in Figure 5-25. 

~---------: ---------: ---Jl 

Figure 5-25 Finishing the lines 

• If you've not already saved your work, do so now by choosi ng Save 
from the File menu. 
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The next task is to type the text. To create text, you select the text tool. 
The pointer changes to an !-beam and is used to set the place where the 
text begins. 

Once you enter the text, it becomes a separate object that you can select 
like any other object. Once you se lect it, you ca n drag it around the 
screen to reposition it. You can also place text on top of an object. 

• Double-click o n the text tool. 

• Choose Geneva from the Font menu. 

,,. Choose 9 point from the Size menu. 

".. Click in the blank area to the right o f your partially completed 
message slip and type the word To. 

"',. Click next to that word and type Date. See Figure 5-26. 

M of J'toono No . 

. Mtr ... 9t . :S~ ...... :. 

TELEPHONED tJ 
: I 

[-:--· -~ 

Figure 5-26 Adding text 

• Continue in this manner: Type a word, and then click next to or 
beneath it to create each word as a separate object. Type the 
fo llowing words: 
Time 
M 
of 
Phone No. 
Message 
By 

• Type the following in all ca s, also as sepa rate ob jects: 
TELEPHONED 
WAS IN TO SEE YOU 
WANTS TO SEE YOU 
RETURNED YOUR CALL 
PLEASE CALL 
WILL CALL BACK 
URGENT 
WHILE YOU WERE OUT 
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00 -S • Save your work now. 

EDITING TEXT 

• If you used the Caps Lock key when you typed the last words, be sure 
to press the Ca ps Lock key again to release it. 

When the Caps Lock key is down, it constra ins the movement of the 
po inter and restricts where you can draw and position objects on the 
screen. 

Another kind of text used in MacDraw II is paragraph text. It uses text 
wrap around and confines text to specifi c areas. To create a paragraph, 
select the text tool, and then drag the pointer to create a tempo rary text 
box. You don' t need to set an insertion point because MacDraw will 
ente r the text beginning at the blinking I-beam. When you are finished 
entering the text, clicking anywhere on the screen removes the temporary 
text box and leaves th e paragraph automatically selected with handles 
until yo u click som ewhere else. Dragging any handle will resize the 
margins of the paragraph. You can move the paragraph by clicking in 
it and dragging it around on the screen. 

To edit text, you use the text tool. To select text you'd like to edit, first 
click on the text tool, and then drag across the text you want to change. 
Yo u can also double-click on a single word to select it. This will highlight 
the text. You can then type new text over the selected text. 

To delete text, select it with the text tool in the same manner as above 
and then press the Backspace key or choose Cut or Clear from the Ed it 
menu. 

To insert text, you position the pointer in the line oftextwhereyou want 
to insert a character, wo rd, or words, and then you click to set the 
inserti on point. As you type, the rest o f the text moves, or wraps, to make 
room for the inserted characters. 

FORMATTING TEXT 

You can format any text that you create using the options in the Font, 
Size, and Style m enus. To select text for formatting, you can either wipe 
through it using the text tool, or you can select the text block using the 
selection arrow. 

The phrases "URGENT" and "WHILE YOU WERE OUT" need to be 
changed to a larger, bo ld font. 

• Choose the selection arrow and click o n the word URGENT. Drag 
the handle o n the bottom right of the word so that a longer rectangle 
is created fo r the word, as shown in Figure S-27. 
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This will allow you to change t a larger font and still keep the words 
from going on to more than on line. 

M or Phon• No . 

. . . Mru •g• . ilv ... . 

V -'NTS TO $£E YOU 

. AET\JI!NEQ~CAI.~ •. : • g---.----] 
. . . 

PlEASE C~L 

VLL CALL !lACK • 

~!:::::::=::::=~: 
. ............... . 

Figure 5-27 Resizing the text box 

~ - B • While URGENT is still selected, choose Bold from the Style menu, 
and choose 14 point from the Size menu. See Figure 5-28. 

V oVITS TO $EE YOU 

PlEASE C~L E ______ ] 
. AETIJI!NEQ ~CAl.~ .• : . 

VLL CALL !lACK 

'tJRGENt • : 
. • . .... : ...... \ :. 

Figure 5-28 Changing the text size and style 

• Go through the same procedure for "WHILE YOU WERE OUT". 

REPOSITIONING TEXT 

Now that you have created and formatted the text, you' ll position it on 
the message slip. 

• To make it easier to position t e text precisely, choose Turn Autogrid 
Off from the Layout menu. 
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• Now you can select each text block individually and positio n it next 
to the appropriate line. Do this with all the text except what 
goes in the message optio ns blocks (the text that is in all caps). See 
Figure 5-29. 

To see how the text sho uld be positio ned, refer to Figure 5-1 4 at the 
beginning of this project. 

To 

Dat~ 

M 

of 

---- Tim~ 

Phon~ Np. --- ·--------

- ---- - - --------:-~----

. . 
. 

Figure 5-29 Repositioning text 

3€ -S • Ch oose Save from the File m enu . 

. . 
TELEPHONED . 'tl AS IN TO SEE. 

WANTS TO SEE YOU 

RETURNEe' YOUR CALL . . 
· · PlEASE CALL · · · · • · · · 

WILL CALL BACK 

URGENT 
. . 

· WHILE YOU WERE· 

: t 

• To determine how long to make the m essage options blocks, place 
TELEPHONED, WAS IN TO SEE YOU, WANTS TO SEE YOU, an d 
RETURNED YO UR CALL in the areas sh own in Figu re 5-30. 

:o Telephone Message Slip Layer# 1 E!HI 
:: :~m * OI* I :::mt::::t :: :~- :.: "~ ,'~·:·:·: 
A 1 0 I I : 12 I j3 l 4 l 15 

Oat~ - ---- Time - ----- .......... .. .... I 
M'-----------·---
of'-----------·---
Phon~ Ni>. 

-

,---------------------~----TELEPHOtl ED • · 

WAS IN TO SEE YOU • · 

~I ANTS TO SEE YOU · · 

RETURNED YOUR CALL . . 
~-----------~--------------
Message ---- ----- - - --

Figure 5-30 Moving m o re text 

• Do t h is by selecting each tex t block individually an d dragging it to 
its new loca tion . 
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ADDING AND DUPLICATING LINE 

Now you can determine where the vertical lines need to be placed 
within the inner rectangle. 

,,. Select the line tool, and then draw a vertical line beginning after 
RETURNED YOUR CALL. Make that line the same height as the 
rectangle, as shown in Figure 5-31. 

WAS IN TO SEE YOU ~ · 

WANTS TO SEE YOU • · 

RETURNED YOUR CALL · · ---------- ---------------

----------~----TELEPHONED · · 

Figure 5-31 Drawing the first vertical line 

PLEASE CA(L 

WILL CALL BACK 

URGENt 
·wHiLE Ydu ·wERE: 

3€ -D .. To duplicate that line, choose Duplicate from the Edit menu. 

.. Place the duplicate line about 1/4 inch to the right of the original, as 
shown in Figure 5-32. 

M 

of 

Phone Ni>. ------ -'------

Figure 5-32 Duplicating the 

PLEASE CA(L 

WILL CALL BACK 

URGENt 
·wHiLE Ydu ·wERt 
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8€ -D • Duplicate the line again in the same manner, and place it about 
1/4 inch from the edge of the rectangle, as shown in Figure S-33. 

M 

of 

Phone Np. 

TELEPHONED · • -~---~--
WAS IN TO SEE YOU · · 

WANTS TO SEE YOU · • 

RETURNED YOUR CALL · • ---------- - -----------

Figure 5-33 Duplicating the line again 

PLEASE CA(L 

WILL CALL BACK 

URGENt 

·wHiLE Ydl.J ·wERt . 

• Select the line between WANTS TO SEE YOU and RETURNED YOUR 
CALL. Shorten that line by dragging on the right handle so th at it 
stops at the second vertical line, as shown in Figure S-34 . 

M 

of 

Phone Ni>. 

:~:~':~~~:- ----------E 
'tl ANTS TO SEE YOU · · 
~---------+-~ . 
R~~~:_D_Y~UR C!':_L _ _j_ _____ · ___ _ 

Message ------------------

Figure 5-34 Making room for URGENT 

. . . . . . . . . . . . . . . . . . I 

PLEASE CA(L 

WILL CALL BACK 

URGENt 

·wHiLE Ydl.J ·wERt 0 

• Now you can place the remainder of the text into the form in the 
appropriate places. 

8€ -S • Choose Save fro m the file menu. 
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You can place as many message a rms o n a page as will fit, to save paper 
and printing costs. Four message forms will fit on one page, so that is 
how you ' ll print them. Now that you've com pleted the fi rst message 
form, creating the other ones is easy. 

USING THE ZOOM CONTROLS 

8€-A 

You'll use the zoom controls to reduce your view of the d rawing and see 
more of it o n the screen. 

• Click once o n the left zoom cont ro l to reduce your view to SO% . 

The zoom percentage box now shows "SO". Th is enables you to see mo re 
of your drawing at one time. 

• Choose Select All from the Edit menu. 

You have just told MacDraw to select every ob ject in your drawing. 

GROUPING OBJECTS 

Grouping consolidates a set of ob jects in to one combined o bject. Th is 
enables you to manipulate the group as a si ngle object. It also allows you 
to set each object's position in relatio n to othe r objects in the group. 

8€ -G • Choose Group from the Arrange menu. 

Now all the lines, text, and rectangles that make up the message fo rm 
are grouped as o ne object, and o nly one set o f hand les appears around 
the whole form. See Figu re S-3S . 

. ... • J t _ _ _ 

Figure 5-35 The grouped ob je 

Once you group several objects,! you cannot change a single object in 
the group. To make changes to "ndividua l parts of an o bject, you must 
first select the grouped ob ject, and then choose Ungroup fro m the 
Arrange menu. 
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DUPLICATING OBJECTS 
Next you'll move the message form so you ca n fit two fo rms s ide-by-side 
on the page, and then you'll duplicate the message for m. 

• Drag the message form as far as it will go to the left edge of the 
d ocument, as shown in Figure 5-36. 

Figure 5-36 Moving the form to the left edge of the page 

3€ -D • Choose Duplicate from the Edit menu . 

• Drag the duplica te message form and place it to the righ t of the 
original, as shown in Figu re 5-37. 

Figure 5-37 Placi ng th e dupl icate message form 
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:3€ -A • Select both message form s by hoosingSelcctAllfrom the 

:3€ -D • Choose Duplicate fro m the Edit m enu. 

• Position the two dupli cates o n the bo tto m portion of the p 
shown in figure S-38 . 

• • • •• ••• •• •• 0 

Figure 5-38 Placing two more duplica te fo rms 

Now you have four telephone message forms in one document. 

PRINTING THE DOCUMENT 
Before you print the docum ent, save your work. 

• Choose Save from the Fi le m enu. 

• Choose Print from the File m enu . Click OK to accept the default 
print options and print one copy. 

Compare your printed document with the o ne shown in Hgure 5-14. 

:3€ -Q • To ex it MacDraw, choose Quit from the file me nu. To continue 
working o n the next exercise and rema in in MacDraw, close the 
document by cl icking in its close box. 

Project 2: Creating an Organizational Chart · 

In this pro ject you'll create a cor,)orate o rga n izationa l chart. You' ll use 
som e of the tools and commaljdS that you lea rn ed about in the first 
pro ject, and you' ll a lso learn ha~1dy ways to create some special effects. 
You' ll learn about pe n and fill patterns and about aligning and a rranging 
objects. The finished organizatio nal chart is shown in .figure 5-39. 
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erne Toys, Incorporated 
Manufacturers of Fine Toys 

------------------~ 

I I 

Carol Garms 
Vice-President, 

Sa les 

II 

Mai Nguyen 
Sales Manager 

---•:. 

.-
'· 

... 

j ames W. Nielsen 
President 

-- - ~ ~ ~. -,- -~ . -.. ' 

I I 

J ill Aoki 
Vice-Presiden t, 
Manufacturing 

Ll 

Samuel Neujah r 
Manufacturing 

Manager 

.... i..,_ . ...... -.... · 

J j 

Richa rd P. Cleaves 
Vice-President, 

Finance 

I I 

J udith Crippin 
Controller 

Figure 5-39 Fi nal output of Project 2 
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• Double-click on the MacDraw II icon to open a ne> 
drawing window. If you d id rot exit MacDraw after wo rki. 
previo us pro ject, choose New from the File menu to get 
untitled drawing window. I 

Keep in mind that if you need to de lete an object, select it and press 
Backspace key (Delete key on som e keyboards). 

• Select Show Rulers from the Layout menu. 

You will be using the rulers to determine the size and spacing of the 
objects in your o rganiza tional chart. 

DISPLAYING THE SIZE OF AN OBJECT 
A handy feature in Mac Draw II is the 5/ww Size command. The size of any 
object you d raw is immed iately reflected on the botto m of the screen as 
you d raw it. Also, any time you cl ick o n the border of an object after it 
is drawn, it shows you the size of that object. 

• Choose Show Size from the Layout menu. 

• Select the rectangle tool. 

• Create a rectangle 2 inches wide and 1 inch high . 

Notice that the size of the rectangle is displayed at the bottom of the 
screen as you draw it, as shown in Figure 5-40. 

l : : l : 
r·-:-·····--·~·---·-·1 : I 

..... L.~-~-:-~-~.~~.~.~~-:- ~-~-J . : .. ... .. ... ............ .. . 
. . . . . . . . . . . . . . . . . . . . : ....... : ..... --:. !:·:: 

: !i!:; 
: 1·:,, 
. . ·~ 

Figure 5-40 Using the Show Size feature 

• If you clicked elsewhere on the screen afte r you drew the rectangle, 
click anywhere o n the rectangle to select it. 

CHANGING LINE WEIGHTS 
• To change the thi ckness of the lines forming the rectangle, choose 

2 point from th e Pen menu, as shown in Figure 5-41. 



1>--------1 Autoslze line 
Arrow At Start 
Arrow At End 

Pens ... 
Dashes .. . 
Arrows .. . 

Figure 5-41 The Pen menu 
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You learned about line weights in Project 1. The Pen menu also offers 
different line styles. 

Plain Line, which is checked in the Pen menu shown in Figure S-41, is 
the default line style. The Dashed Line option creates a dashed line, and 
you can customize the dash size and space between dashes by choosing 
Dashes from the Pen Men u. 

An Autosize Line has the line's length automatically printed in the 
middle. Autosize Lines are used for drawing dimension lines that show 
the measurement of objects in a drawing, such as in a floor plan. 

The Arrow At Start and Arrow At End options enable you to draw lines 
that begin or end (or both) with arrowheads. You can modify the shape 
of the arrowhead by choosing Arrows from the Pen menu. 

You can use any combination of line weights, dashes, arrows, and 
dimensions on any line you draw. 

SAVING THE DOCUMENT 

Before you get too deep into this project, it's a good idea to save what 
you've done so far and give the drawing a name. 

3€ -S • Choose Save from the File menu. 

Remember to be careful about where you are saving your document. 
Always verify that the name of the disk (or folder) that you want your 
document saved on is showing at the top of the Save dialog box- in this 
case, where "Pamela Gurnari" is showing in Figure S-42. If necessary, 
click the Drive button so that you are viewing the correct name. 
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ADDING TEXT 

I (g) Pamela Gumari l 

D Telephone Me~sag ... g (g) Parnell! Gu .. 

[ Eject 

[ Drlue 1 
0 

Saue dr11wlng as: [ S11ue I 
I• Ei I if%al Ui I bill ilrtl I [ Cancel I 
@ Dr11wlng 0 St11tlonery 0 PICT 

Figure 5-42 The Save dialog box 

• Type Organizational Chart in the Save drawing as: box, and then 
click the Save button. 

Your drawing window should now have the name of your document 
and the current layer showing at the top: Organizational Chart-Layer#l. 

Now you need to add some text inside the box you just drew. The first 
name and title will be the company president's name. 

,.. Click on the text tool to select it, and then click inside the rectangle 
in approximately the center of it. 

• Choose New York from the Font menu, and then choose 12 point 
from the Size menu. 

3€ -B • Choose Bold and then Center from the Style menu. 

• Type the following text in the block, pressing return where indicated: 
James W. Nielsen (press Return) 
President 

Your screen should look like the one shown in Figure 5-43. 

!James W. Nielsen ! 
1 Presldenq J · · · · · · · · 

Figure 5-43 Adding text to the rectangle 

• Click somewhere else on the screen to deselect the text tool. 

I 
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JECTS 
• To select both the box and the text within it, place the selection 

arrow above and to the left of the box and drag diagonally past the 
bottom right corner of the box. 

A dotted rectangle is created around the objects, as shown in 
Figure 5-44. When you release the mouse button, all objects within the 
temporary rectangle are selected. All objects that are selected will have 
handles showing. 

' . 
: jlunes W . JUetsen 

· · · · :· · : · ·Presid~ut· · · · 
' I . ' · .... . .. .. . ... . . . 
; 

·--- ~ -- ------ ~ - --- - ---~ 

Figure 5-44 Selecting multiple objects 

Selecting multiple objects is not the same as grouping objects. Grouping 
objects creates one composite object made up of all the objects that are 
selected when the Group command is invoked. Selecting multiple 
objects enables you to work with all selected objects at one time, but 
each can still be selected separately. 

Next you'll center the text within the rectangle. 

CENTERING TEXT WITHIN A RECTANGLE 

The Alignment command allows you to align and distribute selected 
objects with each other or with the grid. Aligning refers to moving selected 
objects so that their boundaries line up in a specified manner. Distributing 
objects spaces them evenly in a document, either vertically or 
horizontally. 
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• Choose Alignment from the 1 

• In the resulting dialog box, • 
portion o f the box, and se lec~ 
the box, as shown in Figure S-~5 

Alignment. .. 

@ To eoch other O To grid 

G 
18] Riign 
0 Distribute 

O Top 
@Center 
0 Bottom 
0 llcigh1 

18] Align 0 Distribute 

0 Left ®Center 0 Right 0 lllld1h 

( Cencei I m 
Figure 5-45 The Align ment dialog box 

I 

The settings you just chose for th is dialog box told MacDraw to align the 
objects to the cen ter both vertica lly and horizontally. Notice that the 
small diagram in the dialog box shows you the effect these setti ngs wi ll 
have o n the objects. 

• Click OK to accept the changes you've made to the dialog box. 

Now you' ll use the box you just drew as a template for the others, since 
it is already the correct size and has the text centered within it. To do 
so, you' ll duplicate it. 

DUPLICATING USING AUTOMATIC ALIGNMENT 

You'll duplicate the box as well as the name inside it, even though you' ll 
change the names in just a moment, because you want the text to retain 
the same formatting characteristics (New York font, bold, and centered) 
when you retype a different name. 

3€ -D .. If both the text and the rectangle are not already selected, select 
them now, and then choose Duplicate from the Edit menu. 

• Click on the duplicate set of objects, but not o n any of their 
handles. Drag them to th e lower left side of the screen, as shown in 
Figure S-46. 
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Orgonizo tionol Chort- Loyer# I !:!)! 
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~ Q-------Q ······ .. .. ............ . 
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§~ b-----· .. ~--4 
~ 
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100 ... , 1/2" l 2 7/8" Q 

Figure 5-46 Positioning the dup li cate objects 

• Click on another part of th e sc reen to deselect the objects. 

MacDraw "rem embers" where you placed the last duplicate object with 
reference to the o riginal as long as you do no t deselect the duplicate 
object . This feature is o ne of the reasons that MacDraw works well for 
creating business forms and charts. You can create horizontal, vertical, 
and diagonal rows of identical objects without having to draw each 
ob ject separately or copy them and then align them in a row. When you 
position the duplica te object, you establish the spacing and direction of 
the row, and each duplicate is positio ned and aligned automatically. 
You'll use this feature to crea te the rest of the boxes in the second row 
of the organizational chart. 

• Select the duplica te box and text within it that you just positioned 
in the lower left corner of the screen. 

3€ -D • Choose Duplicate from the Edit menu. 

When you position the duplicate that you just created, you' ll establish 
the direction and spacing o f the second row of objects. 

• Position the second duplicate box to the right of the original and 
a lign the top edges of both o bjects, as shown in Figure 5-47. 

~ Or gonlza tlonol Chort-Loyer # J I::!Jll 
~:~: 0 1* ~Hi•;E';:;:n~:-· ,',J;;E3·:·:·:~~· 
A. ' o I' !". 1~. r . F'. ...f. 
....... 
n 
0 ro 

: T 

. : ( : 
~-

~ 

james W. Nielsen 
. : . -Presiden t- . : ....... : .... .. . : ....... : . I ~'' 

't-ra r= 
~ .---------, t;:-------Q 

James W. Nie lsen ~ames: w. Nielsen• 
~ Pres ide nt • President : • 

~p: '----------' ___ __ ... 1----0 

~ 
100 ... 33/ 4" l 2 7/8" 

Figure 5 -47 Position ing the second d uplicate box 
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3€ -0 • While the ob ject is still sele ted , choose Duplicate from th e Edit 
menu. 

Notice how that actio n caused the next copy to be placed to the right 
of the center block. The box is auto matically aligned according to its 
relative position to the first, as shown in Figure 5-48. 

james w. Nielsen 
. : . -President. .. . 

James W. Nielsen · 
President · 

. . 
james· W. N\elsen 

Presid ent · 

~ames w . • .,_,, ___ .,.,, 
President . • 

Figure 5-48 Automatically positioning the copy 

3€ -S • Save your work by choosing Save fro m the File menu. 

MODIFYING MULTIPLE OBJECTS AT ONCE 

EDITING TEXT 

I 
Now that you have the row of boxes drawn, you need to change the 
names in each box. First you' ll change the text in all three boxes on the 
second row to 10 point type. 

• Click somewhere outside the currently selected box to deselect it. 

• While ho lding down the Shift key, click o n the name in each of the 
three lower boxes so the text in all three boxes is selected. 

• Select 10 point from the Size menu. 

Noti ce that the change takes effect o n all the selected text. It does not 
affect the text in the top box. 

• Select the text tool. 

Double-clicking o n a tool selects· t and keeps it active until you c li ck on 
another tool. 

Now you' ll change the names il each box in the second row. 

• Drag through the name in the first block to select it, as shown in 
Figure 5-49. 
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. . 
James W. Nie lsen 
· .Pres ide nt .... 

James v . lfielsen: 
President · 

James v . lfielsen 
Pr esident · · 

Figure 5-49 Selecting the name in the box 
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Feel free to type names of people who mean something to you. The 
following names are suggestions; you can use whatever names you 
think of. 

,,. Type Carol Garms to replace t he president's name. 

,. Select President in the same box, and type: 
Vice-President, 
Sales 

Press Return if you need to go to a new line within the box. 

,. Continuing in this same manner, change the name and the title in 
the middle box to: 
Jill Aoki 
Vice-President, 
Manufacturing 

,,. Change the name and the title in the last box to: 
Richard P. Cleaves 
Vice-President, 
Finance 

Your boxes should look similar to the ones shown in Figure 5-50. 

James W. Nie lsen 
. : .. Preside nt. . . 

Carol Garms 
Vic·e-President~ 

S:llles 

Jill Aol<i 
Vice 'Preside.nt ~ · 
llanUrae turing : 

Figure 5-50 The edited boxes 

1Ueh 0...<1 P . Cleaves 
Vice -Preside n t_ 

linance · 



Chapter 5: MacDraw II 169 

Now that you have created the s cond row of boxes, using the first as a 
template, you need to change the single box in the top row, the 
President's box, so that it is larger than the others. 

• Select the President's box. 

• Click on the handle in the lower right corner of the President's box, 
and drag to the right. When the dimensions in the size bar at the 
bottom of the screen are 21/z" by 1", release the mouse button. 

This makes the box 1 /z inch wider than the others. 

FORMATTING TEXT 

Now you can center the text within the box. 

• While holding down the Shift key, click on the border of the 
President's box, and then click on the text in the box so that both 
the box and the text are selected. 

Using the Shift key while selecting objects allows you to select more 
than one object at a time. 

a€ -K • To center the text within the box, choose Align from the Arrange 
menu. 

a€ -G • With the box and text within it selected, choose Group from the 
Arrange menu. 

This groups the centered text and the box as one object. 

You did not have to change the alignment specifications as you did 
when you first aligned the text, since the alignment specifications 
remain the same until you change them. The Alignment command 
allows you to change the alignment specifications, and the Align 
command allows you to align objects based on the last alignment 
specifications you set. 

a€ -S • Save your document. 

USING THE ZOOM CONTROLS 
Now view the drawing in 50% size so you can finish adding the other 
boxes and position them properly on the page. 

• Click the left zoom control to reduce your drawing to 50% size. 

You will see "50" in the zoom percentage box. 

I 
DUPLICATING MULTIPLE OBJECTS 

You'll duplicate the three boxes in the second row and place the 
duplicates in a row at the bottom. 
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,. Select the row o f three boxes by dragging around a ll three boxes with 
the selection arrow, as shown in Figu re 5-51 . 

l r-~-1 
. . . 

r;:~~-=:J-r~:J-r~~r· · · · 
~·~·~J · 
- -- -- -- -.-------- -.-------- -.--~ 

Figure 5-51 Selecting the bottom row of boxes 

W- D • Ch oose Duplicate from the Ed it menu. 

• Position the duplicate boxes d irectly beneath the first row of th ree 
boxes, as shown in Figure 5-52. 

1 -~-1 

~]~][~J ···· 

Figure 5-52 Position ing the duplicate boxes 

• Click elsewhere on the screen to deselect the three boxes and the 
tex t within the m. 

RESIZING MULTIPLE OBJECTS 

Next you' ll reduce the size of the bottom three boxes. 
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• Hold down the Shift key and click on the border of each of the 
bottom three boxes. 

This will select just the boxes, not the text within them. 

• Now reduce the size of all three boxes by d ragging to the left the 
lower right corner of any box, unti l the size bar at the bottom of the 
window shows that the box has been reduced to P/4 inches by 1 
inch, as shown in Figure 5-53. 

1-~-1 

~]~][~J '' ' ' 
:~·~.-~] 

1-::J. il>-----~1>-----:--<ai:-· -~-~~- . . .. 

Figure 5-53 Resizing multiple ob jects 

When you release the mouse button, all three boxes are reduced to the 
same size. See Figure 5-54. 

1-~-1 

~]~]§J'''' 

Figure 5-54 The resized boxes 
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,... Use the zoom control to enlarge the drawing to 100% size. Then use 
the scroll boxes to position the screen so you are viewing the smaller 
three boxes. 

Change the names and titles as you did with the middle row of boxes. 
Use names of your choice or the suggested ones that follow. 

•• Change the first box so that it contains the following name and ti tle : 
Mai Nguyen 
Sales Manager 

"• Change the text in the middle box to the following: 
Samuel Neujahr 
Manufacturing Manager 

,... Change the text in the third box to read: 
judith Crippin 
Controller 

Your boxes should now look similar to the ones shown in Figure 5-55. 

~0 Organizational Chart-Layer# I § 
il!:'!: 101*1 -~::1::R::;:t : : l : · : ,',~·:·:·:~~HAl~· 
A ' o 11 12. !3 t'. f'. !6. K 
'-.. Carol Garms · Jlll Aol<i · R.ichar<l P . Clea.,;,s ;;!t' TI Vice-President~ Vice- President · Vice -President_ ~[j;~ 

!-='- S:llles ManUfacturing : :nnance · ;;:;: 

r§-f'2- '--------' '--------' '--------ll:i!li' 
~ 
t:t ra 
r=-1'!-

Mai Nguyen 
Sales Manager . . ... . . 

100 ... o· ll 114" 

Samuel Neujahr : 
Manufac turing · 

· · · ·M~ag·er · · · · · · 

Figure 5-55 The names in the bottom row of boxes 

,,. Click somewhere on the screen to deselect the three boxes. 

:3€ -S ,,. Choose Save from the File menu. 

GROUPING OBJECTS 
The next step is to center the text inside each box and then group the 
box and the text in it. 

• While holding down the Shift key, select the first box in the middle 
row and then the text inside that box. 

:3€ -K •• Choose Align from the Arrange menu. 

This centers the text inside the box, based on the last settings you made 
in the Alignment dialog box. 

:3€ -G • Choose Group from the Arrange menu. 
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This groups the text and the box s that MacDraw views the box and the 
name in it as one object, not twd. 

• Click somewhere on the screen to deselect the grouped box and text 
object. 

Deselecting the previous box is an important step. If you do not deselect 
it first, when you Shift-click to select the next box and text, the box you 
just grouped will be included in your centering and grouping operation . 

• Continue centering the text within each box, and then group the 
centered text and box. Be sure to deselect each box after you group 
it and before you select the next box and text. 

• When you are finished centering text and grouping each box with 
the name within it, use the zoom control to return to 509·6 size. 

ALIGNING OBJECTS 
Now that you can view all the boxes, you need to align them to one 
another. 

• Select the top box and drag it to the center of the top row. 

Use the horizontal ruler to help you determine the approximate center. 

• Shift-click to select the box in the top row, the center one in the 
second row, and the center one in the bottom row so that all three 
are selected at the same time, as shown in Figure 5-56 . 

. . . . . . . ! I -~~~ ·1 .... i ..... . 
-1-~ ·[ ==-I~l · · · 
EJ~~ 
..... . .. .. .. . · ~ . . . . . ..... .... . 

. . . 

Figure 5-56 Selecting the three center boxes 

• Choose Alignment from the Arrange menu. The Alignment dialog 
box will show on your screen. 
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• In the upper right section of th e dialog box, beneath the words "To 
grid", cl ick Align to remove the "X". This should leave both the 
Align and Distribute boxes without an "X" in th em. 

• Next, be sure there is an "X" in th e Align box that runs ho rizontally 
across the bottom o f the dialog box. Beneath that, click Center. 

Your completed dia log bo x should look like the o ne shown in 
Figure 5-5 7. 

Alignment ... 

@ To each other 0 To grid 

r---n-l 0 Align 

I 
U 0 Distribute 
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~( Cancel ) (~} 

Figure 5-57 The Alignment dialog box 

The settings in this dialog box tell Mac Draw that you do not want to do 
an y horizon ta l alignment o r distributio n, just vertica l alignment. 

Return • Click OK to accept those settings o nce you have determin,~d tha t 
they are correct. 

The three boxes you selected a re now aligned vertically. 

• Click somewhere o n the screen to deselect the boxes you just 
aligned, and then Shi ft-cli ck to select th e first box in the second row 
and the first box in the third row. 

:3€ -K • Choose Align from the Arrange menu. 

The a lignment settings you selected las t time will still be in effect. 

• Click somewhere on the screen to deselect the boxes you just 
align ed, and then Shift-click to select the last box in the second row 
and the last box in the third row. 

:3€ - K • Choose Align again from the Arrange menu. 

Now you need to draw the lines to connect the boxes in your 
organizatio na l chart. 

• Select the line tool. 

• Pl ace the pointer in the center o f the top box, and while ho lding 
down the Sh ift key to constra in the line vertically, d rag down to 
d raw a stra ight line to the center o f the middle box in the botto m 
row, as shown in Figure 5-58. 
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Figure 5-58 Draw the first connecting line 

MOVING OBJECTS TO THE BACK 
The order in which objects appea r o n the screen, in front of or behind 
each other, is ca ll ed the stacking order. The line you just drew n eeds to 
be positioned behind the boxes in the chart. You' ll change its position 
in the stacking order now. 

"• Select the li ne you just drew if you deselected it, and then choose 
Move To Back fro m the Arrange menu. 

Now the line appears to be behind the boxes. 

• Draw two mo re vert ical lines th rough the boxes on either side, as 
shown in Figure 5-59. 

Figure 5-59 Draw two more lines 
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• With both lines selected, move them to the back by choosing Move 
To Back from the Arrange menu. 

• Zoom to 100% size using the zoom control. 

• Draw the horizontal line to connect the three vertical lines between 
the top box and the second row of boxes, as shown in Figure 5-60. 
If necessary, change the length of any line that does not meet 
precisely. 

James W. Nielsen 
· · · · · · · · · Piesicient" · · · · · 

R~~~::.;f~::t'• ';, 
:rinance · . ,~;l 

;·•:; 

Figure 5-60 The horizontal connecting line 

3€ -S • Now is a good time to save all your work, if you haven't already 
done so. 

CREATING A DROP SHADOW 

Next you'll proceed with the steps to create a shadowed effect behind 
the boxes of the chart. 

First you need to group all the elements in your existing chart as one 
object. 

3€ -A • Choose Select All from the Edit menu. 

W -G • Choose Group from the Arrange menu. 

• Use the zoom control to reduce the view to SO% size. 

• Drag the whole chart to the bottom portion of the screen, about a 
half-inch from the bottom, as shown in Figure 5-61. 
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Figure 5-61 Reposition the group 

3€ -D .. Choose Duplicate from the Edit menu. 

This places a duplicate of your grouped chart on top of the origina l, and 
the dupli cate is selected. 

Changing the Fill Pattern 

.. Without deselecting the duplicate object, click to select a medium 
gray pattern o n the pattern palette, as shown at the top of 
Figure 5-62. 

Th is will cause the duplicate boxes to be filled wit h gray. See Figure 5-62. 

Figure 5-62 Changing the fi ll 
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Changing the Line Pattern 
• While the duplicate chart is still selected, click on the far right square 

in the pattern palette to indicate that you are referring to the line 
pattern, and then click again on the same shade of gray that you 
selected for the fill pattern. 

This changes the duplicate lines to gray also. 

Next you need to move the duplicate object so that it appears to be 
peeking out from beneath the original boxes, to produce a shadowed 
effect. 

,,. Choose Move To Back from the Arrange menu. 

Your drawing should look like the one shown in Figure 5-63. 

Figure 5-63 Creating a shadowed effect 

3€ -A 3€ -G ,. Choose Select All from the Edit menu, and then choose Group from 
the Arrange menu to group the shadowed chart as one object. 

3€ -S ,. Choose Save from the File menu. 

USING DIFFERENT TEXT STYLES 

Next you'll put the company name at the top of the chart. 

,. Select the text tool. 

,. Select 24 point from the Size menu, and choose Shadow from the 
Style menu. 

,. Position the pointer in the center of the top portion of the screen, 
and type Acme Toys, Incorporated. Then press Return. 

The next line in the chart title will have smaller text and will not be 
shadowed. 
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·• Choose 18 point from the Si e menu, and choose Shadow from the 
Style menu to deselect it. 

• Type Manufacturers of Fine Toys on that line. 

CHANGING THE TEXT BACKGROUND 

Now you'll change the background of the text to make it stand out on 
the page. 

•• While your text is still selected, select a shade of gray from the 
pattern palette, lighter than the one that you used for the shadows 
of the chart boxes. 

This produces a light gray background fo r the title, as shown in 
Figure 5-64. 

Figure 5-64 Title with light gray background 

• To align the title vertically to the chart, select both the chart and the 
title by Shift-clicking. 

,,. Choose Alignment from the Arrange menu. Make sure that the 
settings in the resulting dialog box are for vertical alignment, like 
the ones in the dialog box shown in Figure 5-65. 

Alignment. .. 

® To each other 0 To grid 

~-o---·1 8 ~:~~~ibute 
I ~ I O Top 

l O C<mter 

I Q I 0 Bo11om 
OHeight 

181 Rlign 0 Distribute 

0 Left ®Center 0 Right 0 Ulidth 

It;( Cancel J (G:Jl 

Figure 5-65 Alignment dialog ox 
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Now you'll group the centered title with the chart. 

~ -G • While everything is still selected, choose Group from the Arrange 
menu. 

,,. Click somewhere else in the screen to deselect the objects. 

Finally, you'll center the chart on the page. 

CENTERING THE CHART ON THE PAGE 

You're going to draw a rectangle around the whole page, and then you 'll 
align the chart to the rectangle. After the chart is centered in the 
rectangle, you'll delete the rectangle. 

• Select empty fill, the transparent pattern, from the pattern palette. 

• Click on the far right square of the pattern palette to indicate that 
you are referring to the line pattern, and then click on the solid black 
pattern. 

",. Select Turn Autogrid Off from the Layout menu to enable you to 
place your box precisely on the screen. 

• Select the rectangle tool, and then draw a box around the entire 
drawing page, keeping as close to the edges as possible. 

As you draw the bottom edge of the box and you drag the pointer off 
the bottom of the drawing window, notice how the scroll box in the 
vertical scroll bar moves all the way to the bottom of the scroll bar, as 
shown in Figure 5-66. This indicates that you are at the bottom of the 
drawing page. 

,. Do not release the mouse button until the rectangle reaches the 
bottom of the drawing page. See Figure 5-66. 

Figure 5-66 Draw a box around entire drawing page 
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• Shift-click to select the chart so that bo th the rectangle around the 
page and the ch art are selec ed. 

Now you' ll set the alignment so that the objects are centered vertically 
and horizontally. 

• Choose Alignment from the Arrange menu. Make sure the settings 
in the resulting dialog box match the ones shown in Figure 5-67, and 
then cl ick OK. 

Alignment ... 

® To each other 0 To grid 

, [83 Align 

0 
O Distribute 

O Top 

g~E:i.~ 
[83 flllgn 0 Distribute 

0 Left ®Center 0 Right 0 Width 

( Concel I m 
Figure 5-67 Alignment dialog box 

Now your chart is aligned to the center of the page. 

• Choose Save from the File menu. 

Now that you have centered the chart and title on the page, you no 
longer need the large rectangle you just drew. 

• Click somewhere on the screen to deselect both objects, and then 
click on the rectangle to select it. Press the Backspace key (Delete on 
some keyboards) to remove the rectangle. 

VIEWING THE ENTIRE PAGE 

The entire drawing is not visible in SO% size, but you can see it all in 
25% size. 

,. To view the entire page, cl ick on the left zoom control to reduce the 
drawing to 25%. 

The screen should look similar to the one shown in Figure 5-68. 
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Figure 5-68 Organizatio nal chart at 25% size 

3€ -S • Before you prin t the organizational chart, save it one last time. 

,. Choose Print from the File menu. 

Return ,,. Click OK to accept the default settings of the d ialog box, and print 
one copy o f t he document. 

,,. Compare your printed organizational chart with the one in Figure 
5-39 at the beginning of thi s pro ject. 

If you need to modify a part of the chart or a misspelled name, you must 
ungroup as many times as needed un til the ob ject you want to modify 
is accessible. As you created this chart, you grouped on many different 
levels, so you will have to ungroup several t imes to access individual 
o bjects in the chart. 

3€ -Q • To exit MacDraw II, choose Quit from the Fi le menu. If you intend 
to continue with the additional projects, just close t he document 
and don 't quit MacDraw II. 

SUMMARY 
• MacDraw II 's tool palette contains the drawing tools th at you use to create the ob jects in a 

drawing. You select a tool by clicking on it, and the tool reverts to t he selection arrow after 
each use. To keep a tool active, you do uble-click on it . 

• All objects created in MacDraw ll, including text, lines, and shapes, can be fi ll ed with a 
pattern, resized, duplicated, deleted, and moved. 

• You create text using the text tool. The optio ns in the Font, Size, and Style menus apply to 
the text typed with the text tool. You can change and insert characters or words in MacDraw 
without retypi ng, and you can drag text to a new location in a document. 

• Lines are drawn using the line tool. You can change the weight of a line before you begin 
drawing it or after it is drawn. The Pen menu is used to change the weight of lines d rawn wit h 
the line tool and the borders of any shape drawn with the shape tools. You can also change 
the pattern of any line o r border. The different line styles available on the Pen menu affect 
lines and not borders of shapes. 
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• Shapes are drawn using the oval tool, the rectangle tool, the rounded rectangle tool, the 
freehand tool, and the polygon tool. Shapes can be drawn either unfi lled or filled with a 
pattern. A shape can be resized and moved after it is drawn. 

• Autogrid controls where you draw an object and what size it can be. Using Autogrid makes 
it eas ier to align ob jects, but you cannot place or draw objects between grid divisions when 
Autogrid is o n. The gridlines in a drawing represent where Autogrid wi ll constrain the 
placement of objects. Horizontal and vertical rulers also enable you to control the size and 
placement of objects. 

• The fill and line patterns are controlled with the fi ll pattern box and the line pattern box on 
the pattern palette. 

• You select an object by cl icking on it with the se lection a rrow. You can select multiple ob jects 
at one time using either the Shift-click method, by dragging through multiple objects with 
the selection arrow, o r by choosing Select All from the Edit menu. Once you have selected 
multiple ob jects, you can manipulate them (resize, move, delete, d uplicate, and fi ll th em) all 
at o ne time. 

• The zoom controls allow you to enlarge a drawing to see de tails or reduce it so you can see 
more of it on the screen. You can magnify a drawing up to 3,200% in p redetermin ed 
increments and reduce a drawing to 3.12% in predetermined increments. You can ed it a 
drawing at any zoom level. 

• Grouping consolidates a set of objects into one combined object, which enables you to 
manipulate them as a single object. It also allows you to set the posi tion of an object in 
relation to other objects in the group. 

• You can align and distribute objects in relation to other ob jects using the Al ignment 
command from the Arrange menu. 

KEY TERMS 
active 
align, aligning 
arc tool 
Autogrid 

constrain 
corner/center control 
cross-beam pointe r 

deselect 
distribut ing 
Drawing format 
Duplicate command 

e llipse 

fill 
fi ll pattern box 
freehand tool 

grid 
gridllnes 
grouping 

handle 
highlighted 

insertio n po in t 

layer controls 
layers 
line ~attern box 
line tool 
line Jveigh ts 

menu bar 

paragraph tex t 
patte n palette 
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Pen menu 
point size 
polygon tool 

Reshape command 
resize 
rulers 
ruler settings 

scroll arrows 
scroll box 
select 
selection arrow 
Show Size command 

smooth 
snap 
stacking order 

text tool 
tools palette 
transparent objects 

Unsmooth command 

wrap, text wrap 

zoom controls 
zoom percentage box 
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MACDRAW II COMMAND KEYS AND SHORTCUTS 

File Menu 
New W-N 
Open W-0 
Close W -W 
Save W -S 
Quit W-Q 

Edit Menu Ungroup 
Undo W -Z 
Cut W-X 
Copy W-C 
Paste W-V 
Duplicate W-D 
Select All W-A 
Reshape W -R 
Smooth W-E 
Unsmooth W-Shift-E 

Additional Projects 

Arrange Menu 
Move To Front W-Shift-F 
Move To Back W-Shift-J 
Align W -K 
Alignment W-Shift-K 
~otate ~ -T 
Group 00-G 
W-Shift-G 

Style Menu 
Bold W -B 
Italic W-I 
Underline W -U 

The following projects are accompanied by briefer instructions than 
those you have previously completed in this chapter. They require that 
you apply what you learned in the first two projects. If necessary, refer 
to "Using MacDraw's Tools" at the beginning of this chapter for 
information and instructions about using any tools that you aren' t 
familiar with. 

You will not be reminded to save your work- you should be thinking 
of that on your own by now. 
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PROJECT 3: DRAWING A WHISTL 

This project makes use of the polygon tool, the circle, the corner/center 
control, and the Reshape command. You'll use the zoom controls to 
work in a magnified view of your drawing, and you'll use the Rotate 
command to rotate text. The finished whistle is shown in Figure 5-69. 

Figure 5-69 Final output for Project 3 

• Choose Turn Autogrid Off from the Layout menu. 

[QJ • Select the oval tool. 

• Hold down the Shift key and draw a circle about 1 inch in diameter. 

• Use the polygon tool to draw the mouthpiece extension, as shown 
in Figure 5-70 . 

. . ·CP; .. .. .. . ·
1 

... 1 CJ. ...... .. . 
. . . . . . 
. . . 
. . . 

Figure 5-70 Drawing the mou piece of the whistle 

Now that you have drawn both shapes, you need to examine them and 
make sure they are touching. 
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• With the polygon shape selected, use the zoom control to magnify 
the view to 400%. 

00 -R • Choose Reshape from the Edit menu. 

,. Drag the endpoints of the polygon so they touch the circle. See 
Figure 5-71. 

Figure 5-71 Reshaping the endpoints of the polygon 

,. Click the zoom percentage box to return to lOOo/o viewing size. 

00 -G • Select the circle and the polygon shapes, and then choose Group 
from the Arrange menu. 

00 -D • With the grouped objects still selected, choose Duplicate from the 
Edit menu. 

• Position the duplicate object slightly lower and to the left of the 
original, as shown in Figure 5-72. 

Figure 5-72 Positioning the duplicate object 
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~ -R 

• Fill the front object with a ay pattern and the one behind with a 
different pattern. 

Now you'll change the borders of these objects to a heavier line weight. 

• Select both objects and choose 2 point from the Pen menu. See 
Figure 5-73. 

Figure 5-73 Changing the line weight of the borders 

• Use the zoom control to magnify the view to 400%. 

• Draw the whistle "opening" on the mouthpiece with the polygon 
tool, and fill the shape with black, as shown in Figure 5-74. 

Figure 5-74 Drawing a polygr for the end "opening" 

• Use the Reshape command as necessary to make the four points of 
the "opening" shape match the points on the end of the whistle. 

• Move to the other "opening" area of the whistle and use the polygon 
tool to create that shape. Reshape as necessary, and fill it with black. 
See Figure 5-75. 
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38 -J 

Figure 5-75 Creating the other "opening" with the polygon tool 

• Use the zoom control to change the view to 200% size. 

• Draw the shape that holds the ring with the po lygon tool. Fill it with 
the same pattern as the front o f the whistle. 

• Choose Move Backward from the Arrange menu so the border of 
the circle is no t obscured by the sha pe. See Figure 5-76. 

Figure 5-76 Positio ning the small po lygon 

• Use the Shift key with the oval tool to draw the circle for the ring. 

Fill the ci rcle with the empty fill, or transparent, pattern. 

• Choose 4 point from th e Pen menu to give the ring a heavier border. 

38 -J • Place th e ring o n top of the small po lygon you just drew, and then 
choose Move Backward fro m th e Arrange menu. 
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The rin g now appears to be behind the polygon, as shown in 
Figure S-77. 

Figure 5-77 Moving the ring behind the polygon 

.. Click somewhere to deselect the ring, and then choose 2 point from 
the Pen menu. 

• Use the polygon tool to draw the piece on top of the ring. Fill it with 
the same pattern as the back of the whistle. 

• Choose Move to Back from the Arrange menu to place this polygon 
in the back of the stacking order, as shown in Figure S-78. 

Figure 5-78 Moving the top polygon behind the ring 

• Use the zoom control to view the drawing at 400% magnification. 

• To make the ring appear to be going through the top polygon, draw 
a small rectangle with the skne fill pattern and line pattern as the 
back of the whistle, as shawl in Figure S-79. 
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Figure 5-79 The small rectangle used to "erase" part of the ring 

• Place the rectangle so that it obscures part of the ring, in effect 
"erasing" it. 

• Ch ange the line pattern to black and the fill pattern to white. 

,,. Ch oose 4 point from the Pen menu. 

I f.".::J I •• Set the corner/center control to draw from center. 

~ 
L:iJ 

[AJ 

~-T 

• Draw a small white circle in the center of the main circle, about a 
half-inch in diameter. 

• Set the corner/center control to draw from corner. 

1;-

.. 

.... 

II .. 

.... 

Choose a font of your ch oice and 24 or 36 point size. 

Use the text tool to type your in itial, and then place the initial in the 
center of the white circle. 

Type the words What a whistle!! in a font of you r choice and in 14 
or 18 point size. 

Choose Rotate from the Arrange menu while the text is selected. 

Position the X pointer at the end of the word and drag in a circular 
motion to rotate the text. The text will pivot around the end 
opposite from where you place the pointer, as shown in Figure 5-80. 

,.:._./:::.·-:~~(' . . 

,I!_./.:..--- ·---- : • 
\ Wlut a whistle !! . . .. ~: . .. . . .. ·• . . 

Figure 5-80 Rotating text 
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• Place the text at the same a gle as the underside of the whistle. 

Compare your fin ished wh istle with the one shown in Figure 5-69. 

Project 4: Drawing a Still Life 

This pro ject uses the freehand tool, the a rc too l, the Heshape command, 
and the Smooth and Unsmooth commands. The fini shed drawing is 
shown in Figure 5-81. It shows some suggested foods to d raw, but you 
can use your imaginatio n. Some o ther ideas for food shapes that would 
be interesting to d raw and that would exercise your creativi ty are 
breakfast food s, carrot slices, rolls, beverages, pasta, fish, and sandwiches . 

• 

Figure 5-81 Fina l output fo r Project 4 

• Draw th e p lacemat and the napkin with the rectangle tool, and fill 
them with the patterns of your cho ice. 

• Use the Shift key with the oval tool to draw the plate. Fil l it with 
white. 

• Set the corner/center control to d raw fro m center, and then choose 
6 point from the Pen menu. 

• Set the line pattern to a patte rn of your choice, and then d raw the 
border o n the plate. See Figure 5-82. 
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Figure 5-82 Using a 6-point line weigh t for the plate border 

:3€ -G ,,. Select the placemat1 napkin1 plate1 and border1 and then choose 
Group from the Arrange menu. 

,,. Click somewhere to deselect the object/ and then change the pen 
size by choosing 1 point from the Pen menu. 

,,,. Change the line pattern to black and the fill pattern to white. 

• Scroll to the area to the right of the placemat1 and then select the 
freehand tool. 

,,. Draw the shape of a knife/ as shown in Figure 5-83. Don 1t worry if 
it doesn 1t look too good- you11l use the Reshape command to fix it. 

Figure 5-83 Drawing the shape of the kn ife 

• Choose Turn Autogrid Off from the Layout menu. 

• Use the zoom controls to view the drawing at 400% magnification. 

:3€ -R :3€ -Shi ft-E • With the knife selected/ choose Unsmooth and then Reshape from 
the Edit menu. 
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- Add new points on the border of the shape by clicking and move 
existing points as needed until the shape resembles a kn ife. See 
Figure 5-84. 

Project 4- Loyer# 1 
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A I :Q 
~ 
to 
ID r-
to 
""\ 
I~ 

-11 ta 

I ~ 

\ I~ 
~ 1400 

~~, T1 IC::12: 

Figure 5-84 Moving a point o n the knife shape 

To remove a point from the border o f the shape, hold down the Option 
key and cl ick on the unwanted point. 

• Click in the zoom percentage box to return to 100% size. 

::1€ -E • Choose Smooth from the Edit menu, and click o n the selectio n 
arrow to stop reshaping. 

If your kn ife does not satisfy you, continue unsmoothing, reshaping, 
and smoothing it until it looks the way you want it to. 

• When it is to your liking, fill the knife with a light gray pattern and 
positio n it on the p lacemat to the right of the plate. See Figure 5-85. 

Figure 5-85 Position the completed knife on the placemat 
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• Create the spoon in the same manner and position it on the 
placemat next to the knife. See Figure 5-86. 

Figure 5-86 Creating and reshaping the spoon 

,,. Create the fork in the same way and then place it on the napkin. See 
Figure S-8 7. 

Figure 5-87 Creating and reshaping the fork 

• Use the zoom controls to view the drawing at 200% size. 

• To draw the pile of peas, draw a small circle with a light fill pattern 
and a gray line pattern. 

• Duplicate the circles repeatedly, and position them to form a 
helping of peas. (The Command-key equivalent for the Duplicate 
command, Command-O, is useful for multiple duplications.) See 
Figure 5-88. 
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Figure 5-88 Duplicating circles to form the peas 

• Switch between the different magnification views to suit your 
drawing needs. 

• Draw the mea t with the freehand tool. 

• Draw the basic shape of the meat filled with white, and then draw 
a slightly smaller shape inside of it filled with a light pattern. See 
Figure 5-89. 

Figure 5-89 Creating the meat shape 

• Draw the potatoes with the freehand tool using a gray line pattern. 

.. Draw the gravy with the freehand tool using the same gray line and 
fill pattern. See Figure 5-90. 
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Figure 5-90 Creating the mashed potatoes and gravy. 

• Draw the wedge of cornbread with the arc tool, and after it is drawn 
fill it with a pattern. 

,,. Use the Rotate command to help you position the cornbread on the 
plate. See Figure 5-91. 

Figure 5-91 The cornbread slice created with the arc tool 

If you need to make a smaller "slice," reshape the arc using the Reshape 
command. 

Compare your finished drawing with the one shown in Figure 5-81. 
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P art III: Word Processing in roduces you to word processing on the 
Macintosh. 

Chapter 6 presents the basic concepts of word processing 
applications. Chapter 7 introduces you to Microsoft Word, one of the 
most sophisticated and widely used word processing applications on the 
Macintosh. You will create several kinds of documents in this chapter, 
including a menu and a newsletter, using Microsoft Word's desktop 
publishing capabilities. 
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Chapter 6: Word Processing Concepts 

What You Will Learn in This Chapter 

After readi ng this ch apter, you will understand: 

• The four areas of word processing: entering text, editing, 
formatting, and printing 

• The computer definition of a paragraph 

• The concept of "word wrap" 

• The differences between using a typewriter and a word processor 

• The use of formatting to change t he appearance of a document 

• The use of the search and replace feature 

• The use of a spelling checker and its limitations 

W ord processing is the process of using a computer to help 
automate the production of documents through text entry, 
editing, formatting, and printing. 

In its simplest fo rm, word processing is similar to usi ng a typewriter. 
Whatever you type on the keyboard is printed on the page. Using a word 
processor is much easier than using a typewriter because changes to a 
document are easier to make. You don't have to retype the entire page 
if you want to change a few words or paragraphs or if you want to change 
the spacing or the margins. 

As you produce a document on a typewriter, you must make quick, 
irrevocable decisions about how you want the document to look. For 
example, where will you end a line? If a word doesn't fit on a line, should 
you hyphenate it, erase it and put it on the next line, or just h it the 
margin release and hope you can cram the word in? How many more 
lines will fit on the page? If you type an incorrect lette r, should you erase 
it, type over it, or ignore it? How can you fix a sentence in which you 
left out a word? 

Word processing relieves you of many of these worries and allows you 
to concentrate on producing your best document. Basically four 
processes are used in word processing to produce a document: entering 
text, ed iting, formatti ng, and printing. The order in which these 
processes are used is not fixed-you can en ter all the text and edit and 
fo rmat later, o r format and edit as you enter the text, or use any order 
that you choose. The projects in this section use a sequence of first 
entering the text and then editing, formatting, and finally printing. 
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ENTERING TEXT 

Word processing always begins with basic text entry. But entering text 
is different on a word processor than it is on a typewriter. A typewriter 
commits each keystroke immediately to paper. A word processor 
records what you type and shows it to you on the computer's screen. 
Since most word processors include easy ways to ed it your text and 
many include spelling checkers, you don't have to worry about typing 
everything correctly. just start typing. If you make m istakes, you can 
correct them later. 

When you create a document with a word processor and then save it on 
your disk, you are saving it as a r le. A file is a collection of cha racters, 
and that is actually what your document is. A document can consist of 
any number of characters, words, sentences, pa ragraphs, or pages-you 
are limited only by the amount of storage space available on your d isk. 
The terms file and document are ~nterchangeable in word p rocessing. 

Another advantage of a word processor is that it relieves you of the worry 
of having to decide if you can fit another word at the end of the current 
line. With a typewriter the typist must keep track of the ma rgins-at the 
end of a line you use the carriage return to advance to the next line. With 
a word processor the program keeps track of the margi ns. If the word 
doesn't fit on the line, the word processor wi ll automatically move the 
word down to the next line. This process is called word wrap. Some word 
processors even look up the word in a l1yphenation dictionmy, insert a 
hyphen in the appropriate p lace, and put the rest of the word o n the 
next line. 

Word wrap is one of the main things that touch typists have to adjust 
to when they are first learning to use a word processor. When you enter 
text, do not press the Return key at the end of each fine. Learn to press Return 
on ly at the end of a paragraph. The computer meaning of a paragraph 
is text that is followed by a hard carriage return (pressing Return). A 
paragraph can consist of one or more characters, words, or sentences. 

just as you don't have to think about where to end a line, you don 't have 
tothinkaboutwhereto end a page. When you reach theendofthe page, 
the word processor automatically adds a new page at the end of the 
document; you just continue typing, and your new work is automatically 
entered on this new page. 

When you have a ll the text entered, you may discover m isspelled words, 
grammatical errors, missing or extra words, or even paragraphs out of 
place. These can all be easily corrected durin g another step in producing 
your document: editing. 
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EDITING 

Part III: Word Processing 

Editing is the process of adding, deleting, and modifying the text that 
you or someone else has entered. A word processor gives you tools that 
help you correct and format your document. 

If you left out a word, you can click the mouse at the point in the line 
where the word belongs to set the insertion point and then type the 
word. The computer moves all the text that follows this new word to the 
right. When a word no longer fits at the end of the line, it wraps to the 
next line, and the rest of the paragraph readjusts, or reformats, 
automatically. 

If you find a word that should not be in the document, you can select 
the word and delete it. The paragraph will be reformatted automatically. 
The words that follow move pack to the left, or even from one line to the 
line above it, if there is room. 

As with a typewriter, you can backspace to delete unwanted characters, 
but that is the long way. The beauty of deleting with a word processor 
is that you can select the word or words and just start typing over them. 
You can be much more efficient with your time and avoid 'unnecessary 
steps. 

For example, if a sentence (or paragraph, page, or section) doesn't say 
what you want it to say, you can select that text and replace it by typing 
new text. Any selected text will be deleted automatically when you type 
new words. The paragraphs that are affected will be reformatted. 

These are powerful editing features. Once you have used a word 
processor you will probably never want to go back to using a typewriter. 

Two more importanteditingfeaturesarecuttingandpasting. If a paragraph 
would make more sense somewhere else in your document, you can 
select that paragraph, cut it out of the document, indicate where you'd 
like it to be placed, and paste it into your document at that location. The 
word processor will relocate the text, close the gap that was created 
when the text was removed, make room for the text where you paste it, 
and automatically readjust all affected parts of the document. And you 
don't have to retype the whole document! 

Searching and Replacing 

Very helpful in the editing process is the search and replace feature, which 
allows you to search for a particular character or group of characters and 
replace those characters with something else. For example, you can 
search for a misspelled name such as Mr. Smith and replace all occurrences 
of it with the correct spelling of Mr. Smythe. The search and replace 
feature finds each occurrence in your document of whatever characters 
(or words or groups of words) you are searching for and replaces those 
characters with what you specify. · 
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Spell Checking 

FORMATTING 

You can even search for specific formatting characters, such as tabs and 
spaces, and replace them withl other formatting characters to help 
automate word processing tasks. 

Also helpful in the editing process is having the spelling in a document 
checked for you . A spelling checker determines if a word is spelled correctly 
by comparing each word in a document with the entries in its dictionary. 
If the word matches a dictionary entry, the spelling checker considers 
the word correct. If the word is not in the dictionary, that word is 
considered misspelled. Be aware, however, that all spelling checker 
dictionaries have limitations. Microsoft Word's dictionary contains 
about 130,000 entries, but, like most program-supplied dictionaries, 
proper names, acronyms, and obscure terms are not included. 

Don't depend on a spelling checker to do all your proofreading for you. 
Spelling checkers only find words that they don't recognize. The word 
it finds may be correct, but the spelling checker's dictionary doesn't 
contain it. Or the word in the document may be wrong, but it is a legal 
word. For instance, a spelling checker will know that "their" is spelled 
correctly and won't be able to tell you that the word should be "there" 
for a particular context. The spelling checker only knows correct 
spelling, not correct usage. It doesn't know the difference between 
"flower" and "flour," for example. Spell checking is not an automatic 
process-it simply provides suggestions that the user needs to consider 
before changing the word in question. 

There are programs that check grammatical structure, but they are 
beyond the scope of this book. 

Formatting a document involves determining how your pages will 
appear when printed. You can decide to change the margins of the page; 
change the font, size, and style of type throughout the whole document; 
or change single characters or words in the document. You can use 
multiple columns. Your document can be printed tall on the page like 
the usual letter, which is called portrait orientation, or you can turn the 
page sideways so the document prints out with the long side of the paper 
being the top of the page, which is called landscape orientation. 

Some of these decisions have al eady been made by the creators of the 
word processing program. These preset selections are called defaults. They 
have been previously set to the most common use for your convenience. 
As you become more familiar with a program you can change some of 
the settings to suit your work style and preferences. 
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For instance, Microsoft Word will assume that you want a new document 
to be printed vertically, to have l-inch top and bottom margins and 
11/4-inch left and right margins, to print in one column of text that is 
6 inches wide, and to use New York font, set for 12-point size and 
normal style. 

If you don't do anything, Microsoft Word will use these settings. 
However, if you want to print in three columns, with the page turned 
sideways, using Times font in 10-point bold, you can easily do this. 

Another example of a default setting is in Word's ruler. It is set to measure 
in inches, but a designer may want to measure in picas. Word processors 
usually allow you to change the defaults either for a single file or for the 
program in general. 

Default settings do not limit you. They are there to help your document 
conform to conventional document formats and to help you get started 
easily without havi ng to think about a lot of settings. The decision to 
accept a default setting or to override it is entirely up to you. When you 
become more proficient with Word, you can customize the program to 
suit your preferences. 

PRINTING 

SUMMARY 

Printing your document involves getting the words on the paper. Once 
you have entered, edited, formatted, and checked the text, you tell the 
computer the correct type of printer to use. Then you tell the program 
to print the document. The program sends the document to the printer. 
This process is automatic whether the document is 1 page or, in the case 
of this book, more than 700 pages. 

• Word processing is the process of using a computer to create documents through text entry, 
editing, formatting, and printing. 

• Text entry is the process of typing the text into a document. 

• Word wrap is the concept of the computer keeping track of the margins of a document. 

• A paragraph is any character or group of characters that is followed by a hard return (pressing 
the Return key). 

• A word processor is easier to use than a typewriter because a word processor allows you to 
make changes to a document without having to retype it. 

• The search and replace fea ture of a word processor locates every occurrence of a selected 
character or group of characters in a document and replaces it with the character or group of 
characters that you choose. 



Chapter 6: Word Processing Concepts 203 

• A spelling checker locates words in a document that do not match the entries in its dictionary. 
It does not catch grammatical errors or misuse of words. It is not a replacement for 
proofreading. 

• Formatting refers to the appearance of the printed page. 

• Page size, page orientation, margins, paragraph spacing, line spacing, and character formats 
are all governed by the formatting capabilities of a word processor. 

• Printing a document involves issuing a command to the word processing program to send 
a document to a selected printer. 

KEY TERMS 

cutting 

defaults 
document 

editing 

file 
formatting 

hard carriage return, hard return 
hyphenation dictionary 

landscape orientation 

paragraph 
pasting 
portrait orientation 
printing 

reformat 
ruler 

search and replace 
spelling checker 

text entry 

word processing 
word wrap 
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Chapter 7: Microsoft Word 4 

What You Will Learn in This Chapter 

After reading this chapter and completing the pro jects in it, you 
should be able to: 

• Select, delete, and edit text 

• Change character formats of text 

• Move text 

• Use the Find and Change features 

• Check the spelling of a document 

• Format a paragraph 

• Format a document 

• Insert tabs, tab leaders, and borders 

• Add page numbers 

• Ad just margins 

• Save and print documents 

• Open multiple documents 

• Incorporate graphics and text 

• Create and apply styles 

• Create and modify tables 

• Create multicolumn documents using sections 

• Create headers and footers 

• Create print merge documents 

W ord processing is probably the most widely used application 
on a microcomputer. If your creativity has been hindered by 
writing with pencil and paper or by using a typewriter, you 

will enjoy the benefits of using the Macintosh for word processing. 

Like other Macintosh applications, Microsoft Word uses pull-down 
menus, windows, a mouse, and many of the features you will encounter 
throughout your use of the Macintosh. 

Microsoft Word uses five formatting domains: the character, paragraph, 
table, section, and document. 
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The character is the smallest uni in the document. Characters consist 
of letters of the alphabet, punctuation marks, numbers, and symbols. 
Each character can be formatted individually, and groups of characters, 
such as words and sentences, can be formatted in one operation. 

A paragraph is a collection of characters that is followed by a hard return 
(pressing the Return key). A paragraph can consist of just a few 
characters, many sentences, or even a blank line. Any changes you make 
to the paragraph formatting affect the entire paragraph that is selected 
or that contains the insertion point. The character and paragraph are 
the basic units in Microsoft Word. You'll have the opportunity to work 
with many different character and paragraph formats throughout this 
chapter. 

A table, also called a cell table, consists of rows and columns of cells, and 
each cell can contain characters and paragraphs that have different 
formatting characteristics. You'll learn more about tables in Project 3 of 
this chapter. 

A section consists of one or more paragraphs and is followed by a section 
marker. A document can be divided into many sections, and each 
section can even be formatted with a different page layout, such as 
different numbers of columns. Each document contains at least one 
section. Project 4 in this chapter covers sections in detail. 

The document is the largest unit, and it consists of the document itself. 
When a document is formatted, all formatting pertains to the entire 
document. Some examples of document formatting include page 
margins and printing preparation.! You'll work with document formatting 
at different times throughout th1s chapter. 

STARTING MICROSOFT WORD 

Micr-osoft 'w'ord 

Starting Microsoft Word is just like starting the other applications 
you've worked with-you locate the application's icon and double-click 
on it. 

• Double-click on the Microsoft Word icon on your disk. 

This will start Microsoft Word and open a new document entitled 
"Untitledl". 
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GETTING HELP 

Part III: Word Processing 

While you are workin g in Microsoft Word, it is likely you'll want to make 
use of the additional information sup plied in the o n line Help file. The 
mate rial in the Help file is presented in concise, easily understood terms. 

You can activate Help by choosing About Word from th e Apple menu 
and then cl icking the Help button, or you can choose Help from the 
Window menu. In either case, assuming that the Help file is presen t o n 
the compute r and in the correct location, Word displays the Help 
window, as shown in Figure 7-1. 

Help 

.-~ ............ ~Jn 
l"li c rosoft Product Support :-...... ( 
Agai n - re peati ng co mmands = _ 
Aligning and justifying text 
Arithmetic 
Borders 
Canceling and undoing commands 
Columns 
Copying and moving text 
Copying formats 
Co u nti ng text 
Custo mizing the displ ay 
Custo mizing menus and key assignments 
Defaults 
Deleting text and graphics 
Documents: Cl osi ng 

Converting 
Creating 

Figure 7-1 The Help wi ndow 

Help ) 

Cancel ) 

You scroll through a list of topics that is o rganized alphabetically, and 
select the topic you want to read about. Either double-click on the topic 
name or click o nce to select the topic and then cl ick on the Help button. 
When you've selected a topic, Word presents info rmation about that 
topic. 

When you are finished reading the information, you can either click the 
Next button to continue getting help o r you ca n click the Previous 
butto n to go back to the previous topic. When you are fi nished using 
the Help window, you can close it by clicking its close box, o r click the 
Cancel button. Either way, you are returned to where you left off in your 
Microsoft Word documen t. 
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In figure 7-2, the topic selecfed for additiona l information was 
Formatting: Paragraph. The page number below the Next button 
indicates what page to reference in the program documentation for 
greater detail about that topic. 

10 He lp 

Formotllng: Porogroph ~ Topics I !!Contents ... I!:! About parOC)r>phs ( Concel ) 
Pareoraoh command ootions 

f To oet Indents, tabs, line spocinq, and other formats (Preuious) 
affectlnq the appearance and position of a parOCJr>Ph, ( NeHt l use the Paragroph command ( format menu, full 
men.,.), formatttnq keys,or the ruler. for more I Poge 2 71 information, see: I{ 
Hel! to~ic Reference l!age 

1!:. 
Aligninq and justif!linq text 3 

lndentlnq lines and parOC)raphs 129 

Line and paragraph spacinq 165 j.: 

Ruler 31 0 ~ ~hnlll .nor•n ri!AI!.,• 

Figure 7-2 A Help topic selected 

8€ -? You can also get context-sensitive help on a specific command or option 
without scrolling through the list of available topics. To do this, press 
Command-?, and your pointer turns in to a large question mark. When 
you use that question mark to select a command from one of the m enus, 
to click an icon on the ruler, or to use a key sequence that invokes a 
command, the Help dialog box is presented displaying the relevant 
topic. This also works fo r getting help about an open dialog box. 

With an extended keyboard-one that has function keys, arrow and 
direction keys, and other keys-you can use the Help key on the 
keyboard to get help and the Esc key to get out of Help. 

For more information about using Help, select Using Help from the list 
o f topics presented in the Help d ialog box. 

SAVING YOUR WORK 
Th e first time you save your document, Microsoft Word asks you, byway 
of the d ialog box shown in Figure 7-3, where you want your document 
saved and what you want it to be named. After you have saved a 
document the first t ime, the next time you choose Save, Word assumes 
that you want the document to be saved in the same place and under 
the same name. Be carefu l about saving your document in the correct 
place the first time you save it so you can find it later. The Save process 
is much quicker the second and subsequent times, because you are not 
prompted for any additiona l information. 
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Unfortunately, sometimes people are not careful, and they occasionally 
lose their work because t hey saved it where they couldn't find it when 
they needed it later. Clicking the Drive button repeatedly moves between 
one or more floppy drives and hard drives, depending on the hardware 
you are using. The Save dialog box shows the name of t he floppy disk 
or hard drive as that drive is selected. Your document will be saved on 
the selected disk or hard drive with the name showing in the Save dialog 
box. In the dialog box shown in Figure 7-3, the name of the disk, 
Carolyn Phillips, is shown in two places. Always be aware of where you 
are saving your work. 

The Save As command is similar to the Save command, except that it 
gives you the option to give your document a different name and save 
it in a different location. Every time you choose Save As from the File 
menu, you are prompted with the dialog box shown in Figure 7-3. This 
is the same dialog box you see the first t ime you save your document. 

When you use the Save As command and you attempt to save the 
document with the same name and in the same location as before, you 
will be asked if you want to replace the old document. This is because 
no two files in a particular location can have the same name. If you wan t 
to save different versions of the same document, use the Save As 
command and give the document a different name and/or location. 

Save your work often. Save at least every ten minutes, so you never lose 
more than ten minutes of work. The Command-key equivalent of the 
Save command, Command-S, is a helpful shortcut. Always save your 
work before printing. 

I liD Carolyn Phillips I 

I ~ 
Saue Current Document as: liD Carolyn Phillips 

!Document Name[ I 778K auailable 

0 rus1 SutJ~ 0 Mnk;~ llndult (! Saue J [ Eject ) 

[File Format ... ) Normal (Cancel ) [ Or iue ) 

Figure 7-3 The Save dialog box 
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Be aware that you can save a ocument before you actually type 
anything into it, and that many people do it this way. However, you will 
be given explicit instructions for saving your work at appropriate times 
throughout the projects. 

USING SHORT MENUS AND FULL MENUS 

Microsoft Word provides two sets of menus: Short Menus and Full 
Menus. Short Menus provides commands for routine word processi ng 
tasks and is intended to make the program less intimidating for 
beginners. Full M enus allows you to make use of all the Short Menu 
commands as well as of additional commands for more advanced word 
processing tasks. 

When Microsoft Word is in Short Menus mode, you' ll see Full Menus 
on the Edit menu. Also, when in Short Menus mode, there will not be 
as many settings to choose from on the ruler. To switch to Full Menus 
mode, choose Full Menus from the Edit menu. If Microsoft Word is in 
Full Menus mode, you'll be able to choose Short Menus from the Edit 
menu. In the projects in this chapter, you will be working in Full Menus 
mode. · 

Project 1: Creating a Business Memorandum 

In this first project you will produce a business memorandum. You will 
enter text, set tabs on the ruler, change several formatting characteristics, 
add page numbers, and print your document. 

As with all projects, read the entire project before starting. This will give 
you an overview of what you will encounter and may save you the work 
of having to backtrack if you make mistakes. 

Figure 7-4 shows the completed memorandum. 
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TO: 
FROM: 
DATE: 
SUBJECT: 

Acme Manufacturing, Inc. 
12366 Coyote Lane 

Dust Ring, OR 23366 

MEMORANDUM 

Larry Cassella, Eastern District Sales Manager 
Karin ]ole, Vice President of Sales 
July17, 1993 
january through june Sales Report 

Part III: Word Processing 

Based on a compilation of your recently submitted sales reports, the 
following shows the sales totals (in thousands of dollars) of our small parts 
product line for the first half of the year: 

Widgets 
Gadgets 
DooDads 
Total 

$746 
$564 
$395 

$1,705 

As yuu l:ctn see frum the figures, Widgets continue to be our top seller, and 
Gadgets are moving along at the rate we expected. Although DooDads don't 
seem to be selling too well, they are a seasonal product and we expect to 
see rapid gains through late fall and into early winter. 

Sales for the year closely match anticipated figures, and Widgets are 
running about 10 percent above projections. I am happy with the 
numbers at this point and feel our recent successes are due, in part, to the 
current "Give It All You've Got" sales campaign that has been implemented 
among the sales force. 

In the most recent tally of this sales campaign, four of the eleven people in 
your sales district are already eligible for the Las Vegas trip. Two others 
are close to qualifying, and eight of the eleven have already won their 
monogrammed Acme briefcases. I want you to congratulate these people 
for me, Larry. I' ll be speaking to them personally when we have the 
district sales meeting in September. 

1 

Figure 7-4 Page 1 of the completed memorandum 
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Our President, S. W. Acme, has indicated to me that he is very pleased with 
the results of this sales campaign. He made the following comment during 
the recent shareholders' meeting, and I am pleased to pass it on to you: 

Our sales force is the backbone of our illdustry, and we now have tl1e best in the 
history of Acme Manufacturing. These and women are dedicated workers, without 
whom we could not be showing the profits that we are today. 

I' m sure you'll make the President's remarks known to your sales staff, 
Larry. I know your people are deserving of this praise. 

To achieve projections on Gadgets we need to begin ou r promotions for the 
fall. We can plan our television and magazine advertising strategies during 
the sales projection meeting early next week. If you have any questions 
prior to that, please call me. 

2 

Figure 7-4 (continued) Page 2 of the completed memorandum 
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TYPING IN THE TEXT 
3€ -N If you don't have a document window open, follow the instructions for 

opening a new document under "Starting Microsoft Word" earlier in 
this chapter. 

In the upper left corner of the document window there is a vertical line 
on the screen. This line flashes to draw your attention. It is called the 
insertion point and shows the location where the next character you type 
will appear. Since no text has been entered into this document, the 
insertion point is at the top left corner of the text area on the page, as 
shown in Figure 7-5. 

' j File Edit Format Font Document Utilities Window 

Untitled I 

Page 1 Norm II 

Figure 7-5 The untitled document and the insertion point 

Notice that the pointer changes shape when you move the mouse to 
different parts of the screen. Whenever you move the mo use pointer 
over the text area of the window, the pointer changes to thel-beam pointer. 
This signifies to you that you are in a text editing a rea, and clicking the 
mouse button while the pointer h as this shape will set the insertion 
point to a new location. 

• Choose the font for the document. If you are using a LaserWriter, 
choose Times and 14 point from the Font menu. If you are using an 
Image Writer New York is the default font, and that is fine for this 
project. Leave the font at the default values of 12 point and plain 
text style if you are using an Image Writer. 

There are two types of fonts: bitmapped fonts and laser fonts. The 
output device you will be printing to affects your choice of fonts because 
a laser font will print best o n a LaserWriter, and, if you are using an 
Image Writer, a bitmapped font will print best. In additio n, the printed 
output will have the best quality if you choose a font size that is defined 
in the System file. These defined sizes are called outline fonts and are 
displayed in the size portion o f the Font menu in o utlined lettering. 
Times is a laser font, and New York is a standard Image Writer bitmapped 
font. 
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At the start of each project in tqis chapter a LaserWriter font and an 
lmageWriter font will be suggested for you to use. Base your choice on 
the printer you will be using. 

The example in this project uses the New York font . 

You need to verify that you are using Full Menus. If you are using Full 
Menus, Short Menus will be an option on the Edit menu. If Full Menus 
shows on the Edit menu, select Full Menus. 

• Choose Edit in the menu bar and hold down the mouse button. 

• If Short Menus is showing at the bottom o f the Edit menu, release 
the mouse button without making a selection from the menu. 

If Full Menus is showing at the bottom o f the Edit menu, select Full 
Menus. 

Now you should be working in Full Menus mode, which is the mode 
you' ll be using in all the projects in this chapter. 

In th is pro ject you'll type the entire docum ent without any special 
formatting, and once it's typed you'llformatthe document. If you make 
any err.ors as you type, use the Backspace key (Delete key on some 
keyboards) to remove the character or word and then retype it . 

• Type the following, pressing Return where indicated: 

Acme Manufacturing, Inc. (press Return) 
12366 Coyote Lane (press Return) 
Dust Ring, OR 23366 (press Return three times) 

Type MEMORANDUM in all caps, and then press Return three 
times. 

The first Return is to end the line, and the second and third are to create 
two blank lines. 

Now you'll type the memo heads, and you'll use the Tab key to separate 
the heads from the names. You'll use th e default tab stops for now, 
which are at half-inch intervals. Each time you press the Tab key, the 
insertion point will move 1/2 inch to the right. 

Don't worry about the names lining up at this point. Yo u' ll change that 
later. 

• Type TO: in all caps, and thel press the Tab key. 

• Type Larry Cassella, Eastern f istrict Sales Manager, and then press 
Return. 

• Type FROM:, press the Tab key, and then type Karin ] ole, Vice 
President of Sales. Press Return. 

• Type DATE:, press the Tab key, and then type july 17, 1993. Press 
Return. 
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•• Type SU BJECT:, press t he Tab key, and then type j anua ry through 
june Sa les Report. Press Return three times, so that two blank lines 
are between the memo heads and th e body of the memo. 

Your screen should now look like the one in Figure 7-6. 

r 115 File Edi t Format Font Document Utili t ies Window 

~0 

Acme Manufacturing, Inc. 
12366 Coyote Lane 
Dust Ring, OR 23366 

MEMORANDUM 

Untitledt 

TO: Larry Cassella, Eastern District Sales Manager 
FROM: Kar in Jole, Vice President of Sales 
DATE: July 17, 1993 
SUBJECT: January Ulrough June Sales Report 

Page t JNorm al 

Figure 7-6 The first part of the memorandum 

It's a good idea to save your work at this point. 

., 

SAVING THE DOCUMENT 

Be carefu l about saving your document in the correct place the first time 
you save it so you can find it later. The Save process is much quicker the 
second and subsequent times, because you are not prompted for any 
additional information. 

Save your work often-save at least every ten minu tes, so you never lose 
more than ten minutes of work. The Command-key equivalent of the 
Save command, Command-S, is a helpful sho rtcut. 

3€ -S • Choose Save from the File menu. 

• Click the Drive button, if necessary, to switch drives until the name 
of your data disk is showing at the top of the Save dialog box, where 
Ca ro lyn Phillips is in Figure 7-7. 
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I tg} Carolyn Phillips I 

Saue Current Document as: 

I Sales Rep or~ 
D rust Soul' D Mnkt' Onckup 

[ File Formnt ... J Normol 

tg} Carolyn Phillips 
778K auallable 

8 [! EJect ) 

[ Cnncel] [ Driue J 

Figure 7-7 The Save dialog box 
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,,. Type Sales Report as the name of your document, and then click the 
Save button. See Figure 7-7. 

Now you'll continue typing th e body of the memo. 

• Type the first paragraph o f the memo, allowing word wra p to move 
the text onto the next line as the words reach the right margin. Do 
not press Return until you've typed the last word in the paragraph: 

Based on a compilation of your recentl y submitted sales reports, the 
following shows our sales totals (i n thousands of dollars) of our 
small pa rts product line for the fi rs t half of the year: 

Notice how, when a word doesn't fit o n the li ne, it drops to the next line 
automatically. Word wrap enables you to concentrate o n your typing 
and not have to worry about the end of each line. 

For th e next four lines (the sales figu res), you' lluse the Tab key to type 
the two columns of text. You'll format the m properly when you 've 
finished typing the memorandum. 

,,. Type Widgets, press the Tab key, and then type $746. 

,,. Ho ld down the Shift key whi.l e pressing Return. 

The Shift-Return combination is cal led a soft retum, because it causes the 
insertion point to move to the next line but does not start a new 
paragraph. The n ext line you type will be considered part of the same 
paragraph. The new-line command enables you to format all the lines 
of a paragraph by setting the insert ion point anywhere within one of the 
lines and then selecting the desired formatting options. In this case, it 
will make it easier to format the four lines in these tabbed columns since 
you'll be able to work with them as one pa ragraph. You' ll see h ow-this 
works in a few minutes. 

.. Type Gadgets, press the Tab key, and then type $564. Press Shi ft-
Return. I 

• Type DooDads, press the Tabl key, and then type $395. Press Shift
Return. 

.. Type Total, press the Tab key and then type $1,705. Press Return. 
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If you scroll to see the last text that you typed, your screen should look 
like the one shown in Figure 7-8. 

,.. * File Edit Format Font Document Utilities Window 

Soles Report 

MEMORANDUM 

TO: Larry Cassella, Eastern District Sales Manager 
FROM: Karin Jole, Vice President of Sales 
DATE: July 17, 1993 
SUBJECT: January through June Sales Report 

Based on a co!fipilation of your recently submitted sales reports, the 
follo~ng sho'WS our sales totals (in thousands of dollars) of our small parts 
product line for the first half of the year: 
Widgets $746 
Gadgets $564 
booDa<:ls $395 
Total $1,705 

Page I JNormol 101 

Figure 7-8 The tabbed columns 

,,. Type the following three paragraphs, letting word wrap move the 
words to the next line when they reach the right margin. Press 
Return only at the end of each paragraph. Press the Return key only 
once after you've finished typing each paragraph in the document. 
You' ll format the paragtaphs with a space between them later: 

Sales for the year closely match anticipated figures, and Widgets are 
running about 10 percent above projections. I am happy with the 
numbers at this point and feel our recent successes are due, in part, 
to the current "Give It All You've Got" sales campaign that has been 
implemented among the sales force. 

As you can see from the figures, Widgets continue to be our top 
seller, and Gadgets are moving along at the rate we expected. 
Although DooDads don't seem to be selling too well, they are a 
seasonal product and we expect to see rapid gains through late fall 
and into early winter. 

In the most recent tally of this sales campaign, four of the eleven 
people in your sales district arc already eligible for the Las Vegas trip. 
Two others are close to qualifying, and eight of the eleven have 
already won their monogrammed Acme briefcases. I want you to 
congratulate these people for me, Larry. I'll be speaking to them 
personally when we have our district sales meeting in September. 

3€ -S ,,.. Choose Save from the File menu. 

,,. Type the following four paragraphs to complete the text entry of 
your document: 
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Our President, S. W. Acme, has indicated to me that he is very 
pleased with the results of this sales campaign. He made the 
following comment during the recent shareholders' meeting, and I 
am pleased to pass it on to you: 

"Our sales force is the backbone of our industry, and we now have 
the best in the history of Acme Manufacturing. These men and 
women are dedicated workers, without whom we could not be 
showing the profits that we are today." 

I'm sure you'll make the President's remarks known to your sales 
staff, Larry. I know your people are deserving of this praise. 

To achieve projections on Gadgets we need to begin our promotions 
for the fall. We can plan our television and magazine advertising 
strategies during our sales projection meeting early next week. If 
you have any questions prior to that, please call me. 

You've completed one phase of word processing: creating the document. 
Now that you've typed the body of the letter, save your work again. 

3€ -S • Choose Save from the File menu. 

EDITING THE DOCUMENT 

Using Show 11/Hide 11 

The next phase of word processing on this document is editing. Editing 
covers a lot of area, but basically it means making sure the document 
says what you want it to say and that it is error-free. 

Show~ is a command that can be very useful when you are editing your 
document. 

Every time you press a key on your keyboard, a character is inserted into 
your document in that position. Pressing the Return key at the end of 
a line is an instruction that tells the program to drop down one line and 
go back to the left margin. Microsoft Word stores a paragraph's 
formatting characteristics with the paragraph marker at the end of the 
paragraph. 

The space bar inserts an invisible character into the text, just like typing 
one of the letter, number, or punctuation characters. The space is 
invisible, but it is a real character, ~ike any other. The Tab key also causes 
an invisible character to be placea in the document at the point where 
the Tab key was pressed. 

Using Show~ is a good way to see if you accidentally typed extra spaces 
between words, and it lets you see how many blank lines you are 
creating each time you press the Return key. You can tell how text is 
formatted by using Show 1-for example, did a tab cause a particular 
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This symbol 
represents where 
the Tab key was 
pressed. 

A dot is used to 
represent where the 
space bar was 
pressed. It is similar 
to a period but is 
slightly above the 
period on the line. 
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indentation or was it set using the first-line indent setting of the ruler? 
Show~ also gives you the abil ity to see and select certain characters in 
your document that would otherwise be hidden. 

:3€ -Y ,,. To see the hidden formatting characters in the text you've just 

:+ 

typed, choose Show <j[ from the Edit menu. 

Your screen now shows ch aracters that you probably didn't realize you 
had typed. Figure 7-9 shows an explanation of each character. 

Karin. _Tole,. Vice.President. 
E:+ 

SUBJECT:+ 
July. 17,. 1 993<Jf 
January.through.Jun . 

This symbol represents 
where the Return key was 
pressed (a hard return) and 
is the symbol for the end of 
a paragraph. qr 

qr 
Bas .on .a.compilation.of.your.recen This is the symbol for a 

soft return and is 
produced by holding 
down the Shift key when 
pressing Return. It is 
used when you want to 
move to a new line but 
want to keep the text part 
of the same paragraph. 

o lowing .shovvs.our.sales. totals.(in .th 
parts. product.line.for. the .first.half .of. 
Widgets+ $7 46._. 
Gadgets+ $564._. 
DooDads+ $395._. 
Total+ $1, 705<Jr 

Figure 7-9 Viewing hidden formatting marks using Show ~ 

Many people choose to work with Show ~ on whenever they work in 
Microsoft Word. Throughout this project and the others in this chapter, 
you'll use th is option to enable you to see the different formatting 
characters as you insert them and to make selecting those characters 
easier when editing and formatting your document. These specia l 
characters are visible on the screen only; they wi ll not print when you 
print your document. 

To change back to the normal view, you choose Hide <jJ from the Edit 
menu. The Show~ command isoneofthe menu commands that toggles 
on and off. What appears on the menu is the opposite of what is in 
effect-Hide <J[ won't be showing on the menu unless Show ~ is in effect. 
See Figure 7-10. 
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Selecting Text 
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r7:':-t Undo :•:z -Cnn·tundo :•:z 

cut :•:11 Cut :•:II 
[Ojll.l :a;c [ Ollfj :•:c 
Past e xu Paste xu 
r IL•nr [ l l'llr 
Rtjnln :•:fl RIJilin :•:fl 

lobi e ... Tnble .•. 
GIOSSft rll ... X K Glossory ... X K 

0 , . 

l'tiSI Cl Link l'nslo Unk 
lliHlotl' link Ui>t1ntP. link 

Short M enus Short Menus 
Pref erences ... Pre f er ences ... 
Commands ... Commands ... 

Figure 7-10 Show~ and Hide~ in the Edit menu 

Selecting a character, word, line, sentence, paragraph, or group of any of 
these elements points out to Microsoft Word t he text you want to work 
with . There are several ways to select text in Microsoft Word: 

• Click t he 1-beam pointer to the left of the character, word, or line 
you want to select, and then drag across the portion you want 
selected. Selected text is highlighted. (This is also called wiping through 
text.) 

• To select an entire word, double-click on it. 

• To select an en ti re sentence, hold down the Command key and click 
an ywhere in the sentence. 

• The selection bar provides a means of selecting large blocks of text. 
The selection bar is located a t the far left of the document and 
appears to be a margin about 1/8-inch wide. When you move the 
1-beam pointer into the selection bar, the I-beam changes to an 
arrow that is pointing to the right. Figure 7-11 shows the pointer 
when it is in the selection bar. 

D 
IAcm e.lvlanufacturing,. Inc:qJ 
12 366 .Coy ote.Lane<lJ 
Dust.Ring, .OR .. 2 336 6<lJ 
qJ 

qJ 

~ ME1viORANDUM<lJ 
qJ 

Figure 7-11 The pointer in the selection bar 

s 
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• To select an entire line using the selection bar, position the pointer 
in the selection bar to the left of the line you want to select and click 
the mouse button. 

• To select an entire paragraph using the selection bar, double-click in 
the area to the left of the paragraph. The entire paragraph becomes 
selected. 

• To select any number of lines, click and drag up or down in the 
selection bar. 

• To select a larger portion of the document, click to indicate the 
beginning of a selection, and then Shift-click to indicate the end of 
the selection. The portion of the document that you marked for 
selection will be highlighted. 

:3€ -Option-M • To select an entire document, hold down the Command key and 
click once in the selection bar (the arrow must be pointing in toward 
the text). 

Moving Text 

The ability to move text or graphics from one place in a document to 
another, or between documents, is convenient and time saving. To 
move text, you must first select it using any of the methods described 
above. By selecting, you indicate what text you want to move. After it 
is selected, you cut the selected text from the document and copy it to 
the Clipboard using the Cut command from the Edit menu. The 
Clipboard is an area in computer memory that stores the most recently 
copied or cut item. 

Once the text is in the Clipboard, position your insertion point in the 
document at the location the text should be moved to. Then the Paste 
command places the text from the Clipboard into the document at the 
insertion point. 

:3€ -C Copying works the same way as Cut, except you use the Copy command 
from the Edit menu. Copy does not remove the text from the document 
like the Cut command does, it just places a copy of the selected text in 
the Clipboard for you to paste elsewhere in your document. 

You'll move a paragraph in the Sales Report document now. 

• Select the paragraph beginning "As you can see from the figures", 
which is near the middle of the Sales Report, by double-clicking 
in the selection bar to the left of the paragraph, as shown in 
Figure 7-12. 
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Window 

followmg shows our.sales.totals (in tbousands.of.dollars).of.our.small parts. 
product-line. for the.flrst.half of tne year q 
Wtdgets• $746 ... 
Gadgets• $564 ... 
DooDads• $395"' 
Total• $1.705q 
Sales for .the year c!OS(>Iy.match.anticipated.figures •. and. Widgets.are running 
about. 1 o. percent.above. projections ... I .am.happy. with. tlle.numt>ers.at. this. 
point.and feel our recent.success.are.due •. ln.part •. to.the.current.•Give.It.Ail. 
You·ve.Got".sales.campalgn.that.has.t>een.implemented.among.tlle.sates. 

Figure 7-12 Selecting the paragraph to be moved 
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3€ -X • With the paragraph selected, choose Cut from the Edit menu. 

The selected paragraph is removed from the document and placed in the 
Clipboard. 

• Cli ck to the left of the first "Yord in th e pa ragraph beginn ing "Sales 
for the year" to set the insertion point in front of t hat paragraph. 
Your screen sho uld look like the one in Figure 7-13. 

When you set the insertion point in fron t of the paragraph, the pointer 
should not be in the selection bar, because that would cause the whole 
li ne to be selected. You can tell if you ' re in the selection ba r-the 1-beam 
will change to an arrow if you are. 

r ti File Edit Format Font Document Utilities Window 

following.shows.our .sates. totals. (in. thousands.of.dollars).of .our .small. parts. 
product.line .for. the.first.half.of. the. year:<!! 
Widgets+ $746 .... 
Gadgets+ $564 .... 
DooDads+ $395 .... 
Total+ $1,705<11 
!Sales. for. the. year .closely .match.anticipated.figures,.and. Widgets.are. running. 
about. I 0. percent above. projections ... I .am.happy. with. the.numbers.at. this. 
point.and.feet.our .recent.success.are.due,.in. part,. to. the.current. KGive. It. AU. 
You've .Got• .sa!es.campaign. that. has. been. implemented .among. the .sales. 
force.<!! 

., 

: i In. the.most.recent. tally .or. thls.sa.les.campalgn,.four .of. the.eleven. people. in. 
your .sales.distnct .are.already .eligible.for. the. Las. Vegas. trip .. . Two.others.are. , , 
close. to.qualifying,.and.eightof. the.eleven.have.already. won. their . 
monogrammed.Acme.briefcases .. . I .want.you.to.congratulate.these.people.for. 
me,.Larry ... I'll.be.speaking.to.them.personally.When.we.have.our.district 
sales.meeting.in.September.<i 
Our s .. w .. 

Figure 7-13 Setting the inserti on point before moving the text 

Setting the insertio n point indicates to Microsoft Word where you want 
the tex t that you cut from the document to be pasted. 
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:3€ -V ,,. Choose Paste from the Edit menu. 

The paragraph t hat you cut shou ld now be pasted above where you had 
the insertion point, as shown in Figure 7-14. 

"' * File Edit Format Font Document Utilities Window 

folloWing.shows.our .sales. totals. (in. thousands. of .dollars).of .our .small. parts . 
product .!lne.for. the. fi rst.half .of. the. year:<lf 
Widgets+ $746 .... 
Gadgets+ $564 .... 
DooDads + $395 .... 
Total+ $1, 705'11 
As. you.can.see.from. the.figures,. Widgets.continue. to. be.our. top.seller,.and. 
Gadgets.are.moving.along.atthe .rate.we.expected ... Although.DooDads.don't. 
seem. to. be.selling. too. well,. they .a re .a.seasonal . product. and. we.expect. to.see. 
rapid.gains. through .late.fall .and.into.ear!y .Winter.<lf 
jSales.for. the. year .closely .match.anticipated .figures, and. Widgets.are .running. 
about . 10. percent .above.projections ... I .am.happy.With. the.numbers.at. this. 
point.and.f eel.our .recent.success.are.due,.in. par t,. to. the.current. "Give. It. All . 
You've.Got".sales.campaign .that .has.been .implemented.among. the.sales. 
force.<JJ 
In. the.most.recent . tally .of. this.sales.campaign,.four .of. the.eleven. people .in. 
your .sales.district .are.already .eligible.for . the. Las. Vegas. trip ... Two.others.are . 
close.to. t .of.the.eleven won . thei~r .lillffilliili~~~ 

Figure 7-14 The paragraph after the move 

:3€ -S "• Choose Save from the File menu to save these changes. 

Searching and Replacing 

There may be times when you wan t to replace every occurrence of a 
word with a different word . If your document is very long, this search 
and replace p rocess could be a time-consuming task. Or maybe you'd 
just like to see each occurrence o f the word to see if you've overused it, 
or you want t o see each time it begins with a capital letter so you'll know 
how many sen tences begin with that word. Microsoft Word gives you 
the ability t o find characte rs, words, g roups of words, punctuation 
marks, o r formattin g characters and to change them to just about 
anyth ing you want, using the Find and Change commands. 

Using the Find Command 

The Find command is used to locate every occurrence of a character o r 
group o f characters. Both the Find command and the Change command 
begin the search at the insertion point. If you want to sea rch the whole 
document, it's easiest to set the insert io n po int in fron t of the first word 
in the document. If you do n't, when the search reaches th e end of the 
document, a dialog box will ask you if you want to continue searching 
fro m the beginning of t he document. 

:3€ -F ,,. Cli ck to t he left o f the first word in the document, "Acme", to set the 
insertion poin t there. 

• Choose Find from the Utilities menu. 



Chapter 7: Microsoft Word 

Return or Enter 

The dialog box tha t results is show n in f-igure 7-1 5. 

rind 

Find Who I: II I 
~=-------~--~ 181 Whole Word 181 Match Upper / Lowercose 

U Stort Sean h JJ [ Cancel J 

F~gure 7-15 The Find dialog box 
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The Find What box is where you type the characters or words you wan t 
to find . Let's see if the word "our" has been used too often in thi s letter. 

• Type o u r in the find What box. 

Two o ptions in this dialog box help you narrow the specific words to 
fi nd: the Whole Word and Match Upper/ Lowercase options. 

When you select the Whole Word option, Microsoft Word finds only 
words that stand o n thei r own, those that are preceded and followed by 
a space. For exa mple, if you told Word to find every occurrence of the 
word "the" wi thout selecting the Whole Word o ptio n, it would find any 
words that had "the" anywhere in them-other, leathe r, theate r, and so 
on. W hen you're looking fo r a specific word, use the Whole Word 
option. The Whole Word optio n is the default set ting for the Fi nd dialog 
box; yours should have an "x" in the box to the left of Whole Word. For 
the search you're abou t to make you want the Whole Word option 
selected. 

The Ma tch Upper/ Lo wercase option a llows yo u to specify that you are 
looking for words that are ca pitalized (or not) in a certain way. 
Capitalizing the first letter of the word in the Find What box and using 
the Match Upper/Lowercase option will help you find words that begin 
sentences, for example. The Match Upper/ Lowercase optio n is the 
default setting fo r the Find dialog box. For the sea rch that you are about 
to make you wa nt to find all occurren ces of the word "our", so you do 
not wan t the Match Upper/ Lowercase o ption se lected. 

• Click Match Upper/Lowercase to dese lect that o ption (remove the 
"x" from t he box to its left). 

• Click the Start Search button. 

If a match is found, Microsoft Word highlights the word in the 
documen t and stops. 

The first occurrence of "our" is in the fi rst paragraph, as shown in 
Figure 7-1 6. 
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' 415 File Edit Format Font Document utilities Window 

Soles Report 

rollowing.shows.B'!I!.sales.totals.(in.thousands.of.doUars).of.our.smaJI.parts. 
product Une.ror.the ftrst .balf.of.the.year,q 
Widgets+ $7'16 ... 
Gadgets+ $564 ... 
DooDads+ $395 ... 
Total+ $1,705<1! 
As. you.can .see. from . the. figures,. Widgets.con tinue. to. be .our. top .seller ,.and. 
Gadgets.are.moving.aJong.at. the.rate.we.expected ... Aithough.DooDads.don't. 
seem. to. be .selling. too. weu,. they. are .a. seasonal. product.and . we .expect. to.see. 
rapid.gains.through.late.rau.and.into.early.winter.<i 
Sales.ror .the.y 10 Find .are.r unning. 
about. 1 o.perc 

l our I 
rs.at.this. 

point.and.feel . Find What: "Give. lt.AU. 
You've.Got".Sal 181 Whole Word 0 Match Upper/ lowercase e.Sales. 
force.<i 
In.th& most .r e< (( Find NeHt )j [Cancel ) .poople.in. 
your.sales.dis :.o .0 • .others.are. 
close. to.Q uaJHyinJ!:,.and .eiRht.of. the .eleven. have .already . won. their. 

Figure 7-16 Find ing the firs t occurrence of "our" 

Return or Enter • Click the Find Next button to find the next occurrence of "our." 

• Continue to click the Find Next button after each occu rrence of 
"our" is found. 

• When the "End of document reached" message is shown, click OK 
to that box, and then click the Cancel button in the find dia log box. 

There were many (11, to be exact) occurrences of "our" in the document, 
and it would sound bette r if some of them were changed to "the". You'll 
use the Change command for that operation . Using the Find command 
to coun t each occurrence of a word to determine if the word is overused 
is a good habit. Now that thi s exercise has given you the oppo rtunity 
to see how the Find command works, you'll be able to see more clearly 
how the Find command differs from the Change command. 

Using the Change Command 

The Change command is similar to the Find command. You specify the 
group of characters you want changed, and th en you specify what you 
want them changed to. 

• Since you wan t the sea rch to start at the beginning of th e documen t, 
click to the left of the first word in the document to set the insertion 
point there. 

~ - J-1 • Choose Change from th e Utili ties menu. 

The d ialog box tha t results is shown in Figure 7-17. Notice t hat in the 
find What box is the word "our", which you were searching fo r in the 
Find operatio n. The Find and Change dialog boxes share the Find What 
box, so that when you search for a word in a Find operation you don't 
have to retype it in a subseq uen t Change operation. 
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10 
Find Wha t: 

Change To: 

181 Whole Word 0 Match Upper/ Lowercase 

n Start Search a~ [ Change Hll J ~ 

Figure 7-17 The Change dialog box 

You' ll recognize the Whole Word and Match Upper/Lowercase options 
from the Find d ialog box. These options work the same as they d id in 
the Fi nd dialog box, and their settings also ca rry over from the Find 
dialog box to the Change dialog box. 

• Click in the Change To box, and type the. 

There are th ree buttons at the bottom of the d ialog box. The Start Search 
button causes the sea rch to begin, and you determine what action to 
take when each occurrence of the group of characters is found. You 
verify whether a group of characters is to be changed. 

The Change All button changes all occurrences of the characters 
without having you verify each occurrence. Use this button instead of 
the Sta rt Search button if you are sure you want all occurrences changed 
and don' t need to verify each change. 

The Cancel button cancels the Change operation. 

Return or Enter • Click the Start Search button. 

The first occurrence of the word "our" is found in the first paragraph. 
The Change dialog box looks like the one shown in Figure 7-18. 

' a Fife Edit Format Font Document Utilities Window 

Sefes Report 

lollowing.showsE .sates.totals.(in.thousands.ot .dollars).or.our.small.parts. 
product.llne.ror. the.rtrst.hatr or .the. year-<r 
Widgets• $746 .. 
Gadgets• $564 .. 
DooDads • $395 .. 
TOtal+ $1,705q 
As.you.can.see.rrom the figures,. Widgets.contlnue .to.be.our top.seller, and. 
Gadgets.are.moving.along.a t.lhe.rate.we.expected ... Although.DooDads.don't. 
seem.to.be.selllng.too well,.they.are .a.seasonat.product.and.we.expect.to.see. 

rapid gainM~go~~!ii~~~~~~~~~~~~~ Sales for.tl! running. 
about. to. Find Whet: t. this . 

es. 
point and e ft. AU. 
You've.Go Change To: 
rorce.q 181 Whole Word 0 Match Upper/ Lowercase 
In the mo pte.in. 
yo~-~tes K No Change U [Change) [ Cha ngll Selection) [ Cancer ) ers.are . 
ctose.to. , 

Figure 7-18 Changing the first occurrence of "our" 
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You click the Change button to replace the selected characters with the 
characters in the Change To box, or you click the No Change button to 
leave the selected characters unchanged. Whether you click Change or 
No Change, the search continues to the next occurrence of the characters 
in the document. The Change Selection button allows you to change 
just the selected text, and the Change dialog box stays on the screen . 
You can then enter a new Find What or Change To group of characters 
and start another search. 

"• Click the Change button so that the first occurrence of "our" is 
changed to "the" in the first paragraph. 

,,. Click the No Change button so the second occurrence of "our" in 
the first paragraph is left unchanged . 

• Click the No Change button to each occurrence of "our" in the 
second and th ird paragraphs. 

• In the fourth pa ragraph, click the Change button to change the 
word "our" in the last sentence so that it reads "I' ll be speaking to 
them personally when we have the district sales meeting in 
September. " 

• Click the No Change button for each occurrence of "our" in all but 
the last paragraph of the document. 

,. In the last paragraph, click the No Change button to the first 
occurrence of the word "our" in the second sentence. 

• Click the Change button so that the second occurrence of "our" in 
the second sentence is changed to "the". The sentence should now 
read: "We can plan our television and magazine advertising 
strategies during the sales projection meeting early next week." 

• When you get the "End of document reached" message, click the OK 
button, and then click the Cancel button in the Change dialog box 
to end the operation. 

You should have made a total of three changes in that operation . 

:3€ -S • Save your work by choosing Save from the File menu. 

You can also use the Find and Change utilities to locate special 
formatting characters, such as paragraph marks and tabs. When you are 
searching for these characters, the caret (") precedes the letter that 
represents the character. For example, to search for a tab mark you 
would enter "tin the Find What box. You can search fo r a paragraph 
mark using " p. For a list of special formatting characters that you can 
search for, see Reference to Microsoft Word. 

You learned how to find and change specific words in your document 
using the Find and Change utilities. Next you'lllearn to use the spelling 
checker to fi nd and change words that you don' t usually realize are in 
your document. 
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Using the Spelling Checker I 
Microsoft Word's spelling checker is an invaluable tool for editing your 
document, because it helps you locate and correct m isspelled words, 
including those with typographical errors. 

When using the spelling checker, Microsoft Word begins checking your 
document at the insertion point. To check the entire document without 
interruptio n, you must set the insertion poin t before the first word in 
the document. If you don' t do this, Microsoft Word will check from the 
insertion point to the end of the file and then ask you if you'd like to 
continue checking from the beginning of the document. 

If you already have a word selected and then you run a spelling check, 
Microsoft Word only checks the selected word. This is handy if you've 
al ready checked the entire document and just have an added word or 
paragrap h to check. In that case, you select the word or paragraph before 
running th e spelling check and the selection is the only portion of the 
document checked. 

• Use the scroll ba r to scroll backward in the document to the first line 
and click to the left of the line beginning with "Acme Manufacturing". 

~ -L ,. Choose Spell ing from the Utilities menu. 

The dialog box shown in Figure 7-19 will result. 

m Spelling 

Words: Open Dlctlonories: 

I ~ 
MS Dictionary ~ 
User 1 

In 
Unknown Wor d: 

Chonge To: II 1088 
18J ignore Words In All Caps 

~ stort Check ~ [c hongt)J [ Sugtjl)st) [ Cancel] 

Figure 7-19 The Spelling dialog box 

The Ignore Words in All Caps option allows you to bypass any words 
written in all capita l letters. This is helpful if your document contains 
many acronyms, which are formed from the first letters o f several 
words-for example, AM, PM, IRS. Spell ing checker dictionaries do not 
usually contain acronyms. The default setting for this option is on, as 
you can see by the "x" in the box to its left. Leave this option selected 
when checking the Sales Report document. 

Return or Enter • To begin the spelling check, click Start Check, or press Return 
(because Star t Check is the default choice). 

The first unknown word the spelling checker finds is "Cassella," as 
shown in Figure 7-20. Notice that this word is highlighted in the 
document. Although this word is not misspelled, it is common for 
spelling checker di ctio naries to omit proper names. 
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' j File Edit Format Font Document Utilities Window 

Sales Report 

TO:+ Larry IIIIIIII..Eastem.Distnct.Sales.Managerq 
FROM:+ Kar!n.Jote, VIce Presldent.of.SaJesq 
DATE:+ July 17,. 1993q 
SV8JECT:+ january.tllrough.june.Sales.Repor (q 
q 
q Spelling 
8ased.on.a Wor ds: Open Dictionaries: 
following.! 

I c 
MS Oiction11ry ~ 

!.parts. 
product.llr User I 
Widgets+ 
Gadgets+ 10 DooDads+ 
Total • Unknown Wor d: C11sse1111 
As.you.car 

Change To: II 1080 r,.and. 
Gadgets.ar s.don't. 
seem. to. bE 0 Ignore Words In Rll Caps ct.to.see. 
rapld.gain 

~ No Ch11nge ) !(hnnge) [suggest ) [cancel) Sates.for.tJ .running. 

Figure 7-20 An unknown word found in the document 

Severa l options are ava ilable when Microsoft Word finds an unknown 
word (one that is not in its dictionary): You can type the word that you'd 
like the highlighted word in your document to be changed to in the 
Change To box and then click the Change button. This will replace the 
highlighted word in your document with the word you typed. 

Another cho ice is t hat you can click the No Change button, which 
indicates to Microsoft Word that you want to leave the word in question 
unchanged and move on. 

You can click the Suggest button. This indicates that you 'd like Microsoft 
Word to search through its dictionary and presen t one or more words 
that you may be trying to spell. If the spell checker is able to suggest any 
alternatives, a list o f those words will appear in the Words portion of the 
dialog box, and the first word on the list will appear in the Change To 
field, as shown in Figure 7-21. 

' j File Edit Form11t Font Document Utilities Window 

S11les Report 

TO:• Larry 1111J1,.Eastern.Distrlct.Sates.Managerq 
FROM:+ Karin. )ole,. Vice. Presldent.of. SaJesq 
DATE:+ juty. t7,. 1993q 
S\J8jECT:+ january.tllrough.June.Sales.Reportq 
q 
q ID Spelling 
8ased.on.a Words: Open Dictionar ies: 
following.s 

i!-111! c 
MS Dictionary :!::! 

!.parts. 
product.lln User 1 
Widgets+ 
Gadgets• :n 
DooDads• 
Total+ Unknown Word: Cassella 
As you car 

Change To: 080 r, and. 
Gadgets ar s.don't. 
seem. to bE 0 Ignore words In All C11ps t.to.see 
rapld.galn 

Jl/Chllngeg (Suggest J [ C11ncet) Sales.for .u ( No Change .runrul!&_ 

Figure 7-21 List of suggested words 
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You can scroll through the list of suggested words and select a word 
you'd like by clicking on that word and then clicking the Change 
button o r pressing Return . The selected alternative word will replace the 
word in your document that the spell checker identi fied as unknown. 
If none of the words that were suggested will fit the word in question, 
as in this case, click the No Change button. 

You could also add this unique word to the User 1 dictionary by clicking 
the plus button. Word will then consider it a correct spelling in the 
future. 

• Click the No Change button. 

Microsoft Word continues checking the document and presents each 
unknown word. This allows you to verify each word as it is located. 
When the entire document is checked, a dialog box will appear to 
indicate the end of the document was reached. Click OK in this box to 
end the spelling session . 

• Finish checkingyourdocument for unknown words, making changes 
where appropriate. 

,,. When the "End of document reached" message is shown on your 
screen, click OK, which can cels the spelling session. 

~ -S ,,,. Save your document when you are finished usi ng the spelling 
checker. 

Remember to proofread for incorrectly placed words and o ther grammar 
problems that a spell ing checker cannot catch. 

FORMATTING TEXT 

Now that your document is spell-checked and says what you want it to 
say, the next step is to make it look good on the page. 

Changing Character and Paragraph Formatting 

The basic formatting units used in Microsoft Word are the character and 
the paragraph. 

The character is the sm allest unit in Microsoft Word. formatting 
characters can involve changing the font, or typeface, and point size. You 
can also change the character attributes to bold, italic, underl ine, and 
more. The position of the character on the baseline, where the bottom 
edge of the characters in that font normally line up, can be changed to 
create superscript and subscrip~ characters. You can also stretch o r 
shrink the space between charaoters. 
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These are some examples of character forma tting: 

Th is is Times 10 poi nt size. 

This is Times J 2 point size. 

This is bold, italic, underlined, shadow. 

This is superscri pt this is b . t , su scnp . 

This is condensed, this is expanded. 

To change the formatting of a character or any group of characters, up 
to and including the entire document, you must first select the characters 
you wa nt to change. Then you choose the attribute you wish to change 
to. You can also set the character formatting before typing. If no text 
is selected when you choose a character format, then whatever you type 
at the insertion point will have the formatting characteristics you chose. 

Character formats are changed using the Character command, which is 
on the format menu, although some more commonly used formats can 
be accessed directly from t he Format menu. Fonts and font sizes can be 
accessed either from the Font menu or byusingthe Character command. 

Some other formatting options apply only to paragraphs. A pa ragraph 
is a collection of characters that precede a paragraph mark or hard 
return, which you get when you press the Return key. A paragraph can 
consist of one character, one word, many sentences, o r even a blank line. 
You can apply character formats to entire paragraphs (as long as the 
paragraph is selected), but you cannot apply pa ragraph formats to 
characters within a paragraph-paragraph formatting will affect the 
entire pa ragraph and not just the selected characters. 

Some formatting options that apply only to paragraphs are indents, 
tabs, line spacing, borders, and alignment. To apply formatting to a 
pa ragraph, you do not need to select the paragraph so that it is 
highlighted, as you do when applying character formats. Placing the 
insertion point in a paragraph indicates the paragraph that the formatting 
will affect. The ruler also reflects the current settings for the paragraph 
that contains the insertion point. If the pa ragraph formatting is to affect 
more than one paragraph, you must select (highlight) all paragraphs 
you wish to format. Paragraph formatting can apply to the entire 
document, just as character formatting can, but the entire document 
must be selected first . 

You' ll do most of the character formatting first, and then you' ll change 
the paragraph formatting . 

.- Scro ll to the beginning of the document and select the first line 
by clicking in the se lection bar to the left of that line, as shown in 
Figure 7-22. 
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' * File Edit Format Font Document Utilities Window 

Acru'" Manufactunm .. Inc 
12 366.coyote. LaM<i 
Dust.Ring,.OR .. 2 3366<11 
<!! 
<!! 
MEMORANDUM<!! 
<!! 
<!! 

Sales Repo 

TO:+ Larry.CasseUa,.Eastern.Dist.rict.Sales.Manager'l! 
FROM:• Karin.jole, .Vice.Presldent.of .SalE~s'll 

DATE:+ july. l7,. 1993<!! 
SUBJECT:+ january.tllrough.june.Sales.Report'l! 
q 
q 
Based .on.a.compilation.of. your .recent! y .submltted.sates.reports,. tlle. 
foUowing.shows.tlle.sates.totals.(ln.tllousands.of .dollars).of.our.smau.parts. 
product.IIM.for .tlle.first.half.of .tlle. year :<II 
Wid ets+ $7 46+--

Figure 7-22 Selecting the first line in the document 
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3€ -0 ,... Choose Character from the Format menu. 

The Character dialog box has additional character formats that aren't 
available on the Format menu. This dialog box also allows you to set 
many characteristics at the same time rather than each one separately. 
If you click and hold down the m ouse button in the arrow to the right 
of any of the drop-down fi elds, a list of available formats is shown. 
figure 7-23 shows the available underline formats. 

Character 

Font: Size: n I J) I New York !OI I•• IIQJ OK 

Underline: Color: [ ConC!JI) 

None I(.', I Black !OI [ Rpply ) 
~None Position 

Single 
@ Normol By: Word 

Double 0 Superscript r-· I 
Dotted 0 Subscript 

t W•>•ouu~ 

0 Strlkethru Spocing 
OSmall Caps ®Normal By: 
0 Rll Cops 0 Condensed L __ _.l 
O Hidden 0 EHpanded 

Figure 7-23 Available underline formats 

.,,. In the Character dialog box Style section, click Bold and Italic, as 
shown in Figure 7-24. 
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Character 

Font: Size: (c::EJ 
I New York lol llfMIIQl oK 
Underline: C 1 ( Cancel I o or: 
I None IOI I Block IOI ( Apply I 

Style Position 
18J Bold @Normnl By: 

~ Italic 
0 Outline 

0 Superscript CJ 
0 Subscript 

0Shadow 
0 Strikethru Spoclng 
0 Smoll Caps ® Normal By: 
0 All Caps 0 Condensed L l 
0 Hidden 0 EHponded ~ 

Figure 7-24 Se tting bold and italic character fo rm ats 

Return or Enter • Click OK. 

The first line of the document is now bold and italic. Next you'll make 
that line have a larger point size than the rest of the document. 

Although you could have changed the point size in the Characte r dialog 
box, you probably won't use that method as often as simply selecting 
th e desired size from the Font menu, as you'll do now. 

• With the same line still selected, choose 18 point from the Font 
menu. 

If you don'L have Lhal particular point size installed in your system, use 
any size la rger than 12 point. 

The fi rst line of your document should look similar to the o ne shown in 
Figure 7-25. 

'Acme Manufacturing, lnc:t 
12366.Coyow . I.ane'l 
Dust. Ring, OR .. 23366'1 
q 
q 

MEMORANDUM'I 
q 
q 

TO:+ Larry.Cassella,.Easwrn.District.Sales.Manager'l 
FROM:+ Karln.Jole, Vlce.Presldent.or.Sates'l 
DATE:+ )uty . l 7,. 1993<11 
SUBJECT:+ j anuary. through. june. Sates.Report<ll 
<II 
<II 
8ased.on.a.compllaUon.ot .your.recenUy.submltted.sates.repor ts,.the. 
tollowtng shows the sates. totals (m.thousands.or.dollars) of our small.parts. 
product.line tor the nrst.hatt ot .the.year.<ll 

Figure 7-25 The first line- bold, italic, and 18 point 
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The next two lines of the address will be formatted bold. You'll use the 
Bold command in the Format menu to do this. 

• Select the two address lines at the top of the document. Be sure that 
you don't include the first line, which you already formatted. 

~ -Shift-B ·• Choose Bold from the Format menu. 

Using the Ruler 

Next you'l l use the ruler to change alignment of these lines. 

~-R • Choose Show Ruler from the Format menu. 

One of the most important parts of the Microsoft Word window is the 
ruler, which is located at the top of the window, just below the title bar. 
The default setting in Microsoft Word opens the window without the 
ruler showing. To show the ruler on the screen, choose Show Ruler from 
the Format menu. This is another menu item that toggles-if you do not 
need to view the ruler, choose Hide Ruler from the Format menu. 

The ruler contains controls that allow you to change much of the 
paragraph formatting of your document. It allows you to easily set text 
alignment, line spacing, tab stops, and margins. With Microsoft Word you 
can format each paragraph using different ruler settings. 

Figure 7-26 shows the ruler, and the following sections describe some of 
the controls and what they do. 

I 
Left margin (0 point on ruler) I 

Right indent 

First-line indent 

~Left indent 

/ for each paragraph 1 
Defa"lt tab stops \Right\in 

101 I 11 
; .. .. .. .. 
!Normal I liD n 

t ' 
Style name 
drop-down box 

12 j 13 14 15 \, \ lf .. .. .. .. .. .. .. i 
t .T t . I 1§!11 1-=-1 1::=1 1=1 ~1-11-1 lliiill 1~1 LJ...l 

/ ' 1/ 
I ' / '---..../ I 

1 1 1 1 Scale icon 

Tab icons Alignment icons Paragraph-spacing icons 

Line-spacing icons 

Figure 7-26 The Microsoft Word ruler 

Let's discuss each of these controls and, where appropriate, you' ll see 
samples of how the settings affe'ct the text. 
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Alignment Controls 

These four controls provide si m pie ways to set the alignment of an entire 
text block, whether it is a paragraph or an enti re document. Alignm ent 
re fers to the way the lines of text are placed between the left and right 
margins. justification means that the text is a ligned with both the left 
and right margins. In just ified text, Microsoft Word places spaces 
between the words in a line to help the text li ne up evenly at the left and 
right margins. Notice that th e text in each of the following definitions 
mimics the result you will get with tha t setting. 

1=- I This setting makes the text left-aligned and 
ragged o n the right. Th is is a lso called flush 
left. All of the block will be al igned on its left 
side but will not be justi fied o n the righ t. 

I= I This setting aligns the text b lock by cen tering 
each line between the margins. The left 

and right sides will be uneven, un less the 
lines a re exactly the same length. 

I -1 This setting aligns the text block at the 
right margin. This alignment is a lso call ed 

flush right. As each line fills up, the text 
moves to the left while you type. When a 

word can 't fit, it is dropped to the next line 
on the far righ t side of the line. 

I I This sett ing is for justified text. Both the left and 
the right sides of the text a re even. j ustified text 
often has wide spaces between words, but 
h yphenating can minimize th is problem. 

The three lines that you just formatted, along with the Memorandum 
li ne, need to be centered on the page. You' ll use the cen ter-alignment 
setting on the ruler to accomplish this. 

• Select the lines down through the line containing the word 
"Memo randum," as shown in Figure 7-27. 
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r • File Edit Format Font Document lllltles Window 

• 

" " 

Soles Report 

I EiiJI!tl lc!ll 1. 1 1&11 F l o= r lllOIJI::J t...l 

TO:+ Larry .eassel!a,.Eastern. District . Sales. Manager<ll 
FROM:+ Karin.jole,.Vice.President.of.Sales'l 
DATE:+ july. l7,. 1993'1 
SUBjECT:+ january. tllrough. june. Sales.Repor t'l 
q 

" 11 e Norma 

Figure 7-27 Selecting the lines to be centered 

~ -Sh i ft-C 1 = 1 • Click the center-alignment icon on the ruler. 

All the lines that were selected automatically become centered between 
the margins on the page. 

Line Spacing 

These controls affect the vertical spacing between lines of text . Notice 
that the text for each definition mimics the result you will get. 

1=1 This control sets single-spacing. 12-point text is 
spaced at 6 lines per inch. 

1=1 This control sets 1-1/2-line spacing. 12-point 

text is spaced as if it were 18-point text, resulting 

in 4 lines per inch . An extra half line-space is 

placed between each line of text. 

1=1 This sets double-spacing. 12-point text is spaced 

as if it were 24 points high, resulting in 3 lines 

per inch. An extra full line-space is placed 

between each line of text. 
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Indent Controls 

There are three indentation controls: first line, left, and right. 
control the widths and positions of lines o f text. 

llo.. The first-line indent controls the beginning position o f 
the first line of text. In the picture to the left, the first 
line of each pa ragraph is indented 1/4 inch from the left 
margin, which is represen ted by the lower left tr iangle . 
In Microsoft Word, you use the indent controls instead 
of spaces or tabs for first-line paragraph indents. 

,.. The left indent controls where the text (other than the 
first line of a paragraph) is positioned with respect to the 
left margin . 

~ The right inde11tcontrols the locat ion of text with respect 
to the righ t margin. This control affects all lines of the 
paragraph, even the first. 

They 

The paragraph that consists of four lines with the sales total for each 
product needs to be indented by 1/2 inch from the left margin. You'll 
use the indent controls o n the ruler to do that now. 

• Click anywhere within the line tha t reads "Widgets $746." 

When typing these four lines you did not press Return at the end of each 
li ne, but instead you used the Shift-Return key com bination to go to a 
new li ne. This kept you typing with in the same paragraph, bu t on a 
d ifferent line within that paragraph. When you click within any of the 
fou r lines of th is paragraph, the formatting changes you make with the 
ruler will affect the entire paragraph-all fou r lines. You'll see how this 
works now. 

,,. Place the point of the arrow on the left indent marker on the ru ler 
and drag to the 1/2-inch mark on the rule r. The first-line indent 
marker moves with the left indent marker, as shown in Figure 7-28. 

,.. • File Edit Format F 

0 
10 11 J2 

H .. .. .. 
INorrnal.., •liD 't 1' .1' 

Figure 7-28 Moving the left indent marker 

• When the marker is positioned o n the ruler, release the mouse 
button. 

All fou r lines in the selected paragraph are now indented 1/2 inch from 
the left margin, as shown in Figure 7-29. 
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r • File Edit Format Font Document Utili ties Window 
.., 

::D Sa l~s Report 
10 11 12 13 14 15 

~ 

!Normal I@ t. t r& I 01=11~11=1 ~ 1-11-1 E!i l- 1 L.u..l 

<j[ 

TO:+ Larry .cassella,.Eastern.District. Sales.Manager<!l 
FROM:+ Karin.Jole,.Vice.President.of.Sales<!l 
DATE:+ July. 17,. 1993<11 
SUBJECT:+ january. through. june. Sales.Report<!l 
<j[ 

<j[ 

Based .on.a.compilation .of. your .recently .submitted. sales reports,. the. mm 
following.shows. the.sales totals. (in. thousands. of .dollars ).of .our .small. parts. Iii::! 

produc;~d~~~:-tlle $$.r75i~0s~~a!f.of.the .year :<!l !i!'i' 
Ga gets+ .., :;:::: 
DooDads+ $395.., !i!:ii 
Total+ $1, 705<11 '''": 

As. you.can.see.from. the.figures,. Wiqgets.continue. to. be.our. top.seller ,.and. n 
Page 1 !Normal+... 101 r :::::::mmm:::m::::::::::::::::::::::::::::m::::::mmm:m:::m oQJ 

Figure 7-29 The lines indented 1/2 inch from the left margin 

Tab Settings 

Tab settings control how a column of informatio n will align in p resent 
and succeeding rows. Each paragraph in Microsoft Word can have a 
different ruler. When you set the tab stops they control the current line 
and all succeeding lines, until you change o r remove tab settings. 

·t A left-aligned tab mea?s that the information in the 
column below this tab a ligns with the left end of the 
fi rst word in the column. 

l. 

A center tab centers items in the column below it. 

A right-aligned tab means that the information in the 
column below the tab will al ign with the right end of 
the last word in the colu mn 

A decimal-aligned tab formats the column below it so 
that all items line up at the decimal point. You can 
then enter a column o f numbers and have all the 
decimal points properly aligned , even when no 
deci mal is actually typed. 

This is not really a tab control, but a drawing tool that 
enables you to place a vertica l li ne in your documen t 
corresponding to the tool's position on the ruler. The 
vertica l line con tinuek down the page through each 
paragraph th at is foqruatted with the vertica l-l ine 
tool on its ruler. You 90 not have to press the Tab key 
o r any other character to create the line. This is one 
way to create column separators in tabbed columns. 
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These tab setti ngs have the fol lowing effects on text (see Figu re 7-30): 

=o Untitled I 
0 12 3 4 5 !6 
~ t 1' I .t 1'. -~ 
I Normal IIQ} t 1' .t 1'. D !§;III-I I - 1 1-1 ~ 1-11-1 e1 I 

This is the left edge of the text. The margin extends all the way to 
the 6-inch mark, where the text will then wrap back to the left 
edge. The tabs cause the following alignment patterns for the 
information entered in the columns. (Notice the line in the center of 
the columns. This is the result of placing the vertical line marker on 
the ruler for those paragraphs.) 

This column In this 
is aligned by column each 
the first letter line is 
in the first centered. 
word on each 
line. 

Page I I Normal+ ... 

This column 
is aligned by 

the last letter 
in the last 

word on each 
line. 

$232,222 .78 
- 12.223 
735.10 

.2232 
23423 
(2,239.72~ 

I 

Figure 7-30 Samples of different types of tab stops 

1w..l 

0= 

When you typed your document you pressed the Tab key to separate the 
"To," "From," "Subject," and "Date" fro m the text that fo llowed those 
words. Now you' ll use the tab settings to set a tab stop for those lines. 

... Select the fou r lines in the memo head, as shown in Figure 7-31. 

' '* File Edit Format Font Document Utilities Window 

Sa les Report 
0 

!Normal I liD D 1 :t 1. 1 0 10 1 121 1111 !1;11 Fl r=1 IEia c::1 ""' 

Acme Manufacturing,. lnc.'i 
12 366.Coyote. La ne'll 

Dust. Ring,. OR .. 2 336M! 
<J[ 

<II 
MEMORANDUM'i 

Figure 7-31 Selecting the memo heads 

t. ·• Click on the left-aligned tab ma rker on the rule r, and then click just 
below the 1-1 /4-inch mark on the rule r. See Figure 7-32. 
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• File Edit Format Font • File Edit Format Font 

10 10 -
0 12 _IU. 1 I~ 
~ ~ 't 

ltlor mol I !ill Ill ' j- t. I !Normal I !ill U t j- 1: I 

Figure 7-32 Selecting and posit io ning the tab on the ruler 

This causes a tab stop to be p laced in that posi tion on the rul er for the 
selected paragraphs. A tab stop controls the position of the text that was 
typed after the Tab key was pressed. 

Notice that the text to the right of the tab mark in the line is now aligned 
at 1-1/4-inch on the ruler in all four lines th at were selected. You can 
a lso d rag the tab to where you want it on th e ruler if you want to make 
adjustments later. 

Using the tab settings is the only way to a li gn columns of text or 
numbers. Merely spacing the same num ber of ti mes between columns, 
as is sometimes done o n a typewriter, will no t work, even though o n the 
screen the text looks aligned. When printed , the columns will be jagged 
and will n ot align with one another. 

There's a good reason fo r this- most Macin tosh fonts are proportional 
fonts. This means that the wider characters, such as th e uppercase M, 
take up more space o n a line than the narrower characters, such as the 
lowercase i. Monospace fonts, however, consist of characters that are 
evenly spaced on the screen and when printed . Most typewriters use 
mo nospace fonts, which is why you can sometimes get away with 
spacing the same number of t imes between columns to line up text. But 
it just doesn't work that way on a Macintosh, unless you a re using a 
mo nospace font such as Monaco o r Courier. 

In the second paragraph o f the body of the memo you also used tabs to 
separate columns. You already changed the left indentation of this 
paragraph, and now you'll set up a deci mal tab stop to align the column 
of numbers. 

• Click anywhere within the line that reads "Widgets $746." 

-t-. • Click on the decimal tab marker o n the ruler, and then click just 
below the 2-1/2-inch mark on the ruler. See Figure 7-33 . 

• File Edit Format Font 0 • rue1 Edit Format Font 0 

10 Se 10 Sa 
0 11 12 II 12 , ~ I t . 

Nor mal !ill 't t :1' Ill!.. I 1Nor fll81 I I !ill t t :t O I 

Figure 7-33 Setting a decimal tab stop 

The numbers should align on .Je tab stop, as shown in figure 7-34. 
I 
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• File Edit Format Font Document Utilities Window 

0 Sales Report 
0 2 3 4 5 

~ t . 

!Normal I@ t t :r n I 0 1-1 1- 1 1-1 1iiiJ I=! 1- 1 1E!J I I l...J 

qr 
TO:+ Lar ry . Cassella,.Eastern .District. Sales. Manager<!l 
FROM:+ Karin. Jole,. Vice .Presiden t.of . Sales<!l 
DATE:+ july. 1 7,. 1993<!1 
SUBJECT:+ January. through. June. Sales .Report<!l 
qr 
qr ill 
Based.on .a .compilation .of .your .recently.submit ted .sales.reports,.the. mm 
following.sllows. the.sales . totals. (in . thousands.of .dollars).of .our .small. par ts. :i:j!i 
product .line.for .the. first.half .of.the.year:<R :l:H! 

Widgets+ $7~6... '!":: 
Gadgets+ $564... li!Jil 

As. you~~~:::: rom. the. f~~:~~};idgets.continue. to. be.our. top.seller,.and. ~ 
Page I jNormal+... 1¢1 1¢ '21 

Figure 7-34 The documen t formatted with tab stops 

3C -S • Save these chan ges by choosing Save from the File menu. 

e 1::::::::1 

The nex t fo rmatting you' ll change in the document is the spacing 
between paragraphs. 

Paragraph Spacing 

Paragraph-spacing setti11gs control the amount o f space between 
paragraphs. 

1~1 This setting causes paragraphs to be separated 
by the same amount o f space as that between 
lines in the paragraph. 

1::::::::1 Th is setting places 12 points of extra space 
between paragraphs. 

The body of the m emo needs to have spaces between paragraphs. You'll 
select those paragraphs and then use the pa ragra ph-spacing icon to 
place the space between paragraphs. 

• Click to the left of the li ne beginning "Based on a compil at io n", the 
first paragraph below the memo heads, to set the insertio n point to 
the left of the "B". 

• Use the vertical scroll bar to position the last paragra ph of the 
documen t on the screen . 

• Hold down the Shift key while clicking after the last cha racter in the 
documen t. 

The body o f the document, be low the memo heads, should now be 
selected . This Shih-elick method of selecting is useful when you are 
se lec ti ng large blocks o f text. 

3C -Sh ift-0 1::::::::1 • With the text st ill selected, cl ick on the space-between-paragraphs 
ico n o n the ruler. 
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Now the body of the memo has extra space after each paragraph, as 
shown in Figure 7-35. 

the.recent.shareholders' .meetlng,.and. I .am. pleased. to. pass.it .on . to. you:<!! 

·our.sales.force.is.the.back.bone.of.o1fr.industry,.and.we.now.have.the.best. . 
in. the.history .of .Acme.Manufacturing ... These.men.and. women.are.dedicated. : 
work.ers,.without.Whom.we.could.not.be.showing.the.profits.that.we.ar e. ' 
today."<!! 

I 'm.sure. you'll.mak.e. the .President's .remarks. k.nown. to. your .sales .staff,. 
La rry ... I .k.now. your. people.are.deserving.of. this. praise .<!I 

To.achieve.projectlons.on .Gadgets.wJ .need.to.begin.our.promotions.for.the. '' 
fall.. . we.can. plan.our. television .and.lnagaztne.advertising.strategies.during. 1 ! 
the.sales. projection.meetin&.early .next. week ... If . you.have.any .questions. 
prior. to. that,. please.call.me fll 

Figure 7-35 Placing extra space between paragraphs 

Style Name Box 

The style name box on the ruler shows the style name of the currently 
selected paragraph. A style is a set o f fo rm atting characteristics that 
defines the appearance o f text. Applying a style to selected text causes 
the entire paragraph to take o n those characteristics. Hold ing down the 
mouse button on the arrow to the righ t o f the style name prod uces a 
drop-down list of the styles used in the document. You' ll be learning 
mo re about styles in Project 2 of this ch apter. 

Scale Tool 

The scale tool is used to toggle between the th ree d ifferent ru ler scales 
availab le in Microsoft Wo rd. The o ne you've seen up to this poin t is the 
normal scale, and it is the one you ' ll use primari ly th roughout this 
chapter. 

The page scale is ano ther ru ler scale ava ilable, and it can be used to 
modify page margins, column widths, and spacing between columns. 
You' ll learn more about ad justing page margins with it in just a 
moment. In Project 4 you' ll learn more about colum ns. 

The th ird type of ruler scale is the table scale, and it appears on ly when 
the currently selected text is a table. It can be used to change the width 
of cells in a table. You'll learn mo re about tables in Project 3 when you 
create a table. 
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Margins 

Clicking on the scale icon on the ruler toggles it to the page scale. 
Clicking on the icon again toggles it back to the normal scale. When 
your ruler is in the page scale you can modify the margins of your entire 
document. The 0 point of the ruler represents where the left edge of the 
paper is, and you can drag the margin brackets relative to the edge of the 
paper. When using this method to change t he margins (you' ll learn 
some other methods in this chapter also), remember that the change 
affects the entire document, not just the paragraph that contains the 
insertion point. 

You will be using many of these ruler formatting features when you 
work through the next four assignments in this chapter. You may need 
to refresh your memory by referring back to these explanations of the 
various tools until you become familiar with their uses. 

For the purposes of this project you did the typing first and formatted 
the text later. Another way is to format as you go along, paragraph by 
paragraph. Either way is perfectly acceptable-it is a matter of personal 
preference. 

Formatting settings made in the ruler affect the areas of text that you 
selected before you set the ruler fo rmatting. If you set the ruler without 
selecting any text, the ruler settings will apply to subsequent paragraphs 
that you type. This is the way you format your paragraphs before typing 
them-set the ruler with the formatting characteristics that you want 
the paragraph to have, and then type the paragraph. The ruler settings 
stay in effect for each subsequent paragraph until you change them. 

From this point on, the projects you' ll be working through in this 
chapter require that the ruler be showing at the top of the document 
window. The ruler does not print, nor does it red uce theamountofprint 
area available on the paper. Once you get used to having your 
formatting controls visible, you'll probably choose to view all of your 
documents with the ruler showing. 

Before you move on to document formatting, you need to change the 
character and paragraph formatting of the president's quotation. To 
make the quotation look different from the rest of the let ter, you will 
italicize it, reduce the point size, indent it on both sides, and remove the 
quotation marks. This is called a block quote. 

First you need to remove the quotation marks, since they are not used 
with a block quote. 

~ • Locate the paragraph beginning "Our sales force is the backbone", 
the third paragraph from the end of the document. 

• Select the quotation mark at the beginning of the paragraph and 
press the Backspace key (the Delete key on some keyboards). 
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This deletes the first quotation mark. 

•• Delete the quotation mark at the end of the quote in the same 
manner. 

Normally, when you quote something like this, you indent the left and 
right margins about 1/2-inch as a visual cue indicating a content 
change. You'll do that now. 

• If the insertion point is not in the paragraph where you just removed 
the quotation marks, click anywhere in that paragraph to set the 
insertion point. 

... To change the left indent of the selected paragraph, move the left 
indent and first-line indent markers together by clicking in the 
bottom marker and dragging both to the 1/2-inch mark on the ruler. 
See Figure 7-36. 

10 

~~ 
1 12 1 

!Norm,. lUI ~ .:t t. 

Figure 7-36 Dragging both indent markers 

Next you ' ll change the right margin of this paragraph so that it is 
indented more than the rest of the document. 

• Drag the right indent marker to the 5-1/2-inch mark on the ruler, as 
shown in Figure 7-37. 

!6 

Figure 7-37 Changing the right inden tation 

Now that you've adjusted the margins of this paragraph to set it off as 
a block quote, the next step is to change the text of the quote to a smaller 
size and to italici ze it. To change the character formatting for the 
quotation, you must select the entire quotation. 

• Move the mouse pointer into the selection bar to the left of the 
paragraph and double-click. 

This selects the entire paragraph, as shown in Figure 7-38. 
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' • File Edit Formal Font Document Utili ties Window 

Sales Report 

I liD u t s t . ' m , ... , , .... , lEI g F1 1=1 1>0 18! """ 

the.results.of.this.sales.campalgn ... He.made.the.following.comment.during. 
the.re¢ t. h h ld s' ti d I I e<1 to it. to :<l! . . .. 
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1•-? sll'•WI!Ig t!Jc- r•·!1ts that w-ar" ~:.da 

l'm.sure. you'll.make. the.Presldent·s .remarks. known. to. your .sales.staff,. 
Larry ... !.know. your. pecple.are.deserving.of .this. pralse.<ll 

To.achleve.proje¢tions.on.Gadgets.we.need.to.beg!n.our .promotions.for .the. 
fa ll ... We.can.pian.our.televlslon.and.magazine.advertislng.strategies.during. 
the.sales. projection.meeting.early .next. week ... If. you.have.any .questions . 
prior .to. that,.please.call.m e.<ll 

Normnl• ... 

0 11 

Figure 7-38 Selecting the paragrap h using the selection bar 

• If yo u are using New York font, choose 10 point from the Font menu. 
If you are using Times font, choose 12 point. 

3€ -Shift-1 • Choose Italic from the Format menu. 

3€ -S hift-] 

The block quote does not have to be italicized, since it is already 
differentiated from the ot her paragra phs by size and indent, but the 
italics makes it look even better. 

Now you' ll chan ge the alignment of th is paragraph to justified, wh ich 
will make it even on both sides. 

1 1 .. Click on the justified -alignmen t icon on the ruler, as shown in 
Figure 7-39. 

' • File Edit For mat Font Document Utilities Window 

Sales Report 

II!!) D t s t . I 11!:1 , .... , I~~ ~ l=t 1=1 Do<! 18! """ 

the.results.of.this.sales.campalgn ... He.made.the following.comment .during. 
the.rec t h h ld ' ti d I I sed to it. to :<l! . . .. 
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I'm. sure. you1l.make. the.Pres!dent's. remarks.known. to. your. sales.staff ,. 
Larry ... !.know. your. pecpie.are.deserving.of. this. praise ,q 

To.ach!eve. projections .on .Gadgets. we. need. to. begin .our. promouons.f or . the. 
!all ... we.can.plan.our.televislon.and.magazine.advertising.strategles.during. 
the.sales. projection.me~ting.early .next. week ... If. you.llave.any .questions. 
prior . to. that,. please .cau.me .<II 

Pnge 2 Nor mo + ... 

Figure 7-39 Using the justified-a lignmen t icon 

The previous steps have demo nstrated h ow easy it is to app ly d ifferent 
pa ragraph an d character fo rmats to blocks of text. 



Chapter 7: Microsoft Word 245 

By now you should be getting u ed to saving your work whenever you 
make a significant change to your document. 

00 -S • Save your work now. 

FORMATTING THE DOCUMENT 

Up to this point in this project you h ave worked with character and 
paragraph formatting, both of which affect the selected text. Now you'll 
learn about document fo rmatti ng, wh ich controls the look of the entire 
document. 

Using the Document Command 

Many of the document's formatjting characteristics can be set using the 
Document dialog box. This dialog box appears when you choose 
Document from the Format menu. 

• Choose Document from the Format menu. 

The Document dialog box is shown in Figure 7-40. 

Document 

Margins: Top: I""MI Lert: 
Bottom: I in Right: 

0 Mirror Euen/ Odd Margins 181 Widow Control 
0 Euen/ Odd Headers 

DOl 
~ 

[Set Def ault) 

~ Footnotes 

1 ..,P=--o s':-:i t-"io_n :-c-:::----r= 
Number Pages From:~ I Bottom ot Page IOI 
Gutter: 

Number Lines From: ~ Number From:~ 
Default Tab stops: §] 0 Res tort Each Page 

[ NeHt File... I 

Figure 7-40 The Document dialog box 

One way the margins of your document can be changed is through the 
Document dialog box. The defa ult margin settings are 1 inch top and 
bottom and 1-1 /4 inches left and right. To change these settings, you 
type in the box to t he right of the margin you want to change. 

• Double-click in the box to the righ t of Left and type 1. 

This changes the left margin to 1 inch. 

• Double-click in the box to the right of Right and type 1. 

This changes the right margin lo 1 inch. 

Remember in the discussion of he ruler you read about changing page 
margins using the scale icon to oggle to the page scale. That is another 
way you can change page margins. You' ll also learn about a third way 
to change page margins when you get to Project 4 in this chapter. 
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The Mirror Even/Odd Margins option is used when you're printing on 
both sides of the paper and putting the pages together in book form. 

The Even/Odd Headers option is used to crea te separate headers and 
footers for the even and odd pages. 

The Gutter box a llows you to en ter the amount of space you want to 
leave on the inside edge of the paper for binding the document. 

The Widow Contro l option is the default setting for a document. It 
prevents a widow, the first line of a paragraph, from appearing by itself 
at the bottom o f a page. When this option is set it also prevents orphans. 
An orphan is the last line of a pa ragraph appearing by itself at the top 
of a page. 

The Number Pages From box allows you to begin numbering the 
pages o f the documen t at a number other than 1. Normally you would 
leave this field blank, since usually you want the page numbers to begin 
with 1. 

The Number Lines from box works like the Number Pages From box, 
except it refers to the starting line number for numbered paragraphs. 

The Default Tab Stops box a llows you to change the default tab stops, 
which are set at 1/2-inch intervals. 

The footnotes option allows you to determine the position of the 
foo tnotes on th e printed page. The options in the drop-down Jist are 
Bottom of Page, Beneath Text, End of Section, and End of Document. 

The Next File button allows you to specify a fil e that you always want 
to prin t when the current file is finished printing. 

The on ly changes you needed to make to the document in this dialog 
box were to the left and right margins. 

• Click OK. 

In this chapter you'll learn three ways to number pages. You'll number 
the pages in this document using the Print Preview command, discussed 
in just a moment. 

Another way to number pages is to use the automatic page numbering 
icon found in the header and footer windows. You'll learn about 
headers and footers and the page numbering icon in Project 4 of this 
chapter. Also in Project 4 you' lllearn abo ut page numbering using the 
Sectio ns command. 
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Now that you've worked hard on this letter, you are probably eager to 
see what it looks like printed . You don't have to print your document 
to get an overall view of its layout. Microsoft Word allows you to 
preview it first by using the Prin t Preview feature, which is one of four 
available views in Microsoft Word. 

The view you have been working in so far is ca ll ed Galley View, Word 's 
normal view. Unless you tell it otherwise, Microsoft Word opens any 
documen t in Galley View. Galley View al lows you to write, edit, and 
format your document in the fastest working environment. However, 
as you' ll lea rn in Project 4, all t,orm ats in Galley View do n't a lways 
d isplay the way they will look when printed . 

Page View is another view available in Microsoft Word. This view allows 
you to see your document on the screen in approximately the same way 
it will look when it is printed. You can write, edit, and forma t your 
document in Page View also, altho ugh it is a much slower process than 
in Galley View. You' ll use Page View in Pro ject 4 of th is chapter. 

Outline View lets you look at your document as an ou tline and a lter the 
structure of it using the features available in this view. Outlining is a 
topic not within the scope of this book. 

Print Preview is the fourth view available in Microsoft Word. In Prin t 
Preview you can view the layout of whole pages of your document. 
Although this view allows only limited formatting, and you cannot 
access text directly from this view, it contains some time-saving shortcuts 
that allow you to see the document formatting changes immediately. 
You'll use thi s view several times when working through the projects in 
th is chapter. 

~ -I • Choose Print Preview from the file menu. 

You view a sca led-down version of your document in Print Preview-it 
is just like it will look on the printed page. You can't edit a document 
in this view, nor can you access any of the menu commands. But you 
can make some changes to you r document using the four icons on the 
left side of the window. 

The first is the page numbering icon, and it is one of the ways Microsoft 
Word enables you to number the pages of your document and pos ition 
the page numbers. This is the npethod you' ll use to number the pages 
of this memorandum. 

Numbering Pages in Print Preview 

,. Click on the page number icon, the first one of the four. 

Notice that the pointer changJ to a "1" with arrows on both sides. 
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,. Position the insertion point in the center of the bottom of the first 
page, and then click to tell Microsoft Word that this is where you 
want the page number to appear on all pages of the document. See 
Figure 7-41. 

Print Preuiew: Sales Report Pages 1-2 
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Figure 7-41 Numbering the pages 
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Microsoft Word will consecutively number each page of your document 
automatically. You do not have to manually type in each page number. 
The page nu mbers that are placed in your document in Print Preview are 
only visible when you are in either Print Preview or Page View or when 
you actually print the document. You cannot change the formatting of 
the page numbers with this method of page numbering. You get a 
default font and size for the numbers. 

The second icon on the Print Preview screen is the margins icon. If you 
click on it, it displays dotted lines around the edges of the page to 
indicate the boundaries of your margins, headers, and footers. There 
will be more detail about that icon in Project 4 of this chapter. 

The third icon down allows you to switch from two-page viewing to one
page viewing in Print Preview. 

The last icon allows you to print from this view. It works the same as if 
you had selected Print from the File menu and it presents the Print 
dialog box. 

• Click the Cancel button in the top right corner of this window to 
return to the regular view of the document, Galley View. 

• Scroll back through your document until you're before the block 
quote. 

Controlling Page Breaks 

Notice there is now a do tted line running across the document above the 
block quote, as shown in Figure 7-42. This line is what Microsoft Word 
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uses to represent an automatic Pfge break. Viewing your document in 
Print Preview caused the document to be paginated, which is the process 
of dividing the document into pages based on the document's margins, 
length, and paper size. 

r • File Edi t Format Font Document Utilities Wind ow 
.., 

results.of.this.sales.campaign ... He.made.the.following.comment.during.the . 
. . ?.1?-.a~:~.h.<?~~~r.~: ·. ~~-~~.t:lg, : ?J,~<;I-. ! :~!lU~~~a.s~<;I-.~-.P~.~?.Jto.t:~,..'P,..Y.<?:t!-:~ ... .. .. ...... .. .. ...... . 

OUr. s8les fl:m.-e is the be..:ktxme of our. indu.S'tr,r-:. end 11'1!! norr< hsn:? the. best. i n. , , 
h i stone of' A .:me. Men uRi>: turi ng ... These. men. end n:vmen. sre. dedkBted n:vrkers:. ; ' 
n:ithout n:'hom II'!!! ~-ould not be slion:ing. the profits that n:e Bre tods.r--:<!1 : ' 

I'm.sure.you'll.make.the.President's.remarks.known.to.your.sales.staff,. 
know.your.people.are.deserving.of.l:.his.praise.'ll 

To.achieve.projections.on.Gadgets.we.need.to.begin.our.promotions.for.the 
can.plan.our.television.and.magazine.advertising.strategies.during.the.sales. 
projection.meeting.early .next. week ... If. you.have.any .questions. prior. to. that,. 
can.me.'ll 

Figure 7-42 The automatic page break symbol 

The other type of page break available in Microsoft Word is the manual 
page break. Th is is used when you want the page to break at a particular 
place, other than where an automatic page break would occur. A 
manual page break is entered by ch oosing Insert Page Break from the 
Document menu or by pressing Shift-Enter. 

An automatic page break and a m anual page break look different on the 
screen . Figure 7-43 shows both. 

'-- automatic page break 

..................... ~· · ·;~-~~-~;~;··~~-~~ .. ~~~~··· ..................................... .. 

I 

Figure 7-43 Automa tic and manual page b reaks 

To delete a manual page break select it and press t he Backspace (or 
Delete) key. 

Finally, n ow you're ready to print your document. Always save your 
work before printing. 

,,. Choose Save from the File r enu. 
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PRINTING THE DOCUMENT 
3€- P • Choose Print from the File menu. 

If you a re printing to an Image Writer, yourPrint d ialogbox will look like 
the one shown in Figure 7-44. 

~lm~n~g~eW~r~ll-er~~------~------~----~X2~7 (~) 
Qunllty: 0 Best ® Faster 0 Draft 

Page Ronge: ® All 0 From: 0 To: 0 
Copies: 0 
Poper Feed: ® Automatic 0 Hond Feed 

Section Ronge: From: I To: I 0 Print Sele< lion Only 

0 Print Hidden TeKI 0 Prlnf NPut File 

Figure 7-44 The ImageWriter Print dialog box 

If you are printing to a LaserWriter, your Print dialog box will look like 
the one shown in Figure 7-45. 

loserWrller "LoserWrller" s.2 GJ 
Coples:l•l Pages:® Rll 0 From: D To: D [ Concel J 
Couer Poge: ®No 0 First Page 0 Los t Page ~ 

Po per Source:® Paper Cosse tt e 0 Monuol Feed 
Section Range: From: I To: I 0 Print Selection Only 

0 Print Hidde n TeKI 0 P11n1 NPut File 18] Print Back To Front 

Figure 7-45 The LaserWriter Print dialog box 

.,. Accept the default settings by clicking OK. 

After your document prints, compare it to the finished document at the 
beginning of this project and make any necessary changes. 

QUITTING MICROSOFT WORD 
As in most Macintosh applications, the command to quit Microsoft 
Word is in the File menu. 

3€ -Q • Choose Quit from the File menu to exit Microsoft Word and return 
to the desktop. If you want to continue with the next pro ject in this 
chapter, close this document by clicking in its close box. 

If you try to quit Microsoft Word or close a document without saving 
your work since making any changes, Microsoft Word will ask if you 
want to save changes before closing. You can choose Yes (you do want 
to save changes before closing), No (you do not want to save changes 
before closing), or Cancel (you do not want to close the documen t) . 
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Project 2: Creating a Document with Graphics 

In this p ro ject you' lllearn to insert a graphic into a document. Microsoft 
Word gives you the ability to easily combine graphics and text; you just 
have to open the applica tion the graphic is in, copy the graphic to the 
Clipboa rd, and then paste it into your Microsoft Word document. 

You can create illustratio ns in most Macintosh graphics applications, 
such as MacPaint and MacDraw II, and then copy them into your text 
document. You can also impo rt charts from Microsoft Excel, and yo u 
can copy graphics from o ther Microsoft Word files. In addition, you can 
pu rchase com mercial clip art-artwork that is usually copyrighted and 
d istributed o n disk from software suppliers-and incorporate it in to 
your Microsoft Word document. 

In add it io n to learning about moving graphics into your Microsoft 
Word documen t in th is project, you' ll learn to use sty les, o ne of 
Microsoft Word's most powerful featu res. A style is a particular group of 
paragraph and character form atting characteristics to which you 've 
assigned a name. 

Giving a name to a set o f paragraph and character fo rmatting 
ch arac te ri stics in Mic rosoft Wo rd enables you to apply those 
characteristics repeated ly and consistently to different paragraphs in a 
document, withou t having to format each e lement separately. 

lf you don 't assign a sty le explicitly in Microsoft Word, the default style, 
Normal, is ass igned to any text you type. You 've been usi ng styles a ll 
alo ng and probably d id n 't realize it. 

To defi ne a style, you indicate which formatting characteristics that 
style should contain, and then you a ttach a name to that sty le. A style 
definiti on can include tab settings, fonts, margin settings, line spacing, 
formatting such as underli ne o r italic, and any other command that can 
be applied fro m the ruler or that can apply to a character or paragraph. 
To apply a style to a paragraph, you specify a previously defined style 
that you wan t to use fo r that paragraph, and the characteristics are 
applied to the text immedi ately. 

If you wa nt to modify a pa rticular style, you change its format settings, 
and Microsoft Word instantly changes every paragraph that was assigned 
that style definitio n. This is certainly faste r than selecti ng and changing 
the format fo r each paragraph separately. 

A gro up of sty les attached to a document is called a style sheet. You can 
t ransfer a style sheet to another document, so that the styles you created 
are available to be used in any documen t. That way d ifferent documents 
can have a consisten t appearance. 

In th is p ro ject you' ll learn to d~fine and apply several d ifferen t styles. 
You' ll also learn to use borders, create specia l indentation effects, and create 
tab leaders. 

When com pleted, the assignmen t that you turn in should look like the 
one shown in Figure 7-46. 
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WELCOME TO 

~~Geno's 
--Deli 

Our famous sandwiches and specialty items are served from II :00 AM to 
4:00 PM, Monday through Saturday. Closed Sunday. 

Sandwiches 
DELUXE REUBEN-a full 1/4-pound of corned beef, topped with 

baby swiss cheese, sauerkraut, and russian dressing, served 
grilled on pumpernickel bread ............ ·--·························· 3.95 

HAWA II AN CHICKEN CLUB-sliced chicken, ham, lettuce, tomato, 
and pineapple slices, piled high on our toasted sunflower-seed 
bread-················ ............ -.................. _. ....................... .. ...... 3.75 

BACON AN D ASPARAGUS SUPREME-crispy bacon, tender 
asparagus, and mushrooms, topped wi th melted cheddar cheese 
and served hot on an onion kaiser rolL ___ ............... ....... 3.95 

Side Orders 
Curly Fries .... - .............. .. 1.10 Bermuda Onion Rings .......... 1. 10 
German Potato Salad ...... 1.25 Smoked Baked Beans .......... .95 

Desserts 
HOT FUDGE SUNDAE- two scoops of mint ice cream, smothered 

with creamy hot fud ge and topped with nuts and whipped cream 
......... - ................ .. ......... ..... ···--·········....... ... ........................ I . 7 5 

GENO'S CHEESECAKE-rich and creamy, wi th blueberry topping, 
and large enough to share ............ --............................. 2.25 

Beverages 
lced tea__ ............................. 65 Milk ...... .......... _ ........... ........ 75 
Cola, Orange, Root Beer. ... 75 

CARRY-OUT AVAILABLE ON ALL MENU ITEMS 

Figure 7-46 Pinal o utput of Project 2 

In th is p ro ject you will create a restaurant menu. It is intended that you 
create it using a pa rtially completed documen t, entitled "Gena's Menu 
Unformatted," that is included on the Macintosh journey Projects disk. The 
artwork for the m en u is also on that disk and is en ti tled "Menu 
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I 
Artwork." If you are using this book in a classroom environment, check 
with the instructor to ensure that "Geno's Menu Unformatted" and 
"Menu Artwork" are available. For information about ordering the 
Macintosh Journey Projects disk, see the last page of this book. A printed 
version of the unformatted menu is shown in Figure 7-47. 

Our famous sandwiches and specialty items are served from 11:00 AM to 
4:00PM, Monday through Saturday. Closed Sunday. 
Sandwiches 
DELUXE REUBEN-a full 1/4-pound of corned beef, topped with baby 
swiss cheese, sauerkraut, and russian dressing, served gri lled on 
pumpernickel bread 
HAW A II AN CHICKEN CLUB- sliced chicken, ham, lettuce, tomato, and 
pineapple slices, piled high on our toasted sunflower-seed bread 
BACON AND ASPARAGUS SUPREME-crispy bacon, tender asparagus, 
and mushrooms, topped with melted cheddar cheese and served hot on an 
onion kaiser roll 
Side Orders 
Curly Fries 1.10 Bermuda Onion Rings 1.10 
German Potato Salad 1.25 Smoked Baked Beans .95 
Desserts 
HOT FUDGE SUNDAE-two scoops of mint ice cream, smothered with 
creamy hot fudge and topped with nuts and whipped cream 
GENO 'S CHEESECAKE-rich and creamy, with blueberry topping, and 
large enough to share 
Beverages 
Iced tea .65 Milk .75 
Cola, Orange, Root Beer .75 

CARRY-OUT AVAILABLE ON ALL MENU~TEMS 

Figure 7-47 Unformatted Gej o's Menu 
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I --
Geno 's Menu Unformatted 

O ne way to begin this project is to locate the document entitl ed "Geno's 
Menu Unformatted" and double-cl ick o n its icon. Th is will start 
Microsoft Word and open that documen t. 

Another way to begin is to double-click on the Microsoft Word icon to 
launch the applica tion, and then choose Open from the File menu. 
Locate the Gena's Me nu Unfo rmatted document (click the Drive 
butto n if necessary), and double-click on it to open it. 

~ -0 If you did not quit Microsoft Word afte r the last project, ch oose Open 
fro m the File me nu and double-click on Gena's Menu Unformatted to 
open it. 

Regardless of which method you chose, the document Gena's Menu 
Unformatted sh o uld be o pened on your screen. It should now look li ke 
f igure 7-48. 

' • file Edit Formot font Documen t Utilities Window 

10 Geno's Menu Unformatted 01 

Our famous sandvicbes arxl specialty items are served from 11:00 AM to 4:00PM, ~ 
Monday through Saturday Closed Suroay 
Sandvtcl'es 
DELUXE REUBEN-a full 114-pouro of comld beef, topped vilh baby sviss 
cheese, sauerkraut, arxl russtan dressing, served grilled on pwnpernickel bre<w:l 
HAWAIIAN CHICKEN CLUB-sliced clucken, ham, lettu:e, tomato, and pmeapple IP 
slices, piled high on our toasted sunflover-seed bread 
BACON AND ASPARAGUS SUPREME-crispy bacon, tender asparagus, and 
mushrooms, topped v ilh melted cheddar cheese arxl served hot on an onion kaiser roll 
Side Orders 
Curly Fries 1.10 Bermllia Onion !lings 1.10 
German Potato Salad 1 25 Smoked Baked Beans 95 
Desserts 
HOT FUDGE SUNDAE-tvo scoopsofmintice cream, smothered vilhcrearnyhot 
fllige aOO topped v ilh nuts arxl vhipped cream 

~ GENO'S CHEESECAKE-rich and creamy, vilh blueberry topping, arx! large 
enowrh to share 

I Page (Normal IQI ::;:;.. ,,'·'·\ljc;; ('2) 

Figure 7-48 Gena's Me nu Unformatted 

Let's make a copy of this document, so you can leave the original intact. 

• Choose Save As from the fil e m enu . 

• Click the Drive button, if necessa ry, to be sure you a re saving the 
document on your disk. 

• Replace the name "Gena's Menu Unfo rmatted" with Gena's Menu 
by typing that name in the Save Current Document as box, as shown 
in Figure 7-49. 

Return or Ente r • C li ck the Save butto n. 
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I (g) Corolyn Phillips] 

D (i(IJIO's Monu llnfmma11 (ld :!:! 

Soue Current Document 11s: 

I Geno's Menu 

D rusl StliJP D Moke Backup 

(File Formot. .. J Normol 

(g) Cllrolyn Phillips 
738K BUHiiHble 

[I;J~ 
(conce1) ~ 

Figure 7-49 Saving the fo rmatted menu 
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PLACING THE GRAPHIC 
The a rtwork for the menu is in a document enti tled "Menu Artwork" 
on the Macintosh journey Projects disk which accompanies th is book. 
You'll open that document now. 

Opening Multiple Documents 

Microsoft Word allows you to have more than one documen t open 
at a tim e. When you have multiple documents open, only o ne is 
considered active. The active window is the fro ntmost o ne showing o n 
your screen. If your document windows are s ized and arranged so that 
you can view more than one at a time on the screen, you can easily spot 
the active o ne because it has scroll bars and horizonta l lines on either 
side of the title in the title bar. To make a different open document 
active, select it from the Window menu, and Microsoft Word activates 
it and places it in front of the others. You can also click anywhere in a 
window to make it active. 

S€ -0 • Choose Open fro m the File menu. 

You are presented with a dialog box that lists th e Microsoft Word 
documents available to be opened. See Figure 7-50. 

Select o Document: 

I (g) Cerolyn Phillips I 
0 Geno's Menu !=! lg] Corolyn Phillips 
0 Geno's Menu Unforma ... 691 K ouoiloble 
0 Menu Ar twork 

CEll~ D Soles Report 

( concel] ~ 
In D Rend Only 

Figure 7-50 The Open dialog box 
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• Click the Drive button, if necessa ry, and scroll through the list of 
documen ts in the Open dialog box until you see the Menu Artwork 
document. 

• Select that document from the list by cl icking on it, and then click 
the Open button . 

A shortcut for this procedure is to double-click Menu Artwork in the 
dialog box. An other is to click once on Menu Artwork and then press 
Return, because the Open button is the default. Whichever method you 
use, the document Menu Artwork shou ld now be active on your screen. 

• Click within the Welcome to Geno's Deli graphic to select it . 

When you select a graphic, small black squares appear in the center 
bottom and on the right side of the draw ing. The border around the 
drawing darkens, as shown in Figure 7-51. 

r a File Edit Format Font Document Ut ilities Window 

ifiJ Menu Artwork 

WELCOME TO 

Page 1 

Geno~ 
Deli 

Norma 

Figure 7-51 Selecting the graphic 

Copying and Pasting 

f!€ -C • Choose Copy from the Edit menu to copy the graphic to the 
Clipboard. 

• Click in the close box in the upper left corner of the Menu Artwork 
document to close it. 

Now you' ll place the Menu Artwork in to Gena's Menu. 

f!€ -V • Click in the fi rst line of Geno's Menu to set the insertion point 
there, and then choose Paste from the Ed it menu. 

Now you have pasted the Menu Artwork into Geno's Menu. Your screen 
should look similar to the one shown in Figure 7-52. 
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• • File Edi t Forma t Font Document uL ities Window 

Geno's M enu 

WELCOME TO 

Geno'S 
Deli 

I u b . 

Our famous sarxlvichesam specialty items are served from 11:00 AM to '1:00PM, 1;'~ 
=arc:oughSaturoay. Closed Surrlay. ~~~ 

DELUXE REUBEN-a full 1/4-pourrl of corned beef, topped vith baby sviss ,, 
cheese, sauerkraut, and russian dressing, served grilled on pumpernickel bread . 
HAWAIIAN CHICKEN CLUB-sliced chicken, ham, lettoce, tomato, am pineapple ·r 
slices, piled high on our toasted sunflover-seed bread ~,[-
BACON AND ASPARAGUS SUPREME-crispy bacon, tender asparagus, and 1m; 
mushrooms, topped vith melted cheddar cheese am served hot on an onion kaiser roll ~ 

Page I Norma to >;·:•:•:<·>:tiT>!i:::•WY·:•:::.::i·i~::;:fj~ '2l 

Figure 7-52 Placing the graphic in the document 

3€ -S • Save your work now by choosing Save from the File men u. 

You' ll use Show<[ and the ruler to help you fo rmat and see the effects 
of your fo rm atting throughout thi s project, so you sho uld activate 
them now. 

3€ -Y ,,. Choose Show <j[ fro m the Edit menu . 

3€-R • Choose Show Ruler from the Format menu. 

FORMATTING THE GRAPHIC 
Cente ring the graphic and placing a border around it will make it stand 
out on the menu, so let's do that now. 

Centering the Graphic 

3€-Shi ft-C I= I • To cen ter the graphi c, click on the graphic to select it, and then click 
on the center-alignment icon o n the ruler. 

Adding Borders 

3€ -M • With the graphic still selected, choose Pa ragraph from the Format 
menu. 

lf necessary, drag the Paragraph dialog box by its title bar to move it 
lower o n the screen so tha t you can see the graphic. 

• Click the Borders button at the bottom of the Paragraph dialog box. 

• In the resul ting Paragraph Borders dialog box, click on the second 
li ne thickness down along the left side of the di alog box to select the 
thicker single line. Then click Plain Box. See Figure 7-53. 
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~PI11in DoH 
Q ShlldOW DOH 
0 Outside D11r 

,__ ____ _, 0 Custom 
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Figure 7-53 The Paragraph Borders dia log box 

Notice that a box is drawn arou nd the schematic d iagram to represent 
the effects of your selection. 

Applying Paragraph Borders 

• Click OK in the Paragraph Borders dialog box, and then click OK in 
the Paragraph dialog box. 

Now your menu graphic should have a border around it like the one 
shown in Figure 7-54. 

,.. • File Edit Format Font Document Utili t i es Window 
., 

:o Geno's Menu 
0 2 3 4 5 
~ 

!Normal IIQ) 't t D t . I 1~1 IE3IJ 1=1 1=1 IIIIIJ I=i 1-1 illi311-1 1w..l 

WELCOME TO 

-oeno;~li [lEj ~I 
~---::-~o---:-!""!"'"-oo:---"""!""~~ ..... ---:-o:----:-:""::"::'-:-:"~":""::"::-::i:ll!l:-:----1 'i,· l f 
OW".famous.sandwiches.and.specialty.items.are.served.from II : 00-:-AM. to.4: OO.PM,. :::::: 
Monday. through.SatW"day ... Ciosed.Sunday. <II ,i,i.i.,! .i .1 

Sandwiches<ll .. 
D ELUXE.REUBEN-afull.l/4-pound..of.corned. beef,. topped. with. baby.swiss.cheese,. i:!!ii 
sauerkraut,.and.russiandressing,.served.grilled.on. pumpernickel. bread <II mm 
HAWAIIAN.CHICKEN.CLUB-sliced.chicken,.ham,. lettuce,.tomato,.and.pineapple. ~ 

Page 1 jNormal+... IQL illillill2~ 

Figure 7-54 The border around the graphic 

The left and right margins on the ruler control the relative width of the 
border you place around your text and graphics. Notice that the borde r 
extends about 1/2 inch to the left and right of the graph ic in Figure 7-54. 
That is because the left and right margins of the ruler extend that far to 
either side of the graphic. 

S€ -S • Save your work. 
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FORMATTING THE TEXT 

Now you' ll put a double line beneath the first paragraph and change the 
indentation so the paragraph is set apart from the rest of the menu. 

~ -M • Click anywhere in the first line of the pa ragraph beginning "Our 
famous", and then choose Parag raph from the Format menu. 

sg.sh i ft-0 1::::1 • Click on the paragraph spacing icon on the ru ler to create a space 
before this paragraph. 

• Hold down the Shift key, select the left indent marker, and drag it 
to the 1/2-inch mark on the ruler. See Figure 7-55. 

torm~ ~~ 
! 12 

T I t t 

Figure 7-55 Setting a 1/2-inch indent 

If you do not use the Shift key, the first- line indent marker and left 
inden t marker move together. 

This ruler change causes the second li ne only o f that paragraph to be 
inden ted 1/z-inch from the left margin of that paragraph. 

- Click the Borders button in the Paragraph dialog box. 

• In the resulti ng Paragraph Borders dia log box, click on the th ird 
box down the left side to select the double line. Then click in the 
bottom part of the schematic diagram to place a double line there. 
See Figure 7-56. 

0 Plain BoH 
0Shadow BoH 
0 Outside Bor 

'---.;,_---J ®Cust om 

Spacing: C:=J 

Figure 7-56 Placing a double ine benea th the paragraph 

• Click OK in th is dialog box and again in the Paragraph dialog box. 

Your paragraph should now be forma tted like the one shown in 
Figu re 7-57. 
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Defining Styles 
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r • File Edit Format Font Document Utilities Window 

;o Geno's Menu 
_10 2 3 l<t 5 . 

_L 

!Normal I@ 't 1'01'. I 11311-11 -1 1-1 1111111-11- 1 1:=:1 181 lwl 

J ! 
I ~m~· WELCOME TO 

I 111 

-oeno-s 
Deli 

1....-----l..-----------------=~! ____,:i!! 
Our.famous.sandwicbes.and.specialty.items.are.served.from II :Otr.AM.to.4:00.PM,. !li! 

Momay. throughSaturday ... Ciosed.Sunday. <11 :,!,' !,ii_,i ', 

Sandvicbes<ll .. . 
D ELUXE.REUBEN- afull.l/4-pound.of.corned. beef,. topped. vith baby.sviss.cheese,. :iii:, 
sauerkraut,.and.russiandressing,.served.grilled.on pumpernickel. bread <II 0 

Page I !Normal+... 101 1¢121 

Figure 7-57 The formatted first paragraph 

3€ -S • Now is a good time to save your work. 

Let's create some styles that you can apply to the rest of your menu. 

• Click in the line containing the word "Sandwiches", below the 
double line you just created. 

3€ -T • Choose Define Styles from the Format menu. 

The resulting dia log box is displayed in figure 7-58. 

'Normol + Font: 14 Pofnt 

NeKt style: I I 811sed on: I Norm al 

Figure 7-58 The Define Styles dialog box 

Notice at the top of the dialog box that New Sty le is h ighlighted; 
Microsoft Word is expecting you to create a new style. The insertion 
point is waiting for you to type in a style name. The other style in the 
list is preceded by a bullet. This indicates that it is one of Microsoft 
Word 's automatic styles. The checkmark to the left of the style Normal 
indicates that it is th e style that th e currently selected paragraph is 
formatted in. 
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The insertion point is in the fi e! to the right of Style, ready for you to 
type in the name of the n ew sty e you're about to create. 

In the bottom rigpt corner of the dialog box the Based on box contains 
the word "Normal. " Th~s means that the style that you are about to 
create will contain the characteristics of the already existing style 
Normal, plus whatever modi fications you choose. 

Now you'll create a style that you can use to fo rmat text as bold and with 
a 12-point blank line in front of it. 

• Type Food Class for the name of your new style, as shown in 
Figure 7-59. 

• Define st les:Geno's Menu 

r
.,.~'!!'!!r' · ~ f OK IJ 

[cent el I 
~ 

~__-;:=========: [set D~foult l 

NeHt Style: I I Dosed on: I Normol 

Figure 7-59 Typing the new style name 

• With this dialog box still open, choose Bold from the Format menu. 

Notice that Bold becomes part of the description of the style in the box 
beneath "Food Class." 

• With this dialog box still open, choose Paragraph from the Format 
menu. 

• In the Paragraph dialog box, type 12 in the Before box, as shown in 
Figure 7-60, and then click OK. 

Pereqraph 

Indents Spocing R OK J) 
l ett: § "" ~ Right: Before: 121 [ Cencel I 
Fir st : Rfter: [ ~pply I 
D Page Break Before D Um! NumbNIOI.I J 

0 Keep With NeHt 'I D Keep lines Toget T r 

( Tabs ... ) (Borders ... ) (Position ... ) 

Figure 7-60 Placing a 12-poin line before the paragraph 
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This las t action created a 12- point blank line in front of the paragraph, 
similar to th e way clicking o n the paragraph-spacing icon would. 

• In the Define Styles d ia log box, click the Define butto n, as shown 
in Figure 7-61. 

I Define Styles:Geno's Menu r@ ~ 
ll OK I) 
( Con eel I .t• Normol 

( Apply I 

[Set Deroult I 
Style: I Food Closs I I • 

• r lormol + Font· 14 Point, Bol~, Space Before 12 pt 

NeHt Style: I I Dosed on: I Normal I 
Figure 7-61 Defining the style 

The new style, food Class, that you created is added to the list of styles. 

,,.. Click OK in the Define Styles dialog box. 

Now you should see th e results of applying that style to the paragraph 
th at co ntains th e word "Sandwiches." See Figure 7-62. 

r • File Edit Format Font Document Utilities Window 
., 

§0 Genu's Menu 
0 2 3 4 5 

. . ~ 
IFoodCl~ IIQ} Dt j' 't. I Ul-1 1-11-1 lliilll-11-1 1~1 181 J.wJ 

! 
! 

! 
i iii!;· 

I 1:1

1
' 

WELCOME TO 

-oeno-5 
Deli I !:!::, 

:::::~~~~~.:;~g~=~ftomii007AMMOO~M, ~~ 
DELUXE.REUBE~-afu!L!14~pound.of.c.orned.beef, .top~.vithbaby.sviss.cbeese, . 0 

Page 1 !Food Class IOL 10 Q] 

Figure 7-62 The first style applied 

The name o f the style that you created is now showing in the styles drop
down I ist on the ruler. If you click on the arrow to the right of this style 
name and hold down the mouse button, the list of styles used in this 
document are shown. A checkmark is beside the style name of the 
paragraph that currently contains the insertion point. See Figure 7-63. 
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D 
0 11 12 
~ ~ . ~ ~ 

Food Class IPH n t j' 

1-/Food Class 
Normal I 

1 UTCT £'4£'\ -a. ... c ., 

Figure 7-63 The styles drop-down field 

3€ -S • Save the changes you 've made to your document. 

Now you'll see how simple it is to apply this style to other paragraphs 
in your document. 

• Click in the paragraph containing the words "Side Orders," in 
the middle of the document. 

• Click on the arrow to the right of the sty les drop-down list on the 
ruler and, ho lding down the mouse button, drag to the Food Class 
style so it is highlighted, as shown in Figure 7-64. 

Be su re you click on the arrow to the right of the styles drop-down list, 
not on the name. 

Figure 7-64 Selecting a style 

• Release the mouse button. 

The selected paragraph should now have the same formatting 
characteristics as the Sandwiches paragraph. 

• Using the same method, apply the Food Class style to the paragraph 
containing the word "Desserts" and to the one containing the word 
"Beverages". 

Now you' ll create a different style to use to format the menu items. This 
style will have differen t left and first-line indentat ions and will have 
tabs set with dot leaders. A do t leader is one of several tab leaders that 
Microsoft Word uses to fill blank spaces before a tab stop. When you 
press the Tab key to move to a tab stop that has a leader, the blank space 
up to the tab stop is fi lled with your choice of dots, dashes, or underlines. 
You've probably seen dot leaders in tables of contents or between 
columns of figures. 
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You'll learn a different method for creating this style than you used 
previously. Th is time you' ll format the paragq1ph and then assign the 
style definition by example. 

• Click in the paragraph beginning with "Deluxe Reuben ". 

• Hold down the Shift key, and click on the left indent marker on the 
ruler (the bottom triangle) and drag it to the l-inch mark on 
the ruler. 

• With the Shift key still down, drag the first-line indentto the 1 /z-inch 
mark on the ruler, so that your ruler now looks like the one shown 
in Figure 7-65. 

D 
10 _l 11 _l 12 ... . . , 
INorrn~l Ifill t. t .T 

Figure 7-65 Changing the first-line indent 

Changing the left and first-line indent markers in this manner will result 
in a hanging indent for the selected paragraph. A hanging indent is when 
the first line of the paragraph starts to th.e left of the left margin. 

t . • To set the decimal tab, click on the decimal tab marker on the ruler. 
Then click on the ruler at the 5-5/8-inch marl< to position the tab 
there. 

3€ -M • Choose Paragraph from the Format menu. 

In the resulting Paragraph dialog box, notice the settings in the Indents 
section, as shown in Figure 7-66. Instead of dragging the left and first
line indents to their desired positions on the ruler, yoq could have typed 
the amounts into the appropriate boxes in this dialog box. Both 
methods work the same way. 

• File Edit Format Font Document Utilities Window 
Genu's Menu 

12 ...ft. 
-"- ~. ~ 

IHormol I liD t ~ .t 0 I g ,.112lllil s;J Fll::l a~=:~ 1...1 

II 
i Paragraph I 

I Indents Spacing 
(( DK )J ! 

Left: 

~ ""' rm-1 i 
Right: Before: [Cancel] 

Our .famous. 
~ 

:OO.PM,. 
Molll First: n After: 

Sand vic he 0 Page Break Defore 0 l.lne Numbering 
DEL 0 Keep With NeHt 'II 0 Keep lines Together ~by.sviss. 

[ lobs ... l [Borders ... ] [Position ... ] 

HA WAIIAN.CHICK EN.CLUB shced.chicken,.ham,.lettuce,. tomato,.and pineapple. 
slices,. piled. high on our. toasted.sunflover-seed. bread'll 
BACON.AND ASPARAGUS.SUPREME-crispy. bacon,.terxler.asparagus,·and· 

Figure 7-66 The Paragraph dialog box 
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Setting Tab Leaders 

265 

The indents and tab setting on yJ ur ruler and in your Paragraph dialog 
box should match those shown in Figure 7-66. 

• Click the Tabs button in the Paragraph dialog box. 

• Click on the decimal tab marker that you placed at the 5-5/8-inch 
mark on the ruler. 

• In the Tabs dialog box, click the second button down in the Leader 
section. This is the one with the dots to the right of it, as shown in 
Figure 7-67. 

Tubs '"' -['""' l ""'I " D 
0 l eft 0 None ~ 
0 Center ~. . . . ~ (Cancel) 
0 Right (J----
@ Decimal 0 - (clear All ) 

0 Bur Position: ~ 

Figure 7-67 Selecting the dot leader 

This will attach a dot leader to that tab. You' ll see how a tab leader works 
in just a minute. 

,,,. Click OK in the Tabs dialog box, and then click OK in the Paragraph 
dialog box. 

·t . Notice that the tab marker on your ruler now has a small dot to the left 
of it. This indicates that a leader has been applied to that tab stop. 

Now that your paragraph is formatted, you'll define a style based on that 
formatting. 

• To assign a style name to the paragraph you just formatted, make 
sure the insertion point is somewhere within that paragraph and 
then click the style name box on the ruler to select it. 

• Type Menu Item into that box as shown in Figure 7-68. 

D 
10 I 11 ... ,.. 
!Menu l te~ Ifill t tl 

Figure 7-68 Typing in the sty!~ name 

• Press Return. 

When you press Return, a prompt will verify that you would like to 
define a style based on your current selection, as shown in Figure 7-69. 
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Define st yle "Menu I tem" based on selection? 

Figure 7-69 Define styles prompt 

Return or Enter • Cl ick Define. 

You jus t went th rough the steps for defining a style based on an 
example. You now have a new style called Menu Item. 

To complete the Deluxe Reuben me nu item, you n eed to type in the 
p rice. 

• C lick after "pumpernickel bread" at the e nd of that paragraph 
and press the Tab key. The n type the price, 3.95, as shown in 
Figure 7-70. 

Sandvtche~ 
DELUXE REUBEN-afulll/4-pound.ofcorned.beef,.topped vithbaby.sviss. 

cheese, sauerkraut, and.russiandressing, servedgrilled.on 
pwnperruckeLbread+ .......................................................... 3.95<11 

Figure 7-70 Add ing th e price to the menu item 

The dot leader that you applied to the tab ca uses dots to lead up to the 
tab position, which makes the info rmation easier fo r t he eye to follow. 

~ -S • Save the ch anges that you've made to your d ocument. 

Now let's app ly the Men u Item st yle to " Hawaiian Chicken Club". 

• C lick an ywhere within that paragraph , and then select Menu Item 
from th e style drop-down list o n the ruler. 

Add the price to this m enu item. 

• C lick after "sun flower-seed bread" in that item, press the Tab key, 
and th en type the price, 3. 75. 

,. Follow the same proced ure for a ppl ying th e style to the Bacon and 
Aspa ragus Supreme, Hot Fudge Sundae, and Gena's C heesecake. 

• Be su re to type in the prices fo r these item s, which are 3.95, 1.75, and 
2.25, respectively. 

The re is one more style to be created fo r th is document, "Side Orders and 
Beverages". This style will be indented 1/2 inc h from the left margin and 
will contain three tab stops. 

• C lick in the li ne containing "Cu rly fries". 
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• Drag the left indent and firs~ -line indent markers to the 1/2-inch 
mark on the ruler. 

,,. Click on the decimal tab marker on the ruler, and then click at the 
2-5/8-inch mark and at the 5-5/8-inch mark on the ruler to place 
decimal tab stops there. 

• Click on the left-aligned tab marker on the ruler, and then click at 
the 3-1/4-inch mark on the ruler to place a left-aligned tab stop 
there. 

Your ruler should look like the one shown in Figure 7-71. 

I@ 

Figure 7-71 The left alignment and tab stops on the ruler 

• Double-click on the first decimal tab (at 2-5/8 inches) on the ruler. 

This brings up the Tabs dialog box. Be careful that you don't accidentally 
move the tab marker when you double-click on it. 

• In the Tabs dialog box, click the button next to the dot leader in the 
Leader section . See Figure 7-72. 

Tubs 

''" - [''"'T',.--,1 " n 
0 Left 0 None ~ 
0 Center ~. . . . ~ ( Cancel ] 
0 Right 0 ----
® Oecimul 0 - ( Cleor Rll) 

0 Bur Position: ~ 

Figure 7-72 Setting a dot leader for the 2-5/8-inch tab 

• Click the Set button. 

That sets up the tab leader for the first tab marker on the ruler. 

• Now click on the third tab marker on the ruler, which is set at 
5-5/8 inches. Click the dot leader button for this tab marker also. 

• Click OK in the Tabs dialog box. 

You have already defined the style attributes by setting the indentation, 
tabs, and leaders. Now you need to name that definition. You'll use the 
Define Styles dialog box to define this style. 

3€ -T • Choose Define Styles from the Format menu. 

• Type Side Order/Beverage for the style name. 
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Notice that all the attributes about the style are listed in the box below 
the sty le name, as shown in Figure 7-73. This is helpful if you need to 
verify a particula r formatting characteristic. If you need to change a 
formatting characterist ic, you can do so with the dialog box open, and 
the style description will reflect the changes. 

!0~ Define St tes:Geno's Menu 

Menu Item 
-'•Normal 

L----;:==========: (Set Default J 
st yle: I Side Drder/ Beuerage I ( Define J 

llormel + Font: I 4 Point , Indent: left O.Sin, Tab otopo· 2.6251n 
Number Aligned ... ; 3.251n; 5.625in Number Aligned ... 

NeHt Style: I I Based on: I Normal 

Figure 7-73 The Side Order/Beverage style 

• Click Define in the Define Styles dialog box, and then click OK. 

Thi s Side Order/Beverage style needs to be applied to German Potato 
Salad, Iced Tea, and Cola, Orange, Root Beer. 

• Follow the previous instructions to apply styles to these li nes. 

sg -S ,.. Save your changes. 

The last formatting changes you need to make t o this menu are to t he 
Carry-Out Available line. 

• Click in the selection bar to the left of the Carry-Out line a t the 
botto m of the page to select the entire line. 

I= I • Click on the center-alignment icon on the ruler to center that line. 

3€ -Sh ift-13 3€ -Sh ift-! • Choose Bold from the Format menu, and then choose Italic from 
the Format menu. 

The last line of the menu is now centered, bold, and italicized. 

Now that you've made all these formatting changes, you shou ld save 
and then print your completed document. 

3€ -S • Choose Save from the File menu. 

sg- P • Choose Print fro m the File menu, and then click OK. 

Compare your printed document to the finished menu at the beginning 
o f this pro ject, and make sure they look similar. 

sg -Q • To ex it Microsoft Word, choose Quit from the File menu or just close 
the document and be ready for the next lesson . 
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Project 3: Creating a Table 

In thi s project you'll learn how to use the tables feature, which is new 
with Microsoft Word 4. Using the tables feature is a straightforward way 
to arrange text in rows and columns. The intersection of a row and a 
column is referred to as a cell. You can put just about anything you'd like 
into a cell-numbers, words, paragraphs, groups of paragraphs, or 
graphics. You can format the contents of each cell with character and 
paragraph formats . You can also use any number of line and border 
combinations to format individual cells or the entire table. 

Each cell has many of the properties of a small document, with its own 
top, bottom, left, and right margins and its own selection bar. Text 
word-wraps within a cell just as it does in a document. 

In this project you will create an empty table and then fill it with data. 
However, tables can also be created by selecting existing paragraphs and 
converting them to a filled cell table using the Insert Table command. 
This project does not detail this type of paragraph-to-table conversion 
procedure, but additional information is available in Reference to Microsoft 
Word. 

This project produces a food value table. You'll create this table by 
inserting an empty table grid and then filling each cell with the 
appropriate data. You'll use the ruler to center and left-align the 
contents of individual cells and to set decimal tabs with in several cells 
at once. You'll use cell borders to create vert ical lines between columns 
of cells and to create borders around groups of cells and the entire table. 

Microsoft Word provides three commands for working with tables: 
Insert Table on the Document menu, Cells o n the Format menu, and 
Table on the Edit menu. You' ll work with each of these commands in 
this project. 

The final o utput of this project is the table shown in Figure 7-74. 
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The following is a table showing the fat and cholesterol content of certain foods 
of interest to this particular study group. See Table 7. 

Table 7. Fat and Cholesterol Content of Selected Foods Common 
to Diets of Elderly Nursing Home Patients 

Total Saturated 
Food Item Portion Size Fat Fat Cholesterol 

(grams) (milligrams) 
Lean ground beef 3 oz. 14 6.0 80 
Tuna salad 1/2 cup 10 2.0 40 
Peanut butter 2 Tbsp. 16 2.0 0 
Whole milk 1 cup 8 5.0 33 
Skim milk 1 cup 1 0.2 5 
Butter 1 Tbsp. 11 7.0 31 
Vanilla ice cream 1/2 cup 7 4.0 30 

Source: USDA, Human Nutrition Information Service. 

Figure 7-74 Final output of Project 3 
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,. To begin the assignment, do ble-click on the Microsoft Word icon. 
If you did not exit Word sir ce the previous project, choose New 
from the File menu. 

Your screen will show a new document called "Untitled! ". 

3€ -R ,. Choose Show Rule r from the Format menu. 

3€ -Y • Choose Show lj{ from the Edit menu. 

• Select the paragraph mark (<j[) in the first line. From the Font men u 
choose Helvetica 12 point if you'll be p rinting to a Laser Writer or 
Geneva 12 point if you' ll be usi ng an Image Writer. 

Selecting the paragraph mark before choosing the font is an example of 
setting the character forma t befo re you begin typing. The character 
fo rmat will remain in effect until you change it to something else. 

The example in this pro ject uses Helvetica font. 

This ti me, let's save and name t he document before going on with the 
rest of the pro ject . 

3€ -S ·• Choose Save from the File menu, and save th e document as Food 
Value Table. Be sure you are saving this document on yow· data d isk. 

• Type the following: 

The following is a table showing the fat and cho lesterol conten t o f 
certain foods of inte rest to thi s particula r study group. See Table 7. 

"• Press Return twice to create a blank line. 

WORKING WITH CELLS 

As mentioned earlier, a cell occurs at the intersection of a row and 
column in a table. A row refers to the ho rizontal placement of cells, and 
a column refe rs to the vertical p lacement of cells. In a table consisting 
of four rows and three columns, each row consists of three cells 
horizonta lly and each column con sists of four cells vertically, as shown 
in Figure 7-75 . 

Column 

I l 
Row~ Cell 

I 
Figure 7-75 Relatw nshtp between rows, columns, and cells 

A table can consist of just o ne cell, one row, one column, or any 
combination o f groups of cell s. 
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A cell works like a small document that is contained within the border 
of the cell. You can apply character and paragraph formatting to the 
contents of a cell, and you can wrap text within a cell. 

The appearance of tables can be enhanced using borders and lines. 
Borders can apply to individual cells, groups of cells, or the entire table. 
Lines can improve the readability of tables by separating columns of 
data and by setting headings apart from the body of the table. 

Creating a Single-Column Cell 

•• Choose Insert Table from the Document menu. 

The dialog box that results is shown in Figure 7-76. 

1 nsert Tobie 

Number of Columns: ~ l[ OK )J 
Number of Rows: I ~ 

Column Width: 3 In [Format. .. ) 

Convert From ----_2::====~ 
0 l'<ll '<lfJr<IJI II~ 0 1: o mmu llt~lim i h~ tl 

0 "Tu b ll t~li mltetl 0 Sill!.' btj Side Urli!J 

Figure 7-76 The Insert Table dialog box 

,. Type 1 to replace the highlighted 2 in the Number of Columns box. 

Notice that the column width changed from 3 in to 6 in when you 
changed the number of columns. This is because Microsoft Word 
divides the text co lumn width of your document (the distance between 
the left and right margins of the page) by the number of columns in the 
table, so that each column of cells is the same width. Since the column 
width of this document is 6 inches, the column width of your one-cell 
table is 6 inches also. 

•• Accept the rest of the settings in the dialog box (shown in 
Figure 7-77) by clicking OK. 

Insert Table 

Number of Columns: §I k OK J 
Number of Rows: I ~ 

Column Width: 6 in (Format... ) 

Convert from ---===~==~ 
0 Pm·<tgt ·<1JIIJ ~ 0 [ o m mu ll t~limlted 
0 lob llt~limltetl 0 Si tll~ bt.l Side Only 

Figure 7-77 Dialog box set for one 6-inch-wide column 

Now you see a dotted cell grid that consists of one row and one column 
and, therefore, one ce ll. The insertion point is inside the cell just to th e 
left of the end-of-cell marker, which is represented by a black dot about 
the size of a lowercase "o". The cell also has an end-of-row marker, just 
outside and to the right of the cell grid. See Figure 7-78. 
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Figure 7-78 The first table 

,. Type the following into this cell witho ut pressing Return: 
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• 

..... 
:::;:: 

Table 7. Fat and Cholesterol Content of Selected Foods Common to 
Diets o f Elderly Nursing Ho me Patients 

Not ice how word wrap e nables the text to flow to a new line in the cell 
without you h aving to control the placement of the li nes. Although this 
is a single-column cell, you can create as many lines as n eeded and still 
remain within the same cell . 

Your screen should look li ke the o ne shown in Figure 7-79. 

• File Edit Format Font Document Utilities Window 

:o Food Ualue Table 
10 II 12 13 14 15 '16 

!Normal Ifill D t 1' t . 1 ~ 1=1 1~1 1=1 IIIIi] I-I 1 1 ~!lim 1~1 1.w.1 

The.fo I lowing. is. a.table.showing. the.fatanr . cholesterol.co nte nt of. certain. foods. 
~- interest to. this.particular. study. gt·oup ... s re. Table. 7 .<!! 

i"Table .. T.:FaUi"nct·cfioleste"i'orc·o-nte·nt"of.·sr le-cte·a•·Fo·oc!S":cq:nmon•to:niets•·or:···:· 
L.~.l9~r..ly);l_t,J~.i.t:'9-. t!()_t!I~_..P.~.t.i_~.n..~! ....... ....................................................................................................... .! 

<!! 

Page I I Normal 101 

Figure 7-79 Cell contents of first table 

3€ -S • Choose Save from the File menu. 

Next you'll create a new 5-colut n, 10-row table. 

I 
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Creating Multiple-Column and Multiple-Cell Tables 
• Click to the left of the paragraph mark on the last line of your 

document, beneath the table above it. 

• Choose Insert Table from the Document menu. 

• In the resulting dialog box, change the Number of Columns to 5 and 
the Number of Rows to 10 and accept the rest of the settings by 
clicking OK. See Figure 7-80. 

Number of Columns: 5 

Number of Rows: 

Column Width: 

Conuert From ----===:.._:==~ 
0 Pan1gn1ph~ 
0 lob 0PIImlted 

Figure 7-80 Setting up a 5-column, 10-row table 

Now you have a grid on your screen that looks like the one shown in 
Figure 7-81. 

.. * File Edit Format Font Document Utilities Window 

:0 Food Ualue Table 
0 t 12 3 T4 IS 6 

!Normal IIQ) D 1' .1- t. 1 g 1~1 1 -1 1- 1 1111111- 1 1-1 11!!11 1 I J...l 

The.following. is.a.table.showing.the.Fatand.cholesterol.contentof.certain.foods. 
of. interestto.this.particular.study.group ... See. Table. 7 .<II 
<!! 
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Page 1 101 

Figure 7-81 The grid for the multicolumn table 

., 

• 

Now you need to type the headings in the first row of cells in the 5-
column table. When you press Return o r Shift-Return while typing in 
a cell, Microsoft Word advances you to the next line, but keeps you 
within the same cell. You press the Tab key to advance to a new cell in 
the table. When you are in the last cell of a row, pressing the Tab key 
advances you to the first cell in the next row. 

Rather than creating a predetermined number of rows in a table, you can 
also create new rows as you need them. Pressing the Tab key wh en you 
reach the last row in a table creates a new row with the same characteristics 
as the one you just left, and that row is placed directly beneath the 
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previous row. This is a handy fea ure, beca use it means you don' t have 
to determine ahead of time how n an y rows you'll need in your table. 
It also allows you to fo rmat the first row of cells, and all new rows you 
create will be formatted the sa me as th e original row. 

In this project first you a re creating the table grid and typing in the data. 
Then you are going to change the fo rmatting of pa rts of the table once 
you've seen the layout of the text in the ce lls. Once you've gotten the 
hang of working with tables, feel free to format first and type later. As 
with any document you create, it is a matter of personal p reference, and 
no one way is better than another. 

• Type the column headin gs as shown in Figure 7-82. 

These a re shown with Show~ on, so you ca n see where the new-line 
commnnd, or soft return (Shift-Return), was used to advance to a new line 
in the same cell. 

To move to the next cell to the right, press the Tab key. To move back 
to a cell to the left, press Sh ift-Tab. Or click in any cell to begin typing 
there. 

Figure 7-82 The column head ings in th e tab le 

• After you've typed the head ing in the last cell , press the Tab key to 
advance to the next row. 

• Press the Tab key twice to adva nce to the thi rd cell within this row, 
and type (grams). 

• Press the Tab key twice more to advance to the last cell, and type 
(milligrams). See Figure 7-83. 

I' • File Edit Format Font Document Utilities Window 

0 Food Ualue Table 
5 1- 4 1-~- J-2 _l- 1 _l_O 1i 

_;_ ~ 
!Normal IIQI D t :t t . I !ell '=' 1~1 1=1 lliiill-1 1-1 IE!ll-1 
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Figure 7-83 The second row of 1eadings 
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.. Press th e Tab key to advance to the next row. 

.. Now type the rest of the data in the columns, pressing the Tab key 
to move betwee n cells and also to advance to the next row of cells 
when you have finished typing a row. See Figure 7-84. 

:··r aB'Ie·:7::·:Fat"a:na:cno-leste·rorco·nte·nt"orse·lede-a:·Fo-oas:commo-n:to-:nielS:·oF: .. ··:. 

L.~.~.9.~riY.:.!::I.~.~.!n.Q:.!::!?..t!!.~:.~.a.:~!~.~~,~.,. ... a;;;·r··· ············ ·· ······· · ····s····y.· ········~ ···-;.r···· ·· ·· ····················· ·· ········ ··············..l 
: +' ' +' ' , o~.a. ..., : aLUraLeu+' : ..., •• 
! Food. Item• ! Portion. s ize• ! Fat• ! Fat• ! Cholesterol• ! 

Figure 7-84 Com pleting the table 

3€ -S ... Save your work. 

Don't worry about the unused row in the table-you' ll get rid of it later. 

Now you need to create a single-cell table at the bottom of the table you 
just completed . This will contain your source information. 

• Click to the left o f the paragraph mark (9[) in the last line of the 
document to set the insertion point there. 

• Choose Insert Table from the Document menu. 

• Type 1 to replace the highlighted 2 in the Number of Columns box . 

• Accept the rest of the settings in the dialog box by clicking OK. See 
Figure 7-85. 

I nserl Tobie 

Number or Rows: 1 

t OK J 
~ 

Number or Columns: ~~ 

Column Width: 6 In [rormot... J 

Con11ert From -------=====~ 
0 I'UI'II!Jl'illlh~ 0 [ lltntnll lll~lltnlh~tl 
0 lob lll~llmlh~ll 0 Sltll~ IH.I Sl<lo Ort ly 

Figure 7-85 Dialog box set for one 6-inch-wide column 

Now you have another o ne-cell table beneath the multicolumn one. 

·• In that new o ne-cell table, type th e following source information: 

Source: USDA, Human Nutrition Information Service. 

3€ -S ,,. Save your work. 
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FORMATTING CELLS 

Now that all the information has

1 

een entered, you can change the look 
of the table. 

Each cell has its own 11Selection bar" that you can use to select the 
contents of the cell. The selection bar is to the left of the cell marker if 
there is no data in the cell. If the cell does contain text, the selection 
bar is to the left of t he text. 

The title information in the first one-cell table should be bold. You'll 
select that text now. 

• To select the con tents of the one-cell table that contains the title 
information, click in the selection bar to the left of the text in that 
cell. See Figure 7-86. 

The cell contents become highlighted. 

Figure 7-86 Using the cell selection bar 

:3€ -Sh ift-B • Choose Bold from the Format menu. 

This formatting affected only one cell. You are not limited, h owever, to 
formatting one cell at a time- you can format en tire rows, columns, and 
tables by fi rst selecting the block of cells to be formatted. Next you'll 
format many cells at one time. 

Changing Cell and Column Widths 

The first two columns of the mu ticolumn table should be larger than 
the other three, so let 's change t eir width to 1-1/2 inches. 

•• Beginning in the cell contai ing the words 11Food Item," click and 
drag through the selection qar of the fi rst column, and continue 
dragging through the last cell of the second column. 
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This wi ll highlight both columns, as shown in Figure 7-87. 

Figure 7-87 Selecting two columns 

• Choose Cells from the Format menu. 

• In the resulting dialog box, next to Width of Columns, change that 
box to read 1.5 in, as shown in Figu re 7-88. Then click OK. 

Width of Columns 1-2: 

Sp11ce Between Cols: 

Indent Rows: 

rc!D 
~ 
~ 

(Borders ... J 

(Preu. Column) 

( NeHt Column J 

Figure 7-88 Dialog box showing changed width of columns 

The result of widening the columns is shown in Figure 7-89. 

Figure 7-89 The wider fi rst two columns 
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The changes you made to the c lumn width in the Cell s d ialog box 
affected the columns you had selected. If you had selected on ly o ne 
column, one cell, o r one or more rows, the change would have affected 
on ly whatever you had selected. 

The width of these two columns has increased, and the three columns 
that weren't selected have remained the same. Each of these last three 
columns needs to be on ly 1 inch wide, so you can change them in the 
same m anner. 

,. Drag th rough those three columns to highlight them, and then 
choose Cells from the Form at menu . 

• In the Cell s dialog box, change the Width o f Columns box to 1 in, 
and then click OK. 

Notice that the total width of the 5-column table is now the same wid th 
as the 1-column table above it. 

W -S • Save your work now. 

A shortcut for changing cell or column widths is to use the scale icon on 
the ruler. If you cl ick on this icon while the insertion point is in a table, 
the scale switches to the table scale. This table sca le shows "thumbtacks" 
placed alo ng the ruler where cell margins are. You can d rag to change 
the width of a cell in the row that contains the insertion point . The table 
scale is shown in Figure 7-90. 

Food Uelue Table 
10 12 I'J. 1:1 l(j 

• T T T T Tl 
!Normal I riD t t t t I RIIOI 1'111111111 ,.., Fi t=J l(noO(;::I """ 

"' 
Figure 7-91 The table scale on the ruler 

To change the width of an entire column using the table scale, you must 
first select the column. Otherwise, the change will affect only the row 
that contain s the insertio n point. 

To toggle back to t he no rmal ru ler scale, click on the sca le icon. Cl icking 
on the scale icon while the ruler is in the table scale takes you to th e page 
scale, which has brackets to represent where the page margins are. 
Clicking on the scale icon again returns you to the normal ruler scale. 
Notice that the alignment and spacing icons on the ruler are dimmed 
when you are in table sca le or page scale. You must be in t he normal 
ruler scale to access these set tings. 

Changing Cell Alignment 

Now t ha t the cells are the size th y need to be for th e data in the table, 
the alignment for each cell need to be set. 

The tit le info rmatio n in the first 1-cell table should be centered. 
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3€ -Shift-C ,. Click anywhere in the first 1-cell table, and then click on the center
alignment icon on the ruler. 

The text in the first column in the 5-colum n table should be left aligned. 
If you click in a cell in that column, you'll see that the rul er highlights 
the left-alignment icon, since left alignment is t he default setting. 

The text in the next column should be centered; you' ll change the 
format to center alignment. 

,,. Hold down the Option key. 

Notice that the pointer changes into a downward pointing arrow. 

,,. With the Option key held down, click on the cell in the second 
column that contains the words "Portion Size." 

The second column becomes highlighted. Option-click selects an entire 
column . 

3€ -Shift-C ,,. Cli ck on t he center-alignment icon on the rul er. See Figure 7-91. 

Figure 7-91 Centering the second column 

Now the data in the second column is cen tered within the column. 

Notice that the ruler becomes dimmed when more than one cell is 
selected. This indicates that each cell has different margins or other 
formats, and on ly the margins of the first cell selected are displayed. 

The headings in the next th ree columns should be centered also. 

• Click and drag through the six headi ng cells in the last three 
columns, as shown in Figure 7-92. 

00 -Shift-C • Click on the center-alignment icon on the ruler. 
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Figure 7-92 Selecting and centering the heading cells 

The data in the last three columns of the rest of the table is numeric and 
should be decimal aligned. To do this you need to set a decimal tab for 
aligning the numbers. 

• Click and drag through the last 3 columns in the 5-column table so 
that just those 3 columns are highlighted. 

,,. Click on the decimal tab icon, and then click on the ruler so that the 
tab marker is approximately in the center of the Total Fat column, 
as shown in Figure 7-93. 

s hO'Ni ng. the. fat and. c hoI estero 1. content of. certain. fo 
lar.study.group ... See.Table. 7.qr 

·leste·rol·:co'fite·nt:or'S'~lecte'd:·Fo·o'ds·:corri"· 

· ~~ .... ~.~-~-~.~Y..:.~·r·~J.~~~~;.· .. ~·:f~~~r:hl~;~ .................. .. 
P~.~.i.?..~: .. ?. .!?.~.! ....... j. Fat• l Fat• ~ c ho 

Figure 7-93 Setting a decimal tab for three columns 

This will cause a decimal tab to be set at approximately the center of each 
of the three columns. When a decimal tab stop is placed in a cell, 
pressing the Tab key to advance to that cell automatically advances you 
to the decimal tab position within the cell. For any tab stop other than 
the decimal tab, you must use Of tion-Tab to move over to the stop. 

.. Choose Save from the File menu. 
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Now that you've made all these formatting changes, your screen should 
look like the one shown in Figure 7-94. 

... • File Edit Format Font Document Utilities Window 

§0 Food Ualue Table 
0 2 3 4 5 

I Normal I@ t t :t .. I 1§!11 1§1 1:§1 1§1 liiil 1=1 1=1 IEIJI::::I 

The. following. is. a.table.showing.the.fatand.cholesterol.conte ntof. certain. foods. 
of. interestto.this.particular.study.group ... See. Table. 7.<ll 
<ll 

L..L.l 

1:·;~~~~-:?.:·::~:~:.~~;,~~~~~~~~~~~:~J.;.~~:~~g~~e~~~r~~:~·:::~~;~·~ :- :: 
! Food. ltem• 1 Portion.Size• l Fat• at• l Cholesterol~ 

: ;:;::;~:;;;~~~~::~~~~;:~;; ;;~;:I~il~~~! 
t::?.2.Qt~~:::J!?.:PA.J::!:O:tn.~:(f:B:Qif.i~i§)'iJ:n.:r.o.~@§:tj::?.:~:r.:tJ~~::!::::: :::: ::: ::::: ::: : :::::::~:::::::::::::: ................... J• 
Page 1 Normal 

Figure 7-94 The formatted table 

., 

Borders and column separators will make this table easier to read. You'll 
learn how to add them next. 

Adding Borders and Column Separators 

,.,. Select the entire table by holding down the Option key whil e 
double-clicking anywhere within the table. 

The entire table becomes highlighted. 

,,. Choose Cells from the Format menu, and click the Borders button 
in that dialog box. 

• Select the double line from the five icons running down the left side 
of the dialog box, and then click on the top, bottom, left, and right 
edges of the schematic diagram to produce a border around the 
whole table. Your dialog box should look like the one shown in 
Figure 7-95. 

Cell Borders 

App ly To 
®Selected Cells As Block 
0 Euery Cell In Selection 

Figure 7-95 Applying the border to the block of cells 
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".. Click OK in that dialog box, and then click OK in the Cells dialog 
box to get back to the table. 

,.. Click anywhere outside the table to deselect it so you can see the 
border you just created. 

Next you'll place a line above and below the column headings to set 
them off from the data in the columns. 

• Double-click in the selection bar to the left of the Food Item 
column heading to select the whole row of column headings. See 
Figure 7-96. 

Figure 7-96 Selecting a row using the selection bar 

,.. Choose Cells from the Format menu, and then click the Borders 
button. 

,.. Select the single thin line, and then click at the top and bottom of 
the borders schematic to place a line above and below the selected 
block of cells. Leave the double lines on the left and right of the 
schematic. See Figure 7-97. 

Cell Borders 

Apply To 
®Selected Cells As Block 
0 Euery Cell In Selection 

-

I 

Figure 7-97 Adding borders to the headings 

• Click OK in that dialog box and again in the Cells dialog box. 
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,,,. To place a vertical line between the columns, select the three central 
columns of the table, as shown in Figure 7-98. 

Figure 7-98 Selecting the central columns 

,,,. Choose Cells from the Format menu, and then click the Borders 
button. 

•• In the Cell Borders dialog box, click Every Cell In Selection. 

This indicates that you want the borders applied to each cell in the 
selected area and not to the block of cells as a whole. 

• Click on the left and right sides of the borders schematic diagram 
to place a line on each side of each cell in the selected block, as 
shown in Figure 7-99. 

Cell Borders 

Rpply To 
0 Selected Cells Rs Block 
@Ellery Cell In Selection 

Figure 7-99 Adding column sepa rators to the selected cells 

• Click OK in the Cell Borders dialog box and again in the Cells dialog 
box. 

• Finally, select the last cell in the table, the one containing the source 
information, as shown in Figure 7-100. 
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3€ -S 

3€-y 

285 

. • File Edit Format Font Document tilities Window 

;;o 0~ 
0 5 

!Nor mal I!Ql t t :t Dl I i§; l .. l l""l l;j;l lliilll- 11 I 

~- interestto.this.palticular.study.group .. See. Table. 7.! 

Table. 7 ... Fat.and.Cholesterol. content. of. Sel~cted . Foods. Common • 
to.Diets.of.Eiderl .Nursin .Home,Patients• 

n U I 10n 1 orma IOn HVI 

Normal 

Figure 7-100 Selecting the last cell in the table 

,,. Choose Cells from the Forl at menu, and then click the Borders 
button. 

,,. Select the single thin line, and then click at the top of the borders 
schematic to place a line above the selected cell. Leave the 
double lines on the left, right, and bottom of the schematic. See 
Figure 7-101. 

Cell Borders 

Apply To 
@Selected Cells As Block 
0 Euery Cell In Selec tion ···=;!! ... -- ----- ------ ------ ---- -- --- ----- ------ ------ -- -- -

~-1 ! f-

Figure 7-101 Adding borders to the last cell 

,. Click OK in that dialog box and again in the Cells dialog box. 

,. Save your work. 

I Let's take a look at the table now th at you've added the borders and 
column separators. 

,. Choose Hide Cj[ from the Edrt menu. 

Your table should look like the one in Figure 7-102. 
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,. • File Edit Format Font Document Utilities Window 

Food Item 

Lean ground beef 
Tuna salad 
Peanut butter 
Whole milk 
Skim milk 
Butter 
Vanilla ice cream 

302. 
112 cup 
2Tbsp. 
1 cup 
1 cup 

1 Tbsp. 
112 cup 

40 
0 

33 
5 

31 
30 

Figure 7-102 The table with the bo rde rs and column separato rs 

., 

Adding more white space in the table will keep it from looking so 
cram ped. Yo u' ll do tha t now. 

3€ -Y • Choose Show 91 from the Edit menu. 

Changing Spacing Between Rows 

The contents of cells can be formatted using most of the commands for 
character and paragraph fo rmatting. You'll use the Paragraph command 
to add space to some o f the cells and rows. 

3€ -M 10 Click an ywhere within the title cell of the table, and then choose 
Paragraph fro m the Fo rmat menu . 

• In the Paragraph dialog box, in th e Spacing sectio n , type 12 in the 
Before box and in the After box, as shown in Figure 7-103. 

Paragraph 

Indents Spacing t OK )J left: ~ """ El Right : B Before: 12 (Cancel ) 

First : Rrter: 1 ~ ~ 
0 Page Break Defore 0 Une Numbl.'rintj 
0 Keep With NeHt 'I! 0 Keep lines Together 

( Tnbs ... ) ( Borders ... ) (Position ... ) 

Figure 7-103 Placing a 12-point space before and after the text 

• Click OK. 

The text in that cell now has a 12-po int space a bove and below it. 

• Do uble-cl ick in the selectio n ba r to the left o f the cell with the Food 
Item column heading to select the entire row. See Figure 7-104. 
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• Click on the space-before ic . n o n th e rul er. 

This places a space above the tex t in the cell s in the selected row, as 
sho wn in Figure 7-104. 

Figure 7-104 Placing a space above the row o f column headings 

Click in the last cell in the table, the o ne containing the source 
info rmatio n . 

3€ -M • Choose Paragraph from the Format menu . 

- In the Paragraph d ia log box, in the Spacing sectio n, type 12 in the 
Before box and in the After box, as shown in Figure 7-105. 

Per11groph 

Indents Speclng n OK )J 
Left: § ""' ~ Right: Before: 12 [ cencel ] 

Firs t : Arter: I ~ [ Apply J 

0 Page Break Before 0 line NumberlniJ 
0 Keep With NeHI 'I 0 Keep Lin es Together 

( T8bs ... ) ( Borders ... ) (Position ... ) 

Figure 7-105 The space Befo re and After settings 

• Click OK. 

The text in the source informatio n cell now has a 12-point space above 
and below it. 

3€ -S • Save your work. 

Now the table looks good , except fo r a few final touches. You' ll do some 
final ed iting to fine-tune the appearance o f th e table. 
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EDITING THE TABLE 

Deleting Cells 

Merging Cells 

The empty row in th e 5-colu mn table needs to be deleted. You'll delete 
that row now. 

• Double-cl ick in the selecti on bar to the left of the empty cells at the 
end of th e 5-column table to select th e entire row. 

• Choose Table fro m the Ed it menu. 

The dialog box that resul ts is shown in r:igure 7-106. 

@ Row 
Q Column 
0 Selec tion 

Table 

Insert 

Delete J 
(Merge Cells) 

(cancel ) 

Figure 7-106 Deleting the selection 

• Click the Delete button to delete th e selected row. 

The word "(grams)" under the heading in the Total Fat column needs to 
be centered under both that column and the Saturated Fat column. To 
d o this, you' ll merge two cells. When you merge two cells, you create 
o ne ce ll that contains th e contents o f both. 

• To merge the cell con taining the word "(grams)" with the empty 
cell to its right, select both cells by dragging th rough them. See 
Figu re 7-107. 

oi rue Edit Format Font Document Utilities Window 

CD Food Ualue Table I 
- - - I 14!_ ll ., . J ' ~ -
IHormel I liD 1. t ~ t I IR: I 14tl 121 1•1 1- 1 t=ll I Do(lt:::f ..... . 
Tabl&. 7 ... Fat.and.Chol&stero l Conte nt or Selected. Foods Common 

to.Diots.or Elderly. Nursing Home. Patients• . ... ... Total... j saturated ... 
Food l emo Portion S ize• Fat• 1 Fat• Cho~terol 

tNn ~ildbee1i 
. - - ~= loz • __ 1'1• o Oo 

Tunasa a• f/2.C~ ~~ - -¥;.-- - 41). • 
hlia'nftb"'(jf;if• ~· -o. - . 
~!"~m_!_l(• '"TCi H• o'i.- _ J~ -· : ~~~ -Skmmll<• rr.-'Biirer· l}!>E ----?r.- 31o . 
· vanllla.tce.cream• - 172.-C$'• . "!Uo _J()o . . 
Source USDA, Human Nlb'ltlon lrtonnation Service • 0 
age 1 !Normol IQI IC:: QJ 

Figure 7-107 Selecting th e two cells to be merged 
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• Choose Table from the Ed it l n u, and cJ ick Merge Cells, ass hown 
in the dialog box in Figu re 7-108. 

Q Row 
Q Column 
@ Selection 

Shirt Cells 

Teble 

Figure 7-108 

Insert 

Delete 

~ 
Merging the cells 

• Select and delete the paragraph mark (<Jl) that was placed after 
"(grams)" in the merged cells so that the cell consists of only one 
line. 

31: -S • Save your work. 

Adjusting Margins 

• Scroll to the beginning of the document. 

If you look closely at the document you' ll see that the double border 
a round the table extends beyond the left of the text in the first two lines 
of the document. In order for the text in a table to align with the text 
in the rest of the document, Microsoft Word places the border of the 
table slightly to the left of the left margin . In this case it will look better 
if the border aligns with the text in the first two lines. You' ll adjust that 
now. 

• Ho ld down the O ption key and double-cl ick somewhere in the 
table. 

This selects the whole table. 

• Click o n the sca le icon on the ruler to d isplay the table scale. 

The ruler will be dimmed, and a "thumbtack" will appear under the 
6-inch mark. 

• Click and drag the left indent marker 1/8 inch to the right, as shown 
in r:igure 7-109. 

Figure 7-109 Moving the left indent for the table 

The en ti re table will shift 1/8 inch to the right, and the left border of the 
table wi ll line up with the text in the first two lines of the document. 
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3€-R 3€- Y • Choose Hide Ruler from the Format menu and Hide Cj[ from the 
Ed it menu. 

Changing Borders 

You sh ould be able to see your entire finished document on the screen, 
as shown in Figure 7-110. 

=o Food Ualue Table 

The following Is a table showing the rat and cholesterol content of certain foods 
of interest to this particular study group. See Table 7. 

Table 7. Fat and Cholesterol Content of Selected Foods Common 
to Diets of Elderly Nursing Home Patients 

Food Item 

Lean ground beef 
Tuna salad 
Peanut butter 
Whole mill< 
Skim milk 
Butter 
Vanilla ice cream 

Portion Size 

3oz. 
112 cup 
2Tbsp. 
1 cup 
1 cup 

1 Tbsp. 
112 cup 

Total Saturated 
Fat Fat 

(grams) 
14 6.0 
10 2.0 
16 2.0 

8 5.0 
1 0.2 

11 7.0 
7 4.0 

Source: USDA, Htman Nutrition Information SerYice. 

Page 1 !Normal ...... IQI 

Figure 7-110 The finished Food Value Table 

Cholesterol 
(milligrams) 

80 
40 

0 
33 
5 

31 
30 

Placing the borders around the cells can be somewhat tricky. If you did 
not get the effect you wanted, you can follow these steps for removing 
the borders from the cells or group of cells: 

• Select the cell or block of cells that you want to remove the borders 
from. 

• Choose Cells from the Format menu, and then click the Borders 
button. 

• In the Borders dialog box, click on each line in the borders schematic 
diagram that you want to remove. This will remove the line from 
the schematic. 

·• Click OK in the Cell Borders dialog box and again in the Cells dialog 
box. 

3€-S 3€- P • Save your work, and then print your document. 

Compare your printed document to the one at the beginning of this 
project and make any necessary corrections. 

• Choose Quit from the File menu to exit Microsoft Word. Or, if you 
are continuing with the next project right away, choose Close from 
the File menu. 
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Project 4: Creating a Newsletter 

Desktop publishing is a term heard often today. It refers to using a 
computer and one or more applications to create quality presentation 
documents, such as magazines, newsletters, annual reports, and 
brochures. 

There are many page layout programs on the market that help the 
desktop publisher with design and production. These programs usually 
specialize in one area of desktop publishing and are used in combination 
with other programs to pull together the total project. 

In this project, you'lllearn to use features in Microsoft Word to create 
a newsletter worthy of the term "desktop publishing." Microsoft 
Word's page layout properties enable you to design the page without 
having to incorporate your work into another program. Microsoft 
Word also allows you to add graphics and documents from other 
programs to a Microsoft Word document. 

This project introduces you to the section in Microsoft Word. A section 
is any part of your document that you designate as separate from 
another part. You can compare a section to a chapter in a book. A 
chapter is a part of the whole book, but it is also separate from other 
chapters. 

You can divide a document into one or more sections and then format 
each section differently from other sections in the same document. You 
can even have several sections on one page, each formatted differently. 

The formatting characteristics applied to a section are controlled through 
the section's dialog box. If you do not divide your document into 
sections, Microsoft Word treats the entire document as one section, and 
the settings in the Section dialog box will apply to the whole document. 

You'll create four sections in a document in this project, and each 
section will be formatted differently. You'll also learn how to adjust 
margins using the Print Preview margins tool, and you'll be introduced 
to Page View. 

A finished version of the Traveling Times newsletter is shown on the next 
page in Figure 7-111, and a printed version of the unformatted document 
that is used in this project is sho n in Figure 7-112 on the page after that. 
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February Issue, Volume 14 

MOUNTAIN RACING 
On any given Saturday night from April to 

October, the roar of car engines can be heard 
throughout the Peachtown area of Murley. North 
Carolina. 

Peachtown Raceway. located on old 46 just 
west of Peachtown. is a dirt track that fea tures 
five classes of race cars from the Enduroclass 
(the least expensive cars) to the Sportsmanclass 
(some of these cars range up to $30,000!). 

All evening in the pits there is an air of 
frivolity as the drivers banter back and forth 
while waiting for their turn on the track. The 
more participants there are in each class, themore 
competition, challenge. and exc itement. 
Amazingly, even on a cold or drizzly nightthe 
stands are full of spectators urging on their 
particular hero, and they don 't even seem tomind 
when they are splattered with flyingchunks of 
mud. 

Racers come from many surTounding areasof 
North Carolina. Georgia, and Tennessee. 
Although the monetary prizes are not very large, 
the fun and excitementfor these dri vers and their 
families are obvious. 

Attending Peachtown Raceway is always a 
fun evening for all . participants or spectators. 
and a good way to entertain kids. Be sure to put 
this on your list of things to do when visiting the 
moumains of western North Caroli na. 

Traveling Times 

THE CAYMANS 
On my recem travels to the 

island of Grand Cayman 
survived an interesting 
experience. While I slept 
comfortably in an exclusive 
resort hotel, an incredible storm 
was tearing the island apart. A 
"norwester." as the islanders ca ll 
it. had hit the main town of 
Georgetown and had done 
extensive damage. The public 
beach was completely washed 
away. and debris was scattered 
everywhere. Several shops in 
town were underwater. and a 
couple of homes had been 
transported from their original 
dwelling spots to new locations. 

Grand Cayman is the largest 
of three islands just south of 
Cuba. Originally discovered by 
Christopher Columbus on his 
fourth voyage to North America. 
it was eventually settled by 
pirates and escaped slaves. In a 
treaty with Spain in 1670. the 
islands were transferred to 
England, and they have 
remained a Bri tish Crown 
Colony. 

Bringing the world to you! 

The island was an importalll 
food source for many 
generations, since it was 
inhabited with thousands of 
turtles and marine crocodiles 
called Caymanas (which is 
where the islands got their 
name). After depleting the turtle 
population over the years. the 
islanders now have a large turtle 
farm where they hope to manage 
the species and prevent it from 
becoming extinct. Turtle soup 
and other specialty dishes are 
still favorites on the island and 
are served in most restaurams. 
Unfortunately. most of the 
turtles at the farm escapedduring 
the storm. 

Another illleresting aspectof 
the Caymans is the blending of 
races into a comfortable. 
integrated society. Being from 
different parts of the world and 
having several different ethnic 
backgrounds. these people have 
created their own un ique culture. 
There is a native quality from 
Jamaica and many other 
Caribb~.:an bland~, along wi th an 
aristocratic air from the English 

and Welsh influences. The 
language of the Caymans is 
English, but they do have their 
own melodic version of it that 
they usc in everyday 
conversation with each other. It 
is a joy to hear. even when you 
have no idea what they arc 
talking about. 

The Cayman Islands are a 
paradbc for divers and 
beachcombers. Three sides of 
Grand Cayman are surrounded 
by a reef that is perfect for 
snorkeling. while the fourth side 
has miles of white sand on its 
shoreline and is appropriately 
named Seven Mile Beach. There 
are also hundreds of shipwrecks 
within minutes of shore. where 
divers can search for buried 
treasure to their heart' s content. 

At the north end ofthe island 
is a tiny town called Hell . You 
can imagine the remarks that 
come from that place! At least I 
can say I made it to Hell and 
back! 

-M.Swan 

Figure 7-111 Final output of Project 4 
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On any given Saturday night from April to October. the roar of car engines can be heard 
throughout the Pc<Jchtown area of Murley, North Carolina. 
Peachtown Raceway. located on old 46 just west of Pcachtown. is a din track that features 
live classes of race cars from the Enduro class ( the least expensive cars) to the Sportsman 
class (some of these cars range up to $30.000!). 
Racers come from many surrounding areas of North Carolina. Georgia. and Tennessee. 
A lthough the monetary priLes arc not very large. the fun and excitement for these dri vers 
and their famil ies arc obvious. 
A l l evening in the pits there is an air of fr ivolity as the drivers banter back and forth while 
waiting for their turn on the track . The more participants there are in each class. the more 
competition. challenge. and excitement. A mazingly, even on a cold or drizzly night the 
stands are full of spectators urging on their particular hero. and they don' t even seem to 
mind when they arc splattered with ny ing chunks of mud. 
A ttending Peachtown Raceway is always a fun evening for all. participants or spectators. 
and a good way to entertain kids. Be sure to put this on your list of things to do when 
v isiting the mountains of western North Carolina. 

On my recent travels to the island of Grand Cayman I survi ved an interesting experience. 
While I slept comfortably i n an exclusive resort hotel. an incredible storm was tearing the 
island apart. A "norwcstcr ... as the islanders call it. had hit the main town of Georgetown 
and had done extensive damage. T he public beach was completely washed away. and 
debris was scattered everywhere. Several shops in town were underwater, and a couple of 
homes had been transported from their original dwelli ng spots to new locations. 
Gmnd Cayman is the largest of three islands just south of Cuba. Originally discovered by 
Christopher Columbus on his fourth voyage to Nonh A merica. it was eventually settled by 
pirates and escaped slaves. In a treaty with Spain in 1670. the islands were transferred to 
England. and they have remained a Br itish Crown Colony. 
T he island was an important food source for many generations, since it was inhabited wi th 
thousands of turt les and marine crocodi les called Caymanas (which is where the islands got 
their name). A fter depleting the turtle populat ion over the years, the islanders now have a 
large turtle farm where they hope to manage the species and prevent it from becoming 
extinct. Turtle soup and other specia lty dishes are still favori tes on the island and are 
served in most restaurants. Unfortunately, most of the turtles at the farm escaped during 
the storm. 
A nother interesting aspec t or the Caymans is the blending of races into a comfortable. 
i ntegrated society. Being from different parts of the world and having several di f ferent 
ethnic backgrounds. these people have created their own unique culture. There is a nati ve 
quality from Jamaica and many other Caribbean islands, along with an aristocratic air from 
the Engl ish and Welsh influences. The language of the Caymans is Engl ish, but they do 
have their own melodic version of it that they usc in everyday conversation with each other. 
It is a j oy to hear. even when you have no idea what they are talking about. 
The Cayman Islands arc a paradise for divers and beachcombers. Three sides of Grand 
Cayman are surrounded by a reef that is perfect for snorkeling. while the fourth side has 
miles of white sand on its shoreline and is appropriately named Seven Mile Beach. There 
are also hundreds of shipwrecks within minutes of shore. where divers can search for 
buried treasure to thei r heart 's content. 
At the north end of the island i!> a tiny town called Hel l. You can imagine the remarks that 
come from that place! A t least I can say I made i t to Hell and back! 

-M. Swan 

I 
Figure 7-112 Unfo rmatted Traveling Times newsletter 

293 
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Since the object of this project is not to focus on your typing skills, an 
unformatted document is used. This document is supplied on the 
Macintosh Journey Projects disk, which accompanies this book. Artwork 
for the newsletter is also supplied on the same disk. 

RETRIEVING THE UNFORMATTED DOCUMENT 

I] -
-

TravelinQ Times Unformatted 

Thereareacoupleofways to begin this project. The most straightforward 
way is to locate the document entitled "Traveling Times Unformatted" 
and double-click on its icon. This will start Microsoft Word and open 
that document. 

Another way is to double-click on the Microsoft Word icon to launch the 
application, and then choose Open from the File menu. Locate the 
Traveling Times Unformatted document (click the Drive button if 
necessary), and double-click on it to open it. 

W -0 If you did not quit Microsoft Word after the last project, choose Open 
from the File menu and double-click on Traveling Times Unformatted 
to open it. 

Whichever of the above methods you chose, the document Traveling 
Times Unformatted should be on your screen. 

Since you do not want to alter the original document, the first thing you 
need to do is make a copy of this document to work with. 

• Choose Save As from the File menu and change the document's 
name to Traveling Times. Verify that you are saving this document 
on your data disk, and then click Save. See Figure 7-113. 

I ~ Carolyn Phillips I 
D Colle< tilln letlc!r 
D Colle< Uon I. e11 cw 1 
[) Collc!C tillll l. c! l lc!l' IIIII a 
[) l'uoll Ulllut~ Tnblf.' 
D (ieno's Menu 

S!lue Current Documen t llS: 

I Trauellng Times 

0 l'llSI SIIIH~ 0 Milke Bllc lcup 

(rue Format ... ] Normal 

~ Carolyn Phillips 
73t K auailable 

~--~~ 

Figure 7-113 Saving the document as Traveling Times 

FORMATTING THE DOCUMENT 

A couple of formatting changes need to be made to this document 
before you divide it into sections. 



Chapter 7: Microsoft Word 295 

3€ -R 3€ -Y • Choose Show Ruler from tl e Format menu and Show <JI from the 
Edit menu. 

• Select the entire document by holding down the Command key and 
clicking anywhere in the selection bar of the document, as shown 
in Figure 7-114. 

Figure 7-114 Selecting the entire document 

• With the document selected, move the first-line indent marker on 
the ruler (the top triangle) to the 1/4-inch mark on the ruler to 
indent the first line of each paragraph. 

3€ -Shift-] ,,.. Click on the justified-alignment icon on the ruler to justify the text 
between the margins. See f igure 7-115. 

3€ -Shift-R 

3€ -Shift-B 3€ -Shift-C 

Figure 7-115 The ruler with 1/4 inch first-line indent 

-• Scroll down to the last line in the document, "-M. Swan", and click 
anywhere in that line. Right-align that paragraph by clicking on the 
right-alignment icon on t hl ruler. 

• Insert a blank line at the tog of the document, and click to set the 
insertion point in that line~J 

,.,. Choose Bold from the fon~at menu, and then type MOUNTAIN 
RACING in all caps. Click on the center-alignment icon on the ruler 
to center that line. I 
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,,. Scroll to the middle of the document, where a Return marker 
separates th e two newsletter articl es. 

• Insert another b lank li ne in fro nt of the line beginning with the 
words "On my recen t travels" and click in that new line to set the 
insertion point. 

3€ -Shi ft-B 3€ -Shift-C • Choose Bold from the fo rmat menu, and then type THE CAYMANS 
in a ll caps. Cen ter it using the center-alignment icon on the ruler. 

W -S • Save these changes to your documen t. 

During the rest o f the instructions for this project , you won' t be 
prompted to save your work. That does n 't mean you shouldn't do so, 
it just means you should be thinking of that step on your own by now. 

Now let 's divide this document in to four sections. 

CREATING A NEW SECTION 
,,,. To set the insertion point, click in front of the Return marker 

separating the two articles. 

,,. Hold down the Command key and press the Enter key (on the 
num eric key pad) to insert a section break m arker. 

Be careful to press the Enter key just o nce. If you keep holding it down, 
a series of section breaks will be created. If you had a heavy hand on thi s 
key, select t he extra sect ion markers by dragging through them, and 
then press Backspace to delete them . 

Your screen should have a double dotted line running across it. This is 
the section break m arker. See Figure 7-116. 

,.. a File Edit Format Font Document Utilities Window 

features.fi-ve .classes.of.race.cars.t'rom. the. Enduro . class. (the . l.east. expensive . cars). to. the. 
Sportsmanclass.(some.of. these.cars range. up. to.$30 ,000 !). qr 

Racers . come . from. many. surrounding . areas . of . North . Carolina, . Georgia, . and. 
Tennessee . . . i\11hough.1he.monetar'<J. pri.zes.are.not. very.large ,. the . fun. and. exci1ement. for. 
these. drivers. and. their. fami.lies.are.o bvious. qr 

A.l.l.evening .in.the. pits. there .is an.air.of.frivolity.as. the . drivers. banter. back. and. forth 
while. 'l!aiting.for.their. tum on the. track .. . The. more. participants. there.are. in. each. class, . the. 
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Figure 7-116 The section brea k marker 
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• To create the next section, lick to the left of t he title line, "THE 
CAYMANS," that you typed Ja few steps back. 

The insertion point should be to the left of the "T" in that line. 

• 

* 10 

. 

Use the Command-Enter key sequence to insert a section marker at 
that point, as shown in Figure 7-117. 

File Edit Format Font Document Utilities Window 
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Figure 7-117 Inserting the second section break 

Now let's create the last section at the end of the document. 

• Scroll to the end of the document and click after the last line in the 
document, "-M. Swan". 

The insertion point should be to the right of the "n" in that line, at the 
end of "Swan". 

• Use the Command-Enter key sequence to insert a section marker 
there, as shown in Figure 7-118. 

' a File Edit Format Fon t Document Utilities Window 

ilD Trauelin!l Times 
l 

4 

Pll 

-M . . SY1lll I>· 
:c>ali~===;:::;:..-.::=========="""~~~'F·~--u:~~=-m~r.~~:muo~mfi--T 

1.:1860 Chars Normal• ... 1¢1f l I 

Figure 7-118 Inserting the third section break 
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Now the document is divided into four sectio ns. The first section will 
be fo rmatted in a two-column layout. 

•• Click anywhere in the first sectio n , above the double lines. 

Thi s te lls Microsoft Wo rd which sectio n you want to apply the changes 
to. 

,,. Choose Section fro m the Fo rm at menu. 

The resulting dialog box is shown in Figure 7-11 9. 

Section 

Sta rt: I New Page !OI 0 lm:lude £ndnotP.s ODl 
Page Number - line Numbers [Cancel ) 
0 Auto I Off IOI 

( Apply J 0 Restart a t t 
Count btj: 

~ , , 2 3 IOI [Se t Default ] 

~ 
from l1~nt: 

frorn Top: 

rmm Right: [ o.'i~ Header/ Footer 

r: olumns 
FromTop: ~ 

Number: 

~ 
From Bottom: 0.5in 

Spacing: 0 Firs t Page Special 

Figure 7-119 The Sectio n dialog box 

Since the optio ns in this dialog box can be applied to your who le 
document if it consists of o nly one sectio n (and most documents do 
consist of onl y one section), you need to understand what some of these 
options ca n do. 

The Star t portio n of this dia log box consists of a d rop-down list from 
which you choose where you'd like the section to sta rt. The default is 
New Page, which causes the text in a section to begin on a new page. 
Othe r options are No Break, New Column, Even Page, and Odd Page. 
You ' ll be using the New Page and No Break options in your newsletter. 

The Page Number po rti o n allows you to n umber the pages o f the section 
(or document) automatically . The drop-down list in this fi eld gives you 
severa l number formats to choose from. To number pages from the 
Secti on dialog box, click Auto. The From Top and Fro m Right boxes 
become activated , and the page number is positioned o n the page using 
those fields. The newsletter you are creating in th is pro ject will not have 
page numbers. 

In the Columns port ion of the d ia log box, Number indicates the 
number of columns that sectio n should contain, and the Spacing box 
tells how much space should be between columns. The documents 
you've worked with in this chapter have all consisted of one column. In 
this pro ject you' ll combine two-column, o ne-column, and three-column 
layouts all o n o ne page. 
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The Header/Footer portion allow you to change the vertical position of 
the headers and footers. (Header and footers will be discussed in more 
detail later in this project.) The Frst Page Special option enables you to 
create a header and footer for the first page of the section (or document) 
that can be different from the standard header and footer. This is 
especially useful when you are creating a document that requires a title 
page, since the header and page number should not print on the title 
page. You would create a blank First Page Special header and footer and 
put the page number and other heading data in the standard header or 
footer, which applies to each subsequent page in a section. 

Now you'll use the Columns portion in this dialog box to change the 
first section in the document to two-column format. 

CHANGING THE NUMBER OF COLUMNS 
• Change the number of columns to 2 in the Section dialog box, as 

shown in Figure 7-120, and then click OK. 

Section 

Header/ Footer---, 

FromTop: ~ 
From Bottom: ~ 

D First Pege Special 

0:0 
[cencel I 
~ 

[Set Default I 

Figure 7-120 Changing the number of columns to 2 

Your text is now shown in one column running down the left side of the 
screen. In Galley View, which is Microsoft Word's regular view, you can't 
view both columns at once, but Page View and Print Preview allow you to 
view the columns arranged next to one another on the page. After you 
set up the layout of your other three sections you'll use Page View and 
Print Preview to view the document. 

• Scroll down to the second section of the document, the one that 
consists of one Return marker with a section break both above and 
below it. 

.. Click in the line between tre section markers, and then choose 
Section from the Format menu. 

• In that dialog box, click on tJe arrow to the right of New Page in the 
Start portion, and drag down to select No Break, as shown in Figure 
7-121. Then click OK or press Return. 



300 Part III: Word Processing 

Section 

St art: New Page 10 0 lnc:hl<le [1\lloot~s ODl I I •; 

Puge New Column line Number s (cuncel ) 
onu ./New Puge I Off !ol 

( Apply J O Re Euen Puge f. ount bf.F 
l -----·--1 

'123 Odd Puge 
i.!t.~!~ .. J I Set Defllult J 

Frorn lop: ~~~~~~~~~ 
From ·r.~ut: 

He11der/ Foot er From night : 1 (!:~iln . J 

r:olumns 
FromTop: ~ 

Number: 

~ 
From Bottom: O.Sin 

Spucing: 0 First Puge Speciul 

Figure 7-121 Changing the start to No Break 

The No Break option tells Microsoft Word that this section will start 
where the previous section left off and will not begin on a new page or 
a new column. 

Now let 's work with the layout of the third section. 

• Click on the same line that contains the title "THE CAYMANS", and 
choose Section from the Format menu. 

'",. In the Section dialog box, change the Start to No Break, the number 
of columns to 3, and the Spacing to .25 in as shown in Figure 7-122. 
Then cl ick OK. 

Section 

Stur t : I No Break !ol 0 ln.:lude Endno tl's lCEJ 
Page Number- line Numbers [ cuncel J 
O Auto I Off !ol 

( Apply J 0 Res tort at I 
f.ount b(l: 

t~luto j I I 2 3 !ol (Set Default) from "IP.llt: 
I' rom !"Oft: r~5~~-_J 
From llitjh l: j !l. '~~~~ I Header/ Footer 

r:olumns 
Fromlop: ~ 

Number : ~ 
From Bottom: 0.51n 

Spacing: 0 First Page Special 

Figure 7-122 Settings for the three-column section 

Now this section has a narrow column of text going down the left side 
of the page. 

The fourth section of the document was created so that Microsoft Word 
will balance the length of the text in the columns above it. Inserting a 
section that has the No Break format at the end of a document causes 
Microsoft Word to ad just the lengths of t he columns in the section that 
precedes it until they are approximately equal. 
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• Scroll to the last section in he document, and click on the line 
below the last section market in the document. 

• Choose Section from the Format menu, and in the Section dialog 
box change the Start to No Break. Click OK. 

ADDING AND FORMATTING A GRAPHIC 

Now you'll paste the Traveling Times logo into the newsletter. 

On the Projects disk is a document called "Traveling Times Logo." 

00-0 • Choose Open from the File menu, and double-click on Traveling 
Times Logo. 

3€ -C ,,.. Click on the graphic to select it, and then choose Copy from the Edit 
menu to copy it to the Clipboard. 

00- W "• Close that document by clicking in its close box. 

00- V ,.. Be sure the insertion point is in the blank line in the second section 
of the document. Choose Paste from the Edit menu to paste the 
graphic into that section. 

00 -S hift-C 

Next you'll make some formatting changes to this section. 

• Select the lines between the section marks, but do not include the 
section marks. See Figure 7-123. 

r • File Edit Format Font Document Utilities Window 

u ~ 

!Normal I liD D t s t . I 1£:1 § ~:ill m llili)I=J o=o EJ 1:1 ...., 
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Traveling Times .. <Tt;, 
l,r.;s.__ t . 

( '-: ' Bringing the world to you_l '~-/ 
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:r.:::-..ru:"''"fiii!' :'CAY"MAlf=-Sq,...=::=....-::::!::::::=:.-========~=:t:f;::::.'l::l:::===::-.::t:~:s::.::nt:ca::::cnnsr::x:tra:-=~- !:! 
On.my. recent. tra.vel3 . to. ~:; 

the . lsblld . ot . GWll!. i!' 
C•yman . I . owvived . an. 

1 Norma+ ... 

Figure 7-123 Selecting the area between section marks 

• On the ruler, move the first-~ine indent marker back to 0. 

• Drag the right indent marker to the 6-1/2-inch mark, and then click 
on the center-alignment icon on the ruler to center that section. See 
Figure 7-124. 
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r • File Edit Format Font Document Utilities Window 
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Figure 7-124 Formatting the second section with the ruler 

Now you'll put a border around this logo and add some space above and 
below it. 

3€ -M • Choose Paragraph fro m the Format menu, and click the Borders 
button in the Paragraph dialog box. 

• In the Paragraph Borders dialog box select the double line, and then 
cl ick at the top and bottom of the schematic diagram to place a 
double line above and below the selected graphic, as shown in 
Figure 7-125. 

0 Plain DOH 
0 Shadow DoH 
0 Outside Dar 

...._ ____ _. ®Custom 

Spacing: C=:J 

Figure 7-125 Placing a double line above and below the graph ic 

• Click OK in the Paragraph Borders dialog box. 

That wi ll take you back to the Paragraph dialog box. You' ll change the 
paragraph spacing in th e Paragraph dialog box. 

ln the Paragraph dialog box, you' ll tell Microsoft Word to place a 6-point 
space above and below the selected paragraph or, in this case, the 
selected graphic. This wi ll place a small space above and below the logo 
to set it off slightly from the text. 

Setting the spacing from the Pa ragraph dialog box is similar to using the 
paragraph-spacing icons on the ruler, li ke you did in Project 1. However, 
using this option in the Paragraph d ialog box allows you to specify the 
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exact amount of space you wa11 t placed before or afte r the selected 
paragraph. To remove spacing befo re or after a pa ragraph in thi s dialog 
box, type 0 in the appropriate field. 

• In the Spacing portion of the Paragraph dia log box, cl ick in the box 
next to Before and type 6. Press the Tab key to move to the box next 
to After, and also type 6 there, as shown in Figu re 7-126. Then 
click OK. 

Paragraph 

Indents Spacing m Left: 

~ .... B Right: Before: 6 [ Concet ] 

First: Rfler: ~ ~ 
0 Poge Break Before 0 Un<l NUillllPrin\1 
0 Keep With NeHI 'II 0 Keep lines Together 

[ Tabs ... J (Borders ... J (Position ... ) 

Figure 7-126 Ch anging the Before and After paragra ph spacing 

When you return to your docum ent, your logo will have a double li ne 
and a 6-point space above and below it, as shown in Figure 7-127. 

Figure 7-127 The logo with the borders and spaces 

CREATING A HEADER 
Next you' ll create a header for the newsletter. 

A header is text and/or graphics ~hat appear at the top of every page, 
above the body of the document. A footer can also be text and/or graphics, 
but it appears at the bottom of every page, beneath the body of the 
document. 

In Project 1 of this chapter you created a letterhead at the top of the 
memo randum, but it was actually placed in the document itself and 
printed only on the page on whi c~1 you had typed it. It was don e in this 
way so that it would prin t on th first page of the memorandum only. 
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In this project you'll make use of the header window. You' ll also learn 
about the footer window since, except for the ir placement on the 
printed page, they are very similar. You won 't use a footer in this project, 
but all that you' ll learn about headers can be applied to foo te rs as well. 

A header o r footer prints on every page of a document, unless the 
document has multiple sections and each of those sections has a header 
or footer. The First Page Special header was mentioned earlier in 
reference to the Secti on dialog box. For additional information o n 
headers and footers see Reference to Microsoft Word. 

The newsletter you are creating in this pro ject consists of o nly o ne 
printed page, yet the instructions for creating headers are just as 
applicable for multipage documents . 

• Scroll to the beginning of the newsle tter, and click anywhere in the 
first section of the document. 

Since each section can have a separate header and foo ter, you must 
indicate the sectio n for which you want the header opened. If you recall 
from when you were setting up each section, the first section o f th is 
document is the on ly one that will begin o n a new page. Therefore, this 
is the o nl y section that will need a header. 

• Choose Open Header from the Document menu. 

An open window entitled "Traveling Times: Header (S l )" appears at the 
bottom of the screen . See figure 7-128. 

"(Sl )" in your header title indicates the section this header applies to. 

" a File Edit Format Font Document Utilities Window 
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Figure 7-128 The header window 
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Using the Header Window Icons 
Notice the three icons below the title bar in the left corner of the header 
window shown in Figure 7-128. 

The leftmost icon is the page numbering icon. If you click on that icon, 
it places a page number in the window at the insertion point. Using this 
icon tells Microsoft Word to place the correct page number in every page 
of the document, much as it does when you place a page number in a 
document while in Print Preview, like you did in Project 1 of this 
chapter. However, using this icon in a header or a footer allows you to 
adorn the page number with dashes on either side, the word "Page" in 
front of the number, or any special formatting such as font and size, 
which you cannot do with the Print Preview method. 

The middle icon is the automatic date icon. It places the current date 
at the insertion point in the header or footer. This date changes to the 
currentdatewheneveryou open or print the document. The date comes 
from the computer's system clock, the settings of which you can check 
or change in the Control Panel from the Apple menu. 

The rightmost icon is the automatic time icon. It works like the date 
icon, except that it places the current time at the insertion point in the 
header or footer. It also changes to the current time when the document 
is opened or printed. The time comes from the computer's system clock 
as well. 

These icons are also found in the footer window and work in the same 
manner. 

If you experimented with the date, time, or page number, make sure you 
have deleted them from the header window. To delete any of these 
en tries, select the item and press the Backspace key. 

You format the header with a ruler in the same way that you format the 
document. The header window uses a separate ruler from the one that 
is used for the rest of the document, however. You'll use the header's 
ruler to format your header. 

3€ -R ".. Choose Show Ruler from the Format menu. 

3€ -Sh ift-B ".. Choose Bold from the Format menu, and then type February Issue, 
Volume 14 in the header window, as shown in Figure 7-129. 
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,. 15 File Edit Format Font Document Utilities Window 
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Figure 7-129 Typing text in the header window 

3€ -Shift-R 1 - 1 • Click o n the right alignment icon on the ruler in the header window 
to align the text with the right margin of the page. 

Now you'll place a border beneath the text in the header and a space 
beneath the header line. 

• Double-click in the top portion of the ruler in the header window, 
next to on e of the numbers on the ru ler. 

This is a shortcut to choosing Paragraph from the Format menu. It 
brings up the Paragraph dia log box. 

• Click the Borders button in the Paragraph dialog box. 

In the Paragraph Borders dialog box select the thick si ngle line, and 
then click in the bottom of the diagram to place a thick line below 
the paragraph, as shown in Figure 7-130. 

L OD 
[C11nce1) 
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Spacing: [=::J 

Figure 7-130 The Paragraph Bo rders dialog box 

• Click OK to return to the Paragraph dialog box. 

• In the Paragraph dialog box, type 12 in the box to the right of After 
in the Spacing section, as shown in Figure 7-131. Then click OK. 
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Paragraph 
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Figure 7-131 The space-after setting 

Your h eader should look like th e one shown in Figure 7-132. 
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Figure 7-132 The completed header 

• Once you have established that your header is correct, click in the 
close box of the header window to close the window. 

The contents of the header and footer are visible on ly in Print Preview 
or Page View or when the document is actually printed. 

You're probably curious to see t~e effects of all the formatting changes 
you've made to your document. You' ll do that now using Print Preview. 

Have you saved your work lately? 

ADJUSTING THE MARGINS 
3€ -I • Choose Print Preview from the File menu. 

It looks good, except that the newsletter has gone to a second page. 
You'll adjust that now. 

The margins icon in Print Preview allows you to manually adjust the 
margins and then immediately see the results of the change. You'll 
adjust the margins until the entire documen t fits on one page. 

·• Click on the second icon dovJn the left side of the screen. This is the 
margins icon. 

When you do, dotted margin Iii es appear on the right-hand page. 

• Click on the first page to sele tit. The margin markers appear there. 

Now you'll adjust the margins by dragging the margin markers to 
different locations. 

• Click on the bottom left handle of the margin marker that runs up 
the left side of the page, as srown in Figure 7-133. 
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Figure 7-133 Clicking on th e margin marker handle 

.. Hold down the mouse button and drag to the left so that the num ber 
showing at the top of the page, after the words "Print Preview: 
Traveling Times," changes to 0.75 in, as shown in Figure 7-134. 
Release the mouse button. 

Print Preuiew: Traueling Times 0.75 in 

rm:;o··· \:d . 

~ 
~ 

Figure 7-134 Changing the left margin 

(Page Uiew J ( Cancel ] _ .......... 

.. Do the same with the right margin marker, dragging it so the margin 
width changes to 0.75 in for tha t side also. 

.. Click on the margins icon (or double-click on the page) to tell 
Microsoft Word to recalculate the margins and place th is text 
between the new margins. 

Notice how adjusti ng the margins made more text fi t on the first page. 
as shown in Figure 7-135. 
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Print Preuiew: Traueling Times P S 1-P2S3 [Page Uiew) [ Cancel ) 

................. ,. 

Figure 7-135 Ad justing margins to fit the text 

Now let's adjust the top and bottom margins. 

~ Drag the handle for the top margin, wh ich is at the top left of the 
page, so that the new dimens ion is 0.75 in . 

• Drag th e handle for the bottom ma rgin, which is at the bottom left 
of the page, so that the new dim ension is 0.50 in . 

,. Click on the margins icon to see the effects of these changes. 

Your entire document shou ld fit o n one page now, li ke the one shown 
in Figure 7-136. If it doesn ' t, keep adjusting the margins in thi s manner 
until all the text fits on one page and the page on the right side in Print 
Preview is completely blank. 

Print Preuiew: Traueling Times P 1 S 1 [Page Uiew J ( Cancel ) 

Figure 7-1 36 The document o one page 
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,,. Click Cancel when you are finished. 

Although Print Preview offers limited document changes, it can help 
you determine how a document will look when it is printed. 

When you use Page View you can see a full-scale version of your 
document showing exactly how it will look when printed. And, unlike 
in Print Preview, you can edit and format text while in this view. 

~ -Y ~ -B "• Choose Hide 'I[ from the Edit menu, and then choose Page View 
from the Document menu. 

.. Scroll through your document to see a full-size view of how it will 
look when printed. 

~-B "• When you are finished, choose Page View again from the Document 
menu. 

Galley View is not located on any menu. If you are in Page View, a 
checkmark will be to the left of Page View in the Document menu. To 
get back to Galley View, ch oose Page View again, which removes the 
checkmark beside Page View and returns you to Galley View. 

~ -S/~ -P ,,. Save and print the completed newsletter. 

Compare it to the finished newsletter at the beginning of the project, 
and use the procedures that you learned in this project if changes are 
needed to make it resemble the sample newsletter. 

~ -Q ,,. When you are finished, choose Quit from the File menu, or close the 
newsletter document and choose New from the File menu to begin 
the next project. 

l(r:~j~ct' 5: Creating Merg~ Documents 

This project introduces you to one of the best time-saving features of 
Microsoft Word-print merge. You 'II create a print merge main document 
and data document that allow you to create multiple customized letters 
without having to type each one as a separate letter. 

Figure 7-13 7 on the following page shows the four collection letters you 
will create in this project. As you create the different components of this 
print merge project, you' ll be shown the final document at that point 
in the project. 
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I 
Rosenfelt Office Furniture -------....1---+------------. 

September I 0, 1993 

884 High View 
Danville, KY 4 

Ms. Sandra M. Hardin 
ICU Corporation 
497 Seemore Drive, Sui te 3 
Ashevi lle. NC 29703 

Dear Ms. Hardin: 

According to our records your firm has a 
of $2,950.00. You may have overlooked 
Please check your records and send payn 

If there is some reason that you have not 
please call us to discuss the problem. 

Thanks for your prompt attention to this 

Sincerely, 

Rosenfelt Office Furniture a 
884 High View I 
Danville, KY 4( 

September I 0, 1993 

Ms. Kay Kusunoki 
Kusunoki Printers 
13 17 Beech Place 
San Francisco, CA 941 13 

Dear Ms. Kusunoki: 

According to our records your firm has an 
of $ 150.00. You may have overlooked m 
Please check your records and send paym 

IF there is some reason that you have not 5 

please call us to discuss the problem. 

Thanks for your prompt attention to this n 

Sincerely, 

Steven King 
Credit Manager 

Rosenfelt Office Furniture and Supplies 
884 High View Plaza 
Danville, KY 40422 

September I 0, 1993 

Mr. Jim Bell 
Libraries R Us 
1492 Manuscript Dr. 
Mandarin, FL 49709 

Dear Mr. Bell: 

According to our records your firm has an outstanding balance of 
$ 15,500.05. You may have overlooked making this payment. 
Please check your records and send payment today. 

If there is some reason that you have not sent your payment, 
please call us to discuss the problem. 

Thanks for your prompt attention to this matter. 

Sincerely, 

Rosenfelt Office Furniture and Supplies 
884 High View Plaza 
Danville, KY 40422 

September I 0, 1993 

Ms. Faye L. Mauney 
In Your Prime Beauty Shop 
15 Mockingbird Lane 
Pinelog, TX 69007 

Dear Ms. Mauney: 

According to our records your firm has an outstanding balance 
of $950.2 1. You may have overlooked making this payment. 
Please check your records and send payment today. 

If there is some reason that you have not sent your payment, 
please call us to discuss the problem. 

Thanks for your prompt at ention to th is matter. 

Sincerely, 

Steven King 
Credit Manager 

Figure 7-137 The customized form letters 

311 



312 Part Ill: Word Processing 

CREATING A COLLECTION LETTER 

,1?)' '·· ·•. 

t···1io::wosoft '•,·i cwd 

~ -R 

- To begin the assignment, double-click on the Microsoft Word icon. 
If you are alread y in Word with no file open, choose New from the 
Fi le menu. 

Your screen will show a new document called "Untitledl". 

-
-

From the r:ont menu choose Times 12 point if you'll be printing to 
a LaserWriterorNewYork 12 point if you' ll be using an Image Writer. 

Choose Show Ruler from the Format menu. 

You' ll begin the letter by typing the letterhead information on the first 
three lines. 

,. Type Rosenfelt Office Furniture and Supplies on the first line, and 
then press Return. 

• Type 884 High View Plaza on the second line, and then press 
Return. 

• Type Danville, KY 40422 on the third line, and then press Return 
three times to place two blank lines after the letterhead. 

The letterhead should be centered and bold, and the first line will have 
a larger point size. You'll make those formatting changes now. 

,. Select Lhe three lines you just typed by dragging down the selection 
bar to the left of the text, as shown in Figure 7-138. 

Figure 7-138 Selecting the text in the letterhead 

~ -S hi ft-C • Click on the center alignment ico n on the ruler to center the selected 
lines. 
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3€ -Shift-B 
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• 
• 

Choose Bold from the Forma( menu to bold face the selected lines. 

Select the first line of the lette rhead, and choose 14 point from the 
Font menu. 

This makes the first line of the letterhead larger than the address lines. 

Aft er you've made these formatting changes, your letterhead should 
look like the one shown in Figure 7-139, which was typed using Times. 

r ti File Edit Format Font Document Ut llllle$ Window 

10 Unlllledl 01 
12 14 15 

!Normal IIQ) D t :t t . I l!f: l S ~~ 1•1 1&11 1- 1 I 1 l!l::al t::1 """ 

Page 1 

Roseofelt Office Furniture and Supplies 
884 High v~ ... Plaza 
Du~, 1CY 40422 

INormoi 

Figure 7-139 The fo rmatted letterhead lines 

Now you will save this document and name it. 

3€ -S • Choose Save from the File menu. 

• In the resulting Save dialog box, click the Drive button, if necessary, 
to ensure that the document is saved on your data disk. Name this 
document Main Collection Letter, and then click the Save button . 

W- y • Before continuing with the rest of the letter, choose Show 'II from 
the Edit m enu. 

The formatting characters shown in Show 9l will allow you to keep track 
of the number of blank lines between several of the paragraphs and will 
be of use throughout the rest of the pro ject. 

• Click to the left of the last paragraph mark in the document to set 
the insertion point there, and then type today's date. 

• Press Return four times after typing the date to place three blank 
lines afte r it, as shown in Figure 7-140. 
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r • File Edit Format Font Docume nt Utilities Window 

qr 
qr 

Rosenfelt.Office.Furniture.and.Supplies<lf 
884.High. Viev.Pla.za<lf 
Danville , . K.Y . .40422<!1 

September. tO ,.1993<!1 
qr 
qr 
qr 
fll 

Figure 7-140 The date and three b lank lines after it 

• Next type the first line o f the address at the insertio n point: 

Ms. Vicki Fitzgera ld 

' 
·: : 

il 
:: 

.., 

• Press Return after th at line, and then type the remaini ng li nes of the 
address, pressing Re turn after each li ne: 

lXI Corporation 
3211 Dow Street, E. 
DuPont, MI 53022 

• After typing the Zip code, press Return twice to get a blank line, and 
then type: 

Dear Ms. Fitzgerald: 

• Press Return twice to get a blank line after the salutation. 

In various projects in this chapter you used the space-after-paragraph 
icon on the ruler to place spaces between pa ragraphs. Sometimes it is 
just as easy to press th e Return key to place a blank line after a paragraph, 
especia lly when some paragraphs will be followed by more than one 
blank line. 

• Type the first paragraph of the letter: 

According to our records your firm has an ou tstanding balance o f 
$1,722.00. You may have overlooked maki ng this payment. Please 
check your records and send payment today. 

Con tinue typing the rest of the letter. Press the Return key twice at the 
end of each paragraph to leave a blank line between paragraphs. After 
typing Sincerely, press Return four times to leave three blank lines 
before typing Steven King. 

• Type the following to fi nish the letter: 

If there is some reason that you have not sent your payment, please 
call us to discuss the problem. 
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Thanks for your prompt attention to this matter. 

Sincerely, 

Steven King 
Credit Manager 

Now is a good time to save your work. 

• Choose Save from the File menu. 

315 

The rest of your document should look like the one shown in Figure 7-141. 

,. • File Edit Format Font Document Utilities Window 

0 
10 11 

<jJ 
Deu Ms .. Fitzgereld :<JI 
<jJ 

Main Collection Letter 
2 3 4 5 

According. to. our. records. your. finn. has. an, outs1anding. balance. of. $1 , 722.00 ... You may. 
have. overlooked. malting.1hi3. payment. .. Please. check. )'"'ur. records.and. send. payment 
today.<ll 
<ll 
If. there.is.some.reason.thet youhave.notsent )'"'ur. payment,. please. call us. to. discuss. the. 
problem.<ll 
<ll 
Thanks. for. your. prompt attention.to.lhis.matter. <JI 
<ll 
Sincerely,<JI 
<ll 
<ll 
<jJ 
Steven.King<ll 
Credit Manager<ll 

Page 1 !Normal 101 

Figure 7-141 The rest of the document 

., 

er 
:6 • 

You just created a collection letter that you could use as a template to 
then change and send to many people. To send it to a different 
company, you would first use the Save As command to save this letter 
under a different name, so you do not alter the o riginal. You could then 
modify the letter by typing in a new company name, address, salutation , 
and amount due. You would follow this procedure for each letter you 
had to send and print each letter separately. 

The above procedure would not be too tedious or time consuming if you 
had only a few letters to mail. But what if you had to do this with 75 
letters on a monthly basis? Wo~ld you want to volunteer for the job of 
modi fy ing each letter manually. Not only would the project take quite 
a bit of time, but also the letters ould t ake up a lot of disk storage space. 
Fortunately, Microsoft Word allows you to create customized letters 
using its print merge feature. I 

The concept of print merge is simple: You create a main document that 
contains the body of your letter, and you use special fields to mark the 

I 
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parts that will change with each letter. You also create a data document 
that contains the info rmation you want placed in the special fields in 
the main document. When you issue the Print Merge command, the 
information from the data fi le is merged with the main document 
to create customized form letters. This concept is illustrated in 
Figure 7-142. 

Main document 
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Figure 7-142 The print merge concept 
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I 
PLANNING THE MERGE PROJECli 

Defining the Steps 

A print merge project requires some planning before you can actua lly 
create the documents. Let's discuss some o f those considerations. 

There are two key parts to every merge pro ject: the main document and 
the data document. The main document contains the body of the form 
letter. The data document contains the names, addresses, and other 
data that will be merged with the main document to create the 
customized form letters. 

The Data Document 

The concept o f a data file is basic to all computer applications. A fi le 
consists of related records. In the fi le illustrated in Figure 7-143, the 
records are related because each record contains data about student 
grades. The fi le consists of student grade records. 

A record consists of rela ted fields, o r items. The fields shown in fi gure 
7-143 are related because they each contain information, or data, 
pertain ing to one particular student. The individual fi elds that make up 
the student records are the name, course, and grade. 

name course grade 

John Jones Anthropology 20 I B 

Fi le Mary Smith Calculus 30 I c + Record 

Bob Doe Biology 204 A 

Sue Greene Chemistry I 0 I B 

+ Field 

Figure 7-143 The fi le/record/ fi eld relationship 

The gro up of fi elds to be used in one letter is refe rred to as a record. Yo ur 
data document contains a record for each letter to be sent; therefore, if 
you' re sending 20 customized lette rs, your data document will contain 
20 records. 

In this project you will crea te a data document in Microsoft Word. In 
some prin t merge projects you may use an existing data file for your data 
document, in which case you will not have to create one. Data 
documents, o r databases, can be created in Excel, Microsoft Word, 
FileMaker, and many other app lications. 
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Defining Fields 

Part III: Word Processing 

If the data file does not a lready exist, you do not have to create it before 
you create the main documen t. However, creating the data document 
first can be helpful, because you will already have establi shed the field 
names in the data file, and you'll know to use those same field names 
in the main document. 

The Main Document 

The main document, at the very least, contains the following: 

• The text and layout of the form letter that will not change from one 
letter to the nex t 

• The merge fields, the contents of which will change from letter to 
letter 

• The statement that tells Microsoft Word the name of the data 
document to use when merging with the main document 

In addition to the above parts of the main document, you can have 
many commands and instructions embedded in the main document. 
You' ll learn more abou t these later in th is pro ject. 

In this project you wi ll be modifyi ng the collection letter that you just 
created to use as the main document for the print merge. You won't 
have to retype the parts of the letter that will not change from one letter 
to the next. 

The Print Merge Command 

After the data document and the main document are completed , you 
issue the Print Merge command by choosing Print Merge from the fi le 
menu. 

This command tells Microsoft Word to duplicate the text o f the ma in 
document and to sequen tially insert data from each record in the data 
document in the special merge fields in the main document. A separate 
letter is created for each record in the data document. 

When you create the documents for the print merge, you need to 
consider the field names to be used. The field names in the file 
illustrated in Figure 7-143 are name, course, and grade. The fi eld names 
are representative of the actual data in each field-the name field 
contains th e student's name, the course field contains the name of the 
course, and the grade field contains the student's grade. ft is always a 
good idea to define a fi eld with a meaningful name that accurately 
represents the fi eld 's contents. The field names "field 1" and "55" do not 
accurately define the contents of a field. 

With that in mind, keep the names as short and simple as possible. Use 
either all uppercase or all lowercase letters so you don't have to worry 
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about whether you capitalized o ne and not another. If you use a field 
name that consists of two or mo re words, do not put spaces between the 
words. This is especially important if you are using a program other th an 
Microsoft Word to create the data file, because many applications do not 
all ow spaces embedded in fie ld names. 

You can determine the fi eld names first and then use them consistently 
in both the main document and the data document. Since you have 
alread y typed the main collection letter, you probably have an idea 
about which parts will change from one letter to the next and which 
parts will not change. 

The parts of the letter that will change are called merge fields. A merge 
fi eld acts as a placeholder in the main document- it marks the slot 
where the contents of a fi eld from the data document will be inserted. 
The contents of the merge fields will change with each new letter that 
is created in the print merge process. 

Let's define the field names you' ll be using in th is project before you use 
them in both the main document and the data document. 

• Look at the main collection letter you just typed, the first part of 
which is shown in Figure 7-144. 

' • File Edit Forma t Font Documen t Utilities Window 

j(] Moln Collection Letter E!]; 
I 13 14 

~ ~ 

IHorrml ~~ 0 t :t t . I H toet~tl:lt Iiiii t=l t=l £31::::1 ..... 
Rosenfelt Office Furniture lllld Supplies 

884 Hlch VieY PJua 
Dan rille, ICY 40422 

Seplember 10, 1993 

I 
i 

M•. Vickll'i""erold ;:. 
IX! Corpon>.oon ~· 
3211 Dov Street, 1!. ;.: 
DuPont, Ml 53022 

Dear Mo. l'i""erold: 

Accordlne oounoconl• :,our!inn w IIJI Out:!lalldln& bal.m:eo!$1 ,722.00. You may 
bavt ovttloot.td ~this payment. Pteeoe cbeclt :,ourrocon\5 ml ,.n4 payment 0 

;l'llge I jNorm B IQI '"· It;; 

Figure 7-144 The first part of the main collection letter 

It is likely that the date will change if you send these collection letters 
ou t each month, so th at will be the first field to name. Let's call it "date". 

The customer name is sure to change also. Although you may be 
tempted to group the entire name under o ne field name, notice that the 
letter uses just the title and last name in the greeting, "Dear Ms. 
Fitzgerald:". In such a case, you need to be able to use each part of the 
name as a separate field. Let's call the fields in th e name "title", 
"firstname", and "lastn ame". 
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The name of the company will be di fferent for each letter also. Let's call 
that fi eld "companyname". 

Si nce the address will change fro m letter to letter, let's call the address 
fie ld "address" . In some cases, you may have an address that req uires 
two lines, such as a street address o n o ne li ne and a post office box o n 
another. In that case, you wou ld break the address name field into two 
parts, such as "address l " and "address2". For this project, the address 
will require only one line, so "address" is sufficient. 

You sho uld also break the city, state, and Zip code into separate field 
names, since most mailings will probably be sorted by one of those fi elds 
before be ing taken to the post office. Even though the data docu men t 
that you create for the purposes of th is pro ject will be small, it will show 
you th e correct procedure to fo llow for any size mailing. Let's name 
those fi elds "city", "state", and "zip". 

In the greeting you ' ll print the same "t it le" and "lastname" fields that 
you use in the address portion of the letter. You do not have to give 
another occurrence of those fie lds a different name. 

The first sentence of the body of the letter states a specific amount owed. 
This will also change from letter to letter, so let's call that field 
"amount". The rest of the letter will not change from one letter to the 
next in the print merge process. 

You just determined the field names you' ll be using in the print merge 
docum ents. They are: 

date 

title 

firstname 

lastname 

companyname 

address 

city 

state 

zip 

amount 

You' ll use them in a minute when you c rea te the main document. The 
completed main document wil l look like th e one shown in Figure 7-145 
on the next page. 
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Rosenfelt Office Furniture and Supplies 
884 High View Plaza 
Danville, KY 40422 

«DATA COLLECTION LETTER DATA» 
<<SET date=?Piease enter today' s date:» 
«date» 

«title» «firstname>> <<lastname» 
<<company name>> 
<<address» 
<<City». <<State>> <<Zip>> 

Dear «title>> <dastname>>: 

According to our records your finn has an outstanding balance of S><<amount». You may 
have overlooked making this payment. Please check your records and send payment 
today. 

If there is some reason that you have not sent your payment, please call us to discuss the 
problem. 

Thanks for your prompt attention to this matter. 

Sincerely, 

Steven King 
Credit Manager 

Figure 7-145 The print merg main document 
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CREATING THE MAIN DOCUMENT 
In addition to add ing merge fields to the main document, you will be 
using two sets of instructio ns in this pro ject to tell Microsoft Word to do 
som ething other than just merge data. Merge fields and special 
instructions must be enclosed within special characters to have Word 
recognize them. These special characters, called chevrons, are « and >> . 

These are not sets o f two less-th an and greater-than signs, but characters 
that you ty pe using a particu lar sequence of keys. 

Option-\ • To type the<<, hold down the Option key and type a backslash (\). 

Sh ift-Optio n-\ • To type t he », hold down the Shift and Opt ion keys and type a 
backslash (\) . 

The DATA Instruction 

The first instruction to be placed in this letter is the DATA instructio n. 
The DATA instruction tells Word the name o f th e data documen t to be 
merged with the main document to create the customized letters. The 
DATA instructio n must come before any other instruction or merge field 
in the main documen t, and it is usually the first line of the form letter. 
You' ll insert the DATA instruction now. 

Option-\ • Click to the left o f the date and press Return to create a blank line 
above the date. Click on that blan k line, and then hold down the 
Optio n key and ty pe a backslash (\) to create the << character. 

Shift-Option-\ • Type DATA COLLECTION LEITER DATA (be sure to use all caps), 
and then press Sh ift-Optio n-backslash (\) to create the » cha racter. 
See Figu re 7-146. 

r- • File Edit Format Font Document Utilities Window 

qr 

Rosenfelt.Office.Furniture.and.Supplies<ll 
884.High . Viev.Plaza<ll 
Danville ,.:ra .. 404ZZ<ll 

qr 
<DATACOLLECTION.LETTER. DATA><ll 
September. tO ,. 1993<ll 
qr 
qr 
qr 
Ms .. Vicki. Fitzgerald<ll 
IXI.Corporation<ll 
32tt.Dow.Stteet,. E.<ll 
DuPont,. MI .. 53022<ll 
qr 
Dear.Ms .. Fitzgerald:<ll 
qr 

Figure 7-146 The DATA instruction 

., 
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The SET Instruction 

323 

The DATA statement that you just typed tells Microsoft Word that the 
data document to merge with this main document is called COLLECTION 
LETTER DATA. See Figure 7-147. 

DATA instruction 
I 

«DATA COLLECTION LETTER DATA» 

name of data document 

Figure 7-147 The parts of the DATA instruction 

The next instruction to be placed in this letter is the SET instruction. 
This allows you to enter the value of a field interactively for each page. 
The SET instruction is used when the data in the field is likely to change 
each time you print merge the document. 

You'll use the SET instruction instead of typing the date in the main 
document. The SET instruction must include the word "SET" followed 
by the name of the field you would like to set. Following the field name, 
you type an equal sign (=) and either a value to be assigned to the field 
or a prompt for Microsoft Word to use when asking you what value to 
assign to the field. If typing a prompt, you precede it with a question 
mark (?) to indicate that it is a p rompt. 

• Click in the selection bar to the left of the date to select that line. 

You'll replace this line with the SET instruction for the date. 

Opt ion-\ • Press the Option-backslash (\) to get the special character << , and 
then type the following: 

SET date=?Please enter today's date: 

Shift-Option-\ • Follow that with the » character, which you get by pressing Shift
Option-backslash (\). 

The SET instructio n that you just typed tells Microsoft Word to prompt 
you for the data to be inserted into the date fie ld each time you execute 
the print merge. The prompt "Please enter today's date:" will appear on 
the screen after you issue the Prin t Merge command. The date that you 
type at that prompt will be placed in the date field and will print 
wherever the merge field "date' appears in the main document. See 
Figure 7-148. 
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field name that receives the information typed at screen prompt 

~ 
«SET date=?Please enter today's date:» 

I 
SET instruction prompt that appears on the screen 

Figure 7-148 The parts of the SET instructio n 

Option-\ Sh ift-Option-\ • Press Return to go to the next line, and then on that line type the 
"date" field name, enclosed between the special characte rs: «date» 

Your screen should now look like the one shown in Figure 7-149. 

r 

qr 
qr 

File Edit Format Font Document Utilities Window 

Rosenfelt.Office.Furniture.and.Supplies<ll 
664.High. Viev.Plaza<ll 
Danvill.e, .K.Y .. 40422<li 

cDAT A. COLLECTION. LETTER DATA><!! 
cSET.de.te=?Ple85e.en1er.10de.y's.de.te::.<!l 
cde.te><!l 
qr 
qr 
qr 
Ms .. VickiFi1Zgerald<!l 
lXI. Corporation<!! 
3211.Dov. Street,. E.<!! 
DuPont,.Ivn .. s3022<!1 
qr 
Dear. Ms .. Fitzgerald :<!I 
qr 

Figure 7-149 The SET instruction 

3€ -S Now is a good time to save your work. 

• Choose Save from the File menu. 

., 

The DATA and SET instructions are just two of several instructions that 
Microsoft Word makes available in a print merge environment. The 
IF ... ELSE... ENDlf. instruction allows you to use conditional printing, which 
is the process of printing a field based on the conten ts of a particular 
field. The ASK instruction is similar to the SET instruction. It allows you 
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to enter a value at a particular ROint in the document in response to a 
screen prompt. The NEXT instrJction allows you to either skip a record 
in a data document o r print more than one record on one merge 
document. The INCLUDE instruction enables you to include the entire 
contents of another document in the form letter. For more informa tion 
on these advanced features, refer to Reference to Microsoft Word. 

Enclosing the Field Names 

Now you're ready to replace the name and address lines, the greeting, 
and the amount field in your letter with the merge fields. 

.. Click in the selection bar to the left of the first line to select Ms. Vicki 
Fitzgerald. 

Optio n- \ Shift-Optio n-\ • Type the following, using Option-backslash (\) to create « and 
Shift-Option-backslash (\) to create » : 

«title» «firstname» «lastname» 

Remember that the merge fields you are typing in the mai n document 
will be replaced with data from the data document. Be sure to use the 
appropriate spaces and punctuation between these merge fields, as 
though you were typing in the actual information. Using Show 91 helps 
you verify that you have left a space between the fie lds, as shown in 
figure 7-150. 

Figure 7-150 Leaving spaces between merge fields 

• Select the line lXI Corporation and replace it with «Companyname». 

• Select the line 3211 Dow Street, E. and replace it with «addresS>> . 

.. Select DuPont (but not the comma next to it) in the nex t line and 
replace it with «city». 

,. Select Ml in the same line and replace it with <<State». 

,,. Select the Zip code 53022 in the same line and replace it with <<Zip». 

~ -S • Choose Save from the File menu. 

Your document sho uld look like the one in Figure 7-151 when you' re 
finished with the above instructions. Notice the spaces between field 
names and the comma after <<city» are still intact. 
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r e5 File Edit Format Font Document Utilities Window 

<l! 

Rosenfelt.Office.Furniture.and.Supplies<l! 
884.High. Viev.PJ.aza<l! 
Danrille,.X:Y .. 40422<l! 

<l! 
c:DATACOLLECTION.LETTERDATA><l! 
c:SET.date=?Please.enter.10day's.date::.<l! 
«date:.<l! 
<l! 
<l! 
<l! 
c: title:..c:firstname:..c:l83tname»<ll 
c:companyname:.<l! 
c:address:.<l! 
c:city.) ,. <S1ll.1e) .. c:zip)<l! 
<l! 
Dear.Ms .. Pitzgerald:<l! 
<l! 

Figure 7-151 The merge fields in the address lines 

., 

Now you can see the main document taking shape and how the merge 
fi elds will be la id out on the page. 

The greeting line will contain the "title" and "lastname" fields that you 
used in the address line. The same merge field may be referred to as 
many times as you want in a form letter. It is important, however, to be 
consistent when typing a field name that you are using more than once 
in y6ur document. Each time the field name is used it must be typed 
exactly the same way, including uppercase and lowercase letters and 
spaces, commas, and other special characters. Copying and pasting a 
field name that you've used before rather than retyping it helps prevent 
errors. 

,,. Click on and drag through «title» in the first line of the address to 
select it. Be sure to include the chevrons. 

Double-clicking on a word selects a word, but it does not select the 
chevrons on either side of a merge field or the punctuation marks before 
or after a word. 

3€ -C • Choose Copy from the Edit menu to copy the selected text to the 
Clipboa rd. 

3€ -V • Click on and drag through Ms. (including the period) in the greeting 
line to select it, and then choose Paste from the Edit menu to paste 
the contents of the Clipboard over the selected text. 

3€ -C ,,. Copy the <dastname» field from the first line of the address by 
selecting it and choosing Copy from the Edit menu. 

3€-V • Select Fitzgerald in the greeting line (but not the colon after it) and 
choose Paste from the Edit menu to replace it with «lastname». 
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The last merge field to change i the amount field. 

,,. Select the 1,722.00 (but no the dollar sign before it and not the 
period after it) in the first pa agraph of the letter and replace it with 
«amount>> . See Figure 7-152. 

r e5 File Edit Format Font Document Utilities Window 
., 

~~~==~~_!~~~~~_j~~~=:_!~~~~~~~---- ii 
<II 
«DATA.COLLECTION.LETTERDATA><ll 
«SET.da1ll=?Piease.en1llr.10day's.da1ll::t<!l 
«da1e:t<!l 
<II 
<II 
<II 
«title:!>. «firstname:B>. «lastnamel><ll 
«companyname:~><!l 
«address:~> <!I 
«cityl> ,.cstabll> .. «zip:~> <!I 
<II 
Dear. «title:~>. clastnamel> :<II 
<II 
Acconling.10.our. reconls. your. finn. has. an.oul3tanding. balance. of. $cemount» ... You may. 
have.overlooked.lll8Jting. this. payment ... Please.dheck. your. reconls.and. send. payment 
10day.<!l 
<II 

Figure 7-152 The "amount" merge field 

The text fo rmats in the letter in this pro ject will not vary from one field 
to another. You can emphasize the contents of a particular merge field, 
however, by having it print bold or italic, in a larger font, or with some 
other characteristic. If you want to do this, the merge field in the main 
document must be formatted the way you want the information to look 
when printed. 

For example, suppose you wanted the amount to print in bo ld italics 
each time. You would select the merge fi eld <<amoun t>> and choose Bold 
and Italic from the Format menu. The m erge field itself would carry the 
formatting so that any info rmation from the data document that prints 
in place of the "amount" field on the page will also be bold and italic. 

The main document now contains all the merge fields and instructions 
needed to create the form letters. 

~ -S • Save this completed document now. 

The next step is to create the ata document. Your completed data 
document will look like the one hown in Figure 7-153 on the following 
page. 
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title firstrtame las tname companyname addJ:ess city state 
zip amount 

Ivis. Sandre I•I. Hal:din ICU CoJ:porntion 497 Seemore Drtve, Suite 3 
.<>.sheville NC 29703 2,950 .00 

IviL Jim Bell Libl:artes R Us 1492 Nanuscrtpt DL I'llartdartn FL 
49709 15 ,500.05 

I•Is. Fay-e L. I•Iauney In Your Prtr.ne Beauty Shop 15 IviockingbM Lane 
Pinelog TX 69007 950.21 

I•Is . Kay K usunoki K usunoki Prtntel:S 131 7 Beech Place San FJ:aneisco 
CA 94113 150.00 

Figure 7-153 The print merge data document 



Chapter 7: Microsoft Word 329 

CREATING THE DATA DOCUMEN 

You'll need to open a new doc ment that you 'll use to create the data 
document, the one that Microsoft Word will use to get the information 
it needs to create each of the customized form letters. 

3€ -N • Choose New from the Fi le menu to open a new, un tit led documen t. 

• From the Font menu choose Times 12 point if you 're using a 
LaserWriter or New York 12 point if you're using an Image Wri ter. 

The data document consists of data records, which hold the text that is 
placed in each of the customized form letters. In thi s case, you will have 
one data record for each form letter you want to print. 

Each data record is separated by a Return. It is important when typing 
each data record not to press Return until the entire record is entered. 

Typing in the Header Record 

The first record in the data document is the header record. This specia l 
record lists the fields in the order in which they appear in the other 
records, using the exact field names you used in the main documen t. 
Each of the field names in the header record can be separated with a 
comma or a tab character. The comma o r tab character acts as a field 
delimiter, which indicates where one field ends and the next begins. The 
other records following the header record contain the data, and each of 
those fie lds within each record are a lso separated with either a com ma 
or a tab character, the same as was used to separate the fields in the 
header record. If you use commas to separate the fields, fi elds that 
contain commas in the data must be surrounded by quota tion marks. 

Let 's enter the header record now. 

• In the new untitled document that you just opened, type the 
following fi eld names. Press the Tab key where indicated. 

title (press Tab) firstname (press Tab) lastname (press Tab) 
companyname (press Tab) address (press Tab) city (press Tab) state 
(press Tab) zip (press Tab) amount 

• Do not press Return until afte r you have finished typing the word 
am ount. 

The header record you just typed contains the same field names as in the 
main document, spelled exactly the same way. Your header record 
should look like the one show1 in Figure 7-154 . 



330 Part Ill: Word Processing 

r • File Edit Format Font Document Utilities Window 

:::o Untitled2 
0 12 13 14 J5 :6 • 
~ .. 
!Normal I@ D t ;t t. I 91=1 1~11=1 ij;) I Il-l iml-1 lw1 

title+ firstname+ wmame+ companyname + addre33+ city+ 31ate 
+ zip+ amount<l! 
t'll 

Page 1 !Normal _IQ_I 

Figure 7-154 The header record 

When you pressed the Return key after the word "amount" in your 
header record, that indicated to Microsoft Word that those were all the 
fields in the header record, and it placed the insertion point on the next 
line. That is where you' ll begin your first data record. 

Before you enter the data records, you need to save this document. It 
is important that it be saved under the same name as you told Microsoft 
Word in your DATA instruction in the main document. Figure 7-155 
shows the DATA statement used in the main collection letter. 

DATA instruction 

,_..L_ 
«DATA COLLECTION LETTER DATA» 

name of data document 

Figure 7-155 The data document name in the DATA statement 

:3€ -S ... Choose Save from the File menu. 

• In the dialog box that appears, verify that you are saving this 
document on your data disk. Beneath Save Current Document as, 
type in the name exactly as you had it in the DATA statement in the 
main document, in this case COLLECTION LEITER DATA (in all 
caps). See Figure 7-156. 

Be sure you don't type any leading o r trailing spaces when you type the 
fil ename. 

• Click Save to save the file to your disk. 
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I !g) C11rolyn Phillips I 

Soue Current Document 11s: 

I COLLECT! ON LETIER DRTR 

0 fllS1 \lliJI~ 0 MllkP llllCkllll 

[File Fonn11t ... ) Normol 

~ Corolyn Phillips 
7S3K IIUIIilllble 

( S11ue .,J ~ 

~~ 

Figure 7-156 Saving the data file 
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Entering the Data Records 

• Type the following, pressing the Tab key where indicated by (Tab). 
Press Return only after you have typed the entire data record (after 
the number 2,950): 

Ms. (Tab) Sandra M. (Tab) Hardin (Tab) 
ICU Corporation (Tab) 
497 Seemore Drive, Suite 3 (Tab) 
Asheville (Tab) NC (Tab) 29703 (Tab) 
2,950.00 

Your screen should look like the one shown in Figure 7-157. 

,. a File Edit Format Font Document Utilities Window 

Untitled2 
3 4 

city+ stale title+ fir.nname + lastname + compan}'ll8l'lle + 
+ zip+ amount<lf 
Ms.+ Sex\dre.M. + Hanlin+ ICU.Coxporation+ 
+ A3heville+ NC+ 29703ote,950.00<ll 

497Seemore.Drive ,. Sui1e.3 

qr 

Page 1 Normal 

Figure 7-157 The first data record 

., 

• Now type in the next three data records, pressing the Tab key where 
indicated by (Tab). Press Return only where indicated: 

Mr. (Tab) Jim (Tab) Bell (Tab) Libraries R Us (Tab) 
1492 Manuscript Dr. (Tab) Mandarin (Tab) FL (Tab) 49709 
(Tab)15,500.05 (press Return) 
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Ms. (Tab) Faye L. (Tab) Mauney (Tab) 
In Your Prime Beauty Shop (Tab) 
15 Mockingbird Lane (Tab) Pinelog (Tab) TX (Tab) 69007 
(Tab) 950.21 (press Return) 

Ms. (Tab) Kay (Tab) Kusunoki (Tab) Kusunoki Printers (Tab) 
1317 Beech Place (Tab) San Francisco (Tab) CA (Tab) 94113 (Tab) 
150.00 

Figure 7-158 shows the completed data file . 

.. • File Edi t Form at Fo nt Document Utilit ies Window 
., 

-o Untitled2 0= 
_10 I 2 13 4 _15 !6 • __l_ ~ i.} 

!Normal ~IQ) 0 1' :t 1'. I !ell 1~1 1::=1 1:=1 Iii) I- I I- I iml-1 !.1.1 

title+ fmnname+ lastname+ companyname + address+ city+ Slate 
+ zip+ amount<!! 
Ms.+ Sandre.M. + Hanl.in+ !CU. Corporation+ 497. Seemore. Drive,. Suite.3 
+ l>.sheville + NC + 29703+2,9SO.OOGI 
Mr.+ Jim+ Bell+ Libraries. R. Us+ 1492.ManuscriptDr. +Mandarin+ FL 
+ 49709+15,SOO.OSGI 
Ms.+ Faye.L. + l-iauney+ In. Your.Prime.Beauty. Shop+ IS. Mockingbird. Lane 
+ Pinebg+ TX+ 69007-.950.21 qr 
Ms.+ Kay+ Kusunoki+ Kusunoki Printers+ 13!7.Beech.Piace+ San. Francisco 
+ CA+ 94113+150.00GI -

Page 1 !Normal IQ I I 0 121 

Figure 7-158 Data file after entering all data records 

:3€ -S • Choose Save from the File menu to save the completed data 
document. 

RUNNING THE MERGE 

To merge the main document with the data document, the main 
document must be active on your screen. 

·• Select Main Collection Letter from the Window menu. 

This will activate that document and bring it to the front. 

The main document is the only one that must be open when you issue 
the Print Merge command. The data document that you just created is 
still open, however. Leave it open in case you need to make any changes 
to it. 

• Choose Prin t Merge from the File menu. 

The dialog box that results gives you a choice of printing the resulting 
documents immediately o r merging them to create a new document on 
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your disk. If you choose New D cument, you can view and modify the 
letters before sending them to he p ri nter. This is probably the best 
choice, especially when merging a large number of records to create a 
large number of letters, but you must have enough free space on the disk 
to hold the new document. 

When you' re printing on an AppleTalk network, if you merge to the 
printer instead of to a n ew document, other print jobs can come 
between your letters because eac~ letter is viewed as a d ifferent print job. 
Merging to a new document creates only one print job when you print 
the form letters. 

,,. Click New Document in the Print Merge dialog box, as shown in 
figure 7-159. 

Print M erge 

Merge Records: ® Rll 0 From: L::=J To: c=J 
n Print l) I New Document I [Cancel ) 

Figure 7-159 Print Me rge dialog box 

You should now see a prompt asking you to enter today's date, like the 
one shown in Figure 7-160. 

Please enter today·s date: eEl 
(Stop Merge) 

Figure 7-160 The date prom pt 

This prompt is the result of t he SET instruction that you placed in the 
main document. 

,. Type in today's date, and t hen click OK, as shown in Figure 7-161. 

Please enter to day's dat e: c;EJ 
(~top Merge) 

I Sept ember I D, 1993 

Figure 7-161 The date entered ·n the date dialog box 

When you to ld Microsoft Word to create a new document, it created 
you r merge letters and named th~m Form Letters!. This is what you'll 
be viewing after t he merge comp etes. See Figure 7-162 (which shows 
the screen with Show ~ off) . 
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' a File Edit Format Font Document Utilities Window 

Form Letters 1 
4 

Rosenfelt Office Furniture and Supplies 
664 High Viev Plaza 

Stp~ember 10, 1993 

Ms. Sandra M. Hordm 
ICU ColjiOration 
497 Stemore Drive, Suno 3 
A>hoVllle, NC 29703 

Dear Ms. Hord!n: 

PI Sl 

Dan'7ille, ltY 40422 

(Normal 

Figure 7-162 The merged documents 
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All the form letters are created in one file. As you scroll through the 
docum ent, you' ll see each letter separated by a section marker. In thi s 
case there are 4 letters in the document call ed Form Lette rsl , because 
you had 4 records in the data document. If you create a data document 
with 100 records, you would have 100 form letters in your Form Letters! 
documen t. 

.. Scro ll through the letters to be sure there are no errors. 

3€ -S .. Since it is always a good idea to save your work before printing, save 
your form letters after you verify that they are correct. 

3€ -P • Choose Print from the File menu to print all the customized 
collecti on letters. 

If you r letters did not merge properly, you can probably track down the 
reason. The following are some potential error messages and the ir 
causes. Each time you correct an error and re-run the print merge, 
Microsoft Word names the resulting fo rm letters document sequentially. 
The first time you run the print merge, the letters are called Form 
Lettersl. If you run the merge again, the resulting documen t will be 
ca ll ed Form Le tters2, and so on. After you correct the errors, close the 
corresponding Form Letters document without saving it before running 
the print merge aga in. This wil l keep you from accumulating and 
becoming confused by d ifferent versions of the form letters. 

If you get an error message that says "Missing comma or tab in data 
record": 

• You may have p ressed Return whi le still in the midd le of a data 
record when you entered the data in your d ata document (which 
you saved as COLLECTION LETTER DATA). You will have the 
o ption to click either OK or Help to th is error message. Click either 
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o ption and, when fini shed, th e COLLECTION LETTER DATA 
containing your merge records will be shown o n the screen with the 
record in question h ighlighted. Turn on Show~, if necessa ry, to 
proofread this document for extra spaces, hard returns, or missing 
fi eld delimiters (commas or tabs) . Correct any mistakes and try to 
merge the documents again . 

There is an easy way to verify that the records in your data document 
have th e correct number of fields, are fo ll owed by a hard return, and 
con ta in delimiters in the proper pos itions. You select the who le 
document (Command-Option-M) and then place left-aligned tab sto ps 
o n the ruler to format the data in neat columns and rows. You'll 
probably have to extend the right margin on the ruler to 10 o r 11 inches 
to allow one complete record to fit on o ne line, but you won't be 
printing the data document anyway. Having the data in columns with 
the fields in the header record fo rming th e column names lets you see 
a t a glance if you have a problem in the data. 

If you get an error message that says "Data reco rd too long": 

• Yo u may have one quote missing, or you may have failed to enclose 
within quo tation marks data that conta ined a comma in your merge 
document. This is a problem on ly if you used commas instead of 
tabs as field delimiters in your data records. You will have the o ptio n 
to click either OK or Help to thi s error message. The COLLECTION 
LETTER OAT A containing your merge records will be shown o n the 
screen , and the reco rd in questio n will be highlighted. Correct th e 
error in the record and try again . 

• Yo u specified in your header record that you would have n ine data 
fie lds, and these were separated by e ight tabs. You should always 
have o ne delimiter less than the number of fields. Extra delimiters 
will result in a "Data record too long" error message, and you will 
have the option to click eithe r OK or Help. Whichever opti on you 
choose, eventually t he COLLECTION LETTER DATA containing 
your merge records will be shown on the screen, and the record in 
questio n will be highlighted . Correct the record so it has the right 
number of delimiters (tabs o r commas) and try again. 

If you get an e rror message tha t says "Un known field name": 

• A fie ld name that you used in your main document was not spe ll ed 
the same way (this includes )punctua ti o n, spacing, and uppercase 
and lowercase characte rs) ~s in the header record in your data 
document. The field name if questi on will be high lighted o n your 
Main Collectio n Letter doc~ment, and you'll be presented with a 
dia log box giving you the o ptio n to continue, stop merge, o r get 
help. Regardless of the opti:f you choose, you will need to correct 
the highlighted field name in the main document so it is exactly like 
the field in th e header recori:t in the CO LLECTION LET fER DATA 
document . Then try again. 
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If you get a dialog box asking you to locate a particular document name: 

• Microsoft Word cannot locate the document you h ave specified in 
your DATA statement. This generally means that you d id not create 
your data document using the same name as you indicated in the 
DATA statement or that the document is in a different fo lder and/ 
or a d ifferent drive. This document name must be exactly the same, 
including leading and trailing spaces. 

The printed output of this project consist s of four letters. Be sure to 
compare them with the completed versions in Figure 7-137 at the 
beginning of the pro ject and make any necessary ch anges. 

:3€ -Q ,,. Choose Quit from the File menu to exit Microsoft Word and return 
to the desktop. If you intend to continue with the additi onal 
projects, close the current files but don't quit Word . 

SUMMARY 
• Microsoft Word uses five formatting domains: the character, paragraph, table, section, and 

document. The character and the paragraph are the basic formatting un its in Microsoft 
Word. 

• The character, t he smallest unit in a Word document, includes letters of the alphabet, 
punctuation marks, numbers, and symbols. Font type and size, underlining, character styles 
such as bold and italics, and spacing between characters are examples of different character 
formats. Different characters within a single paragraph can have different character 
formatting attributes. 

• A paragraph is a collection of characters that is followed by a hard return. Paragraph 
formatt ing, such as line spacing, tab settings, text alignment, inden tations, paragraph 
spacing, and paragraph borders, affect the en tire paragraph that con tains the insertion point. 
The ruler is used to format paragraphs, and ruler settings can be d ifferent for each paragraph. 

• A table consists of rows and columns of cells, and each cell can contain characters and 
paragraphs that have different formatting characteristics. 

• A section consists of one or more paragraphs and is followed by a section marker. Each 
section in a document can be forma tted differently, and each document contains a t least one 
section. Section formatting is controlled by the Section command, which controls the 
number of columns in a section, where the section should start, the page number the section 
should begin with, and whether each section should have a different heade r and foo ter. 

• The document itself is the largest formatting unit in Microsoft Word. Some examples of 
document formatting are page margins and printing preparation. If multiple documen ts are 
open at the same time, only one can be active at a time. 

• Graphics can be created in a graphics application and incorporated into a Microsoft Word 
document. Text and graphics can be selected and then moved, copied, or deleted from a 
document. 
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• A style is a set of formatting characteristics to which a name has been assigned. Once a style 
is defined, it can be applied to a paragraph or a series of paragraphs to quickly and consistently 
change the appearance of the text. A group of styles attached to a document is called a style 
sheet. 

• A header is text and/or graphics that appear at the top of every page of a document. A footer 
is similar to a header, except that it prints at the bottom of every page of a document. A header 
or footer can also contain an automatic date and time stamp and a page number. 

• The print merge feature of Microsoft Word allows you to create customized form letters by 
merging records from a data document with the unchanging body text of a main document. 

KEY TERMS 
active window 
automatic page break 
automatic styles 

block quote 
borders 

cell 
center tab 
character 
chevrons 
clip art 
Cli pboard 
conditional printing 

data document 
decimal-aligned tab 
delimiters 
desktop publishing 
document 
dot leaders 
drawing tool 
drop-down list 

end-of-cell marker 
end-of-row marker 
extended keyboard 

field 
first-line indent 
First Page Special 
flush left 
flush right 
font 
foote r 

Galley View 

hanging indent 
header 
header record 

!-beam pointer 
indentation controls 
insertion point 

justification, justified text 

left-aligned tab 
left indent 
line spacing, vertical spacing 

main document 
manual page break 
merge fi elds 
monospace fonts 

new-line command 

orphan 

I page scale 
Page View 
paginate 
paragraph 
parag aph-spacing settings 
point size 
print merge 
Print rreview 
proportional fonts 
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record 
right-aligned tab 
right indent 
ruler 

scale tool 
section 
section break marker, section 

marker, section break 
select 
selection bar 
soft return 
spelling checker 

style name, style 
style sheet 

tab leaders 
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tab settings, tab stops 
table 
table scale 
tables feature 
text alignment, alignment 

widow 
wiping through text 

MICROSOFT WORD COMMAND KEYS AND 
SHORTCUTS 
File Menu Font Menu 
New 3€-N Smaller point size a€ -Shift-< 
Open 3€-0 Larger point size a€ -Shift-> 
Close a€ -W 
Save a€ -S Document Menu 
Print Preview a€ -1 Page View a€ -B 
Print a€ -P Insert Page Break Shift-Enter 
Quit 3€-Q Insert Section Break :!€ -Enter 

Edit Menu Utilities Menu 
Undo a€ -Z Find a€ -F 
Cut 3€-X Change 3€-H 
Copy 3€-C Spelling a€ -L 
Paste 3€-V 
Show/Hide~ a€-y In Speller: 

Suggest Word a€ -S 
Format Menu No Change 3€-N 
Show/Hide Ruler a€ -R 
Character 3€-D 
Paragraph 3€-M 
Define Styles 3€-T 
Bold 3€ -Shift-B 
Italics 3€ -Shift-1 
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Ruler Commands 
Left-align text 3€ -Shift-L 
Center text 3€ -Shift-C 
justify text 3€ -Shift-] 
Right-align text 3€ -Shift-R 
Space After~ 3€ -Shift-0 

General Co 1mands 
Cancel prinhng 
types •< 

types » 
Select entire document 
Accept the default, 

or the more heavily 
outlined button in a 
dialog box 

3€ -. 
Option-\ 
Shift-Option-\ 
3€ -Option-M 

Return or 
Enter 
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ADDITIONAL PROJECTS 
The following projects are accompanied by briefer instructions than 
those you have previously completed in this chapter. If necessary, refer 
to the previous projects in this chapter for information and step-by-step 
instructions for any command that you don't remember how to use. 
Also, Microsoft Word's Help text contains valuable and easily accessed 
information. You will not be reminded to save your work-by now you 
should be thinking of that without having to be reminded. 

Project 6: Creating a Report with Footnotes 

In this project you'll create a report that has a different header for the 
first page than for the rest of tl)e document. Project 4 of this chapter 
introduced you to headers and footers. You'll also learn about adding 
footnotes to your document. T7e final output of Project 6 is shown on 
the next two pages in Figures 7-163 and 7-164. 
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Kenyon Chekelele 
Artl OI 

February 7, 1993 

The Classical Ideal in Greek Sculpture and Architecture 

The classical period of Greek architecture and sculpture began around 480 B.C. The 
artwork of this period reflected the Greek infatuation with the concept of perfection 
and wholeness, that of the ideal This classical ideal was represented by a striving 
toward internal consistency and organic unity as a means to bring form out of the 
chaos of nature. Balance and grace were the resul ts. 

Architecture 

The temples of this period were designed as idealized dwelling places for perfect 
beings and were built using the Doric, Tonic, and Corinthian architectural orders. 
The Parthenon, a pe1fect example of the c lassical period of Greek architecture, was 
erected to serve both as a shrine to Athena and as the treasury of the Del ian League. 
For that reason it had an east cella and a west cella. There were 17 columns on each 
of its 228-foot long sides and 8 columns on the 104-foot wide front and back. There 
were 6 additional columns on both the east and west ends that formed the inner 
porticos. 

The technical skill and workmanship of the Parthenon are astonishing. No mortar 
was used anywhere. The stones were cut so that when they were fitted together they 
formed a single smooth surface. The columns were constructed of sections called 
drums, which were fi tted and held tightly by square plugs in the center so that the 
joinings were hardly visible. The design of the Parthenon was based on the 
mathematical principle of the golden section. This flexible system of dividing lines 
into extreme and mean ratios was used to ensure harmonious proportions and 
allowed much latitude in actual practice. 

C lose examination of the Parthenon shows that what seems to be straight and correct 
is really a complex series of harmonious concave and convex curves. The architects 
lctinus and Callicrates used aesthetics rather than mathematics to correct certain 
optical illusions and to create the illusion of flexibility. 1 Even the fluting of the 
columns was used not on ly to maintain a rounded appearance, but also to create 
graceful curves to please the eye. The Parthenon is a work of art, not merely an 
example of skillful engineering. 

The organization of horizontals and verticals, the relationship of length and breadth 
to height, and the ratio of the solid masses to the openings between the columns all 
were according to the tradition of the Doric order of architecture. A unit of measure 

I Olive Dilgores,An, Man and History. New York: Gabriel Charles Press, 1972, p. 130. 

Figure 7-163 Final output for page 1 of Project 6 
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know as the module was used to assure the proper ratio of parts to whole. T he 
modules were flexible units of measure, such as the diameter and radius of a 
column, not fi xed units like yards and feet. The modu le varied among structures, in 
keeping with the Greek ideal of structural integrity of single buildings. 

Sculpture 

The statues created during the c lassical Greek period concentrated on typical or 
general quali ties rather than on unique or particular ones. This was done in orde r to 
seek a concept closer to pelfection. The most beauti ful details of several mode ls 
were combined to achieve the ideal. 

The Doryphorus (Spear Bearer) by Polyclitus puts into play his rational theory for 
ideal proportions for the human fi gure. Just as the Parthenon had its module deri ved 
from a unit of the building, Polyclitus took his module from a part of the body. The 
whole and all parts of the statue were expressed in multiples or fracti ons of the 
module . As with the optical refinements of the Parthenon, Polyclitus' canon also 
allowed for some flexibility to ensure harmonious grace. 

The sculptor avoided representing the human being in infancy or old age, since these 
extremes implied incompleteness or imperfection. The maj ority were fashioned to 
represent gods who, if portrayed as humans, must have bodies of perfection. In the 
bronze statue of Poseidon (or Zeus) recovered from the sea off the coast of Greece, 

The sculptings, or metopes, in the Doric frieze of the Parthenon were done in high 
relief to take full advantage of the bright sunlight. The l.ilpith n11d Ce11tnur metope 
attributed to Phidias, uses the spreading folds of the mantle to form a backdrop for 
the idealistic human figu re and makes a striking contrast with the grotesque centaur.2 

Phidias' Athena Lemnin, which stood on the Athenian Acropolis, was often referred 
to as "the beautiful" and approached the Greek ideal ofi chaste classical beauty. 

The Dying Warrior from the east pediment of the temple at Aegina is and idealis tic 
model of simplicity and restraint. Dignity and grace are e mbodied in its portrayal of 
the death of the lean and muscular warrior. T he harmonious proportions of the 
Kritios Boy are represented by its enhanced lifelike expression and its contmpposto 
stance. In both cases the essential, ideal qualities of the subjects are captured. 

2Wyman Colla, The Philosophy of Arl and Learning Chicago: Nantahala Publishi ng Company, 
1980, p. 24 1. 

Figure 7-164 Final output for page 2 of Pro ject 6 
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The margins for The Classical Ideal report are 1 inch top and bottom and 
.75 inch left and right. 

".. Choose Document from the forma t menu to set the margins. 

The font used in this pro ject is Times 14 point. 

The easiest way to create this report is to type the report first, and then 
go back and add the headers and footnotes. 

.... Refer to Figures 7-163 and 7-164 and type the body of the report. Do 
not type any of the header info rmation (name, class number, date, 
and page number). Do not type the footnote reference marks (1 and 
2) in the body text or the footno te text at the bottom of each page. 

• Format the title of the report bold and centered and the Architecture 
and Sculpture headings bo ld and left-aligned. Italicize the words 
that require it. 

• Use the spelling checker to check for misspellings. 

Now that all the grunt work is done, you can add the headers. 

.. Choose Section fro m the Format menu and click the First Page 
Special box in the Header/Footer portion of the Section dialog box, 
as shown in Figure 7-165. Click OK when done. 

rOD 
[cancel ) 

~ 
[Set Oefeult J 

Heoder/ Footer----, 

----, From Top: ~ 
From Bottom: ~ 

[8:1 First Page Special 

Figure 7-165 Choosing the First Page Special header option 

When you open the Document menu, you now have two different 
headers and footers to choose from . 

• Choose Open First Header from the Document menu. 

The header window that results will contain the text that prints on the 
first page of your document only. 
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• Type your n am e on the first ine of the header, the class number on 
the next line, and the da~e o n the last line, as shown in the 
completed document in Figure 7-163. Press Return to create a blan k 
line after the date. Format these lines right-aligned . 

3€ -M ,.. Click in the line that contains th e date, and choose Paragraph 
from the Format menu. 

• In th e Paragraph dia log box, click th e Borders butto n, and then 
click in the bottom of the bo rders sche matic to create an underline 
borde r effect. Click OK twioe to get back to your document. 

,.. Close the First Heade r wind<Dw and th en open the header window 
from the Document me nu . 

The contents o f the h eader window wi ll print on every page but the first. 

,.. In the header window, type the word Page, press the space bar, and 
then click on the page number icon in the header window to place 
the automatic page number in the header. Press Return to place a 
blank line after the page-number li ne . 

• Format the page-number line right-aligned, and then place an 
underline border beneath it like you d id in the First Header window. 
Close the header wi ndow whe n fin ished. 

• Use Page View or Print Preview to see the different h eaders o n each 
page, and then return to Ga lley View. 

Next you' ll add the footnotes. 

,. Click to set the insertion point after the period that ends the second 
sentence in th e fourth pa ragraph of the report-the paragraph 
beginning with "Close exan 1inat ion ". 

This is where the footnote refere ce mark will go . The other part of the 
footnote, the footnote text, wi ll go at th e end of the page. 

3€ -E ,. Choose Footnote fro m the Document menu. 

The Footnote dialog box is shown in Figure 7-166. 

18] Auto-numbered Re ference 

or 

footnote Reference Merk:CJ 

! f ootnote Separa tors 

1 (separator ... ) (cont. Separator ... ) [Cont. t'lotice ... d 
Figure 7-166 The Footnote di , log box 
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Notice that Auto-num bered Reference is alread y selected. This o ptio n 
allows Microsoft Wo rd to num ber the footnotes automatically as you go 
alo ng, beginn ing with number 1. If you wanted to use a foo tnote 
reference mark other than auto-numbered, you would type the cha racter 
to use for the re ference mark in the box to the right of Footnote 
Reference Mark. 

The o th er options in the Footnote dia log box concern the footnote 
sepa rato r, which is a ma rk that sepa rates the footno te text fro m the 
ma in text of the documen t. The defau lt foo tnote separator is a line two 
inches long, wh ich is standard fo r most documents. 

• Since you want Word to insert an auto-numbered reference mark 
where the insertio n po in t is, cl ick OK to accept the settings in the 
Footno te d ia log box. 

The reference mark is inse rted in your document at the insertio n po int, 
and t he footnote window opens at the bottom o f the screen. lf Show ~ 

is o n, you'll see that the footnote reference marks are boxed with a 
dotted line. Notice that the same footnote reference mark is a lso placed 
in th e footnote window at the botto m of the scree n, and the insertion 
point au to matically moves there for you to enter your foo tnote text. 

• ln the footnote window, type the foo tnote text that is shown at th e 
bot tom of the first page o f the completed documen t in Figu re 7-163. 
All character and fo rmatting opti ons a re available in the footnote 
window just as they are in the document window. 

You can use the scro llbars to scroll aroun d in the footnote window. To 
c lose the footnote window, double-click in the sp lit ba r, as shown in 
Figure 7-167. 

r. than rnathetnatics. to. correct 
f.flexibility. ~~· Even the. fluting. 
ed. appearance). but to. create. 

· les. Press .. · 1 972 ,. p .. 130. <Jf 

Figure 7-167 The split bar 
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• Now move to the second to the last paragraph of your document to 
insert the second footnote. 

• Click after the second sentence in that paragraph, and insert the 
second footnote in the same mannter as you did the first one. 
Type the footnote text from the finished document shown in 
Figure 7-164. 

If you close the footnote window and would like to do some editing to 
the footnote text, double-click on the footnote reference mark in the 
document to reopen the footnote window. 

To delete a footnote, you select the footnote reference mark in the 
document and press the Backspace key. Not only does this delete the 
reference mark in the document, but it also deletes the footnote text in 
the footnote window and automatically renumbers any subsequent 
footnotes that were auto-numbered. 

I 
For more information about the footnote features, refer to Reference to 
Microsoft Word. 

- Your report should now be complete. Compare it to the finished 
documents shown in Figures 7-163 and 7-164, and make changes as 
needed. 

Project 7: Creating a Form 

In this project you'll use the tables feature and cell borders to create a 
form. For additional help, refer to Project 3 in this chapter, which covers 
the tables feature. The final outpl!tt of Project 7 is shown in Figure 7-168. 
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Student Grade Averaging Form 

Course Name: 

Date Item Grade 

Average-------

Course Name: 

Date Item Grade 

Average ______ _ 

Course Name: 

Date Item Grade 

Average-------

Figure 7-168 Final output for Project 7 
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The margins for the Student Grade Averaging Form are 1 inch top and 
bottom and .75 inch left and right. 

• Use the Document command from the Format menu to set these 
margins. 

The font used in this project is Helvetica 12 point. 

You'll need to work with Show ~ on and with the ruler showing. 

• Begin by typing the title, Student Grade Averaging Form, and then 
press Return three times to create two blank lines after the title. 

The title should be centered and formatted bold. 

• Click to set the insertion point on the last blank line, and then 
choose Insert Table from the Document menu. 

• The Insert Table dialog box should show settings for 2 columns, 1 
row, and 3.5 inch column width. Accept those settings. 

Now you should change the width of the first column in that table. 

,,. Use the scale icon on the ruler to toggle to the table scale, and then 
drag the thumbtack column markers on the ruler so that the first 
column ends at 1-1/2 inches, and the second ends at 4-1/2 inches, 
as in the ruler shown in Figure 7-169. 

~~ . ~ . a . ~ . H . 5 . $ 
~rmollm T t • • t I i£1 Miol 1'!11 !till ;, A !=I """ c::> Wd 

Figure 7-169 The column markers for the first table 

• Click on the blank line below the table you just created, choose 
Insert Table from the Document menu, and insert a table that has 
5 columns and 9 rows. Accept whatever column width is shown, 
since you' ll be changing the column width anyway. 

,,. Select all of the new 5-column, 9-row table, and then click the scale 
icon on the ruler to toggle to the table scale. 

• Move the thumbtack column markers so that the first column of the 
9-row table is 1-1/2 inches wide, the second column is 1/4 inch wide, 
the third is 1-1/2 inches wide, the fourth is 1/4 inch wide, and the 
fifth is 1-1/2 inches wide. Your ruler should look like the one shown 
in Figure 7-170. 

I ~ I ~I • r2 . b1 I ' 5 $ 
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Click to the left of the end-of-row marker in t hat row and 
choose Table from the Edit menu. In the resulting dialog box, 
click to insert the selection horizontally. 

Now that the grid for the table is set up, type the text in the appropriate 
cells as shown in Figure 7-171. 

r!---oa; e. 
. . . . I• . ~emo . , -~ . . . . . • . . . . ,. . , . . . . I: I: !· 

• • • 
i= . . . 

• . • . ' . , . 
• . • 1"1'1 i . 

Averaqel l 
I 

Figure 7-171 The text in the cells 

Note that Course Name is left-aligned; Date, Item, and Grade are 
centered; and Average is right-aligned. 

Finally, add the borders in this table to create the lines of the form. 

"'• The cell to the right of Course Name should be underli ned, so 
click in that cell to set the insertion point. 

'"• Choose Cells from the Format menu, and then click the 
Borders button. Click at the bottom of the borders schematic 
to place a single line at the bottom of the cell, and then click 
OK in both dialog boxes to return to the document. 

Place an underline in all but the last cell in the Date column beginning 
with the cell below the Date heading. Do the same with the Item 
column and the Grade column. The cell to the right of Average should 
have an underline border also. Refer to the completed form in Figure 
7-168. Turning off Show ~ lets you view the results of the underlining 
more clearly. 

Rather than repeating the process of creating each of the other two 
tables needed in this document, you'll duplicate the table you just 
created. 

,. Select the two blank lines after the Student Grade Averaging 
Form heading as well as the entire table. 

111
• Copy the table to the Clipboard, and then click in front of the 

blank line at the end of the document. Paste the table there. 

Paste another copy of the table after the one you just pasted so that you 
have three identical tables in the document, each separated by two 
blank lines. 

Compare your finished table with the completed document shown in 
figure 7-168. 
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P art IV: Spreadsheets introduces you to using the Macintosh to 
work with numerical problems. 

Chapter 8 presents the basic co cepts involved in using a Mac with 
spreadsheet applications. 

Chapter 9 introduces you to Jing Microsoft Excel. Th is program is 
the most widely used electronic spreadsheet application on the 
Macintosh. It has powerful equation-solving capabilities and produces 
presentation-quality graphics. You will learn to create a number of 
spreadsheets, link spreadsheets, and produce line charts, pie charts, and 
bar and column charts. 
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Chapter 8: Spreadsheet Conc;epts 

What You Will Learn in This Chapter 

After reading this chapter, you sho uld be able to: 

• Understand the basic concepts of electron ic spreadsheets and 
their use in numerica l calculat ions 

• Explain the organization of worksheets: rows, columns, and 
cells 

• Recognize a cell 's address 

• Recogni ze a range 

• Know what can be contained in a cell: text, numbers, and 
formulas 

• Recognize and know how to interpret the three most commo n 
types of business graphics: pie charts, column charts, and line 
charts 

WHAT IS A SPREADSHEET? 

Manual Spreadsheets 

Ever since someone discovered how to keep track of business transactions 
there has been a need to organize, calculate, and present information 
about th ose transactions. 

At some point, the manual worksheet (also known as a spreadsheet) was 
created. A manual worksheet helps a person to o rganize and present 
information. 

Small man ual worksheets are easy to create and modify. As worksheets 
get larger and mo re complex, it takes more time and effort to create, use, 
and modify them. Complex spreadsheets, even those with simple 
calculatio ns, are very t ime-consuming to use. As a worksheet gets larger, 
its potential for errors also increases. 

Problems arise with spreadsheets when changes have to be made to 
correct errors or adjust to new business procedures. A manual spreadsheet 
must be reca lculated, a process th at is both time-consuming and error
prone. Manual recalculation of a large spreadsheet can take hours or 
d ays to complete and verify. 
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Electronic Spreadsheets 

Spreadsheet Users 

An electronic spreadsheet is a computerized version of the manual 
worksheet. It 's like a sheet of pape r with the pencil, eraser, and calculator 
bui lt in. 

An electronic spreadsheet allows you to enter, format, calculate, print, 
and edit your information. In add ition, it will ca lculate and draw charts, 
wh ich then may be printed. It can also be used to keep track of lists of 
information, sort that information into a di ffe rent order, and presen t 
summaries about what is in the list. 

Spreadsheets can be used whenever you have information that can be 
organized into rows and columns. They are specifically usefu l when you 
have n umerical data that you in tend to perform mathematical operations 
on. Once you have the information entered into the worksheet, you can 
analyze alternative possibilities, a process that is commonly ca lled 
what if. .. analysis or modeli11g. 

Spreadsheets are commonly used in business for accounting and 
management reports. However, business people are not the only ones 
who benefit from learning to use these ap plications. Anybody who 
performs large groups of calculations or complex calculations wi ll 
benefit from using a spreads heet. Spreadsheets are also useful fo r 
scientists, engineers, statisticians, medical practitioners, and anyone 
else who performs complex, time-consuming ca lculations on numerica l 
data. 

It genera lly takes a little longer to create a worksheet e lectronically than 
it does manually. The process may be faster or slower depending upon 
your familiarity with the softwa re, your typing speed, and how 
comfortable you are with a pa rticular me thod. Once the worksheet is 
created , however, the manual system can not com pete with the electron ic 
version. If you change a value in an electron ic worksheet, the worksheet 
is recalculated with the speed of a computer and often is com pletely 
recalculated before you could even find your calculator to sta rt 
recalcu lating a manual worksheet. 

A spreadsheet can display information on the screen, and if you specify 
a formula for it to use, it can perform n umerous calculations in a very 
sho rt period of time. After these calculations are performed, the display 
is automatically updated to sho~ the results of the calcu lations. If you 
change an y of the data, the ca l ~ulations are aga in performed and the 
d isplay is updated. This rapid feedback is what makes a spreadsheet so 

va luable. I 
With the knowledge of a li ttle algebra and the use of the many built-in 
functions provided by a spreadsheet, you ca n perform intensive and 
sophisticated mathematical analyses of problems in the fields of business, 
finance, statistics, science, engineering, and others that involve numerical 
processing. 
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SPREADSHEET TERMINOLOGY 

Cells and Addresses 

Spreadsheets are o rganized around the use of a worksheet that is divided 
into a table composed of rows and columns (see Figure 8-1 ). 

Figure 8-1 A spreadsheet 's rows, columns, and cells 

As you can see in Figure 8-1, each row is assigned a number, and the 
colum ns are designated by letters of the alphabet. Although you ca n see 
only 19 rows and 6 columns, a spreadsheet is much larger than that. 
Spreadsheet programs ca n create worksheets that are hundreds of 
columns wide and thousands of rows long. Most spreadsheets, however, 
are likely to be no larger than a couple of dozen columns wide and a 
hundred or so rows long, and many are much sma ller than that. 

Each row of a spreadsheet intersects each column, and this intersection 
is known as a cell. A cel l is the basic storage componen t of a spreadsheet. 
Cells have an address that is com posed of the letter of t he co lumn and 
the number of t he row. The top left cell is in colum n A and row 1, so it 
is kn own as cell Al. 

A cell must be selected before anything can be entered into it. When the 
cell is selected, it becomes the active cell, and it can be recogn ized because 
it is high lighted. Cell A1 in figure 8-1 is the active cell; it is su rrounded 
by a heavier border than the other cel ls. 

Information ca n be en tered into the active cell. Th is information can be 
o ne of three types of data: text, nu mbers, or formulas. 

Text is any combi nation of words or letters in a cell. It can be descriptive 
information to identify the contents of other cells, o r it can be data, such 
as customers' names and add resses. 
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Formulas 

Functions 

A cell can contain a number, also known as a value. This value can be any 
real number, such as 1, 3.14159, 363.34, -1 7, and soon. If needed, a very 
large or very small number can be entered using a spreadsheet's 
variation of scientific notatio n. 

Electronic spreadsheets are mainly used to perform numerical 
calculations. These calculations are described to the spreadsheet by 
entering an algebraic expression, or formula, into the cell. Formulas are 
composed of combinations of cell addresses, numeric constants, and 
mathematical opera tors. The mathematical operators are a plus sign(+) 
for addition, a minus sign (-) for subtraction, an asterisk (*) for 
mu ltiplication, and a slash (/) for d iv ision. 

There is a difference between sto ring a number or a formu la in a cell. You 
could manually add the contents of the two cells Al and A2 and enter 
the total into cell A3. If you then changed cell Al or A2, you would 
manually have to add them again and replace the contents of A3 with 
the new result. 

Instead, a cell might have a formu la telling it to add the contents of cells 
A1 and A2. Ifthis form ula were in cell A3, it would be written as=Al+A2. 
(The equals sign(=) tells Excel that a formula- not a value-is about to 
be entered.) The spreadsheet would then add the va lues o f cell Al and 
cell A2 and display the result in cell A3. If you change the value in either 
of the other two cells, the spreadsheet would automatically recalculate 
and display the new result in cell A3 . No matter how many times you 
change either or both of the first two cells, the program automatically 
updates the result displayed in cell A3. 

In additio n to allowing you to create simple formulas, spreadsheets 
provide a set of pre-programmed fo rmulas called bu ilt-in functions. They 
are convenient shorthand for a series of arithmetic formulas you could 
en ter instead. 

A function lets you perform coJ ·Jicated calculations with less work on 
your part. One of the most com~ on functions is SUM(), which adds a 
group of numbers that are listed as a cell range within the parentheses. 
Each list of numbers or cells is known as an argument of the function. 
Another commo n function is AVERAGE(), which computes the average 
of the numbers in its argument Jist. It does this by calculating the sum 
of the numbers and then dividing the result by the total number of items 
in the argument list . Other functions are more complicated. For example, 
the SQRT() function calculates the sq uare root of the values listed within 
the parentheses. 

An example of a simple business spreadsheet that uses the SUM() 
function is shown in Figure 8-2. t his spreadsheet is used to calculate the 
profit or loss resulting from toy sales for the first three months of 
the year. 
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Cell Ranges 

Part IV: Spreadsheets 

r • File Edit Formula Format Data Options Macro Window 
, 

... 

Figure 8-2 A simple profit or loss worksheet 

Many formulas require you to refer to multiple cells. A range of cells is 
a group of contiguous cells that is treated as a unit. 

The address of a range of cells is composed of the address of the top left 
cell, a colon (:), and the address of the bottom right cell in the group. For 
example, the range of cells that includes C2, 0 2, and E2 is referred to as 
C2:E2. 

Exam ples of ranges and their addresses are shown in Figure 8-3. A range 
may consist of several cells in a single row (C2:E2), several cells in one 
column (B4:B9), or a group of cells in multiple rows and columns 
(D5:E8). 

' 1i File Edit Formulo 

Range.C2:E2 

formot Ooto Options Mucro Window 
~ 

~~ II 
__.!!_ _!_ _!_ 

Range .84:89 Range DS:E8 

Figure 8-3 Examples of cell and range names 
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The largest group of cells in Fi re 8-3 consists of four cells in column 
D and four cells in column E. This range of cells is named DS:E8. Let's 
say you want the total of the values in cells DS:E8, and you want this 
total stored in cell 010. You could enter a formula such as =05 + 06 + 
07 +DB+ ES + E6 + E7 + E8 into cell 010, but that gets cumbersome 
very quickly. Using functions and cell ranges within a formula is more 
efficient. The formu la =SUM(DS:E8) can be read as "Equals the sum of 
cells OS through E8." 

BUSINESS GRAPHICS 

A worksheet provides a detailed numerica l view of a problem. It is 
difficult to summarize this information when presented as a spreadsheet, 
however, because people have difficulty assimilating and understanding 
large collections of numbers. 

Graphical representations are absorbed and interpreted much more 
quickly than numerical data. j ust as pictures, drawings, and other 
graphical elements can make a book more interesting, business graphics 
can make a presentation more interesting and more informative. 
Business graphics provide a visual, easily understood overview of the data 
stored in the worksheet. 

Many electronic spreadsheets provide the ability to easily create 
presentation quality business graphics. All you have to do is indicate the 
data to be graphed and the style of chart to be produced, and then the 
computer does the work. 

In addition to helping you get your point across, high quality presentation 
graphics also create a positive impression of your presentation. 

Types of Business Graphics 

Two types of business graphics have evolved since the development of 
the electronic spreadsheet: analytical and presentation graphics. 

Analytical graphics are designed to help you interpret data. Presentation 
graphics illustrate data for presentations to higher management, clients, 
and other presentations in which image and quality are important. 

Many spreadsheet programs have the capabilities to produce high 
quality graphics, although specialized presentation applications typically 
offer more features. For many presentations, the combination of programs 
such as Microsoft Excel and Claris MacOraw allows you to create very 
high quality graphics. Other pr<Dgrams, such as Microsoft PowerPoint 
and Aldus Persuasion, will accep graphics from spreadsheets, and they 
include professionally designed ormats to help you create high quality 
presentations. 
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Types of Charts 
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Most presentation graphics programs allow you to edit and enhance the 
graphs and charts you produce. In many cases, they allow you to create 
drawings, diagrams, speaker's notes, audience handouts, and slides. An 
advantage of using spreadsheet programs on the Macintosh is its 
interchangeability of graphics between programs. All charts and graphs 
produced in Macintosh spreadsheet programs may be incorporated 
easily into presentation programs. 

Even though the computer and spreadsheet do much of the work, you 
will still n eed a certain amount of skill to create a presentation using the 
correct charts. These programs provide tools, but they wi 11 not substitute 
for a person's skill and knowledge. 

Many types of charts are used to present numerical data. In this chapter 
you are introduced to the three most common: pie charts, bar or column 
charts, and line charts. 

Several charts are shown in this section as samples of these three types. 
Each chart represents a portion of the data contained in the business 
worksheet presented previously, which is repeated in Figure 8-4 for easy 
reference. 

r eJ File Edit Formula Format Data Options Macro Window 
., 

Figure 8-4 A simple profit or loss worksheet 

Pie Charts 

A pie chart shows how several amounts make up a who le. Only one 
variable, or data series, may be shown using a pie chart. 

Figure 8-5 shows a pie chart illustrating revenue (the data series). The 
revenue for each month is compared to the to tal revenue for the entire 
period. The slices of the pie, and the percentage of the to tal revenue 
represented by each month's amount, a re ca lculated and displayed. 
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~0 

Figure 8-5 

P e Chart 

Revenue 

34.32% 
38.33% 

27.36% 

Pie chart of revenue for three months 

I 

• January 

0 Febr uar y 

El March 
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Sometimes it is useful to draw atten tion to one of the values in a pie 
chart. In these cases, an exploded pie cha1t is used. This means that one 
slice is pulled away from the others to emphasize it. 

In Figure 8-6, the slice representing March has been exploded. 

~0 EHplo!led Pie Chart 

Revenue 

38.33% 

Figure 8-6 Exploded pie chart 

• January 

0 Febr uary 

El March 

Pie charts have the advantage of being understood by nearly everyone. 
However, they can on ly show the proportional relation of several values 
withi n a single data series. 

Column and Bar Charts 

Column charts and bar charts are sed to illustrate discrete quanti t ies and 
compare them to differen t qua t ities of the same variable. 
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Both types of charts are essen tially the same; they differ on ly in the 
ori en tation of the rectangles used to graph th e data. Colum n charts are 
o ri en ted so that the rectangles a re taller than th ey are wide, whereas bar 
charts are rotated 90°, so the ba rs are wider than they a re ta ll. Values are 
grap hed vertically in co lum n charts and ho rizon tal ly in bar charts. 

Figure 8-7 shows revenue amounts for january, February, and Ma rch . 
This chart represents three values with in the revenue data series. It 
is clear that Februa ry had the lowest revenue an d that March had 
the h ighest: 

~0 Column Chart - I Dat a Series 0~ 

Revenue 

$30,000.00 $28 ,293.80 

$ 25,000.00 

$20,000.00 

$15,000.00 

$ 10,000.00 

$5,000.00 

$0.00 
January f ebr uary Mar ch 

f2J 

Figu re 8-7 Colum n chart showing three values of one variable 

Unli ke pie charts, bar and co lum n charts can also show the relationship 
be tween mu ltiple data series. Figure 8-8 shows a colum n chart 
represen ting three data series. 

Column Char t - 3 Data Ser ies 

$30,000.00 

$25 ,000.00 

$20,000.00 

• Revenue 
$ 15,000.00 

0 Expense 
$ 10,000.00 

III Profi t/( Loss) 

$5,000.00 

$0.00 
J anuary 

($5,000.00) 
f ebruary March 

Figure 8-8 Co lum n chart showing three instances of th ree variables 
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This chart compares the re latio n between reven ue, expense, and profit 
or loss over three months. It is seful for spotting trends that may be 
important. For instance, whi le ·evenue is fluctuat ing over the three 
month period, expenses seem tb be stead ily increasing. Sho uld this 
trend continue, it may have se~ious consequences, and it should be 
carefully watched fo r the next several months. 

Line Charts 

If you want to present information to analyze longer trends and cycles 
that can be spotted mo re easily, you can choose a line chart. 

Like column charts, line charts all ow the presentation of multiple 
occurrences, or data points, of several variables. Its advantage over column 
or bar charts is that it a llows more data points to be graphed in a given 
space than can be shown clearly in a column chart. 

line graph 

Acme Toys Annual Sales 

$80,000 t-------- --------- ----------- --------- ----- ---- --- --- --- -- ----· 

$60,000 -------- ----- - -------------- - -- ----- - ------ - - -- -------- - --- - · 

$40,000 - ----- ---- ------ ------- - ---------- - --- ---- -- - ----------- - - - . ·----·----. 
120 ,ooo ;.:• ->~--=-:t?:':-~~~ZS?:":":":'..a.....--=-:.:;;;; 

$0~~~~~~---r~~--+---+-~~-+---n~~ 

J n Dec 
($20,000) -- -- --- ---------------------------- - - - - - - - -- ------ - --------- - · 

1-•-Revenue .a- Ex pense + Profit/( Loss) I 

Figure 8-9 Twelve-month line chart of sales information 

Figure 8-9 shows a continuation of the data presented in Figure 8-8 over 
a 12-month period. As you can see, the rising expenses noted above did 
not really signal a trend. This view, which shows a longer period oftime, 
offers a gli mpse into the cycl ic nature of sales for this particular toy 
company. Another line chart showing the last ten years of sales history 
might provide useful insights for predicting next year's sales. 

Chapter 8 has introduced you to general spreadsheet and business 
graphics concepts and terminology. Chapter 9 introduces you to Excel, 
a powerful spreadsheet program[ With this program, you can increase 
your ability to analyze data and create presentation graphics. 

In Chapter9 you havetheoppor nityto learn to create worksheets and 
produce the three types of cha rt d iscussed in th is chapter. 
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CHAPTER SUMMARY 
• Spreadsheets, or worksheets, are forms used to organize data into rows and columns. 

• Electronic spreadsheets are computerized versions of manual worksheets and feature faster 
an alysis and fewer computational errors than manual m ethods. 

• Cells are formed from the intersection of rows and columns. A cell is the storage unit used 
in a worksheet. There is one active cell in a worksheet, and that is where information wi ll be 
entered o r modifications will be made. Any cell can be made the active cell by selecting it. 

• A cell can contain either text, a number, or a formula. Formulas may be composed of a 
combination of arithmetic expressions created by the user and built-in, pre-programmed 
fo rmulas known as functions. 

• A cell has an address composed of the letter representing its column and the number 
representing its row. Thus, a cell defined by the intersection of column D and row 14 is named 
0 14. Multiple cells, in rectangular blocks, can be treated as a single unit by defin ing a range 
of cells. 

• Business graphics provide clear, visual, easy to understand presen tations of the data 
contained in a worksheet. Analytical graphics are used to interpret the information in the 
worksheet, and presentation graphics are higher quality v isual aids used to illustrate the 
information in the worksheet. 

• Three types of charts are used commonly to graph data visually: pie, column or bar, and line 
charts. 

KEY TERMS 
active cell 
analytical graphics 
argument of a function 

bar chart 
business graphics 

cell 
cell address 
co lumn 
column chart 

data points 
data series 

electro nic spreadsheet 
exploded pie chart 

formula 
function 

line chart 

modeling 

number 

pie chart 
presentation graphics 

range 
row 

spreadsheet 

text 

value 
variable 

what if... analysis 
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Chapter 9: Microsoft Excel 2.2 

What You Will Learn in This Chapter 

After reading this chapter and completing the projects in it, you 
should be able to: 

• Enter data into a worksheet 

• Change the width and format of a cell 

• Select ranges of cells 

• Insert and delete rows and columns 

• Create formulas 

• Apply functions 

• Save and print worksheets 

• Create, format, and print charts 

• Link data from one worksheet into another 

• Learn shortcuts to replicate data and formu las 

• Use absolute and relative cell referencing 

I 

E 
xcel is the most widely used and one of the best spreadsheets 
available on the Macintosh. It combines spreadsheet, presentation 
graphics, and limited database functions into one powerful, 

integrated package. 

STARTING EXCEL 

Microsof~ Exce 1 

Parts of a Worksheet 

The first step in learning to use Excel is to start the program. 

•• Locate Excel's icon on your cr mputer's deskto p. Double-cl ick on the 
icon to start Excel. 

When Excel starts, it automatically open s a blank worksheet and names 
it "Worksheetl". Figure 9-1 shows this screen and iden tifies its parts. 
(The cancel box and enter box are no t visi ble until you enter o r modify 
a formula.) 

Each part of the worksheet screen is explained next, bu t neither Figure 
9-1 nor the definitions cover the standard parts of a Macintosh window, 
only the objects specific to Excel. 
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Active cell: 
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This cell 's contents will be affected if you enter any text, 
numbers, or fo rmu las o r if you make any formatting 
changes. 

Reference area: There is only on e active cell at a time, a nd this area of the 
screen shows the address o f that cell. 

Cancel box: This is v isible o nly when the formula bar is active; it 
allows you to cancel an y changes you have made to the 
contents of the acti ve ce ll. 

Rcfc: 
area 

C·ml·rl box Fnl (' r bnx Formuh h··1r \VorJ\~IICC I renee . I .• , .T . menu lmr .. l L • File Edit I Formula I Format I Data Options M ocro 
1---- AI 

!!0 Worksheet! 
c A B c D E 

Uorb.ontnl 
split b~1r 

Window 

E!l 
f 

~ 
. ---~-=l$1-. --:. ---·-----+ --- -·--- ----

-4- _____ ± ___ 
5 ·- -----+ _____ -± ___ ---,--r 

'"' Vert it 
!otplil 
har 

-

7 
6 

+a ----- I _____ _____ =r: ____ 
-+!-12 ---13 

14 

~ ---16 ---_g. -------16 

IOl J .. 

Enter 

I 
Stutu~ b:ar 

------ I I 
--

-------
.' . 

Figure 9-1 Some of Excel's con trols and ind icators 

I 

·In 
10121 

rmm 

Enter box: This is visible o nly when the fo rmula bar is active; it 
a llows you to accept any changes you have made to the 
con tents of the active cell. This is the same as pressing 
Enter o n the keyboa rd. 

Formula bar: This area d isplays the actual contents of the active cell. 
If th e active cell contains a formula, you will see the full 
formula in this area and not the results of calculating 
that fo rmula. 

Split bars: These controls are used to di vide the Excel window into 
two o r fo ur panes. If you press o n the vertical split bar, you 
can drag a dividing line to the right that will split the 
window into two vertical windows. Yo u wo uld do this, 
for exa mple, to see tit les in column A and totals farther 
to the right. (You will do this in Pro ject 4.) 

The horizontal split bar allows you to split the window 
in to two ho rizontal panes, one above the other. This 
wo uld allow you to see the top and bottom of a column 
of va lues tha t is too lo ng to fit o n the screen. 

By using both ho rizo n ta l and vertical split bars, you can 
split the window into four independently scrolling 
pa nes, a llowing you to see fo ur sections of a large 
worksheet at the sa me time. 
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Status bar: 

To remove a split bl ar, drag it back to its original position 
and release it. 

This area displays very brief information about the 
current state of Excel (Ready, Calculating, and so on) or 
information about the currently selected command. 

Rows and Columns 

Excel, like other spreadsheets, is organized around the use of a window 
divided into a table composed of rows and columns. 

As you can see in Figure 9-2, each row is assigned a number, and the 
columns are designated by letters of the alphabet. Although you can see 
only 19 rows and 6 columns, the spreadsheet is much larger than that. 

I 
C 1lumn 

If! File Edit Formula Format D11t a Options Macro Window 
AI I I 

WorkJheetl 
D 

Ro"~ 
2 ~3~-------4-------+-----~------~-----4-------t:,rll:: 

-....;r-~--------+·----+-----1·--·-·-----f-------+-----·- !. :; 
~;.-J-------!---·----+-·------l-·--·---l--·---·-·-4------- \: 

~H----·--·-··-i--·--·-··---+---·-···-···--L-i-·--···-·-··-···-·i-·- ------4------- l::i: 
ll-+';'-l·-···--·-·-·-··--1---··----+-·--·-··-··-···-··!-·--·- ·---l-------·- .;-.. -----l'!:;:: 

Figure 9-2 Upper left corner o~ blank worksheet 

You can think of this worksheet as a huge sheet of paper that you are 
looking at through a window. By clicking on the scroll bars, you cause 
the sheet to move behind the window, allowing you to see other parts 
of the sheet. 

Cells 

The intersection of a row and a column is called a cell. A cell is named 
by combining its column letter and row number. 

You can see if Figure 9-3 that there are 16,384 rows and 256 columns. 
The columns are lettered A. .. Z, but then the alphabet ends, so the next 
columns are AA ... AZ, then BA ... BZ, and so on, up through IV. If you 
multiply the number of rows (16,384) by the number of columns (256), 
you find that there is a total of 4)194,304 cells in an Excel spreadsheet. 
The top left cell of the worksheet (see Figure 9-2) is named A1, and the 
lower right cell of the workshee (see Figure 9-3) is named IV16384. 
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Although this many cells technically are available in the spreadsheet, 
your computer probably does not have enough memory to use a ll 
of them. The average spreadsheet usually has no more than a few 
hundred rows and fewer than 100 columns, and many spreadsheets are 
much smaller. 

Formot Dolo Options Mocro Window 

Figure 9-3 Lower right corner of blank worksheet 

Ranges 

A group of cells is referred to by specifying the first (upper left) cell in the 
group and the last (lower right) cell. These two cell references are 
separated by a colon (:). For example, a group of cells consisting of C2, 
02, and E2 is referred to as C2:E2 (see Figure 9-4). You might find it 
useful to pro nounce C2:E2 as "C2 through E2". 

Celi A I Ran~c C2:E2 
r • File I Edit Formula Formot Oato Options Mocro Window ' 

~ I I 
Workshe1 II 

8 D E (I) 

_II) : ':':· •.... i ". l' :·Ki, . <1: ·i~H~ . 1· .,;':.· '' .'? . .·.•x · '•'il~ 1\li 

Ranl(c ll4:ll9 Ran •c DS: E8 

Figure 9-4 Examples of cell and range names 

A range may consist of more than one cell in a single row (C2: E2), several 
cell s in one column (B4:B9), or a group of cells in multiple rows and 
columns (DS:E8) . 
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Cell Contents and Attrib tes 

Cells may contain text, a number, or a formula. Regard less of informatio n 
type, a cell 's contents is limited to a maxim um of 255 characters. 

ln addition to the actual contents, a cell may a lso contain certain 
att ributes tha t dete rmine how the contents will be displayed. These 
att ri butes include text and numerical formats, border lines or shades, 
and al ignment choices. A cell, even an empty one, may have these 
attributes associated with it. 

Unli ke o lde r electron ic spreadsheet programs, Excel is designed to take 
adva ntage of many of the graphics features of the Macintosh. By 
specify ing differen t fonts, sizes, and styles, as well as other formats that 
may be applicable, you can produce a report that no t on ly is informative, 
but also is visuall y appealing. 

Depending o n the contents of a cell and its attributes, Excel may di splay 
something on the screen that is different from what the cell actually 
conta ins. 

figure 9-5 shows a simple worksheet that contains several kinds of data . 

,. 115 File Edit Formula Format Data Options Macro Window 
.., 

c 12 I =C 1 O+C 11 

"" Wor~sheet 1 
II B C D E F 

3 .· . . . . 
4 I Name Evel un Baxter 

6 IPurcha~e~ . .. It em. 1 . . . 
7 Item 2 

. 4i.l4 
10 $255.42 

12 $2'13.941 
13 . . = . 
14 
IS 

17 
18 

19.1 
... Reedy I 
Figure 9-5 A simple worksheet 

Text 

Cells A2, A4, and A6 (and others)· Figure 9-5 contain text. Any text can 
be typed into a cell. Text typed i o a cell is treated as a constant; it will 
not be changed by Excel. You, owever, can modi fy it any t ime you 
want, by select ing the cell and t ping new text. 

Most worksheets contain group of numbers, and those numbers are 
identified by typing text into a jacent cells. This worksheet con tains 
text used as labels (Date, Item 1, and so o n). It also contains text used 
to represent data (Evelyn Baxter) This sp readsheet could be expanded 
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to include the customer's address, cred it information, shipping address, 
and o ther such textual data if desired. 

None of the text cells in figure 9-5 has any special formatting attributes, 
so they all show the text in the sa me fo nt, size, and style. 

Numbers 

Ce ll s 132 and C6:C9 contain numbers. Numbers are t he basic data used 
in a wo rksheet to produce usefu l results. A number, like text, is a 
co nstant value. Once you type a number into a cell it will not change. 
You a re free to go back later and change the number any time you wish. 

The number in 132 is formatted to represent a date, and all of the cells in 
column C a re fo rm atted to show all values rounded to two decimal 
places. 

Cells C9 and Cll have been formatted to show a solid border on the 
bottom of th e cell, to represent a line indicating an arithmetic sum. 

Cells C10 and Cl 2 are formatted as currency, so a dollar sign is added 
in front of the number. This dollar sign is inserted by Excel, not by the 
person creating the worksheet. It is not a part of the value in the cell; it 
is an attribute that affects how the value is d isplayed . 

Formulas 

Cell s C lO, Cl1, and C12 con tain formulas. The main purpose of a 
spreadsheet program is to perform numeric calculations and present the 
results, and cells co nta ining formulas a re the basic mechanism used to 
do this. In t his worksheet, the re are only three formulas. You can tell 
Excel to show the formulas in a worksheet, instead of the values 
calculated by the formu las, by choosing Display from the Options menu, 
and then selecting Formulas. You would then see the worksheet as 
shown in Figure 9-6. 

Figure 9-6 Displaying form ulas in the worksheet 
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A formula must start with the eJals character(=). The formula In cell 
C10 is =SUM(C6:C9). This uses t~e built-in SUM() function, which tel ls 
Excel to calculate the sum of the numbers in those cells. When the sum 
is calculated, it is d isp layed in the cell containing the formula. 

Cell C11 says to multiply the results of the sum calcu lation by 7.2S<J1) a nd 
display the res ul ts. fina lly, C12 has a formula to add the total of the 
purchases an d the ca lcu lated sales tax a nd show the resulting value. 

Figures 9-5 and 9-6 represent the same worksh eet: the first shows the 
di spl ay as it would n ormally be seen, and the second sh ows th e optiona l 
view of the fo rmulas instead o f their calculated resu lts. 

You may be wondering why the date in cell B2 was replaced by th e 
number "32416". The date was entered by typing 10/1/92 . Excel 
recognized this as a val id date and automatically converted it into th e 
serial number represen t ing th e number of days since Excel's base date 
ofjanuary 1, 1904. 

Excel calcula tes a formula and displays the results, not the fo rmula itself, 
on the screen This is one of the main features that make a spreadsheet 
so powerful a nd easy to use. If you change a formula, or the numbers o r 
formulas in cells it refers to, Excel recalculates and displays the new 
value automatica lly. 

Cell Addressing in Formulas 

Two types o f ce ll addressing ca n Je used when you a re crea ti ng formulas 
in Excel: re lative and absolute. 

In the sample works heet just p~esented there was a formula used to 
calculate th e sum of four numbers. The fo rmu la in ce ll C10, 
=SUM(C6:C9), tells Excel to add the numbers found in the fou r cells just 
above C10. As long as you do not copy this formula a nd paste it 
som ewhere else in the spreadsheet or tell Excel to dupl icate the formu la 
for you, you do n't h ave to be aware of how Excel addresses the cells in 
the formula. 

Excel h as a powerful, time-saving feature that Jets it automatically 
d uplicate formulas accross a row or down a column when you tell it to 
do so. It is when you make use of this feature that you must be aware of 
the differences in relat ive and absolute addressing. 

Relative Addressing 

Most formu las used in Excel ar based on relative nddressi11g. Relative 
addressing is like giving d irectiors to somebody who is tryi ng to find 
someth ing n earby. You might tel l him to go to the second red light, turn 
left, and go three blocks. This is~ relative method of givi ng directions. 
If you were standing in a locatio two blocks away, the sa me directions 
would cause the othe r person to arrive at a d ifferen t destination. 

Unless you tell it otherwise, Excel uses relative addressing in interpreting 
formulas. 
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Charts 

GETTING HELP 
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Let's assume that you wan t to add another column of numbers, located 
in cells 06:09. Instead of having to retype the sam e formu la in cell 010, 
you can tell Excel to fi ll the form ula one cel l to th e righ t. When Excel 
copies the form u la into the next ce ll, it auto matica ll y adj usts the 
fo rmula so that it reads =SUM(D6:D9) . This is because Excel th inks you 
st il l want to add th e fo ur cells above the new fo rm ula's location (wh ich 
is now cell 0 10). 

In thi s case, an d most simi lar cases, t hi s assumption and modificat ion 
would be correct. 

Absolute Addressing 

In so me cases, however, you will encoun ter situatio ns whe n the cell 
address in the fo rmula sh o uld be interpreted as an absolute address. 

f-o r exa mple, you might wan t the formu la in cell 0 10 to show the sum 
o f the cells C6:C9, just as it does in cell Cl 0 . There is a simple way to tell 
Excel n ot to ad just the cell referen ces in the formula. To make a cell 
add ress absolute rather than relative, you ch an ge th e fo rmu la to read 
=SUM ($C$6:$C$9) . Absolute add resses (with the do ll ar signs) will not 
be ad justed when Excel du plicates the fo rmu la. 

You will en coun ter situations in Projects 3 and 4 in this chapte r when 
it w ill be necessary to u se absolute addressing to produce the correct 
results. The reasons fo r using ahsolute rath er than re lative add ressi ng 
wil l be explai ned when ever the situa tion arises in th ose pro jects. 

In addit ion to its worksheet features, Excel has a wide range of charti ng 
functions for displaying numeri c data in gra phic form. The chart ing 
aspects of Excel also make wide use o f t he Macintosh 's graphics 
capabilities an d allow you to crea te presentati on-q uality charts, which 
can be p rinted d irectly to your ImageWriter or LaserWriter. 

Excel offers a wide variety of chart types such as pie charts and bar charts. 
You will learn about charting in Pro ject 2. 

In the first four projects in th is c hapter you wi ll lea rn to create, mod ify, 
save, an d print worksh eets an d charts. 

Like most top-quali ty Macintosh programs, Excel offers ex tensive 
o n li ne help . Three m ain types of he lp are avail able. (This assumes tha t 
you copied the Excel help file from the distri bution disk onto your work 
d isk when you origina lly insta lled the p rogra m.) 

The first way to get help is to choose Help from th e Window menu. Th is 
o ffers a va ri ety of help information th rough which you ca n browse. 
W hen you open the Help wi ndow, you will see th at th e terms h ave solid 
u nderlin es (see f- igure 9-7). 
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Figure 9-7 Excel's opening Help screen 
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A term with a solid underline is known as a jump term. When you point 
to this type of term and click the mouse button, Help will find the 
information associated with that term and take you to it. By clicking on 
these Linked terms, you can jump from one topic to another and follow 
a thread of interrelated topics. 

If you click on the underlined phrase Defined Terms, you then jump to 
its screen (see Figure 9-8). Whenever you click on a jump term, you 
descend one level deeper in the help system. To return to the level from 
which you just jumped, click the Back button. 

r • File Edit Formula Formot Oato Opt
1
ions Macro Window 

Figure 9-8 Defined Terms help 
character I 

n showing definition of ASCII 

Each dotted underlined term is called a de{i11ed terrn. If you point to this 
term and then press and hold d9wn the mouse button, a box appears 
containing a brief description of the term. When you release the mouse 
button, the box disappears. 
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Clicking the Next button moves you to the next screen about that topic. 
The Previous button takes you to the previous screen. 

If you are familiar with Lotus 1-2-3, you can click the Lotus 1-2-3 button 
to retrieve information about the Excel equivalents of Lotus 1-2-3 
commands. 

The second way to get help while in Excel is in the form of its context
sensitive help. If you are using Excel and want help on the current 
context, press Command-/ (Command-slash). For example, if you are 
working in a dialog box and want help, pressing Command-/ will 
provide information about the dialog box and any options or responses 
you may select. 

The third way to get information, when you want to specify the context, 
is to press Command-? (Command-question mark, or Command-Shift
slash). The pointer will turn into a question mark. You can then click on 
an object or choose a command. Instead of the click causing an action 
to occur, Excel will give you information about the object or command 
you selected. 

For example, suppose you are working in a worksheet, and you want 
more information about the formula bar. You could choose Help and 
then find the information associated with the formula bar, but there is 
an easier way. 

If you type Command-?, the pointer changes to a question mark. You 
can then move the pointer into the formula bar area (see Figure 9-9). 

' * File Edit Formulo Formet D11t11 Options Metro Window 
c 12 I I :C l O+C l 1 ? 

i Drr %T5 Worksheet 1 
A B C 0 E f 

2 O.to l 0/ l / 92 
3 

6 Purch .. eo Item l I 14.68 

~9~------rlt~em~4~~--~47~. 1~4~--------~------+----~~l: 
~101 1------~=~~rl-~$~25~5.~42;~----~-----+----~~1' Tox 7.25~ I 18.5;-

:~ 4'------+------,_-----rl 
14 
15 

16 '.t 
~------+-----4------+----·~------r-----~L~ 
~ --,-- 1--

,Reedy I -

Figure 9-9 Getting help by typing Command-? 

Clicking the mouse button while the question mark pointer is in the 
formula bar will show its Help screen (see Figure 9-10). If you had clicked 
while the pointer was in the worksheet area, you would have been 
presented with general information about the worksheet. 
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' .J File Edit For mula For mal Dat a 0 lions Macro Window 

101 

c 12 I I :C I O+C I I 

0 Help 

formula Bar 
You ~e the formula bar to enter or edit date tn cells or 
chllrto_ 

• To enter dale, oelect e cell, type t he dole, end pr= 
Enter_ 

• To edit data, fi rst octivole the formulo bor blj cl ic ~i"'l 
'Wl thin it_ Then type your chllll<jeo end press Enter. 

• To cencel your chllll<je!, pr= Eocope or cli c~ the 
cancel box. 

• for more informetion, see formula Bar ln the 
f>h"crbSfJft EX~! Re~r~=-

I 
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( 

0EIT~ 
Topics ] I t l!=! 
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( Preuious ] 
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I 

Figure 9-10 Help screen for t~e formu la ba r 
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If you are in a dialog box when you type Comman d-?, it wi ll work the 
same as typing Command-/ . The dialog box is the current context, so 
you will be presented with the Help screen fo r t hat dialog box. 

An y time you are working in Excel, this help feature is avai lable, and it 
is usually easier than looking up a top ic in the ma nual. Remember, 
however, that the manual con tai n s mo re in-depth information about 
the topics than Help does. 

SAVING YOUR WORK 

The first t ime you save your document, Excel asks you, by way of the 
dialog box shown in Figure 9-11, where you wa n t you r document saved 
and what you want it to be named. 

Clicking the Drive button togg~es between one or more floppy drives 
and h ard drives, depending o n rhe hardware you a re using. The Save 
dialog box shows the name of the floppy disk or hard drive as that drive 
is selected. You are saving your document o n the selected d isk or hard 
drive with the name sh owing inlthe Save d ialog box. In the dialog box 
shown in Figure9-ll, the name ofthedisk, Miguel Garcia Data, is shown 
in two places. Always be aware o f where you are saving your work. 

After you have saved the first tin~e, th e next time you choose Save Excel 
assum es you want your document to be saved in the sam e place and 

I 
under the same name. You should be careful about savingyour document 
in the correct place the first tim e ou save it, so you can find it late r. The 
Save process is much quicker the second a nd subsequen t times, because 
you are not prompted for any a d itional in format ion. 

The Save As command is simil ar to the Save comma nd, except that it 
gLves you the option to give your document a differen t name and save 
it in a different location. Every time you choose Save As from the File 
me nu you are prompted with thb dialog box shown in Figure 9-11. This 
is the same dialog box you see the first ti me you save your document. 

I 
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When you use the Save As command and you attempt to save the 
document with the same name and in the same location as before, you 
will be asked if you want to replace the old document. This is because 
no two files in a particular location can have the same name. If you want 
to save different versions of the same document use the Save As 
command and give the document a different name. 

Save your work often. Save at least every ten minutes, so you never lose 
more than ten minutes of work. The Command-key equivalent of the 
Save command, Command-S, is a helpful shortcut. Always save your 
work before printing. 

I (g) Miguel Garcia Datal 

D CI<J~s Noh's !lu11on~ i!=! (g) Miguel Ga ... 
Cl Final Project s r-:,..,-. --.,..---, 
D Geno's M<m\J llnfor... i:il = [ Eject J 
D Glo~sill Y :':H [ Driue ) 
D Gnw On!J C<n·d flrt :::n 
D L.unnr Mis~lons 

~' 
Saue Worksheet as: 

I Loan Rna lysis 

Normal Format 

Qilfi~j 
[ Cancel J 

[ Options J 

Figure 9-11 The Save dialog box 

Be aware that you can save a document before you actually type 
anything into it and that many people do it this way. However, you will 
be given explicit instructions for saving your work at appropriate times 
throughout the project. 

Project 1: Creating a Worksheet 
I 

In this project you will learn to add text, numbers, and formulas to 
create a worksheet. Then you will save three different copies of the 
worksheet to be used in Projects 2, 3, and 4. In Project 1, you will create 
a worksheet and calculate three different loans: a student loan, a car 
loan, and a house loan. 

All loans are not the same; the amount it costs to pay back a loan 
depends on how much was borrowed (principal), the periodic interest 
rate (annual and monthly rates in these cases), and the length of time 
before the loan is repaid (term of the loan) . 

From these figures you can calculate the amount of the monthly 
payment, the total amount to be repaid to the lender, and the amount 
of interest incurred. 
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The final output of Project 1 is shown in Figure 9-12. 

Loan Analysis Miguel Garcia 

Loan Type Student Loan 

Total Amount $2,500 .00 
Do\>tn Payment $0.00 
Term of Loan 5 years 
Annual Interest Rate 8.500 percent 

Amount financed $2,500.00 
Term of Loan 60 months 

Monthly Payment $51 .29 

Total Amount to be Repaid $3,077.48 
Total Interest $577.48 

6/2/90 1 0:29 Af1 

Figure 9-12 Final o utput of Prb ject 1 
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ORGANIZING A WORKSHEET 

To perform a basic loan ana lysis, you need en te r on ly four va lues: tota l 
amount, down payment, number of periodic payments, and annual 
interest rate. The worksheet will then use seve ral formulas to calculate 
th e loan informatio n and very quickly will display the resu lts of those 
ca lculations on the screen. 

You will in formally divide the works heet into two areas: data entry 
(input) and results of the calculations (output). 

You can use thi s worksheet to calculate any amortized loa n (assuming 
the loan is repaid monthly) . There are many situa tions where a ll the 
formulas an d formatting in a worksheet may be used in solving more 
than one problem . In these cases it ma kes sense to develop a standard 
worksheet, and then copy that worksheet and change only the text and 
numbers necessary to solve each p roblem. 

A worksheet used in this manner is known as a template. A template 
con ta ins all the formulas, labels, formatting, and constant text for 
solving the problem. Whenever you want to solve a problem that has 
been defined in a templa te, you should copy the template, and then 
make changes and ente r appropriate data into the copy. This way you 
won't risk damaging or losing the original. 

In Pro ject 1, you will create a general purpose loa n analysis template. 
Then you will make three copies of this template, change on ly the 
information that is d ifferen t, and produce three specific loan worksheets. 

ADDING TEXT TO A WORKSHEET 

In this worksheet you must enter tex t, numbers, and fo rmulas. It is often 
easiest to en ter a ll text, then all numbers, and then all form ulas. You can 
ente r them in any o rder, and it is not necessary to enter them as groups. 
Some people prefer to complete one part of the worksheet before going 
o n to the next. Whenever you create worksheets, fee l free to enter the 
contents of the cell s whichever way you prefe r. 

In thi s project you wi ll begin by enteri ng the text. 

Of the millions of possible cells in a worksheet, on ly o ne is active at a 
time. The active cell has a border around it, and its address is listed in 
the reference area of the screen . 

,,,. Click cell Alto make it the active cell if it is not al ready active . Type 
Loan Type and press the Reh1rn key. 
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This will enter the text into cell Al and accept it. When you accept a 
cell 's conten ts by typing the Retjurn key, Excel will make th e next cell 
below that one the active cell. This a ll ows you to quickly type information 
into a column of cells without having to se lect each cell and make it 
active before typing its contents. 

You can also have a cell 's text accepted by clicking the enter box or 
pressing the Enter key . If you do this, Excel accepts the text and leaves 
A1 as the active cel l. 

A number of keystrokes can be used to select a different active cell. When 
a new cell becomes active, the border around the formerly active cell is 
removed and the new active cel.l is hig hlighted. The active cell does not 
move; Excel makes another cell active, but it looks like the active cell 
moves around the screen as each cell is highlighted in turn. Speaking 
loosely, many people refer to this process as m oving the active cell. 

The keys shown in Table 9-1 perform the indicated operations in Excel. 

Key 
Enter 
Return 
Shift-Return 
Tab 
Shift-Tab 

Right arrow 

Left arrow 
Up arrow 
Down arrow 

Action 
Accepts formula but does not move active cell 
Accepts formula and moves active cell down 
Accepts formula and moves active cell up 
Accepts formula and moves active cell right 
Accepts formula and moves active cell le ft 

Moves active cell right. If an arrow key u sed while 
a formula is being entered onnodified, it will change 
the formula and not make a diffe rent cell active. 
Moves active cell left 
Moves active cell up 
Moves active cell down 

Table 9-1 Keys that affect acti e cell and formulas in Excel 

Since you want to continue entering tex t in co lumn A, you accepted the 
text by pressing the Return key, which caused Excel to accept the text 
into cell A1 and make the cell below Al th e new active cell. As you can 
see now, cell A2 is outlined and t he reference area shows A2 is active. 

Return ,.. There is no text to enter in cell A2, so press th e Return key again to 
make A3 the active cell. I 

,,,. Refer to Table 9-2, and ente the a ppro pri ate text into each of the 
listed cells. Note that the last three entries go into column C instead 
of column A. 
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Cell address 
Al 
A3 
A4 
AS 
A6 
A8 
A9 
All 
A13 
A14 

cs 
C6 
C9 

Text to be entered 
Loan Type 
Total Amount 
Down Payment 
Term of Loan 
An nual Interest Rate 
Amount Financed 
Term of Loan 
Monthly Payment 
Total Amount to be Repaid 
Total Interest 

years 
percent 
months 
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Table 9-2 Text to be entered into the worksheet 

When you finish, your screen should look like the one shown in 
Figure 9-13. 

,.. * file Edit fo rmula fo rmat Dat a Options Macro Window 

Figure 9-13 Worksheet with all text entered 

CHANGING COLUMN WIDTHS 

You will be entering numbers and formulas into column B, but you will 
encounter a problem, because some of the text in column A does not fit 
and it continues into column B. For instance, note how the label 
"Annual Interest Rate" in Figure 9-13 extends into column B. 

Excel allows up to 255 characters to be entered into a cell. This means 
you easi ly can enter more text than will fit into a column. If the cell to 
the right is blank, Excel allows the text to "spill over" into the blank cell. 
In fact, text can continue into several empty cells. 
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If the cell to the right is not e~ty, Excel will truncate the text and 
wi ll on ly disp lay whatever text will fit in to the current column width. 
This does not mean that any o f the text is lost. If you cl ick o n the cell 
and make it active, you will see the entire contents of that cell in the 
formula bar. 

In a couple of minutes you wi ll be adding numbers and formulas in to 
column B, and this will cause an y text that overflows from column A to 
be truncated . You want to be able to see all the text in column A, so you 
will make the column wider. 

• Move the pointer to the right border of column A between the A and 
B a t the top of the column. 

The pointer changes into a vertical bar with arrows pointing left and 
right, as shown at left. While you see this pointer and you continue 
pressing the m o use button, you can make column A narrower o r wider 
by moving the mouse to the left or to the right. 

.. Press the m ouse button and move the mouse to the right until all th e 
text in column A fits into the column; then release the button. 

Figure 9-1 4 sh ows how the screen looks during (left screen) and after 
(right screen) this operation. The left screen sh ows that cell A's righ t 
bo rder has been "grabbed" and moved past the longest text in column 
A. (It looks like column B is being adjusted, but that is because the righ t 
bo rder o f column A h as been d~agged almost to the right border of 
column B.) In the screen on the right, the mouse button has been 
released, and Excel has resized column A and h as moved the left side of 
column B to where the pointer was when the mouse button was 
released. 

Figure 9-1 4 Changing the width of column A 

Now that all th e text fits into column A, none will be tru ncated. 
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SAVING THE WORKSHEET 

Be careful about saving your document in the correct place the first time 
you save it, so you can find it later. The Save process is much quicker the 
second and subsequent times, because you are not prompted for any 
additional information. 

Save your work often. Save at least every ten minutes, so you never lose 
more than ten minutes of work. The Command-key equivalent of the 
Save command, Command-S, is a convenient shortcut. 

:3€: -S ,. Choose Save from the File menu. 

,. Click the Drive button, if necessary, to switch drives until the name 
of your data disk is showing above the Eject button, where "Miguel 
Garcia" is in Figure 9-15. 

I !g) Miguel Garcia Datal 

D Cl<I~S NntPs llutton~ !:! !g) Miguel Ga"'. 
D Final Projects 

~ :::::~<~:~~<mu Unfm ... i,.~.J: ... ' : .. f:.:l . .: ( :~;;~ : 

D Gn~etlnfJ C<1nl llrt . 
D lunnr Mis~ions 
D Monu Art work 

Saue Worksheet as: 

I Loan Analysis 

Normal Format 

~· 
~ Saue~~;J 
( Cancel ) 

Figure 9-15 The Save dialog box 

,,. Type Loan Analysis as the name of your document, and then click 
the Save button. 

ENTERING NUMBERS 

If you are currently attending college, or have been to college, you might 
be familiar with student loans. We will use this worksheet to analyze a 
loan for $2,500 for 5 years at 8.5% interest. (Of course, there are a wide 
variety of terms and conditions for student loans. At the end of this 
project you will be given the opportunity to analyze several loans and 
compare them.) 

There are only four numbers to enter into this worksheet. 

,,. Refer to Table 9-3 below and enter the appropriate numbers into 
each of the listed cells. 
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Cell address 
B3 
B4 
B5 
B6 

Nurrilber ~~7 entered 

8.5 

Table 9-3 Numbers to be entered into Loan Analysis worksheet 
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You learned earlier that Excel allows up to 255 characters to be 
contained in a cell and- that text can spill over into blank cells to 
the right. 

The 255-character limit applies to cells containing numbers, but the 
ability to "spill over" does not apply. If a cell is not wide enough to show 
the entire number contained in the cell (according to any formatting 
you have chosen), Excel will always show number signs (#) across the 
cell. This is an error message to alert you to change the format of the cell 
or to make the column wider. 

FORMATTING NUMBERS 

Excel provides many predefined formats for displaying numbers, as well 
as the ability to create your own custom formats. 

Most of the values to be displayed in column B will be dollar amounts. 
Some of the other values will be percentages or integers. Since most will 
represent currency, let's tell Excel to display all the numbers in column 
B as currency. Then let's selec 1 individual cells and assign them a 
different format. 

Any time you reassign the format for a cell, it overrides any previous 
formatting. 

To format all of column B, you must select a range of cells. Previously 
you have worked with only a single cell at a time. Excel allows you to 
select a range of cells upon which to operate, but even when a ran ge of 
cells is selected, there still is only one active cell. 

The distinction between a cell's contents and its formatting attributes 
is important. There is only one active cell, and it is the only cell in which 
you can enter text, numbers, or formulas. In Figure 9-16, all of column 
B is selected, but only cell Bl is active. You can see this by looking into 
the reference area, where it shows Bl. 

You can modify the format of any selection of cells all at one time. This 
will not affect the contents of the cells, but only how they will be 
displayed. 

• Select column B by clicking on the letter B at the top of the column. 
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Mocro Window 

Figure 9-16 Selecting an entire column 

Notice that all of column B is highlighted,but cell B1 is outlined and 
shown in white, and the reference area shows that B1 is the active cell 
(see Figure 9-16). 

,. Select Number from the Format menu. Select the format shown in 
Figure 9-17 by clicking on it, and then click OK. 

A shortcut for selecting a format from the list is to double-click on it. 

Format Number 
General 
0 
0.00 
#,##0 
#,##0.00 
$#,##0 ;($#,##0) 
$#,##0 ;[Red)($#,##0) Ill 
$#,##0.00 ;($#,##0.00) ,. :tJ 
Format: 

~ OK 

( Cancel 

ne!e1e 

Figure 9-17 Choosing a currency number format 

~ 
) 

) 

All the cells in column B now display their number values as currency 
with two decimal places. Let's select a different format for three of the 
cells that will not contain currency values. 

In this case, the first and last cells contain numbers representing 
currency. The cells with other formatting are in terspersed inside this 
group, so it is faster to format the whole group as currency first and then 
go back and deal with the exceptions. 



Chapter 9: Excel 381 

When you encounter a situation I here there is no clear majority of cells 
with the same format, it is probably better to format each cell with its 
particular format. But, whenev~r you can format a range of cells it is 
faster, even if you have to go in a change a few. 

The term of the loan will be entered in years. Sometimes it will be an 
integer value, such as 3 or 5, but other times it might be 2.5 or 1.25 years. 
Since most loans are for whole years, this was the easiest way to organize 
the worksheet. We could have opted to let you enter the number of 
months, which might be useful if loans are made for terms like 30 
months. With a little more work, the worksheet could let you enter years 
and months, such as 2 years and 6 months. It is up to the person who 
designs a worksheet to determine the most useful form for entering data 
into a worksheet. 

You want the value to be displayed using the fewest number of digits 
to the right of the decimal point. The format that will do this is the 
General format. Assume that you will be the one using this worksheet 
and that you will not enter some value such as 3.912767349 for the 
term of the loan. 

,. Select B5, where the term of the loan in years was entered, by 
clicking in the cell. Choose Number from the Format menu. Double
click General to select and apply it. 

0 
0.00 
#,##0 
#,##0.00 
$#,##0 ;($#,##0) 
$#,##0 ;[Red]($#,##0) 
$#,##0.00 ;($#,##0.00) 

OK 

Cancel 

[!(1!(11 (1 

Figure 9-18 Choosing a general number format 

) 
) 

Cell B9 will contain the term of tJ;le loan in months. You want this value 
to be displayed as an integer, so ~~t' s tell Excel to format cell B9 to show 
no digits to the right of the decilmal point. 

,. Double-click on 0 to set the format of cell B9. 
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Format Number 

#,##0 
#,##0.00 
$#,##0 ;($#,##0) 
$#,##0 ;[Red]($#,##0) 
$#,##0.00 $# ##0.00) 
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OK D 
Cance l ) 

Bele1e 

Figure 9-19 Choosing an integer number format 

Cell 136 contains the value for the annual interest rate. Since th ese 
interest rates frequentl y have bee n designated in eigh ths of a percent, 
you need to a llow th e display o f three digits to the right of t he decimal 
point. Excel does not have a predefined format for this, so let's create a 
custom fo rmat. 

• Tell Excel that you want to fo rma t the number in cell 136 (use the 
techniques you have used fo r the previous cell s) . When you get to 
the dialog box shown in Figure 9-20, cl ick (do not double-cli ck) 
on 0.00. 

This format wil l now appea r in the box a t the bottom, labeled "Format: ". 

• Position the pointer to the righ t of the last zero and cl ick to position 
the text inse rtion point. 

• Add another 0 by typing (see Figure 9-20). Click OK to accept your 
new custom format. 

Delete 

rF~o_rm __ at~N_um __ b_e_r ____________ ~~ K 
General ~ -
0 ( 

w 

~?}~t1::o~(~~~.##O) I 
$#,##0.00 ;($#,##0.00) fO 

OK J 
Cancel ) 

Format: I 0.000 
~--------------------------~ 

F igure 9-20 Creating a custom num ber format 

At this point, you have entered all the text and numbers needed for 
this worksheet, and you have formatted the numbers as you need them 
to appear. 
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:3€ -S Now is a good time to save your worksheet. 

FORMATTING CELLS 

Anoth er formatting option is to change how data is aligned: either to the 
right, left, or centered. Alignment is a purely aesthetic consideration 
and has no effect on calculations or sorting. Text is automatically 
aligned left, and numbers are aligned right. 

Excel offers the normal style options that can be applied to individual 
cells or cell ranges, such as bold, Ha lic, or underline. Because of its grid 
orientation, it also provides the capability of drawing complete or 
partial borders around cells. Examples would be placing a box around 
a key number or emphasizing th e column header range by making those 
cells bold and outlined. 

CREATING FORMULAS 

A paper spreadsheet can display text and numbers as well as an 
electron ic spreadsheet can. If all you want to do is to present information, 
you can do it manually or with other programs such as word processors. 

The real power of an electronic spreadsheet comes from its abi lity to 
store a formula in a cell, automatical ly recalculate all formu las when 
something changes, and then display the current results on the screen. 

Using Excel's Built-in Functions 

Excel has a total of 131 built-in worksheet fun ctio ns that you can use t o 
create formulas. These functions are organized into 11 categories: 
Database, Date and Time, Financial, Info rmation, Logical, Lookup, 
Mathematical, Matrix, Statistical, Text, and Trigonometric. 

Excel's Help has information available on each of these functions and 
groups of related functions. One of the most used functions is the SUM() 
function, which totals the contents of a range of cells. 

Let's see what Help has to say about the SUM() funct ion. 

• Choose Help from the Window menu. 

• Click on Functions. 

• Scroll down the list of functions until you find SUM(), and then click 
on it. 

Excel presents a bri ef explanatio for the function and some examples 
of its use (see Figure 9-21). 



384 Part IV: Spreadsheets 

li File Edi t Formula Format Dat a Options Macro Window 

10 Help -0~ 

SUM(number l ,number 2, . .. ) Q ( Topics ) 
Give• toto! of ell number> incl uded In argument. . . I to 14 argument• ore ollo..,ed . ( Cancel ) 
• Arquments should be numben, or erreys or references that contain ( Preuious ) number3, 

•Exampl es ( NeH t ) 
If A I :A3 eontolno the number• 5, 8, end 2, then: 

( ) SUM(A I :A3) glveo 15. B~ck 

SUM(A I :A3, t 5,5) glveo 35. 
( lotus 123) 

• Related Toplco 

~ Gtv .. the overoge of Ito argu mento. 
{.1M:!! Glv .. tall v of number. In erQumento. 

!:!!!!!!li! Gl veo tollv of non- blank cello in or9umento. 
~§!.!:! Adds all values In a datobose. 

fm&! ~t ultlplleo all ar9umento tOQether . 
Other Statbt!g!l Fyn;tlorg 

0 ~ 

Figure 9-21 Sum () function Help screen 

lf you want to use any of these built-in functio ns, you h ave two choices 
for en tering them into your formula: (1) you can type the formula into 
the form u la bar, o r (2) you can ch oose Paste Function from the Formula 
m enu . If you decide to use the Paste Function command, you h ave a 
ch oice of whether to have Excel show a Jist o f mguments in the formul a 
or not. 

An argument is o ne of th e values or cell addresses that will appear inside 
the pa rentheses of the functi on. Fo r exam ple, if you want to add all the 
va lues in cells Al , A2, A3, and A4, you h ave two ch oices: (1) you can 
enter the formula: 

=Al +A2+A3+A4 

Or (2) you can use the SUM() function: 

=SUM(Al:A4) 

In the first case the formula tells Excel to add the value in cell Alto the 
va lue in A2 to the va lue in A3 to the value in A4 and then to store the 
results in the current cell. In the second case, the formu la tells Excel to 
ca lculate th e sum of the values sto red in the ran ge of cells from A 1 to A4. 
(The range" Al :A4" is the argument for th e SUM() function in this case.) 

Both formulas will result in the sam e value appearing in the current cell. 
The only difference is how much effort it might take you to enter t he 
formulas. If you needed the sum of on ly two or three cells, the first 
fo rmu la might be the easiest. If, in stead of two o r three cells, you needed 
the sum of 100 cells, th e second alternative would be a much better 
cho ice. Both methods work; you can ch oose the one that is most 
conve nient fo r you. 
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To enter a formula into a celt yo 1 must begin by typing an equals sign. 
This equals sign is the signal t~at tells Excel that you are entering a 
formula rather than t ext or a number. Remember, Excel displays tex t 
just as you entered it, but it must calculate th e results of a fo rmula and 
display the results in the cell that contains the formula. 

You can always see the entire formu la whenever the cell is the active cell. 
The formula will be shown in the formula bar, located just below the 
menu bar at the top of the screen. You can a lso edit a formu la in the 
form ula bar. 

The formula you will enter into cell B8 is =B3-B4, but don't enter it yet. 
This formula tells Excel to subtract the value displayed in cell B4 from 
the value displayed in cell 83 and to show the results of this ca lculatio n 
in cell B8. (Remember, this is a formula using relative addressing. It 
really tells Excel to subtrac t the value in the cell that is located four cells 
above B8 from the value in the cell five cells above B8 and then display 
the results in B8.) 

Refer back to cells B3 and 84. Cell B3 represen ts the tota l amount of a 
purchase or prospective loan , and B4 represents the down payment 
amount. Cell B8 represents the amount you will actually borrow. 
Therefo re, this fo rmula tells Excel to subtract the amount of the down 
payment from the total amount, giving the amount to be financed. 
Since you have previously formatted this column to show values with 
dollar signs and commas, your result will be displayed automatically as 
currency. 

There are two ways to enter the formu la into Excel. You can type the 
formula, or you can use the mo use to point to cells or ranges of cells to 
be placed into the formu la. 

You will now enter the formu la into cell B8 using each method. 

• Select cell B8 by clicking in it. 

• Type the = key, and then type B3-B4. 

• Press the Enter key to te ll Excel to accept the formula, calculate it, 
display the results, and keep cell B8 active. 

When you pressed the Enter key, Excel rap idly ca lculated the results, 
and you now see $2,500.00 displayed in cell B8 (as shown in 
Figure 9-22). 
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,.. c File Edit Formula Format Data Options Macro Window 
., 

Figure 9-22 Entering formula to calculate Amount Financed . 

With such a simple formula, typing is probably the easiest way to enter 
it. An alternative method for entering the formula allows you to specify 
cells or ranges of cells using the mouse. Enter the formula again using 
this method. 

-. Select cell B8, and type the = key. 

This tells Excel that you are entering a formula into this cell. As soon as 
you do this, the equals sign is shown in the formula bar, and two new 
boxes appear as shown to the left. 

The box with the X is the cancel box. If you click in this box an y time 
you are entering or editing something in the formula bar, the edit will 
be cancelled, and the cell and its contents will be left as they were before 
you began the current edit. 

The box with the checkmark is the accept box. Clicking in this box is the 
same as pressing the Enter key. The current contents of the formula bar 
will be accepted into the cell. 

• Select cell B3. 

An effect often called "marching ants" surrounds the cell, and B3 is 
added to the formula in the formula bar. 

Thi s marching ants selection shows that you have selected only one cell 
to be added to the formula. The marching ants are there as a visual 
confirmation of the cell(s) you have selected to be added to the formula. 

• Type a minus sign. 
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The marching ants disappear f om cell B3, to show it is no longer 
selected. Any math operator will cause the marching ants to go away, 
and the operator will be added to the formula. Excel's operators are 
shown in Table 9-4. 

Ogerator Reg resents Examgle Meaning 
" Exponentiation =2"3 2 cubed 
* Multiplication =2*3 2 ti mes 3 
I Division =2/3 2 divided by 3 
+ Addition =2+3 2 plus 3 
- Subtraction =2-3 2 minus 3 

Table 9-4 Common math operators used in Excel 

.. Select cell B4. 

B4 is surrounded by the marching ants, and its address is added to the 
formula. The formula bar now shows =B3-B4. 

• Now press the Enter key, or click on the accept box. 

As soon as you do this, the marching ants will disappear from cell B4, 
and the cancel and accept boxes go away. The formula is accepted into 
the cell, and Excel quickly calculates the formula and shows the result 
in cell B8. 

This method seems like a lot of work compared with the previous 
method, and on such an easy formula it may be. However, it has the 
benefit of being more intuitive. Instead of having to concentrate on the 
addresses of the cells and type them in, pointing and clicking allows you 
to think something like, "In this formula take this cell and subtract that 
cell from it". Whenever you thinkof"this cell" or "that cell" all you have 
to do is point and click. 

This method of using the mouse to select cells is even easier when you 
need to specify a range of cells. In that case, you click on a corner of the 
range, hold down the mouse button, and drag to the diagonally 
opposite corner. As you drag the mouse, a rectangle will become 
highlighted as you select the range of cells inside the rectangle. The 
entire range is surrounded by the marching ants and the address of the 
range is entered into the formula bar. 

As an example, suppose you wanted to enter =SUM(B3:D9) into cell BIZ 
of a new worksheet. You could type =SUMO into the formula bar. Then 
click between the parentheses to position the insertion point. This tells 
Excel you want to insert somethiiilg between the parentheses. You could 
type B3:09 direct ly into the formula bar if you prefer. Or, you could drag 
from cell B3 to 09. As you do this the marching ants will surround the 
range you are selecting. You don 't even have to look at the cell addresses; 
just drag and select the ones you want, and Excel will enter their 
add resses into the formula bar (see Figure 9-23). 
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r a File Edit Formula Format Data Options Macro Window 
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Figure 9-23 Entering a range into a formula by dragging with the 

pointer 

You will now enter the formula into cell B9 to calculate the term of the 
loa n in months, based on the term of the loan in years, which you 
previously entered in cell BS. 

Th is fo rmula will multiply the value in cell BS by 12. 

Let's te ll Excel to force th e value in cell B9 to be an integer. This may be 
done by using the function INT() . The formula you will enter into cell 
B9 is =INT(BS*12) . As before, you can type this into the cell, or you can 
type part of it and select cell BS to add it to the formula. You wi ll use the 
second method, with the addition of using Paste Function from the 
Formula menu. 

• Select cell B9 and type =. 

• Choose Paste Function from the Formula menu. 

• Scroll down in the list until you see INT(), and then double-click on 
it to select it. (See Figure 9-24.) You can also enter the first letter of 
an y functio n to jump to that section of the alphabetized li st . 
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r • File Edit Format Data 0~ lions Mucro Window ' 
B9 I 
~Loan Analysis~ 

A E :::'\ 
Loan rupe Paste Function (! OK ~J 

II OUR() 
......: Total Amount IF() :!:! ( Cancel ) 

OWn Poument 
!Term of Loan iNDEH() 
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Figure 9-24 Pasting the integer function into a formula 

Look a t the screen on your computer. Notice that the for mula bar now 
con tains =INTO, and the insertion point is inside the pa rentheses. 

• Select cell BS, and then type *12 and accept the formula (see 
Figure 9-25). 

'" • File Edit Formula Format Data Options Macro Window 
., 

Figure 9-25 Completed formu la using built-in integer function 

Your worksheet shou ld show 6 as the term of the loan in months. 
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Now it is tim e to calculate one of the m ost im portant parts of a loa n 
analysis-the m o nthly paym ent. To do thi s, you will m ake use o f two 
o f Excel's built-in fo rmul as: PMT() a nd Al3S(). PMT() mea ns "payment" 
and ABS() stands fo r "absolute value". 

The PMT() func ti on is a multipurpose financial fun ctio n . You wi ll be 
using it to calcu late the periodic payment to repay an a mo rtized loan. 

This m eans that you will be m aking a regula r (mo nthly) payme nt, 
whic h wil l be a pplied to the loa n in two ways. First, your payment will 
be applied to the interest o n the remaining ba lan ce of the loan fo r the 
m onth , then a nything le ft will be appli ed to reduce the a mo unt you 
owe. If you pay mo re than the regular payme nt amo unt, mo re will be 
applied to reducing the ba la n ce. 

This worksh eet assumes tha t you will pay exactly the m onthly payment 
each m o n th. 

O ne of the features o f a mo rtized loans tha t usually comes as a surprise 
to first-time borrowers is the ratio of payment to interest versus the 
payment to reduce the principal (outstanding balance). If yo u bo rrow 
m oney to buy a house and the loan is fo r 30 years, you will be paying 
o nly a few d oll ars to red uce the loan and hundreds o f do llars in interest . 
If the loa n is for fewe r yea rs, the proportion of interest to principal will 
be sm aller-you will be paying less for interest and m o re toward 
principal-but your mo nthly payments will be highe r. 

Befo re th e widespread use o f electronic spreadsheets it was difficult for 
consumers to compare different loa n packages, but with this worksheet, 
you will be able to enter just fo ur values a nd almost immediately see the 
monthly payment, to ta l payback amount, and the to tal interest over the 
te rm of the loan . 

The other functio n, ABS(), is the Absolute Value functio n. Since you are 
repaying a loan, the PMT() function wil l calcu late your m onthly 
paym ent as a negative va lue . The payment am ount on this worksheet 
sh ould be sh own as a positive a mo unt, so the ABS() functio n is used to 
make it so. Th e absolute value functio n will make a negative number 
positive and wi ll not affect zero values o r positive numbers. 

To begin the formula in cell Bll you wil l start with the absolute va lue 
function . 

• Select cell Bll , choose Paste function, select the ABSO functio n from 
the li st, and accept it. 

• Now, again choose Paste Function, scroll down a nd select PMT() 
from the li st (do no t do uble-click). 

• Check Paste Arguments (see Figure 9-26) . Click OK. 
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Figure 9-26 Pasting the payment fun ctio n and its arguments into a 

formula 

The formu la bar wi ll now have the AI3S() fu nction and the PMT() 
function pasted into the formula bar. By choosing Paste Arguments, you 
told Excel to add a list of dummy a rguments to indicate what needs to 
be within the parentheses for the PMT() function to calcu late the 
monthly payment o n your loan. 

A dummy argument is a group of le tters that represent what the function 
expects to fi nd inside the parentheses. They are called "dummy" 
arguments because they are only placeholders and must be replaced 
with actual parameters. 

There are fi ve arguments for the PMT() fu nct ion: rate, n per, pv, fv, and 
type. Thei r meani ngs are shown in Table 9-5. 

Argument 
ra te 

nper 

pv 

fv 

type 

I 
Meaning 
the periodic interest rate, in this case, monthly 

the number of periods in the term of the loan; in 
this case, it represents mo nths 

present value (amount to be financed) 
future value (this is not applicable to this pro ject) 

indica tes whether payment is made at the beginning or 
end of the period (defaults to beginning) and can make 
a big d ifference when payments are made quarterly or 
annually 

Table 9-5 Arguments necessary for PMT() function 

To calcula te the monthly paym ln t, you will need to supply values only 
for th e rate, number of periods, and present va lue. 

• To specify the rate, move th . po inter to the formu la bar and do uble
click on th e word "rate." 
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Figure 9-27 Replacing the rate argument with its associated value 

,,. The annual interest rate is in cell 86, so click on B6 to replace the 
word "rate" with the cell address B6. 

This will tell Excel that the periodic rate is 8.5. However, this would not 
be correct, since Excel would interpret this to mean that the monthly 
interest rate is 850%, and that clearly is not correct. To convert t[le 8.5 
to percent form, you must divide it by 100 to get 8.5%, which is the 
annual rate, and then divide that by 12 to get the monthly interest rate. 
The easiest way is to tell Excel to divide the contents of cell B6 by 1200 
to convert it directly to the monthly interest rate as a percentage. 

• The insertion point is directly after B6, so type / 1200 to tell Excel to 
divide the amount in cell B6 by 1200. 

The next step is to replace the dummy argument "nper" with the 
location of the cell that contains the term of the loan in months. 

• Double-click on nper to select it, then select cell B9. 

• Now tell Excel the present value, pv, is in cell B8. 

Since you don 't need the last two arguments, "fv" and "type", you can 
delete them from the formula bar (see Figure 9-28). 

,,. Select Jv,type and press Delete (or Backspace). Be sure to include the 
leading comma, and do not delete either of the trailing parentheses. 
Press the Enter key or cli.ck the accept box to accept the formula. 
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Figure 9-28 Dele ting unnecessary arguments from the fo rm ula 

The pay men t form ula has now bee n entered, and your d isplay sho uld 
show the m onth ly paym ent (see Figure 9-29). 

r • File Edit Formula Forma t Dat a Options Macro Window 
., 

Figure 9-29 The completed m f nth ly payment fo rmu la 

All that is left is to add the form J las to calculate the total amount to be 
repaid and the total interest. Th to tal amount to be repaid is ca lculated 
by multiplying the number of payme nts by the payment amount. The 
total interest is the tota l amoLmt to be repaid m inus the amoun t 
financed . 

.. Enter t he formu la =Bl 1 *B9 ip to cel l B13, a nd =B13-B8 into cell Bl4. 
Now, in cell Bl, type Student Loan. 
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PRINTING 

Page Setup 

~ -S You have completed the worksheet for Pro ject 1. The nextthingyou will 
do is print the worksheet you just completed. It is always a good idea to 
save a document before printing it. Save your work now. 

Printing from Excel involves defining how you want the wo rksheet to 
appear and then issuing the Print command. You can indicate ho w you 
wanttheoutputto appea r by using the Page Setup command. When you 
have finished setting up the page's appearance, you tell Excel to prin t 
the document. 

Excel allows you to print headers and footers when you print your 
worksheet and gives you the o ptio n o f printing the row and column 
headings and grid lines shown on the screen. These optio ns are available 
in the Page Setup dialog box, which is selected by choosing Page Setup 
from th e File menu. 

Before you print your worksheet, you will modify the headers and 
footers and choose not to print gridlines and row and column headings. 

Header and Footer Formatting 

• Choose Page Setup from the File menu. 

The first thing you will do in this dialog box is change the headers and 
foote rs. A header is text that appears in the top margin, and a foo ter 
appears in the bottom margin, o f every page. In this book, the page 
number and chapter title appea r in the header at the top of each page. 

Unless you tell Excel otherwise, it has a set of default va lues that will be 
printed in the header and foote r. The filename of the document (what 
you named it when you saved it) will be displayed in the header, and the 
word "Page" and the page number will appea r in the footer. 

A default value is there fo r your convenience. In many instances, you 
might want these things printed on your o utput so you can identify it 
and keep the pages in orde r. A default value may easily be changed if you 
want something e lse, or nothing at all , in the header or footer. 

In this project, let's change the header so that the filename is at the left 
margin and your name is at the right margin of the page. The output wi ll 
be only one page long, so let's change the foote r to show the date and 
time. 

Befo re you can change what will appear in the header and footer, you 
need to know the available options. To learn more abo ut this, you can 
use Excel's Help. 

~ _7 • Press Command-Shi ft-/ (Command-?). 
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Excel o pens its Help window an · selects the File Page Setup screen: 

I 
Edit Formula Format Ooto 0 

FI LE PAGE SETUP 
Controls the appoeronce or the prl nte<l w rksheet, macro 
sheet, cMrt, or \IDI!Di!:.IZ contenb. 

• Whenever \IOU save o document, the P390 Setu~ 
settt nqsore also save<!. 

• For morel nrormatlon, see Ftle P* Setup In the 
NicrOStlfl Excel R8kr8-. 

~ld1r, FHIIr 
T~po In the text and~ for P* 
numbers and formattlnq \IOU vont. '!., 
Headers and footers ore ol..,.op 112" from the top or 
bottom of the P&90 and 3/4" from the stde of the pa')e. 

lflrgi~V 

Determines omount of space betveen the edge of paper 
and the prl nte<l document. 

Macro Window 

Figure 9-30 Help screen fo r Page Setup dialog box 

• Move the po in ter to the underlined words "header and footer 
codes." The arrow po in ter wiU change to a pointing hand (see Figure 
9-30). Click the mo use button . 

This tells Excel to show the screen that describes these codes. 

Edit Formula Format Ooto 0 

Header and footer Code• 
The IJ@!ij~Q command ollwo IJOU to customize 
headers ondToO!Oi's for prtnte<l documents. 1 
You do this b~ usl ng the follow! ng codes In the Heec1er end 
Footer boxes: I 
Type To 

&L Left·ollgn characters thot follow. 
&C Center cherecters thet follw . 

Rig ht -align characters thet follow. 1 
Print current dote. 
Print current time. 

Print name of document. 

Print the left, center, or right 

Macro Window 

Figure 9 -31 Header and footer codes for Page Setup 

.. When you are finished readi g this screen, click the Cancel bu tton. 

Let 's change the header first. ~ater, whe n you are print ing other 
works heets, you can choose wrat you want to have appear in the 
headers and footers. For now, enter the following commands (substituting 
your name in place of the words "Your Name"): 

• Header: &LLoan Analysis&R&BYour Name 

• Foote r: &C&D &T 
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(Insert fi ve spaces after th e "D" in the footer so the date and time will 
be separated by five spaces instead of running together.) 

This header format tell s Exce l t o print the words "Loan Analysis" against 
t he left margin of the pape r and to print your name in bold cha racters 
against the right margin . 

The footer fo rm at says that you want to center the curren t date, five 
spaces, and t he current time at the bottom of the page. 

Edit Formula Format Data s Macr o Window 

=lm_a~g~ew_r=it~e~r ~~-===~~~======--==·2-7 [~ 
Paper: @ US l etter 0 R4 l e tter 

0 US Legal 0 International Fanfold 
0 Computer Paper 

Orientation Spec ial Effects: 0 Tall Adjust ed 
0 50 '7. Reduction 
0 No Gaps Between Pllges 

Header: I &lloan Rnalysls&R&BYour Name 

Footer: I &C&O &~ 

Margl~ns~=:::;---~==::::;-1 
Lert: lo.?s I Right: lo.7s 
Top: ~~~==~~ Bottom: ~~~===i 

.. For Help on die log settings, press Commend-? 

I2SI Print Row and 
Column Headings 

I2SI Print Grldllnes 

Figure 9-32 Changing the header and footer codes 

Turning Off Gridlines and Row and Column Headings 

Figure 9-32 shows that the gridlines and the row and column headings 
will be printed. You can tell t hat because there is an "X" in th e check box 
next to each o ptio n. Thi s is the defa ult. 

If Print Gridlines is selected, each cell will be shown on the page 
surrounded by dotted lines, as you see them on the screen wh en working 
in the worksheet. 

Row and column headings a re the alphabetic headings that appear at 
the tops of the columns and th e numeric headings th at appear on t he 
left of the rows. These headings are used to determine cell addresses . 

The output from this loan analysis worksheet does not need either of 
these features to be printed , so you can te ll Excel not to p rint them. 

.. To turn off these fea tures, click the appropriate check boxes in the 
Page Setup d ialog box so the "X" d isappears in each o ne, and then 
click OK. 
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Page Preview I 

Excel allows you to preview your document before you print. 

38-P • Choose Print from the Fil e menu, and then click Page Preview in 
the Print dialog box. Click OK or press Return. 

You wi ll see a reduced view of the worksheet, including the headers and 
footers you just changed (see Figure 9-33). 

Figure 9-33 Reduced Page Preview screen 

Although this display is too small to read, it gives you an overall view 
of the worksheet. There are two ways to get a closer view of it. You can 
click the Zoom button, or you can move the pointer (now in the shape 
of a magnifying glass, as shown at left) over th e part of the page you want 
to see magnified and click the mouse button. 

• Use one of these methods to zoom into the previewed page and 
make it larger. 

You now have several choices. Th ere are five buttons at the top of the 
scree n (see Figure 9-34). Next wil l take you to the next page, if there is 
one, and let you preview it. Previous moves you back to the previous 
page. Either, or both, of these buttons will be dimmed if there is no page 
available in that direction. In this case, the document is only one page 
Lo ng, so both buttons are dimmed. 

You know whatZoomdoes. Print tells Excel to quit previewing and print 
the document, and Cancel tells Excel to close the screen and not print. 
You remain in preview mode until you deselect Page Preview in the Print 
di alog box. 

Now that you have made the suggested changes, it is time to print your 
document. 
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• Cli ck the Print button to print your worksheet. 

R Nt~!lt n ( l'reuhlUS ) ( Zoom ) ( Print ) ( Cnncel 

Loon Type Student Loon 

Totol Amount $2,500.00 
Own Poymont $0.00 
Term of le&n 5 years 
Annuol lnter est Rote 8.500 percent 

Amount Ftnoneed $2,500.00 
Term or Loon 60 months 

Monthly Payment $51.29 

Totol Amount to be Repaid $3,077.48 
Totellnterest $577.48 

Figure 9-34 Enla rged Page Preview 

WHAT IF ... EXERCISES 

As previo usly discussed, one of the most powerful features of electronic 
spreadsheets is their ability to auto matically recalculate all formulas and 
update the di splay when ever any changes are made. 

In this las t sectio n o f Pro ject 1, you will calculate several student loans, 
ca r loans, and house loans, and then save the last o ne of each o f these 
to your disk to use in Projects 2, 3, and 4. 

Note: When analyzing some of the following loans, you may see a string 
of number signs(#) in one o r m ore of the cells. This is an error message, 
and it means thatthe value in that cell is too wide to fit. You can remedy 
this by increasing the width of the column containing these symbols. 

These exercises a re presen ted so you can experience the speed of Excel 
and th e power of ''what if" analysis. As you work through th ese exercises, 
you wi ll lea rn how easy it is to use a worksheet fo r loan analysis. 

If you intend to work through Projects 3 and 4, you must work th rough 
th ese what if ... exercises. The spreadsheets you will save in steps S, 10, 
and 15 will be used in those projects. 

Calculating Student Loans 

You have already entered all the data to evaluate a student loan into the 
tem plate you created, so let's save a copy of it. 

• Choose Save As from the Fi le menu. Save a copy of t his worksheet 
o nto your di sk and name it Student Loan. 
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What if .. . 

1. The interes t rate rose to 9.25%? How much would the mo nthl y 
paym ent increase? How much would the total interest repaid 
increase? 

Hint: Select the cell that co11tains the mmual interest mte. Type 9.25 and 
accept it. 

2. What if the interest remained at 8 .5lVc> and the term increased to 
7 years? How would that affect the mo nthly paymen t and to tal 
interest? 

Hint: Select the cell that contains the annual interest mte. Type 8.5 and 
accept it. Select the cell that contains the term of loa11, and e11ter 7 
into it. 

3. What if the in terest remained at 8.5% and the term decreased to 
3 years? How would that affect the loan? 

4. What if t he interest rose to 11% and the term increased to 7 
years? How would that a ffect the loan? 

5. What if the amo unt is $5,000, the rate is 9°A>, and the term is 5 
years? 

r a File Edi t Formula Form at Dat a Options Macr o Window 
., 

A 1 Loan Type 

... Ready 

Figure 9-35 Pina l versio n of Student Loan worksheet 

• Save this worksheet with the I mounts in step 5 fo r use with Pro jects 
3 and 4. 

Calculating Car Loans 

You are read y to eva lua te a car loa n, so save a copy of this worksheet. 

• Enter Car Loan in ce ll Bl. Choose Save As fro m the File menu. Save 
a copy o f th is worksheet o nto your disk and name it Car Loan. 
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What if ... 

6. The car you want to purchase costs $17,995.3 7 and the interest 
rate is 12% fo r 5 yea rs? You will put down a down payment o f 
$2,000. What is the amo unt o f the mo nthly payment? How 
much total interest would you have to repay? 

7. What if the inte rest remains at 12% and the term decreases to 4 
yea rs? How would that affect the month ly payment and total 
interest? 

8. What if th e dealer o ffered either an interest rate o f 3 .9% or 
$1,000 back? The term o f the loan is 5 yea rs. If you take the lower 
in terest rate your down payment remains at $2,000. If you take 
the cash back, your interest rate is 12%, and you add the extra 
$1,000 to your down payment, for a total of $3,000. Which is 
the best dea l? Wh y? 

9 . What if the interest was 10%, the down pay ment was $2,000, 
and th e term of th e loa n was 6 years? How would that affect the 
loan? 

10. What if you decide to buy a different ca r, which costs $9,996.77, 
and you can fin ance it for $1,500 down at 8.9% for 5 years? 
What would your mo nthly payments and total interest be? 

r 4i File Edit Formula Format Dote Options Macro Window 

Figure 9-36 Final version of Car Loan worksheet 

:3€ -S ,.,. Save this worksheet with the amounts in step 10 for use with 
Pro jects 3 and 4. 
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Calculating House Loans 

W-S 

You are ready to eva luate a house loan, so save a copy of this worksheet. 

• Label this loan as a House Loan (in cell B 1). Choose Save As from the 
File menu. Save a copy of this worksheet onto your disk and name 
it House Loan. 

What if ... 

11. The ho use costs $45,000 with 15% down, and it can be financed 
for 30 yea rs at 11.875%? What would be the monthly payment, 
total amount repaid, and total interest? (Hint: Don't calculate 
the down payment and then enter an amount. Enter a formula 
multiplying the total amount by .15. After all, this is a spreadsheet 
program!) 

12. What if you put down 25% and financed it for 10.9%? How 
would that affect the monthly payment and total interest? 

13. What if you had the same terms as in # 1, but you financed it for 
o nly 20 years? How would that affect the loan? 

14. What if the interest rose to 14o/oand the term stayed at20years? 
How would that affect the loan? 

15. Evaluate the loan for a house costing $51,500 that you can buy 
with 20% down. You can get fixed-rate financing at 10.5%. 
What are the monthly payments and total interest repaid for 
this loan if the term is 10, 15, 20, 30, or 40 years. 

,.. • File Edit Formula Format Data Options Macro Window 
., 

AI I I Loan Type 

1§ 1 House Loan 
A 8 c D E 

.HQ 1 ~luoe !House L,oan. 

10 .·. · ·. 
~ Term of Loan . . . .360 .months 

1 1 Monthl u Paument i · ·~376.67 . . .. 
E . . .... .. ... . 
13 Total Amount to be Repaid $ 135.674.13 
1 4 Total i llterest · · $94.474.13 

Figure 9-37 Final versio n o f House Loan worksheet 

• Change the term of the loan dack to 30 years and save the worksheet 
with th e amounts in step 15 for use with Projects 3 and 4. 
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This completes Project 1. 

3€-W ,,. Close the active worksheet now. 

You have saved the original Loan Analysis, as well as three additional 
worksheets: Student Loan, Car Loan, and House Loan. 

The Loan Analysis worksheet will be used in Project 2, where you will 
learn to use some of Excel's charting features . 

The other three worksheets will be used in Project 3, where you will 
create a monthly budget, and in Project 4, where you will expand that 
monthly budget into an annual budget. 

Project 2: Creating Charts 

In this project you will learn to create charts, modify their formats, and 
print them. You will use the Loan Analysis worksheet from Project 1 to 
create a column chart that compares the amount borrowed to the total 
amount of interest for a loan. You will add a title and a legend to the 
chart, modify the patterns used in the chart, change the format, and 
print the chart . Then you will modify the worksheet, produce a pie 
chart, and print it. 

Many people have difficulty comparing numbers that are printed in a 
list, but when those numbers are presented in a chart, they are often 
easier to grasp. 

To begin this project, you should have completed Project 1 first, since 
you will be using the Loan Analysis worksheet that you developed there 
as the basis for starting this project. 

• If you have quit Excel since completing Project 1, insert your data 
disk into the drive, find the Loan Analysis document, and double
click on its icon. 

,,. If you have not quit Excel since completing Pro ject 1, close all open 
worksheets, and open the Loan Analysis worksheet that you created 
in Project 1. 

The final output of Project 2 is shown in Figure 9-38. 
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Figure 9-38 Final output of Project 2 
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TYPES OF CHARTS 
Excel offe rs a w ide va ri ety of ch art types, seve ral of which a re discussed 
nex t. 

A column chart (see Figure 9-39) offers com pari sons between two o r mo re 
groups of da ta, known as data series. (For example, you can chart incom e 
am ounts fo r severa l months a nd also expe nse amo unts fo r th e sam e 
m onths. This would be two da ta series. Each mo nth would con ta in two 
columns, one fo r each data series.) Excel has eight column cha rt 
variatio ns available. 

t OK 1J 

Concel 1 

NeHI .•• 

( Preuious ... 1 

Figure 9-39 Excel's column chart options 

A line clwrt (see Figu re 9-40) is used to show ch anges that occur over a 
period of time. They are also useful for spotting tre nds, because they 
em ph asize th e ra te of cha nge over time. Excel offers eigh t types of line 
charts. Li ne c ha rts can a lso show more tha n on e data series. 

line H OK lJ 
Cancel 

NeHI... 

( Preulous ... 1 

Figure 9-40 Excel's li ne ch art options 

A piechart (see Figure 9-41) sh ows a wh ole composed of a group of item s. 
All ite ms shown in a pie c ha rt must be a part o f one single wh ole. This 
means that only one data series 111ay be shown using a pie chart. 
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(( OK JJ 

Cancel 

NeHI. •. 

( Preulous ... ) 

Figure 9-41 Excel's pie chart options 

Excel also provides area, bar, scatter, and combination charts. When you 
chart your data, you can easily change the type of chart, or one of the 
styles for a chart, by choosing the one you want fro m the Gallery menu. 
In fact, you might decide to display the same data using d ifferent charts 
to emphasize different aspects of the data in each cha rt. 

PARTS OF A CHART 

The various parts of a chart are shown in figure 9-42 and described 
below. 

Yulue axis C hart tillc 

(Y axis) J 

""" Amount Financed versus Total interest 

""" $2,500.00 
$2,500 00 

Chart legend 

I 
$2,000.00 

~ 1 ,500 00 
Data series D Amount f inanced 

Data series 
markers 

~0 00 --Category axis 
(X axis) 

Figure 9-42 Major parts o f a chart 

Chart title The text used for the ti tle of the chart. There may 
also be subtitles present. 

Categoty axis The ho rizontal axis (o r X ax is) commonly used to 
show the data classifications, or categories. A pie 
chart has n • category ax is. 
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Data series markers This is the indicator used o n a chart to represent 
each grou p of data items. A column chart o r bar 
chart uses rectangles for markers, and a line chart 
uses small symbols such as circles, rectangles, 
triangles, and so on. 

Cha1t legend The symbols and tex t used to identify the different 
groups o f data items shown in the chart. 

Tick marks The short lines that intersect the axes and are used 
to represent d ivisions on th e category axis and the 
scale o n th e va lue axis. 

Value axis The vertical axis (or Y ax is) that is used to p lot the 
qua ntity o r unit o f measure fo r the data items. A 
pie chart has no va lue axis. 

CREATING A COLUMN CHART 

Selecting the Cells 

Excel makes it easy to create a column chart from the worksheet. Some 
electronic spreadsheets make you specify many values before you ca n 
see a chart. With Excel, you just select a group of cells, and Excel opens 
a new chart that automatically contains the data you selected on th e 
worksheet. 

To produce thi s chart, you will need to select the cells contai ning th e 
amount financed and the total interest. 

It would seem natura l to select just those two cells, but if you chart just 
those cells, you will find it harder to add a legend to indicate what the 
cells represent. For that reason, you should also select th e ti ties to the left 
of the cells, as shown in Figu re 9-43. 

• Select cells AS and BS by pressing the mouse button on AS and 
dragging over to BS; then release the butto n . 

Selecting a range of cells using this method works just fi ne if all the cells 
are contiguous (next to each other without any gaps between them). 
Sometimes, as in this case, you need to select gro ups that are not 
contiguous. If you were to press and drag from A14 to B14 now, you 
would select the new range, but the process would deselect the first 
two cells . 

Excel gives you an easy way to make no ncontiguous multi pie selectio ns. 
If you select o ne o r more cells, and then ho ld down the Command key, 
Excel will a llow you to add add itio na l cells o r ranges to th e current 
selectio n. That is what you will do now to se lect the cells in row 14. 

- Hold down the Command key, and select cell s A14:B14. 
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Now that you have selected the c lis you want to cha rt (see figure 9-43), 
you need to te ll Excel to open a 1ew chart. 

' a File Edit Formu111 Form11t 011 t 11 Op,tlons M11cro Window 
A 14 I I Toto I Interest 

10 Loon Anolysls 0 1 
A B C D E 

.~ I B 

Figure 9-43 Ma king a multiple-cell selection using the Command key 

Creating a New Chart 

When you create a new fi le, Excel gives you a choice of opening o ne of 
three types of files: Worksheet, Chart, or Macro Sheet (see Figure 9-44) . 

New (( n OK 
o worksheet 
@Ch11rt ( Concel I 
Q M ocro Sheet 

Figure 9-44 New fil e dialog box 

You have already completed a worksheet, and in this project you will 
create a chart. A chart is used to display the information conta ined in 
a worksheet in the form of a graph ic. 

A macro sheet is used to contain a series of Excel commands that are used 
to automate specific tasks. Macros are useful if you perform a task o r 
series of tasks on a regula r basis. However, macros are beyond the scope 
of this book. 

3€ -N • Choose New fro m th e File menu. Si nce you want to create a new 
chart, select Chart and click OK. 

(You could optiona lly choose to double-cl ick Chart as a shortcut.) 

In a few seconds, a new windo appears o n the screen showing your 
data in a column chart (see Figu e 9-45). 
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'* File Edit Gallery Chart Format Macro Window 
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Chart 1 D 
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IIH': :::+-------~---~----~-~- : ···---~'-----~-
.. Ready 111!111 

Figure 9-45 Creating a new column chart 

The left colum n represents the amoun t of the loan, an d the right 
column represents the total interest. 

Excel offers an easy way of labeling this cha rt so that each column's 
meaning would be readily apparent to anyone. This label is known as a 
legend. 

Whenever you create a chart showing more than one series of data, it is 
a good idea to add a legend. A legend is an area o n the chart that shows 
th e pattern of each column and tells what that column represents. 

Since you previously chose a title to the left of each value in the 
wo rksheet before you created the chart, adding a legend is o nly a matter 
of issuing the command. 

• Choose Add Legend from the Chart menu. Click the Zoom box to 
en large the chart. 

Excel adds a box to the right of the chart, showing a rectangle labeled 
"Amount Financed" and another rectangle labeled "Total Interest." 

It is difficult to tell exactly what amount each of the columns represents, 
but you can tell Excel to show the amoun t represented at the top of each 
colu mn. To do this, you will select a different style of column chart from 
the Ga llery menu. 

• Select Column from th e Gallery menu. 

This will produce a d ialog box showing eight different types of column 
charts. The one you want is shown in box number 7. 

• Click o n column chart sty le number 7, and then click OK 

Excel quickly redraws th e cha rt, and now each column has the value 
from the worksheet shown at the top of the column (see Figure 9-46). 
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Adding a Title 

409 

r s File Edit Gallery Chart Fo mat Macro Window 
., 

D hart! 

$2,500.00 
$2,500.00 

$2,000.00 

$1,500.00 
• Amount Financed 

$1,000.00 
D Total Interest 

$577.48 

$500.00 

$0.00 

... Reedy 

Figure 9-46 Changing to column chart style 7 

That's how easy it is to create a chart in Excel. Now that you have a good 
start on this chart, it is a good t ime to save it. 

The first new c hart you create in a session is named "Chartl " by de fault. 
When you choose Save from the File menu, or type Command-S, Excel 
recognizes this as a default name and pu ts up the Save As dialog box so 
you ca n name the chart and specify where it is to be saved. 

8€ -S • Save the chart to your data disk, and name it Loan Column Chart. 

The chart now shows two amounts, both graph ically and numerically, 
a nd indicates in the legend what they re present . Most charts also 
contain some type of title that indicates what the whole chart represents. 

Adding a title to your c ha rt consis ts of tell ing Excel to place text in the 
tit le ele me nt, typing that text, and defin ing the font, size, and style 
you desi re. 

• Choose Attach Text from the Chart menu. 

Figure 9-47 shows that you ca n attach tex t to several elemen ts of a chart, 
including the title, va lue axis, catbgory axis, and series and data points. 

Attach TeHt To n J) OK 
®Chart Title 
0 Ualue A HiS ( Cancel J 
0 Ca tegory AHis 
0 Series and Data Point 

Smi<!~ Number: D 
l'oint Numbm~ D 

Figure 9-47 Attach Text dialog box 
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.. Select Chart Title if it is not selected, and th en click OK. (You can 
double-click Chart Title if you prefer.) 

Excel will create a text block, attach it to the chart (surrounded by eight 
selection squares), and put the word "Title" in th e formula bar as shown 
in Figure 9-48. 

r • File Edit Gallery Chart Format Macro Window 

Ti t le Title 

$2,500.00 

$2,000.00 

$1,500.00 

$1,000.00 

$500.00 

$0.00 

.. Ready 

Loan Column Chart 

$2,500.00 

DOD 
CfitliD 
DOD 

$577.48 

Figure 9-48 Attaching text to the chart ti t le 

• Amount Financed 

DTotal lnterest 

., 

Using Selection Squares 

Text objects (such as titles) are surrounded by eight selection squares 
when they are selected. These selection squares may be black o r wh ite, 
depending upon what type o f object is currently selected. 

Text surrounded by black squares may be resized and moved, but text 
with white selectio n squares is sized and placed by Excel, and you ca n 
not change this placement. The title wi ll be surrounded by white 
squares, which indicates that Excel will automaticall y size and p lace th e 
text, based on its length, size, style, and font. 

You can move o r size a text e lement that is surrounded by black selection 
squares by clicking on o ne o f the squares and dragging it. 

Chart Formatting Options 

Many formatting options are provided for changing the appea rance of 
a chart in Excel. 

This project suggests that you change the fo rmat of three elements: the 
text in the title, the patterns in the columns, and the placement of the 
legend. By making these changes, you wi ll lea rn how to modify the chart 
to suit your preferences. The methods you use here wi ll apply to any 
Excel chart you create o r modify in the future . 
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Formatting Text 

The first formatting you will do is to change the font, size, and style of 
the title. 

• While the title is selected, type Amount Financed versus Total 
Interest, and then press Return. 

You will see the title change in the formula bar as you type. Unlike text 
in cells, text elements in Excel, such as the title, can be only one font, 
size, and style. 

Notice that the title is still surrounded by selection squares. To deselect 
the title, you can click anywhere in the chart window outside the chart 
area. This is a little difficult to do, because clicking anywhere on the 
chart will select the entire chart. The easiest way to deselect an element 
is to click between the top of the chart window and the top selection 
squares for the title. 

.. Click in the chart window to deselect the title. 

Now that you have entered the title, you might notice that the default 
size and style are a little too small for the title. You can make the title 
larger and more distinctive by modifying it. 

.. Select the title by clicking on it, and then choose Font from the Format 
menu. Choose Times font, 18-point, and italic (see Figure 9-49). If 
these choices are not available on your computer, make a comparable 
choice from what is available. 

r • File Edit Gallery Chort Mpcro Window ' I 

T1tle I 1 Amount Flnonced versus Tot~ I Interest 

ill!! 
Font ~ St yle ([ OK ;::) 
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New Century Sch 1Q: 9 lQ O Bold 
New York ] 10 h 181 1 tulle ( Cancel ) 
Pnlotino ' 12 0 Underline 

$ Son Francisco p- 0 St rikeout 
Symbol h I ,, 0 Out line ( Patterns ••. ) 

l ~t:Q 0 Shod ow ( TeHt ... ) 
l 

lnmes lin: I Background-

l 
~Color ®Automatic 

0 Transporent _. 0 [[] []] [[] !IJ [B) [II ®Automatic I Q Whlte Out 

$o.oo I I 
1 

©: 
, For Hel p on dialog settings, press Comm~nd-? I I m ~ 

Figure 9-49 Changing the font, size, and style for the title text 

Changing Patterns 

There is nothing wrong with the lack and white columns on this chart 
(if you have a color monitor the~ may be green and red), but there may 
be times in the future when you ant to select a different pattern for one 
or more columns. 
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Selecting a d ifferent pattern is a matter of double-clicking on the 
column you want to cha nge and then selecting wh ich pattern you want 
it to have. For this pro ject, you wi ll change the Amo unt Financed 
column to medium gray a nd the Total Interest column to a light 
diagonal stripe. 

,. Click on the Amount Financed column to se lect it. Choose Patterns 
from the Format menu. Select the m edium gray pattern (secon d 
from the left) inside th e Area rectangle (see Figure 9-50). 

• File Edit Gallery Chart Formal Macro Window 
SI P I I 1 =SERIESC"Loon Anolysls'I$A$B • ."Loen Anelysls"ISB$8: 

Border 
~ l) ® Rutomollc 0 lnulsible OK 

JStyle 
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-E:::::3 1---1 E31-·-·ll-··-l ~-I ' . ~·.1 ' 0 Rpply to 
~Color ~Weight 

_. O illJ!IJ[[I[Y]IBJ[I]I _~I II II 
Rll 

Rrea 
0 Rutomatic 0 lnuisible 0 l nuert if Negatiue 

[~ij.o s~~~~ -~~~~~•1 
uf oreground Color IIBockground Colo I 
~o~~oom~m •D~~oom~m 

.. ., ... ' ~ - ... 

Figure 9-50 Cha nging the column pattern 

(As a shortcut, you could h ave double-clicked on the Amo unt Financed 
column to change th e pattern assigned to it. You ca n use this shortcut 
to format a ny element in the chart window. Double-cli cking on an 
elem ent a utomatically selects it and brings up the Patte rns d ialog box.) 

• Cha nge th e Tota l Interest column to th e medium diagon al striped 
pa ttern (third from the right) by double-cl icking on th e To tal 
Interest column and then clicking o n the appro priate patte rn. 

An y item in a chart that has a pattern can be ch anged using this method. 

Moving the Legend 

When you tell Excel to add a legend, the default place me n t is o n the 
right side of th e chart. 

Sometimes the legend wou ld look better if it were moved to a nother 
loca tion. If you click on th e legend, you will see tha t it is surrounded by 
w h ite selection sq uares, wh ich indicate that you canno t just drag it to 
a noth er location. 

If you wan t to move the legend, you can select it and th en choose 
Legend fro m the Forma t menu. The legend can occupy one o f fou r 
loca tio ns: Bottom, Corner, Top, or Vertical. 

• Select the legend, and use the Legend command in th e Format menu 
to move it to the botto m o f the cha rt. 
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When the legend was on the rig~t side, the title seemed to be off cente r. 
However, w hen you m oved the legend to the bottom, the columns got 
wider, and now they look too wide for their height. Excel lets you m ove 
the legend to any o f these four locations so you can see how the chart 
will appear and c hoose the one you like best. 

,,. Try m oving the legend to the other locations, and then put it back 
where it started by selecting Vertical. 

at: -S ,,.. Now is a good time to save your work. 

Updating the Chart 

After you've made these formatting changes, your chart sh ould look like 
the one shown in Figure 9-51. 

'" * File Edit Gallery Chart Fqrmat Macro Window 
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Figure 9-51 Column chart after formatting changes 

., 

You h ave created a ch a rt that will graph whatever va lues are contained 
in the Loan Ana lysis worksheet. 

You can resize and move both the worksh eet and ch art so they are both 
visible. If you modify any of the values in the worksheet, the chart will 
be redrawn to reflect that ch an ge. 

Depending u pon the size of your monitor, you can choose to either slide 
the window to the right or resizEt it. The purpose is to be able to see the 
chart and column B of the Loan Analysis worksheet at the same time. If 
you have a large monitor, you cqn place both windows where they are 
visible, and size them t o suit youuself. 

Be advised, however, that how t t chart is printed is d irectly related to 
how you d imension the chart w·ndow. 
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• Move the Loan Column Chart window to the right unt il the legend 
disappears from the right side of the screen (if you have a regular-size 
Mac screen). 

• Use the size box of the Loan Analysis worksheet to resize its window. 
Move the windows around un til they a re both visibl e (see 
Figure 9-52). 

,.. .S File Edit Formula Format Data Options Macro Window 
., 
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loan Column Chart 

Amount Financed versus Total 
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$2,500.00 

m 
Figure 9-52 Resizing the windows to display both the chart and t he 

worksheet 

Figure 9-52 shows the chart you should see if you saved th is worksheet 
and used Save As to create a duplicate worksheet before entering the 
student loan figures in the what if ... scenarios in Project 1. 

Do not save the changes you make to the worksheet in the next three 
action steps . 

Refer back to the what if ... steps numbered 5, 10, and 15 in Project 1. 

• Enter the final values in step 5 into the worksheet and watch the 
chart change to reflect the new values. 

.. Enter the final values in step 10 into the worksheet and notice how 
the chart changes (see Pigure 9-53). 
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Figure 9-53 The ca r loa n amoun ts fro m step 10 in Project 1 
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.., 

•• Enter the final values in step 15 into the worksheet and watch the 
chart change again. 

Notice that this chart (Figure 9-54), unlike the o ther two, shows that the 
tota l interest is larger than the a m ount financed. Why is th is? 

,.. " 
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When a loan is amo rtized, the loan is ca lcula ted so that the sum of the 
payments over a period of t ime will exactly equal the sum of t he in terest 
and the amount financed. As t he length of the loa n increases, the 
payments decrease, but the to tal interest increases beca use you a re 
paying less toward reducing the debt with each payment. 
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A house Joa n financed for 25 years will have a higher mo nthly payment, 
but the to tal inte rest will be less than a Joan financed for 30 years. In fact, 
for the house loan you just calculated, if you increase the term of the 
loan to 107 yea rs or more, the monthly payment will not d ecrease any 
further. Adding more years to the term of the loan will only increase 
total inte rest. 

• Close the Loan Column Chart (without saving the changes). 

You might find it an interesting exercise to vary nothing but the term 
of the loa n and watch the interaction between total interest and the 
monthly payment. 

CREATING A PIE CHART 

WARNING 

The amount financed plus the total interest adds up to the to tal amoun t 
of a ll the payments. This means that the two components make up a 
whole. There is a better chart than the column chart for com paring more 
than one item that adds up to a whole. The type of chart that is most 
useful for this type of comparison is the pie chart. 

In the next several steps of this project, you will make some of the most 
common mistakes that new spreadsheet users encounter. Then you will 
lea rn how to se t up your worksheet properly to keep from making these 
kinds of mistakes. 

Sometimes saving your work frequently is not enough of a safeguard 
aga inst losing you r work. Since you have been advised that you will be 
making a few mistakes along the way, you probably don't want to risk 
losing the work you put into the Loan Analysis worksheet. A good 
method to use when there is potential for damaging a worksheet is to 
make a backup copy of the current (correct) version, and then work from 
that copy. 

- Choose Save As from the File menu. Name the worksheet Loan 
Ana lysis 2. 

You will now modify the Loan Analysis 2 worksheet so you ca n generate 
a pie chart to compare the amount financed and total inte rest amounts. 
You will be working with the house loan figures in step number 15 of 
the what if ... scena rio of Project 1. 

Modifying the Worksheet 

You will start this chart the sa me way you started the column chart. 

• Select th e fou r cells (A8:B8 and Al4:Bl4) the same way you did 
before. 

• Create a new chart. 

• Add a legend and move it to the bottom. 

• Select pie chart style 6. 
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What happened to the total int rest amount (see Figure 9-55)'? Why is 
there only one patterned rectangle and a number 1 in the legend? 

I 

r -' File Edit Gallery Chart Format Macro Window 
., 

§0 Chart I 

Amount Financed 

100.00% 

._Reedy 

Figure 9-55 C rea ting a pie chart that doesn't do exactly wh at you wa nt 

The answer to these questions lies in the d ifferences between column 
ch arts and pie charts. Column cha rts allow th e comparison of multiple 
values that do no t necessarily comprise a whole amount. Pie charts, o n 
the o the r h and, on ly a ll ow the comparison of multiple values that do 
com prise a wh ole. (If you present information to other people using 
char ts, you would be well advised to find a good book on charting 
techniques and study it to lea rn the differences between cha rt types and 
their advan tages and disadvantages for the types of data you presen t.) 

When you selected a noncontiguous group of cells, Excel assumed thi s 
to represent m ore than on e data series. To create the p ie chart for thi s 
pro ject, you have to rearrange the worksh eet so that the two amounts 
are nex t to each o ther (contiguous). 

Adding New Formulas 

You need to make a copy of the four cells and paste them on two 
ad jace nt rows. Since you are becoming an experien ced Macintosh user, 
you probably have already started hatching a plan to accomplish this. 
Maybe it goes something like this:" All I have to do is copy the first two 
cells and paste them below the ast row o f the worksheet. Then 1 can 
copy the oth er two cells and pa te them right below that." 

Maybe you are even more creati~e and have decided that you o nly h ave 
to copy the amount fina nced cells and paste them directly below the 
total interest amount. 

This sounds like a good p lan, but it will not work. 
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3€ -W ,,. Click in the close box to close the new pie chart without saving 
it. (You can also choose Close from the File menu, or type 
Command-W.) 

3€ -C ,.,. Select cells A8:B8 and copy them. (You can use the Copy command 
from the Edit menu, or type Command-C.) 

3€ -V .. Select cell Al6, and paste the two cells into A16:B16. (Use either the 
Paste command from the Edit menu or type Command-V.) 

How did the Amount Financed on row 16 become $376.87? The answer 
to this lies in how Excel helps you in creating large and/or com plicated 
worksheets. 

If you examine the formula in cell B8 and compare it with the formula 
in B16, you will find that they are similar, but Excel has made some 
changes for you. 

Cell B16 has the formula =B11-Bl2, but cell B8 has the formula =B3-B4. 
In both cases, using relative addressing, they tell Excel to subtract the 
value of the cell four rows above the cell containing the formula from 
the value of the cell five rows higher. 

Look at the value displayed in cell B16. If you move up five rows you will 
find the value $376.87. The cell four rows above B16 is empty. When 
Excel tries to subtract the empty cell from the cell with $376.87, it 
produces the result $376.87, just as if the value of the empty cell were 
a zero. 

To correct this problem, you will modify two of t he formulas using 
absolute addressing. There are at least two ways to accomplish your 
objective. You could easily type the new formulas into cells B 16 and B 17, 
using the exact formulas in B8 and B14. This is a valid way to solve this 
problem, but it would not help you learn about using absolute addressing 
in creating formulas. Therefore, let's modify the formulas in B8 and B14, 
and then copy and paste them into rows 16 and 17. 

Modifying the Formulas 

Before you make the modifications to the two formulas, why don't you 
erase what you already copied into row 16? There are several ways to 
do this. 

Since you haven't done anything since pasting the values into row 16, 
the easiest way to remove them is to choose Undo from the Edit menu, 
or type Command-Z. This will always undo the last thing you did. 

If you want to clear some cells and it was not the last thing you did, you 
can click on a cell, press the Backspace or Delete key, accept the new 
empty value, and do the same to any other cells you want to clear. 
Whenever you are erasing one or only a few cells, this is often the fastest 
and most convenient method. 
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Excel p rovides a third method that is mo re useful if you want to e rase 
a larger group of cells. It also provides a selective way to delete only the 
fo rmula or fo rmat of the cell, a no te a ttached to the cell, or all of these 
attribu tes. This is performed using the Clear command from the Edit 
menu. Let's t ry this method here. 

• Select cells A16:B16. 

00 -B • Choose Clear fro m the Edit men u. 

• Select All, and accept it by clicking OK. 

Now that you have erased the incorrect informatio n, modifying the 
formula in cell B8 to produce correct results is a straightforward process. 

• Click in cell B8. Change the formula to =$B$3-$B$4 byeitherretyping 
the who le formula or inserting the do llar signs in the formula bar. 

The do llar signs are the means by which you inform Excel that you want 
to refer to exactly cells B3 and B4 (absolute addressing), not the cell five 
rows higher and the cell below that (relat ive addressing). 

Fo ur ways to use absolute and re lative addressing are shown in Table 9-6. 

B4 
$B4 
B$4 
$B$4 

Table 9-6 

Rela tive co lu mn and re lative row (the default) 
Absolute column and relative row 
Re la tive co lumn and absolute row 
Absolute column and absolute row 

Four possibilities for absolute and relative ad d ressing 

Depending upon the circumstances, you might use any of these four 
methods of addressing. The most commo n methods, by far, a re the first 
and last o nes shown in the table. The two midd le forms are for special 
circumstances, and you should be ca reful in their use. 

00 -C 00- V • Now that the formula has been adjusted using absolute add ressing, 
copy cells A8:B8 and paste into cell Al 6. 

00 -C 00- V • Modify the formula in cell B14 so that it also uses absolute addressing, 
copy A14:Bl4, and paste into A17. 

:3€ -S • Save your wo rksheet again. 

You have adjusted the formulas so that they will produce the correct 
values when they are copied and pasted, and they have been moved so 
that they are contiguo us. It is t ime to once again try to create a pie chart. 
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Creating a New Chart 

• Select ce ll s A16:Bl7. 

~ -N • Choose New fro m the rile menu, and create a new chart. 

• Select pie cha rt style 6. 

Printing the Chart 

.. Add a legend, and move it to the botto m . 

Th is will produce the chart sh ow n in Figure 9-56. 

r .S File Edit Gallery Chart Format Macro Window 
., 

§0 Chart2 

69.63% 

• Amount financed 0 Total 1 nterest 

.. Ready 

Figure 9-56 Pie cha rt compa ring Amo unt Financed and Tota l In terest 

• Ch oose Save As from the File menu, name the ch art, and save it onto 
your da ta disk. 

Now add a ti t le of your cho ice, change a n y patterns you wish, save the 
chart, a nd prin t it. Reme mber that the d imensio ns o f printed ve rsio ns 
are a result o f how the ch art appears o n your d isplay. 

If you decid e to come back later an d reca lculate a loan and wa nt to see 
th is pie cha rt, you wi ll have to use the worksheet you saved as Loan 
An alysis 2, because it is the o ne lin ked to the p ie chart you just created . 

If you are going to do the wh at if ... exercise be low, do not close the Loan 
Analysis 2 worksheet or th e pie chart. 
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WHAT IF ... EXERCISES 

To com plete this exercise, ch ange the amount in the Term of Loan cell 
in the Loa n Analysis 2 worksheet, and the chart wil l be redrawn. Click 
on the chart to make it active, and print it. Click on the worksheet to 
make it active again and make the next change. You do not need to 
create a new chart each time. 

1. Using the loan conditions in step 15 of the ho use loa n in Pro ject 1, 
modify the worksheet to p roduce the charts necessary to compare 
the di fferent loa n options. (The cost is $51,500, with 20lJt(, down, at 
10 .5% per year.) Print a chart for the loan a t 15, 20, and 40 years. 
Compare the changes in mo nth ly payments and the amo unt of 
inte rest you will pay to the lender. Compare the percentage 
composition of the loan by compari ng th e pic charts showi ng 
amount financed and total interest. 

This completes Pro ject 2. 

Project 3: Creating Linked Worksheets 

In this pro ject you will create a new worksheet representing a monthly 
budget. It will be composed of th ree main sect ions: income, expenses, 
and surplus/d efic it. You will learn to for mat date va lues and change the 
fon t, size, and style of values displayed in a cell. 

You also will learn to link va lues from one worksheet to anothe r. This 
is a very powerful and usefu l feature o f Excel. 

As an example, in this project you will link the mon th ly payment values 
calculated in the student, car, and house loans fro m Pro ject 1. If you 
were to lookat a different loan package, it would automatically reca lculate 
the loan, and if this budget worksheet were also o pen it wou ld be 
updated as well. That way you could see the impact on the rest of your 
budget caused by that particul ar Joan package. 

You will a lso create two charts in th is pro ject. A pie chart will show the 
breakdown of all your expenses, and a column chart will show the 
comparisons of total income, total expenses, and any surplus o r d efi cit. 

Figures 9-5 7, 9-58, and 9-59 show the fina l output o f Project 3. 
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Monthly Budget Miguel Garcia 

Budget 
Jan 1994 

Income 
Income #1 $1 , 400.00 
I nco me #2 $735.00 

Total I ncorne $2, 135.00 

Ex penses 
House $376.87 
Car $ 175.97 
Education $103.79 
Food $250.00 
Clothes $75 .00 
Insurance $150 .00 
Utilities $185 .00 
Entertainment $200 .00 

Total Ex penses $1 ,516 .63 

Surplus/Deficit $6 18.37 

Figure 9-57 Final output of Project 3 worksheet 
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l"lonthl y Budget Expenses Chart Miguel Garcia 

Comparison of Expenses 
• House 

D Car 

12.20% 

9.89% 

16.48% 

Figure 9-58 

11 .60% 

!illl Education 

llll!l Food 

[ill Clothes 

8 Insurance 

m Util ities 

~Entertainment 

Final o utput o f Pr ject 3 p ie c ha rt 
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I nco me vs. Expenses 

$2,500.00 

$2,000 .00 

$1,500.00 

$1,000.00 

$500.00 

$0.00 

I ncome vs. Expenses 

$2, 135.00 

$ 1,516.63 

$6 18.37 

Part IV: Spreadsheets 

Miguel Garcia 

• Total Inco me 

D Total Ex penses 

IN! Surplus or Deficit 

Figure 9-59 Final output o f Pro ject 3 column chart 



Chapter 9: Excel 425 

To begin this project, you must ave com pleted Project 1 first. You will 
be using the three worksheets that yo u developed in the what if ... 
exercises in that pro ject as imp rtant components of th is pro ject. 

• If you have quit Excel, restart it by double-clicking on its icon. 

• If you have not quit Excel, close all open files. 

~ -N ,.. Create a new worksheet by choosing New from the File menu. 

ENTERING TEXT AND NUMBERS 
,.. Enter the text shown in Table 9-7 in the indicated cells. 

Cell address 
Al 
A3 
A6 
AS 
A17 
A19 

Text to be entered 
Budget 
Income 
Total Income 
Expenses 
Total Expenses 
Surplus/Deficit 

Table 9-7 Text to be entered into new worksheet in colu mn A 

These cells are used to represent titles and to tal lines. 

• Continue adding the text shown in Table 9-8 into column B. 

Cell address 
B4 
BS 
139 
B10 
Bll 
1312 
Bl3 
B14 
B15 
B16 

Text to be entered 
Income #1 
Income #2 
House 
Car 
Education 
rood 
Clothes 
Insu rance 
Utilities 
Entertainment 

Table 9-8 Text to be entered in column B 

,,. Resize column A so that your worksheet looks like the o ne shown in 
Figure 9-60. 
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,.. e5 File Edit Formula Format Data Options Macro Window 
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Figure 9-60 Resizing column A to simulate indented category titles 

., 

By resizing column A so that it is only about two characters wide, you 
make the categori.es look like they are indented between the group titles 
and the to tal lines. In a word processor you would have done this by 
pressing the Tab key. Since Excel does not let you tab in a cell and typing 
two or three leading spaces results in uneven alignment, this is the 
easiest way to make your category titles and names appear to be 
indented and aligned. 

• Name this worksheet Monthly Budget, and save it onto your 
data disk. 

FORMATTING DATES 

A monthly budget should be labeled with the mon th and year it 
represents. Excel allows you to enter dates using more than one method. 
Excel allows you to use the DATE() function, but it also allows you to 
type the date directly, such as in 1/1 /94. 

If you use t he second method (1/1/94), Excel will assign t he date format 
m/d/yy to the cell. In this worksheet it is necessary to show only the 
month and year, so let's tell Excel to use a different format. 

,.. Enter 1/1/94 in cell CZ. Choose Number from the fo rmat menu, 
and scro ll down to the date formats. 

Excel offers four standard formats for dates. These formats, and how 
they would show 1/1/94, are listed in Table 9-9. 
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Date format 
m /d/yy 
d-mmm-yy 
d-mmm 
mmm-yy 

Displaved as 
1/ 1/94 
1-Jan-94 
1-j an 
j a n-94 

Table 9-9 Exce l's four standard date fo rm ats 

427 

Wh en you des ign a date format, you can specify how Excel will display 
the month, day, and year, how many characters fo r each , the order in 
which th ey will be displayed, and what punctuatio n you wan t, if any. 
The codes fo r creating these formats are shown in Table 9-10. 

Date format Meani n g Displa~ed 
d d ay as number 1-31 
dd numbe r with leading zero 01-31 
ddd day as abbreviation Mon 
dddd day as full name Monday 

m m o nth as number 1-12 
mm number with leading zero 01 -12 
mmm abbreviated name j an 
mmmm full name j anua ry 

yy last two digits of year 00-99 
yyyy year as four-digit number 1904-2040 

Table 9-10 Cod es used to create new da te formats in Excel 

This worksh eet will show th e date using the abbreviated n ame of the 
m o nth and the yea r as fo ur digits. It will no t show the day, because th e 
amounts in each co lumn apply to th e who le month . Wh en you entered 
the date, you specified the first d ay of th e m o nth, but you don 't n eed 
to sh ow it h ere. 

,,. To crea te the custom format, click in th e Format box, and type 
mmm yyyy (see figure 9-61) . 

.-F0_~-~:-E-a+t_0_~_um_b_e_r --------.~..,.., E OK ~ 

ff~~~::M I ( ::~::~ I 
h:mm:ss AM/ PM ll 
h:mm 0 

Format: I mmm yyyy 

Figure 9-61 Entering a custom date format 
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The ability to create custom formats m akes Excel very fl exible and 
a ll ows you to m ake your spreadsheet look as you wan t itto look. You can 
crea te custom fo rm ats for time and numbers as well. Excel even allows 
you to have d ifferent formats for positive, negative, and zero values . If 
you are using a color monitor and printer, you can have positi ve 
num be rs displayed in black and negative numbers in red. You can even 
add tex t in a for mat by encl osi ng it in quotation marks. 

Although th ese types of fo rmats are beyond the scope of this book, you 
ca n learn al l about them by looking up "Form at Number" in the 
Microsoft Excel Reference. 

NAMING CELLS AND RANGES 

In Pro ject 2 you lea rn ed about absolute and relative cell add ressing and 
how they were used in composing formulas. Excel offers another way to 
c rea te fo rmulas: by naming cells or groups of cells and then using those 
n am es in the formulas instead of their addresses. 

Table 9-11 contains a list of five cell ranges. When you e nte red fo rmulas 
into the worksheet in Pro ject 1, you entered the add ress of th e cell. In 
this project, you wi ll lea rn to name a cell o r range of cells and then use 
the name you defined in th e formula. This makes a formula more 
understa ndable and easier to read. 

Cell range 
C4:CS 
C6 
C9:C16 
C17 
C l9 

Table 9-11 

Nam e 
Income 
Totai_Income 
Expenses 
Totai_Expenses 
Surplus 

Na ming cells and ranges of cells 

Notice thatTotai_I nco me and Total_Expenses h ave underline characters 
instead o f spaces separating the words (see Table 9-11 ). Excel does not 
allow cell na mes to have any spaces in them. You h ave the option of 
jamming th e words together, but that reduces th e legibili ty o f the 
n am es. The underline character (creat ed by typing Sh ift-hyphen) 
separates th e words without using spaces. 

Let's n ame th ese five ranges and enter the formulas referring to them in 
th e worksheet. 

• Select cells C4:CS, and then choose Define Name from the Formula 
menu. 

Notice th at Excel has entered th e range of cells in the "Refe rs to:" box 
using absolute addressing (see Figure 9-62). 

... Na me this range Income and cl ick OK. 
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m Define Nnme 

19 ~ OK l) 
Nome: 

( Cancel l I Income I 
Ref ers to: 

( Dele te ) 

lo I · $C$'1:$C$5 I 

Figure 9-62 Nam e cells C4:CS as Income. 

• Define the Expenses, Surplus, Total_lncome, and Totai_Expenses 
names in the same manner. 

As you define each of these named ranges, you will see the previously 
defined names in the scrolling list on the left side of the Define Na me 
dialog box. 

ENTERING FORMULAS 

Now that you have defined the names of these ranges, you can use them 
to create formulas that are mo re understandable. For example, the 
formula =Total_lncome - Tota l_Expenses is much more meaningful 
than =C6-Cl7. 

You can enter formulas using the Paste Name command in the Formula 
menu, or you can type the fo rmu la instead. If you choose to type the 
names yourself, you must be careful that you make no mistakes when 
typing. The name must be entered exactly the same as it was defined. 
Using Paste Name instead of typing the names will prevent making any 
mistakes due to t ypographica l errors o r not remembering the exact 
name you defined. 

The Paste Name co mmand wo,rks similarly to t he Paste Functio n 
command you have a lready learned to use. In fact, in creating many 
formulas, both of these commands are used. 

You will enter only three fo rmul as in this worksh eet. They will be used 
to calculate the sum of the income amounts, the sum of all the expenses, 
and the surplus or deficit (wh ich , yo u may rem ember, is ca lculated by 
subtracting the total expenses from the total income). 

Try using the Paste Name method first to enter the formu la fo r 
calculating the tota l of the income sources. If you were told to add all 
the incomes, you would have no trouble doing that, because you would 
recognize that the income amo u7 ts were in cells C4 and CS. You would 
then determ ine the sum of these ~mounts . You might use a formula like 
total income= C4+CS or to tal in9o me = SUM(C4:CS). That's all there is 
to calculating the sum of the incomes . Let 's tell Excel to do this for you. 

• Sta rt the first formula by clic ·ing on cell C6. 

• Type = and then use Paste Function to enter the SUM() functio n into 
the formula bar. 
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You 've told Excel that you want it to ca lculate the sum o f something, so 
n ow te ll it which something you want it to add. 

• Choose Paste Name, select Income, a nd th en cl ick OK or press Enter 
o r Re turn (see fi gure 9-63). 

Surplus 
Tot aLE H pens e s 
TotaLincome 

n OK , 

( Cancel ) 

( p (j ~ h~ u ~ t ) 

Figure 9-63 Pasting a named group o f cells into a formula 

• To en ter the other two form ulas, enter the expressions shown in 
Table 9-12 into the proper cells. 

Cell 
C17 
C19 

Table 9-12 

Formula 
=SUM(Expenses) 
=Total_lncome - Tota l Ex Jenses 

The two rem aining form ulas for this worksh eet 

These are all the fo rmulas you need for this worksheet. 

• Format al l the cells that will contain numbers as currency, and then 
enter the numbers shown in Table 9-13 into the appropriate cells (in 
column C) . 

Categor~ Cell Number 
Income #1 C4 1400 
Income #2 C5 735 
Food Cl2 250 
Clothes Cl3 75 
Insurance C14 150 
Utilities Cl 5 185 
Entertainment C16 200 

Table 9-13 Amoun ts to be e ntered into column C 

Notice that you did not enter a num ber or formula into th e House, Car, 
and Educa ti on categories. That is because you will now link the 
calculated mo nthl y payments from the worksheets you c reated in 
Project 1 into the appropria te cells in this worksheet. 
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PASTING AND LINKING VALUES 

Excel has the ability to link a va l e in one worksheet to a cell in another 
worksh eet. Once the lin k has been establ ished, any changes made in the 
first worksheet would be reflected a utomatically in the second worksheet. 

If both worksheets are o pen, the change wou ld immediately take place. 
If only o ne worksheet was open when the change was made, and the 
changes were saved to disk, the second worksheet wou ld be updated 
whenever it was next opened. 

When you open a worksheet th at depends o n values located in a 
different worksheet, Excel wi ll ask if you want to update the references 
to that unopened worksheet (see Figure 9-64). 

Update references to 
unopened documents? 

([ Yes 

,---N-o--..) 

Figure 9-64 "Upd ate references to unopened documen ts?" dialog box 

If you answer "Yes," Excel will read the needed values and will then 
recalculate the worksheet that is open to reflect any changes mad e to the 
other one. Sometim es, though, you might wa n t to prin t the last version 
of the worksheet and do not want to update the document to refl ect any 
changes made since the last time it was saved. In that case, you can 
answer "No" and Excel will open the wo rksheet just as you last saved it. 

This ability to link worksheets is especially va luable if you have to create 
reports on a periodic basis th at depend o n values stored in multiple 
spreadsheets. If you link the worksh eets, the summary o r report document 
you must complete can be automat ica lly updated to reflect any changes 
you may have made in the othe r worksheets du ring the period since you 
las t prod uced the report. 

It is commo n for many fami lies to have one or more loan payments th at 
must be paid each m onth. Over a period of severa l yea rs the amounts of 
t hese loans will ch ange, and it wou ld be convenient if the current 
amount of the loan (s) were automatically shown in the budget worksheet. 

In this project, the budget show 
1 
a ho use payment, a car payment, and 

an education loan payment. If thF mo nthl y payment amount of each o f 
these loans could be linked to t~e budget worksheet, then you would 
have a powerful tool for eva luating new purchase options not only by 
the mo nthly pay ment, but also by how they would affect your budget. 

Therefo re, let's li nk each of the three loans this fam ily must repay 
(remember, you calculated and saved them in the what if ... exercises in 
Pro ject 1) to this budget workshee t. 
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Let's start with the Student Loa n worksheet. To link this loa n payment 
to the budget, you will copy the monthly payment amount from the 
Student Loan worksheet and the n paste it into the appropriate cell in th e 
Mon thly Budget wo rksh eet. 

This means that you must h ave two worksheets open at the sa me tim e. 
If you have a large moni tor, this is a simp le thing to do: just move th em 
to whe re they are both visible. O n the smalle r, stan dard Macin tosh 
screen you don't have room to sh ow two large windows. You h ave a 
choi ce of letting th e windows overlap or o f resizing the m and placing 
them so you can see the appropriate pa rts o fthe worksheets at th e same 
time. 

Remember, o nly o ne window in an applica tion is active at any t ime, so 
o nly one will have lines in the title bar, visible scroll ba rs, and oth er 
visible controls. If the window you need to use is not active, click 
an ywhere in that window, and Excel will make it the active window. 

You can also tell Excel which wi ndow you wa nt to ma ke acti ve by 
choosing its nam e from the Window menu. All open worksheets, ch arts, 
and macro sheets wi ll be listed by name in the Window me nu. If you 
wa nt to activate a window that can't be seen on the screen, just c hoose 
its na me in the W indow menu a nd it w ill be brought forward and made 
the acti ve wi ndow. 

.. Open the Monthly Budget worksheet and then the Student Loan 
worksheet. Place them so you ca n see them at the sam e time (see 
fi gure 9-65). 

,. 5 File Edit Formula Format Data Options Macro Window 
., 

Figure 9-65 Arranging the worksheets o n screen so both are visible 
at o nce 

• If it is not already th e active window, activate the Student Loan 
worksheet wi ndow. 
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• Select cell Bll (th e monthly p,aymen t amount) to make it the active 
cell. I 

3€ -C • Copy the payment amount. 

• Click in the Monthly Budget window to activa te it (or choose it from 
the Window menu). 

• Select the Education expense cell (Cll). 

• Choose Paste Link from th e Edit menu . 

Paste Link is a command that saves you a lot o f work when li nking 
wo rksheets. All you have to do is point to the cell from whi ch you want 
to link an d te ll Excel to cop y it. Then, by select ing the cell to which the 
first cell will be linked and choosing Paste Link, you tell Excel no t only 
to remember the originatio n cell 's address, but also the name of the 
worksheet, the disk on which it is loca ted, and the pathway through the 
folders to find the worksheet. 

Excel then pastes a ll this into the destination cell. l f both worksheets are 
open and you make a change to the Student Loan worksheet, Excel will 
update the Student Loan worksheet, and then it wi ll update the 
Month ly Budge t. 

Try this now, and watch as both worksheets change . 

• Change th e Annual In terest Rate in the Studen t Loan worksheet 
to 10%. 

If you were not watching careful ly, you may have missed seeing them 
change. After you make this change, you r worksheets shoul d contain 
the va lues shown in fi gure 9-66. 

r -' File Edit Formula Format Data Options Ma cro Window 
., 

: : : ; ~ - : ! : : . 

Figure 9-66 Changing the interest rate now modifies both worksheets. 
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,. Try this agai n. Leave the interest rate at lO(Y<l, and change the Total 
Amount to $7,500. 

You can see that the mo nthly paymen t amount rose, and in the 
Month ly Budget the total expenses increased and th e surplus d ecreased 
(as shown in Figure 9-67). 

,. j File Edit Formula Format Data Options Macro Window 
... 

Figure 9-67 Changing Total Amount affects both worksheets 

Now you are fini shed with the Studen t Loan worksheet. 

• Close the Student Loan worksheet. When Excel asks if you want to 
save the changes, answer No, so you ca n leave it with the same 
amounts it had when you opened it. 

00 -S • Save th e Mon thly Budget worksheet. 

After closing the Student Loan worksheet, loo k at the formula in the 
Education expense cell of th e Monthly Budget. The formula will have 
changed to show the names of t he disk, folders, and worksheet and the 
address of the cell(s) that a re linked to this cell. (Your formula should 
look similar to the o ne shown in Figure 9-68, but there may be some 
differences due to the way your d isk is organized.) 
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Figure 9-68 formula showing link to cell Bll of the Student Loa n 
worksheet 

In this case, the fo rmu la fo r cell Cll is ='Miguel Garcia Data:Student 
Loan ' !$B$11. In additio n to showing the absolute address of the cell 
that contains the informatio n (a fter th e exclamation point in th e 
formula), it a lso lists the disk and worksheet names. The address of the 
worksheet (which contains the disk name, any folders t hat must be 
opened, and the worksheet's name) is enclosed in single quotes. In this 
case, it says "li nk this cell to the aroun t shown in cell Bll in the Studen t 
Loan worksheet stored on a d isk named Miguel Garcia Data". 

If Miguel had stored this worksheet in the Final Pro jects folder on h is 
disk, the fo rmul a would have read ='Miguel Garcia Data:Fina l 
Projects:Student Loan' !$B$11. The procedure forstoring the worksheet's 
locatio n is to name the disk, then any folders that must be opened (Final 
Pro jects), then the worksheet. Each of these items must be separated by 
a colon (:).The entire location m ust be enclosed in single q uotes, and 
this must be followed by an exclamation point (!) before the cell or range 
address is listed. f ortunately, Excel does all of this automatically when 
you choose the Paste Link command. 

Before linking a spreadsheet to another one, it is a good idea to save the 
worksheet in case something goe~ wrong. If a problem occurs, you won't 
lose any of your valuable work!. and al l you have to do is close the 
worksheet (witlwut saving it), a 1cl then open the version you saved 
before the problem occurred. 



436 Part IV: Spreadsheets 

• Using the procedure you just learned, open the House Loan and lin k 
its monthly payment to the Mo nthly Budget, and then close the 
House Loan. 

You did remember to save the Monthly Budget before starting the next step, 
didn't you? 

• Link the monthly payment fro m the Car Loan worksheet to the 
Monthly Budget, and close the Car Loa n . 

00 -S .. Save th e Month ly Budget worksheet. 

After completing th ese steps, you should h ave a Month ly Budget 
containing the values shown in Figure 9-69. 

" C File Edit 
Cl 9 I 

"'' 

Formula Format Data Options Macro 
I =ToteLincome=ToteLExpenses 

. Monthly BUdget 

Window 
., 

c D E A I B ~ G 

-~1JI~BU~d~Q~e~1 ...... ,_ ................... ; ............. , ....... ".~-~ .. :·!···· .................. -............ ; ........................ _ ........ . j .. .................................. ; ....... . ......................... . f= 2 ~ · · · · · · ·Ja·n 19.94. 

6 ll'otal Income · · ·, · $2.135.00 · 
7 . . ' ·. · !. . . . . 

1 o · ·car · · · •175. ,7 · · · · 
1 1 Education . ; I o3. 19 . 
1 2 . ·Food . >2SO. lO 

. . . . . . '$75. )() . 
: ~ -~~~~~:snce , · · $1 SO. ·)Q · · · · 

1 5 iJ\ilititis . $ i as. )0 
1 6 ·Enter tai riment , · · i2oo.oo 
17 Tota.(Exoenses . $,' .51.6_.63 
18 ( . . . . . 

1 9 Sur ~lus/Deficit . $6 8 .37 
' :::: . 

.._ Reedy 

Figure 9-69 The completed Monthly Budget 

This project will be used aga in in Pro ject 4, so the fi na l version must be 
saved. (Do you get the feeling that saving your work often is important?) 

The next time you open the Monthly Budget worksheet, Excel will ask 
you if you want to update references to unopen ed documents. 

Update refere nces to 
unopened documents? 

([ Yes J] 

No 

Figure 9-70 The dialog box you w ill see whenever you open Month ly 
Budget 
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Excel is asking if you want it tor ad the three loan worksheets that are 
linked to the Monthly Budget anq ad just the budget worksheet to reflect 
any changes you may have mad4 to the loa n worksheets since th e las t 
time the Month ly Budget was sa ed . 

This is very handy. Even if your budget is not open and you make 
changes to one or more of the loan worksheets, Excel can automatically 
update the budget the next tim e you open it if you answer this question 
with Yes . If you answer the question with No, the Monthly Budget will 
be opened with the same figures it had the last time you saved it, even 
if you did modify one or more of the other th ree worksheets to which 
it is linked. 

CREATING A PIE CHART 

:3€ -S 

The next step in completing t his pro ject is to create a pie chart showing 
a comparison of the expenses. You will not have to move any cells, 
because this worksheet was designed to make thi s an easy task. 

.. Select cells B9:C16, and then crea te a new pie chart, using pie chart 
number 6. Add a tit le and a legend, and make whatever format 
changes you prefer. 

You r chart should look simi lar to th e one shown in f igure 9-71. 

' l5 File Edit Gallery Chart Format Macro Window 

10 

Comparis on of Expenses 

16.48% 

... Ready 

R House 

Dear 

D Ed ucation 

R food 

0 Clothe• 

E3 tnsuronce 

OJ Util ltle• 

~ Entertol nmenl 

Pll 

Figure 9-71 Pie ch art compari ~g expense amounts 

• Save this pie chart as Month y Budget Expenses Chart. 

:3€ -P • Print the pie chart. 
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CREATING A COLUMN CHART 

The pie chart was easy to create. Now let's create a column chart 
comparing total income, total expenses, and surplus/deficit. You want 
to show the three numbers o n the chart, and the legend should contain 
a name for the numbers represented by th e colum ns in the cha rt. 

To select no ncontiguo us cells or ranges of cells, use Command-click a t 
the beginning of each ran ge to te ll Excel that you want to trea t 
noncon tiguo us cells as a group. 

.. Select cellsA6:C6, A17:C17, andA19:C19 and create a column chart. 

What's wrong with this chart? There is a space for a data series with no 
data. You chose a selection three co lumns wide, and Excel assumed that 
the first column had the title of the data series, and it does. Then Excel 
assumed that both columns Band C contained data associated with that 
series, but that is not correct. Because there is no informatio n in column 
B in these rows, Excel plotted a column with a height of zero. 

This is not what you want to do. If you moved the titles into column B, 
you could select the cells in Band C in each row, and Excel's assumptions 
about creating a new chart shou ld work. It sure seems a shame to have 
to go in and rearrange your worksheet after getting th is far. Luckily, you 
don't have to do that. 

11,. Close the new chart without saving it. Using Command-click again, 
choose only cells C6, Cl7, and C19. Create a new column chart. Add 
a legend to the chart. 

When you told Excel to add the legend, it put the legend on the right 
side of the box with three patterned rectangles, but there are no words 
associated with the patterns. Thi s is because you chose on ly cells 
containing numbers, and Excel had noth ing to use as names for those 
numbers. 

Th ere is an easy way to modify th e data series you just charted so Excel 
will have a name associa ted with each o ne. 

~~• Click on the column on the left (wh ich represents income) . 

When you do, Excel shows a formula that starts with =SERIESC, in the 
formu la bar. The space between the open ing parenthesis and the first 
comma is where the name of the series goes . 

,,.. Click between the opening parenthesis and the fi rst comma, and 
enter "Total Income" (you must enter th e q uotation characters) . 
Accept the formula. 
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Your chart should now look si, ilar to the one shown in Figure 9-72. 

r e5 File Edit Gallery Chort Format Macro Window 
s 1 P 1 =5ER1ES("Total lncome",,"Monthly Budgel"!$C$6:$C$6, 1) 

Chart4 

$2,500.00 

$2,000.00 

$1 ,500.00 

$1 ,000.00 

$500.00 

$0.00 

.. Ready 

Figure 9-72 Naming the Total Income data series 

• Tote11ncome 

0 

11 

., 

",. Select the center column and name it "Total Expenses", and then 
name the right column "Surplus or Deficit". 

Your chart should have a complete legend. You can now add a title and 
make any formatting changes you desire. 

3€ -S • Save this chart as Monthly Budget Column Chart. 

You now have completed Project 3. Be sureto saveacopyofthe Monthly 
Budget worksheet for use in Project 4. 

WHAT IF ... EXERCISES 

When you work through these what if. .. exercises, do not save any changes that 
you make to yow· worksheets, so you will have the proper values in the Monthly 
Budget for use in Project 4. 



440 Part IV: Spreadsheets 

There are a number of things you can do now. A change to any of the 
three loan worksheets will affect the Monthly Budget worksheet as well 
as the two charts you just created. 

For example: 

1. What if you spend $1,000 this month to buy that new video camera 
you've been dying to own? This will make your expenses for the 
month greater than your income, and your surplus will turn into a 
deficit. Hint: Try adding $1,000 to the Entertainment expense category. 

2. What if you bought that $20,000 car you've been wanting? How will 
that affect your budget? Could you afford it? Hint: Modify the Car 
Loan worksheet and see how it affects your budget. 

3. What would happen if you got a 20-year house loan instead of 30 
years? How much extra money would you have for something else 
by not having to make house payments for an extra ten years? (Hint: 
Subtract the total amount to be repaid for the 20-year loan from the same 
value for the 30-year loan.) How much would your monthly payment 
increase? Would it fit into your budget? 

Project 4: Developing an Annual Budget 

In this project you will modify the monthly budget you created in 
Project 3 and expand it into an annual budget. You will learn to use the 
split bars, create a sequential data series, and make extensive use of the 
Fill Down and Fill Right commands. 

You will create two chart s in this project. A pie chart will show the 
breakdown of all your expenses, and a line chart will show the 
comparisons of total income, total expenses, and any surplus or deficit 
over the 12-month period. 

The final output of Project 4 is shown in Figures 9-73, 9-74, 9-75, 
and 9-76. 
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Budget 
Jan 1994 Feb 1994 Mar 1994 Apr1994 May 1994 Jun 1994 Jul 1994 

Income 
Income #1 $1 ,400.00 $1 ,400.00 $1 ,400.00 $1 ,400.00 $1,400.00 $1,400.00 $1,400.00 
Income #2 $735.00 $735.00 $735.00 $735.00 $735.00 $735.00 $735.00 

Total Income $2,135.00 $2,135.00 $2,135.00 $2,135.00 $2.135.00 $2,135.00 $2,135.00 

Expenses 
House $376.87 $376.87 $376.87 $376.87 $376.87 $376.87 $376.87 
Car $175.97 $175.97 $175.97 $175.97 $175.97 $175.97 $175.97 
Education $103.79 $103.79 $103.79 $103.79 $103.79 $103.79 $103.79 
Food $250.00 $250.00 $250.00 $250.00 $250.00 $250.00 $250.00 
Clothes $75 .00 $75.00 $75.00 $75.00 $75.00 $75.00 $75.00 
Insurance $150.00 $600.00 $150.00 
Utililies $185.00 $185.00 $185.00 $140.00 $100.00 $65.00 $120.00 
Savings $213.50 $213.50 $213.50 $213.50 $213.50 $213.50 $213.50 
Entertainment $200.00 $200.00 $200.00 $200.00 $200.00 $200.00 $200.00 

Total Expenses $1,730.13 $1,580.13 $1 ,580.13 $2,135.13 $1,495.1 3 $1.460.13 $1,665.13 

S urplus/ Deficit $404.87 $554.87 $554.87 ($0.13) $639.87 $674.87 $469.87 

I 

Figure 9-73 Final output of Project 4, budget page 1 

I 
I 

Percent of 
Aug 1994 Sep 1994 Oct1994 Nov 1994 Dec 1994 Totals Total Income 

$1 ,400.00 $1,400.00 $1 ,400.00 $1,400.00 $1,400.00 $ 1 6,800 . 66 .57% 
$735.00 $735.00 $735.00 $735.00 $735.00 $ 8 ' 8 2 0 . 0304 . 4 3 % 

$2,135.00 $2,135.00 $2,135.00 $2.135.00 $2, 135.00 $ 2 5 ' 6 2 0 l 0000 . 0 0 % 

$376.87 $376.87 $376.87 $376.87 $376.87 $ 4 ,52 2 . 41 77 .6 5% 
$175.97 $175.97 $175.97 $175.97 $175.97 $ 2 , I I I . 6 <lB . 2 4 % 
$103.79 $103.79 $103.79 $103.79 $103.79 $ I ,2 4 5 . 5@1.86% 
$250.00 $250.00 $250.00 $250.00 $250.00 $ 3,000 . 010 1 . 7 I % 

$75.00 $75.00 $75.00 $75.00 $75.00 $900 .003.5 1 % 
$9 0 0.003.5 1 % 

$120.00 $65.00 $65.00 $100.00 $170.00 $ 1 ,500 . 0Gi .8 5% 
$213.50 $213.50 $213.50 $213.50 $213.50 $2 , 5 6 2 . 0 100 .00% 
$200.00 $200.00 $200.00 $200.00 $200.00 $ 2,400. 0@ .37% 

$1 ,515.13 $1,460.13 $1 ,460.13 $1,495.1 3 $1 ,565.13 $ 1 9 ' 1 4 1 .5'11 . 7 1 % 

$619.87 $674.87 $674.87 $639.87 $569.87 $ 6 , 4 7 8 . 4235 .2 9% 

Figure 9-74 Final output of Pro ject 4, budget page 2 
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Figure 9-75 Final output of Project 4 line chart 
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To begin this project, you should have completed Project 3 first, since 
you will be using the monthly budget you developed there as a starting 
point for this project. 

.. If you have quit Excel, restart it by double-clicking on the Monthly 
Budget icon. If not, open Monthly Budget. 

.. Save this worksheet as Annual Budget onto your data disk. 

This will not change the monthly budget, but only makes a copy of it, 
names the copy Annual Budget, closes the original worksheet, and 
makes thi s new Annual Budget the active worksheet. 

CREATING A DATA SERIES 

An annual budget usually has a list of the 12 months across the top of 
the budget. Then, under each month's name, there is the amount for 
that month for each income and expense category. 

To create the data series you need to select cells C2 through N2. You will 
make use of the automatic scrolling feature of Excel. If you press the 
mouse button in a cell and drag the pointer past the edge of the window, 
the window will scroll and extend the selection as it scrolls. 

,,. Press the mouse button on cell C2 in the left pane, hold the mouse 
button down, and drag the pointer to the right side of the screen . 
Hold the mouse button down until you have scrolled through and 
selected all the cells in row 2 over to cell N2. 

That may not have been an easy thing to control if you are new to 
automatic scrolling. This is a slow, and unnecessarily difficult, way to 
select large numbers of cells. 

Now that you have some experience in automatic scrolling and selecting, 
let's learn a better way to do this. 

.. Scroll back to the left, using the scroll bar, so that column A is visible 
in the worksheet window. 

You could add the month names now by typing them into cells 0 2 
through N2, but Excel offers several easier ways to accomplish this. Let's 
add the month names in this worksheet by creating a data series. 

The first thing you will notice is that you cannot show a whole year on 
a standard Macintosh monitor. Excel allows you to get around this 
problem by using the split bars. You will use the vertical split bar 
(located in the lower left corner of the worksheet window) to allow you 
to see the cells on the left and right sides of the worksheet. This means 
that you will not be able to see the cells in the middle of the worksheet. 

• Point to the vertical split bar and drag it over the border between 
columns D and E. 
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This splits the window into two vertical panes, each having its own 
horizontal scroll bar, and they both share the vertical scroll bar. . 

• Click on the right pane's scroll bar until column N is centered in the 
pane. 

One handy method for selecting cells is to click on the first one and then 
Shift-click on the last one. This will be especia lly useful for th is project 
since you will be making several wide selections. 

To add the data series, you must first select cells CZ:NZ. As you have 
seen, you can click on CZ and drag to NZ, but it causes the window to 
scro ll and is often d ifficult to control. An easier method is to click on 
the first cell and then Shift-click on the last. 

• Click on cell C2 in the left pane, and then Shift-click on cell N2 in 
the right pane (see Figure 9-77). 

r a File Edit Formula Format Data Options Macro Window 
., 

... Reedy 

FigUJ·e 9-77 Making a wide selection using two vertical panes 

This is a much faster and easier method to make selections across a 
number of columns. This method also works vertically, across multiple 
rows, if you split the screen using the ho rizontal split bar. 

Notice that the first cell in the selection was formatted in Project 3 as a 
date. If you had not already form atted that cell as a date, you would have 
to do so now. 

Wh en you create a data series, the first cell in the selection must have 
a value in it. If the first cell is empty, the data series will be empty. Si nce 
cell C2 has a starting date, you can create a series of dates quickly using 
the Series command. 
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• Choose Series from the Data menu. 

You will see the d ialog box shown in Figure 9-78. 

w rles l:=l 
Type- Date Unit- ~ OK ll 

@ Rows 0 Linear Q Day 
( Cancel l QColumns Q Growth Q Weelcday 

@ Dote @ Month 
Q Year 

Step Uolue: I I Stop Ualue: I I 

Figure 9-78 Creating a series of date values 

The data series you will create will be on a single row and will be a date 
increasing by one month per column. 

• Select Month under the Date Unit. You don 't have to specify a stop 
value, because Excel will automatically stop when it reaches the last 
cell in the selection (N2). 

Return • Click OK or press Return. 

You should now see the month names at the top of the co lumns as 
shown in Figure 9-79. 

'" a File Edi t Formula Format Data Options Macro Window 

... Ready 

Figure 9-79 Filling a selection with a series of dates 

W -S • This is a good time to save your work. 



Chapter 9: Excel 447 

ADDING FORMULAS 

Now that you have set up the month names, it is time to use Excel's 
powerful replication features to quickly expand the monthly budget 
into an annual budget. 

The first step is to tell Excel that February's amounts are the same as 
january's amounts. This will not be strictly true, but it allows you to 
rapidly expand the spreadsheet and then go back and make specific 
adjustments as necessary. 

• Select cell 04 and enter the formula =C4. 

Excel will display 1400 as the Income #1 amount for February. 

Notice that the format is not for currency. This is because you only set 
the cells in column Cas currency format. Since most of the cells in this 
worksheet will contain currency amounts, the next step is to select the 
entire spreadsheet and choose the currency format. 

• Select the entire worksheet by clicking in the top left rectangle to the 
left of Column A and above row 1. 

The entire worksheet will be highlighted. 

.. Select the currency format from the Format menu. 

Notice that the month headings on row 2 changed to currency also. You 
can correct this by selecting those cells again and formatting them with 
the special date format you previously created. 

• Select row 2 by clicking the row number. Select the date format from 
the Format menu. 

DUPLICATING FORMULAS AND NUMBERS 

3€ -0 

Now that you have set up the proper formats, you can duplicate the 
formula in cell 04 down the column so that each category's january 
amount will be displayed in February also. 

,,. Select 04:019, and choose ~ill Down from the Edit menu. 

Notice that all the cells between 04 and 019 momentarily show 1400 
then recalculate almost immediately. Since cells C7, C8, and C18 were 
blank, Excel has put $0.00 into cells 07, 08, and 018. You want these 
cells to be blank, and the easiest .Jvay to do this is to select them and use 
the Clear command. 
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.. Make a multiple selection of cells D7:D8 and Dl8. 

~ -B ,. Choose Clear from the Edit menu, and then click All in the dialog 
box. Click OK. 

Your worksheet should look like the one sh own in Figure 9-80. 

" a Fi le Edit Formula Format Data Options Macro Windo w 
., 
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... Ready I m 
Figure 9-80 Clearing empty cells 

Now you are ready to fill in all the monthly budgets for March through 
December. 

,.. Select cell D4 in the left pane, and then Shift-click on cell N19 in the 
right pane. 

This allows you to select all the cells representing February through 
December. You must select t he February amounts, because you are 
going to duplicate the formulas from these cells into all the months 
through December. 

~-R ,,. Choose Fill Right from the Edit menu. 

After you click in a cell to deselect t he large selection, your worksheet 
should look like the one shown in Figure 9-81 
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r • File Edit Formula Format Data Options Macro Window 
., 

o2 I 
§0 Annual Budget 

... Ready 

Figure 9-81 Annual Budget after filling February values through 
December 

In just a few easy steps you have told Excel to expand the monthly 
budget into a full 12-month annual budget. 

ADDING MULTIPLE COLUMNS 

Now you will add two more columns to the worksheet. Column 0 will 
contain the totals for each category for the year, and column P will 
contain formulas that calculate the total for each category as a percentage 
of total income. 

You will add the titles for the columns and then create two formulas and 
use Fill Down to duplicate them. 

• Select cell 02 and enter Totals. 

.. Type Percent of in cell Pl. 

.. Enter Total Income in cell P2. 

,.. Select these three cells, choose Alignment from the Format menu, 
and in the dialog box click ight to have them align Right. 

Return ,.. Click OK or press Return. 
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Before you add the formulas for these two columns you should change 
the format for the font displayed in cells 04:Pl9. If they are displayed 
the same as the other values, it will be hard to see where the monthly 
values end and these summary columns begin. 

• Selectcells04:P19, thenchooseFontfrom the Format menu. Change 
the font to Bold and click OK. 

You will now add the formulas for cells 04 and P4. 

• Select 04 and enter =SUM(C4:N4), and in P4 enter =04/$0$6. 

The formula in cell P4 needs a little explanation. It tells Excel to take the 
sum of all12 monthly Income #1 amounts (calculated in 04) and divide 
it by the amount in 06 (which is the total annual income). You need to 
use relative addressing for 04, because you want Excel to use the sum of 
each respective category when you use Fill Down. You must use absolute 
addressing for cell 06, because you always want to divide the total for 
each category by the total annual income. 

When you enter the formulas, Excel calculates the total in cell 04 but 
gives you an error message in P4, #DIV /0! (see Figure 9-82). This means 
that you are dividing by zero, which is an undefined mathematical 
operation. You receive this error message because you have not filled the 
formulas down yet, so there is no value in cell 06. This will be rectified 
in the next step. 

,. • File Edit Formula Format Data Options Macro Window 

Figure 9-82 Division by zero error message 

3€ -D • Select cells 04:P19 and choose Fill Down from the Edit menu. 

00 -B • Clear the unnecessary formulas in cells 07:P8 and 018:P18. 

., 

• Select P4:P19, choose Number from the Format menu, and then 
choose 0% from the scrolling list. Click OK. 

The result is shown in Figure 9-83. 
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r a File Edit Formulo Formot Ooto Options Mocro Window 
., 

Figure 9-83 Budget after filling Totals and Percent of Total Income 
columns 

This completes most of the steps necessary to create an annual budget. 
All that is left is to make a few refinements, correct three errors, and 
modify some of the amounts for insurance. 

Additionally, you will insert a new row so you can add a Savings 
category, and you will create a pie chart and a line chart. 

EDITING THE DATA 

One of the most glaring problems with this worksheet is that almost 
nobody pays constant monthly payments for insurance. You will now 
modify this worksheet so that three insurance payments are made. 
While you are doing this, you can take advantage of Excel's ability to 
attach a note to a cell for an explanation about why something is being 
done. 

The first step is to clear all the formulas in the Insurance category for 
February through December. 

ljg - B • Select D14:N14 and clear only the formulas. If you don't remember 
how to clear formulas, refer back to the "Adding Formulas" section 
of this project. 

Notice that the total for the Insurance category was changed, but there 
seems to be a problem with th9 formulas that calculate the monthly 
total expenses. This is because you started with a formula specifying a 
named range and then replicated formulas that told each month to use 
the same total as the month before. 

You need to change the formulas for total income, total expenses, and 
surplus/deficit, and then fill them to the right. 
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• Click in cell C6 and change the formula to =SUM(C4:CS). 

W-R • Select cell s C6:N6 and choose Fill Right from the Edit menu. (Do not 
fill into columns 0 and P.) 

a€ -R • Enter =SUM(C9:C16) in cell C17, select cells C17:N17, and choose 
Fill Rig h t from the Edit menu. 

:5€ -R .. Enter=C6-C17 in cell C19, selectcellsC19:Nl9, and choose Fill Righ t. 

This will correct the fo rmula errors. 

Many times when usi ng a spreadsheet, you will encounter values for 
which origins and purpose are not immediately clear. Excel lets you 
attach notes to a cell to explain why the values are in the cell and where 
they came from. These notes are not visible on the screen, and they will 
not appear when you print unless you choose to see them. 

This family, like most families, has insurance policies that cover the 
house and the car. The house insurance is paid annually in April, and 
the car insurance is paid twice per year, in january and again injuly. The 
january payment insures the car from january through june, and the 
July payment covers the next six months. 

Table 9-14 lists the insu rance values that will be entered and the 
explanatory notes associated with the payment. 

Month 
j anuary 
April 
july 

Table 9-14 

Insuran ce amount 
$150 for car insurance Qan-jun) 
$600 for an nual house insurance 
$150 fo r car insurance Qui-Dec) 

Insurance amounts for three months 

You could enter the th ree payments into the appropriate cells, but 
without attach ing a note, you would not have an explanation for 
the amounts. 

Since you don'twan t to be confused later when you open the worksheet, 
enter the insurance amoun ts into th eir cells and attach the explanatory 
notes to those cells. 

The easiest way to get to t he cell for April's insurance is to scroll the right 
pane of the wi ndow to the left unt il April is visible. This will still leave 
the categories showing in the pane on the left (see Figure 9-84). 
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,. li File Edit Formula Format Data Options Macro Window 
., 

F14 600 
~0 AnnuaiBudget 

Figure 9-84 Entering April's insurance amount aft er scrolling the 
righ t pane 

• Enter 600 for April 's insurance, and then choose Note from the 
Formula menu. Type House insurance, annual, in the Cell 
Note dialog box, click Add, and then click OK or press Return (see 
Figure 9-85). 

House lnsurance , annua~ 
Cell: Ll r_14 __ __....J Note: 

Notes In Shee t: 

CJ Delete 

Figure 9-85 Add a no te to April 's insurance amount in cell F14. 

If you want to see the notes for a worksheet, you can choose Note from 
the Formula menu, and all attached notes will be listed in the scrolling 
list on the left in the Cell Note dialog box. Select any cells listed , and the 
associated no te will appear in the box where you just entered the note 
for the house insurance. 

• Add the amount and note for the car insurance in july and fo r the 
car insurance in j anuary, as well. Refer back to Table 9-14 for the 
info rmation you need. 

While you are making changes to expenses with fluctuating amounts, 
it is a good time to modify the Utilities expense. For this budget you can 
assume that winter heating bills will cause utilities to be higher than in 
the spring and fall, and air conditioning in late summer will also be 
higher. 
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• Enter the amounts shown in Table 9-15 into the specified month's 
utili ty expense (do not clear the existing formulas first). 

Month Amount 
April 140 
May 100 
June 65 
July 120 
September 65 
November 100 
December 170 

Table 9-15 Utility expenses 

INSERTING ROWS 

The budget shows that you are running a surplus every month, so before 
the money slips through your fingers, it might be a good idea to budget 
10% of take-home pay to go into savings each month. 

Although a savings category was not planned for, Excel will let you 
quickly add it. 

~ -I • Select all of row 16 by clicking on the row number to the left of the 
row. Choose Insert from the Edit menu. 

As a shortcut, you can also press Option-click on the row number to 
insert a row. If you want more than one row, use Option-click and drag 
to select the number of rows to insert. 

Since you selected one row, Excel inserted one new row. If you had 
selected five rows, that's how many would have been inserted. This 
same command works for inserting columns if that is what is selected 
before issuing the command. 

The Delete command works in a similar manner. Select the rows or 
columns you want to delete, and then issue the command. 

The action performed by the Delete command is similar to that of Cut, 
but it is not an equivalent process. Cutting a selection moves it to the 
Clipboard, where it can be pasted into a new location. Delete removes 
the rows or columns from the spreadsheet and closes up the space they 
occupied. Deleting does not move the contents of these erased cells to 
the Clipboard. 

• Name the category by entering Savings in cell B16. The formula for 
C16 is =C6*.1. 

~ -R • Select C16:N16 and choose Fill Right from the Edit menu. 

You need to tell Excel to calculate the year-end summary amounts for 
the new row. 

~ -D • Select 015:P16 and choose Fill Down from the Edit menu. 
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Your worksheet should now loo ' like the one in Figure 9-86. 

' * me Ed;t Fo•mola Fo•mat I Data OpUon• Mom Window 
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., 

Figure 9-86 Adjusting formulas to calculate summary values for new 
category 

3€ -S •• Save your work to your data disk. 

Now is a good time to print the ~orksheet. You can set the headers and 
footers and decide about printing gridlines and row and column 
headings. 

The Annual Budget worksheet will be wider than it is tall, so change the 
page orientation to wide (also known as landscape). 

• Choose Page Setup from the File menu. Change the orientation of 
the page to wide by clicking on the icon on the right under 
Orientation that shows the page turned sideways. 

00 -P ,.. Print the Annual Budget worksheet. 

CREATING A LINE CHART 

Creating this line chart will be fairly straightforward, since most of it is 
automatic. You can format the chart's title and place the legend as you 
desire. The only adjustment you ~ill need to make to the chart is adding 
the data series' titles for the legT d. 

Select the monthly summaries or total income, total expenses, and 
surplus/deficit. 

• Click on cell C6, and then Shift-click on cell N6. 

• Now add the expenses to the selection by Command-clicking on 
C18 and Shift-clicking on Nl8. 

• Use the same method to add the surplus/deficit amounts to the 
selection (see Figure 9-87). J 
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r & File Edit Formula Format Dato Options Macro Window 
., 

Figure 9-87 Making a multiple selection to create a new line chart 

,,. Create a new line chart and add the legend and a title. Choose the 
line chart style from the Gallery menu that matches the one shown 
in Figure 9-88. 

' a File Edit Gallery Chart Format Macro Window 
S 1 P6 ~~ =SERIES("Income",,'Annue l Budget'!$C$6:$N$6, 1) 

$ 2,500.00 

$2,000.00 

$1,500.00 

Annual Budget Line Chart 

Income, Expenses, <Uid S11rplus 

' 

$1 ~000.00 --- - -~- ---- ~- --- -~- -- - - ~---- -~-- - --:- -----:------:------:--- --~- - ---~ 
! ~ : . • --rt-;......__ : ~--;--•--•--- ~ 

$500 .00 i~~~:; r-----:--~-:------:-- ----:-----:-----~ 
$0.00 i i + I I I I I 1 1 1 

($5oo oo> ---- -~- ----~- ____ t ----~- ___ -~ ___ _ _? ___ ---~-- --- L_ --~~ ___ -~~ ~ ____ ,J:z 

1··- .Q. ·•-

... Enter 

Figure 9-88 New line chart showing Annual Budget amounts 
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• Add the names for the dat series, as shown in the formula bar in 
Figure 9-88 and explained i Project 3. 

• Use the Page Setup command from the File menu to choose a wide 
orientation for printing. 

:3€ -S .. When you have entered all the names for the data series, save the 
chart as Annual Budget Line Chart. 

3€ -P ,,. Print the chart. 

Your chart should look like the one shown in Figure 9-89. 

"" s File Edit Gallery Chart Pormat Macro Window 
., 

§0 Annual Budget Line Chart 

Income, Expenses, and Si4rpli4s 
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I I I I I I I I I I I 
I I I I I I I I I I 

' ' ' 
I I I I I 

I I I I I I 

$ 1 000.00 .. -- .. - ~--- .... ~-- .. - -~---- -~--- .. -~ .. --- .. : .. ---- .. : .. -- .. - .. : .. ---- .. : .. - .. - .. ~- .. .. .... .: 
1 

I I I I I I I I I I I 

! ~ : I---t.-...... : ~---+--;-+.___ ~ 
$500.00 .L--~-===K----;4----------~-·------·------·-----~-----~ i' : : : : : : : : : : $0.00 i i t I I I I I 1 1 1 

( $500.00) --- --~--- --~--. --~---- ~-.-- -~----. _?_- -- --~-- -- - ~-----~~ - -- _tJ~--- _1_2 

-o. Ex penses ·•- Surpl us 

... Reedy 

Figure 9-89 Line chart after naming data series for legend 

This chart will be used in the what if... exercises in this project. 

CREATING A PIE CHART 

This next chart will be even easier to create than the line chart. All you 
have to do is select the cells showing year-end totals for the expense 
categories. To keep from having to manually add all the names, you can 
select them before creating the new chart. 

I 
• Select the cells, as shown in igure 9-90, and create a new pie chart. 
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r j File Edi t Formula Format Data Options Macro Window 

Figure 9-90 Make a m ultiple selection to create new pie chart 

• Make the page orientation wide, and add a t itle and a legend. 

00 -S • Save this chart as Annual Budget Expenses Pie . 

,. .S File Edit Gallery Char t Format M acro Window 

Rnnual Budget EHpenses Pie 

Comparison of Expenses 

11.03% 

15.67% 

... Ready 

II House 

D ear 

1m Education 

II Food 

D Clothes 

13 1 nsurance 

ill utiliti es 

~ Savings 

~ Entertainment 

Figure 9-91 Annual Budget p ie chart com parin g expenses 

., 

., 

You will be using this ch art and the line ch a rt in the what if ... exercises 
in th is ch apter. Now is a good time to save and print th is ch art. 
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WHAT IF ••• EXERCISES 

When you work through these exercises, be sure to save your Annual Budget 
worksheet first, and then do not save the changes you make in this section. As 
a reminder, you might remember that you can always use the Save As 
command to create a backup with a different name. You then can make any 
changes to that document without affecting the original. This is a handy way 
to make a backup of an important document before making any major 
changes, or before trying any new procedures. It is easier to make backup copies 
than it is to replace lost information. 

1. What if the employer of the person earning Income #1 offered to 
send this person back to school in September for some specific 
courses and offered to pay half salary during the semester and 
reimburse educational expenses when the semester is over? 

2. If this person decides to accept the offer, the employer guarantees 
a $100 per month raise (in net, or take-home, pay) starting in 
December. The employee will incur $1,000 in additional educational 
expenses in September. 

3. You will need to adjust Income #1 to $700 for September, October, 
and November. December income will be $100 more than in 
August, plus the reimbursement of the $1,000 expenses. 

4. Make these changes and print the worksheet. Open each of the two 
charts that you just created, and print them. Compare these printouts 
with what you previously printed. 

5. For what month(s) will this family have to dip into savings because 
their expenses exceeded their income? 

Do not save these changes to your Annual Budget worksheet. 

CHAPTER SUMMARY 

• Excel is an electronic spreadsheet program that incorporates and integrates worksheets, 
charts, macros, and databases. 

• Worksheets are central to data analysis in Excel. 

• Worksheets are organized in columns and rows. The intersection of a row and a column is a 
cell. A cell is located by its address. Columns are named by letters and rows by numbers. A 
cell will have an address designated by a letter-number combination, e.g., A9. 

• A cell can contain text, a number, or a formula. I 

• Formulas refer to values and the contents of other cells. When referring to the contents of 
other cells, formulas can use relative addressing or absolute addressing. 
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• When the contents of a cell referred to by a formula changes, all cells dependent on that cell 
change automatically. 

• Excel allows you to change the width of a column and the format of a cell. 

• The values shown in a worksheet can be charted into area, bar, column, combination, pie, 
and scatter charts. 

• Worksheets can be created, saved, opened, modified, printed, and linked. 

• Excel facilitates rapid spreadsheet construction using data series and the Fill Right and Fill 
Down commands. 

KEY TERMS 
header 

absolute addressing 
active cell 
area chart 
arguments 

bar chart 

cancel box 
cell 
column 
column chart 
combination chart 
context-sensitive help 

data series 
defined term 
dummy argument 

enter box 

fill 
footer 
formula bar 
formula 

grid lines 

horizontal split bar 

jump term 

legend 
line chart 
linked terms 

pie chart 

range 
reference area 
relative addressing 
row 

scatter chart 
selection squares 
status bar 

template 

vertical split bar 

what if... analysis 
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COMMAND KEYS AND SHORTCUTS 
Activity 
Activate next window 
Activate previous window 
Calculate Now 
Cancel 
Clea r 

Close Window 
Copy 
Cut 
Define Name 
Delete 

Fill Down 
Fill Left 
Fill Right 
Fill Up 
Formula Find (displays dia log box) 

Formula Find next 
Formula Fi nd previous 
Go to 
Help 
r nse rt 

New 
Note 
Open 
Paste 
Print 

Qui t 
Save 
Save As 
Select All Cells 
Select Chart 

Undo 

Editing in the Formula Bar 

Activity 
Activate formula bar 
Cancel entry 

Command-key equivalent 
3€ -M 
Shift-3€-M 
3€ -= 
3€ -. (period) 
3€ -B 

3€ -W 
3€ -C 
3€ -X 
3€ -L 
3€ -K 

3€ -D 
Shift-3€-R 
3€ -R 
Shift-3€-D 
3€ -J 

3€ -H 
Shift-3€-H 
3€-G 
3€ -/ or 3€ -? 
3€ -I 

3€-N 
Shi ft-3€-N 
3€-0 
3€ -V 
3€ -P 

3€-Q 
3€ -S 
Shi ft -3€-S 
3€ -A 
3€-A 

3€-Z 

Command-key equivalent 
3€ -U 
3€ -. (period) 

461 
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Choosing Dialog Box Options 

Activity 
Format Bo rder (Outline) 
Fo rmat Border (Left) 
Format Border (Right) 
Format Border (Top) 
Fo rmat Border (Bottom) 

Format Number (Gen eral fo rmat) 
Forma t Numbe r (0.00 format) 
Forma t Number (h:mm AM/PM format) 
Format Number (d-mmm-yy format) 
Format Number 
($#,##0.00; ($#,##0.00) fo rmat) 

Format Number (Oo/o forma t) 
Format Num ber (O.OOE + 00 format) 
Formula Select Special (Notes option) 
Formula Select Specia l 
(Current Region option) 
Formul a Select Special 
(Row Differen ces option) 

Formula Select Special 
(Column Differences o ptio n) 
Formula Select Specia l 
(Precedents: Direct Only option ) 
Formula Select Specia l 
(Precedents: All Levels option) 
Fo rmula Select Specia l 
(Dependents: Direct O nl y option) 
Formula Select Special 
(Dependents: All Levels option) 

O ptio ns Display Fo rmulas 
(toggles between formulas and values) 

Additional Projects 

Command-key equivalent 
:1€-0ptio n-0 (zero) 
:!€-Option-Left Arrow 
:!€-Option-Right Arrow 
:!€-Optio n-Up Arrow 
:!€-Optio n-Down Arrow 

W-Optio n--
3€-0ptio n-! 
W-Optio n-@ 
W-O ptio n-# 
3€-0ptio n-$ 

W-Optio n -o/o 
W-Option-1\ 
:1€-Shift-0 (letter 0) 
3€ -* 

3€ - \ 

W-Shift- \ 

3€ -[ 

W-Sh ift- [ 

3€ -] 

W-Shift-] 

W -' (backquote) 

Part IV: Spreadsheets 

The following project is accompanied by briefer instruction s than those 
you have previously completed in this ch apter. It requires that you 
apply what you learned in the first four projects. If n ecessary, refer back 
to the preceding four projects for information and instructions for any 
procedures that you aren' t fa miliar with. 

You will not be reminded to save your work- you sho uld be thinking 
o f that on your own by now. 
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Project 5: Bar Chart 

1985 

1984 

1983 

1982 

1981 

1980 

1979 

1978 

1977 

1976 
Year 

1975 

1974 

1973 

1972 

1971 

1970 

1969 

1968 

1967 

1966 

0 000 
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This project is easy to complete. It requires you to create a worksheet and 
then produce a bar chart. The worksheet has no formulas or calculations; 
it is there just to hold the data for the chart. 

The final output of Project S is shown in Figure 9-92. 

NASA Outlays for Research and Development 

7.321 

1.000 2.000 6.000 7.000 8 000 

Figure 9-92 Final bar chart output of Pro ject S 
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It is up to you how you set up your worksheet as far as formatting, titles, 
and other features are concerned. You may want to model the worksheet 
after the one in shown in Figure 9-93. The on ly data you actually have 
to enter are the years and the amounts spent in those years. Excel has 
certain defaults for determining category and data series names from 
data entered into a worksheet. If the selection is wider than it is tall, 
Excel expects to find the category names in the first row of the selection 
and the data series names in the first column. If the selection is taller 
than it is wide, Excel will look for the data series names in the first row 
and the category names in the first column. 

In either case, the top left cell in the selection should be blank. 

• One method of approaching this task is to create a data series in row 
6 (starting in B6), beginning with 1966 and advancing one year with 
an ending date of 1985. 

• You might want to put a title for row 7 in cell A7, one such as 
Total Outlays. Enter the values for each year starting with 1966 by 
placing the outlay amount in the cell below the year. For example, 
you could put 1966 in cell B6 and then 5.933 in cell B7. 

• If you have the dates in row 6, the data series title in cell A7, and the 
data series values in the rest of row 7, Excel will know how to label 
each bar with the correct year. Leave cell A6 blank. Since the 
worksheet will be wider than it is tall, Excel will assume that row 6 
represents the categories and row 7 holds the data (see Figure 9-93) . 

Series name 

Figure 9-93 Excel defaults for category and series names in wide 
worksheets 
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The amounts in Table 9-16, in b' llions of dollars, are not adjusted for 
inflation. 

Year Amount 
1966 5.933 
1967 5.426 
1968 4.726 
1969 4.252 
1970 3.753 
1971 3.382 
1972 3.423 
1973 3.316 
1974 3.256 
1975 3.266 
1976 3.670 
1977 3.945 
1978 3.984 
1979 4.187 
1980 4.850 
1981 5.241 
1982 6.035 
1983 6.664 
1984 7.048 
1985 7.321 

Table 9-16 Amounts spent by NASA (billions of dollars) for R & D 

.. Select all necessary cells from A6 through the dollar amount for 
1985, create a new chart, and select the bar chart that shows dollar 
amounts at the end of each bar. 

.. Assign text to the title, category axis, and value axis to match what 
is shown in Figure 9-92. 

.. Choose Page Setup, and select Full Page size. This makes the chart 
taller when it is printed. 

This completes Project 5. 
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P art V introduces you to managing lists of information on the 
Macintosh . You don't have to use a computer to manage small 
amounts of in formation or information that rarely changes, but 

if you have information that changes frequently, or if a large amount 
needs to be managed, you will p~;obably find that using a computer is an 
indispensable part of getting the job done. 

Chapter 10: Information Management Concepts introduces you to the 
organization and manipulation of information. 

Chapter 11: File Maker II shows you how to use one of the most popular 
information management applications available for the Macintosh. It is 
not the most powerful application and would not be suitable for large 
corporations to manage their information, but for personal management, 
small businesses, and departments in larger organizations, FileMaker 
provides enough power and flexibility to manage informa tion. 

Chapter 12: HyperCard 1.2 te~ches you how to access information 
provided by others and how to de ate your own stacks and use them. You 
will learn to print reports and customize the stack so that it suits your 
purpose. 
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Chapter 10: Information Management 
Concepts 

What You Will Learn in This Chapter 

After reading this chapter, you will understand: 

• The difference between data and information 

• How to organize information into databases, files, records, and 
fields 

• Information management's standard operations 

• Common terminology associated with information management 

A 
!most everybody has to keep track of some type of list. This can 
be a to-do list or a simple list of names and addresses. On the 
other hand, it can be something as complicated as a list of a 

company's financial transactions for a year or complete lists of the 
resources, materials, and suppliers needed to build a skyscraper office 
building. 

PERSONAL INFORMATION MANAGEMENT 

For personal use, it is often convenient to store a list in a book or on 
something like 3xS cards. These methods are okay if the lists are 
relatively short or if you are a very organized person. 

Most likely, you already manage various lists in your daily life, such as 
a shopping list, a list of things to do, or appointments on a calendar. 
These types of lists are discarded when they are no longer useful. Other 
types of information must be updated. Examples of the latter include 
address books, business card files, credit card numbers, insurance 
policies, and investments. 

Like many of us, you may find that it is difficult to remember to keep this 
information up to date. You might organize information in piles (on 
your desk, floor, and bookshelves), or you might be the type of person 
who organizes your audio library alphabetically by performer and keeps 
each type of music separated by category. Most people fall somewhere 
between these two groups. Regardless of your personality and preferences, 
you probably don't have to manage large amounts of personal 
information. 

Let's say you keep a list of information concerning your friends. This list 
probably contains their names, addresses, birthdays, and so on. A 
convenient way to keep track of this information is to store it on a 
collection of 3xS cards. Each card contains information about one 
person, and the cards are stored in a box, in alphabetical order. 
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This collection of cards can be c lied a file, and each card is a record of 
information about one person. More than one piece of information 
about the person is on a card. Each individual piece of information 
(name, address, and so on) can be called a field or item. 

If you meet a new person and become friends, you can fill out a new card 
and add it to the file. If someone moves, you can change the information 
or replace the old card with a new one with correct information. lf you 
no longer want to keep information about a person, you can remove the 
card and discard it. 

For many personal needs, this type of a filing system is sufficient. On the 
other hand, businesses, even sypall ones, must manage much more 
information than most individuals. 

BUSINESS INFORMATION MANAGEMENT 

A business can use a file of 3x5 cards, but the situation quickly becomes 
complex. Let 's say you work for a small business and keep track of a list 
of contacts at other businesses. These contacts can be clients, customers, 
suppliers, people to whom you refer business, professional and trade 
acquaintances, and others with whom you do business. 

You've decided to store the information on one card for each contact 
person. When the file is small, it is easily managed. There are only a few 
names to remember. Then, things begin to change. People move, 
change companies, change jobs in a company, change occupations, and 
do all the other things that people do, including dying. Sometimes you 
will know about these changes, and other times you will learn on ly 
when you try to contact someone. 

You may find that some companies have several people whom you 
regularly contact, so you start another file. Th is file is organized by 
company name and lists each contact person at that company on the 
company's card. 

Over time, some people are listed in the contact person file, others are 
listed in the company file, and some are listed in both. If a person 
changes jobs, you must remember to change the information on each 
card that lists the person. Of course, you don ' t always remember to 
do this. 

Sometimes, however, you may I ave difficulty remembering how you 
stored a card with the name ana address you need. Did you store it 
alphabetically by the company' name, or did you store it by the last 
name of the person you need to ~all? Do you also have information on 
this company stored on other car

1
ds by other persons' last names? What 

happens if you can only rememb
1
er that the person you need to contact 

is named Piya, and you can' t remember her last name or the company 
for which she works. 
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In a small card system, this usually is not a critical problem, but what 
happens if you work in a company that has 1,000, 10,000, or 1,000,000 
or more items of information that need to be managed? Would you 
want to be the person who had to maintain an accurate card file on 
thousands of people? Of course not. Even if you did want to do this, 
there would be a point at which the collection of information would 
grow so large or it would change so often that you could not perform 
your duties. 

For centuries, business managers have had to manage three major 
resources: money, materials, and people. In this century, a new resource 
has been added to this list: information. Computerization has made it 
possible to manage large amounts of information, and, at the same time, 
it has accelerated the rate at which information changes. To remain 
competitive in a rapidly changing world, all businesses must now 
manage their four major resources better. 

Effective and efficient management of large amounts of changeable 
information has been one of the major goals of the computing industry 
since the early 1950s. As the industry has progressed and new hardware, 
software, and procedures have been developed, the systems used to 
accomplish this goal have changed. 

Let's briefly explore the systems that have been designed to manage 
business information. What types of information are managed in a 
business, and who needs access to which information? The answers to 
these questions are as varied as the number of organizations, but let's 
look at a "typical" organization. 

A traditionally organized business has a hierarchical management 
structure (see Figl.lre 10-1). 

Tactical 

Operational 

Clerical (or Transactional) 

Figure 10-1 The management hierarchy 

The majority of clerical and lower-level management personnel are 
located in the clerical, or transactional, level. Of all management 
personnel, their duties are most defined, their daily activities are most 
structured, and their decision-making authority is most restricted. They 
are involved with repetitive tasks and are primarily concerned with 
processing various business transactions. Their information needs 
typically involve data entry, error correction, transaction tracking, and 
producing periodic reports for higher management. 
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File Management 

As you travel up the m anageme t hierarchy, there are fewer people on 
each level. Their daily activiticls are less structured, they have mo re 
lati tude and authority in their decision making, and the type of 
in teractio ns they have with the organ izatio n 's info rmatio n changes. 

Personnel at the operational level a re respo nsible fo r completing well
defined tasks that are usually short-term in nature. They also are 
responsible for implementing and achieving goals set a t the tactical 
level. Inform ation needs at this level typicall y involve operatio nal 
feedback, in the fo rm o f detail re~orts, summary repo rts, and exception 
reports. Using a retail department store as an exam ple, a deta il report 
m ight show every item carried in inventory, and a summary report 
might sh ow sales totals for the week orga n ized by departm en t. An 
exception repo1t migh t list only the best-sell ing (or worst-selling) items 
sold by the store or any departmen ts tha t d id not meet their sa les 
projecti ons fo r the week. 

Tactical level managers typically a re responsible for setting and meeting 
goals designed to achieve strategic objectives determined a t the highest 
level o f the compan y. These managers usually are concerned with 
budgetary and operatio nal matters. They also are responsible for setting 
relatively short-term goals and for planning how to achieve those 
goa ls. Much of their in formation needs revolve around periodic reports, 
but occasio nally they will seek "what if .. . " analyses to help them 
m ake decisions. 

A what if ... analysis is used to answer a question such as, "What if we sell 
only 75 percent of the gizmos we are projecting next yea r?" This is the 
type of q uestio n that must be considered when planning company goals 
and budgets. 

Relatively few man agers and officers a re at the strategic level. Their daily 
activities are least structured and their decisio ns are least programmed 
and restricted . They are most con cerned with long-range planning and 
setting o rganizati on al objectives. Their in fo rmation needs typically are 
o ne-time reports on trends affect ing the co mpany, wh at if ... analyses, 
and projectio ns. 

Th e computing industry's approach to managing business info rmatio n 
has pa ralleled this short journey through the management hierarchy. 

In the 1950s and 1960s this pro~ess was called electronic data processing 
(EDP). Data processing involves converting raw facts, or data, into 
information. Data becomes info rljllatio n when it is organ ized, colla ted , 
and sorted so that it becomes accessible and useful. Du ring this stage of 
develo pment, the primary goal ~f business automation was to reduce 
clerical costs by automating clerioal tasks. Each department and division 
had its own set of independent com puterized system s. A large am ount 
o f the info rmati on man agement effort was duplicated o n separate 
machines. On a given machine, tbe informatio n might be duplicated for 
use by diffe rent programs. 
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Most information at that stage was stored in separate files. A file might 
conta in information used to produce a particu lar report. Business had 
hundreds of these files and developed computerized systems to manage 
them. A file might contain information on employees, customers, 
accounts payable, accounts receivable, inventory, payroll, work in 
progress, shipping, receiving, o r any other type of information used to 
produce a management report or account for a transaction. Programs, 
or groups of programs, were written to manage each of these files, and 
information management systems based on this method o f data 
p rocessing were known as file management systems. 

The process of keeping files up-to-date, complete, and correct is known 
as fi le maintenance. Ma ny problems are associated with maintaining 
multiple, separate files. For example, much of the information in one 
group of files may be repeated in other files. This repetit ion is known as 
redundancy. Systems that had to maintain hundreds of separate files ran 
into the same problems encoun tered by an individual maintaining a 
3x5 card file. When information changed, all the files containing that 
information had to be individual ly updated, a process that was time
consuming, expensive, and prone to error. Unfortunately, the problem s 
associated with updating redundant data can result in an item of 
information existing as different versions in the same system. 

These types of information managemen t systems did automate the 
transactional and operational aspects of a company's information 
resources, but they did little to help h igher management. Each 
department or division maintained its own records, and company-wide 
management systems were not available. Managemen t wanted a way to 
tie these systems together into a management infonnation system (MIS). 

At the time, however, several problems prevented this from happening. 
First, the information on t he computers was stored on reel-to-reel 
m agnetic tape. A large file might be stored on several tapes, and finding 
a particular item of data to change might not be accomplished easily and 
quickl y. Second, the information was redundant, so it might take 
mounting and modi fying several tapes to accomplish a change. Third, 
the information was stored in locations that might be widely separated, 
and data communication over phone lines was slower, more expensive, 
and less reli able than it is today. 

Hardware, software, and procedures changed in the 1970s. The first 
problem, data storage, was solved when the price of disk drives declined 
dramatically. Not only did the price decline, but also the reliability of 
disks and the amount of data that could be stored on a disk increased. 
In a few years, most computer systems were using disk drives as their 
main method of data storage. 

Tapes store information sequentially; that is, one item after another. To 
reach an item, all the preceding tape must pass through the system, like 
finding a particu lar song on an audiocassette. Th is method is known as 
sequential access. Disk drives can access informatio n sequentially, but 
they can also locate information directly, a process kn own as direct access 
(or random access). 
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Databases 

The ability to access informatio n directly led to the solution of the 
second problem, redundant information. Methods were devised to 
organize information so it could be accessed and processed more 
efficiently. The organizational method chosen for storing information 
in related files was the database. Three major types of databases are 
currently in use: hierarchical, ~etwork, and relational. Of these, the 
relatio nal model is used popularly in microcomputer database systems. 
Therefore, it is the only one that will be explored here. 

Relational Databases 

A relational database can be com posed of one or more related files. Each 
of these fil es is organized into a tabular structure consisting of rows that 
represent records (also known as tuples) and columns that represent 
fields (also known as attributes or items). 

One of the major advantages of a relational database over a fi le 
management system is the reduction of data redundancy. As an example, 
schools must manage a lot of info rmation about courses offered, 
instructors, students, which courses students have taken, when cou rses 
were taken, and grades received in the courses. 

In a file management system, you might include a student's name, 
address, phone number, and other pertinent informat ion every time 
she or he takes a course; if the student takes 40 courses, the system would 
contain 40 occurrences of all this info rmation. What do you do when 
the student's address changes? You have to find and change all 40 
occurrences and make sure they all match. 

Using a relational database system, information can be divided into 
multiple files, each of which is designed for efficient data storage. Fo r 
example, you can store all the basic studen t information in the student 
file, which would consist of name, address, phone number, fina ncial aid 
status, scholarship status, any disciplinary action taken, and other 
pertinent information. The student is assigned a unique identi fying 
number (usually his or her Social Security Number), and this number 
is used to relate information in one file with information in another 
file. A field used to relate information in more than one file is known as 
a key field. 

An example of a partial student file is shown in Figure 10-2. 

Student Number Last Name First Name Phone 

111-22-3333 Godfrey Geneva 555-6848 
123-45-6789 Adams Rebecca 555-7452 
321-54-9876 Prather Lillie 555-1597 
666-88-7777 A vary Arch 555-7486 
987-45-1236 Borreson Lori 555-3287 
999-99-1111 Cavalie~ Jamie 555-5874 

Figure 10-2 Example of a studlent file 
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One way to look at the contents of this file is to think of it as a table of 
information. There are multiple rows and columns (like a spreadsheet) 
in the fil e. All the information on a particular student will be located 
on the same row. Each row represents one record in t he file (see 
Figure 10-3). 

Student Number Last Name First Name Phone 

111-22-3333 Godfrey Geneva 555-6848 
123-45-6789 Adams Rebecca 555-7452 
321-54-9876 Prather Lillie 555-1597 
666-88-7777 A vary Arch 555-7486 
987-45-1236 Borreson Lori 555-3287 
999-99-1111 Cavalier Jamie 555-5874 

Figure 10-3 A student record in the student file 

Each column in the table represents a single field. Figure 10-4 shows the 
field that represents the students' last names. 

Student Number Last Name First Name Phone 
• 

111-22-3333 !Godfrey Geneva 555-6848 
123-45-6789 Adams Rebecca 555-7452 
321-54-9876 Prather Lillie 555-1597 
666-88-7777 A vary Arch 555-7486 
987-45-1236 Borreson Lori 555-3287 
999-99-1111 Cavalier Jamie 555-5874 

Figure 10-4 The Last Name field in the student file 

Class names and the instructors assigned to teach the class could be 
stored in a class file. Of course, like the student file, more information 
would h ave to be in this file than what is shown. Each class is assigned 
a class number, usually con sisting of an abbreviation for the department 
teaching the course followed by a un ique identifying number for the 
course within that department. Other information such as credit hours, 
class hours, lab h ours, and prerequisites would probably be in the file as 
well. Figure 10-5 shows a partial example of a class file. 

Class Number 

ACC 103 
ART 101 
BUS 211 
EDP 150 
EDP 641 
PHY 453 

Class Name 

Cost Accounting 
Art Appreciation 
Office Machines 
Pascal I 
Compiler Design 
Thermodynamics I 

Figure 10-5 A class file 

Instructor 

Nichols 
Dockery 
Hughes 
Dillard 
Young 
Erker 
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A record of all courses taken by all students could be maintained in a 
completed courses file (see Figure 10-6). This file would contain two key 
fields. The Student Number field is used to relate to information in the 
student file, and the Class Number field relates to information in the 
class file. 

Student Number Class Number Qtr Taken Grade 

111-22-3333 ACC 103 92-3 A 
123-45-6789 EDP 150 91-4 B 
321-54-9876 BUS 211 91-2 A 
666-88-7777 ART 101 92-4 B 
987-45-1236 PHY 453 90-1 B 
999-99-1111 EDP641 91-3 A 

Figure 10-6 The completed courses file 

When a student requests a transcript, the registrar enters the student 
number assigned to that student (or former student). The database 
program sorts the completed classes file by the Qtr Taken field (if the file 
is not already stored in that order), finds every occurrence of the student 
number in the file, and then prints a transcript. Of course, additional 
processing is necessary to group the courses by quarter (or semester), 
calculate the quality points earned (based on credit hours and grade 
received), and calculate the student's grade point average for each 
period and the cumulative grade point average. Additional information 
may be added to the transcript based on information stored in other fi les 
for honors earned and extracurricular activities that may be noted. 

A database system using multiple, specialized files reduces redundancy 
to the point where data is duplicated in the key fields only. Specifying 
that the information in the key fields must not be modified eliminates 
the problem of updating multiple occurrences of an item. If a student 
moves, any information that needs to be changed can be found in one 
place. 

Each file is simple in design and easy to update. Associating, or relating, 
information in different files leads to less wasted space on the disk and 
a reduced possibility of information being partially updated. Unforeseen 
information can be added to reports by creating and relating new files, 
modifying the program to look up information in the new files, and 
adding this information to the ~eport as needed. 

Network Databases 

The third problem that had to be overcome before management 
information systems became widely useful was communication between 
distant systems. In the 1970s data communication became cheaper, 
faster, and much more reliable. This led to formation of wide area 
networks. A wide area network is formed when several computer systems 
communicate with each other by sending information over a common 
carrier, such as the phone systef . 
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Digital signals used in computers are not compatible with the analog 
signals used in phone systems. Therefore, to send and receive computer 
information over the phone lines, a conversion device is used. This 
device, known as a modem, modulates a computer's digital signals into 
sound (analog signals) at one end of the phone system, and a compatible 
modem demodulates the sound back into electron ic d igita l signals at 
the other end for the other computer. The term "modem" derives from 
the process of modulating and demodulating. 

Today, hundreds of databases are available worldwide on computer 
networks. Anyone with an account and a password can use these 
systems to access many types of information and to send and receive 
messages (a process known as electronic mail). 

With computers communicating over the phone li nes, information 
could be accessed directly, and t ransactions could be processed as they 
were made instead of being entered into the system at a later t ime. This 
was known as t ran saction processing. The 1970s brought a big increase 
in transactional processing systems. 

In the 1980s information management systems became widely available. 
With the introduction and widespread availability of microcomputers, 
informat ion management systems went through similar stages of 
evolution as were seen in mainframes and minicomputers in the 1960s 
and 1970s. First, file management systems became available, and these 
were quickly followed by more powerful database systems. 

Recently, information management systems, which were formerly 
described using traditional terms ("file managemen t systems" and 
"database systems"), have begun to blur the distinctio ns between the 
two traditional system types. In the world of microcomputers, most 
people refer to any information management system as a database 
system, regardless of whether it meets the technica l definition. Bowing 
to popular usage, this book will refer to programs such as FileMaker 
as databases. 

Microcomputers brought another d ifference to computing. It is very 
likely that a company will have many microcomputers located in the 
same building. This situation is not as likely with min icomputers and 
mainframes. As communications became more importan t during the 
1980s, a new method of connecting computers was developed and 
became known as a local area network. A local area 11etwork (LAN), 
technically, is a connection of communicating computers that do not 
use any lines or equipment belonging to a common carrie r. By popular 
usage, a group of microcomputers that send and receive information to 
and from each other is called a LAN. 

just as minicomputers and mainframes developed database systems 
that operate over a wide area network, microcomputers now have 
databases that work over a local a rea network. This allows multiple users 
to modify info rmatio n on a common database from any computer 
having access to the LAN. Once again, departments in large companies 
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have the ir own local database management facilities. But, for the first 
time, small companies have access to computing power similar to that 
relegated to o nly the world's largest companies a few years ago. 

USES OF INFORMATION MANAGEMENT SYSTEMS 

Some of the activities and terminology associated with managing 
information have already been presented, along with some of the 
pitfalls of manual methods. Computerized information management 
systems are designed to automate many tasks. Specifically, these programs 
will help you do the following: 

• Organize you r information 

• Store that in formation 

• Perform mathematical calcula tio ns 

• Add new records 

• Delete existing records 

• Edit the contents of selected records 

• Retrieve individual records or groups of records that match specific 
criteria 

• Sort the information into a different order 

• Print reports in different formats 

Each of these functions is discussed below. 

Organizing Information 

Storing Information 

Several types of information management programs exist, but all of 
them are designed primarily to !Jelp you organize information, store it 
on the computer, retrieve information, modify it, and produce reports. 
Information can be organized into databases, files, records, and fields. 

When you have determined the organization of the information, you 
describe it to the computer by creating a new file. At this time, the 
program requires you to specify each field to be used and what type of 
information will be contained in that field (date, number, text, graphics, 
formula, and so on). In most information management p rograms, only 
one type of information may bd contained in each field. 

Once the organization is described to the computer, you may then add 
information to the file. This is usua lly done by creating a new record and 
then filling in each of the fields fo r that record. For a customer, this 
might involve entering name, address, phone number, credit rating, 
cred it limit, and other information that describes that particular customer. 
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Performing Calculations 

Adding Records 

Deleting Records 

Editing Records 

Not a ll info rmation is directly typed into a file. Whenever calculations 
are required, it is frequently easier (and more accurate) to let the 
computer do them for you. 

for example, if you were a real estate agent and wanted to add a new 
house listing to your file, you could have fields set up fo r, among o ther 
things, the length and width o f the house. Then when you enter this 
information, the program could multiply the contents of these two 
fields and store the square footage of the house in the appropriate field . 
You cou ld even have the cost per squa re foot calculated automatically. 

When you first defined the contents of the file, you might have en tered 
the information you had available atthat time. Information management 
programs also all ow you to enter new in formation at any time after the 
file is created. 

If you a re running a business, you (hopefully) will have a steady stream 
of new customers discovering your store and purchas ing the items you 
sell. Therefore, the informatio n management program must allow you 
to add new customers. 

Not o nly does new information present itself an d old information 
change, but also eventually some information becomes obsolete. Suppose 
you have a list of insured ho usehold item s, and one of the items listed 
is a top-quali ty 35mm camera. The camera was very expensive when you 
bought it, but even with proper care and attention it fi nally wore out. 
When you discard th e camera, it is a lso appropriate to d iscard the 
information in the insured items fi le. 

The info rmation in each record will be as correct as it was when you 
entered it, but, as we all know, things change. 

Suppose you maintain a list of the names and add resses of your friends. 
Over a period of several years, chances are that many of them will have 
different addresses from the ones you entered o riginally. 

Informatio n management programs allow you to retrieve the reco rd 
conta ining the information on a particular frie nd, and then you can edit 
any in formation stored in th at record. For example, if a friend has 
moved to a d ifferent state, the street address, city, state, Zip code, and 
telephone number will have to be changed. 
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Retrieving Records 

Sorting Records 

There is another reason that the ability to modify information contained 
in a fil e is important. When the information was originally entered, 
there is always the possibility that it was typed incorrectly. The program 
has to allow you to correct mistakes easily. 

Information that has been entered into the computer is of little value if 
you can't retrieve it at a later time. If you have a list of customers and 
want to send a special mailing to all who live in a particular city or town, 
you can have the computer search through the list and select only those 
whose city matches the one in which you are interested. In this way you 
can select subsets of the entire customer fi le. In this case, the subset is 
the group of customers who live in a particular city. 

You can also find a single record. Suppose you have a file that contains 
information on improvements t?at you have made to your house. At a 
later time, you want to find the total cost of adding the deck. If the 
improvement was entered as "deck", you can tell the program to find 
the record containing "deck" and it would very quickly find the record 
and show it to you on the screen. 

You might also need to find information on a person, but you can only 
remember part ofthat person's name. In manual systems, you would be 
forced to look through each card until you found what you were looking 
for, but in a computerized system, you can tell the computer to find all 
names that match the portion you remember. The computer will do this 
many times faster than you can. 

An info rmation management system can quickly sort an entire file, or 
subset of the file, to display information in any order you want. 

The records in a file are sorted into order by the contents of a chosen 
field, known as the sort field, or the field on which the sort order will be 
based. Common sort field selections include the name fields for alphabetic 
sorts, Zip code field for printing mailing labels, amount-sold-this-year 
field to find the best customers, and so on. 

For instance, if you have a name and address file, and you want to group 
the people by city, you could sort fi rst by city, then by last name, then 
by first name, and the information would be sorted accordingly. If you 
had the following list of names and citi es: 

Wesley Myers-Smith 
june Kelong 
Don Herring 
Dena Taylor 
Diane Herring 
Luke Kelong 

~ew York 

1
oston 

l}tlanta 
Boston 
Atlanta 
Boston 
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The city, last name, firs t name sort command would give the following 
list: 

Diane Herring Atlanta 
Don Herring Atlanta 
june Kelong Boston 
Luke Kelong Boston 
Dena Taylor Boston 
Wesley Myers-Smith New York 

Note that the people living in a particular city are grouped, and the cities 
are presented in alphabetical order. Then, within each city group, the 
people are sorted alphabetically by last name. If more than one person 
has the same last name, they are further sorted by fi rst name. 

Sorting does not change the placem en t of the fie lds in the report, it just 
modifies the order in which each record is d isplayed or p rin ted. 

Creating Reports 

Historically, the main use for an information management system was 
to organize information so that reports cou ld be produced. The 
information was entered into the computer, and the computer sorted 
and selected the records that met the specified criteria. Then, the 
information was output in the form of a prin ted report. 

Since thoseearly days, adiffe ren ttypeofuse has evolved. Mi nicomputers 
and microcomputers led to an inte ractive fo rm o f information 
management. Interactive use of an informatio n management system 
provides timely information on a specific subject almost immediately. 

There still are times, however, when printed reports are more useful 
than interactive access. For instance, your ba nk maintains all of the 
transactions affecting your checking account in its database, but at the 
end of the month it sends you a printed sta temen t so you can verify both 
your set of records and the bank's. Any financial accounting system 
must maintain a paper trail, or series of printed reports, for auditing 
purposes. 

ln the next two chapters you will be introduced to two popular 
information management systems for the Macintosh: FileMaker II and 
HyperCard. 

CHAPTER SUMMARY 
• Each piece of info rmation is called a field or item. Several related items that describe one 

person, place, o r thing are called a record. Multiple related records may be grouped together 
into a file. A database is composed of several related fi les. 
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• Data is raw information. When data has been organized (processed) so that it becomes 
accessible and useful, it is known as information. 

• Businesses manage four major resources: money, materials, people, and information. 

• Information must be correct and up-to-date to be use~ul. There is a time value associated with 
information, because old information is not as valuable as current information. 

• Different people in a business organization have different information needs. Information 
management systems provide both interactive access and printed reports. Common reports 
include detail, summary, and exception reports. In some cases, particularly financial 
accounting systems, printed reports are necessary to provide an audit trail. 

• What if ... analyses are used to answer questions about future possibilities. For users trying to 
develop accurate projections, computers allow the examination of multiple scenarios such 
as, "What if the inflation rate is 3 percent?" or "What if the inflation rate is 6 percent?". 

• Early information management systems were known as file management systems because 
information was stored in separate files that were not associated with each other. Later, 
database management systems were designed to allow the information in several files to be 
associated (or related), to reduce redundancy, and to allow easier updating of information. 

• Info rmation in a database is stored on disk drives, so the information can be directly accessed 
an d updated. Many computer systems communicate with other computer systems over 
networks. Microcomputers are often connected over a local area network to allow for sharing 
of informatio n between computers and to allow interactive access to a centralized database. 

KEY TERMS 
common carrier 

data 
database 
detail report 
direct access 

e lectronic data processing (ED P) 
exception report 

field 
file 
file maintenance 
file management system 

information 
item 

key fi eld 

local area network (LAN) 

management information system (MIS) 
modem 

random access 
record 
redumdancy 
relational database 

sequential access 
sort field 
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Chapter 11: FileMaker II 

What You Will Learn in This Chapter 

After reading this chapter and completing the projects in it, you 
sh ould be able to: 

• Create a new file and enter data into it 

• Modify data in a file 

• Delete records 

• Find specific records and records that match one or more criteria 

• Create a new layout 

• Create calculation fields 

• Create detailed reports 

• Print reports 

• Link files together using lookup fields 

F ileMaker is one of the best-selling information management 
programs for the Macintosh . It will do all the standard tasks found 
in a program that manages information on a personal computer. 

Unlike similar programs on most other computer systems, however, 
FileMaker is designed for use on the Macintosh, and it takes advantage 
of the Mac's graphics capabilities to help you create reports with visual 
impact and style. 

STARTING FILEMAKER 

-----
F il1?1'1.akl?r II 

To start working with FileMaker, you need to have the FileMaker II 
application and the Inven tory data file loaded into your com puter. The 
Inventory file is included on the Macintosh Journey Projects disk that is 
available for use with this book. (Project 1 in Chapter 1 tells you how to copy 
all the files on the Projects disk onto your data disk.) 

This Inventory file will be used later in Project 3. Let 's open it now and 
take a look at it. 

.. Double-click on the Inventory data file icon , as shown in 
Figure 11-1. 
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r a File Edit Uiew Special 
., 

Orooting Card Art 

Trav•ling Tim•s Unformatt• d Trav•Hng Tim•s Logo 

~ ~ 
Glossary Yisual Eff•cts Class Notos But tons 

~ 
lnv•ntory Mys tor y Docum• nt 

0 
Final Proj•cts 

Figure 11-1 Opening Inven tory file from the desktop 

In a few seconds the Inventory file will open and you will see a screen 
like the one shown in Figure 11-2 (without the arrows and labels). 

' 4 File Edit Select GiHl!JCH rormut Cus tom Window 

10 lnuentor 

I 00 I WIPER BLADES 
1002 WIPER MOTOR 

WINDOW BRACKETS 

1. Slide control handle 4. Status area 
2. Book 5. Fields 
3. Active record Indicator 

8.53 
36.9 5 

8.79 

17.26 
11.25 
3 5.68 
36.50 

5.6 3 
8.95 
5.89 

Figure 11-2 What's what on the FileMaker screen 
I 

The opening screen tells you a Jo t about the Inventory file. The status 
area shows there are 20 records ~ n the file, and the fi rst record is active. 
The active record can be determ~ned in two ways: the center page of the 
book has the number 1 displayed, and the active record indicator (the small 
black area between the two vertical lines) is next to the first record. 
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BROWSING THROUGH THE FILE 

At this point you should see the first 12 records in the Inventory fi le on 
your screen. This means that 8 more records a re not currentl y visible. 
You can see them by scrolling through the file. 

There are two ways to scroll through the records. The first is to use the 
slide control handle, and the second is to click o n the bottom page of the 
book. 

The slide control handle method (see Figure 11-3) will let you smoothly 
and q uickly slide to a particula r record if you know the record number. 
As you pull up or down on the slide con trol handle, the current record 
number is displayed o n the middle page of the book. When you release 
the handle, the display scrolls to the record indicated in the middle book 
page. This is particularly efficient when you want to go to the first o r last 
record in the fil e. 

Records : 
20 

Records : 
20 

Records: 
20 

Figure 11-3 Changing active record with slide control handle 

otice that the top page of the book is b lank when the first record is 
active, and the bot tom page is blank when the last record is active. A 
page with simulated text on it shows that there are additional records 
in that directio n. 

The second scrolling method, clicking o n the bottom page, will take you 
o ne record closer to the bottom of the file (see Figure 11-4). You can also 
click o n the top page to move closer to the first record in the file. 

Before After 

~t ~ 
Records: 

20 

Figure 11-4 Changing the active record by clicking on the book 
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GETTING HELP 

485 

Whenever you are using a program such as FileMaker, there are times 
when you haven't learned, or can ' t remember, the proper procedures or 
commands to perform. FileMaker li incl udes online help so you won't 
have to stop what you are doing and find the information in the 
reference manual. 

'3€ -I • Choose Help from the Apple menu (see Figure 11-5). 

'Drue Edit Select (i<Jd~j(ll~ rornu1t Custom Window ' 
Rbout FlleMnker .•. lnuentory E!ll . ' 

~ 

~YII~!Uil II X K 
!!!kr. !!u£!jp.Jin Unit Cost 

sEd it 
Rein WI PER BLADES B.53 

Rlerm Clock WI PER MOTOR 36.95 
Calculator WI NDOW BRACKETS 8.79 
Calculator+ DOOR HANDLE 23.98 

: 
Chooser MIRROR MOUNT 17.26 ~ ": 
Control Penel MIRROR BRACKET 11.25 : 
dCRD Calculator 

FLOOR MATS 35.68 : 
DeskDraw '" 
DeskPelnt '" KEY LOCK 36.50 

OeskPainl'" 2 RADIATOR HOSE 5.63 

OeskPalnt '" 3 RADIATOR CAP 8.95 
Olspley Messege AIR FILTER 5.89 
EHpresslonls t '" " ' " ' e oo T e<> '< L'<. 

" 10 
... e~o. (VI 10121 

Figure 11-5 Getting FileMaker help 

This brings up the opening screen for the help facility, offers some 
inform ation on using FileMaker, and allows you to open the Help file 
(see Figure 11-6). 

'D File Edit Select Gadgeh l'ormut Custom Window 

To ulew , edit, add, and dele t e record s, fi rs t choose Browse f rom 
t he Select M enu. 

0 To type In a field, press l ob or click In D field. 
0 To turn to another record, click o page In the book . 
0 To odd or delete r ecords, choo~e from the Edit m enu. 

" 
Sor To find o group of records, choose Find from the Select menu, ,.:·;, 

then type o request and click the Find button. 'i 

To reor der the records, choose Sort f rom the Selec t menu. 

To change the eppeorance of records f or display nnd for 
printing, choose Layout from the Selec t menu. 

To creo l e new fields, choose Define rl om the Select menu. 

Ropen Help~ [cancel) 

Figure 11-6 Opening the He p fi le 

Click Open Help File. 
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1f the r il eMaker Help file is not on your disk, you must quit FileMaker 
and then copy the Help fi le from the distribution disk into the folder on 
your hard disk that conta ins FileMaker. Then you can re-enter File Maker 
and again try open ing the Help file. 

If you originally installed the Help file p roperl y, or if you just went back 
and installed it, when you click the Open Help File button, you will see 
the screen shown in Figure 11-7. 

r j File Edit Select G<HI(jeh rormut Cust om Window 

10 FlleMaker Help 0~ 

~i 
USING THE HELP FILE ~ 
To brovs r through tht Help file : 

Click ~ ~n of tht book on ttM' ltft to s u othe-r topics. 
- Ge-nwal information is .tt tht front of tht> fit.. Hon df.biltd VlformaUon is towards 

Rt-eords: : tht b~k. 

69 
To choose- a topic: 

Choou tht> topic you want from tht Custom m~nu. Thtn o1ick pa9ts in tht book to s u 
additional information . 

To c los• th• H•lp filt and r•turn to us ing FneHaker : 
Choou t:AJ:>~ from tht filt mt nu. (Or , lfl\ll~ thf Ht lp filt opt-n whllt 1,1 00 w-ork with 
aMt~ f1lf ; choon tht fi~ you w.nt from tht- 'w'indov mtnu or UJt tht ~ 
command to opo9n tbt fi1t.) 

FOf" more inform1Uon, SH tht pa~s of thf. Ff~tr mM~Ua1 rtft rtnetd at tht bottom 
oftM serun 

• To n~ othe-r r~cords on this topkl, click pagts of the- book • t tht top ltft of tht window. 
• For mor• hf.lp on this toplO~ stt tht FlltM•ktr II Own.r's Manu• 1, pp . 82-83 . 

lo • For htlp on otht r topios, choon tht topic IJOU ""¥It from tht Custom mtnu . 

[L] Bro~r~~st Ql I~ '2l 

Figure 11-7 Using the Help file 

3€ -1 • If your screen does not look like the one shown in Figure 11-7, 
choose Using the Help File from the Custom menu. 

The status area shows that there are a total of 69 records in the Help file. 

If you want help on other topics, you can choose Scripts from the Custom 
menu (see Figure 11-8). Or, to make it even easier, you can choose one 
of the options available in the Custom menu. 

r • File Edit Select (i~ldgeh I' or mil l Window ' ' 
Fil eMaker Help 

Scripts 

Using the Help File 
FlleMaker Concepts 

Q ( Perfonn ) 

Working with Files 
Defining Fields 
Adding and Editing Records I 

Finding Records 
Sorting Records ( New ) 
Arranging Information 

( f hllllfj l.' ) Printing and Preuiewing 
EHchanging Data Between Flies 

}!i ( Ot~h.• II~ ) Automating Commands 
Keyboard Shortcu t s 0 ( EHit ) 

l 0~ OON .0 ... . ~, ~· UOO> ' """:' >•• o U~ n~o· o-n U ........ $ · ·-Ne>~ 1'1'• o•-~· 
• For htlp on othf.r top.os, choost tht topic IJ OU 'If ¥It from tM Custom mtro. jQ 

I !0 Browso J<2l J2L'2l 

Figure 11-8 Scripts dialog box 
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f o r instance, if you want more in ormation on understanding FileMaker 
concepts: 

• Choose FileMaker Concepts fro m the Custom menu. 

.i File Edit Select Gadgeh rormot Custom Window 

![] FlleMBker Help ii 

~i 
VHAT IS A F IL£t1AICER FILE? f!£ 
A F"flt~tr f i l e ;s ~ M.cintos:h doeurntnt thtt storu your d~t~. A tilt contilnt" 
StqUffK:t ofrt"cords. Eieh rtoOr"d stOf"ts rt l•ttd lnformtt»n tbout t c~. 

- ~ .. ~~:::.':::;::';;;;;~ ;t;::•:;~~=~:t:n~:t!h~!t~:;:;~n:.•~: !~::~~ .. r .ch Rtoords: 
69 \t".ln~.)()tion, or a p• rson's l alar"\j . 

FOUI>d: 
~ In ~ilion to providin<.;l t structurt for st0t"in9 \jour infOr'mtUon, FlltM~tr' ptovidts t.ht 

fltxj)Uit~ to dtsplil,l tnd pnnt vow informtUon in tht fOf"m \IOU nHd. FUtMaktr'r. 
l~out c ap.abflitt} giv•s tJOU oomplttt eontrol oytr tht <~ppuranct of your dtb . 

heh filt oeeupits ;ts O"Wn window on tht dtsk1+P, 1M tJOU cJn htn up to 16 f1lts optn 

tt onct. All opM f1!.s .art hsttd in tht 'W'tndcrW~ (ntnU . Tht filt in tht .ottvt YW\doY Is 
e t11td tM curr•nt fi1• , ~It 1s ehtoktd 1n tl)t mtnu. To mtk:t • difftrtnl filt tht 
CIJt'rtnt filt , you just choost it from tM rMnu, 

• To stt oth.r records on this top~, olick paQt lj of the book at lht top ltft of tht -window. 
• For mort http on this topio1 stt tht FlltM•ktr II Owntr1S Manual, pp. 7-16. 

lo • For twlp on othtr topics, Moost tht topic lJOU Want from l.ht Custom mtnu. 

Browst :;J J II;: '2l 

Figure 11-9 FileMaker Concepts help record 

This shows the first o f five records associated with this topic (look at the 
status area below the book). Notice, at the end of the next to last line 
on the screen, that you are told to see pages 7-16 in the FileMaker II 
Owner's Ma nual for further help. This fi eld is updated for each record 
in the help file, and it will tell you where to look for more info rmation 
on each of the 69 records. 

If you can't find what you need I is ted in the Custom menu, choose Find 
in the Select menu and tell it what you wa nt to find in the Help file. 

• Choose Find from the Select menu. 

This brings up the fo llowing screen (see Figure 11-10), where you can 
enter your search criteria. 

' * File Edit Select (i<ld<J<lh rormot Custom Window 

FlleMftker llelp 

~P-•g~•-"-wM--·~~ ====---------------------------=--~J ~ 

I O Omi t 

Q§J 

CDCD 
GJCD 
00 
CD Lm 

IIIJ Find 

Figure 11-10 Finding in formation in the Help file 

I 
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Now suppose that you want to fi nd more information on how to add 
automat ic page numbers to a report. 

.. Click in the field across the top of t he FileMaker Help window, then 
type Page Number as shown at the top of the screen (see Figure 11-
10), and then click the Find button. 

This finds one record with t he information on page numbers and tells 
you to see pages 184-186 in the reference manual (see Figure 11-11). 

r a File Edit Select G<Jdgoh rormut Custom Window 

:o FileM nlcer Help 01 

a~ 
PRINTING THE TIME, DATE, P " GE NUMBER, OR RECORD NUMBER Q 

You c..n ten FiltM•k•r to print tht timt, todav's ditt, tht P'9• IUI"Ibtr, or ••ch rtcOf'"d 
numbff bv tvpin9 sp.oUI1 svmbols in lavout t"t)(t on~ l~out: 

R•cords: ::(two colons) to han FiJ.Maktr pr\nt tht timt (from tht Macintosh Control Parwl). 

69 The tim• is displ•y~ whtn vou prtvitw or print rtcords . 
Found: 

I II (t\1/o slashu) to havt FlltMaktr pr int today 's datt (from the Macintosh Control 
p..,,l), You c<~n us. tht rc~ml.lf tvh1 command in tht Format mtnu to chang• thf. 
apptaranct of the datt . Tht datt is displavtd whtn IJOU browu, preov itv, or pr-int 
r t>COr"d S . 

• • (two numb•r signs) to hivt FHtMaktr print tM p.tgt numb•r . TM pa~ numbtr iJ. 
disp~f4 'W'ht n yov prtvitw or print rtcords. Vhtn ~ou choost Fnhl yov ~ sptoif~ 
tht nombtr to s t¥t vith as wtll as tht r.11nqt ofp•gH to print. 

H (two • &t "' J.lCTIS) in tM bo<f\1 of tht t..yout to h&Yt FiltM»:tr print \ht rtcor'd 
oombtr. fht. r'teOr"d RtUmbtr Is dlspl~~Jtd wMn you prni•w or print r.cords. 

• To su ottwr rtcords on this topic , cliek O&QtS of tht book jt tM top ltft of tM wb:tow. 
• f or' mort ~lp on this top~, n t tht Fi~.,- II Owntr~s Manua1, pp. 184- 186. 
• For htlp on otMr topics, choost tht topic ~ou want fr-om thf Custom mtnu. 0 

I!Ll ar . .... . 0 1 11;;12! 

Figure 11-11 Page n umbering help 

Read this screen to learn about the codes used to add the current t ime, 
date, page number, and record number to any layout. 

Take a few minutes now to look through the Help file and familiarize 
yourself with what is available and where you can fi nd it. 

When you are finished with t he Help file, you can close the FileMaker 
Help window and go back to using the Inventory file. Whenever you 
close the Help file, you will be returned to whatever file was in use before 
you asked for help. 

:3€: -W ,,. Close the Help file by clicking in the close box. 

This brief overview of the Help command sh ould give you a start in 
using this handy feature provided with FileMaker. 
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SAVING YOUR WORK 

Unlike other programs, information management applications such as 
FileMaker have no Save command. Since the application is designed to 
allow you to enter and update information, your work is saved 
automatically by the program. 

When you create a new file, you are given the opportunity to specify the 
name of the file, the drive on which to store it, and the folder (if any) 
in which it will be saved. Then, ~s you work with the file, FileMaker will 
save it for you pe riodically. 

This has some good features, as well as a couple of potential problems 
of which you need to be aware. When everything works correctly, you 
will not lose any information. That's good. However, when something 
goes wrong, it may damage a FileMaker data file. There are two ways to 
guard against serious problems with your data file: backing up the file 
and saving a copy of the file. 

You must remember to make a backup copy of any file that contains 
importan t informatio n when working in FileMaker. 

The first reason for backing up is to make an insurance copy of the file 
in case of computer, di sk, o r power failure. If your equipment fails you 
can lose important information. Making backups is th e only way to keep 
from losing information. 

The second reason is important whenever you use a program that 
automatica ll y saves your work for you, especially when every 
modification to a file is no t saved when you make the change. FileMaker 
can tell when you are not working with the file . When you take a break 
or stop to talk to someone or to read something and you are not actively 
using FileMaker, it will take this time to save the file. It does not save 
every modification immediately after the change is made. 

There are times (between when FileMaker last saved your fil e and you 
take the next short b reak) that the file on the disk does n ot match the 
work you have done. You might1have made some important ch anges to 
the fil e since the last time it was saved. If the power goes out, there is the 
potential that your file might be damaged. 

Another action that can damage a file is to stop working while FileMaker 
is running and just turn off the computer (before FileMaker has a chance 
to save your last modifica tions to the file). Many computer users 
develop this bad habit when wo~king with other programs. For example, 
you could o pen MacPaint, crea~e a painting, save it, print it, and just 
turn off the computer. Chances are you would not encounter any 
problem s by do ing this. 
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However, this is a ve1y bad /whit. When you are using a computer as 
sophisticated as the Macintosh, you must follow proper procedures to protect 
yourself from losing data. Always choose Quit to close an application, and 
then choose Shut Down before turning off power to the computer. 

When using FileMaker, it is imperative that you quit the program 
properly. When you close a file, it is updated so that the copy on the disk 
matches what is in the computer's memory. When you choose Quit, 
FileMaker will update any open files. 

If you do not fo llow these procedures, you are leaving yourself open fo r 
problems. The easiest way to avoid problems is to backup your work and 
quit FileMaker properly. 

FileMaker also allows you to save a copy of the file at any time while you 
a re working. (This is si milar to the Save As command in other programs.) 
Saving a copy of the file you are using is a good habit to develop. In this 
chapter, you will be reminded to save a copy of a fil e when you have 
made major modifications to it, but you will not be reminded to make 
backup copies using the Finder. 

Naming and deciding where to store a file will be covered when you 
create a customer fi le in Project 1. You will be introduced to saving a 
copy of a fi le after you enter data into that file. 

This concludes the introduction to FileMaker. Before you continue with 
Project 1, you sho uld close the Inventory file. 

3€ -W ,,. Choose Close from the Hie menu. 

Project 1: Creating a Database 

Let's suppose that you are the owner of B & K Auto Parts, a store that sells 
to custo mers around the country. You publish a catalog and adverti se 
in a number of large cities. Some of your customers are individuals, and 
others are businesses that use or resell the parts they purchase from you. 
You want to use file Maker to keep track of customers and inventory and 
to automate the productio n of invoices when customers place o rders. 

In Project 1, you will create a Customers file. You will learn how to define 
the fie lds for each customer, enter data, format the fields for proper 
disp lay, edit the data, and print the contents of the fi le. 

In Project 2 you will learn to print detail ed reports based on information 
in the Customers fi le. In Pro ject 3 you will create the Sales Invoices file, 
and you will learn to interconnect files and create invoices using 
inform atio n looked up in the Customers and Inven tory files. 

In these th ree pro jects, you will learn the basics of using FileMaker. 
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PREFIX Ms. 

FIRST Sandra 
Ml M. 

LAST Hardin 
TITLE 

COMPANY 

ADDRESS 497 Seemore Drive, Apt. 3. 

CITY Asheville 

STATE NC 
ZIP 29702 

COUNTRY 
AREA CODE 234 

PHONE NUMBER 555-2922 

ENTRY DATE 7/11 /86 

CUSTOMER NUMBER 1001 

BUSINESS TYPE 

REGION 

PREFIX Mr. 

FIRST George 
Ml M. 

LAST Lapmont 
TITLE Manager 

COMPANY Bell Tires 

ADDRESS 2354 78th Avenue 

CITY Bellvue 

STATE WA 
ZIP 71356 

COUNTRY 
AREA CODE 651 

PHONE NUMBER 555-2654 

ENTRY DATE 10/21 /86 

CUSTOMER NUMBER 1002 

BUSINESS TYPE Tire Dealer 
REGION 

Figure 11-12 First page of Proj
1
ect 1 
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SELECTING WORK MODES 

Define 

Browse 

Find 

Sort 

Layout 

There are five work modes in FileMaker that allow you to do all of the 
standard info rm ation managemen t tasks, as presented in Chapter 10. 
These modes are accessed by choosing o ne of them from th e Select 
m enu, and the currently selected mode is indicated with a ch eckmark 
(see f-igure 11-13). A brief overview of these commands follows. 

Figure 11-13 r il eMaker's Select menu 

TheDef711ecommand is used when creating a new file or when modifying 
the structure of an existi ng file. This lets you de fine what fi elds make 
up the records in the fi le and what types of info rm ation can be stored 
within those field s. 

The Browse m ode lets you view the information conta ined in a file. In 
addition to looking at the information, you can also add new data, 
delete records, and modi fy data. 

Fi11d allows you to tell the computer what informatio n you wan t to find, 
and the computer then searches all the records and selects o nly the ones 
that match the criteria you provided. You can o ption ally omit records 
tha t contain specified information as wel l. 

If you want to access or present info rmatio n in a specific o rder, you use 
the Sort command. This a llows you to specify the fields that will be used 
to so rt the fil e. Yo u can sort alphabe ti ca ll y, nume rically, or 
chronologicall y, in ascending ordescendingorder. You can also specify 
mo re tha n o ne sort field. 

If you want to look at the information in a diffe rent manne r, you use the 
Lnyout mode to design a different view. You can't change the contents 
of a field in the layout view, but you can ch ange the position and 
appearance of fie lds, graph ics, and text. This new view the n can be used 
for browsing through the informatio n and fo r printing reports. 
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DEFINING FIELDS 

Field Types 

As discussed in Chapter 10, a field is the lowest level of information 
storage in a file . You can desigrl a record in FileMaker that consists of 
more than one field. Once all the fields have been defined (a process 
consisting of naming the field, specifying its type, and choosing any 
entry options), you then can enter information into the fields. 

All records in the file have the same fields, but the contents of those 
fields in each record can be (and usually are) different. The data file is 
the collection of all the records ithat have been entered. 

The process of creating a ne""' data file consists of defining fields, 
formatting fields, and entering information into one or more records. 
Each record in the Customers file will contain information about one 
customer. After you define all the fields and exit the definition mode, 
you will automatically change to browse mode. FileMaker will create the 
first record, and you then can enter information about the first customer. 

What types of information need to be stored for each customer? You 
need to enter the customer's name, address, and phone number, at least. 
It might also be useful to know !when a customer was entered into the 
file, so you can determine how long that person has been a customer, 
and to assign a unique identifying number to each customer. 

Each field can hold only one type of information: text, number, date, 
picture, calculation, or summary. Each field type is explained below. 

Text 

Text is a versatile type of information. It can hold anywhere from one 
character to as many as you ca~ show on your layout. When you enter 
text into a text field, File Maker automatically wraps any word that doesn't 
fit onto the next line. If you wi~h, you can press the Return key to end 
a line or to create a blank line. This lets you organize your text into 
paragraphs. 

FileMaker can sort text fields alphabetically in ascending or descending 
order based on the information at the beginning of the field. 

FileMaker automatically creates an index of each word in a text field so 
you can find records containin any word you need to find in any text 
field of the file. Even though yoJ. can type up to about 32,000 characters 
in a text field, you will find th~t FileMaker will slow down when you 
access files with very large fie! s. For this reason it is best to keep text 
fields relatively short. 

Number 

A number field also can contain as much information as you care to enter, 
but it must be on only one r1 e. Only the numeric portion of the 
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information is indexed, and FileMaker Jets you find a particular number 
o r a number within a certa in range that you specify. 

Number fields m ay be sorted in increasing or decreasing order by value. 

Number fields may be automatically formatted to include commas, 
dollar signs, and percent signs. You also can specify how many digits 
you want to appear to the right of the decimal point. Fo rmatting 
number fields in FileMaker is similar to formatting cells in Excel. 

In addition to specifyi ng a format , you can tell FileMaker to treat a 
number field as representing a logical Yes or No. A value o f zero 
represents No, and any nonzero value represents Yes. 

Number fi elds can be used in calculation s. By putting the name of the 
field in a calculation or summary fo rmula, you can tell FileMaker to 
calculate other resulting values, such as how many items are on an 
invoice, the sales tax amount, and the total amount of the sale. 

Any formatting that is in effect in a number field only affects the display. 
The unformatted value is used in any calculations or summaries and in 
any find or sort operatio ns. 

Date 

You can enter a date by typing the numeric values for the month, day, 
and year. Dates may be entered in the fo rm 7 /4/92or 7-4-92. These dates 
are then indexed so you can find any specific date or any date within a 
specified range of dates. Date fields m ay be sorted chronologically in 
normal (ascending) o r reverse (descend ing) order. 

Like number fields, date fields can be formatted in several differen t 
styles. The sh ortest format is "7 /4/92" and the longest is "Saturday, July 
4, 1992". 

Date fields can be used in calculat ion and summary formulas. For 
example, to determine how long a customer has been a customer, you 
can subtract the date they were entered in to your Customers file from 
today's date. 

Any date entered into a date field must include the month, day, and year 
values. This restrictio n exists so that date calculations will return the 
correct results. If you want to store the month, year, day of the week, or 
any other subset of a date, you should enter it into a t ext or number field. 

Picture 

A picture field lets you store any graphics image you can cut or copy from 
any appli cation o r desk accessory. You cut or copy the p icture and then 
past e it into the picture field . 

Picture fields cannot be sorted , no r can you do a find on the information 
they contain. 
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If you need to find information contained in a picture fi eld, you must 
add a separate text field, where you can en ter a descript ion of the picture 
field's contents. This separate text field can be used as an index fo r 
sorting or finding the contents o f the picture field . 

Calculation 

Calculation fields let you enter a formula that will determine a value 
based on other fields within the same record. Formulas can result in text, 
number, or date results. These resul ts can be form atted using the 
appropriate formats for the type of resu lt the calcula tion produces (such 
as text, number, or date). You can also use the results of a calculation 
field in another formula in a different field. 

Data cannot be directly entered into a calculation fie ld. All calculations 
are automatically updated whenever a field con tain ing a value that is 
used in the formu la is modified. 

All values resulting from formulas in calculation fields are automatically 
indexed in FileMaker, so you can use the Find command to locate 
specific information. You can also sort the file into alphabeticaC 
numerical, or chronological order, based on the results displayed in a 
calculation field. 

Summary 

A summary field is different from the calculation field in a very important 
aspect. Calculation fields let you compute values using fields within the 
same record only. Summary fields let you compute values using the 
contents of one field spanning a group of records. 

For example, you can use a calculat ion field to calculate the tota l 
amount of the sale for one invoice and a summary fi eld to summarize 
the total amount of all sales for the group of records cu rrently being 
browsed. 

Unlike a calculation fi eld, which can contai n any formula you can 
construct, a summary field allows you to choose one summary formula 
from a predefined list consisting of average, count, fraction of total, 
maximum, minimum, standard deviation, o r total. 

The results shown in the summary field will change, depending on the group 
of records currently being browsed. If you a re browsing the entire file, the 
summary applies to all records in the file. If you a re browsing a subset 
of records as the result of a find command, the summary applies to only 
the records in that subset. Whe~ever you mod ify information in a field 
being summarized, or when yo add or delete a record, the summary 
will be recalculated. 

Summary fields are also differe t from calculation fields because the 
values they calculate cannot be used as input into other calculation 
formulas. I 
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Files cannot be sorted and specific records cannot be found based on 
summary fields, because summary fields contain information that 
applies to groups of records and not to specific records. 

Now that you know something about what can be put into each type of 
field, let's create the Customers file, define its fields, and enter the 
customer records. 

The first step in this process is to tell FileMaker that you want to create 
a new fil e. 

• Choose New from the File menu. 

FileMaker presents a dialog box so you can name the new file and 
indicate where it is to be stored (see Figure 11-14). 

Q Cl<hs Notl~s !lu11on~ 
CJ Final Projects 

D (i<mo's Menu llnforrnd1l<HI .·.:.:,!_i_• 

[.) (iJ<J~Silr~) 

D (inH!1ill9 C<tnl flr1 
D lrw(~n1or~J 
D M<mu flrtwork 

Cr eol e o new file named: 

I customer~ 

Figure 11 -14 New file dialog box 

Ori1.1e 

Cancel 

,,. Name the file Customers, and make sure that it will be stored on 
your data disk. Click New to create the file. 

FileMaker creates the new file and then opens the Field Definition dialog 
box (see Figure 11-15). 

s File Edit em (iddiJeh rormot Custom Window 

Field name: 

Customers 

Field Definition 

Field type: 
@ TeHI :l€T 
O Number :l€N 
0 Dote :l€0 
0 Picture :l€P 
0 Calculation :l€C 
0 Summary :l€S 

[ Deselect J [ OK 

[ tlt~l!~ tP ] [ [Hit 

Figure 11-15 Field Defin ition dialog box 
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Entry Options 

497 

The first field that you enter is a text field that will be used to store the 
pre fix to be attached to the customer's name. The field type defaults to 
Text, and that is what you want for the first several fields. 

FileMaker has no rules about the way you capitalize field names. Some 
people prefer to capitalize all letters in a field name, others prefer to 
capita lize o nly the firs t letter in each word, and oth ers prefer to use all 
lowercase letters. Unlike some other database programs, FileMaker lets 
you capitalize the names to suit yourself and also allows you to enter 
spaces between the words in the field names. 

In Pro ject 1, it is suggested that you use all capital letters in the field 
names to easil y d istinguish between field names and other information 
in the project. Pro ject 2 adds three more (calculated) fields to the 
Customers file, an d it is suggested that you capitalize the fi rst letter of 
these fie ld names, so you can easily distingu ish between the fields th at 
contain calculated resul ts. The rest of the p ro jects in the chapter suggest 
capitalizing the firs t letter of each word in the field name. 

You can choose a style you like and name the fields to suit your 
preferences as you con tinue to use FileMaker in othe r p ro jects after 
completing this chapter. 

Yo u st art defining the fields by entering the name of the fi rst field . 

.. Enter PREFIX in the "field name" box. Click OK. 

Depending upo n the customer, this prefix can take such values as Mr., 
Ms., Mrs., Dr. , Rev., and a number of others. Most of the common 
prefixes are in the list just mentioned. 

In addition to providing six types of field contents, FileMaker provides 
a number of en try options for fields. This means that FileMaker 
automatica ll y enters some values, provides lists from which you can 
choose others, and checks to see that the conten ts of a fi eld meet certain 
criteria that you can specify. 

Field Value List 

In this case, you want FileMaker to display a list of name prefixes from 
which you can choose. This makes data entry faster and helps lo avoid 
typographical and spell ing errors . Let's tell FileMaker to d isplay a list in 
the prefix fie ld. 

When you clicked the OK button, FileMaker placed the field name and 
type in the list at the top of the Field Defin ition dialog box. You can see 
PREFIX and Tex t in the upper box now. 

• Click on PREFIX to select it, and then click Entry Options. 

rileMa ker d isplays the Entry Options dialog box for the PREFIX field (see 
Figure 11-16). 
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' a File Edit G<ldgcH rormnl Custom Window 
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Figure 11-16 Entry options for the PREFIX field 

• Click Display a list of values:. 

An "X" appears in the check box to show that this option is active. Now 
add the list of titles to be displayed in the PREFIX field. You should enter 
one title per line, and press the Return key to go to the next line. Don' t 
press Return after the last title. 

• Enter Mr., Ms., Mrs., Dr., and Rev. in the list on separate lines (see 
Figure 11-16). 

When you have entered these values and checked that they are entered 
correctly, you can accept this list and continue defining other fields. 

,,,. Click OK. 

When you return to the Field Definition dialog box, the word "List" has 
been added on the right side of the line containing "PREFIX" and 
"Text". 

You have now learned how to name a field, choose the type of contents 
for that field, and choose entry options for the field. 

Now, you can continue defining the customer's name. Most customers 
have a first name, a middle initial, and a last name, but you might be 
tempted to enter the entire name into one field. You will find that it is 
easier to use a separate field whenever possible for each piece of 
information you might need to access. Separating the name into three 
fields allows you to easily access any portion of the name. For example, 
if you want to address somebody using their prefix title and last name, 
it is easier to do if these parts of the name are in separate fields. Later, 
in Project 2, you will add a calculation field to calculate the full name 
(except for middle initial) based on the information in the three name 
fields you will now define. 

Let's start with the first name. Remember, the default field type is text, 
so you don't have to ch oose the style for these fields. You will not add 
any entry options to the first name or middle initial fields. 

,. Type FIRST in the "Field name" box and click OK. 
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Now defin e the middle initial field. 

• Type MI for the fi eld name,l and then click OK. 

Field Requirements 

The last name will be defined like these other fields, with one exception. 
You want to be sure that every customer has a name entered before the 
record is saved in the file. There may be times when you won't know the 
first name or middle initi al, but you must enter at least the last name for 
a customer before adding a record to your data file. 

This is not a restriction th at fil eMaker imposes; rather, it is added here 
to ensure the integrity of your data. You can tell FileMaker that the last 
name fie ld must contain information before it is acceptable for saving 
in the fil e. If you mistakenly omit entering a last name, FileMaker will 
detect this mistake and tell you. Since this is an option for entering 
information into the fi eld, you need to add an entry option for the last 
name fi eld. 

• Enter LAST for this field's name (see Figure 11-17), and then click 
OK. 
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':lCP 
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xs 

[II: Entry Options 
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Figure 11-17 Defining the last name field 

• Select the last n am e fi e ld, and click Entry Options (See 
Figure 1 J -17). 

In this case, all you want FileMaker to do is check that a value has been 
entered into the fie ld. There is no way for FileMaker to know if the last 
name is a valid name, but it can check to see that something is in the field 
before accepting a record. 

On the right side of the Entry Options dialog box is a list of check boxes, 
below t he phrase "Require field to contain a:". The first item is "Value," 
and this is the one you want to se lect. 

• Cli ck Value to select it, and then click OK (see Figure 11-18) . 
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r • File Edit em (iadneh rormnt Custom Window 

Customers 
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Figure 11 -18 Requiring a value in the last name fi eld 

The next nine fields all contain text, and none have any special entry 
options. 

,,.. Define the following text fields: TITLE, COMPANY, ADDRESS, 
CITY, STATE, ZIP, COUNTRY, AREA CODE, and PHONE NUMBER. 

You should see a list of fields in the upper box with the word "Text" next 
to them. It is important that the field names are spelled correctly as listed 
in the instructions . If you make a mistake, select the field, and correct 
the name. 

Automatic Entry 

The next fie ld to be entered is a date field, and it will contain the date 
when the customer was entered into the Customers file. This date will 
be automatically en tered by FileMaker through the use of an entry 
option. 

,,. Click Date, and name the field ENTRY DATE. Click OK (see 
Figure 11-19). 
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Figure 11-19 Defining the ENTRY DATE field 



Chapter 11: FileMaker 

Now, let's add the entry option fo r the field. 

• Select the field and cl ick Entry Options. 

501 

You can choose to have FileMaker automatically enter values for you 
when a n ew record is added to the file. On the left side of the Entry 
Options dialog box are three options. Under the phrase" Auto-enter in 
each new record: " is a "Today's date" check box. 

All Macintosh computers have a clock and a calendar that run all the 
time. (A battery supplies power when the computer is turned off or 
unplugged.) The current date and time can be set using the Control 
Panel desk accessory. FileMaker can check this calendar to determine 
the date. It is up to you to be sure the clock and calendar are set correctly, 
and don't forget t o change the clock if you live in a state with Daylight 
Savings Time. 

Choosing the Today's date op tion te lls File Maker to enter the date that 
it finds in the system 's calendar into the ENTRY DATE field. 

• Click Today's date, and then click OK (see Figure 11-20). 

r a file Edit em:ll G<ld!)Gh rormllt Custom Window 
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Auto- enter In eoch new record: 
~ Todoy's dote 
0 11 nl'ul sHI<JI nurnlleJ~ 11 I 
0 Dot a: '-----' 

I I 
0 Disploy o list of uolues: 

I 
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Figure 11-20 Choosing automatic entry of today's date 

The next field is a number field where FileMaker will automatically enter 
a unique identifying number for each customer. Let 's tell FileMaker to 
make the first customer n umber 1001 and then sequentially number 
each customer after that. 

Start by telling FileMaker that th1s is a number field, and then enter the 
name. 

• Click Number, name the fie I CUSTOMER NUMBER, and then click 
OK. 

Now add the entry options. 

• Select the CUSTOMER NUM ER fie ld and click Entry Options (see 
Figure 11-21). 
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Figure 11-21 Adding entry options to the CUSTOMER NUMBER field 

In the last field, ENTRY DATE, you told Fi leMaker to automati cally enter 
the current date . In this field you will tell FileMaker to enter a new serial 
number, starting with 1001. 

,. Click A new serial number:, and enter 1001. 

You want to be sure each customer number is different, so you need to 
tell FileMaker to allow unique values only in this field. 

• Click Unique value only (see Figure 11-22). Now click OK to accept 
these entry optio ns. 
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Figure 11-22 Choosing entry opt io ns for unique number 

Many of your customers represen t a business, so it is useful to en ter the 
business ty pe for each business customer. Thi s is ano ther case where a 
list of va lues is helpful. 

• Create a new text field named BUSINESS TYPE, and open its Entry 
Options dialog box. 

Now, enter the list of values available for this field . 
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• Click Display a list of values:. 

• En ter th e following items i ~to the list : Auto Body Repair, Auto 
Dealer, Car Wash, Glass Repa ir, Mechanic, Tire Dealer, and Welder 
(see Figure 11-23). Click OK. 
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Figure 11-23 Specifying a Jist of items for BUSINESS TYPE 

A majo r benefit o f using a Jist fo r entering info rmation into the fi eld 
becomes obvio us when you try to find all customers who represent a 
particul ar type o f business. By choosing from a list, you know that the 
type o f business is en tered exactly the same each time. Then if you tell 
FileMaker to find all records where the business type is Tire Dealer you 
ca n be confident that it will find a ll occurrences and not miss any 
beca use of typographi cal erro rs or because some were entered as Auto 
Tire Dealer, fo r exam ple. 

If th e business type is not in the li st, you can still type an entry into the 
fi eld . When you find that you have entered the same business type 
severa l times, you ca n choose to define fields, and add the new business 
type to the list. 

The last fi eld you will define for the Custo mers file is the REGION field. 

Yo u have not yet divided your service area into regions, but sometime 
in the near future you plan to do so. Let's set aside a fi eld fo r later use. 
You plan to o rganize your customers into nine regions, numbered 1 
through 9, a nd you wan t to store this number for each customer. 
Additionally, you want FileMaker to verify that the regio n number is in 
this specifi ed range. This can be accomplished by requiring the fie ld to 
conta in a value in the range from 1 to 9 only. 

• Create a new number field n amed REGION. 

• In the Entry Options dialog box, click Value in range only, ente r 
1 in the "from: " box, and then enter 9 in the "to :" box (see 
Figure 11-24) . Click OK. 
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Figure 11-24 Specifying a range of values for the REG ION field 

You have now defined all of the fields for this fil e. 

• When you return to the Field Definition dialog box, click Exit. 

• Click anywhere on the bold field titles on the left to deselect the 
record. 

FileMaker will ask if it is ok to allow the LAST field to remain empty. 
When you defined the fields, you told FileMaker to be sure a value 
existed in the last name field before accepting a record. In a few 
moments, you will enter information into this record, but, for now, tell 
FileMaker it is ok. 

• Click OK. 

FileMaker will create a default vertical layout showing the fields in the 
order they were entered, and will create the first record (see Figure 11-
25). In Project 2 you will learn how to change the formats of the fields 
and create three new detailed layouts for use with this file. For the 
remainder of this project, you will use the default layout created for you 
by FileMaker. 
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Figure 11-25 The first record after defining the fields 
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Notice that the entry date and customer number have already been 
entered by FileMaker. (Your date should be different from the one 
shown in the figure.) 

You have done a significant amount of work now, so it is a good time 
to save a copy of this file. 

• Choose Save a Copy from the File menu. 

FileMaker gives you three choices for the copy: Copy of this file, 
Compressed copy, and Clone (see Figure 11-26). 
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Figure 11-26 Three choices for saving a copy of the Customers file 

The first option is the default, and it is the one you will choose this time. 

• Click OK 

File Maker will suggest naming this file Copy of Customers and will place 
it on the same drive and in the same folder with the Customers file (see 
Figure 11-27). This is what you want to do. 
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Figure 11-27 Saving a copy 
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• Click New to create the new file. 

ENTERING DATA 

Now that you have defined all the fie lds that are necessary for th is file, 
it is time to create new records and enter data. FileMaker created the first 
(mostly) blan k record when you exited from initially defining the fields. 
It has already entered the curren t date and the customer number (1001). 

The other fie lds are blank and will remain blank until you ente r the data. 
Let's enter the name and add ress o f your fi rst customer. 

To begin ente ring data, you have to activate the list in the PREFIX field. 

• Click to the right of the PREFIX field label. 

Clicking in the area where the fields are located activates the record. 
When you click in t he PREFIX field, all the fields in the record are 
o utlined with dotted lines. The PREFIX field is a text field with an en try 
list, so the list becomes visible (see Figure 11-28) . 
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Figure 11-28 Ente ring the prefix data 

The first customer is Ms. Sandra M. Hardin, so let's enter her name. 

• Double-click on Ms. to en ter it into the PREFIX field . 

When you select from a list, FileMaker en ters what you selected into the 
field and then moves the insertion point to the beginning of the next 
field, in this case, the first name fie ld. 

• Type Sandra in to the fi rst name fi eld, and then press the Tab key. 

Wh en you enter th e name, the insertion point remains at the end of the 
field . You can choose between two methods fo r moving to the next field . 
As with most operations on the Macin tosh, you can cl ick on a field with 
the mouse to activate the field and move the insertio n point. In this 
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case, there is a faster way, and thJat is to press the Tab key. Any time you 
press the Tab key, the contents 9f the current field are accepted and the 
next field in the record becomes the active field. In this case, pressing the 
Tab key moved the insertion point to the beginning of the middle initial 
field. 

,.. Type M. in the middle initial field, and then type Tab. 

Now the insertion point should be at the start of the last name field. 

,. Type Hardin, and then tab to the next field. 

Ms. Hardin, as your customer, does not represent a company, so you 
won't enter a title or company. The next information is to be entered 
into the ADDRESS field. 

,. Press the Tab key until the insertion point is in the ADDRESS fie ld. 

Ms. Hardin's address is 497 Seemore Drive, Apt. 3, Asheville, NC 29702. 

u• In the ADDRESS field, type 497 Seem ore Drive, Apt. 3, and then tab 
to the CITY field. 

,.. In the CITY field, type Asheville, and then tab to the STATE fi eld. 

• In the STATE field, type NC, and then tab to the ZIP field. 

• In the ZIP field, type 29702, and then tab to the next field. 

Ms. Hardin lives in the United States so you don't have to enter anything 
in the COUNTRY field. Her phone number is (234) 555-2922. 

• Tab to the AREA CODE field and enter 234, then, after moving to the 
PHONE NUMBER field, enter 555-2922. 

FileMaker has already entered the entry date (yours will show the 
current date) and the customer number (1001). The first eight customers 
you will enter are old customers; some have been customers for several 
years. After entering those customers, you will enter a couple of new 
customers. In the case of a new customer, you will accept the entry date 
that is automatically entered. For someone who already is a customer, 
you can override the entered date and type in the correct one. Let's do 
that for Ms. Hardin. 

.. Tab to the ENTRY DATE field and press Backspace (or Delete) to erase 
the automatic entry. 

,. Type 7/11/86 for her entry date. 

lf you would like to see the rest olf the record, you can click on the down 
a rrow in the scroll bar. Click on the up arrow in the scroll bar to return 
to the top of the record. 

Visually inspect the information you have entered, and compare it with 
the record shown in Figure 1 ~-29 . If you have made any mistakes, 
click in the field with the error and correct your mistake. 
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The next customer is Mr. George M. Lapmont. 

• Enter Mr. by double-clicking on it in the list, then enter the rest of 
his name in the appropriate fields. Don' t fo rget to press the Tab key 
to move to the next field. 

Mr. Lapmont is the manager of Bell Tires, which is a company that 
purchases from you regularly. 

•• Enter Manager in the TITLE field and Bell Tires in the COMPANY 
field. 

Bell Tires is located at 2354 78th Avenue, Bellvue, WA 71356. Their 
phone number is (651) 555-2654. 

• Enter 2354 78th Avenue in the ADDRESS field, Bellvue in the CITY 
field, WA in the STATE field, and 71356 for the ZIP field. 

• You don't need to enter a country, so skip that field by using the Tab 
key. Enter 651 in the AREA CODE field and 555-2654 in the PHONE 
NUMBER field. 

FileMaker has already entered the entry date and customer number into 
the record, but you need to change the entry date. 

,. Replace the date entered by FileMaker with 10/21/86. 

,. Activate the BUSINESS TYPE field by moving to it using the Tab key 
or by clicking in the field with the m ouse. 

When the BUSINESS TYPE field becomes active, it shows the list you 
defined. Bell Tires is a tire dealer. 

• Click on the down arrow in the business type list to scroll down until 
you can see Tire Dealer. Double-click on Tire Dealer to enter it into 
the field (see Figure 11-31). 

ei File Edit Select (i~ldgeh ror mut Custom Window 

Customers 

FIRST !George 
HI .M. I 

LAST j L~pmonl L 
TITLE f M~neger I 

COMPANY jBell Ti res 
ADDRESS j 2354 7Blh 4venue 

CITY !Bellvue 
STATE f WA I 

ZIP f7 1356 I 
COUNTRY 

AREA CODE 

PHONE NUMBER 

i 

I 

C~r W~sh 1 
Gl~ss Rep~ir 
MechOnlc I 

ENTRY DATE ···!!!• -~~~····••tl CUSTOMER NUMBER ~W;.;.el;.;.de;,;.r ___ ~ ------fUO 
BUSINESS TYPE 

~ 
i!i:i 

l!!i!l 
·h~· 
i j~:; 
,i .. 
;r, 

···~· 

ILl sr., .. 101 I I~ 121 

I 
Figure 11-31 Entering the business type into a record 
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Now you can visually veri fy that the inform ation o n this customer is 
entered correctly (see Figure 11-32). 

' 4 File Edit Select Gadgeh Formal Custom Window 

10 Customers 0 i 
""'" j '-'CUO yc ' f'=! 

8! HI jM. I 
LAST ILapmont I 
TITLE !Manager ! 

Rooords : COHPANY jBell Tires I 2 
ADDRESS !2354 78th Avenue 

CITV !Bell vue l 
STATE jWA I ZIP !7 1356 

COUNTRY i i 
AREA CODE 1651 I 1-

PHONE NUMBER 1555- 2654 __j 
r-

ENTRY DATE 110/2 1/86 ! 

11002 l -
CUSTOHER NUMBER i 

BUSINESS TYPE !Tire Dealer -------·-] 
REGION L I [6 

[C) 8rO'W5~ 101 It; '2l 

Figw·e 11-32 Completed second record 

When you a re sure the informatio n is correct, accept this record and 
create a new one. 

3€ -N • Choose New Record from the Edit menu. 

The next customer to be entered is Mr. j im Bell, who lives at 
1492 Document Drive, Mandarin, FL 49709. His phone number is (203) 
SSS-2731. His date for becoming a customer was 11/01/86. 

• Enter the information for this customer into the proper fields. 

When you have completed entering this data, check you r entry against 
the record as shown in Figure 11-33. 

r • File Edit Selec t (iadg<!h Format Custom Window 

iD Customers i 

Bi 
Q 

PREFIX JMr. l 

FIRST iJ 1m I HI : :'' Rtcerds: : 
!Bell 3 LAST 

' f: 
TITLE i 

COMPANY l 
',y 

ADDRESS j 1492 Document Drive 
,, 

CITY !Mendorin : STATE jFL 
ZIP j49709 I !' COUNTRY l 

I AREA CODE j203 ; , 

PHONE NUMBER !555- 273 1 _________ j 
ENTRY DATE 1~ ~ 10 11a~ I ~ 

!D Browst 101 10 '21 

Figure 11 -33 Completed entry for jim Bell 
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When thi s information is corrJct, create a new record and enter the 
information for your West Coast attorney, Ms. Kay B. Kusunoki. 

3€ -N • Choose New Record from the Edit menu. 

• Type the attorney's name in the appropriate fie lds, and then type 
Attorney in the TITLE field. 

Ms. Kusunoki 's address is 7531 Second Street, San Franc isco, CA 92846. 
Her phone number is (978) 555-2383. Her en try date should be 
01/14/87. 

• Enter the address and pho ne number into the proper fie lds. 

Veri fy that you have entered this data correctly (see Figure 11-34). 

r li File Edit Select Gadgeh Format custom Window 

Customers 

B! PREFIX 

FIRST 

HI 

Ms 
Key 
6 

R+cords· 
4 LAST Kusunokl 

T ITLE Allomey 
COMPANY 

ADDRESS 7531 Second Street 
CITY Sen Francisco 

STATE CA 
ZIP 92646 

COUNTRY I 
AREA CODE 976 

PIIONE NUMBER 

ENTRY D ATE 

555-2363 
1-;::0-;-1 /;:-174/;::::8:;-71 --T ~ - ·----·--

[L] Bl-owst 0 1 

Figure 11-34 Comple ted record for Ms. Kusunoki 

• Using what you have learned about en tering new customers, enter 
the four customers listed below: 

Ms. Faye Mau ney 
15 \1ockingbird Lane 
Pine log, TX 69007 
(833) 555-0927 
10/19/87 

Mrs. Mattie L. Dilbeccio 
Owner 
Grape Creek ew and Used Cars 
14709 Main Street 
Grape Creek, C 28087 
(702) 555-1092 
11/06/87 
Auto Dealer 
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Dr. Jose S. deAngello 
117 Third Street 
Apache Junction, AZ 78273 
(604) 555-7826 
08/06/89 

Mr. Gary H. Westmoreland 
Owner 
Western Carolina Welding 
2741 Highway 141 
Peachtree, NC 28915 
(703) 555-1273 
09/29/90 
Welder 

You should now see Mr. Westmoreland's information on the screen (see 
Figure 11-35). 

' j File Edit Select Ciddgoh Format Custom Window 

iD 

B! -
8 

[0 Bro..,,. IQ I 

Customers 
"K~ I 

LA=~ t:-1~:-· e....,st_m_or"'"'el,..-an"'"'d--------i 
TITLE Owner 

coMPANY !Western Carol ina Welding 
ADDREss 274 1 Highway 141 I 

cnY Peachtree J 

sT:: : t-.::~:::':-:~9::-:1-=-s----------ill 
i COUNTRY 

AREA CODE r-7:::':-:03:-:-=---------ij 
PHONE NUMBER t-;:5-;::-55;::;·-;::-12;::;7::;:-3---,- ·--·--·-' 

ENTRY DATE 09/ 29/ 90 ___ i 
CUSTOMER NUMBER ! 1 008 ! 

BUSINESS TYPE i:':W':':"e;":ld':":er:---'-----------.,~ 
REGION l j 

Figure 11-35 Completed record for Mr. Westmoreland 

.. Now, enter two more customers, using information of your choosing. 
Accept the entry date entered by the computer. 

This demonstrates how File Maker can enter the date for you automatically 
for convenience and accuracy but still offers the flexibility to enter other 
information in the field if needed. 

.. When you have completed entering these six names, click on the 
last record, anywhere to the left of the fields to deactivate the record. 

When you click outside the area of the screen that con tains the fields, 
the fields are no longer outlined (see Figure 11-36). 
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EDITING DATA 

Duplicate Record 

' • File Edit Select G<idfJBh rormnt Custom Window 

Customers 

PREFIX MS. 

FIRST LOI S 

HI J . 
LAST 

TITLE 

COMPANY 

ADDRESS 

CITY 

STATE 

v~rmus 

Office MenBger 
Keymus & Ver.mus 
7293 Auror~ Avenue 
Midlothian 
IL 

ZIP 72932 

AREA CODE 826 
PHONE NUMBER 555-2826 

ENTRY DATE I 0/ 26/90 
CUSTOMER NUMBER I 0 1 0 

M, 

(0 llrowst ICJ I 11:) 1/2 

Figure 11-36 The last record has been entered. 
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• This is a good time to save a copy of this file. Choose Save a Copy 
from the File menu, name it Copy 2 of Customers, and click New to 
create the new file on your data disk. 

You now have the current Customers file and two backup copies on your 
data disk. 

FileMaker lets you modify information in the fil e at any time. Standard 
Macintosh editing techniques are used to select, modify, and delete text 
in a field. 

Since you can modify information in a field at any time, there are times 
when it is easier and faster to duplicate a record and then edit the 
information in some of the fields. 

You have now entered ten customers. In this case, none of the customers 
that you were entering had similar data. Sometimes, however, you will 
enter a series of customers who have several fields containing the same 
information. When this situation arises, you can frequently save time 
by duplicating a record rather than creating an entirely new one. 

Let's say that you need to add information on the following customer 
(don't enter anything yet): 

Mrs. june Brooks 
Route 4, Box 199 
Pinelog, TX 69007 
(833) 555-0835 
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Finding a Record 

Part V: Information Management 

Before you add the customer, you remem ber that you already have at 
least o ne customer in Pinelog, Texas, and some of the information in 
that customer's record will match this one. Let's find that customer. 

3€ - F • Choose Find from the Select me nu. 

FileMaker presents you with the Find screen, which looks like a blank 
record (see Figure 11-37). 

' a File Edit Select (illdgoh rormo t Custom Window 

Customers 

a~ 
PREFIX p! 

FIRST Mr. lQ ,, 
Ml Ms. ~· 

LAST Mrs. 
Rtqutsts: Dr. I" 

1 TITLE 

!0 COMPANY 
Rev. 

O Omll 
ADDRESS 

I 

I ~> 
Q§] CITY 

I 
t'· 

STATE I=-' 

CDCD ZIP 

CDGJ COUNTRY 

I 
I 

AREA CODE I 11:•; GCJ PHONE NUMBER 1:? mcm J 
----' 

ENTRY DATE I 
p: 

CUSTOMER NUMBER I I 
IQ 

[IJFind 121 _11;: 121 

Figure 11-37 FileMaker's Find screen 

The PREFIX field is showing its list, bu t you are not going to enter 
anything in tha t fie ld. You want to find a ll customers who live in a city 
named Pinelog. 

• Clic k in the CITY fie ld and type Pin elog. Click Find (see 
Figure 11-38). 

' li File Edit Selec t lilldfl<lh r ormut Custom Window 

!10 

Rtquuts: 
1 

O Omll 

[ Find._] 

CDCD 
CDGJ 
G CJ 
CDCZZJ 

([[ Find 

Customers 
PREFIX 

FIRST lr-------------1 
LA=~ ~ L 
TITLE . 

COM~ANY ~======================~ ADDRESS 
CITY i';;P~In:-:-e;-:IO-::r--!:j---------i 

ST ATE 

ZIP 

COUNTRY 

AREA CODE 

PIIONE NUMBER 

ENTRY DATE 

CUSTOMER NUMBER 

r-------,--·--··-·-·-·--···--·---··-·--

r------,. c~==--~.~ -····· -· 

Figure 11-38 Entering the search criteria 
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By entering Pinelog in the CIT field, you tell FileMaker that you are 
only interested in any record ith that name in that field. You can 
further restrict the search by entering information in other fields. 

When you click the Find button, FileMaker finds all records containing 
Pinelog. It finds one customer who lives in a city named Pinelog: Ms. 
Mauney. This is the same city where Mrs. Brooks lives, and looking at 
both addresses tells you that, indeed, several fields will contain the same 
information. In this case, it makes sense to duplicate Ms. Mauney's 
record and modify it. 

S€ -D • Choose Duplicate Record from the Edit menu. 

Notice that this record looks just like Ms. Mauney's original record, 
except that FileMaker has given it a different customer number already. 
Now you have to ed it the fields that contain different information. 

The PREFIX field is already active and showing its list. You need to 
choose Mrs. from the list . 

,,. Double-click Mrs. to enter it in the PREFIX field. 

• Double-click on the first name field in the record and type june to 
enter it as the first name. 

,,. Double-click on the existing last name and type Brooks to enter it 
in the last name field. 

.. Select the entire ADDRESS field by double-clicking on the first word 
in the address, holding down the mouse button, and dragging to the 
right until all the address is selected. Type Route 4, Box 199 to enter 
the new address. 

The information in the CITY, STATE, ZIP, and AREA CODE fields is the 
same for both customers so those fields don' t need to be changed. 

,.. Double-click on the phone number and type 555-0835. 

The current date and proper customer number are entered automatically 
when you duplicated the record. 

Your screen should look like the one shown in Figure 11-39. 
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Delete Record 
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'" • File Edit Select GddlJ<~h Format Custom Window 

~0 

8! -
2 

Rocords : 
11 

Found : 
2 

[[J Browse 10 I 

Customers 

PREFIX [Mrs_-----------------------------···-··-······-··-·· ··---····-~ 

FIRST jJune I 
HI 

LAST jBrooks 

TITLE 

COMPANY 

ADDRESS J Route 4, BOX 199 

CITY jPinel og 

STATE jT X 
ZIP i":j 6~9":'07.07:::--------------; 

COUNTRY 

AREA CODE 

PHONE NUMBER 

ENTRY DATE 

1833 
jsss-0835 
i 10/26/9 0 ' 

Figure 11-39 The duplicated record after editing the data 
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ii!!l! 

II 
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Look at the status area. It shows that there are now 11 records in the file 
and 2 are found. You told FileMaker to find the records that contain 
Pinelog in the CITY field, and now there are two records that match that 
criteria. 

Let's tell FileMaker to find all records in the file. 

00 -G • Choose Find All from the Select menu. 

• Now is a good time to save a copy of this fil e. 

Assume that you are done entering information into the Customers file 
and want to quit . 

00 -Q • Choose Quit from the File menu. 

At a later date, suppose you need to delete Mrs. Brooks' record from your 
file. To do this, you can open the Customers file, find the record you 
want to delete, and tell FileMaker to remove that record from the file. 

• Find the icon of the Customers file on your data disk and double
click on it to start FileMaker and open that file. 

Before you closed the Customers file, you were looking at the last record 
in the file, but now when you open the file again, the fi rst record is on 
the screen. You need to find Mrs. Brooks' record. 

00- F • Choose Fin d from the Select menu. 

• Type Brooks in the last name field, and then click Find . 

The record will appear on the screen in a moment. Deleting this record 
is fast and easy. 
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:3€ -E ,. Choose Delete Record fro the Edit menu. 

You will be asked if you want to permanen tly delete this record (see 
Figure 11-40). 

r • File iJ!!IISelect Ciadget~ rorm11t Custom Window 
~ 

Customers 

§~ PREFIX Mrs. 
I ~ 

•oR~T lunA !,=l1i 
;';i'i 

Rtcords: 6 Permanently delete this record? 
II 

Found : 
I 

fioelet~ [cancel) 
., 

.... o cou~ !il:l 
STATE TX !ii•' 

ZIP 69007 li:j,i 
COUNTRY 

AREA CODE 633 
PHONE NUMBER 555-0635 

ENTRY DATE 10/26/90 ~ 
Browst '21 

Figure 11-40 Dialog box to confirm deletion of a record 

- Click Delete. The record is then removed from the Customers file. 

You should now see the tenth record on the screen. 

You have been working in Browse mode for most of this project. This 
mode lets you view records, add new records, duplicate records, change 
the information in a record, and delete records. This is the mode you will 
use most of the time when you are working in FileMaker, because it lets 
you work with the information contained in the file. Another mode, 
Layout, lets you modify the arrangement and appearance of fields, 
graphics, and text. You will learn to use Layout mode in Project 2. 

Since you have not learned to create alternate layouts, you have been 
looking at the information in the Customers file using the default layout 
FileMaker created for you. FileMaker lets you create as many different 
layouts for a file as you want. You can browse through the information 
in the file using any of those layouts. 

Before completing Project 1, le 's practice moving through the file a 
little. I 

The top left corner of the window contains the book, slide control 
handle, and status area. You can use the book or the slide control handle 
to move through the file and vtew different records. 

I 
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Using the Book 
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The book lets you go o ne reco rd closer to the firs t or last record. You can 
click on the top page of the book (i f it is not blank) to go one record closer 
to the first record. Clicking on the bottom page of the book takes you 
one record closer to the end of the file. 

Record 10 is showing on the screen now. The bottom page is blank, and 
this ind icates that you are currently viewing the last record in the file. 
If the to p page were blank, you would be viewing the first record. 

.. Click the top page o f the book. 

You should now see record 9 on the screen. Now that you a re not 
viewi ng the last record in the file, the bottom page of the book is no 
longer blank. 

Another way to use the book is to cl ick on the middle page, and t hen 
type the number o f the record you want to see. Let's say you want to see 
customer number 1003. The customers were numbered starti ng with 
1001, and this means that customer number 1001 is in the first record, 
number 1002is in the second record, and soon. To see customer number 
1003, a ll you have to do is view the third record. 

• Click the middle page of the book, type 3, and then type Return or 
Enter. 

You should now be viewing the information fo r customer num ber 1003. 

Using the Slide Control Handle 

The slide control handle is useful for moving quickly to the first or last 
record in the fi le. Also, as your file becomes larger and deletio ns create 
holes in the record number sequence, you will no longer have as clea r 
a relation between the book page number and the customer number. 
Then the slide control handle will allow you to move closer to where you 
th in k the record you wan t may be. 

• Poi n t to the slide control handle, press the mouse button and while 
ho lding the mouse button down, d rag the handle to the bottom. 

You are now looking at the last record in the file again . To view the first 
record you could drag the han dle to the top. As you drag the hand le, the 
number in the midd le page of the book changes to represen t the record 
you would see if you released the mouse button. Move to record number 
3 again. 

• Drag the slide contro l handle unti l the middle page of the book has 
a 3 showing. Release the mouse button. 

• Now, use any of these methods to move to t he first record. 
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PRINTING A FILE 

You have now created a file, defined its fields, and entered data into the 
file . 

It is handy to keep a paper copy of the file in case anything happens to 
the copies stored on the di sk. (You did make several copies and a backup, 
didn' t you?) 

There are two reports you can print whenever you have created a file and 
entered data into it. Both reports are available by choosing the Print 
command. 

3€ -P ,,. Choose Print from the File menu. When the dialog box for printing 
is displayed, accept the default values by clicking OK. 

FileMaker will print a report containing all ten records and their 
contents. The report should take about six pages, and the first page 
should look like the one shown in Figure 11-12, at the beginning of this 
project. 

The second report that is useful for documenting the field definitions of 
a file is also printed using the Print command. 

3€ -P ·• Choose Print from the File menu. 

This time, you want to change one of the options in the dialog box that 
appears . 

,,. In the bottom line of the dialog box, click Field Definitions. 

This tells File Maker to print the definitions of the fields, rather than the 
contents of all the records. 

• Click OK. 

FileMaker will print a report that should look like the one shown in 
Figure 11-41. 
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Field Name Field Type Formula I EntrY Option 

PREFIX Text List: 
Mr. 
Ms. 
Mrs. 
Dr. 
Rev. 

FIRST Text 

Ml Text 

LAST Text Required vall.le 

TITLE Text 

COMPANY Text 

ADDRESS Text 

CITY Text 

STATE Text 

ZIP Text 

COUNTRY Text 

AREA CODE Text 

PHONE NUMBER Text 

ENTRY DATE Date AL!to-enter today's date 

CUSTOMER NUMBER Number Auto-enter serial number: 1012 
Unique values only 

BUSINESS TYPE Text List: 
Auto Body Repair 
Auto Dealer 
Car Wash 
Glass Repair 
Mechanic 
Tire Dealer 
Welder 

REGION Number Value in range from " 1" to " 9" 

Figure 11-41 Report showing field definitions of Customers file 

This concludes Project 1. 

You will continue to use the Customers file in the next two pro jects. 
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Project 2: Creating Detail Reports 

In Project 2, you will learn to create two types of detail reports based on 
the information you entered into the Customers file in Project 1. You 
will create two columnar reports and a report that prints mailing labels. 
These reports will be created using File Maker's preset styles for columnar 
and label reports. 

A columnar report prints information in columns, and a label report 
prints information in a grid-like pattern consisting of several rows and 
columns. 

These reports are called detail reports because they print something for 
each record that is currently selected. A summary report does not give 
details for each record, it just provides information about the current 
selection as a whole. Where a detail report might show how much you 
are owed by each customer, a summary report might show only the total 
amount you currently have in accounts receivable, the average amount 
for each customer, and the number of transactions in the file. 

File Maker also lets you create a new blank report and place fields, graphics, 
and text anywhere on the page. The flexibility provided by the blank 
report demands a cost in terms of time and effort, but it allows you to 
design a report that shows the information you want in exactly the way 
you want to present it. You will learn to create a report from a blank 
layout in Project 3. 

The output of the three reports you'll create in Project 2 appears in 
Figures 11-42, 11-43, and 11-44. 
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FIRST 
Sandra 
George 
Jim 
Kay 
Faye 
Mattie 
Jose 
Gary 
Glenda 
Lois 

LAST 
Hardin 
Lap mont 
Bell 
Kusunoki 
Mauney 
Dilbeccio 
deAngello 
Westmoreland 
Rider 
Yarmus 

Page 1 

Part V: Information Management 

October 27, 1991 
7:33PM 

CUSTOMER NUMBER 
1001 
1002 
1003 
1004 
1005 
1006 
1007 
1008 
1009 
1010 

Figure 11-42 Final output of Project 2, customer name and identification 
number report 
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FIRST 
Jim 
Jose 
Mattie 
Sandra 
Kay 
George 
Faye 
Glenda 
Gary 
Lois 

LAST 
Bell 
deAngello 
Dilbeccio 
Hardin 
Kusunoki 
Lapmont 
Mauney 
Rider 
Westmoreland 
Yarmus 

Page 1 

AREA CODE 
203 
604 
702 
234 
978 
651 
833 
827 
703 
826 

October 27, 1991 
10:14 PM 

PHONE NUMBER 
555-2731 
555-7826 
555-1092 
555-2922 
555-2383 
555-2654 
555-0927 
555-2783 
555-1273 
555-2826 

Figure 11-43 Final output of Project 2, customer name and phone 
number report 
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Mrs. Mattie L. Dilbeccio 
Grape Creek New and Used Cars 
14709 Main Street 
Grape Creek, NC 28087 

Mr. Jim Bell 
1492 Document Drive 
Mandarin, FL 49709 

Ms. Lois J. Yarmus 
Kaymus & Yarmus 
7293 Aurora Avenue 
Midlothian, IL 72932 

Ms. Kay B. Kusunoki 
7531 Second Street 
San Francisco, CA 92846 

Mr. Gary H. Westmoreland 
Western Carolina Welding 
2741 Highway 141 
Peachtree, NC 28915 

Ms. Faye Mauney 
15 Mockingbird Lane 
Pinelog, TX 69007 

Dr. Jose S. deAngello 
117 Third Street 
Apache Junction, AZ 78273 

Part V: Information Management 

Ms. Sandra M. Hardin 
497 Seemore Drive, Apt. 3 
Asheville, NC 29702 

Mr. George M. Lapmont 
Bell Tires 
2354 78th Avenue 
Bellvue, WA 71356 

Ms. Glenda Rider 
1294 Skyline Trail 
Denver, CO 82742 

Figure 11-44 Final output of Project 2, mailing labels report 

CREATING CUSTOMER LISTS 

FileMaker is capable of producing many different types of layouts, and 
you have a wide range of formatting features to customize these layouts 
to fit your particular needs. When you create a new layout, FileMaker 
offers you four choices: standard, columnar, label, or blank. 
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Project 1 introduced you to the s andard layout. This project will guide 
you through completing colum ar and label layouts. You will learn to 
create customized reports from a blank layout in Project 3. 

FileMaker's columnar reports give you the tools to create ad hoc reports 
quickly and easily. If you want a list of a few items from a file, you can 
create that list by creating a new columnar report and specifying the 
fields that should be in the report. FileMaker will create a layout showing 
those fields in the order you specified. With a little practice, this process 
takes only a few seconds to complete. 

The first columnar report you will create lists the customers' names (last 
name and then first name) and their customer numbers. In Project 3, 
you will create a sales invoice file, and that file will look up information 
about the customer's name and address from the Customers file. The key 
field that connects these two files will be the customer number. When 
a customer buys auto parts, you will enter the customer number into the 
proper field on the invoice. 

It is easy to print a report that shows the customers' names and numbers, 
and that report can be used when entering customer information into 
the Sales Invoices file. If you know the customer's name, you can look 
in the list and find his or her number. (Of course, you can use the Find 
command in FileMaker to find this number even faster.) 

There will be times, however, when you will know a customer's number, 
but not his or her name. In this situation, you want to have a report that 
is printed in numerical order based on the CUSTOMER NUMBER field. 

FileMaker can quickly sort a file based on any field you specify. In this 
project, you will sort the customer name and number list in two ways: 
alphabetically by name and numerically by customer number. The 
mailing labels will be sorted by Zip code. 

A report can be printed in alphabetical order by customer name, in 
numerical order based on the customer number, in chronological order 
based on the date of sale, or even in ascending or descending order based 
on the amount of the sale. Depending on the circumstances, the 
information you already have available, and what you are trying to find, 
all of these formats can be very useful. 

FileMaker allows you to create and use several different layouts with 
each data file. A layout determines how the information contained in 
the selected records is presented on the screen or on a printout. 

You can place text (for label? ng fields or showing explanatory 
information), graphics (lines, rectangles, ovals, or images copied from 
other graphics programs), and the fields used by the file. Each of these 
three elements is treated as an object by File Maker. You can move, resize, 
and delete graphics. Text and fields can be modified by changing their 
size, position, font, style, alignment, and formatting attributes. 

I 
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Standard Layout 

The view you have been using is the default layout that FileMaker 
created, using the fields you defined in the order in which they were 
defined. This lists the name of the field on the left and then each of t he 
fields from top to bottom aligned immediately to the righ t of the field 
name (see Figure 11-45) . 

This is not always the best way to display your information, so FileMaker 
allows you to change the default layout and/or create new ones. 

For example, you can make a field in the standard layout longer or 
shorter. You can change the font, size, style, and alignment of the text 
in the fields or in the explanatory labels to the left of the fields. 

If you want a more customized layout, however, the creation of a 
d ifferent layout is better than modifying the standard layout, in most 
cases. 

Let's give it a try. If you quit FileMaker since completing Project 1, you 
should restart. The easiest way to open File Maker and the Customers fil e 
is to find the Customers file icon and double-click on it. 

If you haven't quit FileMaker, you need to open the Customers file. 

• Open the Customers file, if it is not already open. 

3€-L ",. Choose Layout from the Select menu. 

This will show you the standard layout that was created for you when 
you defined the fields in Project 1 (see Figure 11-45). 

r • File Edit Select Gad 

I.Fi.el.d ... ..• l 

COMPANY 

COUNTRY 

AREA CODE 

PHONE NUMBER 

Figure 11-45 Default layout created by o riginally defining fields 

., 
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In Project 1 all the fields were named using a ll uppercase characters. In 
this project, you will add three ca~culation fi elds, and they will be named 
using upper- and lowercase characters to help distinguish between 
them. FileMaker does not specify this style of naming fields, it is used in 
Project 2 only to help you differentiate between the fields you created 
in Project 1 and these you define here. 

Adding a New Layout 

Adding a new layout is a straightforward process in FileMaker. When 
Layout mode is chosen, the Ed it menu changes. Command-N in Browse 
mode means create a new record. The sam e command in Layout mode 
means create a new layout. 

Before you add a new layout to the Customers file, let's look at the tools 
available in Layout mode. 

Palette Tools 

FileMaker provides several tools that may be used to create new layouts. 
The icon s representing these tools are shown in Figure 11-46, an d the 
tools are then described individually. 

1 2 3 

~ m 
4 5 6 

7_.1HeJ.d .. .. .• , 

1 - Arrow tJol 
2- Text tod~ 
3 - Line tool 
4 - Rectangte tool 
5 - Rounded rectangle tool 
6- Oval tool 
7- Field tool 
8 - Part tool 

Figure 11-46 Tools used in Layout mode 

Arrow Tool- As you probably already know from using other Macintosh 
applications, the arrow tool lets you select, move, and reshape objects. 
The arrow tool also allows you to change the size of layout parts. This 
tool is the default tool. 

Text Tool - Clicking this tool somewhere on the layout anchors an 
insertion po int where you can ~dd text. If text already exists, you 
can edit that text by selecting part1 o f it and typing the replacement text. 

Line Tool - Move the mouse to w ere you want to anchor one end of a 
line, press the mouse button and hold it down, drag the line to where 
you want it, and then release the button to anchor the other end. 
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Rectangle Tool - Move the mouse to where you want one of the corners 
of the rectangle, press the mouse button and hold it down to anchor the 
first corner, then drag the outline to where you want the diagonally 
opposite corner. Release the mouse button to anchor the second corner 
and draw the rectangle. 

Rounded Rectangle Tool- This works the same as the rectangle tool, except 
that the corners of the box will be rounded. 

Oval Tool- As with the rectangle and rounded rectangle tools, select one 
corner, and then press the mouse button and drag to the diagonally 
opposite corner. This will define a rectangle, and the oval will then be 
drawn so that it is inset inside the rectangle you just defined. 

Field Tool- By clicking on the field tool and then dragging it onto the 
layout, you can add and position a field anywhere on the layout. 
FileMaker lets you choose from a list of all the fields, so you can 
designate which field you want. You can add new fields to a layout, add 
fields you previously removed, or even show the same field more than 
once on the same layout. 

Once a field is placed, you may select it with the arrow tool and, by 
dragging the box on the lower right corner, you can resize the box larger 
or smaller to display the contents of the field as you want. 

Part Tool- There are several parts to a FileMaker layout. The main ones 
are the header, body, and footer. You may also create title header, title 
footer, sub-summary, and grand summary parts. These parts will be 
discussed in more detail later in this project and the next one. 

To add a part, click on the part tool and then drag the part to where you 
want it on the layout. 

By selecting a part with the arrow tool, you can make the part longer or 
shorter. All parts extend completely across the layout horizontally. 

These tools allow you to place fields wherever you want, to add text 
(which can be in any font or size available), and to use lines, ovals, and 
rectangles to group the different parts of the layout or to add graphic 
emphasis. 

FileMaker also lets you import graphics from other programs (such as 
MacPaint and MacDraw) and use these graphics as the background for 
creating a new layout. You can draw a form in a graphics program, paste 
it into FileMaker, and then add the fields onto the drawing of the form. 
You can also use this capability to paste company logos and other 
graphic elements onto a layout. 
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Now that you are fami liar with t e tools available in Layout mode, let's 
create a new customer list report. his will be a columnar report that will 
list the customers' last names, fi rst names, and customer numbers. 

~ - N .. Choose New Layout from the Edit menu. 

When you issue this command, FileMaker displays a dialog box asking 
for the type of new layout you want (see Figure 11-47). 

L.tvouts: 
1 

Create B new layout which Is a: 

0 Standard layout 

® Columner report layout 

0 label layout 

0 Blenk layout 

PHONE NUMBER 

Figure 11-47 Dialog box for selecting type of new layout 

• Click Columnar report layout, and then click OK. 

Columnar Layout 

Now that you have told FileMaker that the new layout is a columnar 
report, it assumes that you want to display only a few of the fie lds instead 
of all of them. The next thing you see is a dia log box that will let you 
choose the fields you want listed in this layout. 

In this case, you want to show the first name, last name, and customer 
number. Let's tell FileMaker to add the FIRST field to the report. 

• Click on FIRST in the scrolling field on the left. 

This selects the first name field and activates the >>Move>> button. If you 
click the >>Move>> button, it tells FileMaker that you want the selected 
field to be the first field in the left column of the report. 

• This is what you want, so click »Move>> (see Figure 11-48). 
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• File 

Field List 

PREFIH 
FIRST 
Ml 
LAST 
TITLE 
COMPANY 
ADDRESS 
CITY 

Select G11dgets Format Custom Window 

Customers 

Field Order 

[ 1: ll~nr J 

Figure 11-48 Moving the first name field into the report 

Like most Macintosh commands, this is a process of selecting the object 
(first name field) and then specifying the action for the object (move it 
into the report). Many of these two-step commands have equivalent 
shortcut commands. When specifying a field to move into a report, you 
can double-click on the field you want, and it will be selected and moved 
into the field order list with one action. 

.. Double-click on LAST to move it into the field order list. 

.. Double-click on CUSTOMER NUMBER to move it into the field 
order list. 

You have now specified the fields you want in this report, and the 
dialog box should contain these three fields in the order shown in 
Figure 11-49. 

r 45 File II!IJI Select G11dgets Form11t Custom Window 

Field List 

ZIP ~ COUNTRY li!ii 
AREA CODE !Iii !!,1 
PHONE NUMBER l!il 
ENTRY DATE ~~~~ 
CUSTOMER NUMBER 1!!!1 
BUS INESS TYPE fit 
REG ION 10 

Cust omers 

Cle11r 

Mt>IH~ 

OK ~ 
Concel ) 

Field Order 

FIRST 
LAST 
CUSTOMER NUMBER 

J 

r!!:pg~r:::=l}==r===p=H=::=~=Ny=U:=:=~:== :;.~=i=~R=~~="i=. ~=~:=-:~=~.= •• = •. :J=-: .=-:.=-:=-:.=-:.=-:.=-:= ... =. =··= • .,=:·=·:·'f'=~~· 

Figure 11-49 Specifying the three fields to show in this report 

,. When you have verified that the fields you have chosen are correct, 
click OK. 
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FileMaker now produces the co umn layout using the three fields you 
just chose (see Figure 11-50). No~ice that the book has changed to show 
that there are now two layouts for this file. 

r • File Edit Select 
., 

-;FIRST ~ CUSTOMER NUMBER 

]EL~~~~~~~~~:h~~~I~~~~~~~J~-~~Tp_MJ_~~~~~~ij-~~~~~~ 

Figure 11-50 The layout for your customer list 

As part of this process, FileMaker has selected the View as List option 
from the Gadgets menu. Let's look at the differences in how this layout 
works when View as List is not selected and then again when it is. 

• Choose View as List from the Gadgets menu to deselect it. 

~ - B • Choose Browse from the Select menu. 

When View as List is not selected, Browse will only show one record 
using the currently selected layout. Your customer list is not a list since 
you deselected this option (see Figure 11-51). 

' a File Edit Select (i <ld ~Joh rormo t ,Custom Window 

10 Customers 

Rteords : 
10 

FIRST 

Scndrc 

!.MIT 

Herd In 

CUSTOMER NUMBER 

1001 

Browst '21 

Figure 11-51 A columnar layout that is not a list 
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Since you really wanted this to be a Jist, let's go back to select View as List 
again. You can only choose commands from the Gadgets menu from 
within Layout mode. 

~ - L • Choose Layout from the Select menu. 

• Choose View as List from the Gadgets menu. 

Go back into Browse mode and compare the results. 

~-B • Choose Browse from the Select menu. 

You have now produced the customer list you wanted (see Figure 11-52). 

' * File Edit Select (iildg<lh rormut Custom Window 

ID Customers I 

~i 
:!:! 

FIRST !.AlU. CUSTOH~R NUHBER 

- Sendre Herdtn 1001 
Rtcord.s: George Lepmont 1002 10 

Jtm Bell 1003 
Key Kusunokl 1004 
Feye Meuney 1005 
Mellie Dllbeccto 1006 
Jose deAngello 1007 
Gery Westmorelend 1006 
Glenae Rider 1009 
Lots Vermus 1010 

10 
[L] Brow .. ~I 10 QJ 

Figure 11-52 A columnar layout with View as List selected 

This is a good time to save a copy of the file. When you save a copy of 
the file it also saves all the layouts that you have created. 

Before you print the report, let's add page numbers. Because the value 
of information is directly related to how current it is, let's also add the 
date and time on the printout. 

You only want these items to appear once on each page. You can put the 
page number at the bottom of the page in the footer, and the date and 
time can go at the top right corner of the page in the header. 

Headers and Footers 

A header is the margin at the top of the page where normal body 
information is not printed. Information placed in the header area of a 
layout will be printed at the top of every page and will appear at t he top 
of the screen in Browse mode. You can delete the header from any layout 
by dragging the Header part to the top of the screen until it disappears. 

The body area is printed once for every record. This is where the last 
name, first name, and customer number fields are located in this report 
(refer back to Figure 11-50). 
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A foqter is the margin at the bott m of a page. Information placed in the 
footer is printed at the bottom o every page and is shown at the bottom 
of the screen in Browse mode. Like the header, the footer can be 
removed from a layout. To delete the footer, drag the Footer part up to 
the Body part until the Footer part disappears. 

Two special parts, the title header and title footer, are used to replace the 
header and footer on just the first page. 

You can use FileMaker to Jearn more about headers and footers and also 
about adding page numbers, the date, and the time to a layout. As you 
have already seen, FileMaker's Help file is valuable for learning to use the 
program. What can it tell you about layouts and page numbers? 

Let's find out. 

00 -I • Choose Heip from the Apple menu. 

Now you can use one of the predefined scripts to find the layout 
information. 

00 -8 • Choose Arranging Information from the Custom menu. 

00 - F 

You are presented with the first of 15 records that are available for 
arranging information (see Figure 11-53). 

li · · fil e Edi t Selett li<Hig<lh f'ornm t Custom Window 

m FlleMulcer Help e:J! 

~i 
19 \tHAT 11RE LAYOUTS? 

A layout is an arr.nQtmtnt of objects ( fitldl ) t)(planatort,~ tt xt, pic:turu , lints, 
rtotinQlt s , ~nd on1s) Whioh \IOU ust to control tht Vi\1 your VtformaUon appurs on 

- tht scrttn Mid on pt))ff. Li',IOUts art complttt~ stparatt from tht dab in your 

Rtcor$: rtcords; thtV control on tv thto •pp .. r anct of yf)ur re cords . You c~ crutt .u mantJ 

69 1•youts u t,~ou nHd, •nd c.tn ch.lngt U1tm at....., timt to crtatt dlfftrtnt vtt ws of your 
Foond: dab. 

IS 
"a'h.n you crutt • ntw fitt, Fl'ltMaktr pr-oviduyou wUh .a s hnd•r d b y out so 'JOU 
C¥1 s1-1rt ~V!g ~ta irnmtdilttl\l. You un e~~ thts ~out, or cru t• MW I~OCJts: 
for otht>r usn. FfltMlktr providn tools to http !IOU to eru t• rf"PPrts , print mailincj 

~~~~::.,.~; ~~:~~i~:':t ~one;.•~ :~:~7; ':::t:::, ~:~r::~ sizf' 
ov-als; Mld putt pict...-H from othtr o~pplico~Uons . To work with l~oub, choou l,JV41UI 
from thf' Stlf'ct rMnu. 

4i To sH othtr r..cords on this topic, cliek p.tgts of thf book .at tM t09left of tM vindov. 
• For mort http on this topic., ••• thf' FO.Miktr II OwMr's: M~il, pp. 11, 14 1-1 53. 
• F'or hf'lp on othtr t09\ci:, ohoost tht topic you W.ant from thf Custom mtnu. Q 

Brovst Q l J~ £J 

Figure 11-53 The first of 15 help records on layouts 

It is worth your time and effort t~ at least skim the information in t hese 
15 records. One in particular h iljS the information you are looking for. 
You can have FileMaker find it for you. 

I 
• Choose Find from the Select menu. 

You are presented with the Find screen showing the three active fields 
in the Help file. 

• Type page number in the top field (see Figure 11-54). 
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' • File Edit Select Gadgeh r ormtl t Custom Window 

;o FileMolcer Help 0 i 

a~ 
pag• number IIQ 

.. ---, 

I R:tqutsts : 
I I 

oomlt I 

~ 
I 

I 
ITJCD 

I 

I I 
wCD I 

II 
I 

c:JQ I 

I 
CDCZZJ 

• To SH' othtr rtcordJ: on thts tOP.io click p!Q!S of tM book ~Utt.t..!2P.: ltft of tht ~v. 

• For mor. http on this topk , sttf" tn • For htlp on othtr topics , choou thf toplo you 'W~t from tM Custom mtnu. 

[I:] r ind ::JI I~ 112 

Figure 11-54 Finding help on page numbers 

If this seems familiar to you, it may be because this is the example for 
using the Help file that was presented in the introductory part of this 
chapter. 

If any of the records contain "page number" in the top field, FileMaker 
will quickly locate them. Note that capitalization is not important when 
you use Find to locate something in a file. 

"• Click Find. 

FileMaker now presents you with help on adding time, date, and page 
numbers to a layout (see Figure 11-55). It also mentions record numbers, 
but they won't be added to this report. 

' * File Edit Select G<ldg<lh rormut Custom Window 

10 FlleMolcer Help ! 

a~ 
PRINTING THE TIME. DATE. PAGE NUMBER, OR RECORD NUMBER ~ 
You c1n ttll FiltMiktr to print tht tan. , tod~ 's ~tt, tht pa9t numbtr . or taeh rt-cord 
numbtr b\1 tvpkl9 sptoS.l S'ljmbols in lf!Jout ttxt on ~~ layout: 

RKords : :: (two eolons) to hnt FlltM•ktr prklt tM timt (from tht Macintosh Control P~tO. 

69 TM Umt is dfspl~~J•d Yhtn vou prtvitw or Pf'int rtcOrds. 
Found : 

I II ( two s lashts ) to havt FlttM.Ikf'r print today 's dat• ( from tM M iCintosh Control 
Pintl). You o.Jn uu tht r~tD.Ih' comn'U1nd Y\ tht f ormat tMOU to c:h~ thf. 
~..-~of tht ditt . Ttw d~tt ts dtsp1•'ltd wtwn \IOU brows.~ pre-vltv ~or print 
r"toOt"dS. 

• • ( two OI.U'T'Ibtf" si9ns) to hivt ffltM1ktr pr int tnt p1got ~. Thf' P-i9" lll..ll'nbH is 
displ.ttJtd whtn \IOU prnWw or print rtoords. 'W'htn you choon F'rlll vou e m spK:ify 
tht runbfor to st..-t with as wtll u thf' r •ngt of ~s to print. 

6@1 ( two "1t .. sic)ns) in thf' ~ of tht I~~Jout to hn• Fi1~tr print tht r tcord 
l'llJT'bK. Tht rtocor'd nutnbH" is disp~td whtn you prnitw or pri'lt r"f'COr"ds. 

• To SH othtr r.cords on this toplc~ c lick P194'S of tht book 1t tM top ltft of tht' window. 
• for mort htlpon thts topic,"" tht f~"'" II Ow~Wr's MMlu•l, pp. 1S4-1 86. b; • For htlp on othtr topics, choost tht topic y ou w~t from tht Custom nwnu. 

I[L] Browu ::JI 

Figure 11-55 The help record for page numbers 

Now that you know all about this subject, you can close the Help file and 
add these codes to your customer Jist layout. 

•• Close the Help file. 
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You will ad d the page number p ceholder (##) in the foo ter area of the 
layout. To d o this, you must be n Layout mo de. 

:l€ -L • Choose Layout fro m the Select menu. 

You must use the text tool to add these placeholders. 

• Click on the tex t tool in the tool pal ette. 

• Click in the footer, under the last name fi eld, and type Page##. 

,,. Now click in the header, a t the to p of the screen above the 
CUSTOMER NUMBER fi eld, and type I/. Type Return to go to the 
next line, and type :: (see Figure 11-56). 

" s File Edit Select G Custom Window 
., 

Figure 11-56 Adding text to the head er and footer 

:l€ -B • Choose Browse fro m the Select menu. 

Notice that the date has replaced the first placeholder in the header 
section on the screen (see fi gure 11-57) . 
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' a File Edit Select Gdd!J<!h rormut Cust om Window 

~ Cu stomer s ~ 

~i 
October 27, 1990 g 
.. 

E.!!!lii !.All CUST!!H~B NUHD£!! 

- Sendre Herdln 1001 
RtcOrds ~ 

George Lepmont 1002 10 

J 1m Bell 1003 
Key Kusunokl 1004 
Feye Meuney 1005 

Mettle Dllbeccio 1006 

Jose deAnge11o 1007 
Gery Wes tmoreland 1006 
Glende Rider 1009 
Lois Vermus 1010 

Pege •• lQ 
([l'J 8rOYSf ;II Js;QJ 

Figure 11-57 Browsing the report after modifying the header and footer 

The page number and time placeholders, however, are just the way you 
en tered them. These codes will be replaced with the actual page number 
and time when the report is previewed o r printed. Let's preview the 
report and see. 

Preview shows how the report will look when it is printed. There are two 
views: fu ll size and reduced . Full size shows the information at a readable 
size, but, un less you have a large mo nito r, you can only see a portion of 
the page. The reduced view shows the en tire page and how all the 
elements are placed, but it is too small fo r reading the info rmation. 

By switching be tween fu ll size and reduced, you can see the details of 
what will be printed and also get an overview of the page as a whole. 

3€ - U • Choose Preview from the File menu. 

You will see the top left corner of the report page. As you can see, the 
ti me is entered into the header (see Figure 11-58). If you were to scroll 
to the botto m o f the page, you would find that the page number is 
showing in the footer. 
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Figure 11-58 Previewing the customer list repo rt 

You can also choose to see the reduced v iew of th e entire page. 

• Click Reduced. 
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You are now presented with a reduced view o f the page that shows the 
heade r, body, and footer information as it will appear o n the page (see 
Figure 11-59). 

Preulew: 

(Nt>!lt I'O\l •~ ) 

1::::~::::::::::::.:::::::,:::::1::::::::] [ Puge JlliJ 

Figure 11-59 Reduced preview of the custo mer list 

Notice th at th e report is not automatica lly cente red o n the page. Since 
th is is an interna l repo rt (one that will no t be shown outside the 
com pa ny) it is no t a problem, but let 's t ry moving the date and time to 
the upper right side of the page. ISome reports that you might want to 
prin t at a late r date might neetll to be centered to present a better 
appearance. 

To modify the report's layout, you must exit from the prev iew and then 
change to Layout mode. 
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• Click Exit. 

00- L • Choose Layout from t he Select menu. 

Moving an object on the layout is a matter of selecting the arrow tool, 
clicking on an object, and, while h olding down the mouse button, 
dragging the object to a new location . 

Let 's try moving the page number object. 

• If the arrow tool is not selected, click on it to select it. 

• Click on the page number object, and drag it to the left. 

Don' t be concerned about where to move it at this point. Notice t hat a 
horizontal dotted line extends from the object to the left and right when 
you move it (see Figure 11-60). This is an extension of the baseline of the 
text, and it helps you to align th is text object with other text objects. If 
you drag the page number horizontally to the left, you will see that the 
baseline extension aligns exactly with the bottom of the page number 
placeholder (Page ##) that you originally entered in the footer. 

,. t5 File Edit Select Ga 
., 

CUSTOMER NUMBER 

Figure 11-60 Dragging the page number object 

• Drag the page number object to the right, until its left edge aligns 
with the left edge of the CUSTOMER NUMBER field. Release the 
mouse button to place the page number. 

You should be sure that the page number is en tirely in the footer. If you 
late r preview the page or print it and you see the page number 
overlaying the customer number in the body of the report, it means tha t 
you accidentally placed the page number ob ject in the body part of the 
layout. This is an easy mistake to make. The solution is to move the page 
number object entirely into the footer. 
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You can adjust the date and time o that they print at the top right corner 
of the page. 

• Click on the right scroll arrow until a vertical line appears. 

This vertical line marks the right side of the page. 

.. Drag the date and time placeholders to the right until they are about 
an inch and a half from the right side of the page (see Figure 11-61). 

" • file Edit Select Custom Window 
., 

II 

Figure 11-61 Layout after moving date and time placeholders 

You can now preview the report to see if the date, time, and page number 
are where you want them. 

3€ -U 3€ -L ,,. Alternating between the Preview and Layout modes, ad just the date, 
time, and page number placeholders until they are placed properly 
on the page. 

Printing the Report 

When you have the placeholders where you want them, it is time to 
print the report. 

3€ -B • Choose Browse from the Select menu. 

3€- P • Choose Print from the File menu. Accept the defaults by clicking 
OK. 

Compare the output of your report with the output shown in 
Figure 11-42. 

This completes the customer list showing the customer numbers. 

• This is a good time to save a copy of your Customers file. 
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Let's create another columnar report that lists the customer's first name, 
last name, area code, and phone number. It is created like the fi rst report, 
by changing to Layout mode and telling FileMaker to create a new 
layout. 

~ - L • Choose Layout from the Select menu. 

~ -N • Choose New Layout from the Edit menu. 

• When the dialog box appears, select Columnar report layout, and 
then click OK. 

Next, FileMaker will present a dialog box that allows you to select the 
fields that will appear in the report. 

• Double-click on FIRST. 

• Continue by double-clicking on LAST, AREA CODE, and PHONE 
NUMBER. 

You should now have four fields listed in the Field Order box on the righ t 
(see Figure 11-62). 

Field List Field Order 

STATE ~ Clear FIRST 
ZIP -~j~· LAST 
COUNTRY ~it Moue AAEA CODE 
AREA CODE u; PHONE NUMBER 
PHONE NUMBER :(~~: 
ENTRY ORTE 

_:'§; ( OK ~) 
CUSTOMER NUMBER 
BUSINESS TYPE iii ( Cancel ) 

Figure 11-62 Selecting the fi elds fo r the second columnar report 

• When you have verified that th e fi elds are correct, click OK. 

fil eMaker quickly produces the layout you just specified . All you need 
to do to customize this report is to add the page number placeholder in 
the footer and the date and time placeho lders in the header. 

• Click on the text tool. 

• Using th e procedures you learned in the last few pages, add the date, 
time, and page number p laceho lde rs in the ir appropria te posi tions. 
You can align the left edge of the page number wi th the left edge of 
the AREA CODE field. 

You should now have a layout that looks like the one shown in 
Figure 11-63. 
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Sorting Records 

.. . Custom Window 

II 

Figure 11-63 The layout for the customer phone number report 

,,. Click o n the arrow tool. 

a€ -B ,. Change to Browse mode. 
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., 

The list appea rs on yo ur screen showing the four fields you selected. 
Notice that the list is shown in the order in which you entered the 
records . Because the customer number was automa tically entered as you 
added customers to the file, th is resu lts in the list being shown in 
customer number order. 

This is not a conven ient order for th is report. Generally, when you want 
to find t he customer's phone number you would look for the customer's 
name (just like using the phon e boo k). Let 's ch ange the order of this 
report so that the names are listed in alphabetical o rder. 

FileMaker has the ability to sort information in every type of field except 
for picture fields and summary fi elds. Text fie lds can be sorted 
alphabeticall y, nu mber fields can be sorted numerically, and date fields 
can be sorted chro nologically. 

The way the sort works depends o n the type of field. If it is a calculation 
field, the result depends on the zype of resul ts you selected for the field. 

Fortunately, Fil eMaker is smaJ enough to determine which sort is 
appropriate for each field. All ydu have to do is tel l it which fields to use 
fo r t he sort keys. 

Sort Command 

The Sort command is accessed by choosing Sort fro m the Select menu. 
If a fil e is already sorted, you can also choose the Unsort command, 
which returns the records to the order in which th ey were added to 
the file. j 
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~ -S • Choose Sort from the Select menu. 

FileMaker puts up a dialog box and wa its for you to specify the fields to 
use for sorting the file and whethe r to sort each field in ascen ding or 
descending order. 

Ascending and Descending 

For a text fie ld, ascending order means sorting the records of the file in 
order from A to Z based o n one or more specified fi elds. Descending order 
sorts from Z to A and is also known as a reverse sort. 

Number fields are sorted based on the n u meric va lue of the specified 
fie ld(s) . Ascending order is the sa me as smallest to la rgest order. 
Descending order is the opposite. 

Date fields are sorted based on the ch ron ological order of the date. 
Ascending sorts arrange the records fro m ea rl iest da te to la test date. 
Using a descending date sort results in the most recent dates being listed 
first, followed by even ts that happened furt her in the past. 

FileMaker uses a series of rectangles with each one getti ng larger to 
pictorially represent an ascending sort. A series of rectangles getting 
smaller represents a descending sort (see Figure 11-64). 

-·•• Asc:ending Order 

••·- Oesc:ending Order 
Figure 11-64 Symbols used to represen t sort order 

Sorting Levels 

Files can be sorted by one or more fields. lf only one sort field is specified 
t hen the records will be sorted based o n the contents of that field on ly. 

If more than one sort field is specified, the first field determines the most 
significant order of th e file, and the second and subsequent fields are 
used only when duplicate entri es ex ist in the ea rlier sorted fields. 

For example, to sort a list of names in alphabetica l order, you could 
specify the last name fie ld for the sort. Then everyone would be sorted 
by last name. If two o r more people had the same last name, they would 
not be sorted by first name, but wou ld appear based on the order in 
which they were added to the file. 

To be sure that the names a re sorted p rope rly-by last name fi rst, and 
then by first name for people with the same last name- you must 
specify two sort fields. In this case, the last name field is the most 
important, so it is added to th e Sort O rder list first, and then the first 
name field is added to the list. 

• Double-click on LAST in the Field List. 
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The defau lt order for a fi eld is ascending, as shown at the bottom of the 
dialog box. When you double-clicked on the last n ame fi eld, it was 
moved to the Sort Order list, and the ascending order icon is shown next 
to it. 

• Double-click on FIRST in the Field List. 

in a sim ilar manner, the first name field is added to the li st, and the 
ascen di ng o rder icon is displayed next to it as well (see rigure 11-65). 

' • File Edit DmJI Gadgeh lormut Custom Window ' 

Customers 

Field list S"ort Order 

PREFIII ~ ( Cleor ) .al LAST IQ 
FIRST 

[ ) 
.11 FIRST 

M l Mot•<~ 

LAST ( Sort J TITLE 
COMPANY l Unsort ) 
ADDRESS 
CITY (} [ [Hi t ) lr; 

® Ascending Order 

0 Descending Order 

LOI S varmus 626 555-2626 

Page ,.,. 0 
Brown Cl ' ,, .r·. 1c QJ 

Figure 11-65 Choosing the sort order for the report 

Now you a re ready to sort the file. 

• Click Sort. 

Printing the Report 

Change to Browse m ode, and then print the re port. 

3€ -B • Choose Browse from the Select menu. 

When you browse the file, you should see all the custom ers listed in 
alphabetical order. 

:3€ - P .. Ch oose Print from the File menu. Accept th e defa ult va lues by 
clicking OK. 

Com pare the output of this report with the output of the repo rt shown 
in Figure 11-43. 

• This is a good time to save a copy of your file . 

CREATING MAILING LABELS 

Now that you have learn ed to crea te columnar lists and how to sort the m 
into the order you wan t, it is time to create, sort, and print m aili ng labels 
for you r customers. 
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Modifying the Customers File 

Before you create the label format, it will make thi ngs easier if you add 
som e new fields to the file. 

Each label will have information on it that is stored in n ine fields in the 
file: prefix, first name, middle initia l, last name, company name, 
address, city, state, and Zip code. 

Since there are on ly six lines of text available on the label, File Maker will 
let you specify only six fields for automatic placement when you create 
the new label layout. Then yo u would have to resize th e first four fields 
and move them up to the first line o f the label. You would h ave to 
manually place and resizetheotherfields until you completed designing 
the labels. 

There is an easy way around this proble m that will a lso make Project 3 
easier to complete. All you have to do is create new text calculatio n fields 
t hat concatenate (combine) the informatio n fro m several fields in to one 
fie ld. 

You will create a Full Name field that will concatenate the PREFIX, 
FIRST, Ml, and LAST fields. Address2 will combine the CITY, STATE, and 
ZIP fields. The third field, Phone, will combine t he AREA CODE 
(enclosed in pare ntheses) and the PHONE NUMBER. 

Notice that the names for these new fields a re composed of upper- an d 
lowercase letters and that the fields already defined are all in uppercase. 
This technique is used to help you remember that these n ew fields a re 
calculation fields that combine information already en tered in the 
earlier fields. Again, this is just a matter of style and it is not req uired by 
FileMaker. 

Let's add these three fields to the fil e. 

Adding Text Calculation Fields 

You will define these th ree fields in a moment. You can define a field 
fro m an y mode by choosing the Define comma nd, but since FileMaker 
automatically places new fields on whatever layout you a re in before 
you ch oose Define, let's switch to Layout mode first. 

3€ -L • Ch oose Layout from the Select m e nu . Use th e book or slide control 
handle to change to layout number 1. 

Now you are read y to define the three text calcu lation fields. 

,. Choose Define from the Select menu. 

3€ -C • Cli ck Calcula tion to indicate the type of this field, and then type its 
name, Full Name, in to the fi eld name box. Click OK. 

When you click OK, FileMa ker di splays the fo rmu la d ialog box fo r a 
calculation fie ld. Figure 11-66 shows wha t your screen will look like 
when you enter the formula. 
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' 45 File Edit emJI Godgets Formot ustom Window 

Customers 

Field Deftnttlc n 

Ca lculation Result Is: 
Full Nnme ~ ® TeHI 0 Number 0 Dille I'""" .... "'" ...• MO • • • • "" I 
PREFIH IQ 0000 

~ 
abs () IQ 

FIRST 

l c:J8:100 
auerage () tr 

Ml count() 1':• 

LAST OCD0® date(,) 
I 

TITLE t·· OoteToTeHI () ~· COMPANY I 8@00 day 0 
ADDRESS .i 

0El~ CITY 10 ~~] ( Concel ) 

Figure 11-66 Calcu lation formula fo r the Full Name field 

The calcul ation result should be designated as Text. Let's change how 
the result is displayed from the d efault umber. 

_. Click Text to designate the type of calculation result. 

A formula that combines four ex isting fi elds has been entered next. In 
a text formula, each fi eld o r string literal (something inside quotation 
marks) must be combined using the concatenate operato r, which is the 
ampersand (&) character in FileMaker. 

The formula in figure 11 -66 says to display in the Full Na me fi eld a string 
o f text composed of the prefix followed by a space, the fi rst name, 
another space, the middle initial, another space, and the last name. 

There are three scro ll ing lists and a keypad in this dialog box. The list o n 
the left contains a ll the defined fields. The keypad is available so you can 
click o n numbers, the decimal point, mathematical o perators(+ -I*), 
parentheses, quotation marks, a paragraph marker (<Jl), and the string 
concatenation o perator (&). 

The next scro lling list contains a number of logica l operators, and the 
last list contains built-in functions that you can use in creating formu las. 

There are several ways to ente r th e formula in the fo rmula box. You ca n 
choose to type the entire formula if you want, o r you can use a 
combination of typing and clicking in the lists and o n the keypad to 
enter the formula. 

The first thing to do is enter th name o f the first fi eld. 

• Click o n PREFIX in the fi eld names list. 

This enters this word in the formula box. Now you need to tell FileMaker 
to concatenate a space character and another fi eld to this one. 

• Click on & in the keypad. 
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• Click on 11
" in the keypad. 

You now have PREFIX & 1111 in the formula. There is no space between 
the two quotation marks, but the insertion point is automatically placed 
between them, and FileMaker is waiting for you to type something 
there. You will type the space bar to add one space character, and then 
you must move the insertion point outside the closing quote by clicking 
after the second quote or typing the right arrow key. 

• Press the space bar, and then either click after the quote or press the 
right arrow key. 

Now that the insertion point is at the end of the formula, you can type 
the ampersand or click on it in the keypad. 

• Click on&. 

Now you need to add the first name field. 

• Click on FIRST in the field names list. 

The calculation formula should now read PREFIX & 11 
" & FIRST. 

Refer to Figure 11-66 to see how the completed formula should look. 

• Using the steps just described, add MI and LAST to the formula, 
separating each field with & 11 11 &. 

If you make any mistakes you can use Backspace or Delete to erase the 
part that is incorrect, and then continue entering the formula. 

• When you have verified the accuracy of your formula, click OK to 
accept it. 

You should now be back in the Field Definition d ialog box, and the Full 
Name field should be visible at the bottom of the scrolling list. As much 
of the formu la as fits is seen to the right of the field name. 

Before you continue with the next two calculation fields, let's see what 
the Help fil e says about defining fields, calculation formulas, functions, 
and operators. 

• Click Exit to leave the field definition dialog. 

"J€ -I • Choose Help from the Apple menu, and then, when the opening 
screen appears, click Open Help File. 

You want more information about defining fie lds, so ... 

"J€ - -t • Choose Defining Fields from the Custom menu. 

FileMaker will find a group of 16 records containing information on this 
topic. All 16 contain valuable information that you should look at. 

Let's see what it says about text calculations. 

• Scroll to record S. 
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You wi ll now see a screen like t~e o ne shown in Figure 11-67. 

R•corOs: 
69 

Found: 
16 

MEANING USE 

& Conc~ttnatt Joins: two ttxt valuts 

Ttx t consbnt Tru ts tht Va1ut in quotation marks u a const.nt 

Rttum ehw~ttr lnstrts a return ohar~ettr for uch occurrtnct 

Fort)(ltnplt , thtformula Fi r st N1me & "• &lut Name & • t~ • & Address 

l tlls FiltMtktr to conuttNtt tht Ftrst Hwn., lut Nvn. , tnd Addr•ss FWJds, instrting 
t sp~ bthfttn tM first nVM and th+ lut rwnt, W instr'ting a rt hrn eMr-acttr 
btfort t.ht Addnss fJt\d son bf9hs on t.ht li'lt btlow tM nwnt. 

Thts. S\lmbols _.., ustd Yith ttxt Rtlds, ttxt const..-.ts, lnd t•xt nsults of 
c.~\ou~Uons or txprusioM. 

• To SH other rteordJ: on this topic, cliek ~~of tht book at tht top ~ft of tht windc)''&'. 
• For mon http on this: topic, JH tht FfltMaktr II Ovntr's M¥1U1l, p, 103 . 
• For http on othtr' topics, choost tht topic \IOU lf«~l from tM Custom nvnv. 

Figure 11-67 Text operators and symbols record in the Help file 
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This explains more about what you just did when you entered the 
formu la in the Full Name field . 

• Click the top page of the book to move to record 4. 

A reco rd appears that contains info rmatio n about FileMaker's 
mathematical and logical operators that are used in calculating and 
comparing the contents of fields (see Figure 11-68). 

' a File Edit Select !i<ldgeh f"ormut Custom Window 
FlleMolcer Help Pll 

=t 
US IIIO OPERATORS Ill CALCULATIOII FORMULAS 

Q 
SYMIIOI. EXAH'I.E RESil. T MEANt«l 

- . 6 + 3 9 PM 

RfoCOf'ds : - 6-3 3 Mhls 

69 • 6*3 18 TWMS 
Found ; I 6/3 2 Dtvldo 

16 . 6•3 O(llo) Equ•l . 6 •3 1 <Y•s) Hot Equ•l 
) 6>3 1 (Y .. ) Gruttr TNn 
( 6<3 0(/lo) ltu Than 

' 6>3 1 (Y .. ) Gruttr T"-t or Equo~l to 
{ 6<3 O(Ho) l tu Thin or Equal to - 1 AND 1 1 (Y•sl 1 (\If'S) if Will ..... \jfS 

DR ODR I I (Y .. ) 1 (IJtS) if ~t'MN' ¥ f \lfS 
NOT NOT 1 0 (l~o) I (\ju) ff nlu• ts no 

2.3 8 Powtr 

• To Itt othtr rtcords on this toplo, click P19ts of tht book .tt tht top l• ft of tht 'W'indow. 
• for mort htlpon this topic, su tht FUtMakH' II o .... nt r 's Mo~nual , pp. 100-103. 

lo • For htlp on othtr topics, choost tht topk: IJOU lw' .. nt from tht Custom mtnu. 

I[IJ Brow .. I~ JQ: 

Figure 11-68 Help for mathematical and logical operators 

• Move to record 6. 

Records 6 through 10 list information about File Maker's built-in functions 
(see Figure 11-69). 
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' j File Edi t Select (i<ldgeh rormll t Cus tom Window 

10 FileMaker Help !!lli 

=t 
USING NUMER IC C ALCULATION FUNCTIONS 

:!,! 

FUNCTION MEANING 

- •bs (V) absolutt (non-of9<~Un) Vllut of Y 

RK-ords : ;r (VI ,V2,V3) ifYI is 1 (or not z:tro) rtsult b Y2 , othtrYiJ.t V3 

69 ;nt (V) mt~ c~t ofnbt Y 
FO<Jnd: FV (VI ,V2,V3) futurt v •luf. of P-1\!i"Mnt Yl <~t Ylttrut r•t• Y2 ~r ~riod for V3 

16 ~dod.s 

mod (V I ,V2) r•m~ind"" of VI d1vidfd b\1 Y2 
pmt (YI ,V2,Y3) p.ymtnts dut on prlnc~o~l VI o~t inltrtst r<~tt Y2 ptr ptrlod for V3 

p«oriods 
PY (VI ,V2,V3) prtnnt Yl\tt of p~nwot VI It inttftSt ro~tt V2 ptr ptriOd for' Y3 

ptriods 
round (VI ,V2) nlue- ofYI r oundfod to Y2 dKimal pbcH 
s itn (Y) signof Y: 1 ifposittn,O ifuro, - 1 ifn.gatin 

'Where Vis .a ~r, fitld no~rnt, or t xprusion. 

• To set other rtcords on this topk, c1iek pa~s of tht book at thf, top l•ft of tht wlndov. 
• F'Or" more hE"Ip on this tGpic, su tht F"lliM»:tr' II Owntr''s Manuo~l , pp. 103-106, 115 . 
• For help on other topics, choost tht topic \IOU wMlt from tht Custom mtnu . n 

frj Brows. ;;II _E Q] 

Figure 11-69 Help for buil t-i n fu nctions 

• Skim the contents of records 6 through 10. 

• When you have read the reco rds, close the Help fi le . 

Now that you know more about calculatio ns, operators, and functions, 
let's d efine the Address2 and Phone fields. 

• Choose Layout from the Select menu, go to layou t number 1, and 
then choose Define. 

The Address2 field's formula is similar to the one you entered in the Full 
Name field. This fie ld concatenates the CITY, STATE, and ZIP fields. The 
o nly difference is a comma that should appear after the city. 

After you enter the CITY fie ld and the tex t conca tenate operator in to the 
formula box, you enter the quotation marks, with a comma and a space 
between them (see Figure 11-70). 

' * File Edit 

Address2 = 

LAST 
TITLE 
COMPANY 
ADDRESS 
CITY 
STATE 
ZIP 
COUNTRY 

Gad_!!llts Format Custom Window 

Cus tom ers 

Field Definition 

Colculatlon Resul t Is: 
® TeHI 0 Number Q Do te 

:~~:!ge 0 ~ 
count () 
dote(,) ' 
Oal eToTeHI 01/ 
doy () 10 

c::Ji£~] ( Cancel J 

Figure 11-70 Calcu lation formu la for the Address2 field 
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• Designate the calculation r ult by clicking Text. 

• Enter this form ula: CITY & ", 11 & STATE & " 11 & ZIP. 

When you have done this and verified the formu la, click OK. 

Now you are ready to define the Phone field . 

This fi eld will contain a text result and the fo llowing formula: 

"(
11 & AREA CODE & ") 11 & PHONE NUMBER. 

Notice that there is a space after the right parenthesis after the area code 
(see Figure 11-71) . 

' • File Edlt-(i<ldgeh f"ormnt Custom Window ' 
Customers 

Field ueumuon 

Calculation Result Is: 
Phone • ® Teut Q Number Q Dote 

1., .. """ '"" . . , .• ., .. , , . .,. I 

I 
PREFIH !=! 0000 

~ 
abs 0 ~ 

FIRST 
c:J~00 

auerage () 
Ml count () 
LRST OCD00 dote (,.) 
TITLE OoteToTeHt 0 
COMPANY 8@00 doy () ~ 
ADDRESS 

(DEJ~ CITY In [ OK ~ ( Concel l 

Figure 11-71 Calculation formula for the Phone field 

• En ter the formu la as shown, verify it for accuracy, and then click OK 
to accept it. 

This returns you to the Field Definition dialog box. You do n't want to 
define any more fi elds. 

• Click Exit. 

You can verify that the new fields work correctly by visually examining 
them in Browse mode. 

~ -B • Change to Browse mode. 

• Scroll to the bottom of the record and look at the contents of the last 
three fields (see Figure 11-72). 
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a File Edit Select (idd<jeh I ormu t Custom Window 

!0 - Customers E!l~ 

~i 
ADORESS 1492 Document Drive ~ 

CITY Mandann 
STATE FL -

Rtc«ds : ZIP 49709 
10 COUNTRY 

203 I'' 
AREA CODE 

Sod<d 
PHONE NUHBER 555-2731 

ENTRY DATE 11 / 01/66 
CUSTOHER NUHBER 1003 

BUSINESS TYPE I·" 
REGION , .. 

full N~m~ Mr. Jim Bell 

'" 
Adlnss2 Menderin, FL 49709 

Phone- (203) 555-2731 p. 
tn 

li!d. a.. ..... :)I 1Qf2l 

Figure 11 -72 Browsing the records to check the new fields 

,.. Click on the bottom page of th e book to look at the next record, and 
continue c hecking all the record s. 

,,. If you have any mistakes, ch oose Define and redefine the fields that 
are n ot working correctly. To do this, cl ick on the fie ld's name, click 
Reformulate, and then re-enter the formula. 

It is a good idea to print the field definitions report when you h ave 
modified any of the fields in the file. 

~ -P • Choose Print from the File menu, click Field d efinitions, and then 
click OK. 

3€ -L • When everything looks ok, choose Layout from the Select menu. 

You h ave completed defining the new fields, so you a re ready to create 
the label layout. 

Most labe ls are printed using o ne of two for mats: 1-up or 3-up. These a re 
terms that describe how m an y labels a re o n each row. A 1-up fo rmat has 
only one label on each row, and 3-ups have three on a row. 

Other formats are available, but these are the most popular. 

Label Dimensions 

A standard letter-size sheet of paper is 8 .5 inches wide and 11 inches tall. 
Depending on the p rin ter you are using, you ca n use more or less of t he 
page. An lmageWriter prints 8 inches horizontall y, and a LaserWriter 
prints a 1i ttle less. 

Mai ling labels are made by a number o f compani es and are ava ilable for 
continuous feed through a dot-matrix printer and o n single sheets for 
laser printers. 
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Most mailing labels are about 1 i ch tall. Depending on the p rin ter you 
have and the labels you buy, the abets may be 2.5, 3, o r 3.5 inches wide. 
Since every printer wi ll print 3-up labels that are 1 inch high and 2.5 
inches wide, this is the format ybu will use for your labels. It is also the 
default size that FileMaker suggests. 

This label size results in printing 33 labels per page (3 colum ns by 11 
rows). Some laser printer labels are designed with a half-height label at 
the top and bottom, which results in 10 rows of usable labels (and 30 
labels per page). 

When you choose a label format of 1 inch high and 2.5 inches wide, 
FileMaker automatically sizes the text so tha t you can print up to six 
lines of text on each label. 

You can design formats that will print on bo th the 33-labels-per-page 
format and the format that prints 30 labels per page . The vertical 
placement of the first row of l~bels can be adjusted by moving the 
Header part of the label layout up or down un t il the information is 
printed exactly on the labels. 

Creating the Label Layout 

Creating a new label layout is a qu ick and easy process. 

3€ -N .. Choose New Layout from the Edit menu, cl ick Label Layout in the 
dialog box that appears, and t hen click OK. 

A dialog box will appear asking for the number o f labels you wa nt across 
the page. The default is 3. The label size default is 2.5 inch es wide and 
1 inch tall. 

' a File 

L1AEj 
lQl9Q] 

Select Godgets Formot Custom Window 

Customers 

Figure 11-73 Defining the number of labels across and their size 

- This is the format you wa n l1l so cl ick OK. 

Now you can select the fields that will appear in this layout: Full Name, 
COMPANY, ADDRESS, and Address2. 
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• Double-click on the appro priate fi e lds, then c lick OK (see 
Figure 11-74). 

• file_.mi_Select Gadgets format Cust om Window 

Cus tomers 

field list field Order 

PHONE NUMBER 

~ 
Clear full Name 

ENTRY DATE COMPANY 
CUSTOMER NUMBER 

:!; 
( MOUl' l ROORESS 

BUSINESS TYPE Rddress2 
REGION 
full Name [ OK ~ 
Rddress2 r" 
Phone ~ ( Cancel l 

~==r=======================~~-

~ ~IIi_: 
= 

EHTRY DATE [ENTRV.OiiJE ........ J = ~ 
[LJ Lay out 12_ 

Figur e 11-74 Selecting the fie lds to appear in the layout 

FileMa ker will then create a ne\·V label layout for you, as shown in 
Figure 11-75. 

r • File Edit Select Gadgets Format Custom Window 
., 

Figure 11-75 The new maili ng label layout 

Notice that the four lines of text are crowded aga inst the top edge of the 
label. Let's center them vertically by selecting all four fj elds and 
dragging them down one li ne. 

You a lready learned how to move a page number object left and right. 
Moving a field up and down works the same way. In fact, it will be easy 
to move these fields, because FileMaker has made each of the fields 1/

6 
inch high an d constra ins their movemen t using an invisible grid with 
the same measurements. If you click o n a fie ld and drag it down, it will 
jump down to the next line . 
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You can move each o f the fields ·ndividually or select all four fi elds and 
move them as a group. To select all fou r fields, click on one to select it, 
and then Shift-cl ick on each of the other fields to add it to the selection. 

Another way to select all four fields is to move the pointer above the 
fields, press and hold the mouse button down, drag the mouse diagonally 
down and to the side to create the dotted outline of a selection rectangle, 
and, when the rectangle touches all four fields, release the mouse button 
to select the fields (see Figure 11-76). 

'" -' File Edit Select G 
., 

Figure 11-76 Selecting four fields with the selectio n rectangle 

• Using e ither method, select the four fi elds and move them down 
one line so there is a blank line at the top and one at the bottom of 
the label. 

You are nearly done with th is\ layout. You are probably not aware, 
howeve r, that FileMaker selected several options from the Gadgets 
m enu when it created this layout for you. 

Press the mo use button on the Gadgets menu title, and you will see that 
three options are checked to show that they are active (see Figu re 11-77). 

T-Squores XT 
_.. I nuisible Grid 88Y 

TeHt Borders 

Uiew as lis t 
confidentiol 

./Column Setup .. . 

./Slide Object s .. . 

Tob Order ... 

Figure 11 -77 r:i leMaker has s lected three options. 
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The invisible grid h as been discussed (since it is selected the fields wi ll 
jump one line when you move them down) . 

The o ther two options, Column Setup and Slide Objects, need some 
explanation. 

In the Column Options dialog box, FileMaker has already selected three 
columns of labels and has specified the order to be across a row and then 
down to the first column in the next row (see Figure 11-78). 

When you use these mailing labels, you would start at the top of the first 
page and remove the top left label, then you would remove the center 
one, and then the top right one before going to the next row. If you had 
these labels sorted in Zip code order, this printing order would be an 
important consideration. 

Column Setup: 

O None 
® Print records In ~ columns 

®Elncross first 0 olf]::n =~t 
-- --· 
:-:..: -·-

Figure 11-78 Column Setup options 

Sliding Objects 

Slide Objects is a little more complicated t han Column Setup. 

The Slide Ob jects dialog box is shown in Figure 11-79. It contains th ree 
options. 

When printing, remoue unused space at the 
end of fie lds by: 

(ill Sliding objects le ft 
(ill Sliding objects up 

D Sliding port up 

Figure 11-79 Slide Objects options 
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Sliding objects left is used when ypu want punctuation to closely follow 
the end of text in a preceding field or when another field follows on the 
same line. In this layout, you have already taken care of this potential 
problem by defining the Address2 field , which combines the CITY, 
STATE, and ZIP fields into one field. 

Sliding objects up is used when a field is empty and you do n 't want a blank 
line to print on the report. In this mailing label layout, the COMPANY 
field is o n the second line. Some customers represent a compan y and 
will have information entered in this field, and some don't represent a 
compan y and the field is empty. By telling File Maker to slide objects up, 
you won't end up with blank second lines on the labels. Don't be 
surpri sed when you see blank company lines when you browse the 
layout. Sliding objects on ly applies to previewing and printing the 
report. 

Sliding pmts up is used to remove empty space when an object has been 
slid up. You do not want this checked on this layout, because all of the 
labels are 1 inch tall. The parts must not slide up in th is case. 

You can look at the label report by going into the Browse mode. 

S€ -B • Choose Browse from the Select menu. 

You will now see the label for Mr. Bell. Noti ce that the labels are 
presented in sorted order, because they were sorted alphabetically when 
you created the layout. 

r • File Edit Select G<HI<J<~h rormut Custom Window 
., 

:o Customers t!);; 

~i 
~ 

Mr. Jim Btll -
Rtcords : 1492 Doeumtnt Drivt 

10 Mandarin, FL 49709 

Sorttd 

0 
IIJ Browst ~I I IQ 121 

Figure 11-80 Browsing the mailing labels 



556 Pa rt V: Info rmatio n Man agem ent 

You ca n see wh at the labels will look like when they are printed by 
previewing the report. 

~-U • Ch oose Preview fro m the File menu. When the preview co mes o nto 
the screen, click the right scroll a rrow so you ca n see tha t som e 
records have three lines and o thers have four lines. 

Figure 11-81 shows that the slide objects up option is working correctly. 

,.. • liD Edit Select G<HI9eh rnrmnt Custom Window 

Dr. Jose S. de Angello 
117 Third Street 
Apache Junction , A2 78273 

Ms. Ka~ 8. Kusunoki 
7531 Second Street 
San Francisco, CA 92846 

Ms. Glenda Rider 
1294 Sk~line Tr ail 
Denver CO 82742 

Customers 

Mrs . Mattie L. Dilbeccio 
Grape Creek Nevt and Used Cars 
14709 Main Str eet 
Grape Creek, NC 28087 

Mr . George M. Lapmont 
Bell Tires 
2354 78th Avenue 
Bellvue, WA 7 1356 

Mr . Gary H. Westmor eland 
Western Carolina Welding 
2741 HiQhvtau 14 1 

Figure 11-81 Previewing the mailing labels 

Aligning Labels on a Page 

Preuiew: 

[Hit 

If you a re really printing these labels on pre-cut, gummed labe ls, you 
might have to do a little adjusting to be sure the tex t fits correctl y o n the 
labels. 

Different printe r a nd la bel combinatio ns make it im possible to give a ll 
the steps involved for a ll combinatio ns, but a general method can be 
presented. 

The m ost likely p roble m involves how the labels are forma tted on the 
page. Labels m ade fo r continuo us feed thro ugh dot-matri x printers 
usua lly do n ot have a top margin- the first label starts at the top of the 
page. 

Labels made fo r laser printe rs sometimes have a half-inch m argin at the 
top and botto m o f the page, because some lase r printers canno t print o n 
the top and bottom labels of a 33-l abels-per-page fo rm at. These labels 
have a ha lf label at the top a nd th e botto m, resultin g in 30 full labe ls on 
th e page. 
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Adjusting the vertical placeme~t of the labels involves making the 
header in the layout shorter or ta~er. This can be done by clicking on the 
Header part and dragging it up or down. In fact, if you need to, you can 
remove the header entirely, by dragging the Header part up to the top 
of the screen and re leasing the mouse button . 

If you print labels on both dot-matrix and laser prin ters, you can 
duplicate the layout you just created and adjust one version fo r the dot
matrix printer and the other for the lase r p rin ter. 

3€ -B ,.. Exit the preview, and go back to Browse mode. 

Sorting Customers by Zip Code 

The Customers file is presently sorted a lphabetically, but for mailing 
labels you should sort by Zip code. If you mail enough letters, you can 
get a discount from the post office by sorting the letters into Zip code 
order. 

3€ -S .. Choose Sort from the Select menu. 

",. Specify the sort order by double-clicking on ZIP (see Figure 11-82). 

' • File Edit em (i{ldi)(lh formnt Uustom Window 
~ 

Customers 

Field list Sort Order 

STRTE R ( 
Clear l . 11 ZIP Q 

ZIP 
( l COUNTRY M<we 

RRER CODE 
I=' ( Sort ~~;l PHONE NUMBER 

ENTRY DRTE 
p!i: ( Unsort l CUSTOMER NUMBER 

BUS I NESS TYPE In ( EHil ) 0 

® Ascending Order 

0 Descending Ord
1
er 

I I<> 
tL:l Bro'Wst Ql 10'21 

Figure 11-82 Specifying a Zip code sort order 

• When you have done this, sort the fi le by cl icking Sort. 
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Print Mailing Labels 

You have completed creating the mailing labels, and now all that is left 
is to print them. 

a€ - P • Choose Print from the File menu, and accept the defaults by 
clicki ng OK. 

Compare the mailing labels you printed with the output shown in 
Figure 11-44. 

• Don't forget to save a copy of the Customers fi le. 

This completes Project 2. You have learned a lot about creating reports 
usi ng the preset forma ts available in FileMaker. Project 3 wi ll lead you 
through creating a new file and a custom layout using the blan k layout 
optio n. 

In Pro ject 1 you created a Custo mers file, and you produced reports from 
that file in Project 2 . For Project 3 you will also use the Invento ry file, 
which is included on the Macintosh Journey Projects disk. 

In this project, you will create a new Sales Invoices fil e. You will c reate 
a new layout startin g from a blank one, and you wi ll learn how to 
interconnect this new file to the Cust omers and Inventory files. 

You will lea rn how to place fields on the layout using the field tool, how 
to add grap hi cs o bjects created in other applications, and how to add 
lines and boxes to enhance the appearance of a layout. 

You will use a customer number fi eld to link to in formation in the 
Customers file and a part number field to link to the Inventory file. 

You will create fie lds that can look up information in othe r fi les. For 
example, the Name field can look up the customer num ber in the 
Customers file and copy the customer's n ame into the Sales Invoices file. 

In completi ng this p roject, you will learn to use many of the tools, 
commands, and gadgets avai lable in FileMaker. You will also learn how 
to forma t the information presented in a field. 
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~&I( 
1417 $ outh Jonquil St. 

INVOICE 
Smyrna, GA 30829 
( 404) 555-7283 

Auto Parts 
Fax: (404) 555-6284 

IN VO I CE NUMBER 
CUST NO 1006 90005 

N AME MI'S. Mat t ie L. Di lJJecc i o 

AD DR ESS 14709 Ma in Street SALE S DATE 
Gr ape Cr eek, NC 28087 Oc t 29, 1990 

PART NO QTY DESCRIPTION UNIT COST EXT. COST 

1013 4 HEAD G,A.SKET $15.87 $63.48 
1007 12 FLOOR MATS $35.68 $428. 16 
1001 48 WI PER BLADES $8.53 $--109.--14 
1008 2 KEY LOCK $36 50 $73.00 
1010 4 RADIATOR CAP $8.95 $35.80 
1002 5 WIPER MOTOR $36.95 $184.75 

75 I TEM COU NT S UB TOT AL $1,194.63 
SALES TAX $65.70 

SHIPPI NG COS T $56.25 

GRAND TOT AL $ 1, 3 16 .58 

Figure 11 -83 Fin al o utput of Pro ject 3 

BACKING UP CUSTOMERS AND 11 VENTORY FILES 

If you were working in a real bus ness and you were usin g FileMaker to 
manage the business's in form at i n , it would be vitally important th at 
you m ake regular backu ps of the informat ion in the files. 
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This does not involve just saving a copy of a file periodically. Making a 
backup implies that the copy is on a different disk. To protect yourself 
as much as possible, you should keep two or three generations of 
backups, and at least o ne copy should be stored in a different building. 
More than one business has been seriously hu rt when someone broke 
into the building and sto le their computer(s). The really bad part o f the 
story was when the thieves stole the backups of all the data, because the 
backups were stored with the computers. 

Theft, fire, or o ther catastrophic damage to your computer system, 
when it is used to manage all of the information for a business, can be 
a disaster. This damage can be lessened by getting into the h abit of 
making daily backups of the information stored on the computer and 
storing at least one copy off site. 

CREATING SALES INVOICES 

Defining Field Types 

If you quit FileMaker after completing Project 2, you need to restart it . 

• Find the FileMaker icon and double-click o n it to start. 

• When the Open File dialog box appears, click New to create a new 
file. 

• When the next dialog box appears, name the file Sales In voices and 
then click New and save it onto your data disk. 

You are once again p resented with the field Definition dialog box. You 
will define 16 fields for this fil e. 

Number Fields 

The fi rst four fields you will define a re number fields. They will be used 
to hold the invoice number, customer number, part number, and 
quantity ordered. 

:3€ -N ,,. Cli ck Number to choose the type of field. 

.. Name the field Invo ice Number, and then click OK. 

You will now select the entry options for this field. 

,,. Click on the field to select it, and then click Entry Options. 

• Click A new serial number: and type 90001 into the box. 

This number represents the invoices for the year 1990, starting with 
invoice number 001. This is a hint for creating invoice numbers. This file 
will have invoices for years other than 1990. 

You want each invoice to have a unique number, so you need to tell 
FileMaker. 
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• Click Unique value only. 

The Entry Options d ialog box should look like the one shown in 
Figure 11-84. 

r * File Edit (illd!J<lh rormot Custom Window 

Soles I nuoice~ 

Entry Options for " I nuolce. Number" 

Auto- enter In eoch new record: Require field to contoln o: 
0 l'<idlllJ'S d<tt<l 0 Uolue 
r8l A new serlol number: 1900011 [8J Unique uolue only 
0 Ooto: 0 EHisting ualue only 

I I 0 Numeric uolue only 
L__ _ _______ _J 0 Uolue in ronge only 

0 Display 11 list of uolues: from: 1 1 

I '"'I I 

0 look up uolue from another file [ Ch~n9f. t.ooklltl J ~ ~ 

Figure 11-84 Entry options for Invoice Number field 

• Click OK to accept the options. 

The next fie ld will hold the customer number. 

• Name the new field Customer Number, and cl ick OK. 

Create another fie ld to h old the part number. 

• Name the next field Part Nwnber, and click OK. 

You must be able to store the quantity of each part that a customer wants 
to buy. This field will be named Qty, which is an abbreviation for 
quantity. 

,,. Name the next field Qty, and click OK. 

This completes defining the number fi elds. 

Date Fields 

There is one date field for this file: Sa les Date. 

You cou ld define this field as an auto-ente r fie ld and have FileMaker 
en ter the current date wheneve the record is added. In this case, t hat 
option has not been chosen. If ypu accept orders over several days and 
then process them a ll on one daf, you may e lect to enter the date they 
were received as the sales date. f you always want the current date to 
appea r o n the invoice, you can elect the entry option. 

.. Click Date to choose the tyJ e of field. 

• Name the da te fi eld Sales Date, and click OK. 
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You have now defined the first five fields, and the Field Definition dialog 
box should look like the one shown in Figure 11-85. 

' • File Edi t emil Gadg(!h rornmt Custom Window 

Sales I nuoices 

Field Definition 

lnuolce Number 
Custom er Number 

Number 
Number 

nuto-enter Ser ial, ... !!'! 

Part Number Number 
Qty Number 
Sales Dote Dote 

~ 
Field name: Field type: Entry Options 

II O TeHt ~T 

O Number ~N llefonnulale 
@ Date lli:D 
0 Picture :gp ( 01'S8l(!( t) ( OK 

0 Calculation l*C 
( 01'11'11~ l ( o summory ~s 

[Hit 

Figure 11-85 First five fie ld definitions 

Lookup Fields 

The next five fields will be defined so they can look up information in 
the Customers fi le o r the Inventory file. 

You will use the Customer Number field to serve as a link to the 
Customers file, and the Part Number field will link to the Inventory file. 
Fields used for this purpose are known as key fields or lookup fields. 

The first four of these lookup fields will store text, and the last one will 
store a number. 

l}€ -T ,,. Click Text to choose the type of field. 

• Name the new text field Name, and then click OK. 

• Select the field in the list, and then click Entry Options. 

• At the bottom of the Entry Options dialog box, click Look up value 
from another file, and then click OK. 

You are p resen ted with a standard open file dialog box. 

• Double-click on Customers to link to that file. 

The Customers file is read from the disk, and in a few seconds another 
dialog box appears that contains three scrolling lists. 

The top left corner of this dialog box shows the name of the field that 
will receive the value looked up in the Customers file. The top right list 
shows all the field names defined in the Customers file and all ows you 
to select which one to copy in to the field you are currently defining. 

There are two scrolli ng lists in the middle of the dialog box. These lists 
allow you to select the key field in each file. 



Chapter 11: FileMaker 563 

In this case, you want to copy th Full Name from the Customers file into 
this new Name field. You onl want to do this when the Customer 
Number field in the Sales Inv01ces fil e matches a value stored in the 
CUSTOMER NUMBER field in the Customers fil e. 

• Click on Full Name in the "from 'Customers':" list. 

• In the "When what is typed in:" list, click on Customer Number. 

• In the "matches a value in:" list , click o n CUSTOMER NUMBER. 

The dialog box should appear like the one shown in Figure 11-86. 

r s File Edit GadgeH rormllt Custom Window 

Copy into: 
Name 

Sales 1 nuoices 

from ·customers· : 
IIDII~bhH· 
Rddress2 
Phone 

matches a ualue In: 
PHONE NUMBER 
ENTIJY ORTE 
CUSTOMER NUMBER 

If ualue Is not found, then: [switch Lookup File ] 

® don't copy 
0 copy using neHt lower ualue ~ [ Cancel J 

Figure 11-86 Dialog box for looking up Full Name 

• If your dialog box m atches the one shown in rigure 11-86, click OK 
to accept the link. 

Now you can use the same procedure to look up the address of t he 
customer in the Customers file. 

• Create a new text field and name it Address. Click OK. 

• In the Entry Options dialog box for this new field, click Look up 
value from another file. Click OK. 

When you cl ick OK this time, you will not see the open file dialog box 
because FileMaker expects you to continue looking up values in the 
Customers fil e. You can change the lookup fi le whenever you need to. 

FileMaker remembers that you are using the Customer Number field in 
the Sales Invoices file to link to the CUSTOMER NUMBER field in the 
Customers file. All you need to s ecify this time is the nam e of the field 
in the Customers file that cont ins the add ress. 

'"• Scroll to ADDRESS and click ~nit in the "from 'Customers' :"list, and 
then cl ick OK (see Figure 1 ~-87) . 
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IJ File Edit (i<Jdgeh f'or mnt Custom Window 

Copy into: 
Address 

Sales I nuoices 

from · cust om er s· : 

COMPANY 
' II ' 

CITY 

matches a ualue in: 
PHONE NUMBER 
ENTRY DATE 
CUSTOMER NUMBER 

I r ualue is not round, then: (Switch Lookup File J 
@ don't copy 
0 copy using neHt lower ualue ~ [ Cancel J 

Figure 11-87 Looking up the customer's address 

Next, you need to look up the city/ state, and Zip code for the custo mer. 
You could use three fields for this in this file, but let 's take advantage of 
the Address2 field you created in the Customers fil e in Pro ject 2. 

.. Create a new text field and name it Address2. Then cl ick OK. 

• Select the Address2 field in the list, and then cl ick Entry Options 
and make this fi eld a lookup field. 

• Tell FileMaker to copy the Address2 field from the Customers file 
into the Address2 field in the Sales Invoices file . Click OK. 

When you were creating the number fields fo r the Sales Invoices fi le, you 
created a field named Part Number. Lefs use that as a key field to look 
up the description and unit cost of a pa rt in the Inventory fi le. 

• Create a text field named Description, accept it, make it a lookup 
field in the entry options/ and click OK. 

Th is time you want to look up values in the In ven tory file instead of the 
Customers file . 

• Click Switch Lookup File, and then when the o pen file dia log box 
a ppears, double-click on Inventory. 

In the lookup dialog box/ the top right list says "fro m ' lnven tory' :11 now. 

You will link the In ventory file to the Sales Invoices file using the Part 
Number fi eld in both files. 

• Click on Description in the "from ' ln ventory':'1 list. 

• Click on Part Number in both midd le lists. 

Your d ialog box should look like the one shown in Figure 11-88. 
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r 15 File Edit Gadgeh Formot ustom Window 

Sales lnuoice~ 

Copy into: 
Description 

Part Number 

I r ualue Is not round, then: (Swit ch Lo okup File J 
® don't copy 
0 copy using neHt lower ualue ~ [ Cancel J 

Figure 11-88 Settings to look up Descri ption in the Inventory file 

• If everything matches, cl ick OK. 

The last lookup field will store a number. The un it cost, or cost of o ne 
part, is sto red in the Inventory fil e. You need to know the cost of one 
item so you can multiply it by the quanti ty ordered by the customer to 
determine the extended cost for that item. 

~ -N • Click Number to choose the type of fi eld. 

• Name the new field Unit Cost, and ma ke it a loo kup field. 

The part number still links the Inventory and Sales Invoices files, so tell 
FileMaker to copy the value in Unit Cost in the Inventory file into the 
Unit Cost field in Sales Invoices. 

• Click on Unit Cost in the "from 'Invento ry' :" list. 

,,. If your screen looks like the one shown in r:igure 11-89, click OK. 

r • File Edit emDI G<td!J<lh Fornmt Custom Window ' 
Sales lnuoi ces 

.. 

Copy into: from " lnuento ry ": 
Unit Cost ~~art Number Jl Description . 
When what is typed in: matches a ualue in: 

1
1
1 nuolce Number JJ ~~~s~rip ti~~ Customer Number kJ I' Unit 1cost 

·-----------,------------
1 r ualue is not round, then: Sw i t ch Lookup File J 
® don't copy 
0 copy using neHt lower ualue OK.._ J [ Cancel ] 

Fi gu re 11-89 Settin g s to look J p Unit Cost in the Inv en tory file 

This completes defining the lookup fie lds for the Sales Invoices file. 
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Calculation Fields 

The next fie lds that need to be defined are six calculation fi elds. 

You learned to crea te text calculation fields in Project 2, and you are 
loo king up information in those fields and copying it into fields in the 
Sales In voices file. 

In th is project, you will create six simple calculation fields. 

3€ -C • Click Calculation to choose the type of fi eld. 

• Na me the new field Ext Cost, and then click OK. 

When you click OK, FileMaker shows the same dialog box you used in 
Pro ject 2 to enter a formula. 

The formula for the extended cost field is the quan tity (Qty) ordered 
multiplied by the cost of an individual item (Un it Cost). 

• Enter the form ula Qty *Unit Cost by clicking on Qty in the fi eld I ist, 
then clicking o n the asterisk(*), and finally clicking on Unit Cost 
in the fie ld list (see Figure 11-90). 

a File Edit em G<1dgoh rormot Custom Window 

[HI Cost • 

Port Number 
Qty 
Soles Dote 
Nome 
Rddress 
Rddress2 
Description 
Unit Cost 

Sales lnuoices 

Field Definition 

Ca lculation Result is: 
0 TeHI @Number 0 Date 

Figure 11-90 Entering a formula to calculate extended cost 

• When the formula is correct, click OK. 

At the bottom of the Qty field in the invoice, you want Fi leMaker to 
show the tota l number of items ordered. Through experience, you have 
determi ned that charging 75fT. per item will cover the shipping costs. To 
calculate the sh ipping costs, you first need to determine the total 
number of items ordered and then multiply that by $0.75. The first step 
is to create the Item Count fie ld . 

• Create a new number calculation field nam ed Item Count, and then 
click OK. 
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The Qty field will be for matted sa repeating field. Repeating fields can 
hold more than one value. To ge the number of items ordered, you must 
take the sum of a ll va lues entered in the Qty fie ld. The formu la for this 
is sum(Qty). 

• Enter this formula by scrolling down the fun ction list until you see 
sum(), and t hen click on it. This moves the function to the formu la 
and leaves the insertion point between the paren theses. Now, click 
on Qty in the field list to enter it between the parentheses (see 
Figure 11-91). 

' 15 File Edit llllmZIJI (i<tdgeh rormnt !Custom Window 

Item Count • 

l'"m (QOyJ 

1 nuolce Number 
Customer Number 
Port Number 
Qty 
Soles Date 
Name 

Soles I nuolces 

Field Definition 

Calculation Result is: 
Q TeHt @Number 0 D11te 

~ 0000 
m c:JG00 

~~~:~1 ~~~a 
Address l:l!l'l 

._R_dd_re_s_s2 ____ =[0 0 EJ ~ 

Figure 11-91 Entering the formula for the Item Count fie ld 

• When your formula looks like the one in Figure 11-91, click OK. 

• Using the same technique, create a new calculation field named Sub 
Total, and enter the following formula: sum(Ext Cost). Click OK to 
accept the field and its definition. 

This tells fileMaker to calculate the sum of a ll values entered in the 
extended cost fie ld and put the result in the Sub Total field. 

The next field will calculate sal11s tax on the order, which is calculated 
by multiplying the Sub Total by 5.5 percent (or .055). When you 
multiply the Sub Total (containing a value with two digits to the right 
of the decimal point) by .055 (containing three digi ts right of th e 
decimal point), you end up with a number with five digits to the right 
of the decimal point. You want to round this resul ting value to two digits 
to the right of the decimal point. 

The round(,) function will accomplish this. This function has a comma 
between the parentheses because it takes two arguments inside the 
parentheses. The first argumentlis the value to be rounded, and in this 
case tha t value is calculated by tlie formula Sub Total* .055. The second 
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argument to the round function determines the number of digits to the 
right of the decimal point that will be preserved. Therefore, the full 
formula becomes round(Sub Total * .055,2). 

This formula is shown in Figure 11-92. 

' 15 File Edit ll!!mZIJI Gdd!Jilh rormut Custom Window 

Soles ToH • 

Nome 
Address 
Rddress2 
Description 
Unit Cost 
EHt Cost 
Item count 
Sub Total 

Soles I nuoices 

Field Definition 

Calculation Result is: 
0 TeH t ®Number 0 Dote 

Figure 11-92 Formula to calculate sales tax 

• Create a new ca lculation field named Sales Tax, and enter the 
formula as shown in Figure 11-92. Click OK to accept it . 

Had you only wanted to affect the number of decimal places displayed 
instead of the actual calculation, you could omit the round function and 
fix the number of digits with the Format Number command from the 
Format menu. 

Now you must create a new shipping cost field. 

• Create a new calculation field named Shipping Cost, and enter the 
formula Item Count * .75. Click OK to accept it after you have 
verified that it is correct. 

The last calculation field for the Sales Invoices file is the Grand Total 
field. This is the sum of the Sub Total, the Sales Tax, and the Sh ipping 
Cost. 

• Create a new calculation field named Grand Total, and enter 
the formula Sub Total + Sales Tax + Shipping Cost. Click OK to 
accept it. 

Your Field Definition dialog box should look like the one shown in 
Figure 11-93. 
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Figure 11-93 The formulas for the calculation fields 

This completes the field definitions for the Sales Invoices file. 

,. Click Exit to leave the Field Definitions dialog box. 
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,. This is a good time to save a copy of the file onto your data disk. 

Now that you are in Browse mode, Jet's try entering a sales invoice into 
the standard vertical layout that FileMaker just created. 

Suppose that Ms. Kay Kusunoki sends an order for 3 wiper motors. Her 
customer number is 1004, and the wiper motors have a part number of 
1002. 

,. Click just to the right of the Customer Number label to activate the 
field. 

,,. Type 1004 and then press Tab. 

FileMaker looks up this customer number in the Customers file and 
copies the customer information into the fields you specified (Name, 
Address, and Address2). 

Typing the Tab key accepts the information you entered into the 
Customer Number field and then activates the next field: Part Number. 

• Type 1002 in the Part Number field, and then press Tab. 

The unit cost and description are found and are copied into the 
appropriate fields. FileMaker the attempts to calculate the Ext Cost, 
Sub Total, Sales Tax, and Grand Total fields. At this point, they all 
contain zero values, because yo have not entered anything into the 
Qty field . 

• Type 3 in the Qty field, and hen press Tab. 

FileMaker recalculates the amounts in the fi elds (see Figure 11-94). 
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Figure 11-94 First invoice with looked up and calculated values 

I IQ 

• Enter 10/29/90 in the Sales Date field to complete the transaction. 

As it stands now, this layout has several problems. You can enter only 
one item per invoice, and the dollar amounts are not formatted to look 
like dollar amounts. 

Let's solve this problem by creating a new layout . This time you will 
begin with a blank layout and build it from there. 

3€- L • Change to Layout mode. 

3€-N • Choose New Layout from the Edit menu. 

• When the dialog box appears asking for the type of layout, click 
Blank layout (see Figure 11-95). Then click OK. 

I.1:AEl 
[Q9Q] 

Create a new layout which is a: 

0 St andard layout 

0 Columnar report layout 

0 Label layout 

®Blank layout 

Figure 11-95 Creating a blank layout 
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The first thing you will do to cr ate this new layout is to place a graphic 
object. 

• Save a copy of this file, and then quit FileMaker. 

The B & K Auto Parts logo is included on the Macintosh Journey Projects 
disk. It is stored twice on the disk. Both a MacPaint and a MacDraw 
document are available. If you will be printing on an Image Writer, it 
doesn't make much difference which you choose, but if you are printing 
on a Laser Writer, open and copy the MacDraw logo, because it will look 
better when printed. 

• Using whichever application you prefer (or have available), open 
one of the logo files, select the logo, and copy it. 

• Now that the logo is on the Clipboard, close the graphics application. 

• Open FileMaker again by double-clicking on the Sales Invoices icon. 

• Change to Layout mode. 

You are back where you were before you quit, but now you can paste 
the logo onto the layout. 

• Choose Paste from the Edit menu. 

The logo will be placed onto the layout (see Figure 11-96). 

r j File Edit Select 

---L-----------------------------------------------

Layouts : 
2 

L1Abl 
[gig§ 

IHel.d .....• l 

Figure 11-96 Pasting a 

~&k 
Auto Parts • 

object from another application 

., 

• Drag the logo to the top the screen, into the header area (see 
Figure 11-97). 
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l ayouts : 
2 

--~&K· 
Auto Parts . 

Figure 11-97 Moving the logo into the header 

., 

You must enlarge the header so that the logo is entirely enclosed. 
Placing the logo in the header area makes the logo appear on every page 
printed from this layout. 

• Drag the Header part down below the logo (see Figure 11-98). 

r • File Edit Select Gadgets Format Custom Window 
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~&I( 
Auto Parts 

Figure 11-98 Dragging the Header part so it encloses the logo 

., 

• Now drag the logo to its final position in the top left corner of the 
layout (see Figure 11-99). 
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Figure 11-99 Placing the logo in its final position 
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., 

Now, let's add the address and phone numbers into the header of this 
layout. The default text is Geneva, 12 point, plain text, aligned left. 

• Click on the text tool. 

If you wanted, you could scroll to the right in the layout window until 
you could see the vertical Line denoting the right side of the page. You 
could then enter the address and phone numbers in the top right corner 
of the page. If you were printing real invoices, you would want to do this. 

Since this is an exercise, it is more convenient to place the address and 
phone numbers in the top right corner of the screen, rather than the top 
right corner of the page. 

,,. Click a couple of inches from the right side of the screen, near the 
top of the header. 

,,,. Type the following text into the header of the layout as shown in 
Figure 11-100. (Press Return at the end of each line and again 
between the phone number and fax number to make a blank line.) 

1417 South jonquil St. 

Smyrna, GA 30829 

(404) 555-7283 

Fax: (404) 555-6284 
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141 7 South Jonquil St. r=: 
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H~J~!-----------------------------------------------

Figure 11-100 Adding text information to the header 

Now you can add the word INVOICE in the header. 

,. Click about halfway between the logo and the address. 

You can ch oose the font yo u want to use and how it will appear by 
making choices from the Format menu. 

• Choose a large, easy-to-read font such as Helvetica or Geneva, 18 
po in t, underlined and bold, al igned center. 

,.. Type INVOICE (see Figure 11-101). 

' • File Edit Select Gadgets Format Cust om Window 
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a~ ~&!( 
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Figure 11-101 Entering mo re text in t he header 

• Drag the text elements around inside the header until you are 
sat isfied with their p lacement. 

You are now ready to enter some text labels into the body of the layout . 

Select Gen eva, 9 point, bold , and a lign righ t fro m the Format menu. 

Click in the body partofthe layout, and then typeCUST NO, NAME, 
and ADDRESS (see Figure 11-102). 
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CUST NO 
NAME 

ADDRESsj 

Figure 11 -102 Entering text labels in the body of the layout 

The next text to enter is the labels for invoice number and sales date (see 
Figure 11-103). 

' a File Edit Select Godgets Formot Custom Window 
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1417 South Jonqui I St. l:! 
Smyrno, GA 30829 
(404) 555-7283 

Figure 11-103 Adding text labels for fields 

• Click to the right of CUST NO and below the fax number. 

·• Select align left from the Format menu. 

,,. Type INVOICE NUMBER, ar d then press Return twice. 

• Type SALES DATE. 

Your screen should look like the one shown in Figure 11-103. 
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It is time to drag some fields onto the layout, but first, you need to select 
the style for the text in the fields. 

• Click on the arrow tool. 

• Choose Geneva, 9 point, plain text, and align left from the Format 
menu. 

• Click on the field tool, and drag a fi eld onto the layout to the right 
of the CUST NO text label. 

A list will appear showing all the fi elds that are defined in the Sales 
Invoices file. 

• Double-click on Customer Number so the new field will show the 
information you entered in the customer number. 

a File Edit Select G11dgets Format Custom Window 
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Figure 11 -104 Adding the Customer Number field to the layout 

• Drag another field onto the layout, right below the first one, and 
double-click on Name in the scrolling list. 

• Drag the Address field below the Name field. 

• Drag the Address2 fie ld below the previous one. 

Your screen should now look like the one shown in Figure 11-105. 
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Figure 11-105 Entering the first four fields for this layout 

The default length for the n ame and two address fields is not long 
enough for all values. You can increase the length of the fields quickly. 

• Drag the black square in the lower right corner of the Name field to 
the right (see Figure 11-106). 
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Figure 11-106 Making the Name field longer 

., 

... Now make the Address and Address2 the same length as the Name 
field (see Figure 11-107). 
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Figure 11-107 Extending the length of three fields 

• Add the Invoice Number and Sales Date fields to the layout as shown 
in Figure 11-107. 

Notice that the SALES DATE label obscures part of the bottom of the 
Invoice Number field. You can fix that by moving the Invoice Number 
field and label up higher on the layout. 

• Select the Invoice Number field and text label, and then drag them 
up one line on the layout (see Figure 11-108). 

,. a File Edit Select 6 
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Figure 11-108 Moving the Invoice Number field and label 
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- This is a good time to save a copy of this file. 

The next thing to be done is to add five text labels horizontally across 
the layout (see Figure 11-109). 

• Click on the text tool, and then choose Geneva, 9 point, bold, and 
align left from the Format menu. 

• Click below the address label, and then type PART NO. 

• Click a little to the right of that label, and then type QTY. 

• Continue clicking and typing in this manner until you have added 
the other three text labels: DESCRIPTION, UNIT COST, and EXT. 
COST. 

You should now have five new text label objects (see Figure 11-109) . 
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Figure 11-109 Entering five new text labels 

You can now enter the five fields that correspond with the labels you just 
entered (see Figure 11-110). 

• Click on the arrow tool. 

• Choose Geneva, 9 point, plain text, and align left from the Format 
menu. 

• Drag the Part Number field onto the layout. 

• Shorten the field as shown in Figure 11-110. 
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Figure 11-110 Adding five new fields to the layout 

., 

• Continue adding the fields, adjusting their position, and changing 
their lengths until your screen looks like the one shown in 
Figure 11-110. 

FileMaker provides several formatting options that may be selected for 
a field. This allows you to enter information in one format and to display 
it in another. For exam ple, the entry date might be entered by FileMaker 
as 10/22/90 but be displayed as Monday, October 22, 1990. 

For all fields, you can select the font, size, style, and alignment of the 
information displayed in the field. FileMaker offers additional formatting 
options for text, number, and date fields. A fourth type of forma tted 
field is the repeating field. These formatting options are presented 
below. 

Text Fields 

You have been formatting text fields in this project since you created the 
blank layout. 

Font, size, style, and alignment can be set for every field or text ob ject. 
All text within each field must be formatted the same, but all fields do 
not have to be formatted alike. 
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Number Fields 

Number fields can be formatted, or they can be left unformatted. 

If you choose to format a number field, you have several choices. You 
can choose to h ave FileMaker insert commas in fields that con tain a 
value that is greater than or equal to 1,000. 

You can choose to have FileMaker add notation characters to the 
contents of a fi eld: 

If you choose dollar notation, the field will be displayed with a 
leading dollar sign and negative numbers will be enclosed in 
parentheses. 

If you choose percent notation, the number will be displayed as a 
value 100 times greater than what it really is and will be followed by 
a percent sign (%). For example, a sales tax of .055 would be 
d isplayed as 5.5%. 

You can specify a fixed number of digits to be displayed to the right of 
the decimal point. A positive number of digits will round the number 
to that many digits to the right of the decimal point. If you specify a 
negative number of digits, the number will be displayed rounded that 
many digits to the left of the decimal point. 

For example, a value of 456.789 that is in a field with 2 fixed digits would 
be displayed as 456.79. The same value in a field with 0 fixed digits 
would be displayed as 457. If you specified -2 fixed digits, the number 
would be rounded two digits to the left of the decimal point, and would 
be displayed as 500. 

Number fields can also be formatted to display the contents as a logical 
Yes or No. If the field is empty, or if it contains non-numeric characters 
(other tl)an Y, Yes, N, or No), it will be d isplayed as empty. If the field 
contains a value of 0 (zero), No, or N, it will be d isplayed as No. If t he 
field contains any val ue except for 0 (zero), or if it contains Yes or Y, then 
it will be displayed as Yes. 

The part number and quantity fields will contain integers (whole 
numbers) only, so you wqnt to format them so they won't display any 
digits to the right of the decimal point. 

• Select the Part Number and Qty fields and then choose Format 
Number from the Format menu. 

• When the dialog box appears (see Figure 11-111), click Fixed number 
of decimal digits:, and enter 0 in the box. Click OK. 
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Figure 11-111 Formatting fields to contain integer values 

The unit cost and extended cost fields will display dollar amounts, and 
should show dollars and cents. You should format these fields with 
commas, dollar notation, and 2 fixed decimal digi ts. 

• Select the Unit Cost and Ext Cost fields and then choose Format 
Number from the Format menu. 

• When the dialog box appears (see Figure 11-112), click Commas, 
Notation: Dollar, and Fixed number of decimal digits:, and then 
enter 2 in the box. Click OK. 

r • file Edit Select Gadgets I Custom Window 
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Figure 11-112 Formatting fields to contain dol lar amounts 



Chapter 11: FileMaker 583 

Date Fields 

Date fields, calculation fields wlth date results, and date placeholders 
(/ /) can be formatted to display I he date according to your preferences. 

You can choose from five formats for date fields, plus one for unformatted 
dates. 

Unformatted date fields will display the date just as you enter it. 

Let's format the date so that it will display the three-letter abbreviation 
for the month, the day of the month, and then the four-digit value for 
the year. Using this format, 10/22/90 would be displayed as Oct 22, 
1990. 

• Select the Sales Date field and then choose Format Date from the 
Format menu. 

,,. When the dialog box appears, clickjul22, 1988 (see Figure 11-113). 
Click OK. 
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Figure 11-113 Formatting a date field 

After all of the work you've done, you're probably wondering what the 
invoice looks like now. Let's find out. 

3€ -B ,,. Change to Browse mode. 

The formats you specified have changed the presentation of the ' 
information shown in this layout (see Figure 11-114). 
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Figure 11-114 Viewing the format changes 

Notice that the Part Number, Qty, Unit Cost, and Ext Cost fields should 
be aligned on the right, so the numbers will line up correctly. 

~-L • Go back to Layout mode. 

• Select the Part Number, Qty, Unit Cost, and Ext Cost fields and 
then choose a lign right from the Format menu. 

• Make sure the labels above these four fields are lined up with the 
right side of the fields. Drag any labels or fields that aren't aligned 
properly. 

~ -B • Go back to Browse mode, and verify the alignment and format of the 
fields you just modified. 

~ -L • Return to Layout mode. 

• This is a good time to save a copy of the file. 

Repeating Fields 

Your customers usually order two to five different items with each order, 
but this layout on ly lets them order one item per invoice. 

Let's make the bottom five fields repeating fields and allow for six entries 
in each one. 
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You can format any text, date, number, picture, or calculation field to 
show more than one value by formatting the field to repeat. 

• Select the Part Number, Qty, Description, Unit Cost, and Ext Cost 
fields. 

,,. Choose Repeat from the F<Drmat menu, enter 6 in the Values box 
when the dialog box appea rs (see Figure 11-115), and then click OK. 
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Figure 11-115 Formatting fields to repeat six times 

Each of the fields has now extended downward for five more lines (see 
Figure 11-116). 
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If you were to switch back to layout 1, you would only see the first item 
in each of these fields, because the fields are only formatted for repeating 
values in this layout. Any entries you made in this layout would still be 
there, but you could not see or modify them in layout 1. 

Adding Lines and Boxes 

FileMaker provides the tools for adding lines, rectangles, rounded 
rectangles, and ovals to a layout. 

Let's draw rectangles around the repeating fields and their headings and 
then separate the columns with vertical lines. 

,. Click on the rectangle tool. 

• Choose a line width of 2 pixels from the Format menu. (Choose 
the second line below hairline.) 

3€ -Y • Turn off the invisible grid by choosing Invisible Grid from the 
Gadgets menu. 

"• Draw a rectangle around the column headings as shown in 
Figure 11-117. 
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Figure 11-117 A rectangle surrounds the column headings. 

., 

·• Change the line width to 1 pixel (by choosing the line below the 
hairline in the Format menu). 

• Draw another rectangle, this time surrounding the repeating fields. 
Be careful to align it correctly with the rectangle you drew around 
the column headings (see Figure 11-118). Be sure that the rectangles 
you draw do not overlap other rectangles or the fi elds. They must 
completely enclose the fields without overlapping or touching 
them. 
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., 

INVOICE NUMBER 
!.Invoice. Nuoober. .. .... J 
SALES DATE 

!.sales. D.ate ........ .... J 

DESCRIPTION UNIT COST EXT. COST 

.Des.~~i~lioo .... .... .. ... . . ....... Ex i.Cos . 

. .1 ... ... . 

Figure 11-118 A second rectangle surrounds the repeating fields. 

3€ -B • Choose Browse to see the results of the changes you have made. 

3€ - L. 

Your screen should look like the one shown in Figure 11-119. 

r a File Edit Select G<ldH(~h f"ormnt Custom Window 

Records : 
I 

y --" 
Auto Parts 

CUST NO 1004 

Sales I nuoices 
11'41¥~ 

NAME Ms. Kay B. Kusunoki 
ADDRESS 7531 Second Street 

San Francisco , CA 92846 

PART NO QTY DESCRIPTION 

1002 3 WIPER MOTOR 

(404) 555-7283 

F6~ (404)555-6284 

INVOICE NUMBER 
90001 

SALES DATE 
Oct 29, 1990 

UNIT COST EXT. COST 

$36.95 $1 10.85 

., 

I [I] Browse IQ ~ Q] 

Figure 11-119 Viewing the changes made in the layout 

• Change back to Layout mo~e. 

Now you are ready to add vertical lines to the layout to separate the 
columns. There is an easy way to ensure that the lines are perfectly 
verticaL FileMaker provides a gadget called T-Squares that will be useful 
for adding these lines. 
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Let's see if there is any help available concerning lin ing up objects in the 
layout. 

:3€ -/ • Open the Help file. 

3€ -8 • Choose Arranging Information from the Custom menu. 

3€-W 

• Go to record 5 of the 15 records found on this topic (see 
Figure 11-120). 

" File Edit Select Giidgch rormot Cu~om Window 

m FlleMoli:er Help ern 

=t 
LIN lNG UP OBJECTS ON THE L II YOUT ~ 
The G•dgtts mtnu h.u: thrtt oomminds to htlp you lint up objtcts on tht la\jout: 

- 'When you choost r-~Y:i, FUt Makt r dnws i horizonti l .and i Vtrticll T- s:qu•r• on 

Rteords : tht I&~Jout . As \I OU drt g a T-squ61"t , FiltMaktr indic.11tu H s dishnct (n inohts fl"om thf. 

69 top ltft oorntr of tht ptptr uou'vt chon n with tht> F'.J?! ~ft.p comm1nd. You c•n m•b 
found : surt objtots oo tht Itt) OUt hlvt tht samt t dgt, b.ast lint, or ct ntt r tMJ dr'609i~ thtm so 

15 thtyllnt up with .1 T- squ•rt . 'When T-squares art ma9f\ttio, objtcts 'Will automatic.tlly 
snap to U~m. Cliok tht magntt k:on in tht lowtr ltft cornt r of tl'lt s t.ttus 4YU to turn 
T-squ.trt m.t90ftlsm on or off. 

'W'htn you ehoost h t>'i:r~N tJn il, FiltMHtr turns on -in Ttvisiblt rMgMUo 9"'id of 12 
d;vi:~ions p.r inch (6 poi-Its). 'w'htn \I OU cru b ~ rtshapt>, or movt objtcts vith tht 9'"'id 
on. 1,101.1 ~n ~just thtm ir\ I / 12 inch incrt>mt>nts. To tpmpor~ ttrn tht cyid off, hold 
down thf COtnr'l\6nd ktV ..,hilt you dr~ an ob~t. 

'When you Choos t T<M·t6Wa¥Y~ F'ilt~t>r dr~'WS ~ box arOtnS t.Kh unit of l.t&Jout ttxt. 
T•xt bonS.rs .art ust ful vMn you 'W¥1t to liM up liyout ttxt vith othtr objtets 

• To Sf'f otht r rtcords on thts topic. click p~~s of thiP book ~t tht top lt ft of tht window. 
• For mon h• lp on this topic. u• tht FHt Maktr II Owntr's Min~.Ul, pp. 176- 179. 

lo • For h~lp on othtr top;os, choost tht> topic you want from tht Custom mtnu. 

Brows• Ql II;; I2J 

Figure 11-120 Helpful information on lining up objects 

This screen contains information about invisible grids and T-squares. 
You should read this screen to learn more about using the T-squares. 

The other 14 screens in this selection have valuable information that should 
make more sense now that you have some experience working with layouts. 

• After you have read this screen, close the Help file. 

Now, you can use the T-squares to help you draw the vertical lines. 

3€ -T ,,. Choose T-Squares from the Gadgets menu. 

• Drag the vertical part of the T-squares midway between the Part 
Number and Qty fields. 

• Drag the h orizontal part of the T-squares to the exact bottom of the 
rectangle surrounding the repeating fi elds (see Figure 11-121). 

A magnet icon is showing below the part tool in the status and tool area. 
The T-square lines are magnetic (will attract the pointer and any objects 
it manipulates) when the magnet is black with lines emanating from it 
(as it is in Figure 11-121). 
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" • File Edit Select Gadgets Format Custom Window 
., 

Figure 11-121 Positioning the T-squares for a vertical line 

If the magnet is a hollow white outline (turned off), it means the 
T-squares will not magnetically attract the mouse pointer. 

• If the magnet is turned off, click on it to turn it on. 

• Choose the line tool and set the width to 1 pixel. 

Now draw the vertical line between the Part Number and Qty fields. 

• Starting at the top of the rectangle surrounding the column headings, 
carefully align the pointer 9n the vertical part of the T-squares and 
the top part of the rectangle. 

• Draw a line downward to the intersection of the two parts of the T
square, and then release the mouse button. 

The "magnetic" properties of the T-square constrained the line to be 
vertical and caused it to stop exactly at the bottom of the rectangle 
surrounding the repeating fields. 

3€ -B 3€ -L • Confirm that the line is correct by changing to Browse mode (see 
Figure 11-122), and then return to the layout. 
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,. a File Edit Selec t G<ld9<lh rormn t Custom Window 

Records: 
1 CUST NO 1004 

NAME Ms. Kay B. Kusunoki 
ADDRESS 7531 Second Street 

San Francisco, CA 92846 

PART NO QTY DESCRIPTION 

1002 3 WIPER MOTOR 

Fe~(404)555-6284 

INVOICE NUMBER 
90001 

S ALES DATE 
Oc\29, 1990 

UNIT COST EXT. COST 

$36.95 $110.85 

Figure 11-122 The layout after adding one vertical line 

uat Click on th e arrow tool to select it. 

., 

• Drag the vertical part of the T-square to the right and place it 
between the Qty and Description fields. 

• Select the line tool. 

• Add a vertica l line separating these two fields. 

• Continue moving the T-square and adding li nes until all the 
columns are separated. 

00 -B W-L • Confirm the placement of the lines by changing to Browse mode, 
and then return to the layout. 

Now you can add a box below the quantity column that will hold the 
Item Count field. 

00 -T • Remove the T-sq uare by choosingT -Squares from the Gadgets menu. 

... Use the rectangle tool to add a box under the Qty field. Make it about 
the size of the one shown in Figure 11-123. Do not overlap other 
objects. 

,,. This is a good ti me to save a copy of the file. 
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Adding the Calculation Fields 

You have added all of the objects to this layout except for the calculation 
fields and the text labels for those fields. 

The first calculation field you will add to the layout is the Item Count 
field. Adding a calculation field is just like adding any of the other fields: 
drag a new field from the field tool, choose the name of the field, and 
ad just it for position, size, and font attributes. 

• Select the arrow tool. 

• Drag a field into the rectangle you drew under the quantity column, 
and, after releasing the field, double-click on Item Count in the 
scrolling list. 

,. Place the field as shown in Figure 11-123, and size it so it fits entirely 
inside the rectangle, without overlapping. 

,.. j File 

:D 

-
2 

Edit Select Gadgets Format Custom Window 

~Sales I nuoices 
y ..... "' J (404) 555- 7283 

Auto Parts 

., 

Fax: (404) 555-6284 
H~a2!_rl _- - ------ --- - ---- - ----------------------- ------ il,li' 

INVOICE NUMBER 
8! 
Layouts : 

2 

.. J 
IJn'loioe. Nuoob~r. . . . . .. J 
S ALES DATE 

l.s ~J~s. Dale. . .. . .... .. . J 

PART NO QTY DESC~IPTION UNIT COST EXT. COST 

I.FleJ.d .. .. .• l Q~s.G~idtioo . .. .. . .... ..... . . . . . . ... Ext .Cos.~ 

[EJ Layout 

Figure 11-123 Adding the Item Count field 

3€-Y • Ch oose Invisible Grid from the Gadgets menu to turn on the 
invisible grid. 

• Choose Geneva, 9 point, bold, and align right from the Format 
menu. 

• Add the text labels shown in Figure 11-124 to the bottom of the 
layout. I 

,,. Choose plain text from t hf Format menu. 

,. Drag the Sub Total, Sales !fax, Shipping Cost, and Grand Total 
fields onto the layout (see Figure 11-124) . 
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Specifying Tab Order 

Part V: Information Management 

Layouts: 
2 

L1AE;] 
[gig§ 

I.Flel.d .....• l 

PART NO QTY 

~::·.0·'·.· 
....... 
... .... 
.. .. . .. 

SALES DATE 
l.saJes. D.;M .. .. .. ..... J 

DESCRIPTION UNIT COST EXT. COST 

De~.~r.iQ!iQil .. . ............ . 

: ~ 
ITEM COUNT SUB TOTAL Sub TotalJ 

SALES TAX Salos Tal<! 
SHIPP lNG COST I ...... .... SbloP.inq .Co~.\J 

GRAND TOTAL I. ... .... ... . Grand.TP.taU 

---, ' : 

~--- - -------------------------------------------- l 

Figure 11-124 Layout #2 with all fields in place 

.., 

A blank line was left between the Shipping Cost and Grand Total fields. 
This was done so you can add a horizon tal line to indicate that addition 
is being done. 

• Add a horizontal line between the Shipping Cost and Grand Total 
fields (see Figure 11-125). 

The last four fie lds you added to the layout represent dollar amounts, so 
you should now format them as such. 

• Select the last four fields you added by clicking on one and then 
Shift-clicking on the others. 

• Choose Format Number from the Format menu. 

,. Select Commas, Notation: Dollar, and Fixed number of decimal 
digits: 2. Click OK. 

Now you can make the grand total amou nt stand out by making it bold. 

• Select the Grand Total field, and then choose bold from the Format 
menu. 

You are almost done with this layout, but before you change to Browse 
mode and enter some transactions, you need to change the tab order of 
the fields. 

In this type of layout, the top left field would be active first, and when 
you type the Tab key, the next field to the right would become active. 
If there were no more fields to the right, the next one down wou ld 
become active. 

You don't want to have to tab through the Name, Address, Address2, 
and other fi elds, because the only information you will type into thi s 
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form will be in the Customer Number, Sales Date, Qty, and Part Number 
fields. You can change the tab order of the fields by selecting the fields 
you will use and creating a tab g}oup. 

• Select the Customer Number, Sales Date, Part Number, and Qty 
fields (see Figure 11-125). 

r j File Edit Select Gadgets Format Custom Window 

Soles lnuolce~ 

8! -
2 

Heidt;:• 
---~ -------- - ------- -- -------------------- - - ----- -- ~·~·· 

Figure 11-125 Selecting the fields to make a tab group 

If you can't select individual fie lds, it is probably because your rectangles 
or fields overlap each other. Using the arrow tool and moving the 
objects so they don't overlap should correct the problem. 

• Choose Tab Order from the Gadgets menu. 

FileMaker displays a dialog box like the one shown in Figure 11-126. 

r li File Edit Select Format Custom Window 

Soles lnuoices 

CUST NO 

Tob Order 

When browsing, FlleMaker will tab through all the 
fields In o tob group before continuing to the other 
fields on the layout. 

® Put the selected fields Into 11 tab group 

0 He mol!!.> the S<!hH tetl lll•hls fl·orn their tab g•·oup 

Figure 11-126 Dialog box for reating or removing tab groups 

- Select Put the selected fields into a tab group, and then click OK. 

• Click in a blank area of the layout to deselect the fields. 

You have completed the creatio of this layout. 

,.. This is a good time to save a copy of your file. 
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Entering New Sales Invoices 

Now that you have created this new layout, let's enter some transactions 
and see how it works. 

~-B • Change to Browse mode. 

Suppose one of your customers, Ms. Sandra Hardin (customer number 
1001), ordered 1 radiator hose (part number 1009) and 1 radiator cap 
(part number 1010). Let's add a new record to process the transaction. 

W-N • Choose New Record from the Edit menu. 

You will enter the transaction information into this record and type the 
date into the Sales Date field. 

.. Type 1001 in the Customer Number fi eld, and then type Tab. 

The customer information is read from the Customers file and displayed 
on the screen. 

• Type 10/29/90 into the Sales Date field, and then tab to the next 
field. 

• Type 1009 into the Part Number field, and then tab to the next field. 

The contents of the Description and Unit Cost fields are read fro m the 
Inventory file and displayed on the screen. 

• Type 1 into the Qty field, as shown in Figure 11-127, and then press 
Tab to advance to the next field. 

,.. a File Edit Select G<HI~Jeh Format Custom Window 

§0 Sales lnuoices 

8! -
2 

Records: 
2 

['0 Browse 

CUST NO j_"QQ}~~~~~~~~.·~~~.·~-~~~~~=~~~~~~~~~~J ........................ _ .. ..., 
INVOICE NUMBER 

f2Q.iii?.'f~~=.~~.~~·~~~=--J 
N liME dr a M. Hardin i 

ADDRESS !497 Seemore Drive , Apt. 3 ,.l? .. ~b~~ .. Q.~I~ ................ , 
l.!.Q/~?..(.?.9 ........ _ .. _ ........ ) l.~.~~.~:Y.!.!!~ ... N..~.~:?.Q~.--...... - ·- ··-···-·_j 

: ........................................................... ! ! !""'""""""'""'"""' 
t,··························································i, ' 

I i 
;··· ··-·--····· ·····-···· · ·····-················· · ··· · ··~ t!·.·:.~·-·.·-~·.·.·.·:~.-... ~.~~-....... ~ .... ~,i 
t····················-····································1 
=··-·····-·······--··-······-···-·-··-·········-! i_ .. , .. , ... __ , ... ,_,_j 

SUB TOTAL 
SIILES TIIX 

SHIPPING COST 

GRIIND TOTIIL 

EXT. COST 

$5.63 

$5.63 
$0.31 
$0.75 

$6 .69 

F igure 11-127 Ms. Hardin's partially completed transaction 

., 

Ill 

~II 
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.. Complete the order by e9tering the proper information for 1 
radiator cap. 

The grand total for this order should be $16.88. 

The next transaction, on 10/29/90, is from Mr. Gary Westmoreland 
(#1008), who wants 2 engine mounts (#1014), 1 package of wiper blades 
(#1001), and 1 door handle (#1004). 

3€ -N .. Add a new record, and enter the information to complete this 
t ransaction. Enter the current date for the sales date. 

Verify that your results match t hose shown in Figure 11-128. 

r • File Edit Select G<1<l9Hh Format Custom Window 

0 

B! -
3 

Records: 
3 

[0 Browse PI 

Sales I nuoices 

CUST NO ["_i_"iJ.'iJ.~:.·.·.·:.··.··.·:.·:::.·:.j::·.·.·:·.·.·:.·.·:.·.·.·.·} ............................... , 
NAME !Mr . Gar\! H. Westmorel and ! 

ADDRESS l2741 Highwa~ 141 l 
l~~.a.~.h.~r.~~-~ .. ~f: .. ~-~.?..) .. 5. ..... .......................... 1 

~~~lf6.f-:~·:.~~:~:~.~~.::::::; 
Lfii?.~i?.?.·f.,t_~·~·::::::::::::::::; 

PART NO 

r·· --~·a;··4·: 

F~~~:.~-i~~-~11 
I I 
t--·~············· · ···~ 
!. ..................... .! 

QTY DESCRIPTION UNIT COST 

:-·········2·: !"E"r:iri'iN.E"M"ouN·r·-· . :-···· ···1·2: 98! 
r·······-··,-; fw'iP.ER·a·cii·o-i:s·-·--·----·--··--·---··1 L:~=~:~~~-;~jj 
[ _ _-::.~:-~:.TJ_. ro·ao·R--Ii'ii.Nc·cE---...................... : L. ...... ----~-~:~?.J,· 

r·~······~·······-··-·· ............................... i 
l··············j . . 
f .. ·.·.·.·.·.·.·.·.·.·.·.·.·.l. f·.·.·.·.·.·.·.·.·.·.·.·.·.·.·-~-·-·.·.·.·.·.·.·.·.·.·.·:.·.·.·:.-~·::.~·.·.·.·:.·.·~·.·.·.·.·.·_._· .. ·._· .. ·i_; r.:.--.~_·:_ .. · .. · .. · .. · .. · .. ·-.· .· .. · .. · .. · .. ·:_ .. ~.--.--.·-.--.··_· .. ~.-.·.·.·1.: 

: ..............• , .............. .................... .. 

~ ITEM I COUNT SUB TOTAL I S ALES TAX 
SHIPPING COST 

GRAND TOTAL 

EXT. COST 

$25.96 
$8 .53 

$23.98 

$58 .47 
$3.22 
$3.00 

$64.69 

Figure 11-128 Mr. Westmoreland's order 

., 

IQQJ 

Mr. Jim Bell (#1003) places an order next, and he wants to purchase 1 
mirror mount (#1005) and 1 fuel filter (#1012). 

3€ -N • Add a new record, and enter the transaction. 

Compare your sales invoice with the one shown in Figure 11-129. 
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,. a File Edit Select G<HI9<lh Format Custom Window 

::o 

8! -
4 

Records : 
4 

rEJ Browse Q I 

Sales lnuoices 

cu~~~~ r£~~I~~--~;;;:::.·:::.·:~::.·::.·_·j·······-······-··-·····--: 
INVOICE NUMBER 

r~·9.i?.i?.~:=:==-·:=~~:=~:.~~."J 
ADDRESS ! 1492 Document Drive SALES DATE 

f.FiZ?."iZCi.i?.:::::::::~~:.~:.~::.~:J 

PART NO 

t~!.n.g.~r..~!:\, .. f..~ .. ~.9.?.Q.9. .... -···········-··········-·····.! 

QTY 

!'''""''''1"! 
!"""""''1'1 
i"'"'"'"'''i 

t.·.·.·~-~~·.·.·.·.·.·.t 
i. ............ l 
L.. __ ,,, . ..l 

DESCRIPTION 
!11.iRRoR .. i-1.ou~i·:r· · · · · ··· ···· · · ·· ·· ··· · ·: 

fi'.u"E:t:·i'·ii:-T.£R······························1 
i'' ''' '-' ' ' ' ' '''''' '''' ' ' ''''''' ' ' ''''' ''''"''"''"''' '"i 

) .......... ............. .. ... ....... . ... ..... ......... ..... ,j 

!-·················-·····-································! 

t.·.~-·-·.·~-.-.-~·-·.-.~.·~-·-·.~=-·.-.·.-.·.-.·.-.~.--·~~-·.·.·.-.-.~.-.-.~-J 

UNIT COST 

l~·.·.·~---.. ~·.·.·.·_· ... ·.·~---~-·.·.~·.·.· 
! __ ,,,,,,,,,_,_,,,,,,,_ 

2 ITEM COUNT SUB TOTAL 
'---- S ALES TAX 

SHIPPING COST 

GRAND TOTAL 

EXT. COST 

$17.26 
$3 .15 

$20.41 
$ 1.12 
$ 1.50 

$23.03 

Figure 11-129 Mr. Bell 's completed o rder 

., 

Ill 

IOQJ 

The next order comes from Mrs. Mattie Dilbeccio of Grape Creek New 
and Used Cars (#1006), and it is a large order. She wants to purchase 4 
head gaskets (#1013), 12 floor mats (#1007), 48 wiper blades (#1001), 2 
key locks (#1008), 4 radiator caps (#1010), and 5 wiper motors (#1002). 

~ - .'J .. Add another record, and enter the transaction. 

Compare your results with those shown in Figure 11-130. 

r a File Edit Select G <ld ~) <~h Format Custom Window 

:o 

8! -
5 

Records : 
5 

rEJ Browse IQ 

Sales I nuoices 

C UST NO [fQQ~.-:·:.-:::.-:.:~~~::::.~::~:=:~:.~J ... ---·········--··-.., 
NAME iMr s. Mattie L. Dilbeccio i 

ADDRESS i 14 709 Main Str eet 

l!?.r..~P..~ .. g.r.~ ... ~.l .• ~<:: .. ?.f!.Qf!.?. ...................... _ .. J 

INVOICE NUMBER 
l9ooo§ 

.. ~.~!,~§J?..~J..!; ... -··-···-··-
Lt.<:l./.?.2./_~9. ........................ .! 

PART NO QTY DESCRIPTION UNIT COST EXT. COST 

75 ITEM COUNT 
'-----

SUB TOTAL 
S ALES TAX 

SHIPPING COST 

GRAND TOTAL 

$63.4B 
$428.16 
$409.44 

$73 .00 
$35.BO 

$ 184.75 

$ 1, 194.63 
$65 .70 
$56 .25 

$ 1 ,3 16.5B 

Figure 11-130 Mrs. Dilbeccio places a large order. 

., 

lJilil 

I 
0 
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Next, you receive an order from s. Faye Mauney (#1005). She wants 1 
package of window brackets (#1003) and 1 mirror mount (#1005). 

W -N ,. Enter the transaction, and compare your resul ts with those shown 
in Figure 11-131. 

r e5 File Edit Select (iad~J<~1~ Format Custom Window 

§0 

8! -
6 

Records : 
6 

[[j Brows• 

Sales lnuoices 

CUST NO [!§Q·~···:.:·.·:.·.·::.·::.·.·:.·.· ·.r·::.·:::.·:.J ................................ , 
NAME !Ms. Fa~e Mauney i 

ADDRESS ~ 15 Mockingbird' Lane 1 
lE!.~~.!~.9 •.. !.~ .. ~~9.!?.? ...........•........................... ! 

[;§.~9.'~:~·.·:~.~~.~-~·~:::::::! 

rit-~.~~zf.i?.~.~·~·.·.·:.·::.·.·::::::.J 
PART NO QTV DESCRIPTION 

rwiiioo\teR-,;;ci<Ei·s-· .. ···-······: 
fi1.iR.iiii·ii·FiouN_r ........................ 1 
l·-·-·······-·· .. ·-···-·········- ········-···-··1 
t······-······ · ···-t··················~··············· · ··~ 
!······· ············-··················-··················: 
~-···· · · ··· ········~···-·· ............................... j 

i. .................. L... ................................... ! 

UNIT COST 

:··············--ii791 
f.~::·.~.:~:.:T?:.:.~.~-1 
~-········· ···-··· ······-··{ 

~-··········· ······ ········ · ··1 
t.-.·.·.·.·.·.·.·.·.·.·.·-~.·.·.·.·.·.·.·.·:.-.-:.'.1 

ITEM COUNT SUB TOTAL 
SALES TAX 

SHIPPING COST 

GRAND TOTAL 

EXT. COST 

$8.79 
$ 17 .26 

$26.05 
$1.43 
$1.50 

$28.98 

Figure 11-131 Ms. Mauney's order has been entered 

., 

The last order today is another G>rder from Grape Creek New and Used 
Cars (#1006). This time, they order 24 radiator hoses (#1009), 12 fuel 
filters (#1012), 2 engine mounts (#1014), and 60 fan belts (#1015). 

W -N • Enter the order and compare it with the results shown in 
Figure 11-132. 

" • File Edit Sel ec t G<ldfj(~h .Format Custom Window 

0 Sales lnuoices 

8! -
7 

R•cords : 
7 

[[j Brows• 1¢ 

: ........... -...................................... : 
CUST NO i 1 006 ! ............................... . [;.§~Ji:~::.-~.~=-~~~ .. :~·.-:.1 

NAME !Mrs. Mattie L. Dil beccio 
ADDRESS l14 709 Main sjr•et j SALES DATE 

l§r:.a.P..~_g!.:!.~~./ .. f>:!f: .. ?.?..Q.?..? •........................... .! Lfiiz~·?.z~i!·.·:.:·~:~:·:.-.-::.~:::::.-:J 

PART NO QTV DESCRIPTION UNIT COST 

r:~rt~J I f~ ~~~~I~~=f_;~ 
c.-::.·.·.·.-::.-~·.·:.-.-.~:,:~:i! 
' ................ :>. ... ! .. ?..! 
' 12.98! 
:::.-.:·::::.-:.-::.-:·:§·.:.~.~.1 
L ...... .................... J 

L ................... J l .............. : L ...................................................... .! ;, ........................... j 

98 
'----

ITEM OUNT 

I 

SUB TOTAL 
SALES TAX 

SHIPPING COST 

GRAND TOTAL 

EXT. COST 

$ 135.12 
$37.80 
$25.96 

$394 .80 

$593 .68 
$32.65 
$73.50 

$69 9 .83 

Figure 11-132 Grape Creek New and Used Cars' second order 

., 



598 Part V: Information Management 

This completes the data entry for today's orders. 

PRINTING SALES INVOICES 

Now, before printing the invoices, let's preview them to see how they 
will look. 

• Choose Preview from the File menu. Click Reduced. 

If you designed your form small enough, you will see two records on the 
previewed page, and that is not what you want. If you do have two 
records showing on a page, there is a sim ple solution. 

• If you have this problem, change to Layout mode, drag the Body part 
farther down on the page, and then return to Browse mode. 

Preview the page again . If the problem persists, change back to Layout 
mode and drag the Body part down some more until you only have one 
record showing on a page. 

• This is a good time to save a copy of this file. 

Now that you have entered all the information for today's transactions, 
and you have adjusted the layout to show only one record per page (if 
necessary), it is time to print a ll seven of the invoices . 

• Choose Print from the File menu. Accept the defaults by clicking OK 
in the Print dia log box. 

You have defined a number of fields in this file, so it is a good idea to 
print a field definition report and save it fo r documentation purposes. 

• Choose Print from the File menu. Click Field Definitions, and then 
click OK. 

Your field definitions report should look like the one shown in 
Figure 11-133. 

Congratulations! You have completed Project 3. 
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Field Na me 

Invoice Number 

Customer Number 

Pa·t Number 

Oiy 

Sales Datf 

Name 

A<.Jtlre"" 

Address2 

Descnot ior. 

Una Cost 

Ext Cost 

1 tern Count 

Sub Total 

Sales Tax 

SniPPing Cos 

Grand Total 

Field Type 

~lumber 

r~urr ber 

' lumber 

I lumbe-r 

oa· e 

Text 

Tt>xt 

Tex t 

Te~t 

Nu~ ber 

Ca\cu lauon 
Olumoe-J 

Ca lculation 
(Number) 

Ca\culatro-. 
( tJumb~r ) 

Calculatlo'l 
II lumber) 

Calcula::.lo'l 
1Number l 

Calcula~10n 

( 'lumber) 

Formula I Entry Option 

Auto·er1ter sena l number 90008 
Unique values only 

LOOI up "Full Name 1n 'Customers wne'l ·customer 
Number matcnes 'CUSTOMER NUMBER" 

Loo«uo .. AODRESS" in "Customers" when · Cu:.torner Number" 
matches 'CUSTOI"'ER NUMBE~" 

Loo• up 'Address2" 1n "Customers when "Customer 
Number· matches "CUSTOMER NUMBER" 

Loo• uo "Descr iption· 1n ' Inventory" when "Part Numoer· 
matcnes "Part Number· 

Loor uo "Uni t Cost · in Inventory· when 'Part Number· 
matc1es Part Number 

= Oty · una Cost 

a sum (Qty) 

- sum (Ex t Cos t ) 

• round CSub Total '" 05S,2l 

- 1 terr Count - 7S 

=Sub Total • Sales Tax • Sh1ppmg Cost 

599 

Figure 11 -133 The printout of the Sales Invoices field definitions 
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SUMMARY 
• FileMaker provides excellent online help. 

• Even though FileMaker automatically saves any changes you m ake to a fi le, it is importan t 
tha t you regularly save a copy of the file and make periodic backups. This applies to any 
application that manages important informatio n, not just to FileMaker. 

• FileMaker has five main work modes: Define, Browse, Fi nd, Sort, and Layout. Define is used 
to name the fields and specify their type, entry options, and fo rmulas. Browse is used to view 
the fil e, add records, delete record s, and modify information stored in the ex isti ng records. 
Find is used to locate records with information that matches a specific criteria. Sort rearranges 
th e file in ascending or descending order based on the contents of one or more sort fields. 
Layout is used to create a variety o f reports and screens for editing, displaying, and printing 
the contents of the fi le. 

• Six main field types are ava ilable in FileMaker: text, number, date, picture, calculation, and 
summary. 

• Entry options are available for au tomatically entering information, providing a list to choose 
from, and specifying criteria that FileMaker will check before accepting an entry into a field. 

• FileMaker provides the ability to print several types of reports: detail reports, summary 
reports, labels repo rts, and fie ld definitio n reports. 

• File Maker has a variety of tools available fo r creating and modifying the layout of screens and 
reports. These too ls include: a rrow tool, text tool, line tool, rectangle tool, rounded rectangle 
tool, oval too l, field tool, and pa rt tool. 

• The three main pa rts of a layout are: header, body, and footer. Title parts and summary parts 
are a lso ava ilable. 

• FileMaker provides the capabili ty to preview reports before you commit them to paper. 

• Fi leMaker allows you to crea te four ty pes of new layouts: standard, colu mnar, label, and 
blank. 

• Fi leMaker has the ability to look up information in one fi le and copy it into another based 
on a common value stored in a key field . 

• You can format fields to change how they display and prin t t heir contents. 
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KEY TERMS 

1-up labels 
3-up labels 

active record indicator 
arrow tool 
ascending order 

backup 
blank report 
Body part 
book 
Browse mode 

calculation field 
columnar repo rt 
concatenate 

date field 
Define 
descending order 
detail report 

field tool 
field 
file 
Find 
Footer part 
footer 

Header part 
header 

key field 

labels report 
Layout mode 
line tool 
lookup field 

number field 

oval tool 

part tool 
picture field 

record 
rectangle tool 
repeating field 
rounded rectangle tool 

search criteria 
slide control handle 
Sliding objects left 
Sliding objects up 
Sliding part up 
Sort 
sort field 
status area 
string literal 
Sub-summary part 
summary fi eld 

T-squares 
text tool 
text field 

FILEMAKER II COMMAND KEYS AND SHORTCUTS 

Apple Menu 
Help 3€ - / 

File Menu 
Close 3€ -W 
Preview 3€ -U 
Print 3€ -P 
Quit 3€ -Q 

601 



602 

Edit Menu (Browse Mode) 
Undo 3€ -Z 
Cut 3€ -X 
Copy 3€ -C 
Paste 3€ -V 
Select All 3€ -Y 
New Record 3€ -N 
Duplicate Record 3€ -D 
Delete Record 3€ -E 

Select Menu 
Browse 3€ -B 
Find 3€ -F 
Refind 3€ -R 
Find All 3€ -G 
Sort 3€ -S 
Layout 3€ -L 

Gadgets Menu 
T-Squares 3€ -T 
Invisible Grid 3€ -Y 

Part V: Information Management 

ADDITIONAL PROJECTS 
The following project is accompanied by briefer instructions than those 
you have previously completed in this chapter. If necessary, refer to the 
previous projects in this chapter for information and step-by-step 
instructions for any command that you don't remember how to use. 
Also, FileMaker's Help file contains valuable and easily accessed 
information. You will not be reminded to save your work-by now you 
should be thinking of that on your own. 

Project 4: Creating Summary Reports 

In Project 4 you will learn to create a summary report that organizes all 
sales transactions by customer, lists information about each sales 
invoice, summarizes total sales by customer, and provides final summaries 
about all the sales invoices as a group. 

You will learn to create two new parts: a sub-summary part that 
summarizes information for each customer when the file is sorted by 
customer number and a grand summary part that provides information 
about all the transactions as a group. 

You will learn to create a new layout by duplicating layout number 2 
that you created in Project 3 and then modifying it for this project. 

You will also learn how to select sales invoices that fall within a range 
of dates. This gives you the ability to display or print a summary for a 
particular month, quarter, or year in addition to summarizing all of the 
transactions in the file . 
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~&I( 
1417 Sou th Jonqui I St. 

INVOICE 
Smyrna, GA 30829 
(404) 555-7283 

Auto Parts Fax: (404) 555-6284 

NAME CUST NO MONTHLY INVOICES 

SALES DATE INVOICE " SUB TOTAL SALES TAX SHIPPING COST 

Ms. Sandra M. Hard in 1001 $ I 6 .88 

Oct 29. 1990 90002 $ I 4.58 $0.80 $ 1.50 

Mr. Jim Bell 1003 $23.03 

Oct 29, 1990 90004 $20 4 1 $1 12 $1 .50 

Ms. Kay B. Kusunol< 1 1004 S I 19 .2 0 

Oct 29, 1990 90001 $ 110.85 $6 10 $2.25 

Ms. Faye Mauney 1005 $28 .98 

Oct 29, 1990 90006 $26.05 $ 1.43 II 50 

Mrs. Matt ie L. Dllbecc lo 1006 $2,0 16. 4 1 

Oct29, 1990 90005 $1,194.63 $65.70 $56 25 

Oct 29, 1990 90007 $593.68 $32.65 $73.50 

Mr. Gary H. Westmoreland 1008 $64.69 

Oct 29, 1990 90003 $58 47 $3.22 $3.00 

Average Sale $288 38 Monthly Invoices $2,269. 19 

Largest Sale $1,19-163 Total Sales Tax $Ill 02 

Smallest Sale $14 58 Total Shipping Cost $139.50 

Private and Confidential Internal Use On ly 

Page 1 

Figure 11-134 Final output of Project 4 
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DUPLICATING A LAYOUT 

To begin this project, o pen FileMaker and save a copy of the file. 

If you h ave been experimenting with the Sales Invoices fi le, check the 
status area to see that the file is not sorted and that all records are 
currently being browsed. 

3€ -S • You can be sure the file is not sorted by choosing Sort and then clicking 
Unsort in the dialog box. 

3€ -G • All records can be browsed by choosing Find All from the Select 
menu. 

3€ -L • Change to Layout mode, and scroll to layout 2. 

You will now be looking at the layout you created in Project 3. Let's 
duplicate this layout. 

3€ -0 • Choose Duplicate Layout from the Ed it menu. 

MODIFYING A LAYOUT 

You will now see that there are three layouts associated with the Sa les 
Invoices file. 

Let's delete all the fields, text, and graphics objects that won't be used 
in this report. 

• Select the fields and text labels shown in Figure 11-135. You can use 
Shift-click to add objects to the selection. Press Backspace (o r Delete) 
to delete these ob jects. 

r s File Edit Select Gadgets Format Custom Window 

§0 Sales lnuoices 

8! 
H~2~!-----------------------------------------------

-
3 

Layo~ts: 
3 

~ 
Address2 • 

~ 

------
------

------

lllj§IHaliJai 

INVOICE NUMBER 
!In Yo ice. N~(l)ber. .. . ... J 
SALES DATE 

Gr.a.r~ll TPtaJ. 

., 

(D Layout 121 

Figure 11-135 Selecting the ob jects to be deleted 

,,. Now delete the rectangles and lines that are not needed in this 
layout. 
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You will be left with a layout th t contains most of the fields and text 
you will use for this project (see Figure 11-136). 

,. ei File Edit Select Gadgets Format Custom Window 

0 

Layouts: 
3 

l.flel.d .... .• , 

I ---·-----------------------------------------------
INVOICE NUMBER 
i.lnvoic,. Nvrobtr; ...... J 
SALES DATE 

l.$~)9$, D.~t9. 0 0 0 0 0 0 0 0 0 0 0 J 

Figure 11-136 The layout after deleting unnecessary ob jects 

., 

The bod y section will be much smaller in this layout, and you need to 
make mo re room in the footer fo r later use. 

• Scro ll down in the layout until you can see the Body part icon. Drag 
it back up to just below the Shipping Cost fi eld. Drag the Footer part 
to about 2 inches be low the Body part (see Figure 11-137). 

,. • File Edit Select 

8! --

Layouts : 
3 

, 
L---------- --------------------------------------

Figure 11 -137 Adjusting the Body and footer parts 

., 
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You need to make the header about an inch larger. You will put two rows 
o f column headings in the header and add a line above and below these 
h eadings. 

• Drag the Header part down about an inch or so (see Figure 11-138) . 

Layouts: 
3 

IHeJ.d ... ... l 

Custom Window 

(404) 555-7283 

Fex: (404) 555-6284 

NAME CUST NO 
- -~LF.S DATE INVOICE '* SUB TOTAL SALES TAX 

~~~~:~~ ~~ber .. ? ........ .. .. .. J Un'loic~. Number. ..... . J 

l.s~ Jes. Pale. ..J 

Figure 11-138 Adjusting the objects in the header 

., 

• Now you need to drag the text labels from the body area into the 
header area, as shown in Figure 11-138. Don't fo rget that you can 
use the T-squares to m ake this process easier and neater. 

• Change Invoice Number to Invoice# to m ake more room fo r the 
other column h eadings. 

Since every customer in th e summary repo rt will have at least two lines 
of information, you can make the first line bold and the second line 
plain to help differentiate them and make it more obvio us which 
headings refer to which data items. 

·• Change the second row of headings (starting with Sales Date) to 
plain text. 

,,,. Add a 2-point ho rizonta l line belo w the fax number and a 1-point 
horizontal line under the column headings and completely inside 
the h eader. 

• Drag the Header part up to just below the second line you just added. 

You now have the header for this report completed . In Project 3, there 
were only three parts to the layout: the header, the body, and the footer. 
In this layout, two mo re parts will be added: a sub-summary and a grand 
summary. 



Chapter 11: FileMaker 607 

ADDING A SUB-SUMMARY PART 

ln this report, you will list each customer one time and, below that, 
importan t information about each transaction completed by that 
customer. You want the customer name to only show once, and you 
want to show the customer num ber and the total of a ll t ransactions that 
are listed for that customer. To do th is, you will add a sub-summary part 
that wi ll be used in the report when the fil e is sorted by customer 
number. Then, you will list the transactions in the body section of the 
report. 

_. Drag a new part onto the layout about an inch or so below the 
header. 

A dialog box will appear to let you select which body part you want this 
one to represent. 

,.,. Click Sub-summary when sorted by:, and then click on Customer 
Number in the scrolling li st to the right (see Figure 11-139). 

* File Edit Select Gadgets Format Custom Window 

(404) 555-7283 

0 1111e Ue<lde.- I nuolce Number 
OH<Hrd<w U\lomer Number 
0 Uody Port Number 
®Sub- summary when sorted by: Qty 
0 Grand Summary Soles Date 
0 rootl'r Name 
0 1111e rootpr Address 

Address2 

0 Page brenk 

Figure 11-139 Adding a sub-summary and sort requirement 

• Move the Name and Customer Number fields into this sub-summary 
area (see Figure 11-140). 

You can use the T-squares gadget to help in aligning objects in the 
layout. Resizing and moving the fi elds and text labels will also be 
necessary to get good use of the space available. 
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r 45 Fil e Edit Select Gadgets Format Custom Window 

La~ outs. 
3 INVOICE a 

(404) 555-7283 

Fax: (404) 555-6284 

SALES TAX SHIPPING COST 

.., 

----------------
~ ~!5:::========---f~_,~-~ -E: -:-:~ -!!!!!. -'!!£! -= -,=--------rm

1

. 

IFi.eJ.d .....• l ----------------------------
ffo.!-SL __ IJPY.oice. t!urnber ....... J 

!2 .694 " 
/) 

lsales. D.~te .......... J 

2 .537'" 

Figure 11-140 Moving field s into the sub-summary part 

• Add a 1-po int horizontal line at the top of the sub-summary area to 
separate each customer. 

Now you need to move the fields that wi ll be in the body into a row just 
below the sub-summary. 

• Move the Sales Date, Invoice Number, Sub Total, Sales Tax, and 
Shipping Cost fields into a row in the body o f the layout (see 
Figure 11-141). 

• Drag the Body part up just below this row o f fi ve fields. 

Fax: (404) 555-6284 

i.HeJ.d .....• l 

Figure 11-141 Placing fields in the body area o f the layout 
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DEFINING SUMMARY FIELDS 

At the end of the report, you want some info rmation to be presented 
about the records in the file as a group. When you are managing a 
business, it is usefu l to know basic statistical information about your 
sales. Let's calculate the average amount of all the sales and determine 
the largest and smallest purchases, the total amount for all transactions, 
the total sales tax collected, and the total amount collected to cover 
shipping costs. 

You want this info rmation to print just once, and you want to reflect 
summary information about the file as a whole, so you need to define 
six summary fi elds, create a summary part, and place the fields into 
that part. 

Let's define the summary fie lds first. 

• Choose Define from the Select menu. 

W -S • Click Summary to designate the type of field, and name the first 
fi eld Monthly Invoices. Click OK or press Return . 

A dialog box wi ll appear on the screen (see Figure 11-142), and 
you should click Total of and select Grand Total in the scrolling list 
o f fi elds. 

' • File Edit l!lii!ZIII Gadgets Format Custom Window 
~ 

Soles lnuolces 

Field Definition 

Summary Formulo: 

Monthly lnuoices • 
@ Tot al of Descr iption f¥ 0 Ruerage of Unit Cost . .,,, 

0 Count of EHt Cost ::~1~ 
:~;: 

O Minlmum Item Co unt ·Jl! 
O MaHimum Sub Total 
0 Standard Deulotlon of Sales ToH 

i!'f ' 0 Fraction of Totol of Shipping Cost 
I I 

0 Running toto I ~ (cancel) 

=•u' ""u' !l -· 
Figure 11-142 Defining the Monthly Invoices summary field 

• Using this method, define ~he other five summary fields (Average 
Sale, Largest Sale, Smallest Sale, Total Sa les Tax, and Total Shipping 
Cost) as shown in Figure 11-143. 
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' • File Edit 

Shipping Cost 
Grand Total 
Monthly lnuolces 
Ruer age Sale 
largest Sale 
smallest Sole 
Total Sales TaH 
Total Shipping Cost 

Field name: 

Window 

Field Definition 

• Item Count • • 75 !!'! 
• Sub Total • Sales TaH • Shipping cost 
• Total of Grand Tota l 
• Rue rage of Sub Total 
• MaHimum Sub Total 
• Minimum Sub Total 
• Total of Sales TaH 
• Total of Shipping Cost 

Field type: 
O TeHt XT 
O Number X N 
0 Date XD 
O Picture XP 
0 Calculation XC 
@ Summary XS 

£ntrtj D1111ons 

flefonnutale 

( Oesele< t J ( OK 

( Delete ] L§C~ 

Figure 11-143 Formulas for all the summary fields 

When you exit from the Field Definition dialog box, FileMaker adds 
these new fields into the body of the layout and makes the body large 
enough to hold them (see Figure 11-144). 

.. • File Edit Select Ga 

INVOICE 

14 17 South Jonqui I St. 
Smyrna, GA 30829 
(404) 555- 7283 

Fax: (404) 555- 6284 

Figure 11-144 FileMaker adds the new fields to the layout . 

., 

- Select these fields, and format them as Geneva, 9-point, plain text, 
and align right. 

• Format the summary fields to display currency with commas, dollar 
signs, and 2 digits to t he right of the decimal point . 

You want to use the Monthly Invoices field in two different ways in this 
layout. If you put this field into the sub-summary section of the report, 
it will show the total amount of all purchases by that particular 
customer. If you put this field into the grand summary section, it will 
show the total amount of all purchases made by all customers. 
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You will duplicate this field (and its text label) and place one Monthly 
Invoices field in the sub-summary area. Then you will create the Grand 
Summary part and put the other Monthly Invoices field into the grand 
summary area. 

- Deselect the fields, and then select just the Monthly Invoices field 
and its associated text label, copy them, and paste them back into 
the layout. Move the new objects to any white area wh ere you can 

' see them. 

• Move the Monthly Invoices field into the sub-summary area and the 
text label into the header, as shown in Figure 11-145. 

• Format the Monthly Invoices field in the sub-summary area to 
display bold text. 

• Rearrange the remaining six summary fields and their text and drag 
them into the footer. Then drag the Body part up to just below the 
Sales Date field. 

ADDING A GRAND SUMMARY PART 

Now you need to create the Grand Summary part and place the 
summary fields inside it. 

• Drag a new part into the footer below the six summary fields, and 
when the dialog box appears, click Grand Summary. 

• Arrange the fields and their text labels as shown in Figure 11-145. 
Add a 2-point line at the top of the grand summary area to separate 
this section from the last customer. 

r a File Edit Select God ets Format Custom Window 
., 

I ... . Avt!j~Ot. S~liJ Honthl\1 lnvoic.s I. . MPn\bN.InY.Q\QeiJ l 
I. ...... L.v:oes.tS~liJ Tobl S~les T~x I. ... TP.ta\Sales.T.aliJ 

f~aJSL__ I. ..... Smi.lles.tSalil Tobl Shipping Cost IJotaJ.SIIippin? .CP$011 

Figure 11-145 Placing a grand summary part and its fields 
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• Add a page number placeholder in the footer, as shown in 
Figure 11-145. 

This report is for your use only, so it should be labeled as private. 

• Make the footer a little larger, and add two text blocks. The first text 
object should say Private and Confidential, and the other should say 
Internal Use Only. 

Your layout should now look like the one shown in Figure 11-146. 

r el File Edit Select Gadgets Format Custom Window 

Bi -
3 

Layouts: 
3 

I. ..... AVf1:42t.Sal!IJ Honthl\1 lnvo;ces 1. . 1':1Pnt~ly .lnY.Q\qtiJ 
. ___ 

1 
Largest Sal• I. ...... LW.Q~s.t Sal!J Total Sales Tax I ... .TP.t~\ S•lu. T.~>IJ 

! ~or~ --- ___ s_"!."..!l.!~t !>al• I. ..... Sro.lll~s.t Salil Total Sh;pp;ng Cost l:r.olal.SI\iPRin9.CPJiOII . 

6~~~~~~~~1 - -- ------------------------------------ --- : ' 
Internal Use Only 

Figure 11-146 The last text objects have been placed. 

., 

You have completed designing the layout form, so Jet's see what it looks 
like when you browse and preview this report. 

BROWSING AND PREVIEWING THE REPORT 
W- 13 .. Choose Browse from the Select menu. 

Your screen should look like the one shown in Figure 11-147. 



Chapter 11: FileMaker 

3€ -S 

3€ -U 

613 

,.. e5 File Edit Select (I<HI9(~h lrormut Custom Window 
., 

sO Sales I nuoices 

h=)~ ~&!( 
1417 South Jonqui 1 St. Q 

~ ~ Auto Parts 
R~cords : 

7 

NAME 
SALES DATE 

Oct 29, 1990 

Oct 29, 1990 

INVOICE • 

90001 

90002 

INVOICE 

I 
CUST NO 

SUB TOTAL 

$110.85 

$14 .58 

Smyrna, GA 30829 
( 404) 555- 7283 

Fex: (404) 555- 6284 

HONTHL Y INVOICES 
SALES TAX SHIPPING COST 

$6.10 $2.25 

$0.80 $1.50 

Oct 29, 1990 90003 $58 .47 

Oct 29, 1990 90004 $20.4 1 

Oct 29 . 1990 qnnnc; $1 .194.63 ~2, .. , u •• f~ I 
0 

Pri vote and Confidential 

Page"" 

10 Brows• Ql 

Figure 11-147 Browsing the Sales Invoices report 

Where are the customer names, customer numbers, and total invoice 
amounts? 

The sub-summary part will only take effect when the report is sorted by 
customer number. 

--
Sort the file by customer number. 

Preview the report (see Figure 11-148). 

You can see that the report is working like you wanted. 

,.. 
e5JIIEdit Select Gadgets Format Custom Window 

Sales I nuoices 

Fex: (404) 555-6284 

~E CUST NO HONTHL Y INVOICES 
~LES DATE INVOICE" SUB TOTAL SALES TAX SHIPPING COST 

Sandra H . Hardin 1001 
I 

$16 .88 

It 29, 199o 90002 $14.58 $0 .80 $1.50 

Jim Bell 1003 $23.03 

It 29, 199o 90004 $20.41 $1.12 $1.50 

Kay B . Kusunoki 1004 $119.20 

lt 29, 1990 90001 $1 10 .85 $6.10 $2.25 

Faye Mauney 1005 $28 .98 

'>O ooon onnn< .. .,~ n" .. n .. "n 

Q iT:: 'HH''"'"''i':d r.:; 

Figure ll-l48 Previewing your summary report 

- Now you can ex it the preview. 

., 

Preuiew: 

(Nt~Ht PU~W ) 

[ Page Jlllll 
D Reduced 

( [Hit l 
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PRINTING THE REPORT 

This report layout is completed . Now is a good time to print the report 
and the field definitions fo r the file. 

~ -P • Print the summary report, and then print the field defin itions. 

SELECTING INVOICES WITHIN A RANGE OF DATES 

You now have a report that will give you summary information about 
the entire fi le, but it would be mo re useful if you could te ll Fi leMaker to 
summarize all transactions for a particular period of time. 

FileMaker provides the capability to produce this type of summary 
report. You will use the report layout you just designed, and all you have 
to do is select all the records that match speci fi c criteria. 

You can choose a summary o f al l transactions by one customer by using 
the Find command. If you select Find, a report appears on the screen 
showing rectangles where the fi eld info rmatio n would normally be. If 
you type the customer number into the Customer Number field and 
click Find, all the transactions for that customer appear. (You would still 
have to remember to sort by customer number after finding the records 
so the sub-summary sectio n would be activated.) 

Another use for the Find command is to select all transactions within a 
particular range of dates. For instance, you can te ll FileMaker to find all 
sales invoices with sales dates that are between 10/1/90 and 10/31/90. 
This would select the records you entered in Project 3. 

Let's record some sales transactio ns for July 1991. 

~ - L ~-B - Switch to layout 2 and choose Browse mode. 

Enter the following four sales transactions. 

7/14/91, Customer #1002 purchased 2 #1017 headl ights and 1 
#1019 battery. 

7/15/91, Customer #1005 purchased 1 #1020 fuel pump. 

7/18/91, Customer #1007 purchased 1 #1018 voltage regulato r and 
1 #1019 battery. 

7/22/91, Customer #1009 purchased 2 #1017 head lights, 1 #1018 
voltage regulator, and 1 #1020 fuel pump. 

~ -L • Switch to layout 3. 

Let 's find all sales transactions fo r July 1991. 

~ - F • Choose Find from the Select menu. Type 7 / 1/91...7/31/91 into the 
Sales Date field. 

Don't worry if it doesn't all show. just type ca refull y, o r ch ange to the 
layout and make the sales date longe r. 
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... Click Find. 

~ -S • Sort the found reco rds by customer number. 

When you preview the report, you should see a screen like the one 
shown in Figure 11-149 (when you scroll a little). 

,. . Edit Select (i <ld~J<lh f"ormut Custom Window 
., 

Soles I nuotces 

•org• H . Lapmont 1002 $60.71 

4, 1991 90008 $55.41 $3.05 $2.25 

ay• Haun•y 1005 $32.36 

5,1991 90009 $29.96 $1.65 $0.75 

lg Preulew: 

·11
1

11 (N~Ht Pug~ ) 
I ( Poge Jll•l 

os• S. d•Ang•llo 1007 

I 
$72.64 

8, 1991 90010 $67 .43 $3 .71 $1 .50 

l •nda Rid•r 1009 

I 
$80.96 

2, 1991 90011 $73.90 $4 .06 $3.00 

II ~ ·;:,:"· 
v•rag• Sal• $56.68 Monthly lnvoic•s $246.67 

arg•st Sal• $73.90 Total Sal•s Tax $12.47 

rnall•s t Sal• $29.96 Tota 1 Shipping Cos t $7 .50 

Figure 11-149 Previewing the summary report fo r July sales 

• Exit the preview when you are read y. Print the report if you wan t. 

If you want to see a summary for all the records in the fi le, you can easily 
do so . 

~ -G ~ -S • Choose Find All from the Select menu, and then sort by customer 
number. 
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When you preview thi s report, your screen should look similar to the 
one shown in Figure 11-150. 

r -' • Edit Select G<JdgHh Formnt Custom Window 

~&!( 
~to Parts 

ES DATE 

ver;oge S;ole 

a rgest Sal e 

.,alh•st Sal e 

Sales lnuoices 

1417 South Jonquil St. 

INVOICE Smyrna, GA 30829 
(404) 555- 7283 

Fax: (404) 555-6284 

CUST NO MONTHLY INVOICES 
INVOICE • SUB TOTAL SALES TAX SHIPPING COST 

$204 .1 2 Monthly lnvo;ces 

$1 ,194.63 Total S;oles T;ox 

$2,5 15.86 

$123.49 

$1 47 .00 $14.58 Tot a 1 Sh;pp;ng Cost 

Figure 11-150 Previewing all sales recor~s 

• Exit from the preview. 

IQ 

., 

You can produce many types of summary reports using this layout. If 
you want more information about select ing records using the Find 
command, try looking in the Help file. 

You try a report now. 

- Print a report showing all transactions during the period from july 
15, 1991, through july 18, 1991. 

You might try adding a few more sales transactions and previewing or 
printing some more reports. 

Congratulations! You have completed all the FileMaker projects. 
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Chapter 12: HyperCard 1.2 

What You Will Learn in This Chapter 

After reading this chapter and completing the projects in it, you 
should be able to: 

• Understand what a stack is and how it can be used 

• Open stacks and browse through the information in them 

• Add and modify the information in stacks 

• Create a new stack usi ng HyperCard's authoring features 

• Create, modify, and use buttons to contro l HyperCard's actions 

• Create, modify, and use fields to store information 

• Use the painting tools to change the appearance of stacks 

• Store graphics in stacks 

• Add visual effects to your stacks 

• Print the cards from a stack 

• Print a report based on info rmation stored in the cards of a stack 

T his chapter introduces you to all these aspects of using HyperCard, 
but it does not attempt to cover all the features of the program. 
Several excellen t books have been written that cover the entire 

program, including references to the HyperTalk scripting language and 
samples of using it. 

STARTING HYPERCARD 

HyperC.:wd 

• Start HyperCard by double-clicking on its icon. 

When HyperCard opens, it p resents you with the Home stack, as shown 
in Figure 12-1. Your Home card may look different from the one shown. 
HyperCard allows you to customize the Home stack. 
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,.. • File Edit Go Tools Objects 

w 
lntro Help 

~ ~ 
Phone To Do 

Art Ideas Clip Art 

..-.Home ,..._rd~ l!ili!J . '-'l1 ~ 

Address 

Weekly 

Card Ideas 

Inc . 

= = 
Documents 

Calendar 

Button Ideas 

Figure 12-1 HyperCard's Home stack 

LJ] 
File Index 

~ 
Slide Show 

.. (}. 
' "tf' 

Stack Ideas 

., 

Book Shelf 

HyperCalc 

Quotations 

6:52PM 

You can see a number of icons on the Home card. Each is linked to a card 
in another stack. Unlike icons on the desktop, you don'thave to double
click on one to open it. In HyperCard, all you do is click on ce on the 
button, and it will then do whatever it is programmed to do. In this case 
each button is programmed to take you to a specific card or stack. 

USING THE GO MENU 

Before you start jumping around to t he diffe ren t stacks, you should 
know how to use the Go menu. 

Some stacks allow you to move freely within the stack, and some do no t. 
Since HyperCard is customizable by many people, you can assume 
certain types of buttons will respond in a particular manner when you 
cl ick them. However, their response to your click may not always be as 
you assume. 

The first thing to notice is tha t the Go menu is divided into three groups 
of commands . The top group is designed to allow movement inside a 
stack or to other stacks. The middle group is for use in moving inside one 
stack, and the bottom grou p is important because it lets you issue 
commands directly to the stack. These commands may be as varied as 
the number of people using the stack and can include most of the 
HyperTnlk commands. 
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Back 

Home 

Help 

Recent 
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takes you back to t~e last card you visited, even if it was in 
a completely different stack. 

takes you directly to the Home card. 

takes you to the opening card of the Help stack, which 
contains a very large collection of information about 
HyperCard. If you really want to get off to a flying start 
with this program you should become familiar with the 
use of the Help stack. Many people have learned to use 
HyperCard just through the information contained there. 

shows a collection of up to 42 of the last cards you have 
looked at. You can return to one of these cards by clicking 
on its picture. 

The next group of commands lets you move around inside the current 
stack. 

First takes you to the very first card in the stack, even if it is on 
a different background. 

Previous takes you to the card just before the current card. This is 
generally the same as clicking a left arrow button. 

Next takes you to the next card in the stack, and works the same 
as most right arrow buttons. 

Last takes you to the very last card of the stack. 

The last group of commands allows you to do many different things, 
depending on what you do after you issue the command. 

Find allows you to find a word, phrase, or even just a few 
characters that appear in any field in the stack. It is a very 
powerful command and searches very quickly to find 
information, even if you can remember only a portion of 
it. For example, if you can only remember a person's first 
name, HyperCard can still find that person in an address 
stack. 

Message shows the Message box and allows you to type one line of 
HyperTalk commands. 

EXPLORING THE INTRO STACK 

The Intro stack is a friendly introduction to HyperCard. It is not really 
a tutorial, but it introduces you to some of the concepts involved in 
using HyperCard. 

,.. Cli ck the button named lnt o. 
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( What Is HyperCard~~ 
1 

( Go back ) 

Figure 12-2 lntro stack opening ca rd 

.. Click the What is HyperCard? button. 

The Intra stack takes you th rough a brief introduc tion to HyperCard. 
Each ca rd has an arrow pointing to the right. When you have fin ished 
reading the card, click on the right arrow to advance to the next one (see 
Figure 12-3). 

HyperCard is a personal toolkit 
You cen use Hyper Card t o crea t e you r own applications 
for ga t he r ing, or gani z ing, presenting, search i ng, end 
customizing In f ormation. 

Figure 12-3 The second card in the lntro stack 

Continue workin g through the Intra stack until you come to the last 
card. In a few minutes you will arrive at the card shown in Figure 12-4, 
except that the rectangles will no t be showing. In fact, it may be a little 
difficu lt sometimes to tell where buttons are located since they can be 
made transpa rent. 

~Option • Press the Command and Option keys at the same time. 
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GETTING HELP 
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You will now see a rectangle drawn around each button on the card (as 
shown in Figure 12-4). 

What next? 

Clt ck He lp cards t o f ind ou t mor e aDou\ explori ng 
HyperCard end mak ing sleeks of your ow n. 
Or cl i ck Home and re ly on ser and l pl\ y to uncov er t he 
une xpec \ed. 

@ -·-··----·
Home to explore on my ownJ -----------1-'-----

Figure 12-4 Using Command and Option to see the buttons 

When you release the two keys, the rectangles will once again disappear, 
but now you know exactly where the buttons are. This feature is useful 
whenever you are not sure what buttons are available on a card. 

• Now that you have found the button s, click the Help cards button. 

Figure 12-S shows the first card of the Help stack. 

The HyperCard Help stack is a powerful learning tool and will remain 
a useful reference even when you have become an experienced user. 

HyperCard 
Help 

0 Int roduct ion 

Click the Browse tab below 
aft er you've seen the 
Int roduction. 

Figure 12-5 The Help stack's opening card 
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Notice that the Help stack looks like a spiral bound set of flip cards, or 
a notebook turned sideways. The tabs along the bottom look li ke and 
function as index cards. To select the index card of your choice, move 
the pointer to it and click. (Each tab is a button in disguise.) 

You are in the process of learning how to browse through HyperCard, 
so now would be a good time to see what the Help stack has to say about 
browsing. 

• Click the Browse tab to go to the first card that has information 
about browsing (see Figure 12-6) . 

Browsing HyperCClrd 

o How to use Help 
0 NClvigat ing 
o Opening st <lcks 
0 Editing text 
o Searching for text 
0 Adding CClrds to stClcks 
0 Pr inting cards and st<lcks 

Figure 12-6 Index card for help in bro wsing through HyperCard 

Thi s card is an index to seven topics associated with browsing through 
HyperCard stacks. By read ing each o f these sections, you will learn the 
basics of working with HyperCard. Let 's see what this sectio n has to say 
about using Help . 

• Click How to use Help. 

Figure 12-7 shows the card this command will present. It tells you about 
basic arrow buttons and the shortcut command to get help (pressing 
Command-?) and provides an in troduction to using the Find command. 
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How to use Help 

Get to the Help cards (Wilere you are now) from 
anywhere in HyperCarct1 by choosing Help from the Go 
menu (or typing Command-?). 

• Click arrows near the bottom of the Help cards to: 

go to the previous card on the topic 
go to the next card on the topic 
return to a list of topics or a cross reference 

1

101 1 • Choose Find from the Go menu to search for text 
!!lLl!!!J.!!!!l.:_ within the Help stack 

Figure 12-7 First help card of How to use Help topic 
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The right arrow atthebottom of the card indicates that more information 
o n the same topic is on the next ca rd . 

,. Click on the right arrow to see the next help card on this subj ect. 

This card (see Figure 12-8) tells you abou t some of the conven tions used 
in th e Help stack. It discusses the Glossary and Index features of the Help 
stack, two parts that are useful for finding information quickly. 

How to u se Help (cont.) 

• Click asterisks in text to see more information in a 
pop-up field or to go to cross-references.* 

• Click the Glossary tab to look up terms in the 
glossary. Flip through the glossary using the arrows at 
the bottom of the cards or spec1fy text to find. 

• Click the Index tab to look things up there. Clicking 
an entry in the IndeK J kes you to the Help card that 
explains that topic. 

See also the Hypercard manual You can curl up with 
it and read detailed de crlptions about Hypercard. 

¢1 ~ 

Figure 12-8 Second How to use Help card 

The Help stack uses asterisks to ind icate that more information is 
ava ilable about a s~bj ect. Cli ckirg on the asterisk either shows a hidden 
fi eld with more info rmatio n o r takes you directly to a card that contains 
cross-referenced materi al. I 
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At the bottom ofthe card you can see two buttons: a left arrow (Previous) 
butto n and a Return button . The lack of a right arrow (Next) button 
ind icates that you have reached the end of t his branch of information. 

If you wanted to learn more about browsing, you could click on the 
Return button and choose another topic from t he index on the card 
shown in Figure 12-6. If you would like to explore more about this topic, 
feel free to do so. When you have fi n ished reading about browsing, 
con t inue with the next command. 

• Click the Index tab to go to the fi rst card in the Help stack Index. 

The first Index card in the Help stack is shown in Figure 12-9. The index 
gives you several ways of finding more information on HyperCard . Each 
term to the right of a shadowed sq uare is surrounded by a button. If you 
click o n the term, the button te ll s HyperCard to take you to the card 
con ta ining more informat ion about tha t term. 

15 File Edit Go 

Index 

0 Addi ng 
0 b8ckgrounds 
0 buttons 
0 c8rds 
Cl fi elds 
0 St8CKS 
0 text, typing 
0 pictures 
0 sp8ce between text lines 
0 8iming links 
0 Apple menu 

0 Apple key 
0 8PPIIC8tlons 
0 l8unchlng or opening other 
0 8rrow or cursor keys 
0 8sten sk (* ) 

Figure 12-9 The fi rst Index card 

You can a lso look at the previous o r next card by clicking o n t he left o r 
right arrow, respectively. If you don't want to look at the index, you can 
click on the Return button . 

The Index card also has a button named Find located between the right 
arrow and the Return butto n. You saw a little about Find on the How to 
use Help cards. Let's learn more about HyperCard's ability to q uickly 
find text in a stack. 

• Click Find. 

As soon as you click the Find button, the Message box appears with 
the phrase Find 1111 showing in the box (see Figu re 12-10). The Find 
com mand no rmally puts th is in to the Message box, places the insertion 
point between the quotatio n marks, and then waits for you to type some 
characters o r one o r more words fo r it to find. 
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Index 

0 Adding 
0 backgrounds 
0 buttons 
0 cards 
o f ields 
0 st acks 
0 t ext , typing 
D pictures 
D space bet ween t ext lines 
D aiming l inks 
D Apple menu 

0 Apple key 
0 applications 
0 launching or opening other 
0 arrow or cursor keys 
o osterlsk (*) 

-~~~:_ti n~_----------------------

Figure 12-10 Using the Find command 
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If you type th e fi rst few characters of a word, HyperCard searches for any 
word that begins with those characters in all cards in that stack. If you 
type o ne word, it finds any card containing that word. If you type more 
than one word, it finds only the cards that contain all the words on the 
same card . 

.. Enter find between the quo tatio n marks, and then press the Return 
key. 

HyperCard ign ores differences between uppercase and lowercase letters 
during a find operation. 

When you press the Return key, Find looks through all the cards on the 
Index background and quickly shows th e first card containing the word 
"find" or any word beginning with it (see Figure 12-11). 

r • File Edit Go 

Index 

D Beck command 
D Background 
0 buttons 
D f iel ds 
0 PICture 
D Backgr ounds, 
D eddl ng or modifying 
D copyi ng existing 
D Bkgnd Info command 
D Background commend 
D beckup 

0 Blind typing 
0 Bring Closer commend 
o Browse tool 
0 cllckmg buttons with 
0 l findln!ll text with 
0 Brush Shape commend 
0 Button Inf o commend 

Figure 12-11 The text has been found. 

The text found by HyperCard refe rs to finding text with the browse tool. 
Now you can cli ck the phrase to take you to that entry in t he Help stack. 
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• Click the finding text with phrase. 

HyperCard quickly takes you to the first card that explains how to use 
the Find command (see Figure 12-12). 

' oj File Edit Go i 

• Choose Find from the Go menu. Choosing Find 
displays the Message bOx (lf tt•s not already visible) 
and places the Find command in it. 

• Type the text you want to flnd. 

• Press the Return or Enter key to start searching the 
current stack for text you specified. 

(If you try this now, you11 search the Help stack. If 
you want to search another stack, fi rst go to that stack.) 

Ex! I 

Figure 12-12 Help on searching for text 

• When you finish reading this card, click on the right arrow. 

' oj File Edit Go i 

wes~e.lnthe.l 

the~you 
specify 

Searching for text (cont.) 

HyperCard takes you to the first card that contains all 
of the text you specified (even l! the words are in a 
different order), encloses the first word in a rectangle, 
and closes the Message box. 

• Press the Return or Enter key again to find the next 
occurrence. 

Command-clicking or Command-dragging across 
existing text replaces any selection in the Message bOx 
with that text. This ls handy for flndlng other 
occurrences of text you come across. 

Figure 12-13 Second card on searching for text 

You now see the second help card concerning searching for text. You 
know this is the end of the branch on th is topic because there is no righ t 
arrow showing. 

Depending on the amount of time you have and your interest in 
exploring the Help stack, you can continue looking through this 
informative stack. Read at least the Browse information at this point. 

- When you are ready to leave the Help stack, click the Exit tab on 
the bottom right of the card. 
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You are returned to th e Home c rd. If you were in a d ifferent stack and 
needed to look up something inlthe Help stack, you could choose Help 
from the Go menu o r type Command-?. Then when you were finished 
with the Help stack, clicking the Exit tab would return you exactly to 
where you were before you opened the Help stack. 

The Help stack is always available, easy to use, and full of useful 
information . If you want to learn to use HyperCard to its fullest, you 
should become familiar with the informati on in the Help stack and the 
HyperCard manual. 

SAVING YOUR WORK 

You do not have to save your work in HyperCard the way you do in other 
applications. HyperCard is designed to manage information that can 
change often, so it automatically saves all changes to the disk. These 
changes are saved almost as soon as they occu r, so you stand very little 
chance o f losing any changes you have made. 

There is a drawback to this method, however. lf you make a big change, 
involving several operations, that you really did not want to make, you 
may be forced to return the file to its original state using time
consuming methods. 

Also, don't forget that all disks fai l eventually. Even HyperCard's 
dedication to saving your work won' t save you if the d isk goes bad. 
Always make a backup of important info rmation on a different disk. 

USING HYPERCARD'S TOOLS 

Essential Elements 

Everything in HyperCard in some way in volves the use of cards, stacks, 
fields, and butto ns. Whether you are using a stack created by som eone 
else or one that you created, these are HyperCard's basic building b locks. 

Just as the Macintosh operating system is based o n the desktop metaphor, 
HyperCard bases everything on stacks of cards. 

Cards 

You can think of these cards as lyi ng o n a table starting at the left and 
extending to the right, or you aan think of them as being piled into a 
stack. Everything in HyperCard involves at least one card, and most 
stacks use many cards. Hype rC~rd has a max imum limit of 16,777,216 
cards, and a stack can be as large as 512 megabytes, so you shouldn't be 
too concerned about runnin g 1ut of room. 

Unlike a row of cards laid out o n a table or a stack of cards piled high o n 
' a tabl e, the cards in a HyperCard stack are arranged in a circula r fashion. 

When you reach the last card i a stack and tell HyperCard to go to the 
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next one, it starts over again with the first card. If you are at the first card 
in the stack and issue a Go Previous command, HyperCard will bring up 
the last card in the stack. 

A card has two layers. There is a background layer, which mo re than one 
card can share, and there is a card layer that belongs to that specific card 
only. Other ob jects can be located on one of these layers. 

If an object (painting, button, field, and so forth) is located o n t he 
background layer, any new cards created with the same background will 
have t his ob ject visible on them as well, and the object will have the 
same properties and be able to do the same thing o n all cards with 
that background . 

If an object is located on the card layer, it will be local to that card o nly, 
and if you create a new card with the same background, the object 
located on the card layer of the original card will not appear o n the 
new card. 

It is no t uncommo n for someone new to HyperCard to mistakenly place 
an object on the card layer when it should be o n the background layer. 
However, it is easy to cut the o bject from the card layer, switch to the 
background layer, and paste the object in to its proper layer. 

Stacks 

This stack of cards, whether you think of it as being located from left to 
righ t or top to bo ttom, has certain features that are common to all stacks. 

A stack may be composed of more than one card, as it usually is. A stack 
can even have multiple backgrounds, with each backgro und containing 
more than o ne card . The converse of th is is not t rue: a card cannot be 
in more than one background or stack. 

Regard less of how you picture a stack of cards, each card has a certain 
relationship to the o ther cards in the stack. For any given ca rd, except 
the top o r left-most o ne, there is a card that comes before it known as 
the previous card. When moving between cards in the same stack, th e 
left arrow means to go to the previous card . 

Likewise, for every ca rd (except the bottom or right-most o ne) t here is 
a next card . The right arrow takes you to the next card . 

Cards, by themselves, would not be very interesting, so HyperCard 
provides two other very important and usefu l objects. 

Fields 

A field is also known as a text field. It is an area on the card (either o n the 
background or the ca rd layer) tha t can hold editable text. All text in a 
field is limited to the same fo nt, size, and style in HyperCard version 1.2. 
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If a field is in the background layer, then it will appear on every card in 
that background. But unlike with pictures and buttons, each card can 
store different information in the fi eld . 

A fi eld located on the card layer only exists on that particular card, so 
it will not have varying contents among different cards. 

There can be a maximum of 32,767 fields on a single card (if they would 
fit), and each field can store up to 30,000 characters. The script 
associated with each field can be up to 30,000 characters, also. 

Buttons 

A button exists to carry out some type of action. You have already seen 
a number of buttons. Each icon on the Home card is a button that is 
linked to a particular card in a different stack. Other buttons, such as the 
left and right arrows, function the same on every card (although their 
actions can be customized). 

If you are working in the Authoring level, you can link a button to a 
different card. When you progress to scripting, you can create simple o r 
complex scripts for the button to follow when it is activated. 

Buttons in the background layer (known as background buttons) appear 
on every card in that background and have the same capabilities on each 
of those cards. 

Card buttons appear on one card only and are used for special purposes 
that apply specifically to that card (although they can affect other cards, 
stacks, and even applications and documents) . 

Links 

If you are in the Authoring o r Scripting level, you can establish links from 
an object to another object (such as a button to a card). This involves no 
programming. 

If you were to create a new button, you could double-click on the button 
(while you are using the button tool), and then tell HyperCard that you 
want to establish a link. A floating window appears and floats above 
everything else. You can go to another card o r even open a different 
stack and find a particular card, and then tell HyperCard to link to either 
the stack or the currently selested card. The next time you click the 
button using the browse tool, HyperCard wil l take you to the place you 
chose for the link. 
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Home Stack 

The Home stack is essential for HyperCard to operate. The first card, 
known as the Home card, contains a group of buttons that take you to 
the stacks distributed by Apple with HyperCard, as shown in Figure 12-
1. You are free to delete any buttons you don 't use and to add new 
buttons as you wish. In fact, if one card is not enough, you can add more 
Home cards to the stack (see Figure 12-14) and put additional buttons 
on the new cards. The button shown on the ca rd in Figure 12-14 
automatically opens Microsoft Word. 

' a File Edit Go Tools 

~Home Card~ 
Page 2 

Figure 12-14 Second Home card added to Home stack 

The next three cards of the Home stack are where HyperCard stores the 
paths it fo llows when looking for other stacks (see Figure 12-15), 
applications (see Figure 12-16), and documents (see Figure 12-17) . 

' a File Edit Go Tools 

:HyperCard St acks: 
:More Stacks: 
:My Stacks: 
:Help St<:~cks: 
: Ide<:~ St acks: 

Look tbr Stacks in: 

HyperCard & St<:~cks:More St acks: 
HyperC~:~rd Help:Help St acks: 
HyperCard ldeas:ldea Stacks: 
My Hard Disk:Star Trek Folder Two: 

., 

:~: 

Figure 12-15 Pathnames for finding other stacks 
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' 45 File Edit Go Tools Objects 

:Applications: 
:Ut ili ties: 

Look tbr Applications in: 

My Hard Disk:Appl ications Folder:Word Processing 
Folder:MS Word 4 Folder: 

Figure 12-16 Pathnames for finding applications 

' 45 File Edit Go Tools Objects 

:HyperCar d St acks: 
:Documents: 

Figure 12-17 Pathnames for finding documents 
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You don't have to do anything to any of these cards. Whenever you issue 
the command to open a stack, application, or document, HyperCard 
looks in the folders listed on the appropriate card. If the file being 
looked for isn't found in any of the listed folders, HyperCard puts up a 
standard dialog box for opening a file, allows you to find that file 
on the disk, and then opens it for you. HyperCard then adds the 
pathname to the appropriate file, so you won't have to show it where to 
look the next time. I 

If you change hard disks or reorganize your disk, you might want to erase 
the pathnames on these cards t at are no longer correct. 

User Levels 

The last card in the Home stack allows you to set certain preferences for 
how you like to use HyperCard, to tell it your name, and to choose a user 
level (see Figure 12-18). 
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Basic Tools 

r s File Edit Go Tools Object s 

User Preferences 

user Nome: Mllrshl! Szczepansk i 

~' 

User Leuel: 

QBrowslng 

Q Typlng 

Q Palnllng 

0 Ruthorlng 

®scripting 

,.:s)"-::-~n-;::.77 ;: ":~rs>j,: ,... 

0 TeHt Rrrows 

0 Power Keys 

0 Blind Typing 
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Figure 12-18 User Preferences card in Home stack 

just as the list of descriptions on the last several pages suggests, you can 
do many things with HyperCard. In fact, there are five levels of using 
this program, so that-as you learn more about the program-you can 
access more of its features. Beginners can use the program for Browsing 
information previously compiled by other authors. With a few minutes 
of practice, you can progress to Typing, which is the level that lets you 
change and add information . 

With a lit tle more practice you can progress to Painting, which gives you 
access to the bitmapped Painting tools. These tools work very similarly 
to the ones in MacPaint. 

When you feel like venturing into the world of creating your own stacks, 
you can choose theAuthoringuser level. Now you can create, copy, paste, 
and modify buttons and fields. You can create links from a button to a 
different card in the same stack or a different stack. 

If you want to explore Hyper Talk programming, you must set the level 
to Scripting. This h ighest level gives you access to everything HyperCard 
can do. As you learn to modify existing scripts and then to create 
your own, you will be able to fu lly rea lize t he power of t his 
remarkable application . 

HyperCard does not restrict you to starting with browsing and then 
progressing through the user levels in order. Many people use the 
authoring level before painting, and others paint before typing. You 
can go directly to the level you need for the job you are doing. 

Everything you do in HyperCard involves using one of four major types 
of tools. There are 3 General tools (browse, button, and field) and 15 
Painting tools. If you choose the authoring or scripting level, you have 
access to all18 tools. The painting level shows all 18 tools, but does not 
allow access to the button or field tool. In the browsing or typing levels, 
you have access to the browse tool only. 



Chapter 12: HyperCard 633 

The tools are shown in Figure 12 19, and a short description for each one 
follows. 

General ~ Browso 
Tools: :i:~:n 
Painting Tools: 

r-- ~ ---=-
[~J Selection p Lasso (I Pencil 
~ 77 "'"'--

,.t!l Brush Eraser "-.... Line 
-::-- f-- -, .. (g Spray D Rectangle 0 Rounded Rectangle 
~ f-- -
~ Bucket 0 Oval v Curve 
--':c- f-- -A Paint Text 0 Regular Polygon Cl Polygon 
=-= '-- -

Figure 12-19 Tools available in HyperCard 

General Tools 

All user levels provide access to the browse tool. The Painting level gives 
you access to the painting tools, and the Authoring and Scripting levels 
let you use the button and field tools. 

Browse Tool 

The browse tool is used to click buttons and to select and edit text. When 
not in a text field, it assumes the appearance of a hand as shown at left. 
It is the only tool that will activate a button, and it is used for navigating 
through a stack. 

When inside an unlocked text field, the pointer changes to an I-beam 
to indicate that you may use it to select and edit the text in the field or 
to add more text. 

Button Tool 

The button tool is used to create new buttons, to see existing buttons 
(even transparent ones), and to modify buttons if desired. 

The button tool is only available if the Authoring or Scripting level has 
been chosen. When you choose the button tool, all buttons on the card 
are surrounded by a thin rectangle. If you click a button with the button 
tool, the button's script is not activated. Instead, the button is selected 
and then is enclosed by a moving dotted line (sometimes referred to as 
"marching ants"). I 

You can create a new button by ~hoosing New Button from the Objects 
menu or by holding down the Command key and dragging the button 
tool diagonally to establish the position of the new button on the card 
or background. 
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To select an existing button, make sure you are using the button tool, 
then point to the button and click. 

If you want to place the button on the background so it will be available 
to all cards with that background, you must choose Background from 
the Edit menu (or press Command-B) and then create the new button. 
When you change to the background layer, the menu will have diagonal 
stripes around its outer edges (see Figure 12-20). 

Card layer: 

r a File Edit Go Tools Objects 

Background layer: 

Figure 12-20 Menu appearances for card layer and background layer 

You can move buttons to different locations and change their sizes. To 
move a button, first select it with the button tool, and then place the 
pointer anywhere inside the button (or exactly on one of the four edges 
except for a corner) and drag it to its new location. A selected button is 
resized by dragging any of its corners to make it larger or smaller. 

Buttons may be duplicated, copied, cut, cleared, and pasted. 

You duplicate a button by selecting it, holding down the Option key, 
and dragging the new copy to a different location. 

You copy a button by selecting it and then choosing Copy Button from 
the Edit menu (or typing Command-C). 

A button may be cut by selecting it and then choosing Cut Button from 
the Edit menu (or typing Command-X). 

Clear a button by selecting it and then choosing Clear Button from the 
Edit menu (or pressing the Backspace or Delete or Clear key). 

Paste a button that has been previously cut or copied by choosing Paste 
Button from the Ed it menu (or typing Command-V). A button that is 
pasted will be in the same locati on from which it was copied or cut. 

If you want more information about a button, or if you want to change 
its style, show its name, link it to something else, or modify its script, 
select the button and then choose Button Info from the Objects menu 
(or double-click the button). 

For example, if you choose the button tool and then click on the right 
arrow button on the Home card, HyperCard presents a dialog box 
similar to the one shown in Figure 12-21. 
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Figure 12-21 Button Info dialog box 
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When you chose the button tool, each button on the card was outlined 
to show its size and location. Double-clicking on the right arrow button 
presented the dialog box that allows you to specify the appearance of the 
button, its name, and some facts about how it operates. 

If you are using the browse tool and want to know where all the buttons 
on a card are located, and you want to use one of the buttons rather than 
modify it, hold down the Option and Command keys simultaneously 
and all the buttons will be outlined in gray. Then when you release the 
Command and Option keys, you can click the button you want to use. 

Field Tool 

The field tool is used to create new fi elds, to see existing fields (even 
I 

transparent ones), and to modify fields if desired. 

The field tool is only available if you have chosen the Authoring or 
Scripting level. When you choose the field tool, all fields on the card are 
surrounded by a thin rectangle.lf you click on a field with the field tool, 
the field does not allow you to enter or modify text. Instead, it is selected 
and then is enclosed by a moving dotted line. 

You can create a new field by choosing New Field from the Objects menu 
or by holding down the Command key and dragging the field tool 
diagonally to establish the po ition of the new field on the card or 
background. 

Notice that the Edit menu changes depending on the tool you are 
currently using. If you are using the button tool, the Edit menu says New 
Button, but if you are using thJ field tool it says New Field. 

I 
A field is designed to hold text, and the number of lines of text that a field 
can hold is determined by the font, size, and style chosen for that field. 
HyperCard allows you to chodse only one font, size, and style for a 
particular field. 
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Creating a field is done in the same manner as creating a button, except 
that you use the Field tool. 

Thought must go into the placement of a field. If you are creating a field 
that will be seen on several cards, and each card will hold similar, but 
different, information, then the field must be placed on the background. 
If the information in the field is for a particular card and does not 
correspond to similar information on other cards in the same stack, the 
field should be placed on the card layer. 

Whenever you want to place an ob ject, in this case a field, on the 
background layer you must first choose Background from the Edit menu. 

Refer to Figure 12-20 if you want a reminder about how the menus look 
when the card layer or the background layer is chosen. 

The most common mistake made when creating a new field is putting 
it on the card layer when it should have been on the background layer. 
The easiest way to spot this problem is to go to another card. If the field 
is also on this card but the contents are blank, the field is on the 
background. If the field disappears, it was placed on the card layer. 

If you put a field on the wrong layer, use the field tool to select the field, 
cut it, change to the proper layer, and paste the field back into position. 

Selecting, duplicating, cutting, copying, clearing, and pasting fields are 
performed using the same procedures that are used for buttons. The only 
difference is that you must be using the field tool and it affects only 
fields. (See the previous section, 11Buttons Tool. ") 

Unlike deleting a button, you can lose much valuable information if you delete 
a background text field. Since a single background field can contain information 
on hundreds of cards, deleting the field would delete all the information stored 
on all those cards. HyperCard will ask you to confirm that you want to do this, 
and if you tell it to continue, there is no way to undo the cut or clear operation. 
If you actually do this, HyperCard's automatic save feature quickly makes the 
changes to the stack on the disk. The only way to recover from this mistake 
would be to reload a backup file if you recently made one. 

just as you can get information about a button, you can get inform ation 
about a field. The dialog box that appears when you choose Field Info 
from the Objects menu (or double-click on a fi eld with the field tool) 
allows you to set the style of the field, give it a name, lock the text so 
nobody can change it, unlock a field so it can be modified, choose the 
text characteristics for the fi eld, and even modify its script. 

For example, we prepared a Glossary stack (wh ich you will use in 
Project 1) that lists common terms and definitions associated with using 
a Macintosh. If you were to open the Glossary stack, choose the field 
tool, and double-click on the Definition field, you would see the Field 
Info dialog box as shown in Figure 12-22. 
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Figure 12-22 field In fo dialog box in Glossary stack 
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Projects 2 and 3 introduce you to usi ng the button and field tools to 
create, modify, cut, paste, and further customize both fields and 
buttons. 

Painting Tools 

just as with buttons and fields, the Painting tools allow you to paint on 
the background layer or the card layer. Any picture shown on a 
background layer appears on all cards that share t hat background. A 
picture on a card layer is seen only on that particu lar card. 

The picture on the card layer is on top of the background picture and can 
obscure portions or all of the background. Painting over a field or button 
does not deactivate it, but on ly hides it from view. 

HyperCard's Painting tools work simila rly to the same tools in MacPain t, 
but since it is a newer program and is written for computers wi th more 
memory, HyperCard extends the power of some of the tools over what 
is available in MacPaint. 

Both the Tools and Patterns m enus are known as tear-off menus and 
may be converted fro m a menu into a palette (see Figure 12-23). These 
menus are changed into palettes by dragging below the bottom of the 
menu. When you pass the bottom of the menu, a gray outline of the 
palette appears. Drag the palette's outline to where you wa nt it and 
release the mouse button. The palette will "float" on top of everyth ing 
else on the screen. If you are about to do a lot of painting, it is often 
beneficial to tear off the menus and select the tools and patterns di rectly 
from the pa lettes. 
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Figure 12-23 The Tools and Patterns palettes 

Selection Tool 

The selection tool is used to select a rectangular portion of a picture. 

Once you have selected something, it can be copied, cut, cleared, 
resized, rotated, flipped, inverted, outlined, darkened, lightened, and 
moved on the screen. 

If you hold down the Option key while selecting an object with this tool, 
the tool converts into a lasso and selects only the object, not the 
surrounding white space. 

When you move the pointer into a selected area, it changes from the 
crosshairs pointer into an arrow pointer. This signifies that you can 
now drag the object around on the screen . 

Double-clicking on the selection tool selects the entire card picture. 

Lasso 

The lasso is used to select an irregular shaped area of a picture. 

Once something is selected, it can be copied, cut, cleared, and moved on 
the screen. The lasso is similar to the selecti on tool, but when you draw 
a loop around the object(s) you want to select, it tightens around the 
object and only affects it and not the white space surrounding it. 

When you move the pointer into a selected area, it changes from the 
lasso into an arrow pointer. This signifies that you can now drag the 
object around on the screen . 
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Brush Tool 

The brush tool is used to paint ith the currently selected pattern. 

The shape of the brush can be chan ged by double-clicking on the brush 
tool after the Tools menu has been "torn off" and mnverted into a 
palette (see Figure 12-24). 

j File Edit Go Tools Point Options Potterns 

Address cards, Rotary cards 

. Q , 

Figure 12-24 Dialog box for choosing new brush shape and size 

The brush can be constrained to paint in a straight (horizontal or 
vertical) line by holding down the Shift key (or locking the Caps Lock 
key in the down position) while you paint . 

Holding down the Command key while you paint with the brush 
converts it into an eraser with the current brush shape. 

Spray Tool 

The spray tool allows you to spray the current pattern onto the picture. 
By moving the spray tool back and forth over an area, you add more of 
the pattern to the picture. 

Holding down the Shift key (or the Caps Lock key) while you spray 
constrains the spray tool to horizontal or vertical movements. 

Pressing the Command key while you spray converts it into a spray 
eraser. 

Bucket Tool I 
The bucket tool is used to pour the current pattern into a bounded area. 
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If the area is not bounded, o r if there are any ho les (even 1 pixel wide) 
in the boundary, the paint will spill into the rest of the ca rd. 

To recover from a "paint spill," choose Undo from the Edit menu 
immediately after making the mistake. (I f you do anything else, the 
Undo command will not correct the problem.) Then find and correct the 
hole in the boundary and try again. Sometimes it is easier to repair the 
hole using the pencil tool and Fat Bits (see the section on the pencil 
tool). 

You can change black areas to other patterns with the bucket tool. ln this 
case the edge of the black area is the bounda ry; the paint will not spi ll 
into surrounding white areas. 

You cannot use the bucket tool to change the pattern in a filled area. To 
do this, use the selectio n tool or the lasso and choose Fill from the 
Paint menu. 

If you double-click on the bucket tool in the palette, you make the 
Patterns palette alternately appear o r disappear. 

Paint Text Tool 

The paint text tool allows you to add text to your drawing, but painted 
text is not editable after it has been deselected by clicking somewhere 
else with the paint text tool or by selecting a different tool. When the 
text is deselected, it is converted into a bitmapped picture of the text and 
is no longer editable with the paint text tool. At that point, the only way 
to change the text is to erase it and re-enter the text as you want it. 

If the paint text has not been deselected, you can change any 
typographical errors by backspacing to the error and retyping the rest of 
the text. You can also change the font, size, style, line height, and 
alignment of the text while it is still selected. 

When typing text, you can press the Return key to start a new line under 
the current line. This will not deselect the previous line. The new line 
will be aligned under the previous line depending upon whether you 
have selected left, center, or righ t alignment. Left alignment is t he 
default va lue. 

If you want to change any of the text characteristics, choose Text 
Style from the Edit menu (or double-click on the pain t text tool). 
Figure 12-25 shows the resulting Text Style dialog box, and all of the 
settings represent the defaults. 
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Figure 12-25 Text Style dialog box 
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If you have just typed and deselected some text and wish to move it to 
a new position, type Command-S and HyperCard will select it for you. 

Paint text is not editable, nor can HyperCard's Find command locate 
text that was painted. If you want to modify text or be able to have 
HyperCard find it for you, create a field and enter the text there. 

Eraser Tool 

The eraser tool is used to eliminate portions of the picture. Erasing a 
portion of a card picture exposes the background picture underneath, 
which can be somewhat disconcerting. Instead of erasing parts of a card 
picture, you may find it easier to paint over someth ing using the brush 
tool and a white pa ttern, using the brush tool and the Command key to 
make the brush in to a shaped eraser, or using the eraser tool and the 
Command key, wh ich makes the eraser paint with white (like using 
White-Out). 

If you want to erase an entire card picture, double-click on the eraser tool 
in the Tools palette. 

Rectangle Tool 

The rectangle tool is used to draw rectangles and squares. 

To draw a rectangle, press the mouse button when the pointer is where 
you want one of the corners, and then drag the mouse to the diagonally 
opposite corner and release the button when the corner is where you 
want it. 

Rectangles may be drawn centered around a point by choosing Draw 
Centered from the Options menu. 
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Rectangles may be drawn filled with the current pattern by choosing 
Draw Filled from the Options menu (or by double-clicking on the 
rectangle tool in the palette) . 

You can change the line thickness of the rectangle tool by choosing Line 
Size from the Options menu (or by double-clicking on the line tool in 
the palette). 

To draw a rectangle with the border lines in the current pattern, hold 
down the Option key as you draw the rectangle. 

To draw a bo rderless rectangle, choose Draw Filled from the Option s 
menu and draw the rectangle with the Option key held down . 

To constrain the rectangle to be a square, h old down the Shift key (or 
Caps Lock key) as you draw. 

Oval Tool 

The oval tool works like the rectangle tool, except that it draws ovals that 
fit inside the rectangle you create, instead of drawing the rectangle itself. 

All the options listed for the rectangle tool work with the oval tool, 
except that the Shi ft key (or Caps Lock key) constrains it to drawing a 
circle. 

Regular Polygon Tool 

The regular polygon tool is used to easily create polygons that have regular 
sides and angles. 

Unlike the other tools, the regular polygon tool always draws from the 
center outwa rd (just as if you had chosen Draw Centered from the 
Options menu). It makes no difference whether Draw Centered is 
selected o r not. 

Also unlike the other shape tools, the regular polygon tool allows you 
to rotate a shape before it is fi xed into place. While you are drawing a 
shape with this tool, you should n ormally drag horizon ta lly to the right. 
If you move the mouse to any other posit ion, the shape will rotate. The 
rotation can be constrained to 15° increments by ho lding down the 
Shift key (or Caps Lock key). 

Several shapes are available, and you can select one by double-clicking 
on t he regular polygon too l in the Tools pale tte and then cl icking on the 
polygon of your choice in the resulting dialog box (see Figure 12-26). 
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Figure 12-26 Choosing a regular polygon shape 

Pencil Tool 

The pencil tool is used to modify individual pixels in a painting. It can be 
used to wri te like a pencil or to erase like one. 

If the current pixel is white, the pencil makes it black, and vice versa. 

The pencil tool can be constrained to draw only horizontal or vertical 
lines by holding down the Shift key (or Caps Lock key) while you d raw. 

Double-clicking on the pencil tool when it is in the Tools palette 
magnifies the screen eight times and takes you in to Fat Bits so you can 
edit ind ividual pixels (see Figure 12-27). The floating window shows the 
actual-size view of the picture being edited . 

r s Fil e Edit Go Tools Point Options Patterns 

• •• • • • • • • •• • • • • ••• •• 
•• • 

•• • 

Figure 12-27 Editing with the Pencil tool in Fat Bits 
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Line Tool 

The line tool is used to draw lines from one point on the screen to 
another. Anchor one end of the line by pressing where you want it to 
start, and then (while continuing to hold the mouse button down) 
move the mouse to where you want the line to end. The line will 
continue to be displayed while you move the mouse. When you have 
the line where you want it, release the mouse button to anchor the 
second end of the line. 

You can constrain the line to 15° increments by holding down the Shift 
key (or Caps Lock key) while you draw. 

Double-clicking on the line tool in the palette allows you to change the 
thickness of the line (see Figure 12-28). 

a File Edit Go Tools Point Options Patterns 

Address cards, Rotary cards 

Figure 12-28 Changing the thickness of the line 

Rounded Rectangle Tool 

The rounded rectangle tool works like the rectangle tool, except that it 
draws rectangles with rounded corners instead of right-angle corners. 

All the options listed for the rectangle tool work with the rounded 
rectangle tool. 

Curve Tool 

Use the curve tool to draw freehand curved shapes. 

When Draw Filled is not selected, the curve tool works similarly to the 
pencil tool. If Draw Filled is selected, the curve tool automatically 
connects the starting position of the curve to where you release the 
mouse button at the end of the curve with a straight line. The area 
bounded by the curve is then filled with the current pattern. 
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A simple way to toggle Draw Fi led on or off is to double-click on the 
curve tool. 

You can modify the width of the line drawn by the curve tool by 
choosing Line Size from the OJ?tions menu (or by double-clicking on 
the line tool). 

Holding down the Option key while you draw with the curve tool causes 
the curve to be drawn using the current pattern. 

Polygon Tool 

The polygon tool is used to create multi-sided objects with irregular 
shapes. This is the only shape tool that works as it does. With the other 
shape tools, you hold down the mouse button until you have comple ted 
drawing the object and then release it when the position and size are 
correct. 

The polygon tool works on the principle of drawing a shape with 
multiple straight lines connected by several vertices (intersections) . 

To draw a polygon, click where you want the first line to start. Then 
continue clicking at the location of each of the subsequent vertices. This 
is like tracing around the edge of the object with a tool that draws 
multiple connected lines. 

Drawing the polygon is completed by double-clicking at the last vertex. 
This can be at the same point as the sta rting position or at a different 
location. If Draw Filled is checked, HyperCard automatically connects 
the starting and ending points with a line and fills the resulting polygon 
with the current pattern. 

Holding down the Option key while d rawing a polygon draws the 
border in the currently selected pattern. 

You can change polygon line widths by double-clicking on the line tool 
and choosing the li!le width you prefer. 

Holding down the Shift key (or Caps Lock key) constrains the lines that 
make up the polygon to 15° angles. 

As you get more involved with HyperCard, you will fi nd that you need 
to do something and there is no button available for that specific 
purpose. HyperCard allows you to create your own buttons, and you can 
give the button any icon that is currently available in the Home stack. 

When you create a new button you can tell HyperCard that you want 
the button to have an icon, and you will be presented with the scrolling 
list of icons shown in Figure 12-29. Icons are one of the types of resources 
that HyperCard lets you use in your stacks. You can also add sounds, 
additional art, and even programming code to extend the commands 
available in HyperCard. 
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Figure 12-29 Icon resources for buttons 

Idea Stacks 

HyperCard is distri buted with four idea stacks: Art Ideas, Button Ideas, Card 
Ideas, and Stack Ideas. 

To open one of these idea stacks, you need only to click the appropriate 
button on the Horne card. 

If you look at the Art Ideas stack, you see the index card first (see Figure 
12-30). This card has th ree columns of buttons. Clicking one of these 
buttons takes you to the card linked to that button. There are also four 
other buttons just to t he right of the stack's title. 

D lndex1 
~ ¢19 

Click on. o.n y word or picture to ,o to tha. t co.rd . 

G:;J Address cards, Rotary ... 

W Animals, Wildlif~, Fish •. 

~Arrows 

~ Books,Artiolos,Nows .. . 

dc, Business, Or g. Charts .. . 

II) Cal~ndars, Datobooks_ 

!01 Disks, Disbtte Library 

CJ Filing cards, Later al.. . .ij Macintosh, Apple ... 

thll Font- Cairo El_ Miscellaneous 1. 

thll Font - Mobile El_ Mise• llaneous 2. 

~ Geography , Maps $ Money ,Credit, Calc ... 

~ Holidays, Seasons ) Music, Rocords, Tapes_ 

Jii'3. Home, Household Activ_ ~ Notes, Notepad, Memos _ 

B Letters, Envelopes_ (_3. Poop I•, Humans 

Figure 12-30 First index card in Art Ideas stack 
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The Tell Me .. . button is usually li ked to info rmation or help concerning 
the current stack or card. ln thi case, clicking on the icon takes you to 
the card shown in Figure 12-31. This card tells you about the Art Ideas 
stack. Clicking the Index button takes you back to the first index card. 
You can also choose Back from the Go menu. 

About Art Ideas ... 

This stack is made up of cl ip :~rt for you to cut 
and paste into your own stacl's. 

Cl ick on t he subject you want in the Index to get 
t o that art or search for the subject you want 
using t he message box. 

Figure 12-31 Information card for Art Ideas stack 

The Home button takes you back to the Home card of the Home stack. 

The left arrow is the Previous button and is used to go to the previous 
card. If the current card is not the top card on the list, the left arrow takes 
you to the card just before the current one. You can think of the previous 
card as being either to the left of or just above the current card. Clicking 
on the left arrow takes you to the same card (in this case) as pressing the 
Tell Me ... button. \ 

The right arrow is the Next button and takes you to the next card . If the 
current card is not the bottom card of the stack, it usually takes you to 
the card just after t he current card. Clicking on the right arrow in this 
case takes you to the second index card of the Art Ideas stack (see 
Figure 12-32) . 
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1ii' Telephones, Dialing ... 
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Figure 12-32 Second index card of the Art Ideas stack 

., 

Now that you know how to navigate through this stack, let 's look at one 
of the cards in the Art Ideas stack. If you click the button labelled 
Macintosh, Apple ... you go to the card shown in Figure 12-33. 

* File Edit Go Tool s Objec ts 

M11cintosh, Apple, Computers, Printers 

Figure 12-33 Macintosh clip art in Art Ideas stack 

This card contains a number of pictures of Macintosh computers, 
printers, LocalTalk cables, connectors, and Apple Computer logos. All 
of this art can be cop ied from the stack and pasted into your 
stacks wheneve r you need a picture of a Macintosh computer. (Don 't 
fo rget, however, that the stack is copyrighted and you have to have 
Apple's permission to distribute the art in a form that others can copy 
and reuse.) 
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You could now click the Hom button and return to the Home card. 
Then, if you click the button labelled Card Ideas, you go to the index 
card shown in Figure 12-34. 

,.. 

~ 
Address File 

~ 
rmmB 

Bookshelves US Stat e map US Zip code map US Time zones 

Metric Equiv . Stationery Guide Baby s itter 

I Click on small car d picture to go to that card.l 

Figure 12-34 Index card to Ca rd Ideas stack 

., 

This stack has a number of ideas for cards that can be included in your 
stacks as you create them . For instance, suppose you were taking a 
chemistry class and wanted to keep your notes in a HyperCard stack for 
reviewing before a test. You might decide that you would like a quick 
reference to metric weights and measurements. You could add this to 
your stack by clicking the button labelled Metric Equiv., which would 
take you to the card shown in Figure 12-35. 

,.. a File Edit Go Tools Objects 
'@$':§;!; ;:~:" >: ~ ,; ;' . :.;; ;:J.\0''' w ., "' .J%1;· 

~ I I I I I I ,!, I I I ' I.! I It I 
Equivalents 

METRIC EQU IVALENTS FOR LENGTH 
I cent imeter ............. 0 .394 inches 
I inch .. .. ... ........ 2.540 cent imeter s 
I meter .. .. ........ .... , ....... 3 .281 feet 
1 foot ... .. ... .. ... ...... , ... 0 .3 .5 meters 
I meter ···············+ 1 .0936 yards 
1 yard .... .. ... ........ .. 0 .9144 me ter s 
I kilometer .. ..... ... . ~ .. .. 0 .6214 mile 
1 mile ... ...... ... . . 1 .6r 4 kilometers 

METRIC EQUIVALENfS FOR SQUARES 
1 sq . centimeter .. T 0 .1550 sq. in. 
1 sq. inch .. .. 6 .452 t q. centimeters 
1 sq . meter ........... 0 .764 sq. feet 
I sq. foo\.. ..... 0 .0 9 90 sq. meters 
1 sq. meter ........... 196 sq. yards 
1 sq. yard ........ O.B 6 1 sq. meter·s 
1 sq. kilometer ...... 0.386 sq. mile 
1 s q. mile ........ 2 .5 s q. kilometers 

METRIC EQUIVALENTS FOR VOLUME 
1 cubic centimeter ..... 0 .061 cu. in. 
1 cu. inch .... . 16.39 cu. cent imeter s 
I cu.meter ............ 35 .3 14cu. feet 
I cu. foot .. ...... 0 .0 2832 cu. meters 
I cu. meter . .. . ...... . 1 .308 cu. yards 
I cu. yard ......... 0 .7646 cu. meters 
I liter (dry) .. ... ... ... ... .. 0 .908 quart 
I quart (dry ) . ... .......... I .! 01 liters 
I liter (liquid) ... ... ... I .0567 quarts 
1 quart (liquid) ......... 0 .9463 liters 
I US gallon (1iquid) ..... . 3 .785 liters 
1 Imperia l gal. (liquid) .4 .546 liters 
I liter ( liquid) ...... 0 .264 US gallon 
I liter (liquid) . .. 0 .220 Imperial gal. 

METRIC EQUIVALENTS FOR WEIGHT 
1 gr am ................... 0 .03527 ounce 
I ounce ... ................... 28.35 grams 
I kilogram .............. 2 .20 46 pounds 
I pound .............. 0.45 36 kilogr ams 
I metr ic ton .... 0 .98421 English ton 
I English ton ........ l .0 16 metric ton 

Figure 12-35 Metric Equivale ~ts card in Card Ideas stack 

., 
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Then, all you have to do iscopy thecard, go back to your chemistry notes 
stack, and paste the Metric Equivalents card into the stack. 

You could go to the card shown in Figure 12-36, the Button Ideas index 
card, by clicking on the Button Ideas icon on the Home card. This stack 
includes seven cards from which you can copy buttons. Most of these 
buttons have already been programmed to perform a function, and 
when you copy the button and paste it into your stack it will remember 
h ow to do what it was programmed to do in the Button Ideas stack. This 
is a great time saver and lets you use buttons in your stacks even if you 
don't yet know how to write scripts in HyperTalk. 

15 File Edit Go Tools 

Click on M'!\1 'W'Ot'd or pich.r• to 90 to tNt f»rd. 

~~~ ~~,., Fi r st, Previous, Next, Last, Return 

+ • • + +' Other Arrows 

~Text 

<$1 0 liiD' Icons 

!!ill c;;J ii Home, Business 

P ? About, Help, Informati on 

~ e c;. ~ Miscellaneous 

Figure 12-36 Index card for Button Ideas stack 

If you click on the Stack Ideas button on the Home card, you go to the 
card shown in figure 12-3 7. This is the first of four index cards in this 
stack. 

., 

~ 
Phone Mess 

DJ~LI:JJ 
Daily List Daily Cal 1 Daily Cal 2 

LEI] 
Weekly Ca13 Monthly Call Memo Notepad Postlettes Hand car d 

Click on a picture to go to that card 

Figure 12-37 Index card for Stack Ideas stack 
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The thi rd index card is shown i I Figure 12-38. 

,.. 

Dis k labels 

~ 
~ 

Geneology 

Cassette Tape Smm Video 

Art Card 1 Border· 1 

Click on a picture to go to that card 

VHS Library Ideas 

CJGJ 
Border 3 Computer paper 

Figure 12-38 Third index card for Stack Ideas stack 
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If you click the lower right button named "Computer paper," you go to 
the card shown in Figure 12-39, which you will use as a starting point 
in Project 3 to hold your class notes. 

,. C File Edit Go Tools Objects I 
~; ' . 

o ! 
0 1 My home computer sits 1dly in the corner. How cM 1 

0 
i modify it so 1t will brew a decent cup of coffee? 

~ I 
:\ 
~V i 
@i 

Chances ere you're not looking et e horne computer s1tt1ng 
idle In the corner , but a coffee maker. Today's modern co ffee 
makers do bear e strong resemblance to computers, and you're 
probably not the first confused user to mistake one for the 
other. A good experi ment to establish the identity of the 
appliance in the corner invol ves flllin~ the basket just under 
the top wi th coff ee grounds, then powiing cold water mto the 
grill on top. I f the fuses blow end you!end up w1th a floppy 
disk covered with co ffee grounds, you~re on the wrong track. 
But If, moments later , you f ind yourself enjoymg e fresh 
brewed cup of coffee, well then, my hunch was correct. Good 
luck! 

el 
o j 
® i 
Gd 
o i 
0 I ~ <D19860uok's Br••lh M~slor~ Thulro 

Figure 12-39 The "Computer paper" card 

Of course, coffee has little to do 'lith chemistry (except for t he night just 
before the test), so you could ±copy only the background , which also 
contains the fou r buttons sho n. You could then add the necessary 
components fo r keeping your c emistry notes organized. 

I 
This card introduces a new icon . The Return button takes you back to 
a previously selected card. You will make use of this button in many 
stacks. 
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Utilities 

Part V: Information Management 

In this short description of the ideas stacks you have been introduced to 
some of the ways in which HyperCard's authors h ave made it easier for 
you to construct your own stacks and to personalize and customize 
stacks you get from others. 

One of the main reasons that you can put HyperCard to work for you, 
even if you don't know anything about scripting in HyperTalk, is that 
the ideas stacks include many cards, buttons, and fields that are already 
pre-scripted and that can be used directly in your stacks. 

HyperCard is distributed with several utility stacks that you might find 
to be useful. 

Address Stack 

The Address stack is designed to work similarly to a rotary card file. You 
can store names and addresses in this stack (see Figure 12-40). If you 
need to keep multiple name and address lists you can make several 
copies of this stack and keep only the names you want in each stack. 

I'" 
Do vi o o gborn 
2 1 19 Runnymede St 
Tempe, Arlzono 

1r (602)555-6692 

Figure 12-40 Address stack 

The Address stack also has the advantage of being linked to the other 
personal stacks, such as the calendar, phone dialing, and to-do lists. If 
you want, you can link any of these stacks to other stacks, including the 
ones you create. 

Calendar 

HyperCard includes several types of calendars. There is already a 
Calendar stack (see Figure 12-41) linked to the Address stack, and Stack 
Ideas offers several additional calendars from which to choose. 
Additionally, you can modify and customize any of these stacks to suit 
yourself and any special needs you might have. 
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* File Edit Go Tools Objects 

1991 June week 25 'It c:o~ m ~rn 
Mon 17 Thu 20 

-----------

Tue 18 Pri 21 

Wed 19 Sa,t 22 Sun 23 

----·-----
1(1)-----· 

Figure 12-41 Calendar stack 

In addition to having a calendar to note future events you must 
remember, the Calendar stack includes a to-do list(see Figure 12-42). You 
can add, modify, or delete any items on your list. If two pages are not 
enough, you can add as many as you wish. You can even keep separate 
to-do lists for personal, business, civic, and other needs. 

r • File Edit Go Tools Objects 

To Do: 

::J::::::::=::::::::::::=:~:=~~== :=~======~~ 

. ..... .J ...... -------- -- ·- .. ·----- ·---··- ·--

:::::::i====--=--==:======== 
·-------.. ----·----

....... ;------·-------______ M ________ _ 

;-------·-·--

I :::::::::::::::=====--==--= 
-~----------- ---·----==---=---=== I Q ~ : 

Figure 12-42 To-do list in the Calendar stack 

Phone Dialing 

Your Address stack will probabit contain many phone numbers, and 
HyperCard provides a nice feature for dialing them for you. Click on the 
phone icon, and HyperCard automatically dials the number. 

In addition to dialing the numders in your Address stack, HyperCard 
provides a Phone stack that allow~ you to customize how the dialing will 
be done, and it includes the area codes for all of the United States and 
Canada. 
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The Phone stack can dial a phone three ways: by creating the phone's 
touch -tone sounds through the computer's speaker (not very reliable), 
by digital tone dialing through a modem, or by rotary pulse dialing 
through a modem. It allows you to enter the local phone prefixes and 
uses th em to determine if the call is a long d istance or local call. It is even 
smart enough to get an outside line or make an international call. 

You can set your preferences and local calling information directly on 
the first page of the Phone stack (see Figure 12-43). 

Click h•r• to dial 

111111 

®Speaker (tone dialing) 
0 Modem (tone dialing ) 
0 Modem (pulse dialing) 

5:45AM 

local Area Code: .. 1Q.1 ............ . 

Ente r your local prefixes: 

Outside line: 
Toll cell : .! .................... .. 
Long distance: .. !... .................. . 
International: .. 9J .. L ............ .. 

............ X-..................... _ .................................................................................................................................................... _ .. ___ ...... -........ . 

Figure 12-43 Phone stack 

If you click the Area Codes button, you will be presented with a stack of 
area codes, and the Message box will have the Find command already 
entered with the insertion point located between the quotation marks. 
To find an area code for a location, type in the name (or partof thename) 
and HyperCard will find it if it is in the stack. It will find all states and 
provinces and most larger cities. 

If this stack does not contain the places you need to call, search by state 
or closest city and add the name of the town to the appropriate card. Of 
course, you are not restricted to just adding towns to the Phone stack. 
You can also add names of friends and relatives to the appropriate cards 
and can tell the time difference, nearest cities to visit, or whatever you 
can think of that would work here. Once you get this stack it is yours to 
customize as you want. 

If you want to find the area codes for Arizona, for example, all you 
have to do is enter the state's name in the Message box and press the 
Return key. 

You can see (in Figure 12-44) that HyperCard found the appropriate card 
(which has h ad some towns added). All of Arizona has a 602 area code. 
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Phoenix, Flagstaff, Tucson, Tempe, Mesa, Apache Junction 
For all locations in this region, dial 1-602-

find "Arizona" 

Figure 12-44 Area codes in Phone Stack 
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This completes the overview of HyperCard. In the projects that fo llow, 
you will learn to use some of HyperCard's many powerful-yet 
surprisingly easy-to-use-features for yourself. 

Project 1: Using an Existing Stack 

In this project, you will browse through the Glossary stack that was 
developed for use with this book. 

When you complete this project you will know the major concepts and 
conventions used in browsing through a stack. You will learn to use the 
Find command, to use the Message box, and how to navigate through 
dynamic links in the stack. 

One of the tasks associated with writing a technical book is producing 
a glossary of terms used in the book. A glossary for this type of book 
contains terms relating to computers in general, the Macintosh 
specifically, desktop publishing, Word processing, graphics, information 
management, spreadsheets, and HyperCard. 

Since we used HyperCard to coll1te and sort this information and then 
export it to Word to create a tlxt glossary, we thought it would be 
interesting to demonstrate the pynamic (and some of the graphics) 
features of HyperCard. We sprue d up the stack a little and included it 
on the Macintosh Journey Projects disk. 

If you completed Project 1 in Chapter 1, you have already copied the 
Glossary stack onto your data disk. If not, you need to copy all three 
HyperCard stacks from the Projects disk onto your data disk. 
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~ -Q .. Quit HyperCard by choosing Quit HyperCard from the File menu. 

• If you haven't already done so, copy the Glossary stack onto your 
data disk. 

• Restart HyperCard by double-clicking on the Glossary stack's icon. 

Starting HyperCard by double-clicking on a stack icon bypasses the 
Home card and causes the stack you double-clicked to be loaded (see 
Figure 12-45). 

Figure 12-45 The first card containing terms and definitions 

The card contains four fields, noted below. 

• Term Contains a word or phrase used as a glossary 
entry 

• Definition Contains a definition and possibly a short 
discussion about the term 

• Additional Notes Mostly used to inform you when a card 
contains an explanatory pictu re 

• See also Contains dynamic links to related terms. If 
you click one of the terms you are taken to a 
card containing that term. 

The background for this card contains nine buttons, some of which are 
hidden at times depending on your actions. 

• Home 

• Show Picture 

Shows a closing card, closes the stack, and 
goes to the Home card 

Shows the picture that is hidden on some of 
the cards. If the Additional Notes field contains 
"See the Picture" then you can cl ick on this 
button to show it. 
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• Hide Picture 

• Previous 

• Sort 

• Find 

• Next 

• Return 

• Tell Me 

657 

Hides he picture 

Goes to the previous card and automatically 
hides the picture before leaving the current 
card. If you click on the left arrow while on 
the first card, it shows you the last card. 

Sorts all of the cards on the Terms and 
Definitions background alphabetically by the 
contents of the Term field. This is available so 
you ca~ extend the glossary by adding more 
terms.j ~licking Sort then re-sorts the cards 
very quickly so you can look through them in 
alphabetical order. 

First determines if you want to find a word or 
phrase anywhere on a card or just in the Term 
field. When you answer this question, it lets 
you enter the word or phrase, and then places 
the entire Find command into the Message 
box and finds the first occurrence if it is in the 
stack. To find any subsequent occurrences, 
press the Return key. When you are done 
with this Find command, close the Message 
box by clicking in its close box. 

Goes to the next card and automatically 
hides the picture before leaving the current 
card. If you click on the right arrow while on 
the last card, it shows you the first card. 

If you click on a term in the See also field, the 
Return button appears so you can return to 
the ca(d from which you jumped. 

Displays the copyright notice and authors' 
names. 

As you can see on the first card (see Figure 12-45), it contains the term 
"acronym ", a definition of the term, and some examples. The Additional 
Notes field of this card is empty, but the See also field contains several 
items that are acronyms, which also appear as terms in the stack. 

NAVIGATING THROUGH DYNAMIC LINKS 

The first term in the See also fielb is "ASCII". You can see the card that 
contains its definition by clicki~g the word with the browse tool. The 
See also field contains locked texj which means that it alone, of the four 
text fields, contains informatio'( that should not be changed. It also 
contains a short script that remetpbers that you started on this card and 
then takes you to the card contcti ning the term that you clicked. 

Let's see how the dynamic links in the See also field operate. 

.. Click ASCII in the See also field, as shown in Figure 12-46. 
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Glossary Stack 

Figure 12-46 jumping to a related term 

When you jump to a related term, a Return arrow appears, and you can 
use it to return to the original term. This lin kage supports jumping to a 
series of terms through the See also fi eld. Cli cking on the Return button 
will take you back through the series of cards you followed until you 
reach the o riginal one. If you click the find, left arrow, or right arrow 
buttons, this linkage is dissolved and the Return button disappears. 

When you click the word in the See also fie ld, HyperCard takes you 
directly to the card that contains 11 ASCII" in the Term field. In add ition 
to the definitio n and other information about 11 ASCII", th is card 
contains "See the picture" in the Additional Notes field, as shown in 
Figure 12-47. 

Figure 12-47 Some cards have pictures. 
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Anytime "See the picture" is sha ing in the Additional Notes field, you 
can click Show Picture to see tt: hidden card picture. 

• Click Show Picture. 

This card, which contains the term "ASCII", has a picture showing the 
entire ASCII character set for the Geneva font (see Figure 12-48). 

0 NUL DLE spc 0 t 00 l -
I SOH DC1 a q e 0 ± i -
2 STX DC2 .. 2 B R b r c ¢ ! " 
3 ETX DC3 " 3 c s c s E £ l .f " 
4 EOT DC4 $ 4 D T d t N § ¥ I 
5 ENO NAK % 5 E u • u 0 • ~ 

., 
6 ACK SYN & 6 F v f v 0 'll ~ 1!. + 

Low 
7 BEL ETB 7 G vi w a f3 I « 0 

8 BS CAN ( a H X X a ® TT )) y 
9 HT EM ) 9 I y i y a 0 @ 11 
A LF SUB " J z j z a 0 tM J nbs 
8 VT ESC + K [ k 0 A 
C FF FS < L \ 1 2 A 
D CR GS - M I m 9 "" 0 0 
E SO RS > N - • u .-'E CP CE 

Figure 12-48 Viewing the card picture 

Most of you will have little reason to know the actual numbers for each 
of the characters shown, since you can easily find the characters using 
the Key Caps desk accessory when you want to type them from the 
keyboard. 

When you are finished looking at the picture, you can click the Hide 
Picture button or click on any of the arrow buttons. You really don't 
have to hide the picture, because the stack is programmed to hide the 
picture automatically whenever you go to a different card. 

,. For practice, click Hide Picture. 

You originallygottothiscard by jumping from the card with "acronym" 
in the Term field. You can now go back to the card from wh ich you 
originally jumped. 

• Click on the Return button (see Figure 12-49). 
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Glossary Stack 

Figure 12-49 Click the Return button to return to the original card 

You are now returned to the "acronym" card. Now you know how to 
navigate through the dynamic links in the See also field. Remember, 
however, that if you go to a different card using one of the arrow keys, 
the dynamic link is broken and the Return button disappears. This lets 
you override the Return link in favor of exploring in a different 
direction. 

USING THE FIND BUTTON 

Another way to find information in the Glossary stack is by clicking on 
the Find button. Unlike choosing Find from the Go menu or typing 
Command-F on the keyboard, this button has a script that offers you 
two choices of where to look for the term or to cancel if you clicked the 
button by mistake. 

• Click Find. 

When you click the Find button, the Glossa ry stack asks you wh ere you 
want it to look (see Figure 12-50) . The default is to limit the search to the 
Term field. You can choose this by clicking on the default button or by 
pressing Return or Enter. 



Chapter 12: HyperCard 661 

Figure 12-50 Telling the Glossary stack where to look for text 

Click the Anywhere button if you want to extend the search to any field 
in the stack. If you really don't want to find anything, click the Cancel 
button. 

In this case, you will limit the search to finding a word in the Term field 
only. Two fonts with names that start with "Zapf" are available in 
LaserWriters that support PostScript. Now you can see how quickly 
HyperCard will find one of them for you. 

,,,. Click Field 'Term' or press the Return key. 

Now that you have told the stack where to look, it is time to enter the 
word or phrase you want to find (see Figure 12-51). 

{[E:J [ Cancel ] 

Figure 12-51 stack what to find 

• Type Zapf or ZAPF or (capitalization does not matter). 

In a second or two the card conta ining "Zapf Chancery" is shown (see 
Figure 12-52) . To aid you in finding other occurrences of the phrase you 
are finding, the Message box has become visible and a find command 
has been entered for you. 
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Figure 12-52 Text found in a card 

Za pf Chancery is the first of the two cards with the word "Zapf", and you 
can now find the second very easi ly. As long as the Message box is 
showing with the find command, all you have to do is press the Return 
key to find the next occurrence of the word or phrase being found. 

• Press the Return key. 

The next card containing "Zapf" in the Term field is shown a lmost 
immed iately (see Figure 12-53). 

Glossary Stack 

Figure 12-53 Text found in another ca rd 
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This card (a nd the preceding on ) contains a picture showing a sample 
of the font. In fact, most of the s andard screen and Laser Writer outline 
fonts are listed in the Glossa ry, ahd each has a sample of the font shown 
on the card picture. 

The Zapf Dingbats font contains a number of symbols; if you want to see 
a sample, cli ck the Show Picture button. A better example of a sample 
font picture is on the preceding card. Let's look at it. 

• Click o n the left arrow butto n. 

You now see the Zapf Chancery card . Show the picture to see a sample 
o f this font (see Figure 12-54). 

• Click Show Picture. 

'I1iis is a samp(e of tlie Zapf Cliancen; font 

JI'BCD'E'FG'Jfi'J'.J(£7Vf'J{O'PQ'R..STU'VWX)'Z 

a6caefsliij~mnopq~~z 

1234567890 

Figure 12-54 A sample of the Zapf Chancery font 

Ex plo re the Glossary stack as much as you want . When you are ready to 
go back to the Home stack, follow the instructions below. 

,. Click o n the Ho me button on the to p right of the card. 

The stack then shows the closing card, and in a few seconds it fades out 
and takes you back to the Home card. 

You can now continue explo ring the othe r stacks shown o n the Home 
card if you want. 

~ -Q • When you are done, choose Quit HyperCard from the File menu . 

This completes Project 1. You IjOW know how to move around inside 
most HyperCard stacks and hoW to use the Help stack fo r learning mo re 
about HyperCard. The Glossar~ stack is available for quickly finding 
definitions and seeing exam ples of more than 600 terms. 
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Project 2: Modifying a Stack 

In Pro ject 2 you will create a new stack from one of the cards shown in 
the Card Ideas stack. This stack will allow you to enter, find, and modify 
names and addresses of your friends and acquaintances. You will see 
how easi ly a new stack can be adapted from another one. 

In the second part of the stack you will enter a few names and some 
related informa tion. Then, in the final part of the project you wi ll 
produce mailing labels and an alphabetical list of all the n ames in the 
stack. 

SETTING THE USER LEVEL 

This project requires that you h ave access to the authorin g capabi lities 
of HyperCard. 

,. Start HyperCard. 

,. Go to the User Preferences card in the Home stack by cli cking on the 
left arrow button and change the user level to Authoring, as shown 
in Figure 12-55. 

• File Edit Go Tools Object s 

User Prefurena::s 

User Name: Marsha Szczepanski 

User Leuel : 

0 Browsing 

0 Typing 

0 Painting 

.®, Authoring 

U Scripting 

0 TeHI Arrows 

0 Pow er Keys 

Figure 12-55 Ch oosing the Authoring user level 

.. If Text Arrows is selected, click it to deselect it. Be sure Power Keys 
is a lso deselected. 

• Go to the Home card by clicking on the right arrow. 

When you change the user level to Authoring, you see two new menus 
added to the menu bar: Tools and Objects. 

You now have access to the Tools menu, which allows you to choose the 
button tool, fi eld tool, and any of the painting tools. The Objects menu 
allows you to get information about the objects in the stack and to 
change certain options that control the objects. 
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COPYING STACK IDEAS ELEMEN S 

Instead of creating a new address stack from scratch/ you can save 
yourself a lot of work by creating a new stack based on an existing card. 
For this project/ you will create a new stack from Address card 2 in Stack 
Ideas. 

• Click Stack Ideas. 

This opens Stack Ideas and shows you the index card. 

• Click Address card 2. 

You now see the second address card sample (see Figure 12-56). You will 
use this card to create a new stack. Then you will modify some of the 
characteristics of the fields on the card and enter information into the 
fields. 

c File Edit Go Tools 

Royce Walthrop 

2 I 7 Crocker Lane 
Hillsdale, Ohio 44704 
(21 6) 555-3452 

Work: 
General Sprocket 
(2 16) 5 55-7654 

3 kids: 
Sareh (18) 
Bill (12) 
Beth (9) 

&ood Brld&e partner 

Royce9/21 
Charlene 4/22 

Figure 12-56 The second address card in Stack Ideas 

Creating a new stack from an existing card is a fast and easy process. 

• Choose New Stack from the File menu. 

You are presented with a dialog box that allows you to name the new 
stack (see Figure 12-5 7). 



666 Part V: Information Management 

Edit Go Tools eels 

lest HyperCnnll es 
IQ: !g) Mnrshn Sz ... 

Eject 

[ Drlue J 
partner 

New stack nnme: ~~] 
( Concel ) 

Figure 12-57 Creating a new stack from an existing card 

• Name the new stack My address stack, be sure Copy current 
background is selected, and save the new stack on your data disk. 

In a few seconds, HyperCard does some work and you have a new stack 
on your data disk. It is important to copy the current background 
because it has a number of buttons and fields already in place. By 
copying the background, you copy not only the graphics on the card but 
also the other objects and their characteristics and scripts. 

You can easily find information about your new stack using the Objects 
menu. 

,. Choose Stack Info from the Objects menu. 

A dialog box appears on the screen telling you the name of the stack, 
where it is located, the number of cards and backgrounds it contains, the 
current size, and how much space is free in the stack (see Figure 12-58). 

This is a new stack with only the one card and one background you just 
copied. It takes up 8 kilobytes on the disk and has no free space yet. 

' 15 File Edit Go Tools 

Stock Nome: I* .fiii§JJjm. 
Where: Mnrsha SzczepBnskl 

Stock contolns 1 cords. 

Sl11ck cont11lns I backgrounds. 

Size of Stack: 8 K 

Free In Stack : 0 K 

Figure 12-58 Getting information about the stack 
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• Click OK when you have re d the information in the dialog box. 

Adjusting Background Fields 

One of the first changes you will make is to show the outline of the Name 
and Address field and show the lines in the field. The font for the field 
is currently 12-point New York, and you will change it to 12-point 
Geneva. 

To make it easier to work with various tools, you can convert the Tools 
menu into a floating palette. This is a tear-off menu, and all you have 
to do to move it on the screen is choose the menu and drag it from the 
menu bar to where you want it. 

• Tear off the Tools menu and move the palette to the lower left corner 
of the card (see Figure 12-59). 

• File Edit Go Tools 

Notes 

Figure 12-59 Tear off the Tools menu to make it easier to use. 

Now that you have the Tools palette where you can use it, you need to 
choose the field tool so you can modify some of the fields on the 
background. 

,. Select the field tool. 

When you select the field tool, all the fields on this background become 
visible. You can see that there are four fields showing on the card (see 
Figure 12-60). 
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!If; File Edit Go Tools 

Figure 12-60 Fields become visible when the field tool is chosen. 

Let 's examine one of the fields in more detail. 

• Click in the top left field . 

The field becomes selected. This is shown by a moving dotted line 
surrounding the field. A selected field may be moved by dragging it with 
the pointer. It may be reduced or enlarged by dragging one of its corners 
in the appropriate d irection. It may be deleted by pressing the Backspace 
(or Delete) key. 

In this case, you don't want to change its size or position or delete it. 
What you will do next is to change its appearance and font characteristics. 

• Choose Field Info from the Objects menu. 

A dialog box similar to a stack information box appears. In this box are 
the name of the field (Name and Address), its number on the background 
(1), the style of the field (transparent), and any other chosen characteristics 
(none). 

• Change the style to rectangle, and click the Show Lines check box. 

The dialog box should now look like the one in Figure 12-61. 
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• File Edit 

Field Name: f!:tn,J. .IHII;OQII¥\ 
Bkgnd field number: t 

Bkgnd field I 0: 2 Style: 

0 transpar ent 
0 opaque 
® rectangle 
O shadow 
0 scrolling 

Figure 12-61 Setting characteristics for a field 
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Before you click the OK button to accept these changes, you can modify 
some of the text characte ristics. 

• Click Font. 

Another dialog box appears, replacing the field information box. 

figure 12-62 shows the dialog box just before you click OK to accept the 
new choices . 

Style Chlcogo 
0 Bold Courier 

Ot tallc ~~~··· 0 Underline Gregorian 
0 Outline Heluetlca 
0Shadow 
0 Condense 
O EKtend 

Figure 12-62 Setting font characteristics for a field 

• Select Geneva fan t, and 12-, oint size. Click OK to accept the change. 

To see the results o f the changes ou just made to the Name and Address 
field, choose the browse tool. 

• Select the browse tool. 
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The fi eld is now visible on the screen. The re is a solid rectangular frame 
around th e fie ld, and dotted lines indicate each li ne of text the field can 
contain, based on 12-point Geneva (see Figure 12-63). 

~---·---~~-~ --------·----.. --·--···----
---------··--··--·--~--·---· .. 

. ----
" -

Figure 12-63 The modified Name and Address fi eld 

Now that you can see this fi eld, you ca n modify the field below it. 

• Select the fie ld tool, and double-cl ick on the lower left field. 

You now see a field in formation dia log box (see Figure 12-64). 

' 115 File Edit Go Tools Objects 

Field N11me: I Phone 
'--------

Bkgnd field number: 2 

Okgnd field I D: 3 

D lock TeHt 
D Show lines 
D Wide Margins 
D Auto Tab 

Style: 

0 transparent 
0 opequ e 
® rectangle 
O shadow 
0 scrolling 

Figure 12-64 Naming the Phone fi eld and changing its style 

• Name the fi eld Pho ne, and select the rectangle style. Click OK. 

After you close the dial og box, your address ca rd sho uld look similar to 
the one shown in Figure 12-65 . 
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Figure 12-65 The card after c~anging the two fie lds 

You have now completed all the changes you wi ll be making to the fields 
in this stack. One of the most appealing aspects of HyperCard is the 
ability to continually customize and modify stacks to suit your particular 
needs and aesthetics. 

Now that you have finalized the design of this stack, change back to the 
browse tool and close the Tools palette . 

• Choose the browse tool, and close the Tools pa lette. 

You a re now ready to enter information into several cards. Entering text 
in a field is as easy as selecting where you wa nt it and then typing it into 
the fi eld. 

There are several ways to position the text insertion point in the Name 
and Address field. You can move the pointer to the first line o f the field 
and click the mo use button, or, if no text insertion point is visible in any 
of the fields, press the Tab key to move the insertio n point into the first 
field on the background. 

Since the Name and Address field is th e first background field, either 
method would work in this case. When you are creating new cards and 
entering information, you may find it easier to use the Tab key method 
of placing the insertion point. 

• Press the Tab key. 

The insertion point is placed into the first line of the Name and Address 
field. You are now ready to enter the first person's data in your address 

stack. I 
• Type Francesco Cavaliri, and then press the Return key. 

The name appears in the field and the insertion point moves to the start 
of the next line in the field. 
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• Type Route 3, Box 149, and then press Return. 

When you type th e last line of the address you do not need to press the 
Return key. 

• Type Pagosa Springs, CO 82032. 

This is all the information that needs to go in the first fi eld. Now you can 
enter the area code and phone number in the Phone field. 

• Press the Tab key to move the insert io n point to th e Phone field. 

• Type (303) 555-1293. 

You have now entered all the info rmatio n that will go on this card. Your 
card should look like the one shown in Figure 12-66. 

., 

Figure 12-66 The stack's first card with a name and address entered 

An address stack with only o ne name and address is not very useful, but 
how do you add mo re information to your list? You must create a new 
card for each person you want to ente r in your fi le . 

Let's create a new ca rd and enter ano ther person's data. 

• Choose New Card from the Edit menu. 

• Type the fo llowing information in the appropriate fields: 

David Wilson 
1429 Denali Drive 
Marietta, GA 30922 
(404) 555-2916 
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You should now see a card like the one shown in Figure 12-67. 

Figure 12-67 The second name and address card 

• Continue creating new cards, and enter the information for the 
following people: 

Linda Ammerman 
928 Dobie Way 
Bellevue, NC 28002 

Bill Beck 
Route 3, Box 992 
Hanging Dog, NC 28982 

Larry Wilson 
1298 Main Street 
Apache Junction, AZ 92778 

George Kelischek 
112 Via Viol 
Brasstown, NC 28672 

Ed Smith 
Marianne Myers-Smith 
8392 Hilltop Lane 
Spotted Fawn, TN 27202 

David Willie 
9289 Rock Road 
Auburn, GA 30282 

George P. Burdell 
1837 Imagination Alley 
Atlanta, GA 30003 

(704) 555-9273 

(704) 555-1092 

(602) 555-8725 

(704) 555-2892 

(615) 555-2906 

(404) 555-1296 

(404) 555-9272 
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HyperCard can print one card or all the cards in the stack, but it does not 
directly support a command to print only some of the cards. This can 
be done, but it requires creating a HyperTalk script to accomplish it. 

In this case you want to print only one card. 

• Click on the left arrow or the right arrow until you find a card you 
want to print. 

• Choose Print Card from the File menu. 

WORKING WITH STACKS 

Sorting the Stack 

You now have an address stack with information on nine people. You 
can add as many cards as you want to a stack like this, limited only by 
the amount of disk space available on your system . 

The names in this stack were entered in no particular order. One of the 
main functions of information management software is to organize 
information. 

When you copied the background from Stack Ideas you also copied a 
number of buttons located on that background. The icons of the buttons 
and their names are shown in Figure 12-68. 

~ Home 

~Dial 

~Calendar 

~ToDo 

~View 

~Sort 

Figure 12-68 Background buttons in the address stack 

The Home button does what all Home buttons do: it goes to the Home 
card. 

The Calendar and To Do buttons take you to the previously discussed 
stacks with the same names. View shows you all the cards in a stack in 
rapid sequence. To stop View (or almost any other script), type Command
period. 
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The Sort button was previously programmed to allow you to sort by the 
first word or the last word of the first line of the Name and Address field. 
This assumes that you have entered the names on the first line, in first 
name, middle name or initial, and then last name order. 

When you copied the background, the buttons were copied and retained 
their original position and characteristics, including the scripts they 
had in their original stack. 

Dial allows you to dial a phone number through the Phone stack. Select 
the number you want to dial, and then click on the Dial button. (Do not 
do this if you have a modem attached, unless it is a number you really 
want dialed.) 

Now that you know the names of the buttons and a little about what 
they do, you can put one to work and sort the cards in the stack. Most 
address lists are sorted alphabetically by last name, with people having 
the same last name sorted by first name. 

You can accomplish this in this stack by sorting first by first name, and 
then again according to last name. When HyperCard sees two cards with 
the same sort value it will not change their positions. So, when you sort 
first by first name, and then by last name, HyperCard will leave the 
people with the same last name in alphabetical order by first name. 
Unless you have hundreds of names in the stack, the process goes fairly 
quickly. 

,,. Click Sort and choose First Name. Then click Sort again and choose 
Last Name, as shown in Figure 12-69. 

'* File Edit Go Too ls 

Figure 12-69 Sorting the names in alphabetical order by last name 

You have now completed sorting the cards into alphabetical order. 
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With the stack in alphabetical order, it is a good idea to print all the cards 
in the stack. 

HyperCard provides a command to do this: Print Stack. When you 
choose this command, it allows you to select various options before 
printing. 

• Choose Print Stack from the File menu. 

You are presented with a dialog box like the one shown in Figure 12-70. 

a Edit Go Tools 

Print Stock ... Coples:l• l 
D Monuol poper feed ll::]L~J] 
D Dorleer printing 

Heoder: ~0 ~ ~ 

[ Concel ] 

D No spoce between cords 

0 Pr int one c11rd per poge 
0 Print full size c11rds 
® Print hol f size cards 
0 Print quorter size cords 

® Stondord format 
0 Split- page format 

Figure 12-70 The Print Stack dialog box 

• Select Print half size cards and Standard format. 

The bottom of the dialog box has a box with four icons that lets you 
create a custom header fo r the pages on which the stack will be printed. 

In order, the icons stand fo r Date, Time, Page Number, and Stack Name. 
Clicking on one or more of these will en ter the respective data into the 
header when the stack is printed. You can separate the information with 
one or more spaces. 

• Click OK. 

The stack will print on two pages, with eight cards on the first page and 
only one on the second page. This is not the fastest or most effi cient way 
to print a report from a stack, but it has the advantage of showing all the 
graphics stored on each background and on each card. Printing the stack 
is a good way to document the appearan ce of a new stack in case you 
need to crea te a simi lar one in the future. 
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HyperCard provides three main ways to print reports based on 
information in the stack. It only processes all cards and will not allow 
you to select a subset of the data for a report. 

The lack of ability to print info rmation that matches specific criteria is 
one of the problems that inhibits using HyperCard fo r a database 
management program. As with most th ings in HyperCard, however, 
HyperTa lk provides the tools to accomplish th is task if you are an 
accom pi ished scri pter. 

To complete this project, you will print each of the three types of reports 
provided in HyperCard: labels, columns, and rows. 

A number of printing options are available when printing HyperCard 
reports, but this project does not try to exhaustively cover each of the 
optio ns. Instead, you are presented with an example of how you might 
produce each of the three types of reports. 

Labels 

A label report is used to create mailing labels or o ther labels that a re 
arranged several to a page in a rectangular pattern. 

Each label contains in formation stored in the fields o f one card. The 
information printed in each label is automatical ly centered on the label. 
Each label in the report you are about to print will con ta in left-aligned 
text, but the left edge of the text in a ll labels will not be aligned, as 
HyperCa rd will adjust the contents of each label so the text will fit as 
near the center of the label as possible. 

This is easier to understand if you print a label report. 

• Choose Print Report from the File menu. 

You are presented with a dialog box such as the one in Figure 12-71. 

' li:lm!ll Edit Go Tools Objects 

Print report... Coples:lr.l 
0 Monuol paper feed 
0 Darker printing 

Arronbe fields In: lt:JiOk!JJ @ 
® lobels [ Cancel J n~~:~; 
0 Columns CD rm, [f'....,L."'J o Rows: CI'J ~m rim 
Print teHt fields from oil cards: 
0 In the entire s tock 

1/ 
h 

® With the current background I'> 
Which fields: 
0 Card fields J~., 

~::::~"~ ':."'""' """ b ~ 
Fle l ~ 3 :.:_ 

Dimensions: 
® Inches O cm 

Fi eld 4 ~~~[ 

rffi D.D 1 1.0 ~ D.D 1~1i: 
-ID D.D625 & 2.8125 G.iiEl D.O i~: 

Figure 12-71 The selections for printing a label report 
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• Select Labels, With the current background, Selected background 
fields, and the Nam e and Address fie ld (see Figure 12-71). Then 
click OK. 

HyperCard prints the reports to the cu rren t ly selected p ri nter. If you a re 
printing on an lmageWriter, you must use 3-up labels o n 8.5- by 11 -inch 
paper, because Hype rCard is not programmed to print on narrower 
labels. 

Columns 

A colu mnar report prints the report in vertical columns. Each field is 
printed in its own column. lfthe column is too narrow to hold the en tire 
conten ts of the fi eld, the text is automa tica lly wrapped within the 
appropriate column. 

In this report, you will print the arne and Address field in the left 
column and the Phone field in the right colum n. 

• Choose Columns, With the curren t background, Selected 
background fi e lds, and the Nam e and Address and Phone fields 
(see Figure 12-72) . Choose to print field names. Click OK. 

Edit Go Too ls 

Print report... Coples:l• l 
0 Monuel paper feed 
0 Darker printing 

r- r 
i 

I 
! 

I ___ L ____ . __ _ 

Header: 1li'n 0 l!!ll Q 

Rrronge fields In: ILJ[Jj 
0 Labels I Cancel J 
®Co lumns 

0 Rows: ffi ~ !ffij 
Print teHt fields from ell cards: 
(: In the entire Hock 
® With the curren t background 

Which fields: 
0 ( ord liPids 

Selec ted DIICICOrllUn~ 

Print the names of: 
0 Cords 181 Fields 

Figure 12-72 Selecting optio ns fo r a column report 

The report consists of a two-col urn n report listing the information in t he 
two fields. The information for a particular ca rd appears side by side. 

If you choose to pri n t the names of fields, they appear at the top of each 
column, wh ile card names appear in thei r own column on the left side 
of the re port. 

Rows 

If you choose to print a row re port, th e information for each card is 
printed in a verti ca l format with th e name o f each field (if the option is 
chosen ) to the left of the first line of the conten ts of that field. 
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HyperCard allows you to print row reports in one-colum n or two
column format. If you choose the one column-format, the information 
for a single card can go all the way to the righ t ma rgin. A two-column 
format causes the in format ion on two cards to be printed side by side. 

In this project you will choose a single-column format. 

To print a row report, make the same selections as you did for the 
column report, with o ne exceptio n: 

• Choose Ro ws instead of Columns, and then click OK (see 
Figure 12-73) . 

r 
Edit Go Tools ects 

Print report... Copies:IIMj 

0 Manual paper feed 
0 Darker printing 

~=r~:==:~~====:~ 
r··-···-1--···-·-··-·-·-·---··-·i 
~---···- r-·- ·-·-··· ..................................... , 
! : i r .......... t~·· ................................................. i 
! I l 

i ········"' f "'"'''' " ' ""'" ''"""'" ''"''""'" '' "'""'l 

i I i 
j""""''" j """""'''"'''" ''''"'" ' ''''"''"'" '" ''''" 'l 

t:~.:t:::~::~:::::::::::::::::=:::·:~::.:::J 
Header: ~ eJ ~ " 

Rrrange fields in: 
0 labels 
QColumns 
@Rows: II 

n OK 

[ Cancel 

mm mm 
(l][i] ([][i] 

Print tewt fields from all cards: 
0 In the entire stack 
® With the current background 

Field 4 

Print the names of: 
D Cards !81 Fields 

Figure 12-73 Selectio ns fo r a row report 

This completes the three reports for this project. 

., 

Dialing a Phone Number 

When you copied the background for this stack, you copied an interesting 
button as well. The Dia l butto n allows you to use your computer to dial 
the phone automatically based on informa ti on in a stack. 

Since each of the peop le in this stack has a phone number listed, you can 
use the Dial button to call them. 

To use this in a real situation, you would open the Phone stack and make 
any adjustments and customizati ons necessary fo r you r particular 
location and computer system. 

The Phone stack knows how to d ial by generati ng touch tones from the 
computer's speaker or by dialing through a modem using pulse or touch 
tones. If you are doing this in a computer lab or at home without a 
modem, you can hear the sounds of the computer d iali ng if the Phone 
stack is set to gen erate tones fr m its speaker. 
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If your computer is attached to a modem and you have modified the 
Phone stack to dial through the modem, the following exercise will 
actually d ial your pho ne. All the numbers are imaginary, so the call 
shouldn't really go through, but you may want to be awa re that it will 
really d ia l the phone. 

You can use any of the cards in the stack for this exercise . 

• Select the phone number, and then click on the Dial button (see 
Figure 12-74). 

Figure 12-74 Using HyperCard to place a call 

HyperCard goes to the Pho ne stack and attempts to dial the number you 
selected. If the number has the same area code as that listed in the Phone 
stack, it asks if this is a local o r long-distance call and dials according to 
the preferences you have listed . 

This concludes Project 2. 

W -Q • You can choose Quit HyperCard or continue with the n ext project. 

Project 3: Creating a New Stack 

In Project 3, you create a n ew st ack called Class Notes without copying 
a card or background . This means that you must draw the background 
picture, and your new stack will not have the benefit of already having 
the fields and buttons on the background as you did in Project 2. 
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When you begin to use HyperC rd for automating more tasks, you will 
want to create stacks that are personalized for the specific task at hand. 
This project is based on the premise that you will find tasks for which 
you will not be able to use one of the cards in Stack Ideas. In this project, 
you will copy a portion of a background picture, paste it into your stack, 
complete the d rawing, add new fields, and import several buttons from 
other stacks (so you don' t have to write the scripts for them). 

To m ake your stack more visually appealing, you will be introduced t o 
HyperTalk scripting. Compared to oth er programming languages, 
HyperTa lk is easy to learn and use, but it is beyond the scope of this book 
to teach scripting in general. 

Most of the butto ns in this stack are avail able in the Button Ideas stack, 
but you will use a Sort button and a Print Report button that is included 
in the Class Notes Buttons stack on the Macintosh Journey Projects disk. 
To demonstrate HyperCard's visual effects and how they can be used to 
add visual appeal to your stacks, we have also included a simple Visual 
Effects stack on the Projects disk. 

The Class Notes stack, shown in Figure 12-75, is designed for taking any 
type of cl ass notes . It can be used for multi ple classes and will sort the 
notes into chronological order within each class. The Print Report 
button can be used to produce a text file based on a range of dates or a 
keyword search. The resulting text file may be opened by any word 
processing application for formatting a nd printing. 

r j File Edit Go Tools Objects 

CLASS NOTES ®i 
G> ! 
® 1 Dele: j 3/3 1/ 91 Class: I Musi c Appreciation 

! Read Introduction a n~ Theory sections, Pages 1-87 
([; ! Assi gnments: Watch '"From Antiqu\ty to the Renaissance·· video 
It i Exam in two weeks 

i 
® i Noles: 
It ! Timbre is synonymous with tone color. 

· Degrees of loudness and softness in music are called dynamics. 
€) J The relative highness or lowness that.we hear in a sound is called pitch. 

0 
,! The distance between lowest and highest tones of ani nstrument is pitch range . 

v Pianissimo: soft, forte: loud, fortissimo: very loud. 
0 i The pitch of a sound is determi ned by the freq uency of its vibrations. 
,~ •. ·~·. The distance in pitch between any two tones is called an interval. 
v The frequency of vi brations is measured in cycles per second (Hertz) . 
"' :.· A dynamic accent occurs when a performer plays a tone louder than the others 
v surroundi ng it. 

oi 
o i 
e ! ~ ¢l 

; 
Print Report Sort 

Figure 12-75 The final Class otes stack 
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Thi s stack is also useful for rna ing class no tes if you teach any type of 
class o r for organizing other not~s that may not necessa rily be associated 
with a class. The techniques you will learn in this project w ill be 
applicable to many other types of stack creation. 
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For most of this assignment you can leave the user level set to Authoring. 
When you add the visual effects to your stack, you will need to (briefly) 
change the user level to Scripting. 

You should also be sure that you have copied the Class Notes Buttons 
and Visual Effects stacks from the Macintosh Journey Projects disk onto 
your disk. The procedure for doing this was covered in Project 1 in 
Chapter 1. 

If you do not presently have HyperCard open: 

• Open HyperCard by double-clicking on its icon. 

CREATING THE BACKGROUND 

When you create a new stack without copying a background, you must 
create the picture for the background, create all the fields necessary, and 
create or copy any necessary buttons. 

In this case you will create the background picture with minimal help 
from Stack Ideas. 

To begin this project, you need to go to the third index card in Stack 
Ideas. 

• Click Stack Ideas. 

This will take you to the first index card in Stack Ideas. 

• Click on the right arrow button two times. 

The third index card of Stack Ideas contains a miniature picture of a card 
named Computer paper. This is the card you will use as the basis for 
creating the background picture of the Class Notes stack. 

• Click Computer paper. 

When you do this, HyperCard goes to the card and shows a short story 
about determining the difference between a coffee maker and a computer. 
If you would like to take a few moments to read the story before 
proceeding, go ahead. 

It is an interesting method for identi fying a coffee maker, but it would 
not be of much use in a class notes stack. However, the picture of the 
computer paper in the background might make an interesting background 
for your new stack. 

The picture on the background layer of a stack only serves as a visual 
analogy for the purpose of the stack and how it operates. In this case, the 
background picture is not of major importance, and you could have 
chosen a number of different approaches for the background for a class 
no tes stack. 
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The background of this stack c ntains a picture and four buttons you 
will eventually use on your new stack, and you can accomplish a lot of 
what you will do in this project by creating a new stack based on this card 
and copying the background. But, if you do that you won't learn how 
to create and place all the objects in to the background of your new stack. 

3€ -B • Change to the background layer by choosing Background from the 
Edit menu. 

The Background command is a toggle that switches between the card 
layer and the background layer. 

When you issue this command, HyperCard indicates that you are in the 
background layer by adding a series of short diagonal stripes at the top 
and bottom of the menu bar. If the menu bar is not visible, you can make 
it visible by typing Command-space bar. This is a toggle command and 
will either hide or display the menu bar. It is very important that the 
menu bar be visible so you can see in which layer you are currently 
working. 

• Tear off the Tools palette, and choose the selection tool. 

You will now use this tool to copy the series of pin-feed holes and 
perforation indicators on the left side of the computer paper. 

3€ -C ,,. Select the area of the computer paper shown in Figure 12-76, and 
then choose Copy Picture from the Edit menu. 

l e 
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Figure 12-76 Copying the left edge of the computer paper 

You will now create a new stacJ 

• Choose New Stack from the File menu. 

• In the dialog box that appl ars, name the stack Class Notes, and 
deselect the option Copy current background. 

This creates a new stack with a blank, white background. You now will 
paste the picture you copied from the Computer paper card to the 
background of the only card in the new stack. 
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3€ -B • Change to the background layer. 

~ -v • Choose Paste Picture from the Edit menu (see Figure 12-77). Do not 
click anywhere to deselect the picture you just pasted into the 
background layer. 

r • •• • "rile .. i.i1i. "cia . 'roo is·. Paint·. oiiilons. ·Patterns .................. ., 

• • • • • • • • • • • • • • • 
Figure 12-77 Beginning to paint the new background 

~-V • Paste the picture onto the background again, and be sure to leave it 
selected. 

This puts another (selected) copy of the picture on top of the one you 
pasted a few seconds ago. Now you will drag the new copy straight to the 
right and then flip it horizontally to form the right edge of the paper. 

• Press the Shift key and drag the picture to the right side of the screen 
(see Figure 12-78). 

r • •• • "rile· . i.i1i .. cia • 'roois" . Paint· . oiii1ons .. Patterns .................. ., 

• • • • • • • • • • • • • • • 

• : e: . : 
• • • • • 
I 
• • • • • 

Figure 12-78 The background after dragging the copy of the picture 

The second copy of the picture is facing in the wrong direction, so you 
need to tell HyperCard to flip the picture horizontally. 

.. Choose Flip Horizontal from the Paint menu. 
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This gives the two sides you nee for the computer paper you are about 
to finish painting (see Figure d -79). 

' ..•. "ri1e·. rli1i. "rio. roo is·. i>airit .. options. "P'8iterns .................. ., 

Figure 12-79 
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Both sides of the paper are in place. 

Painting the Background 

By holding down the Shift key while you dragged the second copy of the 
picture to the right side of the card, you constrained the drag to be 
exactly horizontal. This means that the tops and bottoms of the pictures 
should match exactly, and you now can easily draw a line across the top 
and bottom to finish the sheet of paper. 

• Choose the line tool from the Tools palette. 

,,. Press the Shift key to constrain the line tool to horizontal lines only, 
and draw two horizontal lines to connect the top and bottom of the 
page (see Figure 12-80). 

,. ....................................... , ....... , ............... .., 
j File Edit Go Tools Paint Options Patterns 

Figure 12-80 The background after the paper is completed 
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You can now complete the background by pouring a gray pattern 
around the paper with the bucket tool. 

• Select the bucket tool and the medium gray pattern, and pou r the 
pattern at the top of the page, above the paper. 

Sometimes the pattern you pour might not align properly with the 
pattern that surrounded the paper when you pasted it onto the screen 
(see the thin black line above and on the right side of the computer 
paper's pin-feed holes in Figure 12-81). If you encounter this problem, 
you can carefully erase the part of the pattern that does not match and 
then repour the pattern into the area you erased. 

just as the Shift key constrains lines, circles, and squares, you can hold 
it down while using the eraser tool. This causes the eraser to move only 
vertica lly or horizontally, depending on how you first start moving it. 
This makes it easier to erase a pattern up to the very edge of a straight 
line such as around the edge of this computer paper. 

A pattern is automatically aligned to the top left edge of the card, so the 
pattern you pour the second time (if you need it) always matches the 
pattern you poured the first time in any given card. 
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Figure 12-81 The background after pouring a medium gray pattern 

The next step is to add a title to the top of the background. 

To do this, you wil l choose a large font and type the n ame at the center 
of the top of the computer paper. 

• Double-click on the paint text tool in the Tools palette. 

This opens a dialog box (see Figure 12-82). 

• Choose 24-point Bookman (or any similar font available on your 
system), select Center align ment, and click OK. 
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Figure 12-82 Choosing a large font for the title 
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• Click the paint text tool somewhere near the center of the top of the 
computer paper, and then type CLASS NOTES (see Figu re 12-83). 

• · ·* · ·rile· · £.i1i · · 68 · roo is · F>8int· · otliions · · Polterns · · · · · · · · · · · · · · · · · · ., 
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Figure 12-83 En tering the stack's tit le 

It is sometimes difficult to enter the title in an acceptable location the 
first time. Rather than erasing and typing the title in a new location, you 
can use the lasso to move it to a better location. 

• Select the Jasso from the Tools pa lette, and then select the title text 
by carefully dragging the ~asso around it. Drag the title to the 
location you prefer (see Fig~re 12-84). 
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r- ~ ............. . ...... .. ................... .. .. . ......... . ........... -, a File Edit Go Tools Paint Options Patterns 
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Figure 12-84 Dragging the title to a better location 

This completes the painting of the background for the Class Notes stack. 
You will now add the fields and labels for the fields. 

Adding Background Fields 

There will be four background fields in the Class Notes stack. One 
contains the date; another, the name of the class; the third field contains 
the assignments for the class; and the fourth field holds any notes for the 
class on that date. 

Before you begin creating the fields, be sure that you are still in 
HyperCard's background layer (hint: look at the menu bar). 

Before you begin adding fields, select the field tool from the Tools menu 
or palette. 

There are two easy ways to create a new field. The first is to choose New 
Field from the Objects menu. This places a field somewhere on the 
card. You can then use the field tool to drag the field to its 
intended location. 

The second way allows you to draw a field in the position where you 
want it. To do this, move the field tool to one of the four corners of the 
new field's location, hold the Command key down, and then press the 
mouse button and drag to the opposite corner of the field 's location. The 
outline of the field is drawn and may be modified until you release the 
mouse button, at which time the new field will be placed on the card in 
the location you specified. 
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A field may be moved by dragginl it with the field tool or may be resized 
by dragging any of the four corners. 

Since you can move a field to a new location and easily change its size, 
it is not critical that you initially place the field exactly in its intended 
location. If you don't like where it is, you can move it or resize it at will, 
even after you have typed text into it. 

If you move a field after information has been entered into it, the text 
will reflow based on the new size of the field. 

Now it is time for you to try it. 

• Choose the field tool from the Tools palette. 

• Using one of the methods you just learned, create a new field on the 
stack's background. 

At this point, it is not important where the field is located, but you 
should see a field somewhere on the screen similar to the one shown in 
Figure 12-85 . 

. . '" .... ..... ... ... ......... ... ... ..... ... .. .. .. ............ ... ., 
File Edit Go Tools Objects I 
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Figure 12-85 Creating your first field 

The field is not the right size or in the correct location. 

• Using the methods previously described, move the field to the 
location shown in Figure 12-86, and resize it to approximately the 
size indicated there. 

Precise location and sizing are not critical factors in creating this stack. 
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Figure 12-86 The first field in its proper location 

• Continue adding the other three fields as shown in Figure 12-87. 

The style of the fields is not important right now. j ust place four fields 
in approximately the locations shown. You will customize the fields 
next . 

• File Edit Go Tools Objects 

e i CLASS NOTES l e 
I '• e i 
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Figure 12-87 The four placed fields 

The first field you created becomes the Date field. The second field 
should be just to the right of the first field and becomes the Class field. 
The third field is for assignments. The Notes field comes last and is the 
largest. 

• Choose the paint text tool and enter the field labels shown in 
Figure 12-88. The fon t and style are your choice, but be sure you are 
in the background layer when you add the text. 
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Figure 12-88 The placed fields and text labels 
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The fields containing assignments and notes will become scrolling fields 
and allow you to type as much text as you need into the field (up to 
30,000 characters). If there is too much text to be visible in the space 
provided for the field, the text will scroll (similar to a word processor) 
as you enter more text. Later, you can scroll up or down to see different 
sections. 

You have already learned how to choose fonts, sizes, and styles for the 
characters to be entered into a field and also how to select the rectangular 
style for a field. 

• In this project, you can choose fonts, sizes, and styles of your choice 
for the four fields. Choose rectangle as the style of t he Date and 
Class fields and scrolling for the style of the Assignments and Notes 
fields (see Figure 12-89). 

s File Edit Go Tools Object s 
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•1 Asslgnme .I 
• i Notes: • • === • 
. 11----11 

~ ~--
• 

Field Name: I 
Bkgnd rield number: 3 

Bkgnd field I D: 3 

0 Lock TeHt 
0 Show lines 
0 Wide Margins 
0 Ruto Tab 
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Figure 12-89 Naming a field and selecting its characteristics 
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After clicking the OK button, you can see the change in the Assignments 
fi eld (see Figure 12-90). The rectangle outlining this fie ld has changed, 
and a scroll bar has been added on the right side of the field. 

This allows you to add more text than will show in the field and access 
that text conveniently. 

r • File Edit Go Tools Objects 
:::<: 

Figure 12-90 The Assignments field has a new scroll bar. 

When you finish setting the styles, options, and fonts fo r the fields, your 
background should look li ke the one shown in Figure 12-91. Note that 
the browse tool is chosen . This automatically takes you from the 
background layer to the card layer. If you have not properly specified the 
characteristics of a fi eld it may be apparent at this poin t. 

If you need to make changes, choose the appropriate tool, change to the 
background layer, and make those changes. Then select the browse tool 
and see if your card compares to the one in Figure 12-91. 

r 15 File 

Figure 12-91 Final paint text and fields for the stack 
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Adding Background Buttons 

You can make your stack more conven ient by adding a few buttons on 
the background layer. Moving to the next card, or the previous one, is 
a common thing to do in stacks. Going to the last card to add a new card 
would be convenient, and to balance it out you could add a button to 
go to the first card. 

To leave the stack, you probably want a button to go to the Home stack. 
There will be times when you want to quickly find something, so a Find 
button also would help. 

You will round out the stack's complement of buttons with a button for 
sorting and one for printing reports. (These reports are different from, 
and somewhat more flexible than, the ones built into HyperCard, so 
your stack will have the benefit of being able to print the standard 
HyperCard reports plus these customized ones.) 

You will add the buttons fo r going to the first, previous, next, and last 
cards by copying them from the Button Ideas stack. A button contains 
a HyperTalk script that tells Hype rCard what the button can do. 

Let's start by copying the button that will be used for going to the first 
ca rd in the stack. 

3€ -H • Choose Home from the Go menu. 

• Click Button Ideas, and find the card shown in Figure 12-92. 

,,. Select the button tool. 

• Select the third First button, as shown in Figure 12-92. 

a File Edit Go Tools 0 

First, Previous, Next, Last , Return ~ 

Los I Return 

Figure 12-92 Copying a First utton 
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3€ -C ,. Choose Copy Button from the Edit menu. 
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Now that you have copied t his button, you need to go back to the Class 
Notes stack and place it on the background. The easiest way to get there 
is to choose the Recent command from the Go menu. This sh ows you 
a series (up to 42) of miniature pictures of the cards you have recently 
visited . 

Your list of recent cards depends on which stacks you have opened since 
starting HyperCa rd and the manner in which you chose to navigate 
through those stacks. Figure 12-93 shows a sample list of recent cards. 
It con ta ins the cards you have seen if you fo llowed these d irections 
carefully and a few others to simulate the condition of other cards 
possibly being presen t if you took a different rou te. 

The two important cards shown here a re the small p icture of t he Class 
Notes stack and the one that represents th e current card of the Button 
Ideas stack (which is outlined and is posi tioned on the right side of the 
list of cards) . 

To go to a recen tly visited card, click on its p icture. 

• Click on the p icture of the Class Notes stack, as shown in 
Figure 12-93. 

., 

Figure 12-93 A list of recently visited cards 

You are immediately returned to the card you chose. If you happened 
to click on the wrong one, you can choose Recent again and click o n the 
proper card . 
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You will find this a very conveniJent way to move around in HyperCard. 
Since some of the statks you will use will hide the menu bar, you might 
want to remember that Command-R is the keyboard equivalent for 
choosing Recent from the Go menu. 

Now that you have copied the button you need and have returned to the 
Class Notes stack, you can paste the button onto the background layer. 
(Make sure you are on the background layer before doing the next step.) 

38 -V .. Choose Paste Button from the Edit menu. 

This command places the button on this stack's background layer in the 
same position it occupied in Button Ideas. Moving the button to where 
you want it is a simple process. 

Move the pointer to approximately the center of the button before 
dragging it. If you are too close to one of the four corners, you tell 
HyperCard to resize the button, and that is not what you want to do 
now. 

If you do resize the button, before doing anything else choose Undo 
from the Edit menu to return it to its proper size. 

.. Drag the button to the position indicated in Figure 12-94. 
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Figure 12-94 The First button pasted into your stack 

Now you can copy and paste the other three buttons from that same 
card in the Button Ideas stack. 

~ -R 38 -C 38 -v • Using what you have learned here, use the Recent command and 
copy and paste the buttons you need. Drag them to their proper 
positions (see Figure 12-95). 
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Figure 12-95 The four buttons from Button Ideas pasted into Class 

Notes 

3€ -R 3€ -C 3€-V • Go back to the Button Ideas stack and copy a Home button. Return 
to the Class Notes stack and paste it and drag it to the position 
shown in Figure 12-96. 
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Figure 12-96 The Class Notes stack with all fields and buttons in place 

Notice (see Figure 12-96) that two new buttons are at the bottom of the 
computer paper. These two buttons have been scripted to sort the class 
notes into ch ronological order, class order, or both and to print custom 
reports based on a range of dates or a part icular topic. 

The Sort button contains a script that is not very complex, but the script 
of the Print Report button is fairly long and complex. To save you from 
having to enter these scripts, we have placed the two buttons (and their 
scripts) into a stack named Class Notes Buttons on the Macintosh Journey 
Projects disk (see Figure 12-97). 
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Figure 12-97 The Class Notes Buttons stack 

If you have a copy of this disk, you can add the two buttons to your Class 
Notes stack by copying and pasting. 

If you do not have a copy of the disk, you can use the scripts that are 
printed on the last pages of this chapter. Typing them in requires that 
you change to the Scripting use~ level, create two new buttons, click on 
the Script button in the Button Info dialog box, and enter the script. 

Be aware that scripting requires absolute accuracy in your typing; you 
must enter the scripts exactly as shown for them to work properly. If you 
do not have the Projects disk, you may skip adding these two buttons to 
the stack and continue with the rest of the project. Then when you reach 
an instruction that tells you to do something with one of these buttons 
you can skip that step. 

3€ -C 3€ -V • Copy a button from the Class Notes Buttons stack and paste it into 
t he background of the Class Notes stack. Repeat this process for the 
other button . 

There is one o ther thing you might want to do to customize the stack 
to reflect personal preference for going from one card to the next. 

Learn ing to script in HyperTalk usually involves learning something 
now, then a little more later, and before you know it you are scripting. 

One of the easiest things you can do is add a visual effect to a button that 
changes from one card to another (or one stack to another). 
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INCLUDING VISUAL EFFECTS 

A number of visual effects are available in HyperCard, and they can be 
combined with others for more complex transitions. You can also tell 
HyperCard to perform the visual effect very slowly, slowly, fast, or 
very fast. 

Since explaining visual effects in print is difficult to do, we created a 
Visual Effects stack that contains 20 pre-scripted visual effects samples. 
Figure 12-98 shows the first card of this stack and the 20 buttons on it. 

Figure 12-98 The first card of the Visual Effects stack 

Visual effects include Wipe, Iris, Venetian Blinds, Checkerboard, Dissolve, 
Barn Door, Scroll, Zoom, and Plain (which is the same as not using a 
visual effect). 

There are two cards in this stack. The first one does all the work, and the 
second one (see Figure 12-99) is there for contrast so the effects are easily 
visible. 
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Figure 12-99 The second card of the Visual Effects stack 

All of these effects are similar. The script for the Dissolve button, fo r 
example, tells HyperCard to use the dissolve effect at a slow speed, go to 
the next card, wait 30 ticks (this is a half-second-there are 60 ticks per 
second), use the same visual effect, and go to the next ca rd (see Figure 
12-100). Since there are on ly two cards, this returns you to the fi rst card. 
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Figure 12-100 The script for the Dissolve butto n 

If you do no t have access to the Visual Effects stack, you could crea te one 
for yourself by entering this script into a button and then experimen t 
by changing the effects used. 

If you do have access to the Visual Effect s stack, you can open that stack 
now and look at the effects available in HyperCard. Pick o ne that you 
like and that you want your Class Notes stack to use, and then you can 
modify the Previous and Next buttons to use the effect of your cho ice. 
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• Choose Open Stack from the File menu. Locate the Visual Effects 
stack and then click Open. 

3€- R • Spend as long as you want experimenting with the effects, then use 
Recent from the Go menu to return to the Class Notes stack. 

Remember which effect you liked the most, and you can use it to modify 
any of the arrow buttons you wish. 

To do this, you must choose the Scripting user level. Instead of going 
back home, you can issue the command directly to HyperCard using the 
Message box. 

3€ -M • Type Command-M to open the Message box, then type set userlevel 
to 5 and press the Return key. (Do not enter a space in userlevel, it 
shou ld be one word for this command.) 

Th is sets the user level to Scripting (Browsing = 1, Typing = 2, 
Painting= 3, Authoring= 4, and Scripting= 5). 

Be sure the button tool is currently selected before doing the following 
steps. 

• Hold down the Command and Option keys, and click on the 
Previous (left arrow) button. 

The scripting dialog box for the left arrow button appears, and should 
contain this script: 

on mouseUp 
go to previous card 

end mouseUp 

This te lls HyperCard to go to the previous card when you release the 
mouse button if the pointer is on the left arrow button. 

If you decide you like the Scroll Right visual effect, you can change this 
script to the fo llowing: 

on mouseUp 
visual effect scroll right 
go to previous card 

end mouseUp 

This tells HyperCard to use the effect rather than just jumping to the 
card. It will look like the previous card comes in from the left of the 
screen and overlays the current card. 

• When you have entered the effects you like, click OK to close the 
d ialog box. 

If you like, you can add visual effects to any of the arrow buttons or the 
Home button. 
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ADDING A FIND BUTTON 

Now you will add a button to make finding information in your notes 
easier. 

3€: -C • Go to the Button Ideas stack and copy the Find button (see 
Figure 12-101). 
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Figure 12-101 Copy the Find button from here. 

sg -R 3€: -V - Use the Recent command to return to the Class Notes stack, and 
paste the Find button on the background. 

• Use the button tool to drag the buttons to their final locations, as 
shown in Figure 12-102 (or wherever you would prefer them). 
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Figure 12-102 Final appearance of the Class Notes stack 
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If you go to any cards and any of the buttons or fields disappear, go back 
and use the appropria te tool to cut the object from the card layer and 
paste it onto the background layer. 

ENTERING DATA 

A list of 11 notes for 4 classes follows. You will en ter all this information 
into the stack. The dates are chosen at random within a narrow range. 
It doesn 't matte r in which order you enter these notes; the Sort 
command will put them in this order if you sort using the Both o ption . 

You can enter the notes fo r ca rd one on the card that is a lready showing 
in t he stack. To enter any other notes, fi rst choose New Card from the 
Edit menu, and then enter th e inform ation into the appropriate fields. 
Be carefu l typing the info rmation in t he Date and Class fields. The 
information in the other fields is to show how the stack works, and the 
content is representational only. 

To begin ente ri ng the information, click in the Date fi eld to put the text 
insertion poin t there (or p ress th e Tab key to select the first field). Then, 
after typing the info rmation for this field, you can select the next field 
by typing the Tab key o r cl icking in the n ext field . 

,. Enter the information for th e first card (as sh own in Figure 12-103). 
Refer to t he information below the figure for the actual contents. 

Card One: 
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m• • • • • • @ 

• • • • • • e 
• 

., 



Chapter 12: HyperCard 703 

Date: 3/31/91 

Class: Music Appreciation 

Assignments: Read Introduction and Theory sections, Pages 1-87 
Watch "From Antiquity to the Renaissance" video 
Exam in two weeks 

Notes: Timbre is synonymous with tone color. 

Degrees of loudness and softness in music are called 
dynamics. 

The relative highness or lowness of a sound is called 
pitch. 

The distance between lowest and highest tones of an 
instrument is pitch range. 

Pianissimo: soft, forte: loud, fortissimo: very loud. 

The pitch of a sound is determined by the frequency 
of its vibrations. 

The distance in pitch between any two tones is called 
an interval. 

The frequency of vibrations is measured in cycles per 
second (Hertz). 

A dynamic accent occurs when a performer plays a 
tone louder than the others surrounding it. 

:3€ -r • Choose New Card from the Edit menu. Enter the in formation for 
card two. Continue this process un til you have entered the 
information for all 11 cards. 

Card Two: 

Date: 

Class: 

Notes: 

4/ 3/91 

Music Appreciation 

The lowest instrument in an orchestra is the 
contrabassoon. 

A part of an instrument's total range is called a 
register. 

The highest instrument in the orchestra is the piccolo. 

Vibrato (rocking the left hand to produce small 
fluctuations) is used by string players to make the 
tone warmer and more expressive. 

Plucking a string with a finger instead of using a bow 
is called pizzicato. 

Symphonic bands differ from symphonic orchestras 
by not having a string section. 

Woodwind instruments are so named because they 
were originally made of wood. 

The range of a singer's voice depends on both physical 
makeup and training. 
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00 -N Card Three: 

Date: 

Class: 

Notes: 

00 -N Card Four: 

Date: 

Class: 

4/5/ 91 

Music Appreciation 

accent - stress or emphasis on a note. 

beat- regular, recurrent pulsations that divide music 
into equal periods of time. 

downbeat - first, or stressed, beat of a measure. 

measure- unit or group containing a fixed number of 
beats. 

meter - organization of beats into regular groupings 

metronome - apparatus that produces sounds or 
light flashes at a desired speed. 

rhythm - particular arrangement of note lengths in 
a piece of music. 

syncopation - putting an accent in music where it is 
not normally expected. 

tempo - rate of speed of the beat of music. 

upbeat- unaccented pulse preceding the downbeat. 

3/31/91 

Oral Communications 

Assignments: Read chap. 25 - Informative Speaking 
Informative speech next week - 5 to 7 minutes 

Notes: Informative speech - Select subject: What are you 
interested in? Choose something you already know. 

Inform: Create understanding; support materials and 
info should only clarify. 

Audience: What do they need to know? Select a 
narrow purpose (more manageable). 

Formulate bare bones first: 

• Main idea: points you want to cover 

• Supporting points 

• Fill out body of speech with variety of support 
(summaries, statistics, quotations) 

• Determine overall pattern (precise order) of speech 

• Intro (usually best to create this after you have 
decided what you will say) 

• Conclusion: tell them what you told them 
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W-N Card Five: 

Da~: 4/3/91 

Class: Oral Communications 

Assignments: Persuasive speech next week 
5 minutes or less!!!!! 

Notes: Persuasive speech 

W -N Card Six: 

Intro: needs an attention getter, should state main 
idea, what you want them to do 

Points: should answer question, "Why should I do 
this?" 

Conclusion: reiterate, sum up, last chance to 
influence, close neatly 

Date: 4/ 5/ 91 

Class: Oral Communications 

Assignments: Prepare that persuasive speech!! 

Notes: 3 types of persuasive speeches: 

W -N Card Seven: 

1) logos - reason - logical argument 

2) pathos - appeal to emotion 

3) ethos - how audience sees the speaker; deals with 
character, how you present yoursel( credibility 

Date: 3/29/91 

Class: Sociology 11 

Assignments: Read chapter 10- Mass Communications 
First t est will cover chapters 10-14 

Notes: Break into groups for discussions. Discuss the 
following issues: 

Life before people had TV 

1) How are fa mily holidays different with TV? 

2) How was radio different before TV? 

3) Has TV taken something away from family life? 

4) Give examples of 3 ads on TV that present instant 
solutions to problems. 

5) Saturday morning TV - what products are pitched 
to children? How do children respond to those ads? 
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8€ -N Card Eight: 

Date: 

Class: 

otes: 

8€ -N Card Nine: 

Date: 

Class: 

Notes: 

8€ -N Card Ten: 

4/6/ 91 

Sociology II 

TV is an addiction for many people - average is 4.5 
hours per day per person. 

Parents spend average of 5 minutes per day really 
talking to children. 

"Television violence does have an adverse effect on 
those children predisposed to violence, and no one 
knows how many children are predisposed to 
violence." -U.S. Surgeon General 

300-500 violent acts per week on network TV. Most 
people witness over 11,000 "deaths" (on TV) by the 
time they are 15 years old. 

4/ 8/91 

Sociology 11 

Political leaders have been elected by TV since 1960 
(since debates between Kennedy and Nixon). 
Hundreds of millions of dollars spent on this. 

News is a network person's VIEW of the news. Even 
if there is no intent to slant the news, the fact that 
some events are reported and some aren't has a 
biasing effect. Bad news and disasters generally make 
the news. Good news is aired mostly on "slow news 
days." 

Newspapers can also slant news - yellow journalism, 
banner headlines. 

Date: 3/30/91 

Class: Technical Writing 

Assignments: Read chapters 1-4 by next week 

Page 39- do "audience analysis" exercise 

Page 48- do "What's wrong with technical writing?" 
exercise 

Write paragraph to explain the part writing plays in 
your job 
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Technical writmg - practical writing people do as 
part of their jobs 

What sets technical writing apart? - It's about 
technical stuff! Usually uses different (technical) 
vocabulary. Uses sequential thought process. Uses 
facts, more to the point, meaning must be clear and 
concise (only one meaning). Uses clear, concise 
writing to convey one meaning (no ambiguity- only 
one interpretation possible). 

W-N Card Eleven: 

SORTING 

' 

Date: 4/2/91 

Class: Technical Writing 

Assignments: Write a paragraph about what type of job I want and 
the type of writing I will have to do in that job. 

Notes: communicatior - exchange, dialog 

medium - means by which message is conveyed 

document - (text) - generic term for written object 

generate -to produce (broader process than writing) 

Characteristics of technical communication: 

1) specific audience - only those interested in your 
subject 

2) objective la? guage - inform with facts 

3) clear organization - 3 part form (intro, body, 
conclusion) 

4) visual aids - must be integral part of text 

You can now check to see if you have a total of 11 cards in this stack. 

• Ch oose Stack Info from the Objects menu. It should say there are 
11 cards in the stack. 

If you decide to use this stack for keeping track of notes, you can create 
a new stack and copy the background so all the buttons and fields are 
in place. Then all you have to do is enter specific information. 

HyperCard has the ability to change the order of cards in a stack. This 
is most easily accomplished bylcreating a Sort command so HyperCard 
will rearrange cards automatic lly in the order you want. 

In this stack there are three ways to sort the cards (if you copied the Sort 
command from the Class Notes Buttons stack). 
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When you click on the Sort button you see a dialog box that lets you 
choose to sort the stack by Date, Class, or Both. 

Date sorts chrono logica lly by the con tents of the Date field. Be su re to 
enter information consistently in the Date field in the form "mm/dd/ 
yy", without entering leading zeros. For example, the entry fo r july 1, 
1995, would be 7/1/95. It is important that you are consistent and 
accurate in en tering the information in this field if you want the sort to 
work properly. 

Class sorts alphabetically by the contents of the Class field. Aga in, you 
need to be consistent when entering the contents of this field. If you 
were taking Music Appreciation and it had a class number of MUS 101, 
you would need to use one o r the other identifier, but not switch 
between them for different entries. If you use both names, the Sort script 
will sort the entries into different classes. 

Both sorts first by date and then again by class. This leaves all of the 
en tries for a class sorted in chronological order, and the classes are sorted 
alphabetically. All your Music Appreciation class notes will appear 
before the Oral Communications class notes, and inside each class the 
notes will be sorted by date. 

PRINTING REPORTS 

HyperCard has some nice reporting capabilities, as you saw in the 
previo us project, but it does not allow you to print a portion o f a stack. 
You can print a single card, the entire stack, or all of the cards on a 
background. 

The Print Report button includes a script that allows you to print a report 
based o n a range of dates o r a particular topic. When you enter the 
starting and ending date, or the topic, the script searches for all cards 
that match the conditions you specified and prints the enti re contents 
of each card to a text file . 

It then asks if you want to open the file with a word processor. If you 
want to do thi s, it gives you a choice of Mac Write, Other, o r Microsoft 
Word. They a re listed in this o rder so Microsoft Word will be the default. 
If you choose Other, you are given the opportunity to type in the name 
of your word processing application. (If you make use of this stack, you 
can edit the script so it defau lts to the word processor of your choice.) 

If the chosen word processing application is not already open, the script 
opens the applicatio n and loads the report fil e. You can then use the 
word processor to format and print the report. When you quit the word 
processor, you are returned to the Class Notes stack. 

A useful way to list all your class notes is to sort them using the 
Both option and then use the Print Report command from the File 
menu. Make the report a row report and select all four fields. This 
prints a readable copy of all your class notes sorted chronologically 
within each class. 
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SUMMARY 
• There must be a Home stack for HyperCard to function correctly. The Home stack is used to 

open other stacks and applications from HyperCard. There are several buttons on the Home 
card that represent other stacks. Opening another stack simply requires clicking on its button; 
you do not double-click as you would from the desktop. The user level may be set from the 
Home stack. 

• There are five user levels: Browsing, Typing, Painting, Authoring, and Scripting. Of these 
levels, Scripting gives the most access to HyperCard's features and Browsing restricts you to 
looking at a stack. 

• HyperCard automatically saves all changes you make to a stack. 

• HyperCard's Go menu allows you to navigate through one or more stacks. The Recent 
command shows the last 42 cards that were visited and allows you to return to one by clicking 
on its reduced-size picture. 

• Three general tools are available for your use: browse, button, and field. The browse tool is 
used to activate buttons and select fields for entering or editing data. The button tool is used 
to create, position, resize, and edit buttons. The field tool is used to create, position, resize, 
edit, and choose the text attributes for a field. 

• Buttons can contain scripts that act like small computer programs. Buttons can also be linked 
to specific cards or stacks. 

• HyperCard has a full set of Painting tools for producing bitmapped pictures. These pictures 
may be copied and pasted into almost every other Macintosh application. 

• There are two layers in every stack: background and card. Background objects are available 
on every card that shares a background. Card objects are available only on the specific card 
that contains them. 

• HyperCard comes with a Help stack that provides extensive online help. 

• Several idea stacks that are included with HyperCard contain resources for creating stacks, 
cards, buttons, fields, and pictures. 

• HyperCard's Find command locates any text in a stack within a few seconds at most. You can 
decide to search all text or just the text in a specific field. You can choose to find any group 
of characters that match what you type, or you can restrict HyperCard to finding only words 
that match the words you enterect. 

• HyperCard can print reports that are formatted for labels, rows, or columns. 

KEY TERMS 

Address stack 
Authoring level 

background button 
background layer 
browse tool 

Browsing level 
bru h tool 
bucket tool 
button 
putton tool 
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Calendar stack paint text tool 
card Painting level 
card button Painting tools 
card layer palette 
curve tool pencil tool 

Phone stack 
dynamic link polygon tool 

eraser tool rectangle tool 
regular polygon tool 

Fat Bits rounded rectangle tool 
field 
field tool scripting 

Scripting level 
General tools selection tool 

spray tool 
Home button stack 
Home card 
Home stack tear-off menu 
HyperTalk Tell Me ... button 

text field 
lasso Typing level 
line tool 
link user level 

Message box visual effect 

oval tool 

HYPERCARD COMMAND KEYS AND SHORTCUTS 

File Menu Go Menu 
Open ~-0 Back ~ --
Print Card ~ -P Home ~ -H 

Quit HyperCard ~-Q Help ~ -? 
Recent ~ -R 

Edit Menu First ~ -1 
Undo ~ -Z Prev(ious) ~ -2 
Cut ~-X Next ~ -3 
Copy ~-C Last ~ -4 
Paste ~-V Find ~ -F 
New Card ~-N Message ~ -M 
Text Style ~-T 

Background ~ -B Objects Menu 
Bring Closer ~ -+ 

Paint Menu Send Farther ~ --
Select ~ -S 
Select All ~-A 

Keep ~ -K 
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ADDITIONAL PROJECTS 

The following project is accompanied by briefer instructions than those 
you have previously completed in this chapter. If necessary, refer to the 
previous projects in this chapter for information and step-by-step 
instructions for any command that you don't remember how to use. 
Also, HyperCard's Help file contains valuable and easily accessed 
information. 

Project 4: Creating a Dynamic Company Organization Chart 

In this project, you will create an organization chart similar to the 
second project in the MacDraw chapter. Although the charts look 
almost alike, there is a big difference in what they do. The chart in 
MacDraw is static. You create it, print it, and there it sits. 

The chart you will create in this project is a dynamic chart. When you 
click on one of the people represented on the chart, HyperCard takes 
you to another card that shows more information on that person. You 
then can return to the chart to obtain information on someone else. 

Let's get started. 

- Change the user level to Scripting. 

• Choose New Stack. Name the stack Company Organization and 
store it on your data disk (see Figure 12-104). 

Edit Go Tools 

~ 
lntr-o 

~ 
Phone 

~ 
Art ldus 

li1EI 
~ 

Plots 

I [g) Morsho Szczeponslcl ... I 
D D & K I. O!JO Dl"<lllling ~ [g) Morsho Sz ... 
D II & K I.O!JO P<Jin lin!J I 
D CI<I~S Nllh~s I111 1t on~ ri ( Eject ) 
D COli~) of CIIH OmNs :;: ( Drlue J 
D COli~) of lrlli<H110I"!J :•: 
D COII~J Of '>nh~s lrn•oi .. , 

New stoclc nome: 

I Compony Orgonlzotlon ' I 
I D Copy current boclcgrou~d 

~ 
1.2 .5 Rtl+~n Nott s 

LB§Oi;:J 
[ Concel ) 

Boolc Sholf 

Quot~tions 

5:36PM 

Figure 12-104 Creating the new Company Organization stack 
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• Using the Painting tools, create the organization chart as shown in 
Figure 12-105. The fonts are Geneva 9-point and 12-point, plain text 
and bold . 

Figure 12-105 Painting the organization chart 

• Center tne chart on the screen using the selection tool (see 
Figure 12-106). 

' '* File Edit Go Tools Point Options Patterns 

r-------------------------------------------
Acme Toys Incorporated 
Menufecturers of Fine Toys 

Figure 12-106 Center the chart on the screen 

• 
• 

Choose Bkgnd Info from the Objects menu . 

Name this background Ch~rt, and set it so it can' t be deleted (see 
Figure 12-107). 
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' • File Edit Go Tools ' 

Background Name: I Char~ I 
Background I D: 2739 

Background sh11red by I cards. 

Contains I background fields. 

Contllins 2 bllckground buttons. 

181 Can•t delete background. 

[ script ..• ) f( OK ) ( Cancel ) 

I I I M>ll>90r I I 

oc:> 

Figure 12-107 Naming and protecting the background 

Creating Directory Background 

Now that you have completed the organization chart, it is time to create 
a directory listing for each of the people on the chart. 

Let's use the same background painting for the chart and the directory. 

:#.: -B .. Change to the background layer. 

The chart disappears when you f hange to the background layer, but the 
picture of a stack of paper is still there. 

,. Double-click on the selecti0n tool to select the entire background. 

W -C • Copy the background. 

• Choose New Background from the Objects menu. 

W-V • Make sure you are in the ~ackground layer, and then paste the 
background picture. 

• Choose the field tool, and add the background fields and text for the 
directory (see Figure 12-108). 

The choices of fonts, sizes, and styles are up to you. 

• After you create the fields, double-click on each one (with the field 
tool) and give it a name, such as Title, Name, Address, and so on. 

• Name this background Directory. 

• Select the browse tool. 

• Enter the information for e president (see Figure 12-108). 
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,.. .J File Edit Go Tools cts 
.., 

Titl• .. P..r.~.S..J.Q~.O.t ........................................................................................................ .. 

Nam• .. J..~.m~.§. ... 'W.., ... ~.t~J..~.~.O. ............................................................... .. 

Hom• Addnss ..!..1J .. ~ .. ~~.l.~:'!f.!.Q.E.9.~.~---· · ................ - ........................................................ .. 
.. !?.~!l.19.0~.Q~ .•. !;llL~§I?.?.I?. ........ _ ................................................................ .. 

Offic• 
Ext•nsion .. .!..?..?..?. ............................ -........................ . 

Offic• Numb• r .. J..?..Q.J.! ......................... -.................... -... . 

Figure 12-108 The Directory background and president's in fo 

3g- N • Create a new card, and enter the information for the vice-president 
of sales (see Figure 12-109). 

,.. .J File Edit Go Tools 0 ects 
.., 

Titl• .. V.J~.~.:::.P..r.~.S.J..Q~.O.t ..... S..~J.~~ ......................................................... . 

Nam• _t;;. _~.[QJ_.G.~.r.:.ro..~ ............ - ......... _ .................... _.,_ .. __ , ___ .. __ _ 

Hom• Addr• ss .. !1.~.?1..~rn!.l.h~.9.!l...~.Y..'-D.Y~ .... - ........ - ................... --................. - ....... .. 
.. tl~r.i!.t!.~~ .. !l.~-~.~~.!!.7. ...... - ........... _ .. _. _________________ ...... .. 

Hom• Phon• .. (1.!1.11.~~-~:.!1.7..!!.;1 .............................. _ 

Offic• 
Ext•nsion .J..9.JA ........ -....... -..... - ......... _ ............ . 

Offic• Numb•r .. J..9. .. Q} ....................................................... . 

Figure 12-109 Entering information for the V.P. of sales 

3g - N • Create a new card for each of the other five people on the chart, and 
make up the information you en ter for each of them. 

You should now have a background named Chart with one card and a 
background named Directory with seven cards. 
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Linking Cards 
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You created the card with the chart and each person's name. Then you 
created a separate card in the Directory background for each person on 
the chart. Now you need to add some buttons to allow navigation 
around the stack. 

• Copy a Home button from another stack and paste it onto the 
bottom right corner of the card containing the organization chart 
(see Figure 12-110). 

,.. a File Edit Go Tools cts 
., 

( Acme Toys lncorporoted 
M6nuf6cturers of F1ne Toys 

James Y . Nielsen 
Pr esident 

Carol Garmo Jtffrty Hal• Richard P. Cluvts 
\lico-Prosidont, l'icr ·Prosidont, l'ico-Prosidont, 

Salts Manufactur ing Finane• 

I I I 

Clyde C. Rigglo A law ay no Parks Robtrt P . Nimon 
Salts Managor Ma~ufacturing Controlltr 

anager 

Figure 12-110 Adding a Home button to quit the stack 

This button is for going back to the Home stack when you are ready to 
leave this stack. 

Now you will add a transparent button on top of each name in the 
organization chart. Each of these buttons will be linked to the appropriate 
card in the Directory background. 

• Select the button tool. Position the pointer just outside the top-left 
corner of the president's box. 

,,. Press the Command key, and drag a rectangle for a new button that 
surrounds the president's box. 

This is a shortcut method for cr~ating a new button. 

• Double-click this new button, make it transparent, and deselect the 
option for showing its namt 

Your screen should look like th l one in Figure 12-111. 



716 Part V: Information Management 

r • File Edit Go Tools 0 ts 
., 

l Acme Toys lncor poroted J 
Menufecturers of Fine Toys 

·~·- .... ·-.. .............. --- ~ 

J ames Y. Nielsen 
President 

............. ·············+ 

Carol Oarm~ J~ffr~y Hal~ Richard P. Cl~av~s 
Vic~-Pr~sid~nt , Vice-President , Vlce-Pres ident, 

Sal~s Manufacturing Finane~ 

_j_ _j_ _j_ 

Clyde C. Riggl~ Alawayno Parks Rob~rt P . Nim~n 
Sal~s Manag~r Manufacturing Controll~r 

Manag~r 

Figure 12-111 Adding a new button on top of the president's box 

You are ready to tell HyperCard to link this button to the president's card 
in the Directory background. 

,.. Double-click the new button and, when its information dialog box 
appears, click LinkTo. 

A new mini window appears floating above the card. Most of you are 
probably unfamiliar with the term mini window. HyperCard introduced 
a new type of floating window that could be moved and closed, but not 
resized. Its main characteristic that distinguishes it from a window is 
that it floats in front of all other windows and has a gray pattern in the 
title bar rather than horizontal lines. The Message box, LinkTo box, and 
Tools and Patterns palettes are all mini windows. They are the exception 
to the rule that all action takes place in the front window. When one or 
more mini windows are present, all actions will still take place in the 
active window with the exception of activity directly in the mini 
window. This way you can use the palette to choose a different tool or 
pattern, and draw in the active window without forcing any mini 
windows to go behind the active window. Mini windows are also known 
as floating windows. 

This mini window allows you to link the button you just double-clicked 
with a specific card in a stack or with the first card of a stack. The stack 
can be the current one or any other stack. 

You want to link to the president's information card. 

• Use the arrow keys on the keyboard, the Go menu, or the Command
key equivalents to go to the next card. When the president's card 
is showing under the linking mini window (see Figure 12-112), click 
This Card. 
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The link is now completed. 

,.. -' File Edit Go Tools Ob cts 
., 

Titl• J:>.r.:~.~Jq~nt .......... -····--·················-··-·······--···-···-·······-··············-·······--·· 
g 0 !i!iiiiiiiiiii!i!ii#iii!iiiiiiiiiii"iiii!iiiiiiiiiiiiii;iiiii!Hiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii!iiiiiiii!iiiiiiiiiiiiiiiiiiii 

Go to destination, then aim linlc at: 

[ This Card~ [ This Stack J [ Cancel 

Offici! 
Ext•nsion ... 1.?..'?,.?. ____ ·····-··-·······-··········---·····-·-· 

Offici! Numb•r ... J..?..QJ_ ........... -·························-···········-

Figure 12-112 Linking a button to this card 

Unfortunately, you have not provided a way to get back to the chart card 
without using the keyboard, the Go menu, or Command-keyequivalents. 
Let's add a button to the Directory background that links to the chart 
card. 

,,.. In the lower left corner of the Directory background picture, draw 
a small picture of the chart. y se Fat Bits to make this easier if you like 
(see Figure 12-113). 

' · ·• ·'rile' · iti1i · · 6o · roo is· · i>ain't' · opiions • · P'81tei-ri5 · · · · · · · · · · · · · · · · · · ... 

Figure 12-113 

1•••n••n••1 
I I • • • • ............. • • ........................... • • • ......... ......... .. ...... . • • • • • • 

I . . . . . • • • • • • • • • ........ ......... ... ..... . • • • • • • ......... ......... ... ..... . 
I I I I I I 

I I I I I ......... , ......... ... ... --; 
Drawing a small picture of the organization chart 
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• When the picture is as you want it, create a transparent button over 
it, and then link the button to the card containing the organization 
chart (see Figure 12-114). 

Hom• Phon• 

Officl' 
Extl'nsion 

Officl' Numbl'r 

Figure 12-114 Creating a button to link to the chart card 

• Return to the chart card, and create a button on top of each box in 
the chart. Link each button to the appropriate card. 

When you have completed this, you will be able to click on any name 
in the chart, and HyperCard will show you information about that 
person. Then, by clicking on the button at the bottom left corner of the 
information card, you can return to the chart. When you are fin ished, 
you can click the Home button to close the stack (but don't do that yet). 

Printing Directory Report 

You have seven ca rds in the Directory background, and each of them 
contains information about one of the people in the organization chart. 
This provides a convenient way to print a corporate directory (at least 
for seven employees). 

• Go to one of the information cards in the Di rectory background. 
Choose Print Report from the File menu, and select the options 
shown in Figure 12-115. 
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Edit Go Tools 

Print report... Copies:EJ 

0 Manual paper feed 
0 Darker printing 

r·--···· .. r-···-··-·····---------------- ------~ 

!·-·---~--·-·--·---··-----···--! 
! I i r·----r-···-----------------------... -·1 
~--M--.. -·r--·····---.. --------·~----~ 

r--------~--------------------------- - -------1 
~----.·-:·-------·------------ ·--······--i 

l::==t=-~~:~~~:= .=~::=::_~j 
i ! ! 
i.----~-·----------- -~----··-------------1 

fields in: H OK IJ 
0 lab !liS ( Cancel I 
O Columns • 
@ Rows· - CiJ[I) II:lrn 

1 • - [ffiJ rnm 
Print t'\Ht fields from oil cards: 
0 In the entire stack 
® WitH the current background 

Which f,ields: 
0 Card fields 
18] Selected background fields: 
Title :!': 
Name • 
Addre~s II 
Home Phone :i2 

Print the names of: 
0 Ca~ds 18] Fields 

Figure 12-115 Selecting options for printing the directory 
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By telling HyperCard to print text fields from all cards with the current 
background, you restrict the prih ting to the background you were in 
when you chose the command. This is handy for printing information 
in a stack with multiple backgrounds when you wantonly the information 
in a particular background. 

~ When you have made all the selections, click OK. 

This creates a two-column report with information about the seven 
people on the chart. 

If you like, you can also tell HyperCard to print all of the cards. 

There are a number of ways this stack can be enhanced without too 
much additional work. It would be easy to copy the Phone button from 
another stack and paste into th~s one to automatically dial a person's 
number. With a little more effort, you could add a map of the company's 
headquarters and show where the person's office is. A photograph of the 

I 
person could be scanned into the system and stored with his or her 
directory card. 

If you want to try any of these ei)hancements, go right ahead. You will 
find that HyperCard's abilities expand more and more as you learn to 
make use of them. 

SCRIPTS FOR CLASS NOTES BUT ONS STACK 

The following scripts may be en ered if you do not have the Macintosh 
Journey Projects disk. Be careful t~ping in the scripts. The character "--{' 
represents a continued line of HyperTalk code and is entered by holding 
the Option key down while youl press the Return key. 
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SORT BUTTON SCRIPT 

on mouseUp 
answer " Sort by what? " with "Date " or "Class " or "Both " 
if it is "Date" then 

Sort datetime by bg field "Date " 
else if it is "Class " then 

Sort by bg field "Class " 
else 

Sort datetime by bg field " Date " 
Sort by bg field "Class " 

end if 
end mouseUp 

PRINT REPORT BUTTON SCRIPT 

© 1990 by John L . Dilbeck , COP 
All rights reserved worldwide 

on mouseUp 
set cursor to 4 
put the number of cards into cardcount 

put space & return into ret 

get the l ong name of stack 
delele first word of it 
delete first char of it 
delete last char of it 

repeat while (last char of it<> '' : " ) and (length(it) > 0) 
delete last char of it 

end repeat 

put it into reportfilename 

ask " What do you wish to name the report? " with " Enter Name Here " 
repeat while it is " Enter Name Here" 

beep (l) 
put " You must enter a file name " 
ask " What do you wish to name the report? " with "Enter Name Here" 

end repeat 

put it after reportfilename 

answer " Do you want to produce a report based on " wi t h --, 
"Cancel " or "Dates " or " Topics " 

if it is "Cancel " then 
exit mous eUp 

end if 

Open file reportfilename 
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if it is " Dates " then 
-- produce a report based between two dates 
ask " What is the beginning date" with " mm/dd/yy" 
repeat while it is " mm/dd/yy" 

beep (1) 
put " You must enter a beginning date " 
ask " What is the beginning date " wi t h "mm/dd/ y y " 
hide message 

end repeat 
put it into StartDate 
convert StartDate to short date 
put it into startfinddate 
convert startfinddate to short date 

ask " What is the ending date " with "mm/dd/yy" 
repeat while it is " mm/dd/yy " 

beep(l) 
put " You must enter an ending date ~ 

ask " What is the ending date" with " mm/dd/ yy " 
hide message 

end repeat 
put it into EndDate 
convert EndDate to Short date 

write "Class Notes Report between " & quo t e & ---, 
StartDate & quote & " and " & quote & EndDa t e & quot e ---, 
& return & the long date & tab & the time & ---, 
return & return to file reportfilename 

Sort by bg field " Class " 
Sort datetime by bg field " Date" 

go to card 1 of this background 
put fld "Date " into testdate 

repeat until testdate >= StartDate 
put " Searching ... " 
go to next card 
put field "Date " i nto t estdate 

end repeat 

hide msg 

repeat while testdate >= StartDate a nd testdat e <= EndDate 
write "Date :" & tab & field "Date" & return & ---, 
"Class :" & tab & field "Class " & r eturn & ret u rn & ---, 
" *** Assignments *** " & field "Assignments " & ---, 
return & return & -. I 
" *** Notes **** " & field " Notes ~ & retur n & return & ---, 
"-------- - --------------- --" & return & r e tur n ---, 
to file reportfilename 

if the number of this card 
exit repeat 

end if 

cardcount the n 

721 



722 

go to next card 
put field " Date " into testdate 

end repeat 
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else 
produce a report based on all cards containing a certain topic 

ask "What is the search topic? " with "Enter topic here " 
repeat while it is "Enter topic here" 

beep (1) 
put "You must enter a search topic " 
ask " What is the search topic? " wi th "Enter topic here" 
hide message 

end repeat 
put it into searchcriteria 

write " Class Notes Report concerning " & quote & ~ 
searchcriteria & quote & return & ~ 
the long date & tab & the time & return & return ~ 
to file reportfilename 

go to card 1 of this background 
find searchcriteria 
if the result is " not found " then 

beep (1) 
put "That topic is not found" 
wait 180 
hide msg 
close file reportfilename 
exit mouseUp 

else 
put the id of this card into startedhere 
put false into foundtwice 

end if 

repeat until (the id of this card 
foundtwice is true 
put true into foundtw i ce 

startedhere) and ~ 

write "Date:" & tab & field "Date" & return & ~ 
"Class :" & tab & field "Class" & return & return & ~ 
"*** Assignments *** " & field "Assignments" & ~ 
return & return & ~ 
" *** Notes **** " & field "Notes" & return & return & ~ 
"------------------- -------" & return & r eturn ~ 
to file reportfilename 

go to next card 
find searchcriteria 

end repeat 

end if 
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Close file reportfilename 
put "The file has been saved ." 
wait 60 
hide message 

answer " Do you want to open the file?" with "No " or " Yes " 
if it is " Yes " then 

answer " Which Word Processor? " with "MacWrite " or "Other" ..., 
or "MS Word" 

if it is "MS Word " t hen 
open reportfi l e n ame with "Microsoft Word " 

else 
if it is "MacWrite" then 

open reportf i lena me with "MacWrite " 
else 

ask "What is the name of your Word Processor" with ..., 
" Enter Name " 
if it is " Enter Name " then 

beep(l) 
else 

open reportfilename with it 
end if 

end if 
end if 

end if 
end mouseUp 
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1-up labels Labels, usually mailing labels, that 

are one form wide. 

3-up labels Labels, usually mailing labels, that 
have three forms side-by-side on each row. 

absolute addressing A method of addressing a 
cell or a range of cells in a spreadsheet. 
Absolute addressing does not change if a 
formula or cell reference is moved, copied or 
pasted. (See also relative addressing) 

active cell The cell in a spreadsheet that is 
marked by a heavy border. Anything typed 
o n the keyboard is entered into the 
active cell . 

active record indicator A small, black vertical 
line that appears to the left of the current 
record in FileMaker's Browse mode when 
records are viewed as a list . 

active window The window that is on top of all 
the other windows; the window in which you 
may work. The title bar and scroll bars are 
highlighted . All other windows are inactive 
and their title bars and scroll bars are white. 

actual size A representation that approximates 
how the output will look when printed. (See 
also actual size window) 

actual size window When viewing a MacPaint 
drawing at 800% size, the actual size window 
displays the drawing at 100% (actual) size. 

Address stack One of the personal utility stacks 
included with HyperCard. It is useful for 
storing names, addresses, and phone numbers. 

algorithm A step-by-step process used to solve a 
problem or accomplish a task. A computer 
program is a group of algoi"ithms coded into 
a computer language in a form the computer 
can follow. (See also program, software) 

alignment How two or more objects line up, 
whether graphic objects or text. With graphic 
objects this can includ~ centering one object 
inside of another or placing objects so that 
their top edges are at the same horizontal 
level. Text alignment can include horizontal 
alignments such as flush left, flush right, 
just ified, and centered, and ve rtical 
alignments such as centered between the top 
and bottom margins. 
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analytical graphics Charts and graphics useful 
for analyzing a numeric problem. These 
graphics a re often produced using a 
spreadsheet program. (See also presentation 
graphics) 

Apple menu The menu located on the far left of 
the menu bar at the top of the screen. Instead 
of the word 11 Apple" it has the symbol of an 
apple. (See also menu, menu bar) 

application program There are two basic types 
of programs: app lication and system 
programs. An application program is designed 
and programmed to accomplish a particular 
task. For instance, Microsoft Word is a word 
processing application program. Most of the 
programs advertised for sale are application 
programs. (See also software, systems program) 

application software A term that applies to 
application programs as a group. (See also 
application program) 

arc tool A tool in a drawing program used to draw 
an arc or part of a ci rcle. 

area chart A chart, similar to a line chart, that 
emphasizes the amount of change over a 
period of t ime. 

arguments Val ues that are enclosed in 
parentheses and are used as input to a function 
in a formula. 

arrow pointer The shape the mouse pointer 
takes when it is possible to use the pointer to 
select something, such as a command from 
the menu bar. 

arrow tool A tool available in many programs 
for moving objects. 

ascending order An order in which information 
can be sorted. For text, ascending order is 
11 A" to 11Z" and for numbers it is lowest value 
to highest. 

Authori+g level One of the five user levels in 
HyperCard. The authoring level allows you 
to h~ve full access to all the tools in the 
program other than scripting in HyperTalk. 

Autogrid An option in MacDraw that allows an 
object to be drawn or moved according to the 
division increments in a grid. 
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automatic page break The point where text 
automatically goes to a new page in Microsoft 
Word based on the top, bottom, left, and 
right document margins. 

automatic styles Predefined styles that are 
built in to Microsoft Word, such as Normal 
and footer. 

background button A button, in HyperCard, 
that is common to all cards sharing the same 
background. 

background layer A template, in HyperCard, 
that can be shared by a number of cards. 
Pictures, fields, buttons, and other objects 
can be placed in the background layer and 
accessed from each of the cards that share 
that background. 

backup Making a copy of your data on more 
than one disk. The idea is to copy all data on 
a disk onto another disk at periodic intervals 
depending on how valuable the information 
is, and how difficult it would be to recreate it 
if it were lost. 

bar chart A chart that compares items by showing 
values at a specific time. It is composed of a 
number of horizontal bars. 

baud The rate at which data is t ransmitted in 
serial communications. Common baud rates 
are 300, 1200, 2400, 9600, and 19200 baud. 

bit An abbreviation of Binary digiT. A bit is a 
unit of information that can represent one of 
two states-on or off. Eight bits are defined 
as a byte. 

bitmapped A method of storing a graphics 
object or a font by representing each dot as 
on or off. Since a bit can easily do this, this 
type of graphic or font is mapped onto a grid 
of bits, resulting in an area that is bitmapped 
and easy to reproduce on the screen or printer. 
(See also bit, object-oriented) 

blank report A report in FileMaker in which 
the user specifies the placement of all fields, 
text, graphics, and other objects. It is the 
most flexible report format, but FileMaker 
h elps the least in this report format. 

block quote A quote that is indented on the 
left and right so as to differentiate it from the 
rest of the document. It does not require 
quotation marks. 
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Body part The main part of a FileMaker report. 
File Maker prints one body part for each record, 
and prints as many as will fit on a page. 

book A tool in FileMal<er that is used to access 
other records and layouts. 

border palette The portion of the MacPaint 
toolbox that is used to change the weight of 
the outline of an object as it is drawn. 

borders Lines or boxes placed around objects 
or text. 

Browse mode A mode in FileMaker that lets you 
view, edit, add and delete records. 

browse tool The tool used in HyperCard that is 
shaped like a pointing hand, and is used to 
click buttons and place the insertion point 
in fields. 

Browsing level The user level in HyperCard that 
allows you to view a stack but not make any 
ch anges to it. 

brush shapes The various sizes and shapes of 
paint brush available with the paint brush 
tool in MacPaint and HyperCard. 

brush tool The brush tool is used to paint with 
a specific shape using the current pattern in 
MacPaint and HyperCard. 

bucket tool The bucket tool is used to pour the 
current pattern into an enclosed white area 
or a continuous black area in MacPaint and 
HyperCard. 

business graphics Business graphics are normally 
used in business management and 
presentations to management and they 
include pie charts, line graphs, bar charts, 
and o thers. Many of these graphics are 
produced by spreadsheet, data base, and 
presentation programs. Business graphics may 
also mean pictorial representations and 
informational screens which can be produced 
by a wide variety of programs on the 
Macintosh. (See also analytical graphics and 
presentation graphics) 

button An area on the screen that is a basic 
component of the Macintosh user interface. 
A button allows you to start an action by 
moving the pointer into the area defined by 
the button and then clicking the mouse. 



Glossary 

button tool The tool used in HyperCard to 
create, select, modify, and delete buttons. 

byte A byte is a unit of measurement that is 
defined to be 8 bits. On the Macintosh we can 
think of it as being the amount of storage 
used to store o ne characte r, such as an "A" or 
a " 1". (See also bit, kilobyte, megabyte) 

cable A set of one or more wires used to send 
information between peripheral devices. 

calculation field A type of fie ld in FileMaker that 
contains a value calculated from other fields 
in the same record . 

Calendar stack One of the personal utility stacks 
included with HyperCard. 

cancel box The small box in the formula bar in 
Excel. Clicking in this box discards any 
changes made to t he active cell and leaves it 
as it was. 

card A type of HyperCard object that is the basic 
storage component of a stack. an d can hold 
graphics, buttons, and fields. A card h as a 
background layer and a card (or foreground) 
layer. 

card button A button that appears on a single 
card in HyperCard. 

card layer The storage area of a card where 
objects such as graphics, fi elds, and buttons 
may be p laced. Th ese objects are o nly 
accessible from the card that contains them. 

cell address The combination of column letter 
and row number that identifies the location 
of a cell in a spreadsheet program such as 
Excel. 

cell The intersection of a row and a column in an 
electronic spreadsheet, such as Excel, and in 
a table, such as created using the Tables 
feature in Microsoft Word. (See also column, 
formula, row, spreadsheet) 

center tab Text is centered around the point at 
which the center tab stop is placed on the 
ruler in Microsoft Word. 

Central Processing Unit (CPU) The actual 
computer in a computing sys t em. In 
microcomputers, the CPU is a single integrated 
circuit (chip). Larger computers have CPUs 
that take multiple boards, each of which 
contains multi ple integrated circu its. 
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charact r A symbol having a meaning that is 
stan ard ized an d widely recognized. 
Common characters are the lette rs you are 
reading, numbers, punctuation, and ot her 
specialized symbols like dollar signs. 

chevrons Special pairs of characte rs(<< , ») that 
precede and follow a merge field in a Microsoft 
Word print merge document. (See also merge 
fields) 

click Quickly pressing and releasing the mouse 
butto n without moving the mouse. (See also 
mouse, mouse button) 

clip art Clip art includes electronic art, saved in 
a number of formats, that can be pasted into 
applications. The term derives from books of 
art which were d istributed. You would cut 
(or clip) the a rt from the page with scissors or 
a knife, and paste it o n to the pasteup of 
the document you were c reating. Clip art 
is distributed commercially by a number 
of vendors. 

Clipboard A special file, located in the system 
folder on the current startup disk, that holds 
one item. This item may be text, a picture, or 
any other copyable item on a Macintosh. The 
Clipboard contains the last item cut or copied 
in any application or desk accessory. Any 
time you make a new copy, the old copy on 
the clipboard is replaced. 

close box The sma ll, whi te square box on the left 
side of the title bar of the active window. 
C li ck ing in this close box closes and 
deactivates that document, or closes a folde r 
and moves up o ne level in t he file system. 
Clicking in the close box is the same as 
choosing Close under the File menu. 

column A vertical grouping of cells in an 
electronic spreadsheet, such as Excel, and 
in a table, such as is created using the 
Tables feature in Microsoft Word. (See also 
spreadsheet, table) 

column chart A chart used to draw comparisons 
amolg several items over a period of ti me. 

columnf r report A type of report, available in 
info~nation management programs, where 
the fields are listed across the top row of the 
repo~t, and the data in those fields is listed in 
columns below t he fi eld head ings. 
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combination chart A chart where related 
information is shown using more than one 
chart type. 

Command key A modifier key on your keyboard 
that causes a command to be performed 
when it is depressed along with one or more 
other keys, or when depressed along with a 
mouse click. The original name for the key 
that is also ca lled the Apple key. New 
keyboards have both the apple symbol and 
the clover leaf symbol (also referred to as the 
propeller symbol). Older keyboards only have 
the clover leaf. 

Command-key equivalent Instead of choosing 
a command from a menu using the mouse, 
most applications give you the option of 
pressing a key in combination with the 
Command key to issue the command. For 
example, Command-S usually means Save, 
Command-C is Copy, Command-X is Cut, 
and Command-V is Paste. 

common carrier A standard communications 
network such as the Bell phone systems. 

concatenate The process of joining two or 
more data items into one longer item by 
joining the beginning of the second item to 
the end of the first item. 

conditional printing The ability to check the 
contents of a field in a data file and insert and 
print different text based on the value of 
that field . 

constrain Using the Shift key while moving or 
drawing an object iri MacPaint, HyperCard 
and MacDraw limits, or co nstrains, the 
movement of the object either vertically or 
horizontally. 

context sensitive help An application help 
system that can identify the context in which 
an action occurred. The help program can 
determine where the pointer is, or what you 
are trying to do when you ask for help. The 
system then tries to give you help for the 
specific task you are performing, or the specific 
object you are accessing. 

copy (1) To make a duplicate of something by 
selecting it, and choosin g Copy from the Edit 
menu. What you copied is placed on the 
Clipboard, and may then be pasted one or 
more times in other locations. (2) To make a 
duplicate of a file by selecting a file icon and 
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then choosing Duplicate under the File menu. 
(3) To make a duplicate of an entire disk by 
dragging the icon of one disk onto the icon of 
a second disk. This will destroy what was on 
the second disk and duplicate all of the files 
on the fi rst disk onto the second. 

corner/center control The cont rol at the 
bottom of the tools palette in MacDraw that 
determines the starting poin t when drawing 
an object (either from center to corner or 
from corner to corner). 

cross-beam pointer When drawing ob jects in 
MacPaint, HyperCard, and MacDraw, the 
arrow pointer changes to the cross-beam 
pointer when it is moved into the drawing 
window. 

CRT (cathode ray tube) A television-like device 
for displaying computer output. 

currently selected pattern The fill or line pattern 
that is shown in the currently selected pattern 
portion of the patterns menu in MacPaint 
and the patterns palette in MacDraw. In 
MacPaint and HyperCard, the currently 
selected pattern controls the pattern of the 
objects drawn with the filled shape tools and 
the pattern used with the paint bucket, paint 
brush, and spray can. In MacDraw it refers to 
the fill and line pattern of any object drawn 
with the shape tools except for the freehand 
and polygon tools. 

curve tool A tool used in HyperCard for drawing 
free-form shapes. 

cut To remove something by selecting it, and 
ch oosing Cut fro m the Edit menu. What you 
cut is placed on the Clipboard, and may then 
be pasted one or more times in other locations. 

data Raw facts. 

data document One ofthe !1ecessarycomponents 
of a print merge pro ject in Microsoft Word.lt 
contains the data records to be merged with 
the main merge document. 

data point A category with a corresponding 
numeric value. 

data series A collection of related data points. 

database An organized collection of data stored 
in a group of related files. 

date field A type of field in FileMaker that holds 
a date. 
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decima l-a ligned tab When typing numbers in 
columns, the method of having the computer 
automatically align the numbers by lining up 
the decimal poin ts. 

defa ul t (1) The initial, predetermined setting for 
an o ption in a program. The user has the 
optio n of changing this setting, or accepting 
it as is. An example is the default setting for 
page margins in a word processing program. 
These margins are normally set to give 
standard margins all around the page, but the 
user may override these defaults and increase 
or decrease the margin settings. (2) When 
using butto ns in a dialog box, the default 
button is the one that is highlighted with the 
larger, darker oval. Default buttons may be 
chosen by clicking on the button, or by 
pressing the Return or Enter key. 

Define The process of naming a field in 
FileMaker and specifying its type of contents 
and entry optio ns. 

defined term A te rm listed in Excel's help file. 

de li mite r A character that is used to indicate 
the end of one item and the beginning o f 
another. When used in producing a print 
merge document in Microsoft Word, all data 
fie lds are delimited, or sepa rated, with 
commas or tabs. 

descending o rder An order in which info rma
tio n can be sorted. For text, descending order 
is "Z" to "A" and for numbers it is highest 
value to lowest. 

deselect Clicking somewhere on the screen so 
that a selected object is no longer selected. 

des ktop publishing The use of microcomputers 
and page layout programs, or fu ll-featured 
wo rd processors, to completely design, edit 
and layout the contents of a document. These 
programs then allow the user to produce 
camera ready output when the document 
is pr inted o n a laser printe r or a 
phototypesetter that is capable of interpreting 
PostScript output. 

deskto p The Macintosh interface revolves around 
the metaphor of items on a desktop. files, 
folders, calculators, clocks, notepads, and 
other items a re normally found on desktops. 
The desktop is the screen you see when you 
first sta rt the Macintosh. It is normally a gray 
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area with a menu bar over it, disk drives 
on the right side and a trash can in the 
lower right corner. The actua l pattern 
can be changed with the Control Panel 
desk accessory. 

destina ti on disk A disk that receives a fil e that is 
being duplicated, copied, o r moved. 

detail repo1t A report that lists one o r more lines 
of output for each record. 

d ia log box A box that pops onto the screen and 
allows the user to interact with the computer. 
Almost all dialog boxes contain messages to 
the user, and allow the user to respond. Ma ny 
dialog boxes also allow the user to select 
options and perform o ther commands. All 
men u cho ices that end in an ellipsis( .. . ) are 
followed by a dialog box requesting more 
input from the user. 

dimmed Most commands in a menu appear in 
black text, but dimmed commands appear in 
gray text. When the command is dimmed, it 
means that it may not be chosen at that 
point. Dimmed icons represent di sks, 
documents, applications or folders that are 
located on a disk that has been inserted into 
the system, and then subseq uently e jected. 
The documents may not be opened while the 
disk is ejected. 

direct access A m ethod of accessing da ta 
without having to read the preceding data. 
Usu all y applies to RAM memory and 
disk drives. 

directo ry window The window that contains 
the listing of the contents of a folder or d isk. 

disk drive The device that contains the disk or 
di ske tte. A disk drive is ab le to read 
information from a di sk, a nd wr ite 
information onto a disk. 

document Information created and stored on 
disk by application or system program s. On 
most computers these are called data fil es. 
The Macintosh term "document" may be 
more descriptive, because each of these files 
is associated with a document icon in 
the Finder. 

do t leaders A series of dots that lead up to a tab 
position. Tab leaders make it easier for the eye 
to follow the area between the tab positions. 



730 

dot-matrix printer A type of impact printer 
that prints by causing small pins to strike the 
ribbon against the paper. The name is derived 
from the fact that all characters are made up 
of a matrix of dots (dots aligned in rows and 
columns) . The printer prints by moving a 
printhead, containing the pins, left and right 
across the page and causing the pins to 
strike as needed. The ImageWriter II from 
Apple is the standard dot matrix printer fo r 
the Macintosh . 

double-click The process of placing the cursor 
where you want it and then clicking the 
mouse button twice in rapid succession 
without moving the mouse. Normally, you 
must click twice in about a half-second to be 
interpreted as a double-click. The t ime delay 
allowed for double-clicking may be changed 
in the Control Panel desk accessory. 

dpi (dots per inch) The number of dots displayed 
o r printed in an inch. The standard Macin tosh 
screen displays 72 dots per inch. The 
Laser Writer prints at 300 dpi. The higher the 
dpi, the better the print or screen resolution. 

dragging The process of positioning the cu rsor 
over some ob ject, pressing the mouse button 
and holding it down, moving the mouse to 
reposition the cursor to a new location, and 
then releasing the mouse button. Dragging 
has three main uses: (1) to make a large 
selection by surrounding and selecting a ll 
objects in the selection area; (2) to move an 
icon by dragging it to a new locatio n; (3) to 
choose a command from a menu by cl icking 
on the menu name, dragging down to the 
item desired, and releasing the mouse button 
to select that command. 

drawing format The default format for saving a 
drawing created in MacDraw. 

drawing tool The small vertical line to the right 
of the tab icons on the Microsoft Word ruler. 
It is used to place a vertical line in a document 
corresponding to the drawing tool's position 
on the ruler. 

drop-down list A list of options that drop down 
when you click on the arrow to the right of 
certa in option boxes, such as the underline 
drop-down list available in the Character 
dialog box in Microsoft Word. 
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DSDD disk Double-Sided Double-Density d isks. 
Standard 3.5-inch disks capable of holding 
800K. 

dummy argument A placeholder argument that 
indicates the type of argument that should be 
input to a function. 

Duplicate command The command used in 
MacDraw to create a dupli cate of an ob ject in 
a drawing. It works like a combina tion copy 
and paste command in one action. 

duplicate An exact copy of the original. 

dynamic link An object in HyperCard that 
links to other ob jects. It can be a button or a 
text phrase that is used to take the viewer to 
a different card or other related information. 

Edit menu Most Macintosh programs have an 
Ed it menu following the Apple menu and File 
menu. Usually the Edit menu will contain at 
least Undo, Cut, Copy and Paste. It freq uently 
contains Clear as well. The Edit menu is one 
of the most standardized of the menus used 
on the Macintosh. 

editing Changing or modifying th e contents of 
a document. This includes editing on paper 
whil e proofreading, and/or changing a 
document on the computer. 

electronic circuit board A board containing 
electronic circuits and attached integrated 
circuit chips. This is also called a card or 
printed circuit board. 

electronic data processing (EDP) The processing 
of data into information using electronic 
devices such as computers rather than manual 
or mechanical methods. 

electronic spreadsheet (See spreadsheet) 

ellipse An oval shape, or a ci rcle. 

end-of-cell marker A small black circle that 
represents the end of a cell in a table in 
Microsoft Word. The end-of-cell marker is 
visible o nly when Sh ow 91 is active. 

end-of-row marker A small black circle that 
represents the end of a row in a table in 
Microsoft Word. The end-of-row marker is 
visible only when Show 91 is active. 
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Enter key A key, normally found on the bottom 
right corner of the Macintosh keyboa rd, that 
may be used to accept an entry or confirm a 
command in a dialog box. Pressing the Enter 
key or the Return key will se lect th e 
high lighted (default) button in a dialog box. 
On many computers, the Enter and Return 
keys are the same. On the Macintosh, they 
often have different functions depending on 
the program being used at the time. 

enter box A small box containing a checkmark 
in Excel's formula bar. Clicking in this box is 
the same as pressing the Enter key and accepts 
any changes that have been made in the 
active cell. 

eraser tool A tool used to erase all or part of an 
item in MacPaint or HyperCard. 

exception report A report caused by an exception 
to anticipated results. This might be a report 
of sales personnel who did not meet their 
quotas, or numerical results in an experiment 
outside the expected range. 

expansion p01t A connector, usually on the 
outside of the computer, that allows the 
connection of additional peripheral devices. 
An example of an expansion port is the 
SCSI port. 

expansion slo t A narrow socket located on the 
main circui t board of the computer into which 
you can attach a peripheral circuit board 
or card. 

exploded pie chart A pie chart where one or 
more slices are pulled away (ex ploded) 
from the rest of the pie to emphasize what 
they represent. 

fatBits The 800% magnification view in MacPaint 
and HyperCard, in which you can work with 
individual pixels. 

field (1) A data ilem used to compose a record. A 
field is a specific type of information in an 
information management program. (2) A 
fie ld in HyperCard is where regular text (as 
opposed to paint text) m ay be stored. 

fie ld tool The tool used in HyperCard to create, 
select, modify, and delete text fields. 

file menu The second (usually) menu in a 
Macintosh application. It generally contains 
commands that affect the entire file, such as 
Save, Save As, Print, and Quit. 
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fil e A s ngle specific collection of information 
that has a name and is stored on a disk. This 
information m ay be a data document, 
application program, system program, or 
system data file. 

file _maintena n ce The process of keeping 
mfonmation in a file up to date. This can also 
include making backup copies of files. 

file management syst em A simple information 
management system where data is organized 
into discrete fi les. This is a precursor to 
database management systems and usually 
has a limit of only one file open at a time. 

fill pattern box The box at the far left of the 
MacDraw pattern palette that reflects the 
currently selected fill pattern. 

fill The pattern that is inside the borders of an 
object in a drawing program. 

find A feature available in many applications 
where you to enter a text phrase and the 
computer finds tha t phrase in the current 
document if it exists. 

Finder The application that automatically starts 
when the Macintosh is turned on. It manages 
and maintains the desktop, and is used to 
open applications, organize files and folders 
on disks, and copy fi les and fo lders. 

First Page Special An option in the Section 
dialog box of Microsoft Word that creates a 
special header and footer that prints on only 
the first page of a document. 

first -line indent The indentation of the first line 
of a paragraph. The fi rst-line indent setting 
on Microsoft Word's ruler is used to control 
this indentation. 

flip The process of turning an object vertically or 
horizontally in a drawing program so that a 
mirror image is produced. 

floppy d isk A disk made of fl exible plastic. 5.25" 
disks! are encased in paper or plastic envelopes 
and r re floppy when you move them. 3.5" 
diskl are also made of flexible plastic, but are 
encared in a hard plastic shell. Both are still 
refeled to as a floppy d isk. 

flush le~ Ali?nment where text is a ligned on the 
left margm and ragged on the right. 

flush right Alignment where text is aligned on 
the right margin and ragged on the left. 
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fo lde r A folder is par t of the Macintosh 
hierarchical file system. The main level of 
the fi le system is the d isk, which may hold 
man y fil es and folde rs. Each folder may 
also hold man y files and folders. On most 
other compute r systems, folders are known 
as subdirectories. 

fo n t A set o f characters which includes letters, 
numbers, punctua tion , and other symbols 
that have a consistent appearance. 

footer One o r more lines o f text and/or graphics 
that appear o n each page of a document in 
the bottom margin. Footers may include page 
numbers, dates, times, text, pictures, or other 
graphics. (See also heade1) 

Footer part The part of a fi leMaker report that 
contains the bottom margin. It is printed on 
every page and can contain page numbers, 
fil e names, the date and other similar 
information. 

formatt ing a d isk The process of initializing a 
disk so that it can store and retrieve data. This 
process divides the disk into tracks, subdivides 
the tracks in to secto rs, and creates a directory 
structure for accessing the information. 

form atting In word processing, the process of 
determining how text and documents will 
appear when printed. 

fo rmula A formula is a mathematical equation. 
In a spreadsheet p rogram, you can write a 
formu la that uses values stored in other cells 
to calculate a value for the current cell. (See 
also fi.mction) 

formula bar In Excel, an area on the screen just 
below the menu bar that is used for editing 
and d isplaying the contents of the active cell. 

freehand tool A tool used in drawing programs, 
such as MacPain t and MacDraw, that is used 
to draw freehand shapes. 

fu n ction A built-in fo rmula in a spreadsheet 
program or programming language that can 
be used for calculating commonly used 
values such as square root, absolute value, 
average, standard deviation, and so on. (See 
also formula) 

Galley View One of the fo ur document views 
available in Microsoft Word . Galley View 
gives you the fastest working environment, 
but does no t display the page as it will look 
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when printed. Documents are normally 
opened in Ga ll ey View. (See also Page View, 
Print Preview) 

Genera l tools The three HyperCard tools that 
are not used for painting: Browse, Button 
and Field. 

grabber tool The hand-shaped tool in MacPaint's 
too lbox that is used to move a different 
portion of the drawing into view. 

graphical user int erface The Mac is the premier 
example of this type o f user interface, which 
consists o f icons, windows, and a mouse that 
controls th e m ovement of a pointer on the 
screen. Commonly abbreviated GUl. 

grid Non-printing guide and control lines in 
programs that help the user to align objects. 
MacPaint , HyperCard, MacDraw, and many 
other graphics programs provide grids that 
can be used fo r this purpose. 

grid lines Dotted lines that can be displayed 
and that mark the boundaries of a grid. 

g ro uping In MacDraw, the consolidation of 
two o r mo re sepa rat e ob jects into o ne 
composite object. 

guide lines Lines that are created in a drawing to 
a id in the placement of objects, and that are 
usually removed before printing. 

handle In MacDraw, the small black squares that 
appear at each corner o f a selected object. (See 
also selection squares) 

ha nging in dent When the fi rst line of a paragraph 
extends (or hangs) to the left of the left 
margin of the rest of the paragraph. 

hard copy When info rmation is printed on 
paper it is known as hard copy. Soft copy is 
info rmatio n p resented on ly on the screen of 
the computer. 

ha rd d isk A d isk that is permanently sealed in its 
d isk drive. These are called hard disks because 
the disk platter is normally made from 
aluminum, whereas a diskette is normally 
produced from plastic. Hard disks normally 
store mega bytes o f da ta. 

hard return Pressing th e Return key creates a 
hard retu rn in a line of text, and causes the 
insertion point to move to the next line. A 
hard return indicates the end of a paragraph. 



Glossary 

hardware The part of the computer that you can 
touch. All physical devices are hardware. This 
is opposed to software, which is abstract and 
intangible. (See also software) 

Header part The part of a FileMaker report that 
contains the top margin. It is printed on 
every page and can contain page numbers, 
fil e names, the date and other similar 
information. 

header One or more lines of text and/or graphics 
that appear on each page of a document in 
the top margin. Headers may include page 
numbers, dates, times, text, pictures, or other 
graphics. (See also foote!) 

header record The first record in a print merge 
data document in Microsoft Word. The header 
record determines the names of the fields and 
the order in which they appear in all data 
records in the data document. 

high-density disk The 3.5 inch disks for use 
in the SuperDrive. It holds 1.4 megabytes 
(1,400 kilobytes). 

highlight A method used to distinguish an 
object from others of its kind. (1) Ahighlighted 
button, also known as the default button, has 
an additional, darker oval surrounding it. (2) 
A highlighted menu or menu item is inverted. 
White pixels become black and vice-versa. (3) 
Highlighted text is also inverted. 

Home button A button with the icon of a house 
that is used in HyperCard to return to the 
Home card. 

Home card A special card in HyperCard that is 
used as a pictorial index to other stacks. 

Home stack A special stack that is required for 
using HyperCard. It contains one o r more 
Home cards, cards for sto ring paths to stacks, 
documents, and application s, and a 
preferences card for setting the user level, 
user name, and other options. 

horizontal split bar (See split bm) 

hot spot The active portion of a MacPaint, 
HyperCard, or MacDraw tool that actually 
does the drawing, selecting, or painting. For 
example, the hot spot of the lasso tool is the 
straight rope, and the hot spot of the paint 
bucket tool is the drip. All pointers have a 
particular hot spot. 
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HyperT k The built-in scripting language used 
to program HyperCard. 

hyphenation dictionary A utility file that is 
used with a word processing program to 
determine the appropriate hyphenation of 
words in a document. 

1-beam pointer The !-shaped pointer that is used 
for editing and entering text. 

icon A picture that is used to represent something 
else. Icons may be pictures of disk drives, 
diskettes, folders, or documents, and are one 
of the main parts of the Macintosh graphical 
user interface. 

ImageWriter A dot matrix printer introduced 
and marketed by Apple Computer. (See also 
dot matrix printe1) 

indentation controls The controls on the 
Microsoft Word ruler that control the 
first line, left, and right indentations of a 
paragraph. 

indentation Moving the first line of a paragraph 
and/or the subsequent lines to the left or 
right. Sometimes the width of a paragraph 
will be increased or decreased relative to 
paragraphs above and below in order to 
visually set it off from the others. 

information Data that has been organized, 
sorted , collated, and otherwise put into a 
useful and retrievable form. 

initialize The process of preparing a new 
diskette, hard disk or tape cartridge so that it 
will be able to store information. This is also 
known as formatting. (See also formatting) 

input The information that is transferred into a 
computer from an external source. Original 
input is usually suppli ed through the 
keyboard. Other input may come from a disk, 
modem, scanner, mouse, trackball, or tape 
drive. Input also refers to the process of 
transferring information into the computer. 
(See also output) 

insertion point The place in a text document 
wherb the next action wi ll occur. You may 
mov1 the insertion point by moving the I
bear~ to a new location and clicking. The 
inseryon point will move tothisnew location 
and a short vertical line will blink so that you 
can easily spot it. 
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item (1) A synon ym for "fi eld" when used in 
te rms o f reco rds a nd files for storing 
information. (2) One of the words or phrases 
listed in a menu, known as a menu item. 

jaggies The jagged lines of some printed objects 
that have been created with bit-mapped 
graphics programs. 

jump term A te rm in Excel's help system that is 
shown with a solid underline. Clicking a 
jump term will take you to information 
associated with that term. 

justification The process of aligning text on the 
left and right by adding extra spacing between 
words o r even between letters. (See also 
alignment) 

justified text Text that is flush on both left and 
right margins. (See also aligmnent, justification) 

key field A fi eld around which a file is structured. 

keyboard An in put device, similar to a typewriter, 
used for inputting text into a computer. 

kilobyte A unit of measurement that is normally 
thought of as 1,000. However, in computer 
terminology, this represents 1,024. Kilobyte 
is normally abbreviated as KB. Although this 
is a strange number in the decimal number 
system, it is a round number in the binary 
number system the computer uses. One 
kilobyt e is 1,024 bytes. 

labels report A report format in FileMaker and 
HyperCard where information is printed on 
labels, such as mailing labels. 

landscape orientation The rotation of a page so 
that the contents are printed sideways on the 
page. Rather than the long side of the page 
being vertical, it will be horizontal. (See also 
portrait orientation) 

laser printer A printing device which uses a 
laser to produce an image on a drum. Then 
the drum is rotated through tiny bits of 
pl as tic ca ll ed to n e r. The drum is 
electrostatically charged and picks up the 
toner in the areas charged by the laser. A piece 
of paper which has been charged with the 
opposite static charge is rotated past the drum, 
picking up the toner from the drum. The 
paper then goes through two heated rollers 
(fusers) that melt the plastic onto the paper 
and fi x it there. Since a laser printer is a non
im pact printer it can not successfully print on 
multi-part forms. (See also LaserWriter) 
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LaserWriter A 300 dot per inch laser printer 
developed and distributed by Apple 
Computer. The LaserWriter was one of the 
four main components that introduced the 
desktop publishing revolution. The other 
three were the Macintosh, PageMaker, and 
PostScript. (See also desktop publishing, laser 
printer, PostScript) 

lasso (See lasso selection tool) 

lasso selection tool The too l in MacPaint and 
HyperCa rd that is used to select an object, but 
that does not select any background around 
the object. (See also selection rectangle) 

layer controls The con trois at the bottom of the 
tools palette that enable you to move between 
named layers in a MacDraw document. 

layers MacDraw and HyperCard keep different 
objects in layers on the screen. Objects created 
fir st are behind objects created later. In 
MacDraw there are layers you can name and 
view separately or as a group, similar to the 
way you can view a stack of drawings on 
transparent film. HyperCa rd keeps different 
objects (buttons, fi elds, pictures, etc.) on 
diffe rent laye rs o n two main layers: 
background and card. 

Layout mode The mode in FileMaker that 
allows you to a rrange fie lds, t ex t, and 
graphics for producing on-screen displays 
and printed reports. 

leaks When filling an o bject with the paint 
bucket tool in MacPaint or HyperCard, if the 
border of the o bject has gaps the pattern 
"leaks" out the gap and fill s the rest of the 
drawing window. 

left indent Where the text in a paragraph is 
positioned with respect to the left margin of 
the paper. 

left-aligned tab The left side of the first word in 
the column be low this tab o n the Microsoft 
Word rul er will align with the position where 
the tab is placed on the rule r. 

legend Symbols and text that are used to identify 
the data represented on a chart. 

line chart A chart that shows the change in data 
over a period o f time emphasizing direction 
and rate o f change. 

line pattern box The box at the fa r right of the 
MacDraw pattern pa lette that reflects the 
currently selected line pattern. 
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line spacing The vertical spacing of lines o f 
text. In double spacing, fo r example, an extra 
full line of space is placed between each line 
of text. 

Hnetool The drawing tool in MacPaint, MacDraw, 
and HyperCard (and other graphics programs) 
that is used to draw a straight line between a 
starting and ending point. 

line weight The thickness of a line, usually 
measured in points. 

link A relationship between tvvo documents 
(such as Excel worksheets) that is defined in 
a formula. 

linked terms Terms that are associated with 
other related terms in Excel's help system. 

local area network (LAN) A group of connected 
computers in a small area (such as a room 
or building) that share information with 
each other. 

lookup field A fi eld (in FileMaker) into which 
information is copied from another file based 
o n match ing information in both fil es. 

magnify To increase the size of the view of a 
drawing to allow more deta il ed work. In 
MacPaint the Zoom In command allows you 
to magnify the drawing up to 800% of its 
actua l size. MacDraw enables you to magnify 
the drawing to 3200% of its o riginal size. 

main document One of the two documents 
used in a print merge project. The main 
document always contains specia l print merge 
commands, the merge fields that ho ld the 
data that changes from o ne document to the 
next, and the body text that does not change 
from one document to the next. 

management information system (MIS) A 
co mputer ized syst em that provides 
informatio n to management personnel 
for operat ional, tactical, and strategic 
decision making. 

manual page break A page break that results 
from issuing a command that causes the text 
to go to a new page at a particular place in a 
document. (See also automatic page break) 

marching ants A term used to describe the 
border of a selection made with the selection 
rectangle in MacPaint and HyperCard. (See 
also selection rectangle) 
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megabyte A unit of measurement that is 
normally thought of as 1,000,000. However, 
in computer terminology, this represents 
1,048,5 76. Megabyte is normally abbreviated 
as MB. Although this is a strange number 
in the decimal number system, it is a 
round number in the binary number 
system the computer uses. One megabyte is 
1,024 kilobytes. 

memory Memory is an electronic device that is 
capable of storing information. All 
Macintoshes include two types of memory: 
RAM and ROM. (See also RAM, ROM) 

menu A list of commands, or menu items, that 
are included under the menu title in the 
menu bar. 

menu bar The horizontal bar at the very top of 
the screen which contains a list of menu 
titles. Most menu bars are consistent in that 
the first three menu titles are Apple, File and 
Edit. Each application has its own distinctive 
menu bar which contains the specific set of 
menu titles and commands that are available 
in that application. (See also menu, menu item) 

menu item A command that is listed on a menu. 
To access a menu item, press on the menu bar 
and drag to the item you want, then release 
the mo use button to select the highlighted 
item. All menu items that end in an ellipsis 
( ... )are followed by a dialog box. (Seealsodialog 
box, dragging, highlight, menu bat) 

merge fields Special fields used in the main 
document of a print merge project that act as 
place holders for data that comes from the 
data document. Merge fie lds in Microsoft 
Word are enclosed with special characters 
ca lled chevrons(« and»). 

Message box A floating window (or mini window) 
in HyperCard used to enter commands and 
show messages. 

microprocessor Th e processor u sed in a 
microcomputer, such as the Motorola 68000 
or 68030. 

modeling The use of a hypothetical 
representation of a real-world situation . 
Frequently, modeling refers to using 
spreadsh eets to try to predict future 
financial events. 
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modem An ab brev iati o n for modula tor/ 
demodulator. A modem is a device that allows 
computers to communicate to other devices 
over pho ne lines . Computers use digita l 
signals internally, and phone lines use analog 
signals, so a modem has to translate so the 
computer can communicate over the phone 
lines. Modulate refers tochangingfrom digital 
to analog (sound), and demodulate refers to 
translating from analog (sound) to digital. 

monitor (also called CRT or VDT) A television
like device for displaying computer output. 

monospace font Fon ts where each letter, 
regardless of its width, is given the same 
a m ount o f space. Typewrite rs use 
monospacing. (See also proportional font) 

mouse A hand-held device that the user moves 
on a flat surface next to the computer. As the 
mouse is moved the cursor on the screen 
moves in a corresponding manner. Most 
commands and selectio ns on the Macintosh 
are made in con junction with pointing, 
clicking, dragging and double-clicking with 
the mouse . (See also click, double click, dragging) 

mouse button The rectangular button on the 
top of th e mouse that is used in conjunction 
with moving the mouse (or not moving the 
mo use) to initiate pointing, clicking, dragging, 
pressing, and double-clicking. Normally, the 
user positions the cursor o n an object by 
moving the mouse, and starts an action by 
pressing the mouse butto n. Then the action 
is confirmed by releasing the mouse. (See also 
click, double click, dragging) 

nesting folders The process of placi ng folders 
inside of other folders. This is the method of 
organizing the structure o f a hard disk into an 
inverted tree structure. (See also (of del) 

new line command Theactofmanually moving 
the insertion point to a new line in a text 
document wi thout creating a new pa ragraph. 
Also called a soft return, in Microsoft Word 
the new line command is Shi ft-Return. (Seen/so 
insertion point, hard retum, soft return) 

number A word, symbol, letter, o r combination 
of symbols used to represent a ma th ematical 
quantity. 

number field A fi eld in FileMaker that holds a 
number or a yes/no value. 
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object-oriented A type of drawing program 
where each object in the drawing is stored as 
mathematical info rmation in the computer 
rather than the collection of dots that 
bitmapped programs store for each ob ject. 
(See also bitmapped) 

Option key A modifier key that is used with a 
character key to alter its functio n. In most 
fonts, there are add itio nal symbols and 
characters that may be formed other than the 
ones that are available by using the key by 
itself or with the Shift key. Two additional 
combinations-with the Option key, or with 
the Option key and the Shift key-allow each 
character key to potentially p roduce a to tal of 
four different characters. The Option key is 
sometimes used with a tool in an applica tion 
to change the normal function of the key. For 
example, in MacPaint, the penci l too l allows 
you to draw dot by dot, but when the Option 
key is depressed, the pencil turns into a hand 
that allows you to move the visible portion of 
the painting arou nd on the screen. 

orphans An orphan line occurs when all of a 
paragraph is on one page except fo r the las t 
line which is on the following page. 

output Information that is transferred from th e 
computer to an external destination such as 
the monitor, a printer, modem, o r disk drive. 
Output also refers to the process of transferring 
described above. (See also input) 

oval tool The tool in MacPaint and HyperCard 
used to draw ellipses and circles. 

Page View One of four document views in 
Microsoft Word. Page View allows you to see 
a full-scale version o f a document as it will 
look when printed and to edit and format 
text. (See also Galley View, Print Preview) 

page scale When you click the sca le icon on the 
ruler in Microsoft Word it toggles to page 
scale, which allows you to modify the margins 
of the entire document. (See also table scale) 

paginate The automatic determinatio n of where 
page breaks wil l occur in a document based 
on the margins, size of the font being used, 
line width, and o ther pertinent factors. (See 
also automatic page break) 

paint brush tool A tool in MacPaint that a llows 
you to draw freehand lines in a variety of 
shapes and patterns. 
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paint bucket tool A tool in Mac Paint that allows 
you to fill o bjects with a pattern. 

paint text tool The tool in HyperCard that is 
used to enter text into a picture. When the 
text is deselected it is no longer editable as 
text, but only as a picture of text. 

Pa inting level The user level in HyperCard that 
allows access to and use o f the various 
painting tools. 

Painting tools A HyperCard tool used to make 
pictures, including the Pencil, Brush, Spray, 
Lasso, Eraser, and o thers . Any tool in 
HyperCard that is not a General tool. 

palette A tear-off menu becomes a palette when 
it is to rn off from the menu bar and becomes 
a floating window. MacPaint and HyperCard 
support palettes for tools and patte rns. 

paragraph In word processing, text that is 
followed by a ha rd return (pressing Return). 
A paragraph can consist of o ne o r more 
characters, words, or sentences. 

paragraph spacing settings The settings on the 
Microsoft Word ruler that con trol the amount 
of space between paragraphs. 

paragraph text Text used in MacDraw II that is 
confined to a text box in the drawing window 
and that uses word wrap to stay within the 
margins of the text box. 

part tool The tool in FileMaker that allows the 
addition of new parts to the layout. 

paste To place a copy of the contents of the 
Clipboard-whatever was last cut o r copied
into the current document at the insertion 
point. (See also Clipboard, copy, cut) 

patterns palette, Patterns menu The portion of 
the drawing window in MacDraw and the 
menu in MacPaint that contain the available 
fill and line patterns. (See also currently selected 
pattern, fill pnttem box, line pattern box) 

Pen menu The menu in the MacDraw menu 
bar that is used to control the line weights 
and styles of lines and borders. 

pencil tool The tool in MacPaint and HyperCard 
that is used to draw a free hand one-pixel
wide line. 

peripheral An external computer device that is 
used with the Macintosh, but is not an integral 
part of it. Peripheral devices include disk 
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d ri v~s, tape drives, graphics tablets, scanners, 
printers, modems and others. These devices 
are usually attached to the computer by cables, 
although they may be internally mounted. 

Phone stack A stack included with HyperCard 
that can be used to dial a phone through the 
Macintosh 's speaker or a modem. 

picture field A type of fie ld in FileMaker that 
ho lds a picture. 

pie chart A chart that shows the relationships 
of the parts compri sing a whole. Always 
contains only one data se ries. 

pixel An abbreviation for picture element, 
which is one o f th e dots th at can be turned on 
o r o f( o n a screen . A Macintosh screen and an 
lmageWriter printer have 72 p ixels per inch 
m easured horizontally and verti cally for a 
total of 5,184 pixels per square inch. The 
LaserWriter has 300 pixels per inch for a total 
of 90,000 pixels per square inch. The higher 
the density, the finer the resolution and the 
bet ter the appearance of the output. (See also 
bitmapped, dpi) 

pointer A small graphic shape visible on the 
screen that moves as the m ouse moves. 
Commo n shapes are arrows (north-east and 
north-west pointing), !-beams, wrist watches 
and crossbars. Many other shapes are possible, 
limited o nl y by the imagina tio n of the 
programmer. Pointers oft en change shape 
over different parts of the screen to indicate 
that they are capable ofdoingdifferent things 
in some areas than in others. 

points, point size A point is the smallest unit of 
measurement in typography and typesetting. 
There are 12 points in a pica, and 6 picas in an 
inch. This mea ns that there are 72 points in 
an inch. Font sizes a re measured in points on 
the Macintosh and different point sizes are 
available fo r each fo nt. A 36 point font should 
be .S inches high and a 144 point font should 
be Z inches tall. (See also font) 

polygo~ tool A tool in MacPaint and MacDraw 
tha9 is used to draw shapes composed of a 
sequence of connected lines. 

portrait orientation The normal page orientation 
for printing. This means that the long side o f 
the paper is vertical and the short side is 
horizon tal. The other orientatio n is called 
landscape. (See also landscnpe orientation) 
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PostScript A page layout language developed by 
Adobe Systems, Inc. that is included in the 
Laser Writer printer and that gives it its special 
capabilities. In addition to fo nt printing, 
scaling, and rotating, it also contains many 
drawing capabilities. PostScript® has become 
the standard o utput language for the desktop 
publishing industry. 

presentation graphics Informatio nal graphics 
produced by a computer application such as 
a spreadshee t tha t sh ows re la ti o nships 
involved in da ta sets. Presentation graphics 
a re m o re sophisticated than ana lytical 
graphics because they are used to present the 
information to management and people 
outside of a company. 

Print Preview One o f four document views in 
Microsoft Word. Print Preview allows you to 
see a scaled-down view of who le pages of a 
document as it will look when pri n ted. You 
cannot access text directly while in Print 
Preview, but it does allow some limited 
formatting capabilities. (See also Galley View, 
Page View) 

print merge A feature in many word processing 
programs tha t involves creating a main 
document that contains the body text, and 
that contains special fields to mark the parts 
that will change with each document. A data 
document is also used that contains the 
information to be placed in the specia l 
fields in the main document. When the print 
merge command is issued the information 
from the data document is merged with 
the main document to create customized 
form documents. (See also data document, 
main document) 

printer A device that produces images o n paper, 
photographic film, or transparencies. Many 
types of printers are available. The Macintosh 
primarily uses the lmageWriter dot matrix 
printer and the LaserWriter laser printer. (See 
also dot111atrix printer, Image Writer, LaserWriter) 

printing The process of issuing a print command 
to send the contents of a document to a 
printer to produce ha rd copy output. 

program A set of instructio ns that tells the 
computer th e complex sequence of steps 
n ecessa ry to perform a pa rti cu la r task. 
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Prog rams are di vided into appli cations 
programs and systems programs. Program is 
syn o n y mo us with software. (See also 
application program, system progra111) 

proportional font A fon t in which different 
characters are allowed d ifferent amounts of 
space in the line of tex t depending on their 
width. A "W" is given more space than an "i" 
in a propo rtio nal font. Most Macintosh 
fo nts a re proportionally spaced. (See also 
moiiOspace {011t) 

pull-down menu A menu that is hidden until 
you press on its title, at which point the list 
of ch oices pulls down onto the screen 
allowing you to select a command. (See also 
menu, menu item) 

RAM An acronym that stands for Random Access 
Memory, and the part of memory that is used 
to store information that is changea ble. RAM 
h o lds appli cat ions p rograms, systems 
programs, documents, and other data. RAM 
is volatile, which means that the informa ti on 
it contains is lost when the power is removed. 
(See also mernory, ROM) 

random access A method of accessing a particular 
record in a file o r byte in memory without 
having to read any preceding information. 
(See also direct access and sequential access) 

range (1) In Excel, a group of cells that are acted 
upon by a command o r formula as a unit. (2) 
In FileMaker, a criterion used for finding 
information that is between a low value and 
a high va lu e, e ith e r alphabetica ll y, 
chronologically, or numerica lly. 

record A group of related information that 
describes one pe rson, place or thing. A record 
is made up o f related fi elds. A group o f re lated 
records is known as a file. (See also file, field) 

rectangle tool A too l used in many graphics 
programs for drawing rectangles and squares. 

redundancy Storing the same data in two or 
more locations. 

reference area The a rea o n the screen to the left 
of the formula bar in Excel that shows the row 
number and column letter of the active cell. 

reformat To change the form at, or the way a 
document looks when printed. (See also 
formatting) 
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regular polygon tool A tool in HyperCard for 
drawing polygons with regular sides. It always 
draws fro m the center outwards and a llows 
rotat io n of the polygon before fixing its 
location on the card. 

relational database A database in which files 
are organized as tables in rows and columns. 

rela t ive addressing A way o f defining the loca
tion o f a cell based o n its position relative to 
the cell containing a formula in Excel. 

repeating field A field that has been formatted 
to allow you to store and d isplay multiple 
values in one record. 

Reshape command A command in MacDraw 
that enabl es you to change the shape of 
o bjects drawn with the arc tool, the polygon 
tool, and the freehand tool. 

resize To change the size of an object in a 
drawing program. 

resolut io n A measure of how well a device can 
produce an image. Higher resolutio ns produce 
clearer images. Resolution is applicable to 
both screen and printer o utput. A Laser Writer 
produces better images than the screen or an 
JmageWriter, because its resolution is a little 
over 16 times higher. (See also rlpi, pixel) 

Return key A key that normally causes the 
insertion point to move down to the start of 
the n ext line when editing tex t. Also 
commo nl y known as the carriage return key, 
it is usually used to end a paragraph, o r 
produce a blank line. Wh en used with a 
dialog box, the Return key can be used as a 
shortcut to select the highlighted, or default, 
butto n. (See also hard return) 

Revert To Saved comma nd The command in 
MacPaint that brings back to the drawing 
window the last version of a document that 
was saved on disk. It is used to undo erro rs 
made to a drawing. 

righ t indent Where the tex t in a paragraph is 
positioned with respect to the right margin of 
the paper. 

righ t-aligned tab The right side of the first word 
in the column below this tab will a lign with 
the posi tion where the tab is placed o n the 
Microsoft Word ruler. 
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ROM A!cronym that stands for Read Only 
Membry, and the part of memory that is used 
to store information that is permanent. 
Information used by the computer system 
throughout all applications is normally stored 
in ROM. For instance, the procedures to 
produce windows, buttons, scroll bars, and 
other normal parts of the Macintosh interface 
are stored in ROM. ROM is also used to store 
the necessary instructions for the computer 
to fo llow when the power is first turned on. 
(See also memo1y, RAM) 

rotate To move an object in a d rawing program 
with its cente r point or corner as an 
anchor point. 

rounded rectang le tool A painting tool avai l
able in most graphics programs that is used 
to draw rectangles and squares with 
rounded corners. 

rounded rect angles Rectangles whose corners 
are formed by arcs instead of sharp angles. 

row In an electronic spreadsheet or in a cell table, 
a horizontal grouping of cells. (See a lso 
cell, column) 

ruler (1) In a word processing program, a graphic 
representation of a ruler which allows you to 
set margins, tab sett ings, line spacing, 
indentation and other settings. (2) In drawing 
and paint programs, a ruler placed a long the 
edge of the window to aid in measuring and 
placing graphic elements in the image. 

ruler settings The margin, tab, line spacing, 
indentation, and o ther settings that a re 
controlled by the ruler in a word processing 
program. (See ntler) 

scale tool The icon on the Microsoft Word ruler 
that toggles between the normal sca le, page 
scale, and table scale. (See also page scale, 
table scale) 

scatter chart A chart that is used to show the 
degree of relationship between values in 
different data series. 

Scripting level The highest user level in 
HyperCard that allows access to programming 
(or scripting) in HyperTalk. It also allows 
access to all the other features of HyperCard. 
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scripting The process of modi fying the script of 
an ob ject in Hype rCard . Every item has a 
script, although some may be em pty. 

scro ll arrow An outline o f an arrow located o n 
each end of a scroll bar. Clicking a scroll 
arrow causes the contents of the window to 
scro ll o ne line closer to th e end of th e 
document to which the arrow po ints. Pressing 
a scroll a rrow causes the contents o f the 
window to scroll continuously, o ne line at a 
time, in the d irection po inted to by the arrow. 
(See also scroll bar, scroll box) 

scroll bar A rectangular bar that may be o rien ted 
vertically along the left o r right edge of a 
window, or horizon tally alo ng the top or 
bottom edge. Normally vertica l scroll bars are 
o n the right, and ho rizontal scroll bars are 
along the bottom. Clicking or pressi ng in the 
scroll ba r causes the contents of the window 
to move a screenfull at a time. The directio n 
of the scro ll depends o n the locatio n of the 
scro ll box. (See also scroll arrow, scroll box) 

scroll box The white square box in the scroll bar. 
The scro ll box is a lso known as the thumb or 
e levato r button. The positio n of the scro ll 
box in the scroll bar gives a relative indicatio n 
of where the contents of the window a re 
located in relation to the correspo nding edges 
of the document. For example, in a vertica l 
scro ll bar, if the scroll box is approximately in 
the middle of the scroll ba r, then the window 
is showi ng approximate ly the middle of the 
documen t from to p to bottom (or beginning 
to end). l n order to quickly move to a particular 
part of the document, you ca n drag th e scroll 
box to the relative position desired. This is 
especially useful when going to the to p 
(beginning) o r bo tto m (e nd) o f a lo ng 
document. (See also scroll arrow, scroll bm) 

search and replace A feature in many word 
processing programs tha t allows you to 
auto ma ti cally locate o ne o r all occurrences o f 
a particular word and replace it with a 
d ifferent word. 

sea rch c rite ria The value or phrase en tered in to 
a find comma nd that is used to locate any 
match ing data. 

sectio n Any part of a document that is desig
nated as separate from another part. A sectio n 
can be compared to a chapte r in a book; a 
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chapter is a part of the whole book, but it is 
also separate from other chapters. In Microsoft 
Word, a document can be d ivided in to o ne or 
mo re sections and each section can be 
formatted di fferently from other sections in 
the same document. Sectio ns are separated 
by section break markers. (See alsosect ion break 
marker) 

section break marker The double dotted line 
that runs across the width of a document in 
Microsoft Word that ind icates the d ivision of 
two sections. The section break command is 
Command-Ente r. (See also section) 

select W hen using the Maci ntosh, you generally 
select an object and then issue a command 
which will operate o n tha t ob ject. How 
something is selected is similar across all 
applications. Selecting occu rs in several ways 
depend ing o n the program in use. (! )Alt hough 
not commonly though t of as a selection, 
positioning the insertion point is the selection 
of the location where the next action will 
occur. (2)To select an icon, click o n it . (3)To 
select several icon s, click above them and 
then drag the select ion rectangle around all 
of them. ( 4)Selecting text can occur by 
wiping through text, double clicking on a 
word, dragging th rough several lines, and 
other methods, depend ing o n the program . 
Selected text is h ighlighted, or inverted. (See 
also highlight) 

selection a rrow The tool in Mac Draw, located at 
the to p of th e tools palette, that is used to 
select objects. 

selection bar The a rea located at the fa r left of a 
Microsoft Word document that is about 1/8-
inch wide and that enables you to select large 
blocks of text. 

selection rectang le Also called the selection 
marquee, the MacPain t too l that is used for 
selecting objects and tha t also selects the 
background around the ob ject. (See also lasso 
selection tool, marching ants) 

selection squares Small black squares that appear 
at the corners of a graph ic ob ject to indicate 
the ob ject is selected. (See also handle) 

sequential access The method of accessing 
info rmation in a file where all preceding 
information must be read first. (See also random 
access and direct access) 
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Shift key A modifier key that affects character 
keys. When used with an alphabetic key, it 
produces the upper case letter. When used 
with a numeric or symbol key, it produces the 
character shown on the top of the key. This is 
similar to the Caps Lock key except that it will 
affect all keys and not just alphabetic keys. 
(See also Shift-click) 

Shift-click A selection technique that allows you 
to extend the area of a selection. (l)When 
used with text, you click at the first location, 
scroll to the final position and click the 
mouse button with the Shift key depressed. 
This will extend the selection from the first 
click to the final position. (2)When used with 
icons or objects, it allows an icon or object to 
be added to, or removed from, the current 
group of selected icons or objects. 

Show Size command A MacDraw command 
that displays the size of an object as it 
is drawn. 

slide control handle A tool used for moving to 
a different record or layout in FileMaker. 

Sliding objects left In FileMaker, used to keep 
fields and punctuation next to preceding 
fields on the same row. 

Sliding objects up In FileMaker, used to eliminate 
blank lines when fields are empty or the 
information in a field does not fill the field. 

Sliding part up In FileMaker, used to eliminate 
empty space in a printed report after objects 
have slid up. 

smooth To round the sharp angles in an object 
into curves. 

snap Aligning of an object or text to a grid 
boundary. 

soft copy When information is presented only 
on the screen of the computer. Hard copy is 
when information is printed on paper. 

soft return A carriage return that causes the 
insertion point in a word processing program 
to move to a new line but does not create a 
new paragraph. In Microsoft Word, a soft 
return is created with the Shift-Return keys. 
(See also hard return, irysertion point, new 
line command) 
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softwar Software is synonymous with program, 
whic is instructions the computer follows 
when accomplishing a designated task. 
Software is the intangible part of the computer, 
as opposed to the physical part which is 
known as hardware. (See also application 
program, hardware, system program) 

sort Placing items in a predetermined 
alphabetical, chronological, or numerical 
order. 

sort field A field whose contents are used as the 
basis for sorting a file or stack. 

source disk The original disk being copied or 
moved to a new destination. (See also 
destination disk) 

spelling checker A utility program that 
determines if a word is spelled correctly by 
comparing each word in a document with 
the entries in its dictionary. If the word 
matches a dictionary entry, the spelling 
checker considers the word correct. If the 
word is not in the dictionary, that word is 
considered misspelled. 

split bar In Excel, the small black rectangle 
located at the top of the vertical scroll bar and 
on the left of the horizontal scroll bar. It is 
used to split the window into two or four 
panes so different parts of the worksheet can 
be seen at the same time. 

spray can tool A tool in MacPaint that paints in 
a "mist" of the currently selected patterq.. 

spreadsheet A general classification of appli
cations that are used for numeric analysis 
such as finance, budgeting, and other business 
uses, as well as other uses such as engineering 
and scientific calculations. Information in a 
spreadsheet program is organized i~to 
columns and rows. The intersections of these 
columns and rows are called cells. A 
spreadsheet application is also known as an 
electronic spreadsheet program. (See also cell, 
column, row) 

I 
stack A ryperCard document containing a group 

of cards. 

stackin~ order The position of objects in front or 
beh1nd other objects. 
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startup disk The d isk the computer reads from 
when the system is first turned o n. This disk 
must have a System file and usually a Finder. 
It also will contain printing resources, desk 
accessories, fonts, fkeys, sounds, and other 
systems software. If mo re than o ne of the 
disks attached to the computer has a system 
fil e, the one that is currently active is known 
as the current startup d isk. In the Finder, this 
disk is the o ne on the very top right of the 
screen. All o ther disk icons will be located 
below the startup disk. If the re is a flo ppy disk 
inserted into one of the floppy disk drives, it 
will take precedence as the startup disk over 
the hard disk. If you have more than one SCSI 
hard disk attached to your computer, and if 
your Macintosh is an SE or Mac II then you 
can ch ange the startup disk by using the 
Control Pane l desk accessory. 

status area An area on the left side o f FileMaker's 
browse screen that shows the number of 
records in the file, whether or not they are 
sorted, and the number of records that have 
been found by the last Find command. 

status bar An area at the bottom of the Excel 
screen that shows information about the 
current activity or mode. 

string literal In programming or scripting, a 
"string" or group of text enclosed in quotation 
marks, as opposed to a string variable. 

style In word processing programs, a group of 
formatting cha racteristics that have been 
assigned a name. The style name is the name 
these characteristics have been assigned. Style 
can also refer to the change in the overall 
impression o f a font, such as bold, italic, 
underlin ed, outlined, shadowed, an d 
combinations o f these. 

style sheet A group of styles attached to a 
document. Transferring style sheets to other 
documents enables different documents to 
have a consistent appearance. (See also style) 

Sub-summary part A part of a layout used to 
d isplay or print summary info rmation when 
a fil e has been sorted by the contents o f a 
specified field. 

summary field A fie ld that conta ins a numeric 
summary o f all the va lues in a field across a 
group of records. 
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summary report A report that prints only 
summary information without printing any 
de tail for each record. (See also detail report) 

System Folder A special folder on the startup 
disk that contains the System file and any 
n ecessary resources t o inte rface with 
peripherals, such as printers . (See also 
peripheral, startup disk) 

system program There are two basic types of 
programs: applica tion and system programs. 
A system program is a program wh ich con trois 
the inte racti on of the hardware devices, or 
a llows the user to control information storage 
o n the system . It is not designed to let the user 
perform a task li ke write a letter. Instead, it is 
designed for tasks the computer must perform. 
(See also application program) 

system software The files, resources and 
applicatio ns-normally located in the System 
fo lder-which are used by the Yfacintosh to 
make itself run . 

T-squares A Gadget available in FileMaker's 
Layout mode fo r aligning objects ho rizontally, 
vertically, o r both. 

tab leaders A series of characters that lead up 
to a tab position. Tab leaders make it easier 
for the eye to fo llow the area between the 
tab positions. 

tab setting The positio n to which the insertion 
point advances when the Tab key is pressed. 
Also called a tab stop. 

table An arrangement o f rows and columns of 
data. In Microsoft Word, the inte rsection of 
a row and a vertically aligned column in a 
table is a cell. 

table scale The ruler scale that is displayed in 
Microsoft Word when the insertion point is 
in a table and the scale tool is clicked. When 
in table scale, the width of columns can be 
modified. (See also page scale) 

tables feature A feature in Microsoft Word that 
a llows the creation of tables in which each 
cell can con ta in text or graphics and can 
be formatted using any character or para
graph formatting option. (See also cell, table, 
table scale) 

tear-off menu A menu that can be detached 
from the menu bar by dragging past the 
bottom of the menu. When the menu 
becomes de tached it is known as a palette. 
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Tell Me ... button A button in HyperCard that 
looks like a cartoon's dialog balloon. Clicking 
this button generally provides more 
information about the stack and how to 
use it. 

template A document that contains predefined 
contents. This can be a word processing 
template, spreadsheet template, or some other 
type of template. It is designed to be used for 
tasks that are often repeated so you don't 
have to create the document from scratch 
each time. 

text alignment The positioning of text relative 
to the horizontal and vertical margins in a 
document. Text alignment can include 
horizontal alignments such as flush left, flush 
right, justified, and centered, and vertical 
alignments such as centered between the top 
and bottom margins. (See also alignment, flush 
left, flush right, justification) 

text entry The process of typing text into a 
document. 

text field A type of field in FileMaker and 
HyperCard that holds text. 

text Information presented in the form of read
able characters. 

text tool The tool in graphic programs, such as 
MacPaint and MacDraw, that is used for typing 
text into a drawing. 

title bar The horizontal area at the top of a 
window that shows the name of the window 
and is an indicator of whether or not that 
window is active. When the window is the 
active window, the title bar has a series of 
horizontal lines; when the window is not the 
active window, the lines are not present. 
A window may be moved on the screen 
by clicking in the title bar and dragging 
the window to a new location. (See also 
active window) 

toolbox The menu in MacPaint that contains 
the tools that are used to create lines, shapes, 
and other drawing elements. 

tools palette The group of tools that runs down 
the left side of the Mac Draw drawing window 
and that are used to create ob jects in a 
MacDraw document. 
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trackbal An input device that is used similarly 
to a mouse, but instead of pushing the mouse 
on a desk and causing the ball inside to move, 
the trackball offers a ball that you can move 
directly. (See also mouse) 

transparent object An object created in a drawing 
program that has a transparent fill pattern, 
making it possible to see other objects beneath 
the transparent object. (See also fill) 

Trash An icon located on the lower right corner 
of the screen that looks like a trash can. When 
you wish to throw an application or docu
ment away, you drag its icon into the trash 
can. When there is nothing in the trash, the 
sides of the can are straight; and when there 
is something in it, the sides appear to bulge. 
Files may be removed from the trash can 
and replaced on the desktop until the trash 
is emptied-either by starting an applica
tion, choosing Shut Down from the Special 
menu, or choosing Empty Trash from the 
Special Menu. 

Typing level A user level in HyperCard that 
allows browsing the stack and entering and 
editing text in fields. 

Undo command A command in most Macintosh 
applications that allows you to undo the last 
action of the mouse or the last command or, 
in word processing programs, the last typing 
or formatting action. 

unfilled In MacPaint, filled or unfilled shapes 
can be created depending on the tool selected. 
A filled shape is fil led with the currently 
selected pattern as it is drawn; an unfilled 
shape is not filled with a pattern when it is 
drawn. (See also currently selected pattern, fill) 

Unsmooth command A MacDraw command 
that changes a polygon or freehand shape 
that has bee n smoothed back to its 
original form. (See also freehand tool, polygon 
tool, smooth) 

user lev~l A setting in the Preferences card in 
Hype Card's Home stack that lets you set the 
arnot nt of access you want to HyperCard's 
tools commands, and features. The five user 
level (from least access to most access) are: 
Brow ing, Typing, Painting, Authoring, and 
Scrip ing. 
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value Generally used to mean a numeric quantity. 
HyperCard stores all values as text strings, 
but can still perform mathematical operations 
on values that represent numbers. 

variable The symbol used in a program or script 
to store text or a numeric value. 

vertical split bar (See split bar) 

video display terminal (VDT) An output device 
that can receive signals by direct connection 
to a computer or other video source, but 
cannot receive transmitted signals. 

visual effect A visual transition that takes place 
on the screen in HyperCard between closing 
the current card and opening the next card 
that will appear. 

what if... analysis The process of analyzing 
alternat ives using a spread sh eet. This 
commonly involves changing parameters in 
the spreadsheet to answer questions that begin 
with "What if...". 

wide area network A system of local area 
networks that are interconnected over a wide 
geographical area, usually using the services 
provided by a common carrier. 

widow A widow occurs when the first line of a 
paragraph appears by itself at the bottom of 
a page and the rest of the paragraph is on the 
next page. 

window The area on the Macintosh's screen 
through which you h ave access to data. 
Opening a disk causes a window to open 
which shows the contents of the disk. Opening 
a document on the desktop opens a window 
which allows you to edit the contents of that 
document. Windows may be opened, closed, 
moved, resized, and the contents of the 
window m ay be scro lled, moved and 
modified. 

wiping through text Positioning the 1-beam 
pointer to the left of text an d dragging to the 
right to select the text in the path of the 1-
beam pointer. 

word processing The process of using a computer 
to ente r, ed it, forma t , and print text 
documents. (See also editing, formatting, text 
entry, printing, word wrap) 
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word wrap The process of automatically causing 
a word to drop to the begin ning of the next 
line if it won't fit at the end of the current 
line. Especially useful in a word processor, it 
is a common feature of almost all windows, 
text boxes and other places where text may 
be edited on the Mac. Word wrap lets you 
continue typing, without regard to how much 
text will fit on a particular line. The only time 
you have to type the Return key is at the end 
of a paragraph or when you want to create a 
blank line. 

wristwatch pointer The pointer you see on the 
screen when the Macintosh is performing a 
lengthy operation . You can interpret it to 
mean, "Wait C} minute, I'm busy." 

Zoom In command A MacPaint command that 
magnifies the view of a drawing jn 200% 
increments, up to 800% of the actual (100%) 
size. (See also FatBits, magnify, Zoom Out 
command) 

Zoom Out commanq A MacPaint command 
that reduces the view of a drawing in 200% 
increments, down to SO% of the actual 
(100%) size. (See also FatBits, magnify, Zoom In 
command) 

zoom box The white square on the righ t side of 
many window title bars. Clicking in the zoom 
box causes the window to expand to fill the 
screen. Clicking again will resize the window 
to its original size. (See a(so title bar, window) 

zoom controls The controls in the lower left 
corner of the MacDraw tools palette that 
reduce and magnify the view of a drawing 
from 3.12% of the actual size to 3200% of the 
actual size. (See also magnify, tools palette, zoom 
percentage box) 

zoom percentage box The box beneath the 
zoom controls on the MacDraw tools palette 
that refl ects the current view size of the 
drawing. (See also magnify, zoom controls) 
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Cursor (See pointer) 

Data 471 
Data points 358 
Data series 356 
Database 473 

Relational 473 
Database Management System 

(DBMS) 473 
Debug 35 
Default 19, 201 
Default button 19 
Delete key 27 
Deselect 62 
Desktop 3 
Desktop publishing 291 
Destination disk 18 
Detail report 471 
Dialog box 13 
Dimmed icon 17 
Direct access 472 
Disk 

400k 13 
800k 14 
Backup 12 
Copying 

One drive 18 
Two drives 19 
Warning 19 

Destination 18 
Directory window 15, 16 
DSDD 14 
Duplicating 16 
Ejecting 17, 21 
Floppy 12 
Formatting 12, 13 
Hard 12 
High-density 14 
Initializing 14 

aming 14 
One-sided 13 
Opening 15 
Source 18 
SuperDrive 14 
Swapping 19 
Two-sided 13 

Document 9, 199 
Copying 19, 25 

Caution 20 
Dragging into folder 28 
Duplicating 25, 26 

New name 26 
Erasing 31 

Dot-matrix printer (See 
Hardware) 

Dots per inch 41 
Double-click 4 
Downloadable font 42 
DPI 41 
Drag4 
Drop-down list 231, 241 
Duplicating 

Disk 16 
Document 25 
Folder 29 

Edit menu 9 
Editing 200 
Ejecting a disk 21 
Electronic circuit board (See 

Hardware) 
Electronic Data Processing 

(EDP) 471 
Electronic Spreadsheet (See 

Spreadsheet) 
Emptying the Trash 31 
Enter key 19 
Erasing 

Document 31 
Folder 30 

Warning 31 
Text 27 

Excel 361 
Absolute address 368, 418, 419, 

450 
Accept box 362, 386 
Active cell 362, 375 

Selecting 375 
Active window 432 
Arrow keys 375 
Cancel box 362, 386 
Cell 363 

Address 363, 367 
Absolute 368, 41 8, 419, 450 
Relative 367, 41 8, 419 

Attributes 365 
Changing width 377 
Clearing 448 
Contents 365, 377 
Date 366, 367 
Formatting 365, 383, 449 

Alignment 383 
Border 383 
Text 383 

Formula 366 
Naming 428 
Notes 453 
Number 366 

Number signs 379 
umber available 363 

Range 364 
Selecting 445 

In different panes 456 
Mu ltiple selection 456 

Text 365 
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Excel (conti11uerl) 
Ch art 368, 404 

Area chart 405 
Bar chart 405 

Creating 463 
Changing type of 408 
Column chart 404 

Creating 406, 438 
Combination ch art 405 
Creating a new chart 407 
Data series 404 
Formatting 410 

Options 410 
Text 411 

Legend 408 
Adding 408 
Moving 412, 413 

Line chart 404 
Creating 455 

Parts of 405 
Category axis 405 
Data series markers 406 
Legend 406 
Tick marks 406 
Title 405 
Value axis 406 

Pattern 411, 412 
Changing 411 

Pie chart 404 
Creating 416, 417, 420, 

437, 457 
Printing 420 
Scatter chart 405 
Selection squares 410 

Black 410 
Whi te 410 

Title 409 
Adding 409 

Updating 413 
Clearing 

Cells 448 
Form ulas 451 

Column 363 
Deleting 454 
Inserting 454 

Column width 
Changing 376, 377 

Creating 
Bar chart 463 
Column chart 406, 438 
Data series 444, 445, 446 
Line chart 455 
Linked worksheets 421 
New chart 407, 420 
Pie chart 437, 457 

Data series 404, 438 
Creating 444, 445, 446 
Naming 438 

Date 366, 367, 426, 427 
Formatting 426, 427 

Deleting 
Column 454 
Row 454 

Divide by zero error 450 
Enter key 375 
Error 

Divide by zero 450 
Number too wide for cell 379 

Fil l Down command 447, 450 

Fil l Right command 448, 452 
Footer 394 
Formatting 

Cells 383, 449 
Date 426, 427 
Numbers 379 

Formula 366, 383 
Absolute address 450 
Accept box 386 
Automatic reca lculation 434 
Cancel box 386 
Clearing 451 
Creating 383 
Date 426, 427 
Entering 385, 386, 387, 392, 

429 
Cell range 388 
Marching ants 387 

Fill Down command 447, 450 
Fill Right command 448, 452 
Functions 383 
Link to another worksheet 

421 
Linking worksheets 431, 435 
Marching ants 386 
Modifying 418, 419 
Naming 

Data series 438 
Paste Function command 

384,388,389,391 
Paste Link command 433, 

435 
Paste Name command 430 

Formula bar 362 
Function 383 

ABS() 390 
Argu ment 391 

Deleting 393 
Dummy argument 391 
INTO 388, 389 
PMT() 390, 391, 392 

Argument 391 
SUM() 384, 387 

Header 394 
Help 368, 394, 395 

Back button 369 
Command-/ 370 
Command-? 370 
Context sensitive 370 
Defined term 369 
Jump term 369 
Listed term 369 
Lotus 1-2-3 button 370 
Next button 370 
Opening 368 

Horizontal split bar 362 
Icon 361 
Inserting 

Column 454 
Row 454 

Legend 408 
Linking worksheets 431 
Marching ants 386 
Mathematical operators 387 
Na ming 

Cell 428 
Data series 438 
Range 428 

Notes 453 

Creating 453 
Number 366 

Date 426, 427 
Entering 378 
Formatting 379 

Currency 380 
Custom 382 
Genera l 381 
Integer 381, 382 

Numbers 378 
Page Preview 397 

Cancel button 397 
Enlarged view 398 
Nex t button 397 
Print button 397 
Reduced view 397 
Zoom button 397 

Page Setup 394, 395, 396 
Codes 395 
Defaults 394, 396 
r:ooter 394, 395, 396 
Header 394, 395,396 
Help 395 
Margins 396 
Options 396 
Page orientation 396 
Print Gridl ines 396 
Print Row and Column 

Headings 396 
Parts of a chart 405 

Index 

Paste Function com mand 388 
Paste Arguments 391 

Paste Name command 430 
Print 398 

Chart 420 
Page Preview 397 

Printing 394 
Project 1 372 
Pro ject 2 402 
Project 3 421 
Project 4 440 
Project 5 463 
Range 

Naming 428 
Range of cells 364 
Reference area 362 
Relative address 367, 418, 419 
Return key 375 
Row 363 

Deleting 454 
Inserting 454 

Save 371, 378 
Save As 371 
Saving your work 371 
Selecting 

Cells 406, 447 
Column 380 
Entire worksheet 447 
In d ifferent panes 445 
Mult iple selections 406 
Using Command key 406 
With Shift key 445 

Split bars 362 
Starting 361 
Status bar 363 
Tab key 375 
Template 374 
Text365 

Entering 374, 375, 425 
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Formatting 411 
Font 411 
Size 411 
Style 411 

Truncation of 377 
Vertical split bar 362 
What if ... analysis 398 
What if ... exercises 398, 399, 

400,401,421,440,459 
Window 414 

Activating 432 
Active 432 
Menu 432 
Moving 414 
Resizing 414 
Vertical split 

Selecting cells 445 
Window menu 432 
Worksheet 

Linked 431 
Updating 431 

Linking 421 
Parts of 361 
Selecting entire worksheet 

447 
Exception report 471 
Expansion port (See Hardware) 
Expansion slot (See Hardware) 
Exploded pie chart 357 

Fat Bits 643 
Field 473 
File 9, 199, 473 

Field 473 
Record 473 

File maintenance 472 
File management 471 
File Management System 472 
File menu 9 
FileMaker 482 

Active record indicator 483 
Backing up files 490 
Blank report 521 
Book 483 

Using 484 
Browse 492 
Browsing 484, 517 

Book 518 
Scrolling 484 
Selecting record 484 
Slide control handle 518 

Calculation field 566 
Closing a file 490 
Columnar report 521 
Creating 

Columnar report 524, 529, 
540 

New file 496 
New layout 527 
New record 508 

Custom menu 486 
Damaged files 489 
Data 

Automatic entry 
Overriding 509 

Duplicating 513 
Editing 513 
Entering 506, 569, 594 

Automatically 507 

From a list of values 506 
Tab order 592 

Date 
Formatting 583 

Define 492 
Defining fields 493 
Deleting 

Record 516 
Detail report 521 
Duplicating 

Layout 604 
Record 513, 515 

Editing 
Data 513 

Entering 
Data 506, 594 

Tab order 592 
Field 493 

Calculation 495, 566 
Finding 495 
Formatting 592 
Formula 545 
Indexing 495 
Placing 591 
Sizing 591 
Sorting 495 
Text 544 

Date 494, 561 
Calculation 494 
Formatting 494 
Restrictions 494 
Sorting 494 

Defining 493, 496, 560 
Entry Options 497 

A new serial number 502, 
560 

Automatic entry 500, 501, 
502 

List of values 497, 498, 503 
Look up values from 

another file 562 
Require value 499 
Today's date 501 
Unique value only 561 
Value in range only 503 

Indexing 493 
Key 562 
Lookup 558, 562, 563, 564, 

565 
Maximum number of 493 
Naming 497 
Number 493, 560 

Calculation 494, 568 
Finding 494 
Formatting 494, 581, 592 
Indexing 494 
Yes or No 494 

Picture 494 
Placing 528 
Repeating 567 

Formatting 584, 585 
Resizing 528 
Selecting 506, 593, 604 

Clicking 506 
Using Tab key 506 

Summary 495, 609 
Change in results 495 
Defining 609 
Formatting 610 

Sorting 613 
Text 493 

Calculation 544 
Finding 493 
Formatting 580 
Resizing 5 77 
Sorting 493 

Field definitions 
Printing 519, 550, 598 

File 493 
Backing up 560 
Closing 490 
Creating 560 
Creating a new file 496 
Damaged 489 
Interconnecting 558 
Sorting 525 
Switch lookup file 564 

Find 492, 614 
Dates in a range 614 

Find All 516, 615 
Finding 

Information 514 
Record 514 

Formula 
Entering 545, 546 
Function 548, 567 
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Logical operators 545, 547 
Mathematical operators 545, 

547 
Summary field 610 
Text 545 

Concatenate 545, 548, 549 
Text operators 547 

Function 
ROUND(,) 567 
SUM() 567 

Gadgets 531, 553 
Invisible Grid 586, 591 
T-squares 587, 588 

Magnetic 588, 589 
Tab order 593 
View as list 531, 532 

Graphics 528 
Importing 528 
Line 589, 592 

Line width 586 
Moving 571 
Pasting 528, 571 
Placing 528, 571 
Resizing 528 

Help 485, 488, 533 
Arranging Information 588 
Command-/ 485 
Find 487, 533, 534 

Search criteria 487 
Finding topics 487 
Formulas 546, 547 
Function 548 
Logical operators 547 
Mathematical operators 547 
Opening 485 
Scripts 486 

Icon 482 
Label report 521 
Layout 492 

Aligning objects 588 
Blank 570 

Adding fields 576 
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FileMaker (continued) 
Creating 570 

Body 532 
Columnar 

Creating 529 
Creating 527 
Date 535, 539 
Default 504, 525, 526 
Duplica ting 604 
Field 525 

Calculation 591 
Choosing 530, 540 
Date 583 
Deleting 604 
Formatting 580 
Moving 553, 578, 608 
Repeating 584 
Selecting 593, 604 
Selecting multiple 553 
Tab order 592, 593 
Text 579 

r:ooter 533 
Gadgets 553 

Column Setup 554 
Invisible Grid 554 
Slide Objects 554 
Slide Ob jects Left 555 
Slide Objects Up 555 
Slide Parts Up 555 

Graphi cs 525, 571 
Line 586, 587 
Rectangle 586, 590 

Header 532 
l.ahel 

1-up 550 
3-up 550 
Adjusting fields 552 
Creating 551 
Defining 551 
Dimensions 550, 551 
For dot-matrix printer 556 
For laser printer 556 
Vertical Page Alignment 

556, 557 
Mailing labels 544 
Modifying 538, 604 
Page number 535, 539 
Part 605 

Adjusting 605, 606, 608 
Body 605 
Footer 605 
Grand Summary 611 
Header 606 
Placing 607 
Sub-summary 607, 613 

Placing 
Field 525 
Graphics 525 
Text 525 

Standard 504, 525, 526 
Text525, 538 

Aligning 538 
Moving 538 

Text labels 573, 575 
Alignment 575 
Formatting 574, 579, 591 
Moving 606 
Placing 579 

Time 535, 539 

Title Footer 533 
Title Header 533 
Vertica l 504 

Lookup field 562 
Menu 526 

Custom 486 
Select 526 

Layout 526 
Modes for working 492 
Number 

Calculation 566 
r:o rmatting 581 

Alignment 584 
Commas 582 
Dollar notation 581, 582 
r:ixed number of decimal 

digits 581, 582 
Percent notation 581 
Yes or No 581 

Opening screen 483 
Part 528 

Adding 528 
Body 528 
Footer 528 
Grand Summary 528 
Header 528 
Placing 528 
Resizing 528, 5 72 
Sub-summary 528 
Title Footer 528 
Title Header 528 

Pasting 
Graphics 528 

Preview 536, 556, 613, 616 
Full sized view 536 
Reduced view 536, 537 

Printing 519, 543, 558, 598 
Field definitions 519, 550, 

598 
Report 539 

Project 1 490 
Pro ject 2 521 
Project 3 558 
Project 4 602 
Quitting 490, 516 
Record 493 

Deactiva ting 512 
Deleting 516 
Duplicating 513, 515 
Find All 516 
Finding 514 
New 508 
Scrolling 484 
Selecting 484 

Repeating field 
Formatting 584 

Report 521 
Blank 521 
Columnar 521, 540 

Creating 524, 529, 540 
Detail 521 
Label 521 
Mailing labels 544 
Printing 539, 543 
Sorting 613 
Summary 521 

Save a copy 505 
Saving your work 489 

Problems 489 

Index 

Screen 
Active record indicator 483 
Book 483 
Slide control handle 483 
Status area 483 

Scripts 486 
Scrolling 484 
Select Menu 526 

Layout 526 
Selecting 

Record 484 
Slide control handle 483, 484 
Sort492, 541,542,615 

Alphabet ical order 542 
Ascending 542 
Chronological order 542 
Descending 542 

umerical value 542 
Sort fi eld 542 
Unsort 604 

Sorting 541, 557 
Starting 482 
Status area 483 
Summary field 609 
Summary report 521 
Switch lookup file 564 
Text 

Concatenate 544 
Tool 

Arrow 527 
Field 528 
Line 527 
Oval 528 
Part 528 
Rectangle 528 
Rounded rectangle 528 
Text 527 

Tools 
Palette 527 

What's what on the screen 483 
Filled 57 
Finder 2, 37 
Floating window 716 
Folder 3 

Closing 10 
Creating 27 

Naming 27 
Directory window 6 
Double-clicking 6 
Duplicating 29, 30 
Erasing 30 

Warning 31 
Final Projects 32 
NewS 
Opening 6, 28 
System Folder 5 

Folders 
Nesting 7 

Font 60 
Bitmapped 212 
Downloadable 42 
LaserWriter 212 
Outline 212 
point size 60 

Formatting 201 
Formatting a d isk 12 
Formula 353 

Graphical user interface 2 
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Graphics 
Analytical 355 
Bitmapped 48, 637 
Object-oriented 48 
Presentation 355 

GUI 35 

Hanging indent 264 
Hard carriage return 199 
Hard copy 42 
Hardware 36, 37 

68000 37 
68020 38 
68030 38 
68040 38 
Cable 40 
Central Processing Unit 37 
CPU 37 
Electron ic circuit board 40 
Expansion port 40 
Expansion slot 40 
Keyboard 40, 41 
Memory 

Bit 39 
Byte 39 
Kilobyte 39 
Megabyte 39 
Permanent 38 
RAM 38 
ROM 38 
Temporary 38 
Volati le 38 

Microprocessor 37 
Modem 42 

Baud rate 42 
Monitor 41 

Black and white 41 
Color 41 
Pixel 42 

Mouse 40 
Mouse button 40 
Periphera l 40 
Printer 42 

lmageWriter 42 
LaserWriter 42 

PostScript 42 
Storage 43 

Backup 43 
Disk 43 

Floppy 43 
Hard 43 

Tape 43 
Trackball 40 

Highlight 10 
Highlighted 56 
HyperCard 

Adding cards 672 
Application 

Opening from HyperCard 
708 

ASCII 658 
Authoring 632 
Back 619 
Background 

Copying 666 
Creating 682 
Field 636 
Multiple cards 628 
Naming 71 2 

Picture 637, 682 
Background command 683 
Background layer 628 
Backing up 627 
Browsing 632 
Button 618, 629 

Background 629, 693 
Calendar 674 
Card 629 
Clearing 634 
Clicking 

With Command and 
Option keys 700 

Copying 634, 693 
Creating 633, 693 
Cutting 634 
Deleting 634 
Dial 674, 675 
Dragging 695 
Duplicating 634 

Copy and Paste 634 
With Option key 634 

Find 624 
Home 647, 674 
Info 635 
Left Arrow (Previous) 624 
Linking to a card 629, 717 
LinkTo 716 

This Card 716 
Marching ants 633 
Moving 634 
Next 64 7 
Pasting 695 
Previous 64 7 
Print Report button script 720 
Resizing 634 
Return 624, 651 
Right Arrow (Next) 624 
Script 720 
Selecting 633 
Selection 634 
Showing with Command-

Option 620 
Sort 674, 675 
Sort button script 720 
Style 

Transparent 715, 718 
Tell Me ... 647 
To Do 674 
View 674 

Card 627, 628, 629 
Background layer 628 
Card layer 628 
Field 636 
Home 630 
Linking 715 
Maximum n umber of 627 
Next 628 
Picture 637, 659, 663 
Previous 628 
Printing 674 
User Preferences 664 

Card layer 628 
Caution 

Browse tool 
Automatically changing to 

card layer 692 
Field placement on layers 636 

Command key 

Brush tool 639, 641 
Button tool 633 
Eraser tool 641 
Field tool 635 
Spray tool 639 

Command-? 622, 627 
Command-Option 620, 635 
Creating 

Background 682 
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New Stack 665, 680, 71 1 
Copy current background 

683 
Copying background 666 

Data 
Entering 671, 672, 673, 702 

Deleted 668 
Dialing 679 
Draw Filled 

Toggle command 645 
Dynarnlc links 65 7 
Edit menu 634 

New Card 672 
Entering 

Data 671, 672, 673, 702 
Fat Bits 643 
Field 635 

Background 629 
Creating 688 

Background layer 636 
Card layer 636 

Caution 636 
Clearing 636 
Copying 636 
Creating 635, 636 

Background 688 
With Command key 635, 

688 
Cutting 636 
Deleting 636 

Warning 636 
Double-clicking 670 
Duplicating 636 
Font 669 

Size 669 
Information 636 
Insertion point 671 

Moving with Tab key 671 
Modifying 667 
Moving 668, 689 
Naming 670 
Pasting 636 
Resizing 668 

Automatic text reflowing 
689 

Scrolling 691 
Selected 

Marching ants 668 
Selecting 635, 636 

Marching ants 635 
Show Lines 668 
Style 668 

Rectangle 670, 691 
Scrolling 691 

Text 628, 635 
Formatting 628, 635 

Find 619, 624, 625, 626 
Finding 

Capitalization 661 
Text 660, 661, 662 
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HyperCard (continued) 
Floating window 629, 716 
Go menu 618 

Back 619 
Find 619 
First 619 
Help 619, 627 
Home 619 
Last 619 
Message 619 
Next 619 
Previous 619 
Recent 619, 694 

Hand pointer 633 
Help 619, 621, 622, 627 

Asterisk 623 
Browse 622 
Command-? 622 
Exit 627 
Find 626 
Glossary 623 
Index 623, 624 
Index tab 622 

Home 617, 630 
Ca rd 617, 618 

Adding 630 
Look for applications in 

631 
Look for documents in 631 
Look for stacks in 630 

Stack 617,618 
1-lyperTalk 618, 681 

Scripting 681, 696 
Continued line character 

719 
Visual Effects 697 

!-beam pointer 633 
Icon 617 
Layer 628 

Background 628, 634 
Card 628 

Linking 629, 715, 717 
Cards 715 

Marching ants 635 
Menu 

Edit 
Background 634, 683 
Clear Button 634 
Copy Button 634, 693 
Copy Picture 683 
Cut Button 634 
New Card 672 
Paste Button 634, 695 
Paste Picture 684 
Text Style 640 
Undo 695 

File 
New Stack 665, 683 
Open Stack 700 
Print Report 677, 718 

Go 618 
Recent 694, 695 

Objects 664 
Bkgnd Info 712 
Button Info 634 
Field Info 636, 668 
New Background 713 
New Button 633, 688 
New Field 635 

Stack Info 666, 707 
Paint 

Flip Horizontal 684 
Patterns 637 
Tear-off 637 
Tools 63 7, 664 

Menu bar 
Appearance 

Background layer634, 683 
Card layer 634 

Message 619, 624 
Miniwindow 716 
Navigating 618, 619 
Ob jects menu 633, 635 

Field Info 636 
Option key 

Button tool 634 
Curve tool 645 
Oval tool 642 
Polygon tool 645 
Rectangle tool 642 
Selection tool 638 

Painting 632 
Over a field or button 637 

Palette 637 
Patterns 637 

Showing and hiding 640 
Positioning 637 
Tools 637, 683 

Path names 631 
Pattern 

Alignment with top left edge 
of card 686 

Patterns menu 637 
Phone dia li ng 653, 679 

Modem 680 
Speaker 679 

Picture 637 
Background 637 
Card 637, 659, 663 
Dragging 684 

With Shift key 685 
Pointer 

Arrow 638 
Cross beam 638 
Hand 633 
!-beam 633 
Lasso 638 

Printing 
Card 674 
Columns report 678 
Labels report 678 
Report677, 708,718 
Rows report 678 
Stack 676 

Pro ject 1 655 
Project 2 664 
Pro ject 3 680 
Project 4 711 
Quitting 656, 663 
Recent 619, 694 
Report 

Columns report 678 
Labels report 677, 678 
Printing 677, 708, 718, 719 
Rows report 678 

Saving your work 627 
Script 696 

Editing 700 

Index 

Scripting 632, 720 
Continued line character 719 
Option-Return 719 
Print Report button script 720 
Return key with Option key 

719 
Sort button script 720 
Visual Effects 697, 699, 700 

Search ing for text (See Find) 
Shift key 

Brush tool 639 
Dragging Picture 685 
Line tool 644 
Oval tool 642 
Pencil tool 643 
Polygon tool 645 
Rectangle tool 642 
Regular Polygon tool 642 
Spray tool 639 

Sort 675 
Sorting 674, 675, 707 
Stack 627, 628, 646 

Address 652 
Buttons 674 

Art Ideas 646, 647, 649 
Clip art 648 
Home button 647 
Index 646, 648, 649 
Metric Equivalents card 649 
Next but ton 647 
Open ing 646 
Previous button 647 
Tell Me ... button 647 

Button Ideas 650, 681, 693, 
701 
Index 650 

Calendar 652, 653 
To Do list 653 

Class Notes 
Assignments field 691 
Class field 691 
Date field 691 
First button 695 
Last button 696 
Next button 696 
Notes field 691 
Previous button 696 
Print Report button 696, 

708 
Print Report button script 

720 
Pri nting 708 
Sort button 696, 708 
Sort button script 720 
Sorting 708 

Class Notes Buttons 681, 696 
Print Report button 681, 

697 
Scripts 697 
Sort button 681, 697 

Company Organization 711 
Chart background 712 
Directory background 713 
Home button 715 
Organization Chart button 

717 
Transparent buttons 715, 

718 
Creating 665, 681 
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Creating a new stack 680 
Glossary 636, 655 

acronym card 658 
Additional notes field 656 
ASCII card 658 
Card picture 659, 663 
Defin itions field 656 
Dynamic links 657 

Dissolving 658 
Find button 657, 660 
Hide Picture button 657, 

659 
Home button 656 
jumping to related terms 

658 
Navigating 657 
Next button 657 
Previous button 657 
Return button 657, 659 
Returning from related 

terms 658 
See also field 656 
Show Picture but ton 656, 

659 
Sort button 657 
Tell Me ... button 657 
Term field 656 

Help 621 
Home 630 
lntro 619 
Modifying 664 
Phone 653, 654 

Area codes 653, 654 
Finding area codes 654, 655 
Local call 680 
Long-distance call 680 
Preferences 654 

Prin ting 676 
Header icons 676 

Resource 645 
Button 645 
Icon 645 
Picture 645 
Sound 645 

Sorting 674, 707 
Stack Ideas 650, 665, 682 

Computer paper 
background 651 

Com puter paper card 682 
Index 650, 65 1 
Return button 651 

Visual Effects 681, 698 
Dissolve button script 699 
Scripting 699 

Starting 617 
Double-cl icking stack icon 

656 
Tab key 

Selecting field 671 
Telephone d ialing 653 
Text 

Maximum characters 629 
Maximum number of 629 

Text field 628 
Tool 632 

Browse tool 632, 633 
Automatica lly changing to 

card layer 692 
Brush tool 639 

Ch anging shape 639 
Constrain 639 
Convert to eraser 639 
Double-clicking 639 
Using 639 
With Command key 639 
With Shift key 639 

Bucket tool 639,686 
Black areas 640 
Double-clicking 640 
Fi lled areas 640 
Pattern misalignment 686 
Pouring pattern 686 
Spill recovery 640 
Spills 640 
Using 639 
Whi te areas 640 

But ton tool 632, 633 
Double-clicking 635 
with Command key 633 

Curve tool 644 
Changi ng line width 645 
Double-cl ick 645 
Draw Filled 644 
Patterned border 645 
Used 644 
With Option key 645 

Eraser tool 641 
Constrain 686 
Double-clicking 641 
Exposing background 

picture 641 
Painting instead of erasing 

641 
With Command key 641 
With Shift key 686 

Field tool 632, 635 
Double-clicking on 636 

General tools 632 
Lasso tool 638, 687 

Changing pattern in filled 
area 640 

Dragging 638 
Uses of 638 

Line tool 644 
Changing line width 644 
Constrain 644 
Double-clicking 644 
Using 644 
With Shift key 644 

Oval tool 642 
Circle 642 
Constrain 642 
Options 642 
Using 642 

Paint text tool 640, 690 
Alignment 640 
Correcting 640 
Double-clicking 640, 686 
Fon t 640 
Line height 640 
Size 640 
Style 640 
Text Style d ialog box 641 
Unable to Find 641 

Pain ting 
Selecting last object 641 
Wi th Command-S 641 

Paint ing tools 633, 637 
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Similarity to MacPaint 637 
Pencil tool 643 

Black painting 643 
Constrain 643 
Double-clicking 643 
Edi ting individual pixels 

643 
Fat Bi ts 643 
Whi te painting 643 
With Shift key 643 

Polygon tool 645 
Changing line wid th 645 
Completing polygon 645 
Constrain 645 
Differen t from o ther tools 

645 
Double-clicking 645 
Pa tterned border 645 
Using 645 
With Option key 645 
With Shift key 645 

Rectangle tool 641 
Borderless 642 
Changing line width 642 
Constrain 642 
Draw Cen tered 641 
Draw Filled 642 
Pa tterned border lines 642 
Square 642 
Using 641 
With Option key 642 

Regular Polygon tool 642 
Constrain 642 
Double-cl icking 642 
Draw Centered 642 
Rotating 642 
Selecting a shape 642 
Using 642 
With Shift key 642 

Rounded Rectangle tool 644 
Like Rectangle tool 644 
Using 644 

Selection tool 638 
Changing pattern in fi lled 

area 640 
Double-clicking 638 
Dragging 638 
Uses of 638 
With Option key 638 

Spray tool 639 
Constrain 639 
Convert to eraser 639 
Using 639 
With Command key 639 
With Shift key 639 

Text (See Paint text tool) 
Tools menu 637 
Tools palette 683 
Typing 632 
Undo 640, 695 
User level 631 

Authoring 629, 632, 664, 682 
Browsing 632 
Pa inting 632 
Scripting 629, 632, 682, 700 
Setti ng 664 
Setting fro m Message box 700 
Typing 632 

User Preferences card 664 
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HyperCard (continued) 
Visual Effects 697, 698 

Barn Door 698 
Checkerboard 698 
Dissolve 698 
Iris 698 
Plain 698 
Scri pting 699 
Scroll 698 
Venetian Blinds 698 
Wipe 698 
Zoom 698 

Warning 
Deleting fields 636 

Window 
Floating 629, 637, 716 
Miniwindow 716 

Hyphenation dictionary 199 

1-beam pointer 5, 60, 151, 212 
Icon 4 

Deselecting 26, 27 
Dimmed 17 
Document 

Moving 22 
Folder 

Moving 27 
Trash 

Bulging 30 
Information 471 
Information Management 468 

3 x 5 cards 468 
Adding records 478 
Business 469, 470 
Common carrier 475 
Com municating over phone 

lines 476 
Concepts 468 
Creating reports 480 
Database 473 
Database Management System 

473 
Deleting records 478 
Editing records 478 
Field 473 

Example 474 
Key 473, 475 

File 473 
Example 473, 474, 475 

Fi le Management System 471, 
472 

FileMaker 482 
HyperCard 617 
Local area network 476 
Management Information 

System 472 
Microcomputers 476 
Organizing information 477 
Performing calculations 478 
Personal 468 
Record 473 

Example 474 
Redundancy 472, 475 
Reports 471, 480 

Audit trai l 480 
Detail 471 
Exception 471 
Paper trail 480 
Summary 471 

Retrieving records 479 
Sorting 479 

Sort Field 479 
Sorting records 479 
Storage 472 

Direct access 472 
Disk 472 
Random access 472 
Sequential access 472 
Tape 472 

Storing information 477 
Uses of 477 
Wide area network 475 

Insertion point 60, 128, 212 
Issuing a command 5 
Item 473 

jaggies 48 

Key 
Backspace 27 
Delete 27 
Enter 19 
Return 19 

Key field 473 
Keyboard 40, 41 
Keyboard equivalent (See 

Command-key equivalent) 
Kilobyte 39 

Landscape orientation 201 
LaserWriter 

Resolution 41 
Line chart 358 
Line weights 60, 146 
Local area network (LAN) 476 

MacDraw 124 
Active Tool 127 
Align command 169 
Aligning ob jects 

To the d rawing page 180 
Using Alignment command 

165 
Using Autogrid 140 
Using Duplica te command 

166 
Without distributing 174 

Alignment command 164 
Autogrid 

Aligning objects 140 
Constraining objects 140 
Ruler settings 141 
Snap to grid increments 140 
Turning off/on 140 

Caps Lock key 152 
Corner/Center control 131 
Deleting objects 128, 129, 146 
Distributing objects 

Using Alignment com mand 
165 

Using Duplicate command 
166 

Document formats 145 
Drawing area 125 
Duplicate command 147 

Automatic alignment/ 
distribution 166 

Duplicating a grouped object 

177 
Multiple objects 169 
Vs. Copy and Paste 148 

Filling objects 
Existing object 139 
While drawing 139 

Index 

Formatting text 151, 178 
Font Menu 15 L, 163 
Size Menu 151, 153, 163 
Style menu 153, 163 

Grid 127 
Gridli nes 127, 140 

Hide/Show 140 
Ruler settings 141 

Grouping objects 157 
Group command 157 
Ungroup com mand 157 

Handles 127, 128 
Help 126 
Icon 125 
Layer controls 138 
Layers 138 
Line weights 146 

Changing ex isti ng object 146 
Creating new object 146 
Pen menu 146 
Point size 146 
Preset 146 

Menu Bar 125 
Modifying multiple objects 167, 

] 71 
Pa ttern palette 129, 139 

Changing fi ll pattern 139, 
177 

Changing line pattern 139, 
178 

Fill pattern box 139 
Line pattern box 139 
Preset patterns 139 
Scroll arrows 139 
Selecting a pattern 130 
Transparent (empty) fil l 

pattern 144 
Pen menu 146, 162 
Pointer 

Cross-bea m 127 
!-beam 151 

Printing 159, 182 
Qui tting 159 
Repositioni ng objects 130, 145 
Reshape command 134, 186 

Adding extra points 193 
Removing unwanted points 

193 
Resizing objects 129, 130, 149 
Rotate command 190 
Rulers 140, 143 

Hide/Show 140 
Ruler settings 141 

Saving your work 126 
Scroll box 143, 1 80 
Selecting a tool 127 
Selecting objects 137 

All objects 145 
Multiple ob jects 137, 145, 

164 
Vs. grouping 164 

Opaque 144 
Tra nsparent 144 



Index 

Sh ift key 
Drawing circles 131 
Drawing quarter circles 132 
Drawing squares 130 
Selecting mult iple objects 145 

Deselecting 145 
Show Size command 161 
Smooth command 134, 136 
Stacking order 175 

Move Backward command 
188 

Move To Back com mand 175 
Starting 125 
Text 

Changing background 
patte rn 179 

Deleting 128, 152 
Editing 128, 152 
Formatting 152, 178 
Inserting 152 
Paragraph 152 
Repositioning 128, 154 
Rotating 190 
Selecting 128, 152 
Text wrap 152 

Tools 127 
Arc 132, 196 

Direction o f mouse 132 
Part of circle 132 
Part of ell ipse 132 

Freehand 133, 192 
Reshape com mand 134 
Smoo thing 133 
Unsmooth com mand 134 

Line 129 
Deleting 129 
Resizing 129 

Oval 131 
Circle 131 

Polygon 135, 185 
Smooth command 136 

Rectangle 129 
Changing fill pattern 130 
Repositio ning 130 
Resizing 130 
Square 130 

Rounded Rectangle 129 
Selection arrow 127, 137 

Dele ting objects 146 
Select ing ob jects 137, 145 

Text 127, 152 
Dele ting 128 
Fonts 151 
!-beam pointer 151 
Insert io n point 128 

Tools palette 127 
Transparent ob jects 144 
Undo command 146 
Unsmooth command 134 
Using MacDraw vs. MacPaint 

125 
Zoom controls 138 

Enla rging view 139 
Reducing view 157 

Zoom percen tage box 138, 139 
Macin tosh 

Mo dels and processors 37, 38 

M acitltosh Journey Projects dtsk 
12, 18, 94, 100, 252, 255, 294, 
301, 482, 558, 571,655, 681, 
682, 696, 719 

MacPaint 52 
Active window 102 
Actual Size window 75 
Aligning objects 67 
Bo rder Palette 60 
Caut io n 56 
Closing a d ocumen t 107 
Copying a rtwork 101 
Deselecting 62 
Documen t formats 69 
Draw 

Fro m Center 1L8 
Fro m Edge 118 

Drawing area 125 
Drawing with a patterned line 

117 
Duplicating 

Copying to the Clipboard 67 
With Option and Com mand 

keys 117 
With Option and Shift keys 

67, 87, 89 
With Optio n key 67, 78, 119, 

120 
FatBits 74, 75 

Actual Size window 75 
Fill ing objects 

Leaks 64 
Flipping an o b ject 68 
Help 53 
Icon 53 
Invert com mand 123 
Magnify 74 
Menu bar 53 
Opening a document 100 
Pasting 103 
Patte rns 

Menu 57,63 
Palette 57 

Pointer 
Cross-beam 56 
Hot spot 84 
!-beam 60 

Printing 94, 111 
Quitting 94 
Revert To Saved command 70 
Rotating 78, 108, 109 
Saving your work 54 
Scroll bar 80, 97, 104 
Scroll box 80, 97, 104 
Selecting 

Delet ing selected object 67 
Lasso 62 
Lasso vs. Selection rectangle 

62 
Selectio n rectangle 61, 108 

Shift key 
Align ing objects 67 
Constraining a motion 67 

68, 71, 87, 90, 96, 97, 1i l , 
119, 121 

Snap to pointer 97 
Shortcu ts 76 

Starting 53 
Text 

Deleting 60 
Drawing 85 
Style menu 92, 104 
Typing 91 

Title bar 74 
Toolbox 

Positioning 55 
Too ls 55 

Eraser 56 
Caution 56 

Freehand 
Fil led 58 
Unfilled 58 

G rabber 63 
Lasso 62, 73 
Line 56 

Line weigh ts 60 
Oval 

Circle 58 
Filled 58 
Unfilled 58 

Paint b rush 
Brush shapes 59, 81 

Paint bucket 64, 83 
Hot spot 84 

Pencil 56 
Polygon 

Filled 58 
Unfilled 58 

Rectangle 
Filled 57 
Square 57 
Unfil led 57 

Ro unded Rectangle 
Filled 57 
Unfilled 57 

Select ion marquee (See 
Selection rectangle) 

Selection rectangle 61 , 62 
Ma rching ants 61 

Spray can 59 
Text 60, 91 

Deleting 60 
Fonts 60 
Insertion point 60 
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Trace Edges command 115, 116 
Undo com mand 70 
Using MacPaint vs. MacDraw 

125 
Zoom In comm and 74 

Actual Size (100%) 75 
Magnification percent 74 

Zoom Out command 76 
SO% size 86 

Managemen t Information 
System (MIS) 472 

Megaby te 39 
Memory (See Hardware) 
Menu 9 

Apple 9 
Edit 9 
File 9 
Pull-down 10 
Tea r-off 55 

Menu ba r 9 

_j 
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Menu item 9 
Selected 10 

Microprocessor 37 
Microsoft Excel (See Excel) 
Microsoft Word 204 

Activating a document 255 
Active window 255 
Automatic date icon 305 
Automatic page break 249 
Automatic styles 260 
Automatic time icon 305 
Block quote 242, 244 

Indenting 243 
Borders 

Dialog box 258 
Line above and below 302 
Plain box 257 

Caution 333 
Change command 224 

Change All 225 
Match Upper/Lowercase 225 
Special formatting characters 

226 
Whole Word 225 

Changing document margins 
242,245,307 

Character 205 
Character command 231 
Character formatting 229 

Change existing text 230 
Set before typing 230, 271 

Clip art 251 
Copy command 220 
Copying a graphic 256, 301 
Creating blank lines 213 
Cut command 220 
Data document 317 
Default tab stops 213, 246 
Deleting text 213 
Desktop publishing 291 
Document command 245 

Default tab stops 246 
Even/odd header 246 
Gutter 246 
Mirror even/odd margins 246 
Number pages from 246 
Widow control 246 

Document views 247 
Dot leaders 263, 266 
Drawing tool 237 
Drop-down fields 231 
Drop-down list 231, 241 
Find command 222 

Match Upper/Lowercase 223 
Searching whole document 

222 
Special formatting characters 

226 
Whole Word 223 

First Page Special Header/Footer 
299 

First-line indent 236 
Font 212, 271 

Monospace 239 
Point size 229 
Proportional 239 

Footer 303, 304 
First Page Special 299 
Viewing 307 

Footnotes 343 
Closing window 344 
Opening window 345 
Reference mark 344 

Formatting domains 204 
Full Menus 209 
Galley View 247, 310 
Hanging indent 264 
Header303,304,343 

Borders 306 
First Page Special 299, 342 
Header window 304 

Icons 305 
Viewing 307 

Help 
Activating 206 
Context-sensitive 207 
Extended keyboard 207 

Hidden characters 218 
Hide Ruler command 233 
Hide If command 218 
Icon 205 
Incorporating Graphics 251 
Left indent 236 
Line spacing 233, 235 
Main document 318 
Manual page break 

Deleting 249 
Inserting 249 

Margins 233 
Monospace fonts 239 
Moving text 220 
New-line command (See Soft 

return) 
Opening a document 254, 256 
Outline View 247 
Page numbering 

Using Header/Footer window 
icons 343 

Using Print Preview 247 
Using section dialog box 298 

Page View 247, 310 
Paginate 249 
Paragraph 205, 230 
Paragraph command 261 

Indents 264 
Space after 303 
Space before 261, 303 

Paragraph formatting 230 
Applying 230 
Ruler 233 

Paragraph marker 217 
Paste command 220 
Pasting a graphic 256, 301 
Point size 229, 232 
Pointer 

Arrow 219 
1-beam 212 

Print merge 310 
Chevrons 322 
Conditional printing 324 
Data document 316,317 
DATA instruction 322 
Data records 331 
Delimiters 329 
Error messages 334, 335 
Field names 318, 320 
Fields 315, 317 
Header record 

Index 

Delimiters 329 
Main document 315, 318 
Merge fields 319 

Formatting 327 
Printing 333 
Records 317 
SET instruction 323 
Troubleshooting 334 

Print Merge command 318, 332 
Print Preview 247, 307 
Printing 248, 250, 268 
Proportional fonts 239 
Quitting 250 

Saving before quitting 250 
Right indent 236 
Ruler 202, 233 

Alignment controls 234 
Indent controls 

First-line indent 236 
Hanging indent 264 
Left indent 236 
Moving with Shift key 259 
Right indent 236 

Line spacing controls 235 
Paragraph spacing settings 

240 
Scale tool 241 

Normal scale 241 
Page scale 241, 242 
Table scale 241 , 279, 289, 

347 
Style Name box 262, 265 

Drop-down list 241 
Tab settings 237, 238 

Center tab 237 
Decimal-aligned tab 237 
Drawing tool 237 
Left-aligned tab 237 
Right-aligned tab 237 
Using tabs vs. spacebar 239 

Save As command 208 
Saving your work 207 
Searching and replacing 222 
Section 205, 291 

2-column layout 299 
3-column layout 300 
Columns 298 

Balancing length of text 
300 

Number of 298, 299, 300 
Spacing between 298, 300 
Viewing 299 

Dialog box 298 
First Page Special Header/ 

Footer 299 
Header/Footer positions 299 
Page number formats 298 
Section break 

Creating 296 
Section break marker 296 

Deleting 296 
Section marker 205 
Start options 298 

Selecting a graphic 256, 301 
Selecting text 219 

Entire document 220, 295 
Selection bar 219 
Wiping through text 219 

Selection bar 219, 221 
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Arrow pointer 219 
Short Menus 209 
Show Ruler command 233 
Show <J1 command 217 

Hard return (paragraph) 
symbol218 

Hidden characters 218 
Soft return (new-line) symbol 

218 
Space symbol 218 
Tab symbol 218 

Soft return 215, 236, 275 
Space between paragraphs 240 
Spelling checker (See Spelling 

Utility) 
Spell ing dictionary 201 
Spelling Utility 227 

Adding words to dictionary 
229 

Checkjng entire document 
227 

Ignore Words jn All Caps 227 
Selected text 227 
Suggested words 228 

Starting 205 
Style 241, 251 

Applying Styles 263 
Automatic styles 260 
Based on field 261 
Creating styles 260 
Define styles dialog box 268 
Define styles prompt 266 
Defining by example 264, 

265 
Defining styles 260 
Style name list 262, 263 

Style sheet 251 
Tab leaders 263, 265, 266 
Tab settings 

Dot leaders 263 
Tab stops 233 
Tables 205, 269, 347 

Adjusting margins 
Table scale 289 

Borders 282 
Around entire table 282 
Every cell in selection 284 
Removing 290 
Row and column separators 

283, 284 
Cell 205, 269, 271 

Deleting 288 
Merging 288 
Selecting contents 277 
Selection bar 277 

Cells command 278 
Changing cell alignment 280 
Changing column width 278 
Changing spacing between 

rows 286 
Column 271 
Creating 272, 274 
Creating new row as needed 

274 
Deleting cells 288 
End-of-cell marker 272 
End-of-row marker 272 
Formatting cells 277 
Insert Table command 272 

Colum n width 272 
Number of columns 2T(-, 

274 
Number of rows 272 

Insertion point 272 
Merging cells 288 
Moving back to a cell 275 
Moving to new line within 

cell 274 
Moving to next cell 274 
Moving to next row 274 
Moving to tab stop in cell 

281 
Pa ragraph command 286 
Row 271 
Selecting an entire column 

280 
Selecting blocks of cells 277 
Selecting entire table 282 
Setting decimal tabs 281 
Table scale 

Changing cell margins 279 
Changing column width 

279 
Tables feature 269 
Tex t al ignment 233, 234 

Centered 234 
Flush left (left aligned) 234 
Flush right (right al igned) 

234 
justified 234 

Vertical spacing 235 
Word wrap 215 

Miniwindow 716 
Modeling 351 
Modem 42, 476 

Baud rate 42 
Monitor (See Hardware) 

Resolution 41 
Mouse 4, 40 

Button 4 
Click 4 
Double-click 4 
Drag 4 
Shift-click 5 

Moving 
Document icon 22 
Folder icon 27 

Nesting folders 7 
New Folder 8 

Object-oriented 49 
Object-oriented graphics 48, 124 
Opening a disk IS 

Palette 55, 127 
Paragraph 199, 205 
Paste 67, 103 
Patterns palette 55 
Peripheral (See Hardware) 
Pie chart 356 

Exploded 357 
Pixel 42, 48 
Point size 229 
Pointer 4, 40 

Arrow 5, 219, 638 
Cross-beam 56, 127, 638 
Hand "633 

1-beam 5, 60, 151, 212, 633 
Wristwatch 5 

Points 60 
Portrait orientation 201 
PostScript 42, 49 
Presentation graphics 355 
Print merge 315 
Printer 42 

Dot-matrix 42 
lmageWriter 42 
LaserWri ter 42 

Program 36 
Application 6 

Opening 8 
Quitting 9 
Starting 8 

Draw 49 
Pa int 49 
System 6 

Pull-down menu 10 

Quitting a program 9 

RAM 35, (See Hardware) 
Random access 472 
Record 473 
Redundancy 472 
Reference Guide to Your 

Macintosh 32 
Relational database 473 
Repeating field 584 
Resolution 41 

lmagcWriter 42 
Better 42 
Faster 42 

LaserWriter 41 
Monitor 41 

Return key 19 
ROM 35, (See Hardware) 
Row 352 

Savilig your work 
Ca ution 39 
Excel 371 
FileMaker 489 
HyperCard 627 

Screen resolution (See 
Resolution) 

Scripting 629 
SCSI 35 
Search and replace 200, 222 
Search criteria 487 
Select 61, 219 
Sequential access 472 
Shift-click 5 
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Shut Down command 32, 490 
Soft copy 42 
Soft return 215 
Software 36 

Application 36, 37 
PostScript 42 
System 36, 37 

Finder 37 
Source disk 18 
Spelling checker 201, 227 
Spreadsheet 350 

Active cell 352 
Capabili t ies 351 
Cell 352 
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Spreadsheet (cont inued) 
Address 352 
Contents 352 
Formula 353, 355 
Function 355 

umber 353 
Range 354 
Text 352 
Value 353 

Column 352 
Formula 353 
Function 353 

Argument 353 
AVERAGE() 353 
SQRT() 353 
SUM() 353 

Graphics 355 
Analytical 355 
Charts 

Bar chart 357 
Col umn chart 357 
Data poin ts 358 
Exploded pie cha rt 357 
Line chart 358 
Pie chart 356 

Presentation 355 
Mathematical operators 353 
Modeling 351 
Modifying 350 
O rganization 35 I 
Range of cells 354 
Row 352 
Terminology 352 
Uses o f 35 1 
What if. .. analysis 351 

Stacking o rder 175 
Starting a program 8 
String li tera l 545 
Summa ry report 471 
Swapping disks 19 
System Folder 5 

System program 6 
System software 36, 37 

Tape drive 43 
Tear-off m enu 55, 637 
Template 374 
Text 

Erasing 27 
Text alignment 234 
Text entry 199 
Title bar 11 
Toolbox 55 
Trackball 40 
Trash 3, 30 

Bulging icon 30 
Emptying 31 

Empty Trash command 31 
Shut Down command 31 
Starting an application 31 

Highlighted 30 
Icon 

Empty 4 
Full 4 

Removing contents 31 

Unfilled 57 
User level (HyperCard) 631 

Value 353 
Variable 356 
VDT (See Hardware, Monitor) 
View of directory window 23 

Warning 
Copying a disk 19 
Erasing a fo lder 31 

What if ... analysis 351 
Wide area n etwork 475 
Window 11 

Active 11 

Close box 10, 11 
Closing 11 

With Option key 11 
Dialog box 13 
Directory 6 

View 23 
By date 24 
By icon 25 
By name 24 
Default 25 

Floating 716 
Miniwindow 716 
Title bar 11 
Zoom box 11 

Word processing 198 
Cutting 200 
Defaults 201 
Document 199 
Editing 200 
File 199 
Formatting 201 

Index 

Landscape o rientation 201 
Portra it orientation 201 

l-Iard carriage re turn 199 
Hard return 199 
Paragraph 199 
Pasting 200 
Printing 202 
Reformat 200 
Search and replace 200 
Spelling checker 201 
Text entry 199 
Word wrap 199 

Word wrap 199 
Worksheet (See Spreadsheet) 
Wristwatch pointer 5 
WYSIWYG 35 

Zoom box 11 



Macintosh Journey P oject Disk o 
The Macintosh Journey Project Disk is designed to accompany A Macintosh Journey with Guided 
Projects by John Dilbeck and Nicki Fink. 

This disk is not required for the completion of projects in the book, but it wi ll save time entering 
data. It includes clip art, several word processing documents with most of the text already entered, 
an inventory file for use with FileMaker, and three HyperCard stacks (Glossary, Class Notes Buttons, 
and Visual Effects). This inexpensive disk will help you travel quickly through the projects in 
A Macintosh Journey. 

If you are using A Macirztosh Journey as a text for a course in which you are enrolled, your 
instructor will already have this disk. You are authorized to make a copy of your instructor's 
disk to use with our book. 

To order, complete the coupon below, and mail it to: 

Benjamin/Cummings Publishing Company 
ATTN: ORDER DEPT. 
ljacob Way 
Reading, MA 01867-9984 

Please allow approximately 10 days for delivery. 

Please send me the Macintosh Journey Project Disk (31262-5) to accompany the text 
A Macintosh Journey with Guided Projects by john Dilbeck and Nicki Fink. 

I understand that the price of the Disk is $2.25 and this covers all costs, including 
shipping and handling. 

Please enclose a check or money order for $2.25 (payable to Benjamin/Cummings 
Publishing Co). 

Name: __________________________________ ~----------------------

Organization: ______________________________ -:-------------------

Address: __________________ -:------------

City: ________________ State: ____ Zip: _____ __ _ 



Common Command-Key Shortcuts 

3€- A 
3€- B 

3€- c 
3€-o 
3€- E 

3€- F 

3€- G 

3€-H 
3€ - I 

3€ - J 
3€- K 

3€- L 

3€-M 
3€-N 

3€-o 
3€- p 

38-Q 
3€- R 

3€- s 
3€- T 
3€-u 

3€- v 
3€-w 
3€- X 
3€- y 
3€- z 
3€- ? 

3€-

repeat last command 

page view 

copy 

set character formats 

create footnote 

find 

go to page 

change 

page view 

repaginate document 

glossary 

spelling checker 

reformat paragraph 

new (file/ folder I 

card/ record) 

open file 

print document/ card 

quit 

show / hide ruler 

save 

define styles 

enter/leave 

outlining mode 

paste 

close 

cut 

show / hide en 
undo 

help 

stop current action 

• -I 
H-u 
88- y 

H-o 
81 -E 

81- B 

81 - R refind 

81- G findall 

H-s sort 

H- L layout 

H -T 

• - y 

Excel 

H - M activat next window 

3€ - = calcula 

81- B 

81- L 

81- K 

88-o 
88- J 
88-H 
88-G 
88- I 

88-A 
H-A 
H-u 

clear 

define arne 

delete 

from A Macintosh Journey by John Dilbeck and Nicki Fink 

© 1991 The Benjamin/Cummings Publishing Company 

HypercardrM 

88- T text style 

88- B background 

88- s select 

H-A select all 

H- K keep 
88-- back 

88-H home 

81- R recent 

88-1 recent 

88-2 prev(ious) 

H- 3 next 

• -4 last 

88-M message 

• - + bring closer 

88-- send farther 

MacPainfiD 

H.- T rotate 

H- M zoomin 

88- L zoomout 

88-a 
88- B 

88- I 

88-u 

MacDraw® II 

3€- A select all 

3€-o duplicate 

3€ - E smooth 

3€- R reshape 
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Figure 5-46 Positioning the duplicate objects 

Part II: Graphics 

• Click on another part of the screen to deselect the objects. 

Mac Draw "remembers" where you placed the last duplicate object with 
reference to the original as long as you do not deselect the duplicate 
object. This feature is one of the reasons that MacDraw works well for 
creating business forms and charts. You can create horizon tat vertical, 
and diagonal rows of identical objects without having to draw each 
ob ject sepa rately or copy thef and then align them in a row. When you 
position the duplicate object, you establish the spacing and direction of 
the row, and each duplicate is positioned and aligned automatically. 
You' ll use this feature to crea te the rest of the boxes in the second row 
of the organizatio nal chart. 

• Select the duplicate box and text with in it that you just positioned 
in the lower left corner of the screen. 

00 -D • Choose Duplicate from I the Edit menu. 

When you position the du plicate that you just created, you'll establish 
the direction and spacing of the second row of objects. 

- Position the second duplicate box to the right of the original and 
align the top edges of both objects, as shown in Figure 5-47. 

james w. Nielsen 
. : .. President. ... 

0 • 

james w. Nielsen· 
Pres ident · 

Figure 5-47 
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• Choose Alignment from the Arrange menu. 

• In th e resulting d ialog box, select Align and Center from the righ t 
portion of the box, and se lect Align and Center from the bottom of 
the box, as shown in Figure 5-45. 

Alignment ... 

® To eoch other 0 To grid 

181 Align 

G ODistrlbute 

O Top 
®Center 
0 Bottom 
O IICI!Jhf 

181 Align 0 Distribute 

0 l eft ®Center 0 Right 0 lllldfh 

( Co ncel ) ~ 

Figure 5-45 The Alignment dialog box 

The settings you just chose for this dialog box told MacDraw to align the 
objects to the center both vertically and horizontally. Notice that the 
small diagram in the dia log box shows you the effect these settings wil l 
have on the ob jects. 

• Click OK to accept the changes you've made to the dialog box. 

Now you' ll use the box you just d rew as a template for the others, since 
it is already the correct size and has the text centered within it. To do 
so, you'll dupl icate it. 

DUPLICATING USING AUTOMATIC ALIGNMENT 

You'll duplicate the box as well as the name inside it, even though you'll 
change the names in just a mo ment, because you want the text to retain 
the same formatting characteristics (New York font, bold, and centered) 
when you retype a d iffe rent name. 

3€ -D • If both the text and the rectangle are no t a lready selected, select 
th em now, and then choose Duplicate from the Edit menu. 

• Click on the duplicate set of objects, but not o n any of their 
handles . Drag them to the lower left side of the screen, as shown in 
Figure 5-46. 
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SELECTING OBJECTS 
• To select both the box and the text within it, place the selection 

arrow above and to the left of the box and drag diagonally past the 
bottom right corner of the box. 

A dotted rectangle is created around the objects, as shown in 
Figure 5-44. When you releake the mouse button, all objects within the 
temporary rectangle are selected. All objects that are selected will have 
handles showing. 

' . . 
: fames W. lUelsen : . . . 

· · · · :· · · · ·President· · · · · ·: · · · · · · · · · · · · · · · · · · · · · · · · · . . . ·. . . . 
' ' ' ' 
'- -- ~ --------~ -- -- -- --~ 

. . 
. ..•..•. • .•..•....... ·!· 

Figure 5-44 Selecting multiple objects 

Selecting multiple objects is not the same as grouping objects. Grouping 
objects creates one composite object made up of all the objects that are 
selected when the Group command is invoked. Selecting multiple 
objects enables you to work with all selected objects at one time, but 
each can still be selected separately. 

Next you'll center the text within the rectangle. 

CENTERING TEXT WITHIN A RECTANGLE 
The Alignment command allows you to align and distribute selected 
objects with each other or with the grid. Aligning refers to moving selected 
objects so that their boundaries line up in a specified manner. Distributing 
objects spaces them even y in a document, either vertically or 
horizontally. 
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ADDING TEXT 

I !g) Pamela Gurneri I 
D Telephone Me~sag ... 1Q !g) Pamela Gu ... 

Saue drawing as: 

I• .6Hit$11UH6111®1 

Eject 

Driue 

S11ue 

[ C11ncel 

® Drawing 0 St11tlonery 0 PICT 

Figure 5-42 The Save dialog box 
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• Type Organizational Chart in the Save drawing as: box, and then 
click the Save button. 

Your drawing window should now have the name of your document 
and the current layer showing at the top: Organizational Chart-Layer# l. 

Now you need to add some text inside the box you just drew. The first 
name and title wil l be the company president's name. 

• Click on the text tool to select it, and then click inside the rectangle 
in approximately the center of it. 

.. Choose New York from the Font menu, and then choose 12 point 
from the Size menu. 

W -B • Choose Bold and then Center from the Style menu. 

• Type the following text in the block, pressing return where indicated: 
j ames W. Nielsen (press Return) 
President 

Your screen should look like the one shown in Figure 5-43. 

p ames W. Nie ls-;;j 
L President! _j 

. . 

Figure 5-43 Adding text to the rectangle 

• Click somewhere else on the screen to deselect the text tool. 
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Figure 5-41 The Pen menu 

You learned about line weights in Pro ject 1. The Pen menu also offers 
diffe rent line styles. 

Pla in Line, which is checked in the Pen menu shown in figure S-41, is 
the default line style. The Dashed Line option creates a dashed line, and 
you can custo mize the dash size and space between das hes by choosing 
Dashes from the Pen Menu. 

An Autosize Line has the line's length automatically printed in the 
midd le. Autosize Lines are used for drawing dimensio n lines that show 
the measurement o f objects in a drawing, such as in a floor plan. 

The Arrow At Start and Arrow At End options enable you to d raw lines 
that begin or end (or both) with arrowheads. You can modify the shape 
of the arrowhead by choosing Arrows from the Pen menu. 

You can use any combination of line weights, dashes, arrows, and 
dimensions o n any line you draw. 

SAVING THE DOCUMENT 

Before you get too deep into this project, it's a good idea to save what 
you 've done so far and give the d rawing a name. 

8€ -S • Choose Save from the liile menu. 

Remember to be careful ab? ut where you are saving your document. 
Always verify tha t the name of the d isk (or fo lder) that you want your 
document saved on is showirg at the top of the Save d ialog box-in this 
case, where "Pamela Gurnari" is showi ng in Figure S-42. If necessa ry, 
click the Drive button so t a t you are viewing the correct name. 
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• Double-click on the MacDraw II icon to open a new, untitled 
drawing window. If you did not exit Mac Draw after working on the 
previous project, choose New from the File menu to get a new, 
untitled drawing window. 

Keep in mind that if you need to delete an object, select it and press th e 
Backspace key (Delete key on some keyboards). 

• Select Show Rulers from the Layout menu. 

You will be using the rulers to determ ine the size and spacing of the 
objects in your organizational chart. 

DISPLAYING THE SIZE OF AN OBJECT 
A handy feature in MacDraw 11 is the Slww Size command. The size of any 
object you draw is immediately reflected on the bottom of the screen as 
you draw it. Also, any time you click on the border of an object after it 
is drawn, it shows you the size of that object. 

• Choose Show Size from the Layout menu. 

• Select the rectangle tool. 

• Create a rectangle 2 inches wide and 1 inch high. 

Notice that the size of the rectan gle is displayed at the bottom of the 
screen as you draw it, as shown in Figure 5-40. 

~--:-·-·---------·--·-i 

i : . i . . ! ... . .. : ..... ,. : .. ... .. . . 
L.~------: --~ : 

Figure 5-40 Using the Show Size fea ture 

• If you clicked elsewh ere on the screen after you drew the rectangle, 
click anywhere o n the rectangle to select it. 

CHANGING LINE WEIGHTS 
- To change the thickness of the lines form ing the rectangle, choose 

2 point from the Pen menu, as shown in Figure 5-41. 
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Acme Toys, Incorporated 
I..__ ____ M_anufacturers of Fine Toy.;;...s ______ __. 

Carol Garms 
Vice-President, 

Sales 

I I 

Mai Nguyen 
Sales Manager 

james W. Nielsen 
President 

I I 

Jill Aoki 
Vice-President, 
Manufacturing 

I I 

Samuel Neujahr 
Manufacturing 

Manager 

I I 

Richard P. Cleaves 
Vice-President, 

Finance 

I I 

Judith Crippin 
Controller 

Figure 5-39 final output of Project 2 
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~ -A • Select both message form s by choosing Select AJI from the Edit me nu. 

~ - D • Choose Duplicate from the Edit m enu. 

• Position the two duplica tes o n the bottom portio n of the page, as 
sh own in figure 5-38. 

' '--:---- ••---:---

Figure 5-38 Placing two more duplicate fo rms 

ow you have four telephone m essage forms in one docume nt. 

PRINTING THE DOCUMENT 

Befo re you print the d ocument, save your work. 

-- Choose Save from the File menu. 

Choose Print from the f ile menu. Click OK to accept the d efa ult 
print options an d print one copy. 

Com pare your printed document with the o ne shown in Figure S-14. 

~ -Q • To exi t MacDraw, choose Quit from the Fi le menu. To continue 
working on the next exercise and remain in MacDraw, close the 
document by clicking in its close box. 

Project 2: Creating an Organizational Chart · 

In thi s project you' ll create a corpo rate o rga n iza ti ona l chart. You' ll use 
some of the tools a nd comma nds that you learned about in the first 
project, and you' ll a lso learn handy ways to create some special effects. 
You' ll learn about pen and fil l patterns and about ali gn ing a nd arranging 
objects. The finished o rga n iza tional cha rt is sh own in Figure S-39. 


